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यह लाइसेंस तर्ी तक क्रकसी व्यजतत को व्यावसाययक उद्देश्यों के ललए र्ी आपके कायभ में 
लमश्रण, थोडा बदलने व यनमाभण करने क्रक आज्ञा देता है, जब तक क्रक व ेआपको शे्रय देते हैं 
और समान शतों के तहत अपनी नई रचनाओं का लाइसेंस देते हैं। इस लाइसेंस की तुलना 
अतसर " कॉपीराइट" फ्री और ओपन-सोसभ सॉफ्टवेयर लाइसेंस स ेकी जाती है। आपके कायभ 
के आधार पर यनलमभत सर्ी नए कायों का एक ही लाइसेंस होगा, इसललए यह क्रकसी र्ी 
व्युत्पन्न कायभ के व्यावसाययक उपयोग की र्ी अनुमयत देगा। यह ववक्रकपीडडया द्वारा उपयोग 
क्रकया जाने वाला लाइसेंस है और उन सामग्रियों के ललए अनुशंलसत है जो ववक्रकपीडडया और 
इसी तरह के लाइसेंस प्राप्त पररयोजनाओं से ली गई हैं।  
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इस वन्यमावली में प्र्ुयक्त प्रतीक वरनह:

ववक्र्य हषेतु नहीं - कषे वल आंतरिक प्रसाि कषे  वलए

प्रतिभागी पुत्िका



रोटो आरटटि्ट

vii

क्रमां्क मॉि्यूि एिं यूरनटें पषृ्ठ सं.

1.  पररचय एिं अरभमखुी्करण 1

्यवूनट 1.1 मीवड्या एंड एंटिटषेनमेंट क्षेत्र सषे परिर्य 3 

्यवूनट 1.2 मुख्य शबद 8

2.  ज़रूर्त ्को समझें (MES/N 3501) 11

्यवूनट 2.1 एवनमषेशन का आिाि एवं वसद्धांत 13 

्यवूनट 2.2 लाइफ ड्ॉइंगस: मानव शिीि िरना ववज्ान का आिािरतू वसद्धांत 24 

्यवूनट 2.3 वनमा्भण पवू्भ कषे  का्य्भ / वनमा्भण सषे पहलषे कषे  काम 31

3.  उप्करणों और सामररियों ्का प्रबंधन ्करना (MES/N 3502) 43 

्यवूनट 3.1 हूक-अप पोवज़ज़ तथा एवनमषेशन बनाना 45 

्यवूनट 3.2 प्रदश्भन पि ज़ोि दषेनषे हषेतु कैमिषे  कषे  वववरनन एंरल प्र्योर किना  49

4.  Rotoscoping िुटजे (MES/N 3506) 65 

्यवूनट 4.1 – Rotoscoping एवनमषेशन बनाना 67 

्यवूनट 4.2 Rotoscoping कषे  वलए प्र्योर वकए जानषे वालषे टूलस/उपकिण 73

5.  2 D एरनमशेन बनाएँ 77

्यवूनट 5.1 Photoshop पि काम किना 79 

्यवूनट 5.2 Flash पि काम किना 91

6.  3D एरनमशेन बनाएँ  113

्यवूनट 6.1 3D एवनमषेशन का वनमा्भण किें  115 

्यवूनट 6.2 वसतुओ ंकी िरना, हषेिफषे ि किना औि दषेखना 164 

्यवूनट 6.3 मा्या 3D दृश्य दषेखना 170 

्यवूनट 6.4 पॉलीरोनल मॉडवलंर 181 

्यवूनट 6.5 NURBS मॉडवलंर 209 

्यवूनट 6.6 एवनमषेशन 217 

्यवूनट 6.7 पॉलीरन टकै्संररिंर/बहुरुज रठन 224 

्यवूनट 6.8 िें डरिंर 227

7.  Stop Motion एरनमशेन  233

्यवूनट 7.1 Stop Motion प्रो कषे  प्र्योर सषे Stop Motion 235

8. ्कायटिस्थि में सिास्थय एिं सरुक्ा बनाय ेरखना (MES/N 0104) 245

्यवूनट 8.1 का्य्भसथल में सवास्थ्य एवं सुिक्ा बना्यषे िखना 247

9.  संचार/संिाद ्कौशि एिं वयािसारय्क ्कौशि 253

्यवूनट 9.1 संराि/संवाद कौशल 255 

्यवूनट 9.2 व्यावसाव्यक कौशल 266

रिषय सूची

ववक्र्य हषेतु नहीं - कषे वल आंतरिक प्रसाि कषे  वलए



viii

प्रतिभागी पुत्िका

ववक्र्य हषेतु नहीं - कषे वल आंतरिक प्रसाि कषे  वलए

क्रमां्क मॉि्यूि एिं यूरनटें पषृ्ठ सं.

10.  रोज़गार और उद्यरम्ता ्कौशि 275 

्यवूनट 10.1 – व्यवक्तरत शवक्त्यां एवं मलू्य प्रणाली 279 

्यवूनट 10.2 – वडवजटल साक्िता: पुनिाववृत्त 296 

्यवूनट 10.3 – पसैषे का महतव 301 

्यवूनट 10.4 – िोज़राि औि सव-िोज़राि कषे  वलए त्ैयािी किना  310 

्यवूनट 10.5 – उद्वमता को समझना 319 

्यवूनट 10.6 – उद्मी बननषे की त्ैयािी किना 338

रिषय सूची



1. पररचय एिं अरभमुखी्करण

्यवूनट 1.1 - मीवड्या एंड एंटिटषेनमेंट क्षेत्र सषे परिर्य

्यवूनट 1.2 - मुख्य शबद



32

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

रनष्कषटि 

इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. मीवड्या एंड एंटिटषेनमेंट क्षेत्र की महत्ता कषे  बािषे  में जाननषे में।

2. िोटो आवट्भसट की रवूमका तथा दाव्यतवों की पहरान किें ।

3. एवनमषेशन/Rotoscoping सषे जुडषे  तकनीकी शबदों की व्याख्या किें ।
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यूरनट ्ेक उद्ेशय  

यूरनट 1.1: मीरिया एंि एंटरटनेमेंट क्ेत्र से पररचय 

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. मीवड्या एंड एंटिटषेनमेंट क्षेत्र की महत्ता कषे  बािषे  में जाननषे में।

2. िोटो आवट्भसट की रवूमका तथा दाव्यतवों की पहरान किें ।

रािती्य मीवड्या एंड एंटिटषेनमेंट (M&E) क्षेत्र, ववश्व का 14वां सबसषे बडा मीवड्या एंड एंटिटषेनमेंट 

क्षेत्र ह ैऔि ्यह राित की GDP में लररर 1.7% का ्योरदान दषेता ह।ै दषेश कषे  कुल िोज़राि में इस 

क्षेत्र का ्योरदान लररर ~9.3 प्रवतशत ह ैऔि उममीद की जा िही ह ैवक ्यह ्योरदान वष्भ  2017 तक 

लररर ~14 प्रवतशत पि पहँुर जाएरा।

एक आकलन कषे  अनुसाि, रािती्य मीवड्या एंड एंटिटषेनमेंट बाज़ाि में 13.9% कषे  CAGR (रक्रववृद्ध 

वावष्भक ववृद्ध दि) सषे ववृद्ध होनषे की उममीद ह ैऔि ्यह वष्भ  2014 में रु. 1026 अिब कषे  सति सषे उठ कि 

वष्भ  2019 में रु. 1964 अिब कषे  सति पि पहँुर जाएरा। ्यह ववृद्ध दि ववैश्वक मीवड्या एंड एंटिटषेनमेंट 

उद्ोर की ववृद्ध दि सषे लररर दोरुनी ह।ै

1.1.1 भार्त में मीरिया एंि एंटरटनेमेंट क्ेत्र

1.1.2 मीरिया एंि एंटरटनेमेंट क्ेत्र में रोज़गार-योगय्ता 

वष्भ 2014 कषे  दौिान, वडवजटल एडवटा्भइवज़ंर में वष्भ  2013 कषे  मुकाबलषे 44.5 प्रवतशत की ववृद्ध दषेखी रई। इस प्रकाि वडवजटल मीवड्या की लोकवप्र्यता में 

उ्ाल लराताि बना िहा। वष्भ  2014 में ववज्ापनों सषे होनषे वाली आ्य में वष्भ  2013 कषे  सति सषे 14.2% की ववृद्ध हुई ह ैऔि ्यह रु. 414 अिब कषे  सति पि पहँुर 

रई ह।ै इसमें वपं्रट (43%) औि टषेलीववज़न (37%) का वहससा सबसषे अविक िहा ह।ै

हमािषे  दषेश में दुवन्या कषे  सबसषे बडषे प्रसािण उद्ोरों में सषे एक ह ैवजसमें लररर 800 उपगह टषेलीववज़न रनैल, 242 FM रनैल औि 100 सषे री अविक सवक्र्य 

सामुदाव्यक िषे वड्यो नषेटवक्भ  हैं। रािती्य वफलम उद्ोर, ववैश्वक सति पि वफलमों का सबसषे बडा वनमा्भता ह।ै ्यहाँ वफलम वनमा्भण कषे  का्य्भ  में 400 वनमा्भण एवं 

कॉपपोिषे ट घिानषे संलगन हैं।

राित सिकाि नषे वववरनन पहल किकषे  मीवड्या एंड एंटिटषेनमेंट उद्ोर की ववृद्ध में सह्योर वद्या ह,ै जसैषे अविक संसथारत ववत्तपोषण आकवष्भत किनषे कषे  

वलए कषे बल ववतिण क्षेत्र का वडवजटलीकिण किना, कषे बल औि DTH सषेटषेलाइट पलषेटफॉम्भ  में FDI की सीमा को 74 प्रवतशत सषे बढाकि 100 प्रवतशत किना, 

औि संसथारत ववत्त तक सिल पहँुर हषेतु वफलम उद्ोर को उद्ोर का दजा्भ  दषेना।

उद्ोर मुख्यतः ववज्ापन सषे होनषे वाली आ्य पि वनर्भि किता ह ैऔि इस उद्ोर का प्रदश्भन मुख्यतः अथ्भव्यवसथा कषे  समग परिदृश्य पि वनर्भि किता ह।ै 

वत्भमान में, वष्भ  2013 कषे  आंकडों कषे  अनुसाि, उद्ोर में 4 लाख लोरों को िोज़राि वमला हुआ ह ैवजसकी वष्भ  2022 तक 13 लाख तक पहंुर जानषे की उममीद 

ह,ै ्यावन 2013-22 की अववि में इससषे िोज़राि कषे  9 लाख अवतरिक्त अवसि पदैा होंरषे।

• पिूषे  राित में, M&E क्षेत्र में का्य्भ  किनषे वालषे कुल लोरों में सषे लररर 25 प्रवतशत वफलम क्षेत्र में का्य्भ  कितषे हैं। 

तित्र 1.1.1: TV उद्ोग के तिए तिज्ापन से होने िािी आय
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• एक आकलन कषे  अनुसाि मीवड्या एंड एंटिटषेनमेंट क्षेत्र में कुल वत्भमान िोज़राि लररर 

~4.6 लाख ह ैऔि इसमें 13 प्रवतशत की CAGR सषे ववृद्ध होकि, वष्भ  2017 में ्यह आँकडा 

7.5 लाख तक पहँुरनषे की उममीद की जा िही ह।ै

• रािती्य मीवड्या एंड एंटिटषेनमेंट क्षेत्र सषे 14.2 प्रवतशत की CAGR सषे ववृद्ध किकषे  वष्भ 

2018 तक रु. 1,786 अिब तक पहँुर जानषे की उममीद की जा िही ह ैऔि इसकषे  प्रत्यषेक 

उप-क्षेत्र में कुशल पषेशषेविों की रािी मांर ह।ै 

• वफलम औि टषेलीववज़न क्षेत्र में का्य्भबल कषे  बडषे अंश को िोज़राि वमलता ह।ै वफलम औि 

टषेलीववज़न, दोनों ही क्षेत्रों में वडवजटलीकिण रवतवववि्यों सषे औि वववरनन शवैल्यों कषे  

रनैल आिंर होनषे सषे इस मांर को उ्ाल वमलता ह।ै

उप-क्ेत्र रोज़गार (िाख में)

2013 2017 2022

टषेलीववज़न 0.14 0.28 0.64

वपं्रट 0.06 0.07 0.13

िषे वड्यो 0.02 0.03 0.04

एवनमषेशन, VFX औि रषेवमंर 0.02 0.03 0.04

वफलमें 0.16 0.24 0.44

संपणू्भ  क्षेत्र 0.4 0.65 1.3

1.1.3 मीरिया एंि एंटरटनेमेंट क्ेत्र ्का रि्कास
• राित में िषे वड्यो प्रसािण की शुरूआत वरिवटश राित में वष्भ  1923 में िषे वड्यो क्लब ऑफ बॉमबषे कषे  साथ हुई थी

• ऑल इंवड्या िषे वड्यो (AIR) की सथापना वष्भ  1936 में हुई थी जो ववश्व कषे  सबसषे बडषे नषेटवककों में सषे एक है

• राित में टषेलीववज़न का आरमन 15 वसतंबि, 1959 को दूिदश्भन (DD) कषे  रूप में हुआ था

• वष्भ  1990 तक रािती्य अथ्भव्यवसथा एक बंद अथ्भव्यवसथा थी, औि इसमें वकसी वनजी वखलाडी को प्रवषेश किनषे की अनुमवत नहीं थी। 1990 कषे  दशक 

में रािती्य वफलम उद्ोर पिूी तिह खंवडत अवसथा में था

• BBC नषे अपनी िाष्ट्ी्य सषेवा वष्भ  1995 में आिंर की

• वष्भ  1999 में सिकाि नषे पणू्भतः सवावमतवािीन रािती्य कंपवन्यों को लाइसेंस शुलक आिाि पि वनजी FM सटषेशन सथावपत किनषे की अनुमवत दषेनषे का 

वनण्भ्य वल्या

• मई 2000 में, िषे वड्यो प्रसािण लाइसेंवसंर कषे  प्रथम रिण कषे  रार कषे  रूप में नीलामी की रई औि 37 लाइसेंस जािी वकए रए, वजनमें सषे 21 लाइसेंस 14 

शहिों में प्ररालनित हैं।

तित्र 1.1.2: िरटि 2013 में मीतिया एंि एंटरटेनमेंट क्ेत्र में रोज़गार

तित्र 1.1.3: मीतिया एंि एंटरटेनमेंट क्ेत्र के तितभन्न उप-क्ेत्ररों में रोज़गार
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1.1.4 प्रमुख उपक्ेत्र एिं खंि

• रािती्य मीवड्या एंड एंटिटषेनमेंट (M&E) उद्ोर कई उप-क्षेत्रों सषे वमलकि बना ह,ै जसैषे टषेलीववज़न, िषे वड्यो, वपं्रट मीवड्या (वजसमें समाराि-पत्र एवं 

पवत्रकाएं शावमल हैं), वफलमें, संरीत तथा एवनमषेशन एवं ववजु़अल इफैक्ट्स (VFX)।

• ्यह उद्ोर मुख्यतः ववज्ापन सषे होनषे वाली आ्य पि वनर्भि किता ह ैऔि इस क्षेत्र की ववृद्ध एवं प्रदश्भन संपणू्भ  अथ्भव्यवसथा कषे  उतथान में एक 

महतवपणू्भ  रवूमका वनरातषे हैं।

• ्यह उद्ोर वन्या्भत-अवरमुख नहीं ह,ै औि इसका अविकांश उतपादन घिषे ल ूबाज़ाि में उपरुक्त होता ह।ै हालांवक, आ्यात इस उद्ोर का उललषेखनी्य 

रार हैं वजनमें अखबािी कारज, सषेट-टॉप बॉक्स एवं एंटीना शावमल हैं।

• ्यह उद्ोर सांसकृवतक एवं पािमपरिक पषृ्ठरवूम्यों में सीवमत ह ैऔि वकसी जनखंड ववशषेष कषे  वलए वनमा्भण किनषे वालषे वववशष्ट कें रिों कषे  इद्भ -वरद्भ 

संरवठत ह।ै उदाहिण कषे  वलए, मंुबई वफलम उद्ोर (बॉलीवुड), दषेश का एक मुख्य वफलम कें रि ह।ै ऐसा ही एक कें रि दवक्ण राित में री ह।ै

तित्र 1.1.4: मीतिया एंि एंटरटेनमेंट क्ेत्र

तित्र 1.1.5: िरटि 2013 में मीतिया एंि एंटरटेनमेंट क्ेत्र की िृतधि दरें
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1.1.5 ए्क रोटो आरटटिसट ्की भूरम्का  
एक िोटो आवट्भसट उन लाइव एक्शन फ्षे मों की ट्षेवसंर/अनुिषे खण किता ह,ै जहां कमप्यटूि गावफक्स लाइव इमषेज कषे  साथ ओविलपै/इंटिैक्ट किें रषे। िोटो 

आवट्भसट फ्षे म कषे  रीति सपष्ट क्षेत्र (मट्ैस) री त्ैयाि किता ह,ै वजससषे कमपोज़ीटि सीन/दृश्य कषे  सरी एलीमेंट्स/ततवों को प्ररावकािी ढंर सषे लषे्यि/

व्यववसथत कि सकषे । मीवड्या एवं एंटिटषेनमेंट उद्ोर में िोटो आवट्भसट को Rotoscopy आवट्भसट/पेंट आवट्भसट री कहतषे हैं।

जॉब ्का संरक्प्त िणटिन

्यह काम किनषे वालषे व्यवक्त को कंटेंट को अलर-अलर फ्षे मस/एलीमेंट्स में तोडना होता ह ैऔि ज़रूित कषे  वहसाब सषे कंटेंट में कांट-्ांट किनी होती ह/ै

कंटेंट िी-वक्रएट किना होता ह।ै

वयरतिग्त गुण

इस काम कषे  वलए व्यवक्त को वफलम-वनमा्भण कषे  मूल-ततवों तथा वसद्धांतों की अच्ी समझ होनी रावहए। व्यवक्त डषेपथ कषे  मूल-ततवों सषे अवरत होना रावहए 

औि उसमें अच्ा ड्ॉइंर तथा इलसट्षेशन कौशल होना रावहए। उसषे Nuke, After Effects, Silhouette इत्यावद सवहत rotoscopy सॉफटवषे्यि की अच्ी काम-

काज़ी जानकािी होनी रावहए।

पहिी आिशय्क्ता 

• उनकषे  पास कमप्यटूि औि ऑपिषे वटंर वससटम का का्य्भकािी ज्ान होना रावहए।

• माउस, मानक मषेन्यजू़ औि कमांड्स का उप्योर कैसषे किें , साथ ही फाइलें कैसषे खोलें, बंद किें  औि सषेव किें ।

इस प्रवशक्ण का्य्भक्रम में आप:

• आवश्यकताओ ंको समझना औि का्य्भ-प्रवाह/वक्भ फलो की ्योजना बनाना

• उपकिणों औि सामवग्यों का प्रबंिन किना

• Rotoscoping फुटषेज

• का्य्भसथल में सवास्थ्य एवं सुिक्ा बना्यषे िखना

उस पषेशषे में प्रवशवक्त व्यवक्त कषे  वलए वनमन प्रकाि की जॉबस /नौकरि्याँ उपलबि होती ह:ै 

• एवनमषेशन वनददेशक

• एवनमषेटि

• कला वनददेशक

• बकैगाउंड पेंटि

• काटू्भ वनसट

• कैिषे क्टि एवनमषेटि

• कैिषे क्टि रिरि

• कलि-की आवट्भसट

• कमपोवज़वटंर आवट्भसट 

• कॉनसषेपट आवट्भसट  

• वडवजटल पेंटि

• वनददेशक

• इफैक्ट्स एवनमषेटि

• वफलमषे एवं वीवड्यो संपादक/एवडटि

• फलशै एवनमषेटि
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• फोिें वसक एवनमषेटि

• गावफक्स वडज़ाइनि

• इन वबटवीनि

• सवतंत्र वफलम–वनमा्भता

• की एवनमषेटि

• प्रकाश/लाइवटंर तकनीवश्यन

• मथैषेमषेवटकल मॉडलि

• िें डि िैं गलि

• Stop Motion एवनमषेटि

• िोटो आवट्भसट

• सटोिी बोड्भ  आवट्भसट

• सटोिी बोड्भ  सहा्यक

• टषेक्सरि आवट्भसट

• वीवड्यो रषेम वडज़ाइनि

• ववजुअल डषेवलपमेंट आवट्भसट

अभयास 
1. रािती्य मीवड्या एंड एंटिटषेनमेंट (M&E) क्षेत्र ववश्व में .........सबसषे बडा है

a) 14वां

b) 15वां 

c) 16वां 

d) इनमें सषे कोई नहीं

2. वष्भ  2013 में मीवड्या एंड एंटिटषेनमेंट क्षेत्र में लोर (वमवल्यन/दस लाख में) का्य्भित थषे:

a) 0.3

b) 0.4

c) 0.5

d) इनमें सषे कोई नहीं

3. वनमन में सषे कौन-सा मीवड्या एंड एंटिटषेनमेंट क्षेत्र का वहससा नहीं ह:ै

a) वपं्रट

b) टषेलीववज़न

c) िषे वड्यो

d) िोबोवटक्स
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यूरनट 1.2: मुखय शबद

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. एवनमषेशन सषे जुडषे  तकनीकी शबदों की व्याख्या किें

1.2.2 पुस्त्क में प्रयुति सामानय मुखय शबद

• एनीमरैट्क: एनीमवैटक, एवनमषेशन का सटोिी बोड्भ  होता ह ैवजसमें संवादों औि धववन्यों कषे  साथ संपावदत वरत्रों की एक श ृंखला होती ह।ै

• ्कमपोरज़रटंग: वरत्रों/घटकों की वववरनन पतकों को एक अकषे लषे फ्षे म में सं्ुयक्त किनषे की प्रवक्र्या को कमपोवज़वटंर कहा जाता ह।ै

• ्कमपोज़ीशन: पषृ्ठरवूम औि कैमिा कषे  सापषेक् ररित्र की वसथवत वनिा्भ रित किनषे को कमपोज़ीशन कहतषे हैं।

• रक्रएरटि ब्ीि: वक्रएवटव रिीफ एक दसतावषेज़ होता ह ैवजसमें ऐसषे मुख्य प्रश्न होतषे हैं जो वनमा्भण कषे  वलए एक राइड का का्य्भ  कितषे हैं, इनमें ववज़न, 

प्रोजषेक्ट का उद्षेश्य, लक््य दश्भकरण, सम्य-सीमाएं, बजट, मुख्य पडाव, वहतिािक आवद शावमल होतषे हैं।

• ्की फे्म: की फ्षे म मुख्य मुरिाएं होतषे हैं, आमतौि पि ्यषे वकसी एवनमषेशन सीक्वेंस की आिंवरक औि अंत मुरिाएं होती हैं।

• मॉिरिंग: एक ववशषेष सॉफटवषे्यि एवपलकषे शन का उप्योर किकषे  एवनमषेशन कषे  वलए वत्रआ्यामी मॉडल बनानषे की प्रवक्र्या को मॉडवलंर कहा जाता ह।ै

• रेनिररंग: वत्रआ्यामी मॉडलों को 3D प्ररावों कषे  साथ वद्आ्यामी वरत्रों में बदलनषे की प्रवक्र्या को िषे नडरिंर कहतषे हैं।

• रररगंग: वकसी मुरिा ववशषेष में प्रसतुत किनषे कषे  दौिान रवत किनषे में सहा्यता दषेनषे कषे  वलए वकसी वसथि वत्रआ्यामी मॉडल में जोड डालनषे की प्रवक्र्या 

को रिवरंर कहा जाता ह।ै

• 2D एरनमेशन: वद्आ्यामी परिवषेश, जसैषे कमप्यटूिीकृत एवनमषेशन सॉफटवषे्यि में रवतमान वरत्रों का वनमा्भण।

• 3D एरनमेशन: इस एवनमषेशन में रहिाई होनषे का एहसास होता ह।ै ्यह दषेखनषे में अविक ्यथाथ्भवादी ्या सजीव लरता ह।ै हालो औि मषेडषेन (Halo and 

Madden) फुटबॉल जसैषे वीवड्यो रषेमस इसकषे  उदाहिण हैं।

• एरनमेशन:  वसथि वरत्रों की एक श ृंखला को तषेज़ी सषे प्रदवश्भत किनषे कषे  द्ािा रवत को वसमुलषेट किना ्या रवत की अनुरवूत किाना।

• एंटीरसपेशन: एक एवनमषेटि एक्शन काि्भ वाई की त्ैयािी कषे  माध्यम सषे एंटीवसपषेशन (पवूा्भनुमान) पदैा किता ह।ै

• आसपेकट रेरशयो: टीवी वरत्र की रौडाई का ऊंराई सषे अनुपात।

• ब्ैकरिाउंि पेंरटंग: वकसी एवनमषेशन की पषृ्ठरवूम कषे  वलए प्र्ुयक्त पेंवटंर।

• CGI (Computer Generated Imagery): वडवजटल सॉफटवषे्यि वससटम का उप्योर किकषे  फ्षे म में आकृवत, सषेवटंर ्या अन्य सामगी बनाना।

• किीन-अप: इसका अथ्भ 2D एवनमषेशन कषे  िफ आट्भवक्भ  कषे  परिशोिन की प्रवक्र्या सषे ह।ै

• ्कम्पयूटर एरनमेशन: कमप्यटूि पि एवनमषेशन बनाना। 3D ्या 2D हो सकता ह।ै एवनमषेशन की प्रवक्र्या में रिण जोडता ह।ै

• फे्म: वफलमें ्या एवनमषेशन बनानषे में प्र्योर होनषे वाली वफलम की पट्ी पि वसथि पािदशशी फोटोगाफ की एक श ृंखला।

• फे्म रेट: वकसी एवनमषेशन में फ्षे मस कषे  आरषे बढनषे की राल। आमतौि पि इसषे फ्षे मस पि सषेकंड (fps) में मापा जाता ह।ै

यूरनट ्ेक उद्ेशय  
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• रिारिकस टबैिटे: इस पि आप सकषे र औि ड्ॉइंर बना सकतषे हैं वजसषे मॉवनटि पि वदखा्या जाता ह।ै

• Pixel: (कमप्यटूि ववज्ान) CRT सक्रीन पि वकसी ्वव ्या वरत्र का सबसषे ्ोटा, पथृक घटक (आमतौि पि एक िंरीन वबंदु)।

• Raster: pixels सषे बनी क्वैतज िषे खाओ ंकषे  समूह सषे वनवम्भत िरना वजसका उप्योर CRT पि वरत्र बनानषे कषे  वलए वक्या जाता ह।ै

• Rotoscoping: जब मनै्ुयअली ्या कमप्यटूि ऑटोमषेशन द्ािा वकसी दृश्य की पषृ्ठरवूम में एक बाि में एक फ्षे म कषे  वहसाब सषे कोई वीवड्यो ्या वफलम कषे  

वरत्र िखषे जातषे हैं।

• टाइटि ्काि्टिस: शुरूआती वफलमों, वजनमें आवाज़ नहीं होती थी, में सक्रीन पि वदखनषे वालषे शबद। इससषे लोरों को कथानक समझनषे में आसानी  

होती थी।

• Tween: मुख्य फ्षे मस कषे  बीर होनषे वाली एवनमषेशन की प्रवक्र्या।

• Vector: इस शबद का अथ्भ एवनमषेशन कषे  उस प्रकाि सषे ह ैवजसमें कला ्या रवत का वन्ंयत्रण pixels की बजाए वषेक्टिों द्ािा होता ह।ै Vector एवनमषेशन 

सषे अक्सि अविक सपष्ट औि वनबा्भि एवनमषेशन बनता ह,ै क््योंवक ्वव्यों का प्रदश्भन औि/्या उनका आकाि बदलनषे का का्य्भ  रंडारित pixel मानों की 

बजाए रवणती्य मानों का उप्योर किकषे  वक्या जाता ह।ै

• CEL: CEL एक पलावसटक शीट होती ह ैजो cellulose acetate ्या cellulose nitrate की बनी होती ह।ै इस पि एनीमषेटषेड कैिषे क्टि वपं्रट वकए जातषे हैं। 

व्यवहाि में, CEL का अथ्भ पलावसटक शीट औि कैिषे क्टि, वसतु औि/्या सपषेशल इफषे क्ट्स कषे  आउटलाइन औि कलरिंर, इन सरी कषे  सं्योजन सषे वल्या 

जानषे लरा ह।ै आउटलाइन ्या तो हाथ सषे बनाई रई हो सकती ह ै्या वफि ज़षेिोगावफक वववि सषे पलावसटक शीट पि ट्ांसफि की रई हो सकती ह।ै सषेल 

को पणू्भ  किनषे कषे  वलए उन आउटलाइंस को वफि, हैंड-पेंवटंर ्या सषेरिगावफक प्रवक्र्या द्ािा, िंर सषे रिा जाता ह।ै

• Rotoscoping: ्यह वह एवनमषेशन प्रवक्र्या ह,ै वजसका प्र्योर वकसी िोटो आवट्भसट ्या एवनमषेटि द्ािा वकसी मोशन वपक्रि फुटषेज को फ्षे म-दि-फ्षे म ट्षेस 

किनषे कषे  वलए तब वक्या जाता ह,ै जब वबलकुल असली/वासतववक/सजीव एक्शन की आवश्यकता हो।

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

रट्पपरणयां 
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2. आिशय्क्ता ्को समझना

्यवूनट 2.1- एवनमषेशन का आिाि तथा वसद्धांत

्यवूनट 2.2- लाइफ ड्ॉइंगस: मानव शिीि िरना ववज्ान का आिािरतू वसद्धांत

्यवूनट 2.3 पवू्भ -वनमा्भण का्य्भ

MES/N 3501
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. अंत-उतपाद कषे  उन वववरनन मापदंडों सषे अवरत होना, जो वनमा्भण/प्रोडक्शन आवश्यकताओ ंको प्रराववत कितषे हैं (उदाहण कषे  वलए: अववि, शलैी, पात्रों 

की संख्या, ववष्य तथा कथानक, वह संसकृवत तथा ज़माना/कालाववि वजस पि कहानी आिारित ह,ै अपषेवक्त इफैक्ट्स, फॉमदेट, संरीत इत्यावद)।

2. आउटपुट, वजसका वनमा्भण वक्या जाना ह,ै कषे  ट्ीटमेंट तथा फाइनल आउटपुट कषे  वॉल्यमू की व्याख्या किना।

3. शॉट सीक्वेंस (हाइ-लषेवल/उचर-सतिी्य) तथा अपषेवक्त वनिनतिता/सामंजस्यता की व्याख्या किना।

4. आउटपुट की मांर पि आिारित सटीक एवनमषेशन तकनीक का र्यन। इसमें शावमल ह:ै 2D एवनमषेशन, 3D एवनमषेशन।

रनष्कषटि 
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यूरनट 2.1: एरनमेशन ्का आधार एिं रसदां्त

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. एवनमषेशन कषे  वसद्धांतों सषे अवरत होना।

2.1.1 एरनमेशन ्ेक मौरि्क रसदां्त
एवनमषेशन एक सम्यातंिाल में वसतु/पात्र की हिकतों में आनषे वालषे बदलाव का वरत्रण ह।ै एवनमषेशन मंर पि वकसी बक्सषे को इिि सषे उिि, एक फ्षे म सषे 

अरलषे फ्षे म पि लषे जानषे जसैा सिल हो सकता ह।ै ्यह बहुत ज्यादा जवटल री हो सकता ह।ै 

सब कु् वकसी न वकसी तिीकषे  सषे रवत किता ह,ै तषेज़ी सषे मंडिातषे जुरन ूसषे लषेकि अनावदकाल सषे खडषे जीण्भ  पव्भतों तक, जो अपनषे अवसततव कषे  घटनाक्रम 

में सिकतषे, रिमतिातषे औि अपना िासता बनातषे िहषे हैं।  रवत सब रीज़ो को जोडती ह ैऔि रवत सब रीज़ों को परिरावषत किती ह।ै खासतौि सषे इंसान, इसी 

बात सषे परिरावषत वकए जातषे हैं, वक रवत कषे  ज़रिए वषे वकस तिह सव्ंय को अवरव्यक्त कितषे हैं।   घबिाए हुए सषे लषेकि आक्रामक तक, दबब ूसषे लषेकि अहंकािी 

तक, तंदरुसत सषे लषेकि िोरी तक सरी तिह कषे  मानव सवराव मनुष््य की मुरिाओ ं(पोज़) तथा वक्र्या-कलापों (एक्शंस) द्ािा सव्ंय को प्रसतुत किनषे कषे  

तिीकषे  सषे ही अवरव्यक्त होतषे हैं।  एवनमषेटि कषे  वलए ्यह कहावत वबलकुल उप्ुयक्त ह ै‘‘एक्शन सपीक लाउडि दनै वड््भस (किनी कथनी सषे बलवान होती ह)ै’’। 

हालांवक, सरी एक्शंस व्यवक्त्यों कषे  अपनषे-अपनषे होतषे हैं/ हालांवक वरनन-वरनन व्यवक्त्यों कषे  एक्शंस री वरनन-वरनन हो सकतषे हैं, वकनतु मूवमेंट/रवत की 

वासतववक प्रवक्र्या वववशष्ट वन्यमों तथा वसद्धांतों सषे परिरावषत ह,ै जो अपरिवत्भनी्य/अवडर व साव्भरौवमक हैं। मूवमेंट/रवत कषे  ्यही वसद्धांत वह बुवन्याद हैं, 

वजन पि एवनमषेशन आिारित ह/ैवटकी हुई ह,ै ्यह मूवमेंट राहषे हाथ सषे ड्ॉ की रई हो, वमट्ी में ढाली रई हो ्या कमप्यटूि सषे जषेनिषे ट की रई हो। एनीमषेवटड 

एक्शन का वनमा्भण वववरनन मुरिाओ ंकी एक शृंखला कषे  तषेज़ औि वनिनति प्रसतुतीकिण सषे रवत का भ्रम पदैा किकषे  वक्या जाता ह।ै  एवनमषेशन का असली 

िाज़ हि मूमेंट/क्ण को इस तिह सषे पोज़ीशन किनषे/िखनषे में व्पा ह,ै वक दषेखनषे वालों को ्यह भ्रम वासतववक, प्ररावपणू्भ  औि ववश्वास किनषे ्योग्य/मुमवकन 

पात्रों सषे सिाबोि लरषे। ्यह सर में इतना ही सिल ह,ै औि सर में इतना ही कवठन!

इन कई वषकों कषे  दौिान एवनमषेशन नषे सव्ंय री अपनषे कई वसद्धांत परिरावषत कि वलए हैं। ्यद्वप इनमें सषे अविकांश वसद्धांत एवनमषेशन कषे  पिमपिारत 2D 

जरत सषे उपजषे हैं, मूवमेंट की अविकांश परिराषा्यें, शबदाववल्यां तथा वसद्धांत एवनमषेशन की सरी शाखाओ ंपि लार ू वकए जा सकतषे हैं। 2D तथा 3D 

एवनमषेशन कषे  ववरारों में इनमें सषे कई वसद्धांतों पि अविक वववशष्ट रूप सषे ररा्भ  की जाएरी, लषेवकन ्यहां इन दोनों कषे  ततवों तथा घटकों पि एक समीक्ा की 

जाएरी। ्यषे वसद्धांत हैं: 

1. सक्वशै एंड सट्षेर 

2. एंटीवसपषेशन 

3. सटषेवजंर 

4. सट्षेट अहषेड एक्शन तथा पोज़-टु-पोज़ एक्शन किना 

5. फॉलो-थ् ूऔि ओविलवैपंर एक्शन 

6. ईज़ इन एंड आउट (्या सलो इन एंड आउट) 

7. आक्स्भ 

8. सषेकें डिी एक्शन 

9. टाइवमंर 

10. अवतश्योवक्त 

11. सॉवलड ड्ॉइंगस

12. अपील/आकष्भण  

यूरनट ्ेक उद्ेशय  
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सकिशै एंि सट्चे

्यह एक्शन कैिषे क्टि कषे  मूव किनषे पि, उसमें वषेट/वज़न तथा वॉल्यमू/ववसताि होनषे का भ्रम किाता ह।ै संवाद एनीमवैटक किनषे तथा राव-रंवरमाएं िरनषे में 

री सक्वशै एंड सट्षेर उप्योरी होता ह।ै सक्वशै एंड सट्षेर वकस हद तक उप्योर वक्या जा्यषेरा, ्यह इस बात पि वनर्भि किता ह,ै वक एवनमषेवटंर दृश्य की मांर 

क््या ह।ै आमतौि पि ्यह वपक्रि की शॉट्भ  सटाइल/लघु शलैी में व्यापक होता ह ैऔि वकसी 

फीरि में अपषेक्ाकृत सौम्य/सकू्म। वकसी बॉल कषे  उ्लनषे/बाउंस होनषे सषे लषेकि वकसी रलतषे 

हुए व्यवक्त कषे  शिीि कषे  वज़न तक, ्यह कैिषे क्टि एवनमषेशन की हि फॉम्भ  में प्र्योर होता ह।ै ्यह 

काफी महतवपणू्भ  अव्यव ह,ै वजसमें आपको दक्ता हावसल किनी होरी औि ्यह अक्सि 

प्र्योर होरा। 

• उदाहिण कषे  वलए – बॉल का उ्लनषे (टकिा कि) कषे  दौिान सपाट हो जाना।

• राव-रंवरमा – मुसकुिानषे कषे  दौिान राल रींरना/वपरकाना
तित्र 2.1.1: ्क्वै श एंि ्टे्ि

तित्र 2.1.2: एंटीतसपेशन/पूिाटिनुमान के उदाहरण

्कीज़:

• वॉल्यमू कांसटेंट

• वववरनन वसतुएं वरनन-वरनन प्रवतवक्र्या दषेती हैं

• ववकृत किनषे की ज़रूित नहीं

• फासट एक्शन सषे वझलवमलाहट को हटानषे कषे  वलए सट्षेवरंर का उप्योर किें

पदर्त:

• वॉल्यमू को संिवक्त िखनषे कषे  वलए सकषे ल का उप्योर कि सकतषे हैं (एक डा्यमेंशन में ‘अप’ औि दूसिी में ‘डाउन’)

एंटीरसपेशन

्यवद कोई एक्शन अपनी मूवमेंट्स तथा पोवज़ज़ में ऊजा्भ  सषे रिपिू ह,ै तो एंवटवसपषेशन प्रवक्र्या महतवपणू्भ  हो जाती ह।ै एंटीवसपषेशन का वन्यम कहता ह,ै वक 

्यवद वकसी वसतु को आरषे की ओि जाना ह ैतो इसषे पहलषे थोडा पी ष्े  जाना होरा। ्या दाई ंओि मूव किनषे सषे पहलषे, इसषे थोडा बाइयं  ओि मूव किकषे  इसषे एंवटवसपषेट 

किना रावह्यषे। इसी तिह, ्यवद वकसी कैिषे क्टि को ऊपि की ओि उ्लना ह,ै तो इसषे पहलषे थोडा नीरषे की ओि झुकना होरा। 

जसैषे कोई कैिषे क्टि ्यवद वकसी िससी सषे नीरषे लटकता ह,ै तो नीरषे की ओि इस बडषे एक्शन की प्रत्याशा में वह पहलषे इसषे थोडा ऊपि उठाता ह।ै

एंटीवसपषेशन हमषेशा प्रमुख एक्शन को एक महतवपणू्भ  ववषमता प्रदान किता ह।ै ्यह दश्भकों को ऐसा ववश्वास वदलाकि, उनसषे वठठोली किता ह,ै वक कोई 

वसतु  ्या वकिदाि उस वदशा में मूव कि िहषे हैं/जा िहषे हैं, जबवक वषे अनतत: ववपिीत वदशा में जा िहषे होतषे हैं। इस तिकीब सषे मूवमेंट की असल वदशा में औि री 

िोमांर आ जाता ह।ै

एंटीवसपषेशन की टाइवमंर री महतवपणू्भ  ह।ै सवपोत्तम एंटीवसपषेशन करी-करी आश्च्य्भजनक रूप सषे बहुत तषेज़ी सषे हो जाती ह,ै लषेवकन करी-करी उतनी ही 

िीिषे । कई बाि आपनषे दषेखा ह,ै वक कोई काटू्भन कैिषे क्टि, ्यों ही अनमनषे ढंर सषे बषेहद िीिषे -िीिषे  रलता ह,ै वफि अरानक ही तषेज़ी सषे सक्रीन कषे  दूसिी तिफ 

पहंुर जाता ह?ै ्यहां तक वक, करी-करी हमें वह दौडता हुआ री नहीं वदखाई दषेता, बस िंुिलापन ्या सपीड लाइंस, ्या िलू का एक बादल, जो पी ष्े  उठता 

हुआ वदखता ह।ै

सोरें, वक एक कैिषे क्टि सव्ंय को अपनी डषेसक सषे दूि िकषे ल िहा ह,ै जसैा वक नीरषे वदखा्या र्या ह।ै एक्शन का अंत इस तिह होरा, वक वह एंटीवसपषेशन 

मूमेंट कषे  अंत में सलो-इन किषे रा, जहां उसका शिीि आरषे की तिफ मूव किता ह ैऔि उसकषे  पिै कस कि घुमा्यषे हुए वसपं्रर की तिह मुडषे हुए होतषे हैं। उसकषे  
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बाद वह अरानक खुद को, डषेसक सषे दूि, पिैों पि ज़ोि का दबाव डालतषे हुए, पी ष्े  की ओि िकषे लता ह,ै ऐसा कितषे हुए सलोि–आउट किता ह।ै एंटीवसपषेशन 

पोज़ीशन में उसकी सलोइंर सक्वीज़ कषे  रलतषे ्यषे इफैक्ट औि री सशक्त तथा ववश्वसनी्य/्यथाथ्भपणू्भ  हो जातषे हैं, बजा्य वक वह तषेज़ औि तषेज़ रवत बढाता 

हुआ सव्ंय को डषेसक सषे दूि िकषे लता। आवखिकाि, ्यह टाइवमंर तथा एंटीवसपषेशन ही ह,ै वजसकषे  रलतषे ्यह सब इतना बखबूी हो जाता ह।ै

एंटीवसपषेशन कहता ह,ै वक ्यवद वकसी कैिषे क्टि को पी ष्े  की तिफ मूव किना ह,ै तो उसषे पहलषे आरषे की ओि मूव किना होरा।

तित्र 2.1.3

सटरेजंग

जब एक ही ववशाल लोकषे शन सषे कई शॉट सटषेज किनषे हों, तो मैं सबसषे पहलषे उस पिूी लोकषे शन का, सािी वरत्रों कषे  साथ, एक मासटि शॉट सकैर आउट कि 

लषेना पसंद किता हँू। इससषे मैं इसकषे  लषेआउट, आकाि औि रिलषेशनवशप ्या वववरनन सषेवटंगस तथा शावमल वकिदािों सषे पिूी तिह सषे अवरत हो जाता हँू (पषृ्ठ 

276 में ऊपि दी रई वरत्र को दषेखें)। मषेिा मानना ह ैवक एवनमषेशन की सबसषे बडी कमी ्यह ह ैवक एक शानदाि बकैगाउंड वडज़ाइन त्ैयाि वक्या जाता ह ैऔि 

वफि इसमें शलैी, फ्षे वमंर ्या लोकषे शन कषे  बािषे  में सोरषे वबना ही, बस ्यों ही वफरस्भ/वरत्रों को डाल दी जाती हैं। इसी तिह, जब अलर-अलर तिह कषे  शॉट्स 

रावह्यषे हों, तो कैमिा री वबलकुल नीिस ढंर सषे इसतषेमाल कि वल्या जाता ह।ै सब कु् का एक मासटि सकैर पहलषे बना लषेनषे सषे आप दषेख पाएंरषे, वक आप 

वकन-वकन ततवों सषे प्रराव डाल सकतषे हैं। साथ ही, आप उन सरी कैमिा एंरलस पि री रौि कि सकतषे हैं, जो एक ही व्यपूवाइंट सषे, बस एक वाइड शॉट, 

वमड शॉट तथा क्लोज़-अप सषे बषेहति होंरषे। इसषे 3D एवनमषेशन में किना कहीं आसान होता ह,ै क््योंवक जब परिवषेश तथा कैिषे क्टि मॉडल सथावपत हो जातषे हैं, 

आप बस उन कैिषे क्टि को वसथत कि दषेतषे हैं औि कैमिषे  को मुक्त रूप सषे मूव कितषे िहतषे हैं, जब तक हि दृश्य कषे  वलए पिफषे क्ट शॉट न वमल जा्यषे।

तित्र 2.1.4: एंटीतसपेशन कहिा हवै, कक यकद ककसी कवै रेकटर को पीछे की िरफ मूि करना हवै, िो उसे पहिे आगे की ओर मूि करना होगा।
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तित्र 2.1.5

्यवद एक जवटल सषेवटंर में खासतौि सषे बडी संख्या में दृश्यों कषे  वलए एवनमषेशन की जा िही हो, तो मैं सषेट तथा इसकषे  कैिषे क्टिों का एक सािािण काड्भबोड्भ  

कट-आउट वज़्भन री बना सकता हँू। एक्शन दृश्यों की सटषेवजंर तथा फ्षे वमंर कषे  वदलरसप तिीकषे  खोजतषे सम्य ्यह संदर्भ का एक मलू्यवान स्ोत बन जाता 

ह,ै वजसका मैं हि कोण सषे अध्य्यन कि सकता हँू। वकसी लोकषे शन पि न्यषे तथा वक्रएवटव शॉट की खोज कितषे हुए, खासतौि सषे दो ्या दो सषे अविक इंटिैवक्टंर 

कैिषे क्टस्भ कषे  साथ, आपको ज़रूिी वफलम तकनीकें  नहीं रलूनी रावहएं, जसैषे लाइन क्रॉस न किना औि एक्शन की वनिनतिता बना्यषे िखना, इत्यावद

एक ही एक्शन को कई अलर-अलर तिीकों सषे फ्षे म वक्या जा सकता ह;ै अपनषे एक्शन को सटषेज किनषे कषे  अनठूषे  तथा वदलरसप तिीकषे  खोजें।

सट्टे अहेि ्त्था पोज-टू-पोज एरनमेशन

सट्षेट अहषेड एवनमषेशन पहली ड्ॉइंर पि शुरू होती ह ैऔि सीन कषे  अंत तक ड्ॉइंर-दि-ड्ॉइंर रलती ह।ै इस पद्धवत सषे साइज़, वॉल्यमू तथा प्रपोश्भन खिाब हो 

सकतषे हैं, लषेवकन इसमें सहजता तथा न्यापन ह।ै फासट, वाइलड एक्शन इसी वववि सषे वक्यषे जातषे हैं। पोज-टू-पोज एवनमषेशन अविक वन्योवजत तथा राटदेड 

होती ह,ै वजसमें की ड्ॉइंगस (फ्षे मस) पिूषे  सीन कषे  दौिान इंटिवषेलस में होती हैं/की जाती हैं। इस तिीक सषे साइज़, वॉल्यमू तथा प्रपोश्भन पि बषेहति वन्ंयत्रण 

िहता ह,ै औि उसी तिह एक्शन पि री। लीड/प्रमुख एवनमषेटि रावटयंर तथा कीज़ अपनषे सहा्यक/अवससटेंट को सौंप दषेरा। इस पद्धवत में सहा्यक का बषेहति 

उप्योर वक्या जा सकता ह,ै इसवलए एवनमषेटि को सीन में हि ड्ॉइंर खुद ड्ॉ नहीं किनी पडती। इस तिह एवनमषेटि कई सीन कि सकता ह ैऔि एवनमषेशन 

की पलावनंर/वन्योजन पि ध्यान कें वरित कि सकता ह।ै कई दृश्यों में एवनमषेशन की दोनों ही वववि्यों का उप्योर वक्या जाता ह।ै

िॉिो-थू् और ओिरिरैपंग एकशन

जब वकिदाि का शिीि (मुख्य वहससा) रुक जाता ह,ै तो अन्य वहससों की हिकत री उसी कषे  वहसाब सषे रुकना शुरू होती ह,ै जसैषे बाहें, लमबषे बाल, कोट की 

तवन्याँ, ड्षेस, लटकतषे कान ्या लमबी पूं् (्यषे री इसी एक्शन (रुकनषे की वक्र्या) का अनुसिण किनषे हैं)। सब कु् एक साथ ही अरानक नहीं रुक जाता। 

इसषे फॉलो थ् ूकहतषे हैं। ओविलवैपंर एक्शन तब होता ह,ै जब पात्र अपनी वदशा बाल लषेता ह,ै लषेवकन उसकषे  कपडषे ्या बाल पहलषे वाली वदशा में ही मूव कितषे 

िहतषे हैं। पात्र एक नई वदशा में जा िहा ह,ै लषेवकन इस वदशा में उसकषे  शिीि का अनुसिण उसकषे  कपडषे कई फ्षे मस कषे  बाद किना शुरू किें रषे। एवनमषेशन में 

‘‘DRAG’’ का उदाहिण ह,ै वक जब रफूी दौडना शुरू किता ह,ै लषेवकन उसका वसि, कान, शिीि का ऊपिी वहससा तथा कपडषे उसकषे  पिैों का अनुसिण 

नहीं कितषे/ उसकषे  पिैों कषे  वहसाब सषे मूव नहीं कितषे। फीरस्भ में इस तिह का एक्शन काफी बािीकी सषे वक्या जाता ह।ै उदाहिण: जब सनो वहाइट डांस शुरू 

किती ह,ै तो उसकी पोशाक तुिंत ही उसकषे  साथ मूव किना शुरू नहीं किती, लषेवकन कु् फ्षे मस कषे  बाद मूव किना शुरू कि दषेती ह।ै लमबषे बाल तथा 

जानविों की पूँ्ों को री इसी तिह सषे हैंडल वक्या जाता ह।ै ड्ैर औि ओविलवैपंर एक्शन की प्ररावशीलता में टाइवमंर की बषेहद महतवपणू्भ  रवूमका ह।ै

उदाहरण ्ेक रिए:

• बॉल फें कता हुआ हाथ, बॉल फें कनषे कषे  बाद री एक्शन में िहता ह।ै

• दिवाज़ा खोलनषे जातषे वक्त, आप अरी रल ही िहषे होतषे हैं, औि आपका हाथ दिवाज़षे तक पहँुर जाता ह।ै

्कीज़:

• वरत्रः एवनमषेशन: लीड एवं ड्ैर पवाइंट्स

• अरला एक्शन शुरू होनषे सषे पहलषे रल िहषे एक्शन को पिूी तिह सषे करी री िोकना नहीं रावहए।
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तित्र 2.1.6: ओिरिवैपपंग एकशन

हिकतों/मूवमेंट में लरक/लरीलापन कषे वल वकिदाि की संिरना औि क्मता का ही ववष्य नहीं ह।ै सकैें ड्ी ऑबजकै्ट्स, जसैषे कपडषे, बाल ्या प्रॉपस, की 

मूवमेंट सषे जुडषे  घटक एक्शन को अविक वासतववकता प्रदान कि सकतषे हैं। उदाहिणाथ्भ , जब लमबषे बालों वाला कोई कोई अपना वसि घुमा/घुमाता ह,ै तो 

बालों की रवत में वकसी न वकसी प्रकाि का ववरूपण ्या ववलंब अवश्य होरा। (TV एंकि कषे  मामलषे को ्ोड कि, क््योंवक उनकषे  बाल हषे्यि सप्रषे सषे वबलकुल 

सषेट वक्यषे हुए होतषे हैं/वरपका्यषे हुए होतषे हैं।) सामान्यत:, जब वसि घमूता ह,ै तो बाल कु् पल बाद ही हिकत में आतषे हैं। वफि, जब वसि का घमूना रुक जाता 

ह,ै तो बाल उनका अनुसिण तो कितषे ही हैं, बवलक अविकति वसि कषे  वसथि अवसथा में आ जानषे कषे  बाद री उनमें मूवमेंट ज़ािी िहती ह ैऔि अनतत: वषे री 

वसि की पोज़ीशन में ही सषेटल हो जातषे हैं, जसैषे वबलकुल नीरषे वाली आकृवत में वदखा्या र्या ह।ै बाल वजतनषे अविक लमबषे, ढीलषे औि लरीलषे होंरषे, उनमें 

आरषे-पी ष्े  होनषे का, िीिषे -िीिषे  कम होता एक्शन उतना ही अविक होरा। । ्यह ओविलवैपंर एक्शन कषे  नाम सषे जाना जाता ह।ै

्यहां पात्र का वसि तथा शिीि की मूवमेंट बस अरी-अरी बंद हुई ह,ै लषेवकन एक फल्यडू, ओविलवैपंर मूवमेंट कषे  प्र्योर सषे बालों का झलूना (वसवंर किना) 

औि वफि सषेटल होना ज़ािी िहता ह।ै इससषे दृश्य अविक सजीव तथा वासतववक लरता ह।ै

तित्र 2.1.7 (a) कवै रेकटर मूव्ज़

ओविलैंवपंर एक्शन पोशाक पि री होता ह।ै वफि वही बात ह,ै वक कैिषे क्टि कषे  कपडषे री उसकषे  शिीि की रवत कषे  साथ ही तुिंत वसथि हो जाएं, ्यह बषेहद 

अवासतववक लरषेरा। एक सटीक उदाहिण ्यहां दषेखें, सोरें वक लमबा, लहिाता हुआ कोट पहनषे कोई वकिदाि रार िहा ह,ै जसैषे नीरषे वदखा्या र्या ह।ै जब 

तक पात्र रवत में ह,ै कोट उसकषे  पी ष्े  लहिाता िहषेरा। हालांवक, जब पात्र रुक जाता ह,ै कोट दौड की ही वदशा में मूवमेंट किना ज़ािी िखता ह,ै सव्ंय को 

पात्र कषे  रािों ओि लपषेटता ह ैऔि आरषे को झलूता ह,ै वफि पी ष्े  होता ह ैऔि अनतत: वसथि पोज़ीशन पि सषेटल हो जाता ह।ै
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्यहां पात्र कषे  कदमों की मूवमेंट कषे  साथ उसकषे  रोरषे में पड िहषे वखंराव पि रौि किें । वफि जब पात्र आरषे की मूवमेंट िोकता ह ैऔि अरला कदम बढानषे की 

त्ैयािी किता ह,ै तो ्यह इकट्ा हो जाता ह।ै

ओविलवैपंर एक्शन प्रॉपस कषे  साथ री हो सकता ह।ै जसैषे कोई पात्र जाती हुई ट्षेन में वकसी की तिफ रुमाल वहला िहा ह।ै लहिाता हुआ हाथ, जब नीरषे आता 

ह,ै तो रुमाल री इसकषे  पी ष्े  ड्ैर होरा। हालांवक, जब हाथ वफि सषे उठता ह,ै रुमाल तब री नीरषे की तिफ ड्ैर होता ह,ै रुरुतव कषे  प्रराव औि हाथ कषे  आवषेर 

की वजह सषे। वफि, जब हाथ दोबािा नीरषे की ओि आता ह,ै तो रुमाल इसषे पी ष्े  ्ोड दोबािा ऊपि की ओि उठता ह,ै हमषेशा हाथ कषे  एक्शन सषे एक कदम 

पी ष्े , औि इसी तिह सषे आरषे री। कोडषे माितषे वक्त कोडषे पि औि घोडषे कषे  दौडतषे वक्त उसकी पूं् पि री ्यही ओवलवैपंर प्रराव होरा।

इस अविक सकू्म उदाहिण में, ड्म मषेजि कषे  हटै पि हुए हलकषे  सषे ओवलवैपंर एक्शन पि रौि किें ।

तित्र 2.1.9 (c): कवै रेकटर मूव्ज़

तित्र 2.1.8 (b): कवै रेकटर मूव्ज़



1918

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

सिो-आउट और सिो-इन 

ज्यादाति मूवमेंट को अपनषे एक्शन में एक्सषेलषेिषे शन (रवत बढनषे) ्या वडसषेलषेिषे शन (रवत कम होनषे) की आवश्यकता पडती ह,ै क््योंवक वासतव में तो, मशीनों 

कषे  अलावा, कोई री रीज़ समान रवत सषे नहीं रलती। आपको इसकषे  बािषे  में राट्भ-वाइज़ सोरनषे औि एवनमषेशन-वाइज़ पिूा किनषे की ्योग्यता ववकवसत 

किनी होरी। इस प्रवक्या को समझानषे का क्लावसक बाउंवसंर बॉल सषे बषेहति तिीका कोई दूसिा नहीं ह।ै ववश्व का लररर हि एवनमषेशन ट््यटूोरि्यल 

बाउंवसंर बॉल वसद्धांत सषे शुरुआत किता ह।ै हालांवक, जीवन की हि वघसी-वपटी बात/पुिानी पड रुकी बात की ही तिह इस वसद्धांत कषे  शषेष्ठतम मूल्य री 

इसकी पणू्भता औि बात में वनवहत हैं, वक इससषे हि कोई परिवरत होता ह।ै बाउंवसंर बॉल में एक ऐसषे एक्शन - जो वक पहलषे तषेज़ होता ह,ै वफि िीमा पडता 

जाता ह ै- कषे  वषे सरी ततव आ जातषे हैं, वजनहें जाननषे की ज़रूित हि एवनमषेटि को होती ह।ै िबि की इस रेंद में टाइवमंर कषे  राि अन्य घटक - सट्क्रि, शषेप, 

वॉल्यमू तथा फलषेवक्सवबवलटी - री कवि हो जातषे हैं औि साथ ही एक अन्य सबसषे महतवपणू्भ  घटक री, जो सरी रीज़ों की रवत को प्रराववत किता ह,ै रुरुतव।

बाउंवसंर बॉल इफैक्ट, जो वक नीरषे वद्यषे र्यषे वरत्र में समझा्या र्या ह,ै व्याख्या किनषे में आसान ह।ै िबि की रेंद ऊपि उ्ालती ह,ै ्या नीरषे आती ह ैऔि 

ज़मीन सषे टकिा कि ऊपि उ्लती ह,ै वफि नीरषे आती ह ैऔि वफि ज़मीन सषे टकिा कि ऊपि उ्लती ह,ै पि इस बाि पहली बाि वजतनी ऊंरी नहीं, वफि 

नीरषे आती ह,ै ज़मीन सषे टकिाकि उ्लती ह ैऔि अबकी बाि उससषे री कम ऊपि इत्यावद, जब तक वक इसकी सािी ऊजा्भ  खतम नहीं हो जाती औि ्यह 

वसथि नहीं हो जाती। इस सािािण सषे एक्शन में बता्यषे र्यषे वसद्धांत ही एवनमषेशन को काफी हद तक परिरावषत कि दषेतषे हैं।

जब रेंद उ्ाली जाती ह,ै वह हवा में तषेज़ रवत सषे ऊपि की ओि जाती ह,ै वफि िीिषे -िीिषे  हवा में ही बीर में लररर रुक सी जाती ह,ै क््योंवक रुरुतवाकष्भण 

बल इस पि अपना प्रराव डालनषे लरता ह ै(1)। मुवशकल सषे क्ण रि कषे  वलए ही ्यह रुकती होरी, रुरुतवाकष्भण बल इसषे नीरषे की ओि खींर लाता ह,ै औि 

वह री तषेज़ी कषे  साथ। वफि, सखत मदैान सषे टकिा कि (11) रेंद दबती/वपरकती ह ैऔि वफि सषे ऊपि उ्ल जाती ह।ै ्यह पहली बाि वजतनी ऊंरी नहीं 

उ्लती, क््योंवक ज़मीन सषे टकिानषे की वजह सषे इसका कु् वषेर खतम हो रुका होरा, औि रुरुतव इसषे पहली बाि कषे  वजतना ऊपि उ्लनषे ्या एक्सषेलषेिषे ट 

नहीं होनषे दषेरा। ्यह वफि सषे िीमी होकि रुकती ह ै(19) औि वफि तषेज़ी सषे नीरषे की ओि आती ह,ै जहां ्यह टकिा्यषेरी (29) औि वफि सषे उ्ल जा्यषेरी (37), 

दिअसल ऐसा कई बाि होरा औि हि उ्ाल पहलषे सषे कम औि कम होता जा्यषेरा, जब तक वक अनतत: रेंद वसथि न हो जा्यषे।

तित्र 2.1.10: मानक/्टैंििटि बाउंपसंग बॉि

अब राट्भ  में इसषे कैसषे परिरावषत वक्या जा सकता ह?ै सबसषे पहलषे हमें प्रमुख पोज़ीशंस को अलर किना होरा, उ्ाल कषे  उचर तथा वनमन (वहट) वबंदु। रौि 
किें , वक अपनषे उचर वबंदुओ ंपि रेंद पिूी तिह सषे रोल ह,ै लषेवकंन वहट पवाइंट्स पि/ज़मीन सषे टकिातषे 

वक् ़त ववरूवपत ह,ै जसैा वक नीरषे दाई ंओि दषेखा जा सकता ह।ै जब निम िबि की रेंद सखत ज़मीन सषे 

टकिाती ह,ै तो इसका वषेर इसषे एक तिफ सषे दबा कि दूसिी तिफ सषे फैला दषेता ह।ै (्याद िखें, वसतु को 

राहषे वकसी री तिह सषे ववरूवपत वक्या जा्यषे, उसका आ्यतन नहीं बदलता, आ्यतन कषे वल तरी कम 

होता ह,ै जब रीज़ वरि कि फैल जा्यषे ्या वफि टूट जा्यषे।)

ज़मीन सषे टकिानषे पि िबि की रेंद में होनषे वालषे ववरूपण को सक्वशै कहा जाता ह।ै वरत्र 2.1.11 में दशा्भ्या 

र्या ह।ै

तित्र 2.1.11 ्क्वै श
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अब, ्यवद ्यह रेंदबाज़ी की रेंद होती औि ट्मैपोलीन ्या निम घास सषे टकिाती, तो इससषे उलट होता, जसैा आकृवत में दशा्भ्या र्या ह,ै सतह दब जा्यषेरी औि 

रेंद वबलकुल ज्यों की त्यों िहषेरी।

तित्र 2.1.12 बाउपिंग बॉि तहटटंग अ ट्रॅम् पोिीन/एक 
ट्वैमपोिीन को तहट करिी बाउपिंग बॉि

्यवद टकिानषे वाली वसतु सतह, वजससषे ्यह टकिा िही ह,ै सषे कठोि होती ह,ै तो वसतु की बजा्य सतह 

ववरूवपत होती ह/ैदबती ह।ै

अब रेंद कषे  ऊपि जानषे औि नीरषे आनषे की रवत पि ववराि किें । जब बॉल अपनी उचरतम वसथवत सषे नीरषे की ओि आती ह,ै तो ्यह तषेज़ रवत सषे आती ह।ै उस 

उचरतम वसथवत पि अवनवा्य्भ  रूप सषे ्यह तषेज़ी सषे उ्ली हुई रेंद रुकती ह,ै क््योंवक रुरुतव इसषे तषेज़, बुहत तषेज़ ज़मीन की ओि खींरता ह।ै

काटू्भन बनानषे की पुिानी पिंपिा में वसतु कषे  पी ष्े  लंबी िषे खाएं खींरकि रवत दशा्भ्या जाता था (जो ‘‘सपीड लाइन’’ कहलाती थीं) लषेवकन एवनमषेटिों नषे पा्या, 

वक वसतु को उसकषे  एक्शन पाथ में सट्षेर किनषे सषे सपीड का इफैक्ट बषेहति आता ह,ै क््योंवक ्यह उस बलि कषे  जसैा लरता ह,ै जो आप फ्ोज़न लाइव-एक्शन 

वफलम फ्षे म में दषेखेंरषे।

एवनमषेशन को वडसटॉट्भ  किकषे  बलि किनषे कषे  इस प्र्यास को सट्षेर कहतषे हैं। पुिानषे कई काटू्भनों में सक्वशै तथा सट्षेर कषे  प्ररंड/रहन उदाहिण वदखा्यषे जातषे 

थषे, ्यद्वप आज कषे  सम्य में ्यह काफी कम हो र्या ह,ै खासतौि सषे कमप्यटूि सषे बनषे 3D एक्शन कषे  अविक सवाराववक दृवष्टकोण कषे  रलतषे।

सट्षेवरंर वसतु की रवत को दशा्भता ह,ै क््योंवक वसतु उस वदशा में मूव कि िही होती ह।ै

तित्र 2.1.13

तित्र 2.1.14 िेग में कोई बदिाि नहीं

तित्र 2.1.15 बाउंपसंग सीन

्यवद वषेर में कोई बदलाव न हो, तो राट्भ  इस तिह वदखषेरा।

सक्वशै तथा सट्षेर वदखानषे कषे  वलए बॉल में इन वबटवीवनंर किनषे सषे बाउंवसंर सीन अविक 

सवाराववक तथा ववश्वसनी्य लरषेरा।

्यवद रेंद का वषेर एक समान ह ैऔि न बढ िहा ह ैन घट िहा ह ै(जो वक संरव नहीं ह)ै, तो रावटयंर, ऊपि बाएं वद्यषे र्यषे राट्भ  कषे  समान वदखषेरी। लषेवकन सचराई 

्यह ह,ै वक जब रेंद नीरषे की ओि तषेज़ी सषे आ िही ह,ै तो इसकी रवत एक समान नहीं ह।ै ऊपि दाई ं ओि वद्या राट्भ  अविक वासतववक वदखनषे वाली 

इनवबटवीन पोज़ीशंस दशा्भ  िहा ह।ै

ड्ॉइंगस वजतनी अविक होंरी, एक्शन उतना ही िीमा लरषेरा। इसवलए, रेंद जब सबसषे ऊपि हो, तो कई सािी पोज़ीशंस को इस तिह सषे सपषेसड आउट किनषे 

(बिाबि अंति पि लरानषे) सषे इफैक्ट ऐसा आ्यषेरा, वक जसैषे बॉल िीिषे  शुरू हुई औि वफि तषेज़ होती रई, क््योंवक पोज़ीशंस फैल जाती हैं।

्यवद रेंद का वषेर एक समान ह ैऔि न बढ िहा ह ैन घट िहा ह ै(जो वक संरव नहीं ह)ै, तो रावटयंर, ऊपि बाएं वद्यषे र्यषे राट्भ  कषे  समान वदखषेरी। लषेवकन सचराई 

्यह ह,ै वक जब रेंद नीरषे की ओि तषेज़ी सषे आ िही ह,ै तो इसकी रवत एक समान नहीं ह।ै ऊपि दाई ं ओि वद्या राट्भ  अविक वासतववक वदखनषे वाली 

इनवबटवीन पोज़ीशंस दशा्भ  िहा ह।ै

ड्ॉइंगस वजतनी अविक होंरी, एक्शन उतना ही िीमा लरषेरा। इसवलए, रेंद जब सबसषे ऊपि हो, तो कई सािी पोज़ीशंस को इस तिह सषे सपषेसड आउट किनषे 

(बिाबि अंति पि लरानषे) सषे इफैक्ट ऐसा आ्यषेरा, वक जसैषे बॉल िीिषे  शुरू हुई औि वफि तषेज़ होती रई, क््योंवक पोज़ीशंस फैल जाती हैं।



2120

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

तित्र 2.1.16: एकशन के अंि में अपेक्ाकृि कम इनतबटिींस प्रयोग 
करने से गति धीमी हो जािी हवै।

रेंद जब एक बाि ज़मीन सषे टकिा रुकी हो औि ्यह अरली ऊंरी पोज़ीशन तक उ्लषे, औि ऐसा 

कितषे हुए इसकी रवत िीमी पडती जा्यषे, तो राट्भ  दाई ंओि वद्यषे र्यषे राट्भ  जसैा वदखषेरा। इस बाि, 

इनवबटवीन पोज़ीशंस एक्शन कषे  अंत में इकट्ी हो रई हैं, ्यह सुवनवश्चत किती हुई, वक एक्शन की 

रवत कम होती जाती ह,ै जसैषे-जसैषे ्यह अपनी पिाकाष्ठा/रिम सीमा पि पहँुरना शुरू होता ह।ै

इस पाज़ीशंस सषे एक न्या राट्भ  बना्या जा्यषेरा, जो रेंद को तषेज़ी सषे उसकी अरली वहट पोज़ीशन की 

ओि बढता हुआ वदखा्यषेरा, ्यद्वप, रूँवक, हि उ्ाल कषे  दौिान रेंद की ऊँराई लराताि कम होती 

जा िहा ह ैऔि हि अरला उ्ाल वप्लषे उ्ाल सषे कम सम्य लषे िहा ह,ै इन वबटवींस की कुल संख्या 

हि राट्भ  में कम, औि कम होती रली जा्यषेरी।

टूज़ में एनीमषेट वक्या र्या, नीरषे वरत्र में वदखा्या र्या एक्शन बाउंस/उ्ाल अरानक/एकाएक कटता हुआ वदखता ह ैऔि कु् हद तक इसका हवा में 

मंडिाना री। हालांवक, अरि इसषे वनस पि एनीमषेट किकषे  अविक समूथ बना्या र्या होता, तो मैं 11 सषे 13 औि 27 सषे 29 तक कषे  मूव इन् वबट्वीन डालनषे को 

त्ैयाि न होता, क््योंवक गाउंड सषे सक्वशै पोज़ीशन

औि ऊपि हवा में अरली पोज़ीशन सषे रिज़लटेंट सनपै रेंद में एक मज़बतू वहट कषे  वलए अपषेवक्त रवत/ऊजा्भ  बनाए िखषेरा, जब ्यह ज़मीन पि आएरी।

तित्र 2.1.17: फुि बाउंपसंग इि्टे्शन

तित्र 2.1.18: बाउंपसंग एकशन के तिए फाइनि िाटटि

ऊपि फुल बाउंवसंर इलसट्षेशन पि आिारित औि टूज़ में एनीमषेट की रई, एक पिूी बाउंवसंर सीक्वेंस ऐसषे राट्भ  की जा्यषेरी, जसैषे ऊपि वदखाई रई ह।ै

एवनमषेशन की शबदावली में, एक की पोज़ीशन सषे दूसिी की पोजीशन की ओि एक्सषेलषेिषे ट किती मूवमेंट की रावटयंर को सलोइंर-आउट कहतषे हैं औि एक 

ऐसी मूवमेंट की रावटयंर, वजसमें ऑबजषेक्ट अरली की पोज़ीशन की ओि िीमा पडता जा िहा हो (वडसषेलषेिषे ट), को सलोइंर-इन कहतषे हैं।

आकसटि

वासतववक दुवन्या में लररर सरी एक्शन एक आक्भ  में मूव कितषे हैं। जब एवनमषेशन त्ैयाि की जा िही हो, तो आपको कोवशश किनी रावह्यषे वक रवत कवड्भ  

(वक्र) पाथ का अनुसिण किषे , बजा्य लीवन्यि (िषे खी्य) पाथ कषे । कोई वकिदाि ्या वकिदाि का कोई वहससा एक सीिी िषे खा में शा्यद ही करी मूव किता 
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हो। ्यहां तक वक शिीि की सथलू रवत, जब आप कहीं रलतषे हैं, री पिूी तिह सषे सीिी नहीं होती। जब हाथ/बांह कु् पकडनषे कषे  वलए आरषे बढता ह,ै तो ्यह 

आक्भ  में मूव किता ह।ै सामान्य उदाहिण – रेंद वकक किना 

तित्र 2.1.19: गेंद ककक करना

से्कें िरी एकशन

्यह एक्शन प्रमुख एक्शन को औि री समदृ्ध बनाता ह ैऔि प्रमुख एक्शन को पणू्भता औि/्या बल प्रदान किकषे  कैिषे क्टि एवनमषेशन को औि री ववसताि दषे 

दषेता ह।ै उदाहिण: एक पात्र रुससषे सषे दूसिषे  पात्र की ओि जा िहा ह।ै उसकी राल सशक्त, आक्रामक औि आरषे की ओि झुकी हुई ह।ै टांरों का एक्शन पिैों को 

घसीट कि रलनषे जसैा ह।ै सकैें ड्ी एक्शन, रलतषे हुए वहल िही बाजु़ओ ंसषे कु् सखत राव व्यक्त किनषे जसैा ह।ै ्यह री संरव ह ैवक, राल तथा संवाद को 
अविक सपष्ट किनषे कषे  वलए, उसी सम्य वसि को इिि-उिि वहलाकि डा्यलॉर री वडलीवि वक्यषे 

जा िहषे हों, लषेवकन इतनषे ज्यादा नहीं, वक रलनषे कषे  एक्शन सषे ध्यान बंट जा्यषे। ्यषे सरी एक्शन एक-

दूसिषे  को सपोट्भ  कितषे हुए, एक साथ काम किनषे रावहएं। रलनषे को प्राइमिी एक्शन कषे  रूप में लें 

औि बाजु़एं झलूनषे, वसि वहलनषे तथा शिीि कषे  अन्य एक्शनों को सकैें ड्ी एक्शन कषे  रूप में।

उदाहिण कषे  वलए:

• कॉड्भ  मूवमेंट

• राव-रंवरमा

कीज़

• प्राथवमक एक्शन को समथ्भन/सपोट्भ  दषेतषे हुए होनषे रावह्यषे।

तित्र 2.1.20: कॉिटि मूिमेंट
टाइरमंग

टाइवमंर ही एवनमषेशन का मूलततव/साि ह।ै वकसी रीज़ कषे  मूव किनषे की रवत सषे ्यह पता लरता ह,ै वह वसतु क््या ह,ै उसका वज़न वकतना ह ैऔि वह मूव 

क््यों कि िही ह।ै जसैषे पलक झपकना तषेज़ री हो सकता ह ैऔि िीमा री । ्यवद ्यह तषेज़ झपकती हैं, तो कैिषे क्टि सतक्भ  व सजर लरषेरा। ्यवद ्यषे िीिषे  झपकती 

हैं, तो कैिषे क्टि थका हुआ ्या सुसत लरषेरा।

उदाहिण कषे  वलए: 

वसि जो दाएं औि बाएं घमूता हो। 

• वसि ्यवद बहुत ही िीिषे  आरषे-पी ष्े  घमूता हो: तो ऐसा लर सकता ह,ै वक कैिषे क्टि अपनी रद्भन सट्षेर कि िहा ह ै(कई सािषे  इन वबटवीन फ्षे मस) 

• थोडा तषेज़ हो तो लरषेरा वक वह ''नहीं'' कह िहा ह ै(कु् ही इन वबटवीन फ्षे मस)। 

• बहुत ही तषेज़, कैिषे क्टि बषेसबॉल कषे  बललषे सषे रोट खानषे पि प्रवतवक्र्या दषे िहा हो (लररर कोई इन वबटवीन फ्षे म 

नहीं)।

तित्र 2.1.21: तसर
अर्तशयोरति

एगज़जैिषे शन हि सम्य वकसी ड्ॉइंर का बषेहद वडसटॉश्भन (ववरूपण) ्या वबलकुल ही अवासतववक वदखनषे वाला वहंसक एक्शन नहीं होता। ्यह मुखाकृवत, 

अवरव्यवक्त, मुरिा ्या िव्ैयषे ्या एक्शन की एक हास्यासपद नकल बनानषे जसैा ह।ै लाइव एक्शन वफलम का एक्शन वबलकुल सही हो सकता ह,ै लषेवकन ्यह 

रूखा औि मशीनी लरता ह।ै फीरि एवनमषेशन में वकिदाि को सवाराववक वदखनषे कषे  वलए ज्यादा खुल कि मूव किना पडता ह।ै ्यही बात राव-रंवरमाओ ं

पि री लार ूहोती ह,ै लषेवकन एक्शन इतना असवाराववक री नहीं होना रावह्यषे, जसैा वकसी शॉट्भ  काटू्भन सटाइल (शलैी) में होता ह।ै राल ्या आँखों की 
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हिकत, ्यहां तक वक वसि घुमानषे में री, ्यवद एगज़जैिषे शन कि वद्या जा्यषे, तो ्यह आपकी वफलम को औि अविक आकष्भक बना दषेता ह।ै अत्यविक नाटकी्य 

तथा कु् ज्यादा ही एवनमषेटषेड होनषे सषे बरनषे कषे  वलए अपनी अच्ी अवररूवर तथा व्यावहारिक ज्ान का प्र्योर किें ।

सॉरिि ड्ॉइंगस

शवैक्क ड्ॉइंर की तिह एवनमषेशन में री ड्ॉइंर का ्यही वसद्धांत लार ूहोता ह,ै वक ड्ॉइंर में वषेट (वज़न), वॉल्यमू सॉवलवडटी तथा वत्रआ्यामी होनषे का भ्रम 

हो। जसैषे आप काटू्भन ड्ॉ कितषे हैं, आप जीवन/अवसततव की पुनरुतपवत्त कषे  वलए रूवढरत तिीकषे  सषे पेंवसल सकैर तथा ड्ॉइंगस का प्र्योर किकषे  ड्ॉ कितषे हैं। 

आप वकिदािों को तीन तथा राि आ्यामों का भ्रम दषेतषे हुए इनहें िंरों तथा हिकतों (मूवमेंट) में परिववत्भत कितषे हैं। सपषेस/रिक्त सथान में मूवमेंट वत्रआ्यामी ह।ै 

रौथा आ्याम ह ैसम्य में हिकत (मूवमेंट इन टाइम)।

अपीि/आ्कषटिण

एक लाइव पिफॉमि में ज़बिदसत आकष्भण होता ह।ै एक एवनमषेटषेड ररित्र मनमोहक/आकष्भक 

होता ह।ै अपीवलंर/आकष्भक एवनमषेशन का तातप्य्भ  कषे वल प्यािा औि मनमोहक होनषे सषे ही नहीं 

ह।ै सरी पात्रों में अपील होनी ही रावह्यषे, राहषे वषे ना्यक हों, खलना्यक हों हास्य हों ्या प्यािषे । 

अपील, वजस अथ्भ में आप इसषे लषेतषे हैं, में समझनषे में आसान वडज़ाइन, सपष्ट ड्ॉइंर तथा व्यवक्ततव 

ववकास शावमल ह,ै जो दषेखनषे वालों का ध्यान खींरषे औि उनकी वदलरसपी बना्यषे िखषे। 

आिंवरक दौि कषे  काटू्भन, दिअसल वकसी प्रमुख ववष्य पि बनी, एक हास्य-श ृंखला होती थी। 

इन वषपो कषे  दौिान वनमा्भता ्यषे समझ रुकषे  हैं, वक फीरि बनानषे कषे  वलए कहानी में एक 

वनिनतिता, पात्र ववकास (कैिषे क्टि वडवलपमेंट) औि पिूषे  वनमा्भण कषे  दौिान आट्भवक्भ  की उचर 

रुणवत्ता की आवश्यकता होती ह।ै कथा वाारन कषे  अन्य रूपों की ही तिह फीरि में री मन 

तथा आँखें, दोनों को बाँिें िखनषे की क्मता होनी रावह्यषे।
तित्र 2.1.22: अपीि/आकरटिण

सक्वशै औि सट्षेर कषे  उप्योर सषे इस वकिदाि को अपषेवक्त वषेट दषेनषे में मदद वमली। फॉलो थ् ूतथा ओविलवैपंर एक्शन कषे  रलतषे उसका पषेट अपनषे ही इनवश्भ्या 

सषे/अपनी ही रवत सषे वहलता -उठता िहता ह,ै औि इसकी मूवमेंट प्रमुख एक्शन की मूवमेंट सषे कु् पी ष्े  िहती ह।ै शषेरिफ कषे  कोट, हटै तथा मू्ों कषे  वलए री 

फॉलो थ् ूप्र्योर वक्या र्या ह।ै सशक्त एंटीवसपषेशन पात्र कषे  उठनषे/िाइज़ की रवत/मूवमेंट को उसकी पिूी ऊँराई तक जानषे सषे िोकती ह,ै साथ ही, सॉवलड 

ड्ॉइंर कषे  वसद्धांत तथा अपील री इस समदृ्ध एवनमषेटषेड सीक्वेंस में ज़ावहि होतषे हैं।
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यूरनट 2.2: िाइि ड्ॉइंगस: मानि शरीर रचना रिज्ान ्का आधारभू्त रसदां्त

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. मानवी दषेह कषे  रठन, राव, वक्र्या-कलाप/एक्शन तथा अवरव्यवक्त्यों की लाइफ ड्ॉइंर (वकसी इंसान को दषेखकि उसका वरत्र बनाना) कीवज्यषे।

2.2.1 भाि-भंरगमा
हाइिाकशी/पदक्रम में सबसषे पहलषे आता ह,ै इंसान का रषेहिा, वजस पि आँखें सबसषे पहलषे जाकि वटकती हैं: ्यवद वकसी कृवत में रषेहिा नज़ि आ िहा ह,ै तो जो 

रीज़ हम सबसषे पहलषे दषेखतषे हैं, वषे हैं उसकी अवरव्यवक्त्यां।  दषेह हमािषे  वक्र्या-कलापों को अवरव्यक्त किती ह,ै लषेवकन रषेहिा हमािषे  आंतरिक जीवन का दप्भण 

होता ह ैऔि वकसी वकिदाि में इसी आंतरिक जीवन की अवरव्यवक्त एक कुशल, पनैी नज़ि वालषे आवट्भसट (्या लषेखक) औि एक रावशनू्य आवट्भसट कषे  बीर 

अनति पदैा किती ह।ै

यूरनट ्ेक उद्ेशय  

तित्र 2.2.1: भाि-भंतगमा

आंखें

वसफ्भ  आंखों सषे ही काफी कु् वक्या जा सकता ह।ै पलकों, आँख की पुतली तथा पुतली कषे  बीर वसथत तािषे  (प्यपूल) की पिसपि-वक्र्याएं अवरव्यवक्त में सकू्म 

वकनतु वबलकुल सपष्ट अनति पदैा किती हैं, क््योंवक आँखें ही रषेहिषे  पि ध्यान का मुख्य कें रि होती हैं। आँखें पिूी अवरव्यवक्त में प्रमुख होती हैं, इसवलए बाकी 

रीज़ों पि ध्यान दषेनषे सषे पहलषे सुवनवश्चत कि लें, वक आँखें वबलकुल सही हों। 
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तित्र 2.2.2: भौंहें

रौंहें बषेहद संवषेदी होती हैं। मुझषे लरता ह,ै वक रौंहों में ला्या र्या मामूली सा बदलाव री उस अवरव्यवक्त में बदलाव लषे आता ह,ै जो मैं ड्ॉ कि िहा होता हँू। 

अपनषे उद्धषेश्य कषे  अनुसाि हम रौहों को दो वहससों में बांट सकतषे हैं, जो अि्भ-सवतनत्र रूप सषे रवत कि सकें : वसिा औि वक्र।

मुँह

अवरवव्यवक्त कषे  वलए आँखों कषे  क्षेत्र कषे  बाद आता ह,ै मँुह का क्षेत्र। होंठों की वसथवत (औि वडंपल, दांत....इत्यावद अवतरिक्त अवरव्ंयजक वववशष्टताओ)ं की 

ववसततृ जानकािी आपको इमोशन ट्ी कषे  रीति वमल जा्यषेरी, लषेवकन ्यहां मँुह कषे  आकाि कषे  ववष्य में ररा्भ  की रई ह,ै जो हिषे क होंठ कषे  वक्र कषे  सं्योजन 

सषे बना्यषे जातषे हैं।

1. दोनों होंठ ऊपि की ओि मुडषे हुए: वखवस्यानी हँसी, सामान्य खुशी (खुलषे) वाला मँुह का आकाि

2. ऊपिी होंठ नीरषे औि वनरला होंठ ऊपि की ओि मुडा हुआ: कु् ज्यादा ही खुश - मँुह सामान्य सषे अविक खुला ह,ै शा्यद वरललानषे कषे  वलए।

3. दोनों ओठों नीरषे की ओि झुकषे  हुए: वनिाशा, र्य (वकनािषे  वशवथल हैं, लषेवकन वनरला होंठ वषेदना सषे ऊपि को ठषेलता हुआ)। 

4. ऊपिी होंठ नीरषे को मुडा हुआ, वनरला ऊपि की ओि, लषेवकन इस बाि ऊपिी वहससा बडा ह:ै वववसमत/अवाक दोनों होंठ वशवथल पडषे/लटकषे  हुए हैं।

5. ऐसा लरता ह,ै मानों होंठ बीर में आना राहतषे हैं: वकनािों की वजह सषे जो झरडें में उठषे  हुए हैं: ्यह रुससषे में खुला हुआ मँुह ह।ै

ना्क

नाक बहुत ज्यादा अवरव्यक्त किनषेवाला अंर नहीं होता ह,ै लषेवकन कु् रावों (रुससा, िोना, घणृा, उत्तषेजना) में ्यह री फूलती/फैलती हैं औि बषेहद रुससषे ्या 

घणृा सषे मूल/बषेस सषे वसकुड री जाती ह।ै

तित्र 2.2.3: हरोंठरों की हरकि
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भािनाएं 

शां्त चेहरा 

इसमें नाक-नक्श की वसथवत क्वैतजी्य होती ह ैऔि इसमें कु् री बहुत अविक नहीं होता - रषेहिा ववरूवपत 

नहीं होता।

आश्चयटिचर्क्त चेहरा 

्यह शषेष की तुलना में एक ्ोटा क्षेत्र ह,ै क््योंवक आश्च्य्भ आमतौि पि अन्य रावों कषे  साथ शावमल होता ह,ै 

लषेवकन ्यहां हम वसफ्भ  ''शुद्ध'' आश्च्य्भ की बात कि िहषे हैं, न सकािातमक न नकािातमक। इसकी कुल वमलाकि 

्यह ववशषेषता इसका खुलापन औि रोलाई होती ह:ै पहलषे आँखों की औि वफि बाकी नाक-नक्श की।

तित्र 2.2.4: शांि िेहरा

तित्र 2.2.5: आश्चयटििककि िेहरा

मुस्ुकरा्ता चेहरा 

रषेहिषे  पि नीरषे की ओि उरिनषे वाली मुडवक्यों सषे अवरव्यक्त वववशष्ट राव।

तित्र 2.2.6: मु्कुरािा िेहरा
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क्रोरध्त चेहरा 

इसकी ववशषेषता इसका वसकुडना ह,ै खासतौि सषे रौहों कषे  बीर का क्षेत्र, वजसमें वनमन कु् रावों कषे  तहत सबसषे ज्यादा वशकन आतषे हैं।

उदास चेहरा 

नाक-नक्श कषे  नीरषे की तिफ ढलकषे  होना इसकी ववशषेषता ह।ै रावों की इस पिूी शाखा में कंिों में री कु् झुकाव िहता ह।ै

तित्र 2.2.7: क्ोतधि िेहरा

तित्र 2.2.6: उदास िेहरा

शारीरर्क हाि-भाि

हम वबिलषे ही अपनी रावनाएं कषे वल रषेहिषे  सषे व्यक्त कितषे हैं: हमािी पिूी दषेह ही हमािषे  रावों की अरषेतन अवरव्यवक्त कि िही होती ह।ै इनकषे  प्र्योर सषे आपकषे  

कैिषे क्टि रूखषे/नकली कम औि सवाराववक ज्यादा लरेंरषे। हाथ खासतौि सषे काफी अवरव्ंयजक होतषे हैं औि हाथों की अवरव्ंयजनाओ ं का वजक्र अन्य 

प्रासंवरक अवरव्यवक्त्यों कषे  साथ वक्या र्या ह।ै ्यहां कु् आम तथा प्रवसद्ध/प्ररवलत शािीरिक मुरिाएं दी रई हैं, वजनहें वनवश्चत रूप सषे प्र्योर किना रावह्यषे:
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रन्तंब पर हा्थ:

हथषेवल्यां वनतंब पि, अँरुवल्यां आरषे की ओि, कोवहवन्यां झुकी, बाहि को वनकली हुई

• आतम-ववश्वास का एक उतकृष्ट संकषे त

• दशा्भता ह,ै वक शिीि एक्शन में आनषे कषे  वलए वबलकुल त्ैयाि ह,ै जसैषे काम शुरू किनषे कषे  वलए इत्यावद।

• शिीि कषे  ऊपिी वहससषे का बडा होना/फैलना, वजससषे वह आमना-सामना/मुकाबला होनषे की वसथवत में अविक शवक्तशाली तथा र्यानक लरता ह ै(्या 

जब बचरों को कु् वसखा िहषे हों)।

• इसका ्यह री मतलब होता ह ै‘‘मुझ सषे दूि ही िहो, जानतषे नहीं मैं बहुत बडा रंुडा हँू’’

• ध्यान िहषे, जब अँरठूषे  आरषे की ओि हों, तो ्यह मुरिा अविक व्रि्योवरत् लरती ह ैऔि आक्रामकता की बजा्य अवनवश्चतता का संकषे त दषेती ह।ै

बाहें बँधी हुई:

उतकृष्ट िक्ातमक रूख

• असहमवत, अपना मत न िखनषे का मन बनाना, अहंकाि, नापसंद। मवहलाएं उन पुरुषों कषे  सामनषे बाँहें बाँिषे नहीं िहती, वजनहें वषे पसंद किती हैं।

• सव्ंय को तसलली दषेनषे वाली मुरिा, वरनता ्या सामावजक तनाव कम किनषे कषे  वलए प्र्योर की जाती ह।ै

• कसकि शिीि की ओि वखंरषे हुई बाँहें तथा कोवहनी बषेहद घबिाहट का संकषे त दषेती ह।ै

खुद ्को छूना:

हम अनजानषे ही सव्ंय को तसलली दषेनषे ्या तनाव कम किनषे कषे  वलए अपनषे शिीि को ्ूतषे हैं। अँरुवल्यों सषे होंठों को ्ूनषे का अथ्भ ह,ै व्यगता, असहमवत, 

वनिाशा, अवनवश्चत, हाथ वसि खुजा िहषे हों, रद्भन पकड िहषे हों, इ्यिलोब (कान का वनरला वहससा) पकड िहषे हों, राल मसल िहषे हों, दूसिषे  हाथ की मावलश 

कि िहषे हों इत्यावद। तनाव तथा असहमवत कषे  साथ सषेलफ-मवैनपुलषेशन बढ जातषे हैं ।

• इन संकषे तों कषे  ज़रि्यषे दबषे हुए रुससषे को वदखाना खासतौि सषे एक प्ररावी तिीका ह,ै क््योंवक ्यषे अक्सि रुससा वनकालनषे कषे  तिीकषे  होतषे हैं।

• ्यहां ध्यान दें, वक ्ोटषे बचरषे वसि कषे  पी ष्े  हाथ िखकि ईष््या्भ  व्यक्त कितषे हैं।

एकशन/रक्रया-्किाप

तित्र 2.2.7: शारीररक हाि-भाि
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चरण 1: वववरनन मुरिाओ ंका पता लरानषे कषे  वलए कई ड्ॉइंगस बनाएं। शािीरिक लक्णों/वववशष्टताओ ंपि वनर्भि

चरण 2: अब अपनषे थमबनषेलस लें औि उनहें सामान्य आकाि/नॉम्भल साइज़ तक बलो किें । ्याद िखें, अपनी लाइन ऑफ एक्शन सषे शुरू किें  औि एगज़जैिें ट किनषे की कोवशश 

किें । जो रावना आप व्यक्त किना राहतषे हैं उसषे हमषेशा मन में िखें। वरत्रों/ड्ॉइंगस की ऐसी श ृंखला बनाएं जो दृश्य/सीन की कहानी ब्यां किती हो। 

चरण 3: लाइन ऑफ एक्शन कषे  आस-पास अपनषे कैिषे क्टि पोज़ वनवम्भत किें । अपनी ड्ॉइंगस को लजू़ तथा सपोंटषेवन्यस िखें औि ड्ॉइंगस को एगज़जैिषे ट ्या पुश किनषे की 

कोवशश कितषे िहें। 

चरण 4: अच्ी पोवज़र कषे  सबसषे महतवपणू्भ  ततवों में सषे एक ह,ै िोरक ्ा्यावरत्र। रावना एक गावफक की तिह पढी जानी रावह्यषे - कमिषे , ्या हमािषे  मामलषे में वथएटि कषे  

वबलकुल पी ष्े  सषे री वबलकुल सपष्ट समझ आ्यषे। 
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Rotoscoping अक्सि लाइव-एक्शन मूवीज़ में ववजु़अल इफैक्ट्स कषे  वलए एक टूल कषे  रूप में प्र्योर की जाती ह।ै एक ऑबजषेक्ट को ट्षेस किकषे  आवट्भसट एक 

वसलुएट (वजसषे मटै कहतषे हैं) त्ैयाि किता ह,ै वजसषे उस ऑबजषेक्ट को वकसी अन्य बकैगाउंड पि प्र्योर किनषे हषेतु उस दृश्य में सषे वनकालनषे कषे  वलए प्र्योर 

वक्या जा सकता ह।ै जहां एक ओि, बल ूतथा गीन सक्रीन तकनीकों नषे सीन में सबजषेक्ट्स को लषे्यि किनषे की प्रवक्र्या आसान बना दी ह,ै Rotoscoping 

अब री ववजु़अल इफैक्ट्स इमषेजिी कषे  वनमा्भण में एक अपषेक्ाकृत बडी रवूमका वनराती ह।ै वडवजटल डोमषेन में अक्सि मोशन ट्वैकंर तथा अवन्यन-वसकवनंर 

सॉफ़टवषे्यि Rotoscoping कषे  सहा्यक होतषे हैं। Rotoscoping अक्सि अन्य मटै-पुवलंर प्रवक्र्याओ ंकषे  वलए राबदेज मटै त्ैयाि किनषे हषेतु प्र्योर की जाती ह।ै

Rotoscoping, मटै अथवा िोटोसकोपड लाइन सषे वनददेवशत हो, सपषेवश्यल ववजु़अल इफैक्ट्स (जसैषे गलो/रमक) डालनषे कषे  वलए री प्र्योर की जाती ह।ै पहली 

तीन सटाि वाि मूवीज़ में प्र्योर हुई पिमपिारत Rotoscoping का एक ववख्यात प्र्योर ह,ै जहां ्यह कलाकािों द्ािा पकडी हुई ्वड्यों पि मटै वक्रएट किकषे  

एक रमकदाि लाइटसषेबि इफैक्ट पदैा किनषे कषे  वलए प्र्योर की रई थी। ्यह इफैक्ट हावसल किनषे कषे  वलए इफैक्ट तक्नीवश्यनों नषे प्रत्यषेक फ्षे म कषे  ऊपि प्रॉप 

कषे  ज़रिए एक लाइन ट्षेस की, वफि हि लाइन को बडा वक्या औि गलो एड वक्या।

2.2.2 Rotoscoping

चरण 5:  जब आप लाइन ऑफ एक्शन औि ्ा्यावरत्र एगज़जैिषे ट कि रुकषे  हों, तो अन्य ततव तलाशें, जो रावना को औि सशक्त तिीकषे  सषे अवरव्यक्त कि सकतषे हों। बाल, 

हाथ, पिै (वज़न) औि कपडषे आपकी मुरिाओ ंको औि बषेहति बना सकतषे हैं।
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यूरनट 2.3: एरनमेशन रनमाटिण प्ररक्रया 

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. प्रोडक्शन/वनमा्भण की अविािणाओ ंऔि हि प्रोजषेक्ट कषे  वलए उनकी उप्योवरता की व्याख्या किनषे में।

2. ऑबजषेक्ट्स को एनीमषेट किनषे हषेतु उपलबि वववरनन तकनीकों की जानकािी में।

3. बौवद्धक संपदा अविकािों की वववषेरना किनषे में, अंवतम उतपाद, एलीमेंट्स/ततव, आट्भवक्भ  सुवनवश्चत किनषे कषे  वलए।

2.3.2 पूिटि-रनमाटिण ्कायटि (प्री-प्रोिकशन)

2.3.1 पररचय
एवनमषेशन एक मीवड्या सटषेपल ह ै(एनीमषेश मीवड्या में बषेहद आम ह)ै टीवी दषेखतषे हुए, कोई मूवी दषेखतषे हुए ्या कोई वषेबसाइट वववजट कितषे हुए, एवनमषेशन सषे 

आपका पाला पडषेरा ही। करी ्यह कषे वल एक शबद होता ह,ै जो वकसी वषेबपषेज पि मूव किता वदखाई दषेता ह।ै करी ्यह एक काटू्भन म्ली होती ह,ै जो बचरों 

को सपषेवलंगस वसखा िही होती ह।ै करी-करी वकसी महाकाव्य/पौिावणक ्ुयद्ध रल िहा होता ह ैऔि ्ुयद्ध में जुटी सषेनाएं इतनी वासतववक लरती हैं, वक 

आपको पता ही नहीं लरता वक ्यषे एवनमषेशन ह।ै 

वसथवत राहषे जो री हो, एवनमषेशन बनानषे की प्रवक्र्या हमषेशा एक ही तिह सषे शुरू होती ह:ै कोई इसषे राहता ह ै औि इसकषे  वलए रुरतान किनषे को री  

त्ैयाि ह।ै 

एवनमषेशन कई प्रकाि की होती हैं औि इनकी लारत कई घटकों पि वनर्भि किती ह।ै मूल्य इस पि वनर्भि किता ह,ै वक वकतना प्रोड््यजू़ किनषे की ज़रूित 

ह,ै वकतनषे लोर प्रोडक्शन में ्योरदान कि िहषे हैं, इसकषे  वनमा्भण में लरनषे वाली प्रौद्ोवरकी वकतनी महंरी ह ैऔि इसमें शावमल लोरों का वनमा्भण कषे  क्षेत्र 

में अनुरव वकतना ह।ै

 इसकषे  बाद आता ह,ै एवनमषेशन वनमा्भण कषे  कई रिणों का संवक्प्त ब्यौिा औि साथ ही, कौन-कौन सी बातें लरनषे वालषे सम्य औि लारत पि प्रराव डालेंरी।

प्रोडक्शन कषे  असल में शुरू होनषे सषे पहलषे कई कदम उठा्यषे जातषे हैं। इस ''समस्या-समािान'' रिण को प्री-प्रोडक्शन कहा जाता ह।ै एक पिूा उद्ोर ह,ै जो 

इन रिणों को समवप्भत को समवप्भत ह/ैजो ्यही काम किता ह,ै रूंवक, एवनमषेशन (औि वफलम-मषेवकंर) कला का एक लमबषे सम्य तक रलनषे वाला औि महंरा 

रूप ह।ै कहावत ह ैवक ‘‘सम्य ही पसैा ह’ै’। 

यूरनट ्ेक उद्ेशय  

परर्कलपना/आइरिया: उममीद किें , वक ्यह अच्ा हो!  आमतौि पि, व्यवक्त अपनषे आइवड्या कषे  वलए 

एवनमषेशन कषे  माध्यम पि तरी वनर्भि किता ह,ै जब इसषे वक्र्यावनवत किनषे का कोई औि तिीका न हो...जसैषे 

वक काउबॉएज़ िाइवडंर डा्यनासॉस्भ/काउबॉएज़ डा्यनासॉि की सवािी कितषे हुए ... एवनमषेशन सषे कु् री 

संरव ह!ै ज़ावहि ह,ै ्यह व्यवक्त कषे  बजट पि वनर्भि किषे रा वक प्रोडक्शन में CG डा्यनासॉस्भ कषे  साथ लाइव 

एक्टि वफलमा्यषे जाएंरषे ्या वफि Flash काटूयंस सषे ही काम रलाना पडषेरा। लरनषे वाला सम्य: आइवड्या तो 

क्ण रि में री आ सकता ह।ै अच ष्े  आइवड्या ववकवसत होनषे में सालों लर सकतषे हैं। लरनषे वाली लारत: 

आइवड्या मुफत होतषे हैं, औि कोई री एकदम सषे उन पि अपना हक नहीं जता सकता/औि कोई री एकदम 

सषे उनका मावलक नहीं बन सकता।  

तित्र 2.3.1: तििार

रसक्र्पट: आमतौि पि, आइवड्या को कारज़ पि एक लषेखक उतािता ह,ै वजसषे वसक्रपट कहतषे हैं। वसक्रपट में सषेवटंगस, कैिषे क्टि एक्शंस, संवाद तथा कैमिा 

फ्षे वमंर कषे  ज़रि्यषे कहानी का वण्भन होता ह।ै इससषे वनददेशक कहानी की जानकािी को सीन तथा शॉट में तोड सकता ह।ै एक सीन (वजसषे एक सीक्वेंस री 

कहतषे हैं) कई शॉट सषे वमलकि बनता ह ैऔि ्यषे सषेवटंर सषे लषेकि कहानी कषे  वकसी कथानक/परिदृश्य तक, कु् री हो सकता ह।ै एक शॉट, वबना वकसी 
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रुकावट कषे  वल्या र्या इकहिा कैमिा कट होता ह।ै लरनषे वाला सम्य: प्रोडक्ट कषे  आिाि पि एक वदन ्या वफि एक सप्ताह। मोशन वपक्रि वसक्रपट में महीनों 

लर सकतषे हैं। लरनषे वाली लारत: आमतौि पि प्रोडक्शन बजट का 5 सषे 10 प्रवतशत िाइवटंर/लषेखन को समवप्भत होता ह।ै

सटोरीबोिटि: अब वसक्रपट को ववजु़अली प्रसतुत किनषे की ज़रूित होती ह।ै इसषे सटोिीबोड्भ  किना सबसषे तीव्र औि सबसषे अविक लारत-प्ररावी प्रणाली होती 

ह।ै सटोिीबोड्भ  एक कॉवमक्स की तिह होता ह,ै इसमें सीक्वेंवश्यल ड्ॉइंगस कषे  कई पनैल सटोिी का खाका त्ैयाि कितषे हैं। ्यहां पि, सीन बलॉवकंर, कैमिा 

मूवस औि ्यहां तक वक कैिषे क्टि की पफपोममेंस की री पहलषे व्याख्या की जाती ह।ै रूंवक एवनमषेशन एक बषेहदखरशीली तथा सम्य लषेनषे वाली प्रवक्र्या ह,ै 

प्रोडक्शन तब तक शुरू नहीं की जाती, जब तक क्लाइंट सटोिीबोड्भ  को अप्रवू/मंज़िू न कि लषे। सटोिीबोवडयंर का पिूषे  प्रोडक्शन कषे  दौिान रलतषे िहना कोई 

असामान्य बात नहीं ह,ै क््योंवक सटोिी में कु् रीज़ें बदली जा सकती हैं। सटोिीबोड्भ  कषे  वबना कु् नहीं वक्या जाता। लरनषे वाला सम्य: 30 सषेकंड कषे  एक 

ववज्ापन में एक सप्ताह ्या इससषे कम सम्य लरता ह ैऔि एक मूवी में महीनों लर सकतषे हैं। लरनषे वाली लारत: प्रवत पषृ्ठ, प्रवत पनैल ्या काम कषे  प्रवत घंटषे 

कषे  आिाि पि शुलक।

तित्र 2.3.2: ्टोरीबोिटि

एरनमेरट्क: जब सटोिीबोड्भ  पिूा हो जाता ह,ै तो अलर-अलर पनैलों को संवाद, संरीत तथा साउंड इफैक्ट्स कषे  साथ एवडट वक्या जाता ह,ै ्यह दषेखनषे कषे  

वलए वक एक मूवी कषे  रूप में इसका प्रवाह कैसा बन िहा ह।ै इसषे एवनमषेवटक कहा जाता ह।ै ्यहां तक री, कहानी में कु् सुिाि ्या बदलाव किना महँरा 

नहीं पडता। एवनमषेवटक फाइनल एवडट कषे  वलए बलवूप्रनट का काम किता ह ैऔि ्यह वनिा्भ रित किता ह,ै वक प्रत्यषेक शॉट कषे  वलए वकतनी वासतववक 

एवनमषेशन प्रोड््यजू़ किनी होरी। लरनषे वाला सम्य: पनैलस त्ैयाि किनषे औि एवडट वनमा्भण में, मात्रा कषे  आिाि पि, कु् वदन सषे लषेकि कई सप्ताह लर 

सकतषे हैं। लरनषे वाली लारत: वफलम कषे  प्रवत सषेकंड/वमनट ्या का्य्भ  प्रवत घंटषे कषे  शुलक पि वनर्भि ह।ै 
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तित्र 2.3.3: एनीमवैरटक

पूिटि-दृशयां्कन (प्री-रिजुअिाइजेशन): इसषे ‘‘प्रीववज’’ री कहा जाता ह।ै ्यह लारत-प्ररावी तकनीक 3D एवनमषेशन, सपषेवश्यल इफैक्ट्स तथा लाइव 

एक्शन वफलम कषे  वलए व्यापक रूप सषे प्र्योर की जाती ह।ै शुरूआत में ही त्ैयाि एलीमेंट्स औि फुटषेज वडवलप ्या शटू किनषे की बजा्य 3D सपषेस में कैमिा 

पोज़ीशंस, टाइवमंर तथा मूवमेंट का सही-सही पता लरानषे कषे  वलए वडवजटल सटैंवडंगस प्र्योर की जाती हैं। कोई री बािा, जो शॉट में आ सकती ह,ै उसषे  

कहीं पहलषे ही वनबटा वल्या जाता ह,ै इससषे पहलषे वक फाइनल प्रोडक्ट में उस पि बषेहद थकाऊ प्र्यास वक्यषे जाएं। लरनषे वाला सम्य: 30 सषेकंड कषे  एक 

ववज्ापन कषे  वलए 2 सप्ताह सषे लषेकि एक महीनषे तक का सम्य लर सकता ह।ै लरनषे वाली लारत: वफलम कषे  प्रवत सषेकंड/वमनट ्या का्य्भ  प्रवत घंटषे कषे  शुलक 

पि वनर्भि ह।ै 

प्रारूप (रिजाइन): इस वबनदु पि प्रोजषेक्ट कषे  वलए एक वसगनषेरि सटाइल ववकवसत की जाती ह।ै प्री-प्रोडक्शन कषे  रिण में वडज़ाइन करी री वक्या जा 

सकता ह ैऔि ्यह कैिषे क्टि सषे लषेकि माहौल, कपडों, प्रॉपस तथा वाहनों तक कषे  वलए की जा सकती ह।ै । राइड्स (कैिषे क्टि बाइबल की ही तिह) वक्रएट 

वक्यषे जातषे हैं, वजससषे आवट्भसट वडज़ाइन पिैामीटस्भ कषे  रीति ही एलीमेंट्स ड्ॉ ्या वडवजटल सकलपट कि सकषे । माहौल का वडज़ाइन सथावपत किनषे तथा 

परिवषेश सषेट किनषे कषे  वलए कॉनसपैच्ुयअल पेंवटंर की जाती हैं। लरनषे वाला सम्य: क्लाइंट द्ािा फाइनल कि वद्यषे जानषे तक ज़ािी िहता ह।ै लरनषे वाली 

लारत: प्रवत पषेज त्थ्य ्या प्रवत पेंवटंर अथवा काम कषे  प्रवत घंटषे कषे  शुलक कषे  आिाि पि 

मॉिरिंग: 2D (सीवमत): सीवमत 2D एवनमषेशन में, कैिषे क्टि कषे  मूल पोवज़ज त्ैयाि वक्यषे जातषे हैं औि वफि उनहें कई पितों वालषे एलीमेंट्स में ववच ष्े वदत वक्या 

जाता ह,ै जसैषे वसि, मँुह, आँखें, बाँहें, टाँरें इत्यावद। ्यषे एलीमेंट्स इस तिह सषे वडज़ाइन वक्यषे र्यषे होनषे रावह्यषे, वक जब इनसषे काम वल्या जा्यषे, तो ्यषे वबलकुल 

सही ढंर सषे ओविलपै/अवतच्ावदत हों, वजससषे 2D आट्भवक्भ  में वासतव में आ्याम नज़ि आएं। 3D: ्यवद प्रोडक्शन में कोई 3D एलीमेंट्स हों, तो उनहें 3D 

सॉफटवषे्यि पकैषे ज कषे  प्र्योर सषे मॉडल वक्या जाना रावह्यषे। मॉडल किनषे कषे  कई तिीकषे  हैं: असेंबल किकषे  ्या मौज़दूा ज्योमटै्ी को न्यषे आकािों में मोलड 

किकषे , वा्यि फ्षे मवक्भ  त्ैयाि किकषे  वफि इसकषे  ऊपि सफदे स वबै किकषे /बुन कि ्या असली सकलपरस्भ को 3D सकैनि सषे सकैन किकषे  आवद...। Stop Motion: 

सटॉप-मोशन कषे  वलए मॉडलस बनानषे कषे  कई तिीकषे  हो सकतषे हैं। कैिषे क्टस्भ कषे  वलए क्लषे (वरकनी वमट्ी) तथा फॉम्भ  की कठपुतवल्यां (पपषेट्स) बनाई जाती 

हैं। इसकषे  बाद फाइनल पपषेट्स पि कपडषे, बाल तथा अन्य दुवन्यावी सामवग्यां जोडी जा सकती हैं। परिवषेश कषे  वलए काड्भबोड्भ  सषे लषेकि बालसा लकडी औि 

कुट्ी (papier mache) तक कु् री प्र्योर वक्या जा सकता ह।ै लरनषे वाला सम्य: ्ोटा-मोटा परिवषेश त्ैयाि किनषे में एक ्या दो सप्ताह लर सकतषे हैं, लषेवकन 

्यवद बडा हो तो एक महीना ्या इससषे अविक री लर सकता ह।ै लरनषे वाली लारत: प्रवत मॉडल ्या काम कषे  प्रवत घंटषे कषे  आिाि पि शुलक।
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2.3.3 प्रोिकशन
जब एक बाि सटोिी त्ैयाि हो जाए, वडज़ाइन पिूषे  हो जाएं औि मॉडलस बन जाएं, तो असल प्रोडक्शन शुरू हो सकती ह।ै ्यह रिण शुरू में िीमा रलता ह ैऔि 

वफि अंत तक पहंुरतषे-पहंुरतषे बहुत तषेज़ हो जाता ह।ै अरि प्री-प्रोडक्शन पि प्या्भप्त ध्यान वद्या र्या हो, तो प्रोडक्शन वनमा्भण कषे  सरी रिणों कषे  दौिान अपनी 

सम्य-सीमा तथा बजट संबंिी अपषेक्ाओ ंपि खिा उतिषे रा।

िआेउट (खा्का)

सीन लषेआउट अपनषे सटोिीबोड्भ  पनैलस पि हलकषे  तौि पि औि अपनषे कॉनसषेपरुअल इलुसट्षेशंस/वरैारिक वरत्रणों पि वनकट रूप सषे आिारित होतषे हैं। 

• 2D: सषेवटंर तथा कैिषे क्टि बलॉवकंर, दोनों कषे  लषेआउट कषे  वलए एक हाथ सषे ड्ॉ वक्या र्या बकैगाउंड प्र्योर वक्या जाता ह।ै एवनमषेशन, बकैगाउंड - जो 

वक बाद में पेंट वक्या जाता ह ै- कषे  पिैामीटि/दा्यिषे  कषे  रीति ही िहती ह।ै 

• 3D: 3D सपषेस में एक कैमिा औि सटैंड-इन-मॉडलस (्या त्ैयाि मॉडलस, ्यवद उपलबि हों तो) व्यववसथत वक्यषे जातषे हैं। एनीमषेटिों कषे  वलए मज़बतू 

कमपोज़ीशन सथावपत किनषे कषे  वलए कैमिा मूवज़ व इसका वहलना-डुलना िोक वल्या जाता ह।ै ्यह रिण आमतौि पि प्रीववजु़अलाइज़षेशन कषे  दौिान 

होता ह।ै 

• Stop Motion: रूंवक, कठपुतवल्यां वासतववक सषेट कषे  रीति मौज़दू होती हैं, इसवलए उनहें वसैषे ही मंवरत तथा प्रकावशत वक्या जाना रावह्यषे, जसैषे वकसी 

लाइव वफलम कषे  वलए वक्या जा्यषेरा। जवटल कैमिा मूवज़ महँरषे हो सकतषे हैं औि इनहें मोशन कंट्ोल वससटम कषे  ज़रि्यषे हावसल वक्या जाता ह।ै जब एक 

बाि कैमिा पाथ त्य हो जाता ह,ै तो कमप्यटूि-वन्ंयवत्रत रिर लाइव कैमिषे  को, एक बाि में एक फ्षे म कषे  वहसाब सषे, मूव किती ह।ै ्यह एक Stop Motion 

सषेट कषे  रीति डा्यनावमक एंरलस उपलबि किाता ह।ै 

रररगंग: 

• 2D (सीरम्त): कैिषे क्टि कषे  अलर-अलर टुकडों मषे बनषे अव्यव (बाहें, टाँरषे इत्यावद) कठपुतली की तिह सषेट किनषे पड सकतषे हैं। उदाहिण कषे  वलए, पिै 

को टाँर कषे  वनरलषे वहससषे सषे जोडा जाता ह,ै वजसषे वफि ऊपिी टाँर सषे जोडा जाता ह ैऔि वफि इसषे पषेडू (पषेवलवस) सषे जोडा जाता ह।ै इन जोडषे र्यषे अंरों में 

रलू/कीला (वपवट पवाइंट) होना रावह्यषे, वजससषे ्यषे उवरत वबनदु पि घमू सकें , िोटषेट कि सकें । 

• 3D: कैिषे क्टि मॉडल जब अवसततव में आ जा्यषे/त्ैयाि हो जा्यषे, तो इसमें हड्वड्यों तथा अन्य रिवरंर वससटम सषेट किनषे की ज़रूित होती ह,ै वजससषे इसषे 

प्र्योर वक्या जा सकषे । ्यह सुवनवश्चत किना वक 3D मषेश वांव्त तिीकषे  सषे बेंड औि फोलड हो, काफी पषेरीदा औि मषेहनत का काम हो सकता ह।ै अन्य 

अव्यव, वजनहें रिवरंर की ज़रूित हो सकती ह,ै वषे हैं मांस-पषेवश्यां, बाल, कपडषे औि आंखें री। Stop Motion: क्लषे ्या फॉम्भ  सषे बनषे कैिषे क्टि को सपोट्भ 

दषेनषे कषे  वलए मुडनषे वाली तािें  ्या मशीन सषे बनषे एल्यवूमवन्यम सकषे लषेटन, वजनहें आमदेरस्भ कहा जाता ह,ै का वनमा्भण वक्या जाता ह।ै कैिषे क्टि कषे  पिैों कषे  

नीरषे आमतौि पि नट्स लरषे होतषे हैं, वजनहें वफि सषेट सषे बोलट कि वद्या जाता ह,ै वजससषे वषे आिाम सषे खडषे हो सकें  औि रलतषे हुए संतुवलत िह सकें । 

लरनषे वाला सम्य: प्री-प्रोडक्शन का ्यह सबसषे पषेरीदा पहल ूहो सकता ह,ै खासतौि सषे जहां बात 3D की हो। सािािण कैिषे क्टिों का ढाँरा (रिर) बननषे 

में लररर एक सप्ताह लरता ह,ै लषेवकन वकसी जवटल कैिषे क्टि कषे  मामलषे में महीनषे रि सषे री ज्यादा सम्य लर सकता ह।ै लरनषे वाली लारत: प्रवत 

मॉडल ्या काम कषे  प्रवत घंटषे कषे  आिाि पि शुलक

टकैसचररंग: 

• 2D: ्यह आमतौि पि सामान्य/एक सा (फलटै) ्या उताि/रढाव (गषेवडएंट) वाला िंर होता ह,ै लषेवकन कु् एवनमषेशन में कई बाि, मॉडलस कषे  अनुरूप 

जवटल टकै्सरि हो सकतषे हैं।

• 3D: वडवजटल मॉडलस कषे  कई टकै्सरड्भ  लुक हो सकतषे हैं। ्यहां तक वक इनका लुक गावफक 2D री हो सकता ह।ै टकै्सररिंर, सॉवलड कलि सषे हैंड-

पेंवटड ्या फोटोगावफक इमषेजिी तक, कु् री हो सकती ह।ै ्यह इमषेजिी, वजसषे मपै कहा जाता ह,ै को वकसी री संराव्य सतह को वसमुलषेट किनषे हषेतु 

3D मॉडल पि प्रोजषेक्ट वक्या जा सकता ह।ै सतह पि प्रकाश की प्रवतवक्र्या (जसैषे प्रवतवबंब औि पािरासी) कैसी िहषेरी, इसषे री टकै्सररिंर द्ािा ही 

वन्ंयवत्रत वक्या जाता ह।ै

• Stop Motion: सटॉप-मोशन पपषेट्स तथा सषेट्स कषे  वलए टकै्सरि आमतौि पि सकलपट वक्या जाता ह ै्या हाथ सषे सीिषे उनहीं पि पेंट वक्या जाता ह।ै

• िगने िािा समय: सािािण टकै्सररिंर, वजसमें बस रंद िंरों का ही काम होता ह,ै कु ष्ेक वमनटों में ही बन जाती ह।ै लषेवकन जवटल टकै्सररिंर, जसैषे 

वासतववक वदखनषे वाली डा्यनासौि की तवरा, बननषे में कई वदन लर सकतषे हैं।

• िगने िािी िाग्त: प्रवत मॉडल ्या काम कषे  प्रवत घंटषे कषे  आिाि पि शुलक।
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• िगने िािा समय: बकैगाउंड की जवटलता तथा कैमिा मूवज़ कषे  आिाि पि कु् घंटों सषे लषेकि कई वदनों तक का सम्य लर सकता ह।ै 

• िगने िािी िाग्त: प्रवत ड्ाइंर ्या प्रवत घंटा का्य्भ  कषे  शुलक कषे  आिाि पि।

एरनमेशन 

• 2D (किारस्कि): जब एक बाि सषेवटंर कषे  रीति कैिषे क्टि की पोजीशन बलॉक हो जाती ह,ै तो की फ्षे म ड्ॉइंगस पिूी हो जाती हैं। ्यषे वषे मुख्य पोवज़ज़ 

हैं, जो कैिषे क्टि कषे  एक्शन कषे  रिम वबंदुओ ं को सथावपत/त्य कितषे हैं। जब इनका सम्य पिूा हो जाता ह,ै तो मोशन को सुरारू बनानषे कषे  वलए 

इनवबटवीनस ड्ॉ वक्यषे जातषे हैं। इस सकषे र वालषे एवनमषेशन को “पेंवसल टषेसट” कहा जाता ह।ै  वफि िफ एवनमषेशन िषे खाओ ंको साफ (स्याही सषे रिना) 

कि वद्या जाता ह,ै पेंट वक्या जाता ह ैऔि उनहें बकैगाउंड कषे  साथ सं्योवजत कि वद्या जाता ह।ै शषेडो व हाइलाइट्स जसैी इफैक्ट्स एवनमषेशन सषे इस 

प्रवक्र्या में काफी सम्य लर सकता ह।ै क्लावसकल एवनमषेशन अपनी व्यापक रवत व तिलता कषे  वलए जाना जाता ह।ै 

• 2D (सीरम्त): वमवनमल ड्ॉइंगस (करी करी वसफ्भ  एक) को वडवजटल रूप में इस तिह सषे बदला जाता ह,ै जसैषे वक क्लावसकल एवनमषेशन की नकल 

हो। कैिषे क्टि कषे  रषेहिषे  पि कई माउथ पोज़ीशंस/मौवखक मुरिाएं वरपकाई जाती हैं औि वलप वसंक पदैा किनषे कषे  वलए इनहें पिसपि बदला जाता ह।ै अलर-

अलर अंरुवल्यां शिीि सषे जोडी जाती हैं, वकसी कठपुतली की तिह औि वफि वकिदाि का अवरन्य/प्रदश्भन त्ैयाि किनषे कषे  वलए इनमें कमप्यटूि में 

हषेि-फषे ि की जाती ह।ै इनवबटवीनस सॉफटवषे्यि में सवरावलत/ऑटोमवैटक ढंर सषे बना वलए जातषे हैं, वजससषे ्यह प्रवक्र्या पिमपिारत प्रवक्र्या कषे  मुकाबलषे 

कहीं अविक तषेज़ हो जाती ह।ै वलवमटषेड एवनमषेशन अपनषे तषेज़ प्रोडक्शन सम्य व लारत-प्ररावशीलता कषे  वलए जानी जाती ह।ै 

• 3D: जब 3D कैिषे क्टि मॉडल रिर हो जाता ह,ै तो एक एवनमषेटि आरासी कठपुतली की तिह इसमें हषेि-फषे ि किकषे  रवत पदैा कि ला सकता ह।ै 3D 

एवनमषेशन में कठपुतली को वन्ंयवत्रत किनषे कषे  वलए XYZ कोआवड्भनषेट व न्यमूषेरिक सलाइडस्भ जसैी तकनीकी अविािणाएं प्र्योर की जाती हैं। मुख्य/

की पोज़ीशंस कषे  बीर में सॉफटवषे्यि द्ािा सवरावलत रूप सषे इनवबटवीनस डाल वद्यषे जातषे हैं। 3D एवनमषेशन अपनी आ्यामी ्वव औि वबलकुल असली 

लरनषे वाली क्वावलटी कषे  वलए जानी जाती ह।ै 

• Stop Motion: वबलकुल जसैषे पिमपिारत एवनमषेशन में एक बाि में एक ही फ्षे म ड्ॉ की जाती ह,ै Stop Motion पपषेट ्ोटी-्ोटी बढत सषे रलती ह ैऔि 

एक बाि में एक ही फ्षे म शॉट किती ह।ै रूंवक, ्यह तकनीक असल दुवन्या की रौवतकी की सीमाओ ंमें बंिी ह,ै वासतववक रौवमकी सषे जुडी ह,ै अक्सि 

वकसी रिवरंर ्या वा्यि को हटाना ज़रूिी हो जाता ह,ै जो वकिदाि को रुरुतवाकष्भण की उपषेक्ा किनषे वालषे एक्शन कि पानषे में मदद कितषे हैं।

• िगने िािा समय: आवखिकाि, मोशन कषे  वजतनषे ज्यादा फ्षे म होंरषे, एवनमषेशन को पिूा होनषे में उतना ही सम्य लरषेरा। ्यहां तक वक लारत-सक्म 

एवनमषेशन प्रोडक्शन का सबसषे ज्यादा सम्य लषेनषे वाला वहससा हो सकती ह।ै 

• िगने िािी िाग्त: आमतौि पि वफलम कषे  प्रवत सषेकंड शुलक कषे  आिाि पि होती ह,ै हालांवक, वलवमटषेड 2D एवनमषेशन प्रवत ड्ॉइंर कषे  आिाि पि री 

हो सकती हैं

रें िररंग 

िें डरिंर का मतलब कमप्यटूि कषे  जरिए वडवज़टल फ्षे मस बनाना ह।ै रलषे ही ज्यादाति वीवड्यो-मीवड्या सॉफटवषे्यि में वकसी न वकसी तिह की िें डरिंर की 

ज़रूित पडती ह,ै मरि इस ववरार का तातप्य्भ  वववशष्ट रूप सषे 3D एवनमषेशन की िें डरिंर सषे ह।ै ्यह रिण इस बात पि वनर्भि कितषे हुए जलदी सषे हो सकता 

ह,ै वक फाइनल इमषेज बनानषे कषे  वलए कमप्यटूि को वकतनी रणनाएं किनी पडेंरी। रािी प्रवक्र्याओ ंकषे  वलए, कमप्यटूिों सषे रिी पिूी की पिूी वबवलडंरें होती 

हैं वजनहें िें डि फामस्भ कहतषे हैं। ्यह असामान्य बात नहीं ह ैवक हाई-डषेवफनषेशन 3D एवनमषेशन कषे  एक अकषे लषे फ्षे म को बनानषे में एक हफतषे सषे री ज्यादा का 

सम्य लर जाता ह।ै 

• िगने िािा समय: सषेकंडों सषे लषेकि हफतों तक कु् री, जोवक इस बात पि वनर्भि ह ैवक 3D सीन की रणना वकतनी जवटल ह ै्या त्ैयाि इमषेजषेस 

वकतनी बडी हैं। 

• िगने िािी िाग्त: प्रवत GHzh शुलक पि वनर्भि ह।ै

2.3.4 पोसट – प्रोिकशन
जब एवनमषेशन िें डि औि वफलम वपं्रट हो जाती ह,ै तो ्यह वफवनवशंर टर कषे  वलए त्ैयाि हो जाती ह।ै ्यह सपषेवश्यल इफैक्ट्स सषे लषेकि इमषेज इनहांसमेंट औि 

कलि किैक्शन तक कु् री हो सकता ह।ै फाइनल साउंड व म्यवूजक री इसी रिण का एक वहससा हैं।
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इिैकट्स

रलषे ही ्यह ख्याली िलू हो, एक रमकती तलवाि ्या एक पिमाणु ववसफोट, सपषेवश्यल इफैक्ट्स अववश्वसनी्य को हकीकत जसैा बना सकतषे हैं। हालांवक, 

ज्यादाति इफैक्ट्स आमतौि पि सािािण ही होतषे हैं; जसैषे वक एक ्ोटषे सषेट को ववसताि दषेना वक वह रव्य वदखषे ्या वदन में वक्यषे र्यषे शटू में िात का सम्य 

वदखाना। 2D एवनमषेशन में, आर, िुएं व पानी जसैषे ततव इफैक्ट्स मानषे जातषे हैं, लषेवकन ऐसषे ही बुवन्यादी शषेडो व हाइलाइट्स री हैं। इफैक्ट्स आमतौि पि 

कमपोज़ीवटंर कषे  साथ-साथ ही डालषे जातषे हैं।

• िगने िािा समय: कई बाि 2D एवनमषेशन इफैक्ट्स ,उससषे री कम सम्य में ड्ॉ, इंक औि कलि वक्यषे जा सकतषे हैं, वजतना सम्य 3D इफैक्ट्स को 

सषेट अप तथा िें डि किनषे में लरता ह।ै ्यह वाकई में इस बात पि वनर्भि किता ह ैवक इफैक्ट्स वकतनषे जवटल हैं औि उनमें सषे वकतनों को बनानषे की 

ज़रूित ह।ै 

• िगने िािी िाग्त: वफलम की प्रवत सषेकंड ्या का्य्भ  कषे  प्रवत घंटषे शुलक पि वनर्भि ह।ै

्कमपोज़ीरटंग

कमपोज़ीवटंर, आवखिकाि, कई अलर-अलर इमषेजषेस की एक त्ैयाि कमपोज़ीशन में लषे्यरिंर किना ह।ै हालांवक, इसमें बहुत सी रीज़ें शावमल हैं। गीन 

सक्रीन रिमूवल, िोटोसकोप मावसकंर तथा कलि किैक्शन वषे कु् काम हैं, जो कमपोज़ीवटंर सटषेज कषे  दौिान वक्यषे जातषे हैं। राहषे आपको प्रारीन रीन कषे  

एक शॉट में सषे Volkswagen हटानी हो ्या हाई-डषेवफनषेशन फुटषेज को 1930 कषे  दशक की श्वषेत-श्याम (बलकै एंड वहाइट) वफलम की तिह वदखाना हो, प्रोजषेक्ट 

की फाइनल इमषेज कमपोज़ीवटंर कलाकाि पि वनर्भि ह।ै 

• िगने िािा समय: अच्ी तिह प्रकावशत गीन सक्रीन फुटषेज कषे  सामनषे शॉट वक्यषे र्यषे सबजषेक्ट्स को तषेज़ी सषे मासक आउट वक्या जा सकता है

एरिरटंग

एवडवटंर ्यह सुवनवश्चत किनषे कषे  वलए एनीमवैटक रिण पि शुरू होती ह ैवक शॉट्स फलो एक आकष्भक रवत पि हो। जसैषे-जसैषे प्रोडक्शन आरषे बढती ह,ै एवडट 

को री शॉट्स कषे  प्रीववजु़अलाइज़षेशन सषे िफ एवनमषेशन, वफि फाइनल िें डि औि वफि फाइनल कमपोवज़ट की ओि बढनषे कषे  साथ-साथ लराताि अपडषेट वक्या 

जाता िहता ह।ै इस रिण में ववजु़अलस कषे  साथ साउंड इफैक्ट्स औि म्यवूज़क री सं्योवजत कि वद्यषे जातषे हैं।

• िगने िािा समय: शुरुआत में काफी तषेज़ी सषे होती ह ैमरि वफि री एवडवटंर पिूषे  प्रोडक्शन कषे  दौिान होती िह सकती ह।ै िॉ लाइव फूटषेज कषे  कई घंटों 

को एवडट किनषे में कई महीनषे लर सकतषे हैं। 

• िगने िािी िाग्त: वफलम कषे  प्रवत सषेकंड/वमनट ्या का्य्भ  प्रवत घंटषे कषे  शुलक पि वनर्भि ह।ै

ऑरियो

हालांवक, फाइनल ऑवड्यो पोसट तक नहीं डाला जाता, लषेवकन आमतौि पि असथा्यी साउंड तथा म्यवूज़क, वजसषे सकै्रर ऑवड्यो कहतषे हैं, एनीमवैटक में 

शावमल कि वद्यषे जातषे हैं, वजससषे एवडट कषे  वलए मूड तथा पषेस (रवत) सषेट किनषे में मदद वमलषे। ऐसा कहा जाता ह ैवक साउंड मूवी का आिा वहससा होती ह ै

औि इस क्षेत्र में दक् पषेशषेविों को हा्यि किनषे सषे अंवतम उतपाद की समपननता दस रुणा बढ जाती ह।ै फोलषे कलाकाि साउंड इफैक्ट्स खोजनषे ्या िरनषे कषे  

वलए उत्तिदा्यी होतषे हैं, कंपोज़स्भ म्यवूज़कल सकोि वलखतषे व बजातषे हैं, औि साउंड इंजीवन्यस्भ इन सरी को सामंजस्यपणू्भ  संतुलन में वमवशत कितषे हैं। 

• िगने िािा समय: कोई साउंड वजतनी ज्यादा वनिाली ्या दुल्भर होती ह,ै उसषे खोजनषे ्या बनानषे में उतना ही ज्यादा वक्त लरता ह।ै वलखनषे व  

प्रदश्भन में म्यवूज़क को घंटो सषे लषेकि हफतों तक का सम्य लर सकता ह,ै ्यह कंपोज़ीशन की लंबाई व आवश्यक म्यवूज़वश्यनों की संख्या पि वनर्भि 

किता ह।ै 

• िगने िािी िाग्त: साउंड- प्रवत साउंड ्या का्य्भ  प्रवत घंटषे कषे  शुलक पि वनर्भि होती ह।ै म्यवूज़क- का्य्भ  प्रवत घंटषे कषे  शुलक पि वनर्भि होता ह।ै साउंड 

इंजीवन्यरिंर- का्य्भ  प्रवत घंटषे कषे  शुलक  पि वनर्भि होती ह।ै कु् सषेकंड का अंतिाल तावक आप ्यह बषेहति ढंर सषे जान सकें  वक कहानी जम िही ह ै 

्या नहीं।

2.3.5 ए्क एरनमेशन मीरियम चुनना
एवनमषेशन कषे  ज़रि्यषे कोई री कहानी कही जा सकती ह।ै इसका मतलब ्यह नहीं ह,ै वक हि कहानी एवनमषेशन कषे  जरिए ही कही जाए। ्यह एक सम्य खानषे 

वाली व महंरी प्रवक्र्या ह ैवजसमें सकैडों व्यवक्त शावमल होतषे हैं। इसवलए ्यह सुवनवश्चत कि लें, वक एवनमषेशन ही आपकषे  प्रोजषेक्ट को प्रसतुत किनषे कषे  वलए 

सवपोत्तम ज़रि्या ह।ै 
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एवनमषेशन का माध्यम आमतौि पि तब अपना्या जाता ह ैजब वकसी प्रोजषेक्ट को ववजु़अलाइज़ किनषे का कोई औि ज़रि्या न हो। ्यह तब री आदश्भ ह ैजब 

वकसी एक खास लुक की अखंडता को बिकिाि िखनषे की कोवशश की जा िही हो, जसैषे वक बचरों की वकताब में सवरत्र व्याख्याएं ्या वकसी काटू्भन 

कैिषे क्टि की सनक। जब एक बाि मीवड्यम रुन वल्या जाता ह,ै हालांवक, एवनमषेशन कषे  रीति री कु् शवैल्यां होती हैं, वजन पि ववराि वक्या जाना रावह्यषे। 

्यह लघु मार्भदवश्भका ऐसी जानकािी उपलबि किा्यषेरी, वजससषे कु् अन्य भ्रवमत किनषे वालषे ववकलपी ्ट जाएंरषे।

2D- किारस्कि: जब कोई गावफक लुक पानषे की कोवशश में हो, तो हाथ सषे बनाई ्या क्लावसकल 2D एवनमषेशन आदश्भ ह।ै कैिषे क्टि मोशन व प्रदश्भन 

हावसल किना पिूी तिह सषे कलाकाि पि वनर्भि होता ह।ै रूंवक, मोशन का हिषे क फ्षे म हाथ सषे बना होता ह,ै एवनमषेशन में कुदिती एहसास आता ह ैऔि ्यह 

तकनीकी बािाओ ंकी द्या पि वनर्भि नहीं िहती। क्लावसकल एवनमषेशन कषे  वलए प्रोडक्शन वकसी अन्य सटाइल/शलैी कषे  मुकाबलषे कहीं तषेज़ी सषे शुरू होता 

ह,ै क््योंवक कैिषे क्टि ड्ॉ वकए जातषे हैं, न वक वनवम्भत ्या रिर वक्यषे जातषे हैं। प्रोडक्शन िीमा हो जा्यषेरा, हालांवक, इनवबटवीन, इंक तथा पेंट कषे  रिणों कषे  

दौिान। क्लावसकल एवनमषेशन सम्य खानषे वाली प्रवक्र्या ह ैऔि इसमें कई लोर शावमल होतषे हैं, इसवलए इसषे बनाना महंरा ह।ै 

रिरमटिे: जब वकसी प्रोजषेक्ट का बजट सीवमत होता ह ैऔि इसषे काटू्भनी सटाइल की ज़रूित होती ह,ै तो वलवमटषेड 2D एवनमषेशन आदश्भ ह।ै कलाकािों कषे  

वलए कमप्यटूि सॉफटवषे्यि सवरावलत ढंर सषे इनवबटवीन की रई वसंरल ड्ॉइंगस में हषेि-फषे ि किना संरव बना दषेता ह,ै वजससषे ्यषे क्लावसकल एवनमषेशन का 

आरास दें। क््योंवक ्यह तकनीक पिूी तिह सषे वसंरल ड्ॉइंर कषे  आकष्भण पि वनर्भि किती ह,ै इसवलए व्यवक्तरत कला ततवों पि आमतौि सषे ज्यादा सम्य 

खर्भ होता ह।ै वलवमटषेड एवनमषेशन कषे  वलए प्रोडक्शन क्लावसकल एवनमषेशन कषे  मुकाबलषे काफी िीमषे शुरू होता ह।ै कैिषे क्टिों को आमतौि पि एवनमषेशन शुरू 

किनषे सषे पहलषे इंक, कलि तथा रिर किनषे की ज़रूित पडती ह ैऔि इसमें शावमल कला कषे  वलए ढषेि सािी ्योजनाओ ंऔि आ्योजनों की ज़रूित होती ह,ै 

वजससषे इससषे अविकतम लार हो। जब एक बाि ततव पिूषे  व संरवठत हो जातषे हैं, तो प्रोडक्शन क्लावसकल एवनमषेशन कषे  मुकाबलषे काफी तषेज़ी सषे रलषेरा। 

वलवमटषेड एवनमषेशन में कु् ड्ॉइंगस की ज़रूित पडती ह ैवजनमें वडवज़टल तौि पि हषेि-फषे ि की जा सकती ह,ै इसवलए इसषे बनाना तषेज़ व लारत-सक्म ह।ै 

वकसी री 2D एवनमषेशन की िें डरिंर आमतौि पि 3D कषे  मुकाबलषे काफी तषेज़ी सषे होती ह ैक््योंवक इसमें कोई री जवटल ज्यावमती्य रणनाएं शावमल नहीं 

होती। हालांवक, करी-करी कई 2D इमषेज लषे्यस्भ कमपोवज़ट िें डि को वकसी 3D सीन कषे  मुकाबलषे काफी दषेि तक उलझा सकती हैं।

2.3.6 एरनमेशन ्की ्त्कनी्कें

वसथि इमषेजों कषे  क्रम, जोवक एक दूसिषे  सषे मामूली रूप सषे ही वरनन होती हैं, कषे  तवरित प्रदश्भन कषे  माध्यम सषे मोशन औि आकाि परिवत्भन का भ्रम पदैा किनषे 

की प्रवक्र्या एवनमषेशन ह।ै रावनाओ ंकषे  मुख्य प्रकाि: 

1. ट्षेवडशनल एवनमषेशन

2. 2D Vector आिारित एवनमषेशन

3. 3D कमप्यटूि एवनमषेशन

4. मोशन गावफक्स

5. Stop Motion

6. क्लषेमोशन 

7. कठपुतवल्यां

8. कटआउट्स

9. Silhouette

10. एक्शन वरत्र/लषेरो

11. Pixelation

ट्रेिशनि एरनमेशन 

पिमपिारत एवनमषेशन में, एवनमषेटि, सटैंड पि जुडषे एक पािदशशी कारज कषे  टुकडषे पि िंरीन पेंवसल सषे इमषेजषेस ड्ॉ किें रषे, एक बाि में एक फ्षे म। एवनमषेटि 
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तित्र 2.3.4: टे्तिशनि एतनमेशन

आमतौि पि बहुत िफ कैिषे क्टस्भ कषे  साथ एवनमषेशन का पिीक्ण किें रषे ्यह दषेखनषे कषे  वलए वक 

एक्शन को अच्ी तिह सषे समझानषे कषे  वलए उनहें वकतनषे फ्षे म ड्ॉ किनषे की ज़रूित पडषेरी। 

पिमपिारत एवनमषेशन में, टाइवमंर बषेहद महतवपणू्भ  ह,ै क््योंवक फ्षे मस को साउंडट्कै्स कषे  साथ 

एकदम वफट बठैना होता ह,ै इस तिह पिमपिारत एवनमषेशन की एवनमषेशन प्रवक्र्या लंबी व 

महंरी हो सकती ह।ै जब क्लीन-अप व इनवबटवीन पिूा हो जाता ह,ै तो प्रोडक्शन, हिषे क पथृक 

फ्षे म की फोटोगावफंर वालषे रिण में रली जाएरी। 

पिमपिारत एवनमषेशन मूवीज़: सनो वहाइट एंड वद सषेवन ड्वाफस्भ, पीटि पनै, औि सलीवपंर 

ब्यटूी, अलादीन

2D एरनमेशन

2D एवनमषेशन सषे तातप्य्भ  ज्यादाति वकसी की फ्षे म एवनमषेशन सषे होता ह,ै जो वकसी समतल 

सतह पि बनी हो, लषेवकन इसका तातप्य्भ  vector एवनमषेशन सषे री हो सकता ह,ै वजसमें 

पिमपिारत एवनमषेशन की तकनीकें  अपनाई रई हों।

Vector आिारित एवनमषेशन, अथा्भत् कमप्यटूि सषे त्ैयाि 2D एवनमषेशन, में वबलकुल पिमपिारत 

एवनमषेशन जसैी ही तकनीकें  प्र्योर की जाती हैं, बस फा्यदा ्यह ह,ै वक इसमें पिमपिारत 2D 

एवनमषेशन की तिह कमप्यटूि कषे  अलावा कोई औि रौवतक वसतुएं नहीं रावह्यषे होती।

3D एरनमेशन (CGI, ्कम्पयूटर एरनमेशन)

3D एवनमषेशन पिमपिारत एवनमषेशन कषे  मुकाबलषे वबलकुल अलर तिह सषे काम किती ह।ै इन 

दोनों में ही मूवमेंट व कंपोज़ीशन कषे  समान वसद्धांतों की समझ की ज़रूित पडती ह,ै लषेवकन 

प्रत्यषेक काम कषे  वलए आवश्यक तकनीकी ्योग्यता वबलकुल वरनन ह।ै जहां एक ओि पहलषे 

आपको एवनमषेटि होनषे कषे  वलए एक अच्ा ड्ाफट्समनै होना बषेहद ज़रूिी था, कमप्यटूि 

एवनमषेशन कषे  साथ अब ऐसा कोई ज़रूिी नहीं ह।ै 3D एवनमषेशन ड्ॉइंर की बजा्य कठपुतवल्यों 

को नरानषे सषे ज्यादा वमलती-जुलती ह।ै

मोशन रिारिकस (टाइपोरिािी, एनीमेरटि िोगो)

हालांवक इसषे अरी री एवनमषेशन की एक फॉम्भ  माना जाता ह,ै मोशन गावफक्स अन्य प्रकाि की 

एवनमषेशन सषे वबलकुल अलर ह।ै ज्यादाति इसवलए क््योंवक हमािी सरूी की अन्य प्रकािों सषे 

अलर, ्यह कैिषे क्टि ्या सटोिी सषे नहीं रलती। ्यह गावफक्स ततवों ्या टषेक्सट की िरनातमक 

ढंर सषे रलानषे की कला ह,ै आमतौि पि ऐसा वावणवज्यक ्या प्रराि कषे  उद्धषेश्य सषे वक्या जाता 

ह।ै एनीमषेवटड लोरोज़, एक्सपलषेनि वीवड्योज़, एप कमवश्भ्यल, टषेलीववज़न प्रोमोज़ ्या ्यहां तक 

वक वफलम कषे  शुरुआती टाइटलस कषे  बािषे  में सोरें।

मोशन गावफक्स समतल-आिाि वाली इमषेज ्या 3D ऑबजषेक्ट मात्र होतषे हैं, वजनमें म्यवूजक तथा साउंड इफैक्ट्स कषे  साथ रवत का भ्रम पदैा वक्या जाता ह।ै 

्यह तकनीक अक्सि मलटीमीवड्या प्रोजषेक्टस कषे  वलए इसतषेमाल की जाती ह।ै

तित्र 2.3.5: 2D एतनमेशन

तित्र 2.3.6: 3D एतनमेशन

तित्र 2.3.7: मोशन ग्ाकफकस
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Stop Motion 

Stop Motion वकसी वसतु (ऑबजषेक्ट) की फोटो लषेकि, वफि इसषे थोडा सा सिका-कि वफि सषे फोटो लषेनषे की प्रवक्र्या ह।ै ्यह प्रवक्र्या दोहिाई जाती ह ैऔि जब 

इन फोटो को एक कषे  बाद पलषे, वक्या जाता ह,ै तो ्यषे मूवमेंट/रवत होनषे का भ्रम पदैा किती हैं। ्यह पिमपिारत एवनमषेशन कषे  समान ही ह,ै लषेवकन इनमें ड्ॉइंर 

की बजाए असली सामवग्यों/वसतुओ ंका इसतषेमाल वक्या जाता ह।ै

Stop Motion एवनमषेशन का तातप्य्भ  वकसी री उस एवनमषेशन सषे ह,ै वजसमें एनीमषेवटड एक्शन 

पदैा किनषे कषे  वलए वसतुओ ंकी एक क्रम में तसवीिषे  ली जाती हैं। 

Stop Motion एवनमषेशन की प्रवक्र्या बहुत लंबी ह,ै क््योंवक हिषे क वसतु को साविानीपवू्भक इंर 

दि इंर सिकाना पडता ह,ै औि एवनमषेशन का प्रवाह क्रम िरनषे कषे  वलए हि बदलाव की फोटो 

ली जाती ह।ै

किमेेशन

क्लषेमषेशन बषेहद लोकवप्र्य फॉम्भ  में सषे एक ह।ै क्लषे ्या पलषे-डो कैिषे क्टि, वजनमें एवनमषेशन कषे  वलए 

आसानी सषे हषेि-फषे ि/जोड-तोड की जा सकती ह,ै कषे  साथ काम किना। एडवांस क्लषेमषेशन, 

(जसैषे द नषेविहुड ्या आवम्भक्रॉर) में, अविक ठोस रिगस कषे  वलए, िातु कषे  ढांरों का इसतषेमाल 

वक्या जाता ह,ै वजन पि वफि क्लषे रढाई जाती ह।ै

्कठपु्तरियां

कु् एवनमषेटि क्लषे वाली कठपुतवल्यों की आम/वन्यवमत कठपुतवल्यां इसतषेमाल कितषे हैं, ्यषे 

री आमतौि पि वकसी प्रकाि सकैलषेटन रिर ठोस पि वनवम्भत होती हैं। अवरव्यवक्त कषे  आिाि पि 

कैिषे क्टिों कषे  रषेहिषे  बदलषे, ्या रिर कषे  रीति ही वन्ंयवत्रत वकए जा सकतषे हैं।

्कट-आउट

Stop Motion की एक औि लोकवप्र्य फॉम्भ  ह,ै कट-आउट। कंसट्क्शन पषेपि ्या काड्भबोड्भ  

कैिषे क्टस्भ का इसतषेमाल किकषे , उनहें पषेपि पि िख कि ऊपि सषे एवनमषेशन शटू की जाती ह ै

(कमप्यटूि कषे  प्र्योर में आनषे सषे पहलषे साउथ पाक्भ  इसी तिह बनाई रई थी)। वफि काड्भबोड्भ  को 

हिषे क फ्षे म में थोडा सा सिका्या जाता ह,ै वजससषे मूवमेंट/रवत का भ्रम हो। 

तित्र 2.3.9: किेमेशन

तित्र 2.3.10: कठपुितियां

तित्र 2.3.11: कट-आउट

तित्र 2.3.8: Stop Motion 
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Silhouette

कट-आउट एवनमषेशन कषे  समान ही, silhouette एवनमषेशन में काड्भबोड्भ  ्या वकसी तिह की 

समतल सामगी का इसतषेमाल होता ह,ै मरि वसतुएं पिूी काली होती हैं औि शॉट वसफ्भ  

silhouette सषे वलए जातषे हैं। ्यह Stop Motion की प्रारीनतम फॉम्भ  में सषे एक ह ैऔि आज 

वविलषे ही इसतषेमाल होती ह।ै

2.3.7 पयटििेक्ण/गौर ्करना, अरभनय और भाि प्र्कट ्करना

ववश्वसनी्य एवनमषेशन बनानषे कषे  वलए सवाराववक तथा ववश्वसनी्य रावनाएं िरना आवश्यक ह।ै  अच्ा एवनमषेवटड राव दृश्य में कहीं अविक नाटकी्यता 

रि सकता ह,ै औि एवनमषेवटड वफलम दषेखनषे वालषे लोरों में रुवर पदैा कि सकती ह।ै रावना वसफ्भ  काटू्भन कैिषे क्टि की राव-रंवरमाओ ंमें ही वनवहत नहीं होती 

ह ैबवलक हाव-रावों में री वनवहत होती ह।ै

एवनमषेशन में रावना का संराि किनषे का एक तिीका ्यह सुवनवश्चत किना ह,ै वक हम एक ववरािशील कैिषे क्टि बना िहषे हैं। ्यह िािणा दश्भकों तक 

पहँुराना बषेहद महतवपणू्भ  ह,ै वक एवनमषेवटड कैिषे क्टि कषे  एक्शन तथा मूवमेंट उसकषे  ववरािों सषे ही प्रषेरित होतषे हैं। क्लावसकल काटू्भन एवनमषेशन का एंटीवसपषेशन 

वसद्धांत 2D कषे  साथ-साथ 3D परिवषेश में री ववश्वसनी्य तथा रावनातम् क एवनमषेशन त्ैयाि किनषे कषे  वलए प्र्योर वक्या जा सकता ह।ै

• ्यह ज़रूिी ह,ै वक बॉडी मूवमेंट वक्रएट किनषे सषे पहलषे आंख व वसि मूवमेंट वप्रपिषे शन वक्रएट की जाएं। आंखें पहलषे मूव होनी रावहएं, क््योंवक ्यही शिीि 

की आरामी हिकत कषे  वलए जवाबदषेह होती हैं/ क््योंवक ्यही शिीि की आरामी हिकत का इशािा दषेती हैं औि वकिदाि कषे  मन, ववराि तथा रावनाओ ं

का आईना होती हैं। 

• दूसिषे  नमबि पि आती ह,ै वसि की मूवमेंट। अरि एवनमषेशन कषे  इस वसद्धांत का पालन नहीं वक्या जाता, औि बॉडी, वसि व आंखों सषे पहलषे वहलती ह,ै 

तो action कैिषे क्टि द्ािा शुरू वक्या हुआ नहीं लरषेरा बवलक वकसी औि ताकत द्ािा वक्या हुआ लरषेरा औि ्यह कैिषे क्टि कषे  शुरुआती ववरािों का 

वविोि किता प्रतीत होरा। एक ववरािशील पात्र का सजृन, वकसी वकिदाि में जान डालनषे का पहला कदम ह।ै 

तित्र 2.3.14: Pixelation

तित्र 2.3.12: Silhouette

एकशन रचत्र/िगेो

कु् एवनमषेशन कषे  वलए एक्शन वरत्र ्या Lego कैिषे क्टस्भ का री इसतषेमाल कितषे हैं। ्यह शलैी 

YouTube पि काफी लोकवप्र्य ह ैऔि कई रनैल Lego कैिषे क्टस्भ कषे  साथ मज़षेदाि बनातषे हैं। 

Robot Chicken इसका एक बवढ्या उदाहिण ह।ै वषे पॉप कलरि का मजाक उडानषे कषे  वलए 

मशहूि एक्शन वरत्र का इसतषेमाल कितषे हैं।
तित्र 2.3.13: एकशन तित्र

Pixelation

Pixelation, Stop Motion की एक फॉम्भ  ह ैवजसमें कालपवनक वीवड्यो बनानषे कषे  वलए असल 

लोरों व असल माहौल का इसतषेमाल होता ह।ै ्यह वसटल फोटो लषेनषे, रीज़ों कषे  इद्भ -वरद्भ  घमूनषे, 

औि वफि अन्य फोटो लषेनषे वालषे, Stop Motion तिीकषे  का इसतषेमाल किता ह,ै मरि subject 

matter आमतौि पि कठपुतवल्यों की बजाए असल व्यवक्त होतषे हैं।
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• रावनाएं हिषे क एक्शन कषे  होनषे में लरनषे वालषे सम्य को री त्य कि सकती हैं। एक खुश कैिषे क्टि एक उदास व्यवक्त कषे  मुकाबलषे हिषे क मूवमेंट व 

एक्शन तषेज़ रवत सषे किषे रा।

• राव-रंवरमाएं एवनमषेशन में रावनाएं व्यक्त/समप्रषेवषत किनषे में एक अहम रवूमका री वनराती हैं। रावनाओ ं की अवरव्यवक्त में रषेहिषे  कषे  जो वहससषे 

शावमल होतषे हैं इस प्रकाि हैं: आंखें, रौहें व मंुह।

• ज्यादा ्यथाथ्भवादी व जीवंत आंखें िरनषे कषे  वलए ्यह ्याद िखना महतवपणू्भ  ह ै वक उनकी सतह हमषेशा नम हो औि उनमें रमक हो/ वषे प्रकाश को 

प्राववत्भत किें  औि ्यह बात आंखों की सतह कषे  वलए प्र्योर की रई सामगी ह ्या आंखों की ड्ॉइंर में झलकनी ज़रूिी ह।ै

• रौहें री समप्रषेषण व रावनातमक अवरव्यवक्त में एक महतवपणू्भ  रवूमका वनराती हैं। उठी हुई रौहें अक्सि आश्च्य्भ व ववसम्य कषे  साथ-साथ अवनवश्चतता 

व भ्रम की संकषे तक होती हैं।

• झुकी हुई रौहें कपट ्या नािाजरी की संकषे तक होती हैं। रौहें रुससा, उदासी, डि व अन्य वववरनन रावनाएं, वजनहें मानव शिीि समप्रषेवषत कि सकता 

ह,ै को ज़ावहि कि सकती हैं।

्यह समझना महतवपणू्भ  ह ैवक वजस दुवन्या में हम िहतषे हैं उसमें अविकति संवाद मौवखक नहीं होता। एक एवनमषेटि एवनमषेशन में रावनाओ ंकी रवूमका को 

समझनषे कषे  वलए बाध्य ह,ै ्याद िखें वक शिीि का लररर हिषे क वहससा समप्रषेषण/रावनाओ ंकी अवरव्यवक्त कषे  वलए इसतषेमाल वक्या जा सकता ह ैऔि काटू्भन 

कैिषे क्टस्भ को एनीमषेट किनषे की प्रवक्र्या में इस ज्ान का इसतषेमाल किें ।

2.3.8 बौरद्क संपदा अरध्कार

बौवद्धक संपदा (IP) का संदर्भ वदमार की िरनाओ ंसषे ह,ै जसैषे खोजें; सावहवत्यक ्या कलातमक का्य्भ; वडज़ाइन औि वावणज्य में प्र्योर होनषे वालषे वरनह, नाम 

तथा ्वव्याँ/तसवीिें । बौवद्धक संपदा में 2 वरनन रूप शावमल हैं: 

• वह संपदा जो मानव बुवद्ध सषे पनपती ह।ै

• मानव िरना व कलातमक का्य्भ  का उतपाद  

सावहवत्यक व कलातमक का्य्भ: ्यषे हैं वकताबें, पेंवटंर, म्यवूज़कल कंपोज़ीशन, नाटक, मूवी, िषे वड्यो/टीवी प्रोगाम, प्रदश्भन तथा अन्य कलातमक का्य्भ  औि ्यषे 

कॉपीिाइट द्ािा सुिवक्त िखषे जातषे हैं।

औद्ोवरक संपदा: ्यह एक रौवतक पदाथ्भ  को व्याख्याव्यत किता ह ैजो वावणवज्यक उद्षेश्य कषे  वलए वकसी ववराि ्या िािणा का उतपाद ह।ै ्यषे वनमन द्ािा 

सुिवक्त हैं:

• पषेटेंटषेड वसतुएं 

• ट्षेडमाक्भ

• औद्ोवरक वडज़ाइन

• ट्षेड सीक्रषे ट 

• लषेआउट-वडज़ाइन 

• रौरोवलक संकषे त।  

्यह सजृनकता्भ  ्या सवामी कषे  अविकािों की िक्ा इस प्रकाि किता ह,ै वक दूसिषे  उनकषे  का्य्भ/कृवत्यों को वबना उनकी आज्ा कषे  इसतषेमाल नहीं कि सकतषे। 

इन सरी सषे जुडषे  अविकािों को लाइसेंस, हसतांतरित ्या दसतावषेज़ीकिण किनषे की आवश्यकता होती ह,ै वजससषे वनमा्भता/प्रोड््यजू़ि - सजृनातमक ववरािों/

वक्रएवटव आइवड्याज़ को एक ववपणन ्योग्य अविािणा में बदलनषे कषे  वलए उत्तिदा्यी व्यवक्त वफलम कषे  सवावमतव का दावा कि सकषे , वफलम बनानषे कषे  वलए 

आवश्यक िन जुटा सकषे  औि ववतिण अविकाि लाइसेंस कि सकषे ।

्यह एक अच्ी सटोिी ्या वसक्रपट की तलाश सषे शुरू होता ह।ै आदश्भ तौि पि, वनमा्भता को एक वसक्रपट वमलषेरी, जो वक शटू कषे  वलए त्ैयाि होरी, तरि 

आमतौि पि सक्रीनपलषे बनानषे कषे  वलए एक पषेशषेवि सक्रीनिाइटि की सषेवाएं ली जाती हैं। वसक्रपट कोई न्या काम हो सकती ह ै्या वकसी मौज़दूा कृवत, जसैषे 

कोई उपन्यास, नाटक ्या कॉवमक बुक पि आिारित हो सकती ह।ै

वसक्रपट को अपनषे आप में हमषेशा एक मूल िरना माना जाता ह ैवजससषे IP अविकाि जुडषे होतषे हैं। वनमा्भता वफलम कषे  वलए एक ्ोटा कथातमक वरत्रफलक 

िरनषे कषे  वलए औि एक पहला ड्ाफट त्ैयाि किनषे कषे  वलए वकसी पटकथा लषेखक/वसक्रपट िाइटि को काम पि िखता ह।ै अगीमेंट/सहमवत पत्र में ्यह री सपष्ट 
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रट्पपरणयां 
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वक्या हुआ हो सकता ह,ै त्य वक्यषे र्यषे शुलक पि वकतनषे औि ड्ाफट, िी-िाइट्स ्या परिष्किण होंरषे। लषेखक कषे  अनुबंि की काननूी वसथवत मौज़दूा 

कॉपीिाइट औि संबंवित अविकाि काननूों कषे  वहसाब सषे अलर-अलर हो सकती ह।ै

अरि मूवी ्या एवनमषेशन वकसी मौजदूा काम पि आिारित ह,ै तो वनमा्भता आरषे बढनषे सषे पहलषे इस सामगी को प्र्योर किनषे कषे  अविकाि हावसल किनषे हषेतु 

एक ववकलप इकिािनामा वनकालषेरा। एक ववकलप इकिािनामा कहता ह ैवक उवललवखत काम - वसक्रपट, पुसतक, लषेख ्या लघु कथा - का सवामी प्रोड््यजू़ि 

को एक वनिा्भ ारित सम्य कषे  वलए एक वफलम अथवा एवनमषेशन का वनमा्भण किनषे हषेतु अविकाि प्रदान किता ह।ै

अरि वफलम ्या एवनमषेशन बनती ह ै(औि ववकलप पि अमल होता ह)ै तो उस काम को वफलम में उप्योर किनषे कषे  ज़ािी/राल ूअविकािों कषे  वलए कॉपीिाइट 

मावलक को एक त्य वक्यषे र्यषे शुलक का रुरतान वक्या जाता ह।ै एक अविकाि क्र्य इकिािनामषे पि आमतौि सषे उसी सम्य सक्रीनपलषे अविकािों, टीवी 

अविकािों को सुिवक्त किनषे कषे  वलए औि होम वीवड्यो व न्य ूमीवड्या जसैषे सहा्यक बाजािों में रिलीज़ किनषे कषे  अविकाि हावसल किनषे कषे  वलए शतमें त्य 

किनषे हषेतु री मोलराव हो जाता ह।ै
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3. उप्करणों और सामररियों 
्का प्रबंधन ्करना

्यवूनट 3.1- Hookup Poses व एवनमषेशन वक्रएट किें /िरें

्यवूनट 3.2 - प्रदश्भन वनखािनषे कषे  वलए कैमिा एंरलस का इसतषेमाल किें

MES/N 3502
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. रिसर्भ किनषे ऐसषे कैिषे क्टि संदर्भ प्राप्त किनषे में, जो वडज़ाइन कषे  वलए सहा्यक व प्रषेिक सावबत हों।

2. ववजु़अलाइज़षेशन तथा वडज़ाइनिों द्ािा त्ैयाि कॉनसषेपट आट्भ वक्भ , कलपना सषे बनी ड्ॉइंगस, अवरन्य तथा प्रदश्भन सषे वमलषे संदरकों का प्र्योर किकषे  

प्रोडक्शन कषे  वलए वक्रएवटव कॉनसषेपट तथा आइवड्याज़ त्ैयाि किनषे में।

3. ऐसी का्य्भ-उतपाद शलैी पि सहमत होनषे में, जो का्य्भक्रम व शो की आवश्यकताओ ंकषे  साथ पिूषे  तालमषेल में हो औि लक््य दश्भक वर्भ को सवा्भ विक 

आकष्भक लरषे।

रनष्कषटि 
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यूरनट 3.1: Hookup Poses ि एरनमेशन रचें/रक्रएट ्करें

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. अवरन्य व राव प्रकट किनषे में।

2. Hookup poses व एवनमषेशन की िरना किनषे में।

3.1.1 एरनमेशन ्ेक मौरि्क रसदां्त

हूक-अप पोज़ वह रोंद ह ैजो काटू्भनों को एक साथ जोडषे िखता ह।ै । लषेवकन जब आप वकसी एक (्या एक सषे ज्यादा) कैिषे क्टि कषे  साथ एक सीन पिूा किकषे  

उनहीं कैिषे टस्भ कषे  साथ दूसिषे  सीन में जातषे हैं, तब आप पोवज़ज़ को हूक-अप (जोडतषे) कितषे हैं। इसका मतलब ्यह ह,ै वक पहलषे सीन कषे  आवखिी फ्षे म में 

कैिषे क्टि का पोज़ औि अरलषे सीन कषे  पहलषे फ्षे म में उस कैिषे क्टि का पोज़ आपस में मषेल खाना रावह्यषे।

काटू्भन में, हम एनीमषेट किनषे सषे पहलषे एवडट कितषे हैं। ्यह सुवनवश्चत किना सटोिीबोड्भ  का काम होता ह ैवक काटू्भन में वनिंतिता संबंिी कोई तु्रवट न हो। 

इनकी बाि-बाि समीक्ा की जाती ह ैऔि ्यषे कई वववरनन लोरों द्ािा दषेखषे जातषे हैं। जब एवनमषेशन शुरू हो (हम उममीद कितषे हैं) तो कोई री रलती नहीं 

होनी रावहए।

एक एवनमषेटषेड सीिीज़ में, कई अलर-अलर सीनों पि कई अलर-अलर एवनमषेटि काम कितषे हैं। वषे उन पि पंवक्तबद्ध रूप सषे (क्रोनोलॉवजकल ऑड्भि) में काम 

नहीं कितषे हैं ्या क््या वषे एक दूसिषे  कषे  सहािषे  िहतषे हैं, वक कैसषे पिूा शो वबना वकसी तु्रवट कषे  त्ैयाि हो जा्यषे/्या क््या वषे ्यह दषेखनषे कषे  वलए एक-दूसिषे  की कवम्यां 

वनकालतषे िहतषे हैं, वक शो वबना वकसी कमी कषे  पिूा हो पा्यषेरा वक नहीं। ्यहीं पि ‘हूक-अप’ काम आता ह।ै हूक-अप पोज़ वह रोंद ह ैजो काटू्भनों को एक 

साथ जोडषे िखता ह।ै अरि एक (्या अविक) कैिषे क्टि एक वबलकुल अलर सीन सषे आतषे हैं, तो हूक-अप की ज़रूित नहीं होती। लषेवकन जब एक (्या अविक) 

कैिषे क्टि कषे  साथ एक सीन पिूा होता ह ैऔि अरला सीन री उनहीं कैिषे क्टस्भ कषे  साथ ह,ै तो हूक-अप की ज़रूित होती ह।ै इसका मतलब ्यह ह,ै वक पहलषे 

सीन कषे  आवखिी फ्षे म में कैिषे क्टि का पोज़ औि अरलषे सीन कषे  पहलषे फ्षे म में उस कैिषे क्टि का पोज़ आपस में मषेल खाना रावह्यषे।

उदाहिण कषे  वलए काटू्भन मूवी ‘The Little Mermaid’ का हूक-अप पोज़ वद्या र्या ह:ै सबसषे पहलषे वनिंतिता संबंिी तु्रवट्यों सषे बरें जो वक live-action वफलमों 

कषे  समान ही होती हैं। जसैषे वक:

तित्र 3.1.1(a): हूक-अप पोज़ तित्र 3.1.1(b): हूक-अप पोज़ - त्रुरटयां

यूरनट ्ेक उद्ेशय  
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उसकषे  नंरषे पिैों को किीब सषे वदखातषे हैं/सीन समाप्त हुआ तो वह नंरषे पिै ह।ै अरलषे सीन में 

जहां लोर प्रवतवक्र्या दषे िहषे हैं, उसकी आवाज़ वापस आ जाती है

जतूषे! इसकषे  वलए कोई री तावक्भ क बहाना नहीं ह।ै ्यह बस एक रलती ह।ै 

सीखने िाय्क पाठ: हमषेशा सीन कषे  क्रम में वकसी री मॉडल/वाड्भिोब कषे  बदलाव को 

सटोिीबोड्भ  में अंवकत किें । इसकी बडी आसानी सषे अनदषेखी हो सकती ह।ै ्यहां एक औि 

उदाहिण ह।ै

्यहां इस खास सीन का अंत ह।ै Ariel औि Ursula कषे  पोज़ पि ध्यान दें।

्यह अरलषे सीन का पहला पोज़ ह।ै ्यह बवढ्या हूक-अप नहीं ह,ै मरि किीबी ह।ै Ursula दांत 

पीसती हुई होनी रावहए औि Ariel की आंखषे बंद होनी रावहए। ्यह इतना तषेज़ी सषे होता ह ैवक 

आप ध्यान नहीं दषेतषे।

सीन जािी िहता ह ैऔि Ursula समुरि में कूदनषे कषे  वलए हिकत किती ह।ै ध्यान दें, वक Ariel 

कपडषे पहनषे हुए ह ै(लषेवकन एक जलपिी ह)ै।

इसकषे  अरलषे सीन में में Erik िषे ल कषे  पास जा िह ह ैऔि झुकता ह।ै

तित्र 3.1.1(c): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.1(d): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.1(e): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.1(f): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.1(g): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.1(h): हूक-अप पोज़ - त्रुरटयां
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वफि अरलषे सीन में पानी कषे  नीरषे Ursula Ariel को अपनषे पी ष्े  खींर िही ह।ै ध्यान दें, वक Ariel नषे अब कपडषे नहीं पहनषे हुए ह।ै ्यहां इसका एक तावक्भ क 

कािण हो सकता ह,ै वक उसनषे कपडषे नहीं पहनषे।  हो सकता ह,ै वषे पानी में उतिनषे कषे  दौिान वरि रए होंरषे, जब हमािा ध्यान Erik पि था। आदश्भ तौि पि, 

अरि वषे कपडों को सक्रीन कषे  बाएं शीष्भ  पि तिै कि दूि जातषे हुए वदखा दषेतषे, तो सीन बहुत अच्ा बन पडता। कपडों को ्ोड ही दषेना एक अच्ा ‘िोखा’ ह।ै 

सीखनषे ला्यक पाठ: ‘तावक्भ क िोखषे’ अच ष्े  हैं जब वषे सही ढंर सषे वकए रए हों।

अरध्क हू्क-अ्पस

Ariel पहली बाि महससू किती ह ैवक उसकषे  पास पैंट्स नहीं ह,ै टांरषे हैं

वह अपना पिै उठाना शुरू किती ह।ै

्यहां एक हूक-अप पोज़ ह ै(एक्शन नोट्स में इसषे आप ‘सटाट्भ  पोज़’ री कह सकतषे हैं)। वफि सषे ्यह 

बवढ्या नहीं ह ै(हम पंजषे दषेखतषे हैं) लषेवकन इससषे बस काम रल जाता ह।ै

्यहां सीन का असल एक्शन ह ै– उसका अपना पिै उठाना पि अरि हम ्यहां शुरू कितषे हैं, तो 

्यह पहलषे कषे  ववसतारित शॉट सषे मषेल नहीं खाएरा। समझ आ िहा ह?ै

वह अपनषे पंजषे वहलाती ह ैहंसती ह,ै फलां फलां फलां औि वफि Scuttle की आवाज पि सक्रीन सषे 

बाहि की ओि दषेखती ह।ै

सीन खतम होता ह ैऔि दषेखें वक उसकषे  पोज़ कैसषे हूक-अप कितषे हैं। दो अन्य ्ोटषे शखस मा्यनषे 

नहीं िखतषे क््योंवक वषे पहलषे की सीन में नहीं थषे। हमें वसफ्भ  Ariel कषे  पोज़ सषे मतलब ह।ै ्यह वसफ्भ  

रंद फ्षे मों कषे  वलए ह।ै

तित्र 3.1.2(b): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(c): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(d): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(e): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(f): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(a): हूक-अप पोज़ - त्रुरटयां
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वफि Scuttle उसकी ओि उडता हुआ आता ह।ै

कैमिा थोडा सा सिकता ह ैक््योंवक वह उसकी टांर पि उतिना *शुरू* किता ह।ै

हूक-अप /सटाट्भ  पोज़ दषेखें। ध्यान दें, कैसषे Ariel औि Scuttle वासतव में समान अवसथा में हैं।

औि इसवलए वह उतिता ह।ै ज्यादा एक्शन, ज्यादा फलां फलां। दोबािा, ्यह पहला pose नहीं हो सकता क््योंवक वप्लषे सीन में वह अरी तक उतिा नहीं था। 

तो, लीवज्यषे आपकषे  सामनषे आता ह,ै हूक-अप. उममीद किता हँू, इसका कोई तुक बना होरा। अरि आपकषे  मन में कोई सवाल ह,ै तो उनहें बषेवझझक वटपपवण्यों 

में वलख ्ोडें ।

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

तित्र 3.1.2(g): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(h): हूक-अप पोज़ - त्रुरटयां

तित्र 3.1.2(i): हूक-अप पोज़ - त्रुरटयां
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यूरनट 3.2: प्रदशटिन रनखारने ्ेक रिए ्ैकमरा एंगलस ्का इस्तमेाि ्करें

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. प्रदश्भन वनखािनषे कषे  वलए कैमिा एंरलस का इसतषेमाल किना सीखनषे में

2. वववरनन प्रकाि कषे  कैमिा शॉट्स को पहराननषे में।

3.2.1 ्ैकमरा पोज़ीशन

यूरनट ्ेक उद्ेशय  

वकसी वसक्रपट को प्रसतुत/व्याख्या किनषे कषे  दौिान सबसषे पहली रीज़, जो वकसी वफलम-वनमा्भता को ध्यान में िखनी रावह्यषे, वह ह ैकैमिा की पलषेवसंर तथा 

फ्षे वमंर। तीन बुवन्यादी कैमिा पोज़ीशंस होती हैं - वाइड शॉट, वमड शॉट तथा क्लोज़-अप इनकषे  सकैें ड्ी शॉट्स हैं - अलट्ा वाइड शॉट तथा एक्सट्ीम क्लोज़-

अप। इन बुवन्यादी अविािणाओ ंको ध्यान में िख कि एक वफलम-वनमा्भता एक सीक्वेंस को काफी नाटकी्य तथा सशक्त बना सकता ह।ै

3.2.1.1 अलट्ा-िाइि शॉट
करी करी, एक वफलम ्या एक नई सीक्वेंस की ओपवनंर/शुरुआत में, ्यह आवश्यक होता ह ैवक कैिषे क्टि कषे  संबंि में सकषे ल/माप तथा प्रोपोश्भन/अनुपात 

का एक अवतिंवजत राव दषेना पडता ह।ै उदाहिण कषे  वलए,पवश्चम की ओपवनंर, ज्यादा प्ररावशाली ह ैअरि हम दषेखें वक मुख्य कैिषे क्टि घास कषे  मदैानों, 

जंरलों व बफ्भ  सषे ढकषे  पहाडों ववशाल ररूार सषे होकि रुजिता ह ैजसैषे वक वह बमुवशकल ही अहवम्यत िखता हो। एक अवत-ववसतारित शॉट में, हमें लरता 

ह,ै वक सषेवटंर कैिषे क्टि पि हावी हो िही ह ैऔि इसकषे  रलतषे कैिषे क्टि बौना प्रतीत होता ह।ै डा्यिषे क्टि डषेववड लीन की कु् शानदाि महाकाव्य मूवीज़ में 

बषेहतिीन अलट्ा-वाइड शॉट वदखाई दषेतषे हैं, जहां उसकी वफरस्भ/उसकषे  कैिषे क्टस्भ अपनषे व्यापक रूप सषे ववसततृ परिवषेश सषे इस हद तक डॉवमनषेट हो िहषे थषे/दब 

िहषे थषे, वक करी-करी तो वषे लेंस पि लरा कोई िबबा मात्र प्रतीत हो िहषे थषे। इसीवलए अलट्ा-वाइड शॉट, बडषे पमैानषे व आ्याम का संबद्ध/रिलषेवटंर शॉट होता 

ह ै(अरलषे पषेज पि ऊपिी फोटो दषेखें)।

तित्र 3.2.1: अल्ट्ा-िाइि शॉट
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3.2.1.2 िाइि शॉट

वाइड शॉट पािंपरिक तौि पि, वकसी नई सीक्वेंस का शुरुआती शॉट होता ह,ै इसषे अक्सि एसटावबलवशंर शॉट कहकि परिरावषत वक्या जाता ह।ै वाइड शॉट 

का उद्षेश्य सीन सषेट किना होता ह,ै वजससषे दश्भकों को लोकषे शन, इसकी ववष्य-वसतु तथा इसकषे  मुख्य पात्र तथा पात्रों कषे  साथ इसकषे  संबंि कषे  बािषे  में 

ततकाल एक अंदाज़ा वमल जा्यषे। ्यही कािण ह ैवक क््यों ज्यादाति वफलम-वनमा्भता अपनी वफलम की ओपवनंर/शरुआती सीक्वेंस ्या सीक्वेंस कषे  रीति ही 

वकसी न्यषे सषेट-अप, वजसमें नई लोकषे शन की ज़रूित हो, कषे  वलए एसटवैबलवशंर शॉट कषे  रूप में वाइड शॉट को ही क््यों पसंद कितषे हैं। ज्यादाति ओपवनंगस 

कषे  वलए, वाइड शॉट ही पसंदीदा शॉट होना रावहए, मरि कु् ओपवनंगस ्या ट्ांज़ीशनस काम किती हैं।

एक वाइड शॉट, वाइड तरी कहलाता ह,ै जब शॉट में फुल-साइज् ़ड कैिषे क्टि हों, क््योंवक शॉट का ववसताि/की वाइडनषेस पिूी तिह सषे इस बात पि वनर्भि 

किती ह,ै वक कलाकािों कषे  साथ इसका क््या संबंि बन िहा ह।ै कोई री शॉट जो दृश्य में वदखाई दषे िहषे कैिषे क्टि सषे बडा हो – हम वसि सषे लषेकि पिै तक पिूषे  

कैिषे क्टि औि उसकषे  आस-पास की काफी जरह दषेख पा िहषे हों - तो इसषे वाइड शॉट का नाम वद्या जा सकता ह।ै

अलट्ा-वाइड शॉट में काफी ज्यादा बकैगाउंड/पषृ्ठरवूम वदखाई दषेता ह ैऔि इसमें सबजषेक्ट/कैिषे क्टि (इस मामलषे में, सटॉप साइन/रुकनषे का संकषे त) इस पिूषे  

व्य ूका एक बषेहद ्ोटा सा वहसस होता ह।ै

तित्र 3.2.2: िाइि शॉट

वाइड शॉट पिूषे  कैिषे क्टि को तो वदखाता ही ह,ै साथ ही सीन की तातकावलक सषेवटंर को री वदखाता ह।ै

3.2.1.3 मधय शॉट
वमड शॉट में कैमिा इतना नजदीक लाना पडता ह ैवक कैिषे क्टि पिूा नहीं वदखाई दषेता। आमतौि पि, कैमिा कैिषे क्टि को कमि सषे लषेकि उनकषे  वसिषे  कषे  ऊपिी 

वहससषे तक वदखाता ह,ै ्यद्वप कैिषे क्टि की कमि सषे उसकषे  पिैों कषे  नीरषे तक का वमड शॉट री आप लषे सकतषे हैं, अरि इससषे उद्षेश्य की पवूत्भ  होती ह ैतो। वमड 

शॉट दश्भकों को कैिषे क्टि कषे  थोडा नजदीक लषे आता ह,ै वबना उसषे असहज वक्यषे।
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एक वमड शॉट का तब इसतषेमाल वक्या जाता ह ैजब कैिषे क्टि कु् ऐसा किता ह ैवजसषे हमें साफ तौि पि दषेखनषे की ज़रूित होती ह ै(कु् ऐसा वजस पि वाइड 

शॉट में संरवत दश्भकों की नज़ि न पडषे) ्या अरि वषे अपनषे आस-पास की वकसी रीज़ पि प्रवतवक्र्या दषेतषे हैं ्या एक तिह सषे उसका वजक्र कि िहषे हों, वजसषे 

हमें अविक सपष्ट रूप सषे दषेखनषे की ज़रूित ह।ै कैिषे क्टि दूसिषे  कैिषे क्टि की ्वव कषे  बािषे  में कु् ध्यान दषे िहा हो सकता ह ै्या वषे कु् ऐसा दषेख सकतषे हैं, जो 

उनहें अपनषे वबलकुल पी ष्े  रावह्यषे। ्यह पिूी तिह सषे इस पि वनर्भि किता ह,ै वक कैिषे क्टि क््या कि िहा ह ैऔि उसकषे  उस वववशष्ट एक्शन में उसकषे  आस-पास 

की क््या रीज़ शावमल ह।ै इस तिह, वाइड शॉट औि वमड शॉट दोनों ही ''रिलषेवटंर/संबद्धता'' कषे  शॉट हैं। वाइड शॉट में कैिषे क्टि अपनषे आस-पास कषे  ववसततृ 

परिवषेश सषे संबद्ध होता ह ै औि वमड शॉट में ऐसी वकसी रीज़/अन्य कैिषे क्टि सषे संबद्ध होता ह,ै जो उसकषे  काफी नज़दीक ह।ै इसवलए ्यषे शॉट्स अविक 

अव्यवक्तरत/औपरारिक होतषे हैं औि ्यह बात दश्भकों को री समप्रषेवषत हो जाती ह,ै राहषे अरषेतन में ही सही।

तित्र 3.2.3: तमि शॉट

3.2.1.4 किोज़-अप
क्लोज़-अप वह शॉट होता ह ैवजसका इसतषेमाल हम वसफ्भ  औि वसफ्भ  उस एक्शन को शॉट किनषे 

कषे  वलए कितषे हैं, वजसषे हम दश्भक को वववशष्ट रूप सषे वबना कहीं ध्यान बँटा्यषे वदखाना राहतषे 

हैं। कई बाि, ्यह कैिषे क्टि कषे  रषेहिषे  का क्लोज़ शॉट होता ह,ै जब वषे वकसी अलर तिीकषे  सषे बात 

कि िहषे हों, ्या प्रवतवक्र्या दषे िहषे हों। एक क्लोज़-अप शॉट हमें कैिषे क्टि की रद्भन सषे लषेकि वसि 

कषे  ऊपिी वहससषे तक वदखाद्भ  दषेता ह।ै हालांवक, क्लोज़-अप शॉट हाथ सषे कु् उठानषे, वकसी 

उ्ाली रई राबी कषे  आकि खुली दिाज़ में वरिनषे, महज़ ववसफोट सषे पहलषे प्यजू़ कषे  बम तक 

पहँुरनषे ्या औि वकसी दृश्य का हो सकता ह,ै वजसषे काफी नज़दीक सषे वदखानषे की ज़रूित हो। 

क्लोज़-अप में कैिषे क्टि सव्ंय को अपनषे शिीि की हिकतों की बजा्य, राव-रंवरमाओ ं सषे 

अवरव्यक्त किता ह।ै ्यह दश्भकों को वकसी ऐसी बात/रीज़ का वबलकुल सपष्ट, असंवदगि दृश्य 

वदखाता ह,ै जो दश्भकों की नज़ि सषे ्ूटना नहीं रावह्यषे, ्यवद वषे कहानी की वसथवत को पिूी तिह सषे समझना राहतषे हैं तो। डिावनी/हॉिि शलैी में, ्यह दश्भकों 

को रौरक्का किनषे कषे  वलए री सषेट वक्या जा सकता ह,ै वजसमें कैमिा एक डिषे  हुए रषेहिषे  कषे  क्लोज़-अप पि आकि ठहि जाता ह,ै वफि इसी सीन कषे  एक 

वाइड शॉट में एक मॉनसटि, जो वक पहलषे सीन में नहीं था, एक बषेखबि वववक्टम/वशकाि कषे  पी ष्े  खडा वदखाई दषेता ह।ै क्लोज़-अप को बषेहद व्यवक्तरत शॉट 

माना जाता ह,ै इसवलए, क््योंवक इसमें हमें कषे वल व्यवक्त ्या वकसी बात/रीज़ पि उसकी प्रवतवक्र्या ्या कु् वववशष्ट जो वषे कि िहषे हैं, ्यषे ही दषेखनषे की ज़रूित 

होती ह।ै

तित्र 3.2.4: किोज़-अप (किोज़-अप शॉट सबजेकट, उनके एकशन या 
ररएकशन पर फोकस करिा हवै।)
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3.2.1.5 एकसट्ीम किोज़-अप
एक्सट्ीम क्लोज़-अप वबलकुल वहीं होता ह,ै जो इसकषे  नाम सषे जावहि होता ह;ै कैमिा इतना 

नजदीक मूव किता ह,ै वक सक्रीन बािीक सषे बािीक वण्भन सषे रि जाती ह,ै जसैा वक नीरषे वाली 

आकृवत में ह।ै ्यह आंख झपकना ्या घिूना हो सकता ह।ै ्यह वसरिषे ट कषे  वसिषे  को जलानषे वाली 

मावरस की तीली का वसिा हो सकता ह।ै ्या ्यह बषेहद िीमी रवत में ििती पि आकि वरिनषे 

वाली बारिश की बूंद हो सकती ह।ै शॉट की जो री आवश्यकता हो, कैमिा दश्भकों को इसकषे  

बषेहद नजदीक व किीबी बािीवक्यों में लषे जाता ह ैऔि दश्भकों कषे  वलए इसषे अनदषेखा किना 

नामुमवकन बना दषेता ह।ै एक एक्सट्ीम क्लोज़-अप वह रीज़ ह ैजो वकसी एक्शन, ्या एक्शनस 

की सीिीज़, को पिूा किती ह,ै एक शॉट जो वकसी सीन ्या सीक्वेंस की ्ोडषे न जा सकनषे वालषे 

लमहषे को रिकॉड्भ  किता ह।ै । बषेहद व्यवक्तरत शॉट होनषे कषे  नातषे, क्लोज़-अप कषे  मुकाबलषे कहीं 

अविक व्यवक्तरत, ्यह दश्भकों कषे  मन में इस बात का कोई संदषेह नहीं ्ोडता, वक वफलम-

वनमा्भता उनहें इस क्ण में क््या वदखाना राहता ह।ै

तित्र 3.2.5: एक्ट्ीम किोज़-अप (यह दशटिकरों को ककसी खास एकशन में 
िुबो देिा हवै, इस मामिे में बुिेट कदखाने में)

तित्र 3.2.6: एतनमेशन में सीन की फे्पमंग पर काम कर रहे होिे हैं िो एक बक़िया सुझाि यह हवै, कक हाथरों से ्क्ीन का आकार बनाएं और उसे आस-पास मूि करिे रहें, जब िक उस आटटििकटि  की 
बेहिरीन फे्पमंग पर न पहुँि जाएं।

3.2.2 ्ैकमरे ्ेक िेंस
राि तिह कषे  बुवन्यादी लेंस हैं: सटैंडड्भ  लेंस, वाइड एंरल लेंस, लांर लेंस, तथा ज़मू लेंस। दिअसल एक पांरवा लेंस री होता ह,ै वफशआई, वजसका उललषेख 

री ज़रूिी ह।ै हालांवक इमषेज पि इसका प्रराव, अन्य लेंस कषे  मुकाबलषे काफी सखत होता ह,ै इसवलए इनहें काफी वकफा्यत सषे/कम ही प्र्योर किना रावह्यषे, 

औि तरी प्र्योर किना रावह्यषे, जब प्रोजषेक्ट को इनकी ज़रूित हो। हिषे क लेंस में सीन लषेनषे की एक खास ्योग्यता होती ह ैजो अन्यों में नहीं होती औि 

इसीवलए जब वकसी सीन की ववष्य-वसतु, प्रराव तथा मूड पि ववराि वक्या जा िहा हो, तो प्रत्यषेक वफलम-वनमा्भता को कु् वववशष्ट ववकलप ऑफि किता 

ह।ै “प्राइम लेंस” एक सामान्य शबद ह,ै जो इस तिह कषे  ज्यादाति लेंसों का वण्भन किता ह,ै जो कैमिा तथा ऑबजषेक्ट कषे  बीर एक पक्का रिशता का्यम कि 

लषेतषे हैं। दूसिी ओि, ज़मू लेंस, वफवलमंर कषे  दौिान व्य ूकषे  पवाइंट को बाहि रीति की ओि मूव कि सकतषे हैं। सरी लेंस एक माप कषे  आिाि पि परिरावषत वक्यषे 

जातषे हैं, वजसषे फोकल लेंथ कहा जाता ह,ै वजस पि हिषे क लेंस का मगैनीवफकषे शन तथा फीलड एरि्या वनर्भि किता ह।ै वकसी अन्य कषे  मुकाबलषे 3D एवनमषेटि 

कषे  वलए लेंस र्यन ज्यादा महतवपणू्भ  होता ह,ै ्यद्वप 2D एवनमषेटि अपनषे आट्भवक्भ  कषे  अनदि ही एलीमेंट्स का पस्भपषेवक्टव तथा सकषे ल वडसटॉट्भ  किकषे  समान 

इफैक्ट प्राप्त कि लषेतषे हैं।
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3.2.2.1 सटैंििटि िेंस (50-100रममी. िो्कि िें्थ)
सटैंडड्भ  (्या सामान्य) लेंस वषे हैं जो ज्यादाति वसटल कैमिों में इसतषेमाल होतषे हैं। ्यषे काफी वनष्ठा सषे तसवीि लषेतषे हैं (नीरषे दषेखें), वबलकुल मामूली ्या वबना 

वकसी वडसटॉश्भन कषे  औि इनका व्यइंूर एरि्या काफी ववसततृ होता ह।ै ज्यादाति एनीमषेटषेड वफलम-वनमा्भता सवाराववक रूप सषे अपनी वफलमों में अविकति 

सटैंडड्भ  लेंस व्यपूवाइंट इसतषेमाल कितषे हैं।

तित्र 3.2.7: ्टैंििटि िेंस इमेज में को ्पेत्यि इफवै कट नहीं िािा।

3.2.2.2 िाइि-एंगि िेंस (20-35रममी.)
वाइड-एंरल लेंस तसवीि में ज्यादा रहिाई लातषे हैं औि इसषे एक एक्ज़जैिषे वटड 3D पस्भपषेवक्टव लुक दषेतषे हैं। इस लेंस की ज़रूित तब पडती ह,ै जब वकसी सट्ांर 

तित्र 3.2.8: िाइि-एंगि िेंस आस-पास की पृष्ठभूतम को जयादा से जयादा पेश करिे हैं।
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फोिगाउंड कैिषे क्टि ्या ऑबजषेक्ट पि बहुत नज़दीक सषे फोकस किना हो औि साथ ही उसी शॉट में आस-पास का पिूा बकैगाउंड एनवा्यिनमेंट री नज़ि 

आना रावह्यषे। वाइड-एंरल लेंस सबसषे वनकट की रीज़ों पि फोकस कि सकता ह ैऔि इसकषे  व्य ूका एंरल सटैंडड्भ  लेंस कषे  मुकाबलषे कहीं बडा होता ह।ै

ववजु़अल इफैक्ट्स, कषे  मामलषे में, लेंस वजतना ववसततृ होरा, सेंट्ल इमषेज उतनी ही वडसटॉवट्भड (ववरूवपत) होरी औि बकैगाउंड कषे  साथ इसका संबंि री 

उतना ही ववरूवपत होरा। बुवन्यादी प्रववृत ्यह होरी वक कैमिषे  कषे  नजदीक की रीजें कृवत्रम रूप सषे नज़दीक लरेंरी औि दूि की रीज़ें औि री ज्यादा दूि 

लरेंरी। वाइड-एंरल लेंस पत्रकािों तथा फैशन फोटोगाफिों द्ािा पसंद वक्यषे जातषे हैं, क््योंवक इनहें अपनी इमषेज में वजतना संरव हो सकषे  उतना कैपरि 

किना होता ह,ै औि अक्सि बहुत ही सीवमत जरह में । ्यवद ऑबजषेक्ट्स कषे  फोिगाउंड तथा बकैगाउंड कषे  बीर ववशषेष रूप सषे एगज़जैिषे वटड इफैक्ट की 

आवश्यकता हो, तो वाइड-एंरल लेंस कषे  ज़रि्यषे वाइड शॉट कषे  साथ-साथ, वमड शॉट तथा क्लोज़-अप री दषेखषे जा सकतषे हैं।

3.2.2.3 िाँग िेंस (85-600रममी.)
जब कैमिा काफी दूि हो, तो लाँर लेंस मुख्य रूप सषे वकसी ववशाल शॉट का ववसततृ वहसस फीरि किनषे कषे  वलए प्र्योर वक्यषे जातषे हैं। लाँर लेंस टषेलीसकोप 

की तिह काम कितषे हैं औि बहुत दूि वाली वसतु को बषेहद नजदीक लातषे हैं। लाँर लेंस का व्यइंूर एंरल बषेहद संकिा होता ह,ै तो ध्यान िहषे, आस-पास का 

ज्यादाति बकैगाउंड कैपरि नहीं हो पा्यषेरा। ्यह वसतु कषे  पी ष्े  की हिषे क रीज़ को रपटा कि दषेता ह,ै , वजससषे शॉट कषे  रीति संबद्ध ततवों (एलीमेंट्स) में 

परिप्रषेक््य/्यथाथ्भ  का राव अवनवा्य्भ  रूप सषे कम हो जाता ह।ै

लाँर लेंस इफैक्ट ज्यादाति वाइलडलाइफ डॉक््यमूेंट्ी में दषेखा जा सकता ह,ै जहां जानवि बहुत ज्यादा दूिी सषे वफलमाए जातषे हैं। हालांवक, क्लोज़-अप पोट्षेट 

शॉट कषे  वलए अक्सि अपषेक्ाकृत ्ोटषे लाँर लेंस (85-135वममी.) प्र्योर वक्यषे जातषे हैं, क््योंवक ्यषे मुखाकृवत्यों का अविक सवाराववक परिप्रषेक््य प्रदान कितषे 

हैं। (इसवलए इसकषे  उलट, का मतलब ह ैवक क्लोज़-अप पोट्भिषे ट शॉट में इसतषेमाल होनषे वालषे वाइड-एंरल लेंस नाक को इस करि बडा व ववरूवपत कि देंरषे वक 

ज्यादाति इसषे दषेखना सखत नापसंद किें रषे!) लाँर लेंस सषे परिप्रषेक््य कषे  सपाट वदखनषे सषे वकसी रीड-राड वालषे शॉट में अवासतववक तथा क्लॉसट्फोवबक 

(बंद जरहों का डि) वनकटता (क्लोज़नषेस) आ जा्यषेरी, जसैषे वकसी फुटबॉल मरै में राता हुआ/ शोि किता हुआ प्रशंसकों हुज़मू ्या वबज़ी आस्भ /व्यसत सडकों 

पि रीड-राड कषे  बीर कैिषे क्टि कषे  पी ष्े -पी ष्े  कैमिा लषे जानषे कषे  मामलषे में। क्षेत्र की रहिाई लाँर लेंस में बषेहद सीवमत होती ह,ै वजसका मतलब ह ैवक, सबजषेक्ट 

एरि्या कषे  आस-पास फोकस की दूिी बहुत ज्यादा नहीं होरी। दृश्य में कें रिी्य ऑबजषेक्ट तो वबलकुल सपष्ट/शाप्भ  होरा, लषेवकन उसकषे  एकदम पी ष्े  का औि 

दूि का बकैगाउंड उत्तिोत्ति औि िंुिला होता जा्यषेरा।

3.2.2.4 जू़म िेंस (28-80रममी.; 18-35 रममी.; 70-300 रममी.)

ज़मू लेंस तब उप्योरी होता ह ैजब सीन रलनषे कषे  दौिान कैमिा शॉट कषे  अंदि व बाहि आता 

जाता ह।ै प्राइम लेंसों सषे अलर, ज़मू लेंस क्लोज़-अप सषे सटैंडड्भ  लेंस औि सटैंडड्भ  लेंस सषे लाँर लेंस 

कषे  बीर बदलषे जा सकतषे हैं। वकसी शॉट में कोई कैिषे क्टि आरषे ्या पी ष्े  रलता हुआ हो सकता ह ै

औि वफलम-वनमा्भता को पिूा वक्त उसकी राव-रंवरमाओ ंपि ध्यान दषेना ह।ै ज़मू लेंस सीन कषे  

एक्शन कषे  साथ-साथ रलतषे हैं, इसवलए शॉट में कैिषे क्टि का रषेहिा लररर एक जसैा ही िहता 

ह,ै राहषे कैमिषे  कषे  संदर्भ  में उसकी वसथवत कु् री हो।

तित्र 3.2.9: िाइि-एंगि िेंस आस-पास की पृष्ठभूतम जयादा पेश करिे हैं

एक औि इफैक्ट जो ज़मू लेंस ऑफ़ि कितषे हैं, वह ह ैपुलड फोकस ्यह वह प्रवक्र्या ह ैजहां सीन का शुरुआती वहससा सामनषे वाली (फोिगाउंड) वकसी रीज़ 

पि शाप्भ  फोकस किता ह,ै जबवक बकैगाउंड िंुिला िहता ह।ै हालांवक, वफलम-वनमा्भता अरानक ही बकैगाउंड सषे दश्भकों को कोई रीज़ वदखाना राह सकतषे 

हैं, तो लेंस अरानक उस रीज़ पि िी-फोकस किषे रा औि ्यह एक दूिी पि उरि की आ्यषेरी, औि फोिगाउंड फोकस सषे बाहि हो जा्यषेरा (नीरषे)।
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तित्र 3.2.10: पुल्ि फोकस शॉट के पहिे और बाद में। यह फोरग्ाउंि पर शापटि फोकस और धुंधिे बवैकग्ाउंि से शुरू होिा हवै और धुंधिे फोरग्ाउंि और शापटि बवैकग्ाउंि पर खतम होिा हवै।

3.2.2.5 रिशआई िेंस (6-16रममी.)
वफशआई लेंस, कैमिषे  कषे  व्यपूवाइंट सषे, सीन कषे  180 वडगी तक बषेहद एगज़जैिषे वटड वाइड एंरल लेंस का इफैक्ट दषेता ह ै(नीरषे)। लेंसों कषे  ववजु़अल इफैक्ट्स शॉट 

को बडा ही ववरूवपत, वतृाकाि घुमाव दषेतषे हैं, जसैषे वक हम वकसी अत्यविक पिावत्भक वसल् वि बॉल पि दृश्य का प्रवतवबमब दषेख िहषे हों। वफशआई लेंस बषेहद 

औि, तंर/वसकुड़षे  परिवषेश में प्र्योर किना सवपोत्तम िहता ह,ै जहां कोई वाइड एंरल लेंस री पिूषे  सीन को नहीं समषेट पा्यषेरा। वकैवलपक तौि पि, वफशआई 

लेंस सीन को एक परिववत्भत सरषेतन एहसास दषे सकता ह,ै जसैषे मुख्य वकिदाि, वपए हुए, ड्र वलए हुए, ्या सववपनल हो। वफशआई लेंस दश्भकों कषे  वलए बहुत 

पिषे शानी वाला हो सकता ह ैऔि इसवलए ्यह कम सषे कम इसतषेमाल वक्या जाना रावहए, जब तक इफैक्ट में कोई असल उद्षेश्य न हो।

तित्र 3.2.11: कफशआई िेंस सीन को नाटकीय िौर पर तिरूतपि कर देिा हवै।
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3.2.3 िाइरटंग ि रिलटसटि
हम शॉट में लाइवटंर व वफलटस्भ कषे  इसतषेमाल की बात वकए वबना लेंसों की बात नहीं कि सकतषे। वफलटस्भ िंरीन जलै होतषे हैं, जो वदखाई दषेनषे वालषे िंर, टोन, 

्या कंट्ासट को अवतिंवजत/एगज़जैिषे ट कि दषेतषे हैं। आज कषे  दौि में आिुवनक वडवज़टल इमषेज मवैनपुलषेशन तकनीकों कषे  रलतषे हम इमषेज कैपरि किनषे कषे  

काफी वदन बाद री इसमें हि तिह कषे  रमतकािी बदलाव कि सकतषे हैं। , हालांवक, हि कोई मानता ह ैवक, कम सषे कम live-action फोटोगाफी में, इवच्त 

प्रराव पानषे का बषेहतिीन तिीका ्यह ह ैवक इमषेज, जब री संरव हो, वासतव में लेंस कषे  ज़रि्यषे ही कैपरि की रई हो। वफलटस्भ हमें कैमिषे  द्ािा वदखनषे वालषे 

दृश्य को सीवमत किनषे का ववकलप दषेतषे हैं। ्यषे लाइवटंर हॉट सपॉट्स (सिूज ्या लैंप आवद वक वकिणें व पिाववत्भत प्रकाश) को कम कि सकतषे हैं, ्यषे ्ा्या को 

बढा सकतषे हैं, औि ्यषे सतह की संिरना को री वनखाि सकतषे हैं वजसषे वक मानवी्य आंखें दषेख नहीं सकती। वफलटस्भ औि इनका प्र्योर ववष्य एक पिूी 

वकताब रि सकतषे हैं औि अरी इन सबकषे  बािषे  में बतानषे कषे  वलए प्या्भप्त जरह नहीं ह,ै लषेवकन इतना कहना प्या्भप्त होरा, वक उदाहिण कषे  वलए, एक कलि 

वफलटि दृश्य को एक मूड ्या टोन दषे सकता ह,ै जो वहां वासतव में मौज़दू नहीं थषे औि इस तिह दृश्य की नाटकी्यता बढा सकतषे हैं।

तित्र 3.2.12: ऊपरी-बायां तह्सा शॉट का मूि रंग हवै मगर इसके कुछ रंग हटाए गए हैं, तजससे यह बुतनयादी बिवैक एंि व्हाइट शॉट के जयादा नजदीक हो गया हवै। ऊपरी-दायां तह्सा कंट्ा्ट ब़िािा 
हवै और इसमें सेचयूरेशन शातमि करिा हवै। तनििा-बायां भाग एक शीि नीिे रंग का कफल्टर ट्ीटमेंट देिा हवै, जबकक तनििा-दायां, िाि रंग के कफल्टर जुड़ जाने से, कहीं जयादा ऊषण हवै।

3.2.4 ्ैकमरा मूवज़
ज्यादाति शॉट वसथि ्या वसथि कषे  नजदीक होतषे हैं, जो वफलम की प्रकृवत पि वनर्भि कितषे हैं। हालांवक, ्यह अक्सि जरूिी होता ह,ै वक कैमिषे  को एक्शन कषे  

साथ मूव वक्या जा्यषे, ्यह बतानषे कषे  वलए वक क््या रल िहा ह।ै उदाहिण कषे  वलए, एक आदमी रली में रल िहा ह,ै औि वखडवक्यों सषे दषेखता हुआ कोई रीज़ 

तलाश िहा ह।ै ्यवद कैमिा एक ही जरह वसथत हो, तो ्यह कोई वदलरसप ्या सरूनातमक शॉट शा्यद नहीं बन पा्यषेरा औि हम उस आदमी को दूि सषे रली 

में जातषे हुए दषेखेंरषे। आदमी कषे  साथ-साथ कैमिषे  को रलाना ज्यादा रूवरकि होरा, वासतव में उसषे हि वखडकी सषे झांकता हुआ दषेखना औि बवलक कैमिषे  को 

औि वसवंर किकषे  वखडकी सषे वह दषेखना, जो वह आदमी दषेख िहा ह।ै इस दृश्य को पिूा किनषे कषे  वलए वफलम-वनमा्भता कषे  पास कई तिह कषे  कैमिा मूवज़ 

उपलबि हैं।
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तित्र 3.2.13: सािधानीपूिटिक ककया गया शॉट ियनदशटिकरों को सीधे तिरयि्िु के भीिर िे जािा हवै।

3.2.4.1 स्थाई (Locked Down) शॉट
जसैा वक नाम सषे जावहि ह,ै ्यहां कैमिा नहीं रलता; ्यह वसथि अवसथा में िहता ह ैऔि इसकषे  सामनषे एक्शन होता ह।ै Live-action में, कैमिा वसथिता कषे  

वलए संरवत एक वतपाई पि वसथि िहषेरा, ्या एक डॉली पि री हो सकता ह ैवजसकषे  पवहए लॉक वकए रए हों। कैमिा वसथि शॉट में हाथ में पकडा हुआ री हो 

सकता ह ै(हैंड-हषेलड) (कैमिामनै द्ािा, वबना वकसी वतपाई सा डॉली कषे  प्र्योर सषे), ्यद्वप, इससषे वनससंदषेह शॉट को हलकी सी मूवमेंट वमलषेरी, जो वांव्त 

हो सकती ह।ै कई टीवी कॉप ड्ामा शोज़, एक्शन में अविक वासतववक मानव उपवसथवत वदखानषे कषे  वलए खासतौि सषे हैंड-हषेलड इफैक्ट का प्र्योर कितषे हैं, 

राहषे कैमिा वफक्सड ्या मूववंर पोज़ीशन में ही क््यों न हो।

तित्र 3.2.14: एक locked-down िाइि शॉट

3.2.4.2 Tracking (Panning) शॉट
Live action में, tracking शॉट वह होता ह ैवजसमें कैमिा एक्शन कषे  साथ साथ रलता ह,ै जसैषे हमािषे  आदमी कषे  साथ, जब वह वखडवक्यों सषे झाँकता हुआ 

रली सषे रुज़िता ह।ै इसषे पानषे कषे  वलए, कैमिा असल में डॉली पि वफट वक्या जाता ह ैजो वक एक िषे लिोड जसैषे ट्कै कषे  ऊपि सीिी वसथि होती ह ैऔि ्यह 

एक्शन कषे  समानांति वब्ाई रई होती ह।ै जसैषे आदमी रलता ह,ै कैमिा उसकषे  पी ष्े , ट्कै कषे  साथ साथ रलता ह,ै ्यह दश्भकों को उसकषे  द्ािा की रई हिषे क 

रीज़ दषेखनषे में सक्म बनाता ह।ै ट्षेवडशनल एवनमषेशन में, एक्शन कषे  साथ-साथ रलनषे कषे  समान इफैक्ट ्या वकसी बकैगाउंड आट्भवक्भ  कषे  वाइड पीस, जो वक 
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सक्रीन ववड्थ सषे री ज्यादा रौडा हो, पि मूव किनषे को पवैनंर कहा जाता ह।ै Panning क्वैतज हो सकती ह ै्या लंबवत, जसैषे वकसी ऊंरी वबवलडंर में ऊपि 

की ओि रढतषे हुए, ्या ऊँराई सषे वरिकि ज़मीन की ओि आतषे हुए, आवद।

तित्र 3.2.15: पेड़रों के झुरमुट से होिे हए एक संकरे रा्िे का एक पूणटि 360-तिग्ी tracking/panning शॉट। यह ऊपरी-दाएं भाग में शुरू होिा हवै, ऊपरी िेयर के साथ दाएं से बाएं पवैन होिा हवै, 
और कफर तनििी िेयर के साथ दाएं से बाएं। आतखरकार, एकशन तनििे-बाई ओर के भाग में िापस अपनी मूि अि्था में िौट आिा हवै।

3.2.4.3 जू़म शॉट
ज़मू शॉट वह होता ह ैवजसमें कैमिा एक्शन कषे  अंदि ्या बाहि आता जाता ह।ै ्यह ज़मू लेंस कषे  इसतषेमाल कषे  जरिए वक्या जा सकता ह ै(जसैा वक पहलषे ररा्भ 

की जा रुकी ह)ै ्या असल में सीिषे एक्शन की वदशा में वब्ा्यषे र्यषे ट्कै पि कैमिा डॉली किकषे । कैमिा ट्कै कषे  एक वहससषे सषे शुरू हो सकता ह ैजोवक सीन 

तित्र 3.2.16: पहिी बार में, हमारे मुखय कवै रेकटर, Kermik का कोई तनशान नहीं हवै। हािांकक, जवैसे कवै मरा जू़म इन होिा हवै, आपका धयान उसकी तछपने की जगह पर जािा हवै।
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सषे बषेहद दूि हो, औि वफि इसषे एक्शन की ओि मूव वक्या जा सकता ह,ै ्यह इफैक्ट दषेतषे हुए वक एक्शन नज़दीक आ िहा ह ैऔि इसवलए सक्रीन पि बडा 

वदखाई दषेनषे लरता ह।ै ्यषे री हो सकता ह,ै वक वकसी शॉट कषे  ज़मू इन ्या ज़मू आउट में कोई एक्शन हो ही ना। ्यह एक बडषे सीन कषे  रीति वकसी खास प्रॉप 

्या वसतु का पता लरानषे कषे  वलए री इसतषेमाल हो सकता ह,ै जो ्या तो पहलषे सषे ही वदख िही हो औि कैमिा ज़मू आउट हो, ्या वफि एक दूिी पि हो औि कैमिा 

ज़मू इन किषे ।

3.2.4.4 िॉिी (के्रन) शॉट
डॉली (्या क्रषे न) शॉट अवनवा्य्भ  रूप सषे ट्कै व ज़मू शॉट का एक सं्योजन ह,ै वफि री ्यह इससषे कहीं ज्यादा हो सकता ह।ै रली में रलतषे हमािषे  आदमी का 

उदाहिण वफि सषे लषेतषे हैं, कैमिा पी ष्े  सषे एक वाइड शॉट सषे उसषे दषेख सकता ह ै(एक बडषे शॉट में उसषे व रली को एसटवैबलश कितषे हुए), औि आरषे बढकि वमड 

शॉट लषेतषे हुए उसकषे  साथ-साथ औि वफि आवखिी में उसकषे  सामनषे, उसका रषेहिा औि उस वखडकी कषे  रीति, वजसमें वह झांक िहा ह,ै का एक क्लोज़-अप 

लषेतषे हुए। इसषे हावसल किनषे कषे  वलए, ओपवनंर शॉट कषे  वलए कैमिा लेंस को अवनवा्य्भ  रूप सषे वाइड ज़मू किता ह,ै जब ्यह उस आदमी कषे  पी ष्े  रारतषे हुए (वफि 

तित्र 3.2.17: यहॉं ए्टवैतबिपशंग वू् में Kermik ्पष्ट कदखाई दे रहा हवै, और साथ ही, िह पूरी िोकेशन भी तजसमें िह मौजू़द हवै। दशटिकरों का धयान आस-पास के 
पररिेश से हटाकर उसकी मुखाकृतियरों पर कें करिि करने के तिए कवै मरा उसके िहरे और उसके आस-पास िॉिी करिा हवै।
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री उसकषे  एक्शन कषे  समांति) ट्कै कषे  वसिषे  पि होता ह।ै ज़मू इन किता ह,ै जब कैमिा डॉली ट्कै में उसकषे  साथ-साथ मूव किती ह,ै वफि औि नज़दीक ज़मू 

इन किता ह,ै जब कैमिा उस आदमी औि वखडकी कषे  आरषे ट्कै पि अपनी फाइनल पोज़ीशन पि मूव किता ह।ै ज़मू शॉट, वनवश्चत तौि पि इससषे री आरषे 

जा सकतषे हैं। वासतव में ्यषे सबजषेक्ट कषे  इद्भ -वरद्भ  पिूा 360 वडगी घमू सकतषे हैं औि तब तक घमूतषे िह सकतषे हैं, जब तक उनका रुकना ज़रूिी न हो।

खासतौि सषे एक सीन रिण बद्ध तिीकषे  सषे इन शॉट्स सषे होकि रुजिता ह,ै एसटवैबलवशंर शॉट सषे शुरु होतषे हुए, मीवड्यम शॉट पि, वफि मीवड्यम क्लोज़-अप 

औि वफि क्लोज़-अप तक। ऐसा पटैन्भ  ज़ावहि ह,ै इफैक्ट्स कषे  वलए बदला जा सकता ह ैऔि अक्सि बदला री जाता ह।ै कु् अन्य शॉट्स री सटैंडड्भ  पटैन्भ  कषे  

होतषे हैं:

सीन दर सीन ट्ांज़ीशन

हिषे क शॉट, वकसी न वकसी तिीकषे  सषे, दूसिषे  शॉट पि जाता ह।ै आम तिीका एक कट कषे  साथ का ह,ै लषेवकन ऐसा नहीं री हो सकता ह।ै अन्य ट्ांज़ीशन री 

ह,ै जो उपलबि हैं, वजनमें सषे प्रत्यषेक सीन परिवत्भन की एक अलर व्याख्या पषेश किता ह।ै ्यहां बषेहद लोकवप्र्य में सषे कु् वदए जा िहषे हैं औि उनहें इसतषेमाल 

किनषे कषे  संराववत कािण री।

्कट

तित्र 3.2.18: यहां, एतनमेटर के िाइटबॉकस पर िाइट धीरे धीरे धुंधिी पड़िी हवै।

तित्र 3.2.19: कट ट्ाुँज़ीशन।

वफलम-वनमा्भण में कट इतना आम ह,ै वक इसषे शा्यद ही परिरावषत किनषे की आवश्यकता हो। कट सिल तौि पि, एक सीन को समाप्त कि दूसिषे  सीन पि 

जाना ह,ै बीर में कु् नहीं। एक सीन का आवखिी फ्षे म सीिषे अरलषे सीन कषे  प्रथम फ्षे म सषे वमलता ह।ै इसवलए कट सबसषे सिल औि सीिाा ट्ांज़ीशन ह ैऔि 

संरवत: 90 प्रवतशत सषे ज्यादा सम्य ्यषे ही इसतषेमाल वक्या जाता ह।ै

Dissolve

इस दृवष्ट सषे Dissolve थोडा सौम् ्य ट्ांज़ीशन दषेता ह,ै क््योंवक इसमें कई फ्षे मस में पहला सीन िीिषे -िीिषे  जाता ह ै औि अरला सीन िीिषे -िीिषे  उरिता ह।ै 

Dissolve बहुत थोडषे फ्षे मों पि हो सकता ह ै(अक्सि “सॉफट कट” कषे  नाम सषे जाना जाता ह)ै ्या ्यह ट्ांज़ीशन कषे  प्रकाि कषे  वहसाब सषे, पिूा होनषे में कु् 

सकैें ड्स लषे सकता ह।ै उदाहिण कषे  वलए, एक summer country setting, एक समान शॉट में dissolve हो सकती ह ै(एक “match dissolve”) वजसषे अब पतझड 

्या सवद्भ्यों में दषेखा जा सकता ह।ै जहां कट एक घूंसा मािनषे जसैा ह,ै वहीं dissolve दुलािनषे जसैा।

तित्र 3.2.20: एक सीन से अगिे में dissolve होना।
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3.2.4.5 Fade
Fade एक ऐसा उपकिण ह ैजो एक ईवेंट को समाप्त किता ह,ै एक वबलकुल न्यषे ईवेंट की शुरुआत कषे  वलए Fade तब इसतषेमाल वक्या जाता ह ैजब एक सीन 

सषे दूसिषे  में परिवत्भन एक सौम् ्य तथा काव्यातमक ढंर सषे रावह्यषे हो, जहां मूड तथा पषेस (ल्य) में बदलाव रावह्यषे हो ्या जहां सम्य को आरषे बढाकि वदखाना 

हो। Fade में, तसवीि पहलषे िीिषे  िीिषे  बलकै ्या वहाइट में dissolve होती ह,ै वफि उसी वहाइट ्या बलकै में सषे अरला सीन वनकल कि आता ह/ैdissolves होता 

ह।ै दश्भकों कषे  मन में वनवश्चत रूप सषे मौज़दूा दृश्य की जो कु् अनुरवूत्यां शषेष िह रई होती हैं, इस तिह सषे उनहें, अरलषे दृश्य कषे  उनकी रषेतना में आनषे सषे 

पहलषे, इन अनुरवूत्यों सषे वनकलकि अपनी तंरिा में लौटनषे का सम्य वमल जाता ह।ै बषेशक, ्यह बलकै (्या वहाइट) कषे  साथ कट किकषे  अविक शीघ्रता सषे वक्या 

जा सकता ह,ै बजा्य सीिषे न्यषे सीन में कट किनषे कषे । हालांवक, fade पिूी तिह सषे एक मूड ्या रावना की दूसिी में ट्ांज़ीशन की कोरि्योगावफंर ह ैऔि 

इसवलए ्यह ज्यादा काव्यातमक तकनीक ह।ै

बलकै ्या वहाइट कषे  बीर र्यन थोडा जवटल ह ैऔि ्यह इच्ानुसाि हो सकता ह।ै सबसषे आम पसंद बलकै ह।ै मषेिी समझ ह ैवक बलकै में fade ज्यादा िीमा, 

प्राववत्भत, औि अरषेतन अहसास वाला होता ह,ै जबवक वहाइट में fade ज्यादा प्रत्यक् होता ह ैऔि इसवलए इसमें ज्यादा रषेतना,सवक्र्यता, व ऊजा्भ  का अहसास 

होता ह।ै

तित्र 3.2.21: fade ट्ांज़ीशन

3.2.4.6 Wipe
wipe इन वदनों कम इसतषेमाल होनषे वाला एक ट्ांज़ीशन ह,ै हालांवक ्यह वफलममषेवकंर कषे  शुरुआती वदनों में बषेहद आम था। बुवन्यादी तौि पि, wipe तब आता 

ह ैजब आनषेवालषे सीन की इमषेज सक्रीन को साफ (wipe) किती रलती ह,ै आवखिकाि वप्लषे सीन की इमषेज को वमटा डालती ह।ै Wipe क्वैतज, लंबवत, वतृ 

में, सवप्भल, औि कई पटैन्भ  में हो सकतषे हैं, जसैषे रकैिबोड्भ  ज्यादाति वडवज़टल एवडवटंर सॉफटवषे्यि, जसैषे वक Apple Final Cut औि Adobe Premiere, में रुननषे 

कषे  वलए कई built-in wipes ह,ै मरि wipe अक्सि एक्शन में दखल दषेनषे वालषे होतषे हैं औि वबना खास वजह कषे  इसतषेमाल वकए जानषे पि बनावटी लर सकतषे 

हैं, जसैषे कोई वववशष्ट शलैी (genre) की मूवी जो 1920 की मूवी का मूड िीवक्रएट किनषे का प्र्यास किषे ।

तित्र 3.2.22: िाइप ट्ांज़ीशन

3.2.4.7 Ripple और अनय सपेशि इिैकट्स Dissolves
्यह एक औि कम इसतषेमाल होनषे वाला ट्ांज़ीशन ह,ै वजसका उललषेख वक्या जाना रावह्यषे, क््योंवक कु् परिवसथवत्यों में इसकी एक cliché value (वघसा-

वपटा मूल्य) ह।ै रिपल वडज़ॉलव इफैक्ट में एक सामान्य वडज़ॉलव जसैा होता ह,ै अंति कषे वल इतना ह,ै वक जब ट्ांवज़शन होता ह ैतो इसमें रिपवलंर वाटि इफैक्ट 

पदैा होता ह।ै रिपल वडज़ॉलव का इसतषेमाल तब होता ह ैजब वफलम वकसी ड्ीम वसक्वेंस ्या वकसी हलै्यवूसनषेट्ी (भ्रवमत किनषे वाली आवाज़ें अथवा दृश्य) 

सीक्वेंस में प्रवषेश किती ह ै्या एक्शन पानी में नीरषे की ओि जा िहा हो। वाइप की तिह ही रिपल वडज़ॉलव री कई मामलों में एक वप्रवडक्टषेबल ट्ांज़ीशन 

वडवाइस बन र्या ह,ै हालांवक ्यवद इसका इसतषेमाल वकफा्यत औि समझदािी सषे वक्या जा्यषे, तो ्यह प्ररावी हो सकता ह।ै
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तित्र 3.2.23: प्रीतमयर में बना एक ररपि तिज़ॉल्ि

3.2.5 सक्रीन आसपकैट रेरशयो
अनतत: वफलम वनमा्भण कषे  वासतववक िरनातमक पहल ूमें प्रवषेश किनषे सषे पहलषे एक आवखिी रीज़ जो वफलम वनमा्भता को अवश्य ध्यान में िखनी रावहए, 

वह ह ैफॉमदेट ्या सक्रीन िषे श्यो (अनुपात)। वफलम दषेखतषे सम्य, हम सक्रीन िषे श्यो को कोई महत्व ही नहीं दषेतषे, राहषे ्यह कोई वसनषेमा वफलम हो, टीवी शो हो, 

डीवीडी मूवी हो अथवा वषेब आिारित एवनमषेशन। हालांवक, सक्रीन माप अनुपात कषे  वलहाज़ सषे प्रत्यषेक को सखती सषे परिरावषत वक्या र्या ह ैऔि इसवलए 

्यह आवश्यक ह,ै वक आप हिषे क कषे  लारों तथा हावन्यों सषे अवरत हों।

सटैंडड्भ  एकषे डमी (इसषे 4:3 ्या 1.33:1 फॉमदेट री कहा जाता ह)ै वह फॉमदेट ह,ै वजसका इसतषेमाल वफलम तथा टषेलीववज़न प्रोडक्शन में सवा्भ विक होता ह।ै सटैंडड्भ  

एकषे डमी सक्रीन आकाि की बुवन्यादी ज़रूित ्यह ह ैवक इसषे 4 ्यवूनट्स रौडा औि 3 ्यवूनट्स ऊँरा होना रावहए, वजसका अथ्भ ्यह ह ैवक, फ्षे म आ्याम की हि 

राि इकाई रौडाई कषे  वलए इसषे तीन इकाई ऊँरा होना रावहए। सटैंडड्भ  एकषे डमी को TV एकषे डमी री कहा जाता ह।ै

वफलम एकषे डमी दषेखनषे में बहुत कु् सटैंडड्भ  एकषे डमी aspect ratio कषे  समान ही होता ह,ै वसवा्य इसकषे , वक इसका 

वासतववक सक्रीन िषे श्यो 1.37:1 होता ह।ै वासतव में, इसकषे  सटैंडड्भ  एकषे डमी फॉमदेट कषे  समान होनषे का आरास होता ह।ै 

हालांवक, ्यवद आपको कोई संदषेह हो, तो हमषेशा 1.37:1/ सटैंडड्भ  एकषे डमी आकाि कषे  वलए ही काम किें , इसमें ज्यादा सषे 

ज्यादा बुिा ्यह हो सकता ह,ै वक जब इसषे टीवी पि वदखा्या जा्यषेरा, तो ्वव्यों/तसवीिों का ऊपि का एक वहससा रा्यब 

हो जा्यषेरा।

वाइडसक्रीन में 1.85:1 का िषे श्यो होता ह ैऔि इसमें वफलमकाि कषे  वलए दोनों एकषे डमी फॉमदेट्स कषे  मुकाबलषे एक वनवश्चत 

लार होता ह,ै क््योंवक इसमें अविक लैंडसकषे प शषेप होती ह,ै जो वफलमी लैंडसकषे पस औि ववहंरम/ पनैोिैवमक दृश्यों में सव्ंय 

को अविक सौंद्य्भ कषे  साथ प्रसतुत किता ह।ै इसका अथ्भ ्यह ह ै वक वाइडसक्रीन फॉमदेट कषे  साथ, तसवीिों में अविक 

व्यापकता तथा आ्याम समषेवकत वक्यषे जा सकतषे हैं, वजससषे एवनमषेवटड वफलम-वनमा्भता कषे  वलए रीज़ों की ्वव औि 

बषेहति हो जाती ह।ै वाइडसक्रीन एक काफी लोकवप्र्य फॉमदेट ह,ै वजसषे आसानी सषे कहीं री सक्रीन वक्या जा सकता ह।ै 

वाइडसक्रीन वफलम की ्यह खामी ह ैवक जब उनहें TV पि वदखा्या जाता ह,ै तो उनहें ्या तो लषेटिबॉक्सड वक्या जाता ह ै

(सक्रीन कषे  ऊपि औि नीरषे एक काली पट्ी होती ह,ै जो इसषे एकषे डमी फॉमदेट सक्रीन पि दषेखनषे ्योग्य बनाती हैं) ्या इमषेज 

क्रॉप कि दी जाती हैं (वजससषे वफलम इमषेज टीवी सक्रीन पि ववट्भकली वफट हो जा्यषे, लषेवकन दाई ंतथा बाई ंओि सषे इसकी 

कु् इमषेज रा्यब हो ही जाती हैं)। वकसी वाइडसक्रीन इमषेज को एकषे डमी फॉमदेट में सक्वीज़ किनषे का कोई उप्ुयक्त 

तिीका नहीं ह,ै पि मषेिा सुझाव ह ैवक, एक वफलमकाि कषे  नज़रिए सषे, पहला ववकलप, दूसिषे  कषे  मुकाबलषे कहीं अविक 

उप्ुयक्त ह।ै

वसनषेमासकोप (वजसषे “सकोप” री कहा जाता ह)ै अन्य सरी वफलम फॉमदेट्स कषे  मुकाबलषे एक वबलकुल अलर प्रणाली का 

प्र्योर किता ह।ै सकोप मटैीरि्यल एक ववशषेष लेंस कषे  ज़रि्यषे शॉट तथा प्रोजषेक्ट होता ह,ै वजसषे एनामॉवफ्भ क लेंस कहतषे 

हैं। ्यह लेंस अरल-बरल सषे वफलम इमषेज को सक्वीज़ किता ह,ै वजसका नतीजा ्यह होता ह ैवक जब कोई एकल इमषेज 

को नंरी आँखों सषे दषेखता ह ैतो वपक्रि क्वैतज रूप सषे वपरक जाएरी। हालांवक, वकसी एनामॉवफ्भ क लेंस सषे होकि 
तित्र.3.2.24: ्टैंििटि एकेिमी आ्पेकट 
रेतशयो 
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सषेकें ड पास कषे  बाद, सक्रीन पि प्रदवश्भत होतषे सम्य वफलम इमषेज वफि सषे फैल जाती ह।ै सकोप एवनमषेशन का सक्रीन िषे श्यो वाइडसक्रीन कषे  मुकाबलषे औि री 

रौडा ववहंरम दृश्य उपलबि किाता ह।ै वकसी सकोप सक्रीन साइज़ का आविकारिक फॉमदेट 2.35:1 होता ह,ै वजसका अथ्भ ह ैवक आट्भवक्भ  की प्रत्यषेक ्यवूनट 

ऊँराई कषे  वलए इसषे 2.35 ्यवूनट रौडा होना रावह्यषे।

प्रदवश्भत होनषे पि सकोप सवा्भ विक आकष्भक, एवपक-सटाइल वपक्रि बनाता ह।ै हालांवक टषेलीववज़न प्र्योर कषे  वलए ्यह वबलकुल री उप्ुयक्त नहीं ह,ै क््योंवक 

इसमें वाइडसक्रीन कषे  मुकाबलषे औि री ज्यादा लषेटिबॉवक्संर तथा क्रॉवपंर किनी पडती ह।ै

हाई डषेवफनषेशन फॉमदेट हाई डषेवफनषेशन TV की शुरुआत सरी फॉमदेट में मानकीकिण लानषे कषे  प्र्यास सवरूप की रई ह ैवजसमें वाइडसक्रीन फॉमदेट कषे  कई 

ववजु़अल फा्यदषे वमलतषे हैं, पि इसकषे  वलए अत्यविक लषेटिबॉवक्संर ्या क्रॉवपंर की ज़रूित नहीं होती, जो वकसी टीवी सक्रीन पि वदखानषे कषे  दौिान एकषे डमी 

में किना किना पडता ह।ै हाई डषेवफनषेशन कषे  वलए अपषेवक्त िषे वश्यो 1.78:1 (्या 16:9) होता ह,ै वजसका अथ्भ ह ैवक हि एक ्यवूनट ऊँराई कषे  वलए रौडाई 1.78 

्यवूनट्स होरी।
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4. Rotoscoping िुटजे

्यवूनट 4.1 – Rotoscoping एवनमषेशन बनाना

्यवूनट 4.2- एवनमषेशन कषे  वलए प्र्ुयक्त टूलस

MES/N 3506
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. Rotoscoping एवनमषेशन बना्यें

2. बाज़ाि में प्रोडक्शन कषे  वलए उपलबि वववरनन प्रकाि कषे  सॉफटवषे्यि टूलस सषे परिवरत होनषे में।

3. प्रोडक्शन कषे  वलए सवपोत्तम टूल की खोज किनषे औि सुझाव दषेनषे में।

4. प्रोडक्शन कषे  वलए प्रोडक्शन शषेड््यलू कषे  अनुसाि सम्य-सीमाओ ंका मूल्यांकन किनषे में।

रनष्कषटि 
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यूरनट 4.1: Rotoscoping एरनमेशन बनाना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Rotoscoping क््या ह,ै ववसताि सषे बता्यें

2. Rotoscoping एवनमषेशन बना्यें

यूरनट ्ेक उद्ेशय  

4.1.2 ्कीफे्म इंटरपोिशेन
आिंर में एवनमषेशन, समग रूप में शषेप कषे  वलए ट्ांसलषेशन, िोटषेशन, सकषे ल तथा सक््य ूपरिरावषत किनषे कषे  वलए, हैंडलस का प्र्योर किकषे  रिवजट बॉडी 

ट्ांसफॉमदेशन कषे  प्र्योर सषे की जाती ह।ै  वफि अलर-अलर कंट्ोल पवाइंट्स वसलषेक्ट तथा ट्ांसफॉम्भ  किकषे  नॉन-रिवजड वडफॉमदेशन त्ैयाि वक्या जाता ह।ै 

जहां संरव हो, ्यह पवांट्स कषे  समूह मॉवडफाई किकषे  री वक्या जा सकता ह।ै एवनमषेशन वक्रएट किनषे की दो मानक वववि्यां हैं, ्या तो शॉट पि की पोवज़ज 

का वमलान किकषे  औि वफि जहां ज़रूित हो इंटिमीवडएट कीफ्षे मस की बािी-बािी सषे सबवडवाइवडंर तथा एवडंर सषे ्या वफि एक शॉट में क्रमानुसाि आरषे बढ 

कि हि आवखिी (nth) फ्षे म पि एक कीफ्षे म वक्रएट कितषे हुए। शॉट कषे  शषेष फ्षे म वफि अपनषे आस-पडोस कषे  कीफ्षे म सषे एक पंवक्त बनातषे हुए वबठा वदए जातषे हैं 

(लीवन्यि इंटिपोलषेशन)।

4.1.3 ट्रै्ंकग ्ेक सा्थ एकसीिरेेशन
्यवद शॉट में वकसी प्रकाि की ट्वैकंर की जा सकषे , तो वक्भ फलो में सक्मता (एवफवशएंसी) हावसल की जा सकती ह।ै एक मरै-मूवड कैमिा द्ािा ऑबज़व्भ वकए 

रए रिवजड सीन कषे  एक आदश्भ मामलषे में, ज्योमवैट्क कंसट्ेंट्स/अविोिों को िोटो-शषेपस को सही तिीकषे  सषे मूव किानषे हषेतु काम में ला्या जा सकता ह।ै इन 

दृश्यों को आसान शॉट माना जाता ह ैऔि इन पि ्यहां आरषे ववराि नहीं वक्या र्या ह।ै अविक वासतववक वसनषेरि्यो/परिदृश्य एक मूववंर एलीमेंट का ह,ै जो 

शॉट में वबलकुल अलर ह।ै इस मामलषे में, ्यह संरव हो सकता ह।ै

कंट्ोल पवाइंट्स कषे  गुप को संरावलत किनषे कषे  वलए 2D का प्र्योर ्या पलानि ट्वैकंर का प्र्योर किकषे  रिवजड बॉडी एवनमषेशन परिरावषत की जा  

सकती ह।ै

ट्वैकंर में आमतौि पि सािषे  इमषेज फ्षे मस में इमषेज अपी्यिें स का वमलान किनषे कषे  वलए गषेवडएंट-वडसेंट आिारित ऑवपटमाइज़षेशन का प्र्योर वक्या जाता ह।ै 

पलानि ट्वैकंर में इसी तिह का फ्षे मवक्भ  प्र्योर वक्या जाता ह,ै वजसमें एक मासक कषे  रीति pixels कषे  वलए फ्षे मस कषे  बीर में पिैामीटिाइजड वाप्भ  कषे  आिाि 

pixel रिज़न ट्कै वकए जातषे हैं। ्यषे पद्धवत्यां सर्भ िें ज को ववसततृ कि सकती हैं औि इमषेज वपिावमड्स में कॉस्भ-टु-फाइन pixels का वमलान किकषे  ट्वैकंर को 

एक्सीलषेिषे ट कि सकती हैं। ्यवद वीवड्यो में सपष्ट रूप सषे परिरावषत एवजज़ उपलबि हों, तो डा्यिषे क्ट कव्भ ट्वैकंर एक प्ररावी ववकलप ह।ै

4.1.1 मान्क ्कायटि-प्रिाह/सटैंििटि ि्कटि फिो
वकसी शॉट में एक एलीमेंट को िोटोसकोप किनषे कषे  वलए आवट्भसट क्लोजड सपलाइंस का एक सषेट त्ैयाि किता ह,ै जो एलीमेंट कषे  वलए कमपोनेंट शषेपस 

परिरावषत कितषे हैं। उदाहिण कषे  वलए, वकसी व्यवक्त को िोटोसकोप किनषे कषे  वलए, प्रत्यषेक आवट्भक््यलूषेवटड एलीमेंट कषे  वलए िोटो-शषेपस त्ैयाि की जाती हैं, 

जसैषे ऊपिी तथा वनरली बाहें, हाथ, अँरुवल्यां तथा रषेहिा। वफि शॉट की मूवमेंट सषे तालमषेल वबठानषे कषे  वलए आवट्भसट इन शषेपस को सवतंत्र रूप सषे मवैनपुलषेट 

किता ह।ै Rotoscoping का काम, मूवमेंट को समझनषे तथा ्यह दषेखनषे कषे  वलए वक सीन/दृश्य को अलर-अलर मूवमेंट में कैसषे तोडना ह,ै शॉट कषे  ववश्षे षण 

सषे शुरू होता ह।ै

वफि एक की पोज़ रुन वल्या जाता ह,ै जो प्रत्यषेक शषेप की आउटलाइन को परिरावषत किता ह,ै वफि आवट्भसट शषेप को एनीमषेट किनषे कषे  वलए बाहि सषे/

आउटवाड्भ  काम किता ह।ै



6968

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

4.1.4 Rotoscoping एरनमेशन बनाना

4.1.5 सपेशि इिैकट (2D और 3D)
प्रोडक्शन ्यवद काफी बडा होता ह,ै वहाँ एवनमषेटि कषे  काम को मदद किनषे कषे  वलए वनवश्चत रूप 

सषे एक सपषेशल इफैक्ट ववरार होरा। सपषेशल इफैक्ट में वकसी शॉट में आर लरनषे ्या वबजली 

कडकनषे कषे  इफैक्ट सषे लषेकि, ज़बद्भसत तफूान पदैा किनषे ्या 3D मूवीज में जवालामुखी फटनषे कषे  

इफैक्ट तक कु् री हो सकता ह।ै खासतौि सषे 3D एवनमषेशन में इतनी सािी पिसपि-व्याप्त 

(ओविलवैपंर) वववशष्टताएं होती हैं, वक ्यह जानना कवठन हो जाता ह,ै वक कहाँ "एवनमषेशन’’ 

खतम होता ह ैऔि कहॉ ं"सपषेवश्यल इफैक्ट्स’’ शुरू होतषे हैं। उदाहिण कषे  वलए डा्यनोसोस्भ को 

एवनमषेट किनषे का मतलब कषे वल एक रीमका्य जीव मॉडल को सक्रीन पि मूव किना रि नहीं 

ह।ै आजकल, दश्भक खाल कषे  अंदि मांसपषेवश्यों की हिकत औि तो औि रवतशील मांस-पषेवश्यों 

पि खाल का उताि-रढाव री दषेखनषे की अपषेक्ा िखतषे हैं। इसषे अलर-अलर ववशषेषज् प्रदवश्भत 

कितषे हैं, पि क््या उनहें एवनमषेटि ्या सपषेशल इफैक्ट आवट्भसट कहा जाता ह?ै

तित्र 4.1.1: एतनमेरटि इफवै क्टस: ्पीि िाइंस िथा ि्ट किाउडस (धूि 
के बादि) जवैसे बेहद सादा िथा परमपरागि से िेकर आधुतनक हॉिीिुि 
एकशन मूिीज जवैसे बेहद पररषकृि िक ति्िृि हैं।

4.1.6 (2D) ्की जाँच ्करना
जब 2D प्रोडक्शन में सािा एवनमषेशन पिूा हो जा्यषे, तो काम कषे  कलरिंर, सकैवनंर ्या वफवलमंर 

में आरषे जानषे सषे पहलषे ्यह जाँर लषेना बषेहद ज़रूिी ह,ै वक सब कु् वबलकुल सही ह ै वक नहीं। 

वकसी काम को दोबािा किनषे में लरनषे वाली लारत सषे हि कीमत पि बरना रावह्यषे। इसवलए 

्यह जाँरना वक सरी ड्ॉइंर मौजदू हों; अन्य ववरारों कषे  वलए एवनमषेटि द्ािा वद्यषे र्यषे वनददेश 

सटीक औि सपष्ट हों; औि ्यहाँ तक वक सरी आट्भवक्भ  वडवजटल सकैवनंर, कलरिंर ्या वफवलमंर 

कषे  वलए उप्ुयक्त हों, सरी 2D प्रोडक्शन कषे  वलए एक महत्वपणू्भ  रिण ह।ै ववशषेषज् ्यषे सब 

व्यववसथत (हैंडल) कि लेंरषे, लषेवकन उनहें एवनमषेटि कहा जाता ह ै्या सपषेवश्यल इफैक्ट आवट्भसट?

तित्र 4.1.2 तनरीक्ण (2D)

चरण 1: शुरुआती िोटो-कवस्भ चरण 2: एवनमषेटि सबसषे बाई ंओि कषे  कीफ्षे म पि रिश सट्ोक ड्ॉ किता 

ह,ै जो िोटो-कव्भ कषे  साथ एसोवसएट हो जाता ह ैऔि इस एसोवसएशन सषे 

अरलषे फ्षे मस कषे  वलए नए सट्ोक वक्रएट वकए जा सकतषे हैं।

चरण 3: (b) कषे  समान ही, कषे वल सट्ोक पी ष्े  की ओि प्रसारित होतषे हैं चरण 4: कीफ्षे मस कषे  बीर कषे  सट्ोक बलैंड कि वदए जातषे हैं।
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4.1.7 स्ैकरनंग (2D)
जब सरी ड्ॉइंर पिूषे  हो जातषे हैं, तो उनकी अलर-अलर सकैवनंर औि नमबरिंर की जाती ह।ै आज कल वडवजटल सकैवनंर ज्यादा सषे ज्यादा पसंदीदा ववकलप 

हो र्या ह ै(िोसट्म कैमिा का इसतषेमाल किनषे वाली पािंपरिक वफवलमंर कषे  मुकाबलषे), क््योंवक ज्यादाति सकैं ड फाइलें अविक क्लीन होती हैं औि वडवजटल 

प्रोडक्शन प्रवक्र्या में उनहें प्रबंवित किना अविक आसान होता ह।ै (हालांवक व्यावसाव्यक वडवजटल िोसट्म कैमिा महंरा होता ह,ै पि ्यह कैमिा सकैन 

इमषेवजज को टक्कि दषे सकता ह ैऔि प्रोड््यजू़/वनमा्भण में काफी तषेज़ होता ह।ै)

लाइन क्वावलटी ्यवद प्या्भप्त रहिी हो औि लाइन में कु् ही रिषेक्स ्या पषेपि गषेन हों, तो ओरिवजनल पेंवसल ड्ॉइंगस को सकैन किना औि वडवजटल तौि पि 

कलि किना संरव ह।ै हालांवक, सकैवनंर कषे  वलए काली लाइन सबसषे अच्ी होती ह,ै वजसका अथ्भ ह ैवक पेंवसल ड्ॉइंगस का जब पिीक्ण हो जाता ह ैऔि 

मंजिूी वमल जाती ह,ै तो उसषे सकैवनंर प्रवक्र्या आिंर होनषे सषे पहलषे क्लीन-अप औि इंक इन (जसैषे वक आिंवरक पेंवसल सकषे चड लषेआउट पिूा हो जानषे कषे  बाद 

वरत्रकथा की वकताब को इंक इन वक्या जाता ह)ै किना रावहए। सकैनि पि प्राइमिी कलि वफलटि कषे  साथ अंवतम सकैन सषे सरी नीली पेंवसल की 

कंसट्क्शन लाइंस को (नीरषे वद्या वरत्र दषेखें) हटा्या जा सकता ह।ै इससषे बषेवसक इंक्ड-इन ड्ॉइंगस सॉवलड-लाइन वफवनशड कैिषे क्टि में बदल जाती हैं, जो 

वडवजटल कलरिंर कषे  वलए त्ैयाि होती हैं।

तित्र 4.1.3: प्राइमरी किर कफल्टर से ्कवै न करने पर ही कोई इंकि-इन ड्ॉइंग किटरंग के तिए िवैयार होिा हवै।

4.1.8 ्किररंग (2D)

जब पिूा आट्भवक्भ  वडवजटल फॉम्भ  में आ जा्यषे, तो वडवजटल पेंट प्रोगाम कषे  साथ कलि डालना 

अपषेक्ाकृत आसान होता ह।ै हालांवक इन वदनों वडवजटल एवनमषेशन कषे  दो बषेवसक फॉम्भ  रल िहषे हैं: 

vector तथा raster। Vector एवनमषेशन वबै तथा Flash एवनमषेशन कषे  वलए अविक उप्ुयक्त होता ह,ै 

हालांवक 2D कषे  वलए पेंवसल ड्ॉइंर क्मताओ ंवालषे डषेसकटॉप एवनमषेटस्भ ।

तित्र 4.1.4: होपल्िंग िाइंस हटने से इस बिवैक एंि व्हाइट 
कवै रेकटर पर शेर बिे फिवैट किर अपनी िरह का एक कदिि्प 
तिजाइन बनािे हैं।
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4.1.9 ्कमपोरज़रटंग (2D ्त्था 3D)
2D एवनमषेशन कषे  वलए पुिानी पािंपरिक वववि कषे  ववपिीत, 2D तथा 3D एवनमषेशन में आिुवनक वडवजटल एवनमषेशन तकनीकें  बहुत हद तक इमषेज की 

कमपोवज़वटंर, कई एवनमषेशन सतिों ्या पितों कषे  सं्योजन सषे एक वपक्रि बनानषे पि वटकी हुई होती हैं।

वडवजटल आवट्भसट असीवमत संख्या में लषे्यस्भ कमपोवजट कि सकता ह ैऔि उनहें करी डसट, कलि खिाब होनषे ्या वववरनन लषे्यिों कषे  बीर कलरिंर की 

असमानता की कोई समस्या नहीं होती।

वडवजटल कमपोवज़वटंर अलर-अलर माध्यमों कषे  आसान वमशण की सुवविा री उपलबि किाती ह,ै जसैषे वक 2D एवनमषेशन, 3D एवनमषेशन, लाइव-एक्शन 

वफलम, फोटोगाफस, इलसट्षेशंस तथा गावफक आट्भवक्भ  इत्यावद वजसकी मदद सषे एक वसंरल वफलम इमषेज बनाई जा सकती ह।ै हॉवलवुड वफलम, ख़ासकि 

(लाइव एक्शन तथा एवनमषेटषेड दोनों) वडवजटल कमपोवज़वटंर द्ािा प्रदान वकए जानषे वालषे ववकलपों सषे काम्याब होती हैं। दिअसल, इन वदनों ज्यादाति 

हॉलीवुड वफलमें वडवजटल कमपोवज़वटंर तकनीकों का इसतषेमाल वकए वबना तो बनाई ही नहीं जा सकती थीं!

तित्र 4.1.5: गतिमान िथा त्थि ित्िरों को अिग-अिग करने से हरेक फे्म के तिए रीड्ॉइंग की मात्रा कम हो जािी हवै।

4.1.10 एरिरटंग (2D ्त्था 3D)

लाइव-एक्शन एवडवटंर बषेहद िरनातमक प्रवक्र्या होती ह,ै क््योंवक वनददेशक तथा एवडटि वफलम कषे  हिषे क सीन कषे  वलए ढषेि सािषे  शॉट लषेतषे हैं औि ट्ा्यल व 

एिि वववि का इसतषेमाल कितषे हैं औि साथ ही वफलम सामगी की सबसषे बषेहतिीन व्याख्या किता एक संतोषजनक एवडट त्ैयाि किनषे हषेतु उन ववकलपों को 

हटा दषेतषे हैं, वजनकी आवश्यकता सबसषे कम ह।ै वफलम का एक री सीन एनीमषेट किनषे सषे पहलषे ही एवनमषेशन/एवनमषेटि सरी फैसलषे लषे रुका होता ह ैऔि 

इसवलए, जब तक वक ओरिवजनल सटोिीबोड्भ  ्या एनीमवैटक अप फं्ट कषे  साथ कोई बहुत बडी रकू न हो रई हो ्या जब तक वक पिूी ही सीक्वेंस पुन: 

वडजाइन न की जानी हो, त्ैयाि एनीमवैटड सीन काफी हद तक मौज़दूा एनीमवैटक में ड्ॉप वक्यषे जातषे िहेंरषे, जसै ही वषे उपलबि हों, जब तक वक पिूा 

एनीमवैटक वफवनश् ड, कलड्भ  तथा कमपोवज़वटड एवनमषेशन फुटषेज सषे न बदल जा्यषे।
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तित्र 4.1.6: सॉफटिेयर, जवैसे Premiere, जो एतनमेटर के तिए एतनमेशन में एतिटटंग के पहिुओं को 
बेहद आसान बना देिा हवै!

4.1.11 िाइनि िब (2D और 3D)

जब फाइनल पेंवसल एवनमषेशन पिूा हो जाता ह,ै तब साउंड एवडटि औि वफलम सकोि कमपोज़ि फाइनल ऑवड्यो मटैीरि्यल बनाएंरषे। (लाइव-एक्शन 

वफवलमंर कषे  साथ, ्यह प्रा्यः वफलम एवडट होनषे तक नहीं हो सकता ह।ै) ्यह अक्सि Foley साउंड की रिकॉवडयंर तथा वफलम सकोि कमपोज़ि कषे  वलए 

म्यवूजकल इंटिल्यड्ूस की कमपोवजं़र तथा रिकॉवडयंर की सिल प्रवक्र्या मात्र होती ह।ै

तित्र 4.1.7: िब

4.1.12 रिरज़टि से रिलम ट्ांसिर (2D और 3D)

वडवज़टल रूप सषे बनी वफलम को ्यवद वथएटि में वदखा्या जाना हो तो, इसषे वफलम में बदला जाना होता ह।ै ्यह काम पषेशषेवि रूप सषे वक्या जाना होता ह,ै 

वजसकषे  वलए ऐसषे वववशष्ट वफलम रिकॉवडयंर उपकिण रावह्यषे होतषे हैं, जो अविकांश सवतंत्र वफलम-वनमा्भताओ ंकी पहँुर सषे बाहि होतषे हैं।



7372

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

यूरनट 4.2: Rotoscoping ्ेक रिए प्रयोग र्कए जाने िाि ेटूलस

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. 2D तथा 3 D एवनमषेशन कषे  प्रोडक्शन में प्र्योर वकषे  जानषे वालषे सॉफटवषे्यि/टूलस की पहरान किनषे में।

4.2.1 2D एरनमेशन टूलस

एवनमषेशन बनाना हमषेशा सषे ही गावफक वडज़ाइन का सबसषे जवटल पहल ूमाना जाता िहा ह,ै वजसकषे  वलए ववशषेष सॉफटवषे्यि तथा तकनीकी ववशषेषज्ता की 

आवश्यकता होती ह।ै ्यह सम्य खपानषे वाला काम होता ह ैवजसक वलए रािी-रिकम सॉफटवषे्यि तथा हाई सपीड कमप्यटूि की आवश्यकता होती ह।ै

हालांवक वप्लषे कु् वषकों कषे  दौिान कई प्रकाि कषे  ऑनलाइन प्रषेज़ेंटषेशन तथा एवनमषेशन टूल आ जानषे कषे  कषे  बाद सषे एवनमषेशन बनानषे की प्रवक्र्या काफी 

सिल हो रई ह।ै इनमें सषे ज्यादाति वषेब-आिारित टूलस का परिरालन काफी आसान होता ह ैऔि उनसषे ऐसषे एवनमषेशन बनाए जा सकतषे हैं जो िोज़मिा्भ  कषे  

अनुप्र्योरों कषे  वलए वबलकुल उप्ुयक्त होतषे हैं।

तित्र 4.2.1: िाइट बॉकस

तित्र 4.2.3: Photoshop

यूरनट ्ेक उद्ेशय  

िाइट बॉकस/एरनमेशन िेस्क

एवनमषेट किनषे कषे  वलए आपकी जो सबसषे बुवन्यादी ज़रूित होती ह,ै वह ह ैएवनमषेशन डषेसक ्या लाइटबॉक्स।

Adobe Flash Professional CS6

Adobe® Flash® Professional CS6 सॉफटवषे्यि एवनमषेशन औि मलटीमीवड्या कंटषेट बनानषे कषे  वलए एक 

शवक्तशाली ऑथरिंर एंवा्यिनमेंट होता ह।ै वडज़ाइन सषे रिपिू िोरक एहसास जो डषेसकटॉप तथा टबैलषेट्स, 

समाट्भफोन तथा टषेलीववज़न जसैषे कई सािषे  वडवाइसों पि वनिंति रूप सषे मौजदू होतषे हैं।

तित्र 4.2.2: Flash

Photoshop

वकसी एवनमषेशन सॉफटवषे्यि पि ववराि कितषे सम्य Photoshop को करी-करी नज़िअंदाज़ कि वद्या जाता ह,ै 

पि वासतव में इसकी शवक्तशाली ड्ॉइंर क्मता इसषे फ्षे म बा्य फ्षे म वडजनी-सटाइल एवनमषेशन कषे  वलए सबसषे अच्ा 

ववकलप बनाती ह।ै Photoshop की टाइमलाइन का्या्भतमकता फ्षे म बा्य फ्षे म ड्ॉइंर की मदद सषे ओवन्यम वसकवनंर 

का उप्योर कि एवनमषेशन किना सुरम बनाती ह ैऔि ्यह काफी कािरि होता ह ै।
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4.2.2 3D एरनमेशन सॉफटिेयर

तित्र 4.2.5: Monkeyjam

तित्र 4.2.8: 3ds मवैकस

तित्र 4.2.4: Toon Boom Harmony

Toon Boom Harmony

Toon Boom का एनीमषेट सॉफटवषे्यि पषेशषेविों कषे  वलए ्या उनकषे  वलए वडजाइन वक्या र्या ह,ै जो उचर-सतिी्य 

टूलस तथा इफैक्ट्स राहतषे हैं। इसषे Flash कषे  एक रंरीि प्रवतसपिशी कषे  रूप में वडजाइन तथा माकदे ट वक्या  

र्या ह।ै 

MonkeyJam

MonkeyJam एक कमाल का एवनमषेशन प्रोगाम ह ै वजसषे मूल रूप सषे पेंवसंल तथा पषेपि सषे बनषे ड्ॉइंगस को रवत 

प्रदान किनषे कषे  वलए वडज़ाइन वक्या र्या था। इसकषे  अत्यािुवनक संसकिण में कई नए फीरस्भ शावमल हैं, जसैषे वक 

Stop Motion तथा कैपररिंर मोड्स. मूल रूप सषे ्यह आपको वकसी वीवड्यो सषे कैपरि वकए ड्ॉइंगस औि इमषेज़ों सषे 

एवनमषेशन बनानषे में मदद किता ह,ै जहाँ इसकषे  पास पसंदीदा एवनमषेशन पानषे कषे  वलए कंवफरि किनषे कषे  कई सािषे  

ववकलप मौज़दू िहतषे हैं।

ऑटोिेस्क Maya

Maya इस इंडसट्ी का मानक 3D सॉफटवषे्यि ह,ै वजसका इसतषेमाल अविकति बडषे सटूवड्यो में वक्या जाता ह।ै 

Maya, सॉफटइमषेज तथा 3D मकै्स दिअसल ्यषे सरी ऑटोडषेसक कषे  पाटृ्भस होतषे हैं औि ्यषे एक ही तिीकषे  सषे काम 

कितषे हैं। 

तित्र 4.2.6: ऑटोिे्क Maya

ZBrush

ZBrush एक वडवज़टल सकलपवटंर तथा पेंवटंर प्रोगाम होता ह ैजो आपको वकसी 2D ्या 3D कंसषेपट को झटपट 

सकषे र आउट किनषे कषे  वलए आवश्यक टूलस प्रदान किता ह ैऔि वफि उस आवड्या को पणू्भतातक लषेकि जाता ह।ै 

आप लाइवटंर तथा ऐटमोसफषे रिक इफैक्ट कषे  साथ सीिा ZBrush में रि्यवलवसटक िें डस्भ बना सकतषे हैं।

3ds मकैस

ऑटोडषेसक 3ds मकै्स रषेम डषेवलपस्भ, ववजु़अल इफैक्ट आवट्भसटों तथा गावफक वडज़ाइनिों को एक व्यापक, 

एकीकृत 3D मॉडवलंर, एवनमषेशन तथा िें डरिंर सोल्यशून प्रदान किता ह।ै पिूी तिह सषे एकीकृत Character 

Animation Toolkit (CAT) अनोखा उननत रिवरंर तथा एवनमषेशन वससटम प्रदान किता ह।ै 

तित्र 4.2.7: ZBrush
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Blender

बलेंडि एक मुफत तथा ओपन सोस्भ खुला स्ोत वाला 3D एवनमषेशन सुईट होता ह।ै ्यह सपणू्भ  3D पाइपलाइन को 

सपोट्भ  किता ह:ै मॉडवलंर, रिवरंर, एवनमषेशन, वसम्ुयलषेशन, िें डरिंर,कमपोवज़वटंर तथा मोशन ट्वैकंर, ्यहाँ 

तक वक वीवड्यो एवडवटंर औि रषेम वक्रएशन को री। उननत प्र्योक्ता Python scripting हषेतु बलेंडि कषे  API का 

इसतषेमाल किता ह ैऔि इसकषे  जरिए ऐवपलकषे शन कसटमाइज़ किता औि ववशषेष टूल िाइट किता ह।ै 

तित्र 4.2.9: Blender

4.2.3 ्कमपोरज़रटंग सॉफटिेयर ्त्था VFX

Adobe After Effects CS3

After Effects CS3 की मदद सषे आप मूववंर इमषेजिी, वसटल इमषेजों तथा गावफक्स, टषेक्सट औि 2D ्या 3D सपषेस में 

साउंड कषे  सं्योजन सषे उचर प्रराव वालषे कम्ुयवनकषे शन बना सकतषे हैं औि वफि वसतुत: प्रत्यषेक एलीमेंट कषे  वकसी 

री पहल ूको एवनमषेट कि सकतषे हैं। आप जानषे-पहरानषे Adobe टूलस इसतषेमाल किकषे  After Effects में टषेक्सट औि 

vector गावफक्स री बना सकतषे हैं औि वफि दषेखनषे में वबलकुल नए मोशन गावफक्स कषे  वनमा्भण कषे  वलए इन 

एलीमेंट्स को एवनमषेट कि सकतषे हैं।

तित्र 4.2.10: Adobe After Effects CS3

NUKE

Nuke एक नोड-आिारित वडवज़टल कमपोवज़वटंर ऐवपलकषे शन ह ैवजसका ववकास The Foundry द्ािा वक्या र्या 

ह ै औि इसका इसतषेमाल वफलम तथा टषेलीववज़न पोसट-प्रोडक्शन कषे  वलए वक्या जाता ह।ै NUKE, Microsoft 

Windows, OS X, तथा Linux कषे  वलए उपलबि ह।ै

तित्र 4.2.11: Nuke

Realflow

RealFlow इस उद्ोर का एक मानक, अनोखा फलुइड वसमुलषेशन सॉफटवषे्यि ह।ै ्यह बषेहद तषेज़ ह ैऔि इसषे 

इसतषेमाल किना तषेज़ औि आसान ह,ै ्यह सरी बडषे 3D पलषेटफॉम्भ  कषे  साथ उप्ुयक्त (कमपवैटबल) होता ह।ै

तित्र 4.2.12: Realflow
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4.2.4 एरिरटंग सॉफटिेयर 

Final Cut Pro

Apple Final Cut Pro उद्ोर सतिी्य नॉन-लीवन्यि एवडवटंर सॉफटवषे्यि ह।ै इसका प्र्योक्ता अनुकूल इंटिफषे स, 

इसषे रुणवत्तापणू्भ  एवनमषेशन, मोशन गावफक्स तथा साउंड इनपुट्स बनानषे कषे  वलए पसंदीदा ववकलप बनाता ह।ै 

Final Cut Pro का इसतषेमाल टषेलीववज़न, वफलमों तथा ववज्ापनों में वक्या जाता ह।ै वफलमों कषे  काम में Final Cut 

Pro कषे  इसतषेमाल कषे  उदाहिणों में शावमल ह ै The Cold Mountain, The Curious Case of Benjamin Button 

इत्यावद।

तित्र 4.2.13: Final Cut Pro

Adobe Premiere

Adobe Premiere का इसतषेमाल 3D एवनमषेशन तथा गावफक्स कषे  एवडवटंर (टाइटल जोडना तथा ववजु़अल 

इफैक्ट्स दषेना, इत्यावद) में वक्या जाता ह।ै इसका इसतषेमाल कई लोकवप्र्य टीवी शो तथा मूवीज़ में वक्या  

जाता ह।ै

तित्र 4.2.14: Adobe Premiere
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5. 2 D एरनमेशन बनाएँ

्यवूनट 5.1 - Photoshop पि का्य्भ  किना

्यवूनट 5.2 - Flash पि का्य्भ  किना
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. कमपोवजशन कषे  वलए सटोिीबोड्भ  का पालन किनषे में, अथा्भत बकैगाउंड औि कैमिा कषे  नज़रिए सषे कैिषे क्टि की पोवजशवनंर कि, वांव्त एवनमषेशन 

बनानषे में।

2. सट्ाँर पोवज़ज़ Incorporate audio/music assets कषे  वलए एक संदर्भ वबंदु सथावपत किनषे हषेतु की फ्षे म ड्ॉइंगस ड्ॉ/सोस्भ किनषे में

3. ्यह ध्यान िखनषे में वक एक सीन सषे दूसिषे  में हुक-अप/ट्ावज़शन वबलकुल सही तिीकषे  सषे संपनन वक्या जाता हो।

4. लषे्यस्भ कषे  साथ काम किनषे तथा अच्ा पस्भपषेवक्टव व्य ूपानषे में

5. टीम कषे  रीति तथा असषेट्स, लाइवटंर व इफैक्ट जसैषे ववरारों कषे  साथ वमलकि प्ररावी रूप सषे काम किनषे में।

6. वडज़ाइन वववनददेशों तथा प्रोड््यसूि रिीफ को ध्यान में िखतषे हुए बनषे हुए एवनमषेशन का समीक्ातमक रूप सषे मूल्यांकन किनषे में।

7. ्यह ध्यान में िखनषे में वक वक्भ -प्रोडक्ट रुणवत्तापणू्भ  मानकों पि खिषे  उतितषे हों (तावक उनहें न्यनूतम इटिषे शन कषे  साथ सवीकृत वक्या जा सकषे ) औि 

त्य टाइमलाइन कषे  रीति पिूा वक्या जाए।

8. वसक्वेंस तथा सीन/शॉट्स त्ैयाि किनषे में वडजाइन, 2D एवनमषेशन तथा वफलम-मषेवकंर कषे  वसद्धांतों को अपनानषे में।

रनष्कषटि 
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यूरनट 5.1: Photoshop पर ्कायटि ्करना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. समीक्ा कषे  वलए एक प्रोटोटाइप 2D का्य्भ  उतपाद/प्री-ववजु़अलाइज़षेशन त्ैयाि किनषे में

2. Photoshop सॉफटवषे्यि पि का्य्भ  किनषे में

5.1.1 Photoshop टूि बार

यूरनट ्ेक उद्ेशय  

सक्रीन में सबसषे ऊपि मषेन्य ूबाि पि ववंडो पि वक्लक किें , वफि टूलस पि वक्लक किें । इससषे टूल बाि वदखनषे लरषेरी। Photoshop CS3 में टूल बाि दो प्रकाि 

सषे वदखाई जा सकती ह।ै नीरषे वदए रए वरत्र उनकषे  अंति दशा्भ एंरषे:

तित्र 5.1.1: Photoshop के पिंिो
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्कॉमपकैट टूि बार

एकसटेंिेि टूि बार

टूलबाि कषे  ऊपि, बाई ंओि तीिों का एक ्ोटा सा जोडा कॉमपकै्ट औि एक्सटेंडषेड प्रदश्भन इंवरत किता ह:ै

तित्र 5.1.2: कॉमपवैकट टूि बार

तित्र 5.1.3: एकसटेंिेि और कॉमपवैकट प्रदशटिन
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तित्र 5.1.4: टूल्स के नाम

टूल बाि पि मौजदू कई बटनों में एक सषे अविक टूल ्या एक ही टूल कषे  अलर-अलर मोड शावमल होतषे हैं। उदाहिण कषे  वलए, Lasso टूल में Polygonal टूल 

औि Magnetic Lasso टूल कषे  बटन व्पषे होतषे हैं। नीरषे वदए रए वरत्र में अवतरिक्त टूल ्या मोड दशा्भए रए हैं:
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तित्र 5.1.5: अतिररक्त टूल्स
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5.1.1.2 टूि पिैटे

1. टूि जान्कारी मेनयू: टूल बाि मषेन्य ूमें सषे रुनषे रए टूल का साइज औि उससषे संबंवित अन्य ववकलप बदलता ह।ै

2. History पिैटे: अपनषे रिणों को पवू्भवत (अनडू) किें । Photoshop आपकी वक्र्याओ ंकषे  लररर 30 रिण (सटषेपस) मषेमोिी में िखता ह।ै आप जब राहें तब 

मषेन ऑपशन में सषे वहसटिी सटषेपस की संख्या बदल सकतषे हैं।

3. Tool presets: वत्भमान टूलस कषे  वलए परिरावषत जानकािी

4. Brushes और Clone source: रिश रुनें औि ववकलप बदलें। Clone source ववकलपों का उप्योर किें ।

5. Character एिं Paragraph: टषेक्सट का साइज़, कलि, फ़ॉनट आवद रुनें। अपनषे टषेक्सट को अलाइन (संिषे वखत) किें । सपषेस औि अन्य ववकलप बदलें।

6. Navigator एिं Info: अपनी सक्रीन पि इमषेज कषे  वववरनन रारों में/पि जाएं। ज़मू इन औि ज़मू आउट का वन्ंयत्रण किें । इनफ़ो कषे  साथ वकसी कलि ्या 

वकसी ऑबजषेक्ट (वसतु) की सटीक वसथवत पता किें ।

7. Color सिकेशन: कोई कलि रुनें ्या गषेवडएंट बनाएं।

8. Layer पिैटे: Photoshop की कु् सबसषे शवक्तशाली ववशषेषताओ ंमें सषे एक ह ैलषे्यस्भ का उप्योर। Photoshop डॉक््ुयमेंट में हि लषे्यि एक अलर इमषेज 

होती ह ैवजसषे बाकी लषे्यस्भ सषे अलर किकषे  एवडट वक्या जा सकता ह।ै आप लषे्यि की कलपना वकसी पािदशशी मटैीरि्यल की शीट पि िखषे वकसी वरत्र 

कषे  रूप में कि सकतषे हैं। 

लषे्यस्भ का प्रबंिन Layers पलैषेट (ऊपि वालषे वरत्र में दषेखें) कषे  साथ वक्या जाता ह।ै Layers पलैषेट हि लषे्यि का एक ्ोटा थंबनषेल दृश्य वदखाता ह ैवजससषे उसषे 

पहराननषे में आसानी होती ह।ै 

आप लषे्यि की दृश्यता (वववज़वबवलटी) को ऑन व ऑफ कि सकतषे हैं औि वकसी एक री pixel को सथा्यी रूप सषे प्रराववत वकए वबना इमषेज की पिूी अपी्यिें स 

(वदखावट, रूप-िंर आवद) बदल सकतषे हैं। हि लषे्यि कषे  बाई ंओि मौजदू आँख वाला आइकन उसकी दृश्यता को वन्ंयवत्रत किता ह।ै लषे्यि कषे  आँख वालषे 

आइकन (नीरषे दषेखें) पि वक्लक किकषे  लषे्यि को दृश्य (वववज़वबल) ्या अदृश्य (वहडन) बना सकतषे हैं। नतीजषे में हमें वही पहलषे वाला Photoshop डॉक््ुयमेंट 

वमलता ह,ै बस एक अपवाद होता ह ैवक उसकी एक लषे्यि को व्पा वद्या र्या ह ैवजससषे उसकषे  नीरषे की सफषे द पषृ्ठरवूम वदखनषे लरी ह।ै 

वकसी लषे्यि को वमटानषे कषे  वलए, Layers पलैषेट (नीरषे दषेखें) में उस पि वक्लक किें  औि खींरतषे हुए Trash बटन तक लषे आएं। परिणाम नीरषे दाई ंओि वदखा्या 

र्या ह।ै

तित्र 5.1.8: टूि पवैिेट
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ध्यान दें: डॉक्युम ेंट विडंो की विखािट (अपी्रें स) म ें कोई बिलाि नहीं हुआ ह।ै कौन-सी ले् र एवकटि ह ै्ह िेखन ेके वलए हमशेा Layers पलैटे को िेखें, 
डॉक्युम ेंट विडंो को नहीं।

5.1.1.3 इमेज ्ैक्पचर ्करना

आप अपनी इमषेज में फषे िबदल किनषे कषे  वलए Photoshop का उप्योर कि सकतषे हैं। आप वडवजटल कैमिा, मोबाइल फोन कैमिा, सकैनि औि/्या इंटिनषेट सषे 

अपनी इमषेज इमपोट्भ  कि सकतषे हैं।

रिरजटि ्ैकमरा: अपनषे USB वडवजटल कैमिा को कनषेक्ट किें  औि अपनी सािी इमषेज अपनी हाड्भ  ड्ाइव में वकसी ऐसषे फोलडि में कॉपी कि दें जहां आप 

बाद में उनहें ढंूढ सकें । इसकषे  बाद Photoshop में जाएं, File > Open> पि वक्लक किें  औि जो इमषेज आप खोलना राहतषे हैं उन तक जाएं।

ध्यान दें: सयुवनवचित करें  वक आप सशंोवित इमजे को नए नाम स ेसिे करें , तावक ्वि आप मलू इमजे को िोबारा उप्ोग करना चाहें तो िह आपके पास 

उपलबि हो।

तित्र 5.1.3(a): Layers पवैिेट तित्र.5.1.3(b): Layers पवैिेट

तित्र 5.1.4: इमेज खोिें
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5.1.1.4 Photoshop में इमेज ्को रिरभनन िाइि प्र्कारों में सेि ्करना

मोबाइि ्ैकमरा: USB कषे बल सषे मोबाइल फोन कषे  कैमिषे  को अपनषे PC / MAC सषे उसी प्रकाि जोडें जसैषे ऊपि (वडवजटल कैमिा कषे  वलए) बता्या र्या ह।ै

इंटरनेट से इमेज: इंटिनषेट पि अपनी इमषेज ढंूढें  औि उनहें हाड्भ  ड्ाइव पि वकसी फोलडि में सषेव कि लें। सुवनवश्चत किें  वक आप फोलडि को कोई ऐसा नाम 

दें वजससषे आप बाद में फोलडि ढंूढ सकें  औि अपनी इमषेज खोल सकें । (प्रोजषेक्ट वदशा-वनददेशों की मदद लें)

अपनी इमेज स्ैकन ्करें : अपनी इमषेज को सकैनि कषे  काँर की ओि किकषे  िखें औि File > Import > में जाएं औि सकैनि स्ोत रुन लें। कु् मामलों में एक 

न्यी पॉप अप ववंडो वदखषेरी। ्यह इस पि वनर्भि किता ह ैवक आपकषे  पास कौन-सा सकैनि ह।ै औि आपको अपनी इमषेज कषे  पिैामीटिों में फषे ि-बदल किनषे 

की ज़रूित पडषेरी।

ध्यान दें: जो इमजे आप व्रटं किावलटी की चाहत ेहैं उनके वलए: 150-300 dpi चयुनें। [dot (pixel) per inch] जो इमजे आप स्क्ीन के वलए ्र्ोग करना चाहत े

हैं उनके वलए 72 dpi चयुनें।

ऊपि वदखाए रए वरत्र में सकैनि स्ोत सषे इमषेज सकैन किनषे कषे  वलए की जानषे वाली वक्र्याएं वदखाई रई हैं।

Photoshop में आप अपनी फाइलों को वववरनन प्रकािों में सषेव कि सकतषे हैं। सबसषे अविक जानषे-मानषे फाइल फॉमदेट वनमनांवकत हैं।

• JPEG: ्यह फोटोगावफक इमषेज सटोि किनषे औि रषेजनषे का सबसषे आम फॉमदेट ह।ै

• PSD: .PSD (Photoshop Document) फॉमदेट Photoshop में उपलबि अविकांश इमषेवजंर ववकलपों कषे  समथ्भन कषे  साथ इमषेज को सटोि किता ह।ै इसमें 

मासक्स कषे  साथ लषे्यस्भ, कलि सपषेस, ICC प्रोफाइलस, ट्ांसपिषे नसी, टषेक्सट, अलफा रनैल औि सपॉट कलस्भ, वक्लवपंर पा्थस, तथा डुओटोन सषेवटंगस 

तित्र 5.1.4: इमेज इमपोटटि करना
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शावमल हैं। ऐसा कई अन्य फॉमदेट्स (जसैषे .EPS ्या .GIF) कषे  ववपिीत ह ैजो िािाप्रवाह, वनबा्भि का्य्भशीलता प्रदान किनषे कषे  वलए ववष्य-वसतु को 

सीवमत कि दषेतषे हैं। Photoshop की लोकवप्र्यता का अथ्भ ह ैवक .PSD फॉमदेट का व्यापक उप्योर वक्या जाता ह ैऔि अविकांश प्रवतसपिा्भ  सॉफटवषे्यि 

री इसषे कु् हद तक समवथ्भत कितषे हैं।

• GIF: GIF सीवमत संख्या में िंरों कषे  साथ पनैषे वकनािों वाली िषे खा कलाकृवत्यों (जसैषे लोरो) कषे  वलए उप्ुयक्त होता ह।ै इसमें फॉमदेट कषे  लॉसलसै 

कंप्रषेशन का लार उठा्या जाता ह।ै ्यह फॉमदेट सुपरिरावषत वकनािों कषे  साथ एकसमान िंरों वालषे क्षेत्रों कषे  अनुकूल ह,ै जबवक इसकषे  उलट JPEG फॉमदेट, 

समूद गषेवडएंट्स तथा अविक नम्भ  इमषेज कषे  अनुकूल होता ह।ै GIF फाइलों को ्ोटषे-्ोटषे एवनमषेशन औि कम रिज़ोल्यशून वाली वफलम वक्लपस कषे  वलए 

प्र्योर वक्या जा सकता ह।ै

ध्यान दें: आपको हमारा सयुझाि ह ैवक आप अपनी सशंोवित इमजे (वजनमें ले् स्स शावमल हैं) को PSD फाइलों के रूप में सिे करें । ऐसा करन ेस ेआप जब 

भी चाहेंग ेतब इमजे म ें ्ा इमजे म ें मौजूि टेकस्ट में बिलाि कर पाएंग।े

5.1.1.5 ्किर िॉममेट

5.1.1.6 साइज़ और ररज़ोलयूशन

RGB

कलि मॉडल एक ऐवडवटव कलि मॉडल होता ह ैवजसमें लाल, हिी तथा नीली लाइट्स को कई तिह सषे साथ वमलाकि िंरों का एक व्यापक समूह बना्या 

जाता ह।ै इस मॉडल को अपना एवडवटव नाम तीन ्योरज प्राथवमक िंरों, िषे ड, गीन औि बल ूकषे  पहलषे अक्िों सषे वमला ह।ै आम RGB इनपुट वडवाइसों कषे  

उदाहिण हैं िंरीन TV औि वीवड्यो कैमिा, इमषेज सकैनि औि वडवजटल कैमिा।

CMYK

(स्यान, मषेजेंटा, ्यषेलो तथा की (बलकै) का संवक्प्त रूप औि प्रा्यः इसषे प्रोसषेस कलि ्या राि िंर कषे  रूप में जाना जाता ह)ै, एक सबट्वैक्टव कलि मॉडल ह,ै 

जो कलि वपं्रवटंर में प्र्योर होता ह ैऔि साथ ही,वपं्रवटंर प्रवक्र्या का वण्भन किनषे में री। आमतौि पि स्यावह्यों को संवक्प्त नाम कषे  क्रम में ही लरा्या जाता 

ह,ै हालांवक अलर-अलर वपं्रट घिानों, वपं्रट ऑपिषे टिों, प्रषेस वनमा्भता औि प्रषेस िन इस क्रम में बदलाव कि सकतषे हैं।

अपनषे प्रोजषेक्ट की शुरूआत सषे ही अपनी फाइलों औि 

फोलडिों को व्यववसथत किकषे  िखना बहुत महतवपणू्भ 

होता ह।ै

इमषेजों को सक्रीन रिज़ोल्यशून (72 dpi) में सषेव वक्या 

जाना रावहए तावक आप अपनषे Flash प्रोजषेक्ट कषे  साथ 

आसानी सषे का्य्भ  कि सकें । आपका Flash प्रोजषेक्ट 

वडफॉलट साइज़ 400 x 550 वपक्सल पि आिारित होरा। 

इसवलए ्यवद आपकी इमषेज का साइज़ अविकतम 

800x600 वपक्सल हो तो इससषे मदद वमलषेरी।

• अपनी इमषेजों का साइज़ औि रिज़ोल्यशून बदलें

• Photoshop में सबसषे ऊपि वालषे मषेन्य ू में इमषेज में 

जाएं औि इमषेज साइज़ रुनें
तित्र 5.1.5: साइज़ और ररज़ोल्यूशन बदिें



8786

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

5.1.1.6 अपनी िाइिों ्को Adobe Flash ्ेक रिए उपयुति बनाना

अब जो ववंडो वदखषेरी उसमें आप इमषेज की ववमाएं औि रिज़ोल्यशून बदल सकतषे हैं। सुवनवश्चत किें  वक Constrain Proportion बॉक्स में वनशान लरा  

हुआ हो।

Adobe Flash कषे  वलए अपनी फाइलों को उप्ुयक्त बनानषे औि सषेव किनषे कषे  कु् तिीकषे  

मौजदू हैं। आपकषे  वलए एक सिल तिीका ्यहां वद्या जा िहा ह।ै

• जसैा वक हमनषे ऊपि बता्या था, जब आप वकसी इमषेज को पिूा कितषे हैं (टषेक्सट, 

इफषे क्ट आवद), तो आप लषे्यस्भ आवद शावमल किनषे कषे  वलए उसषे .psd फाइल कषे  रूप 

में सषेव कितषे हैं।

• रूंवक Flash .psd फाइल नहीं खोल पाएरा इसवलए हमें आरषे वलखषे रिणों का 

पालन किना होरा।

• सबसषे ऊपि वालषे मषेन्य ूबाि पि जाएं औि File > Save for the web & devises 

रुनें।

एक न्यी ववंडो खुलषेरी वजसमें कु् ववकलप होंरषे। तित्र 5.1.6: फाइि सेि करें

तित्र 5.1.7: फाइि सेि करें
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Bitmaps

कमप्यटूि गावफक में एक bitmap ्या pixmap एक प्रकाि की मषेमोिी ऑरदेनाइज़षेशन अथवा इमषेज फाइल फॉमदेट ह,ै वजसषे वडवजटल इमषेजस को सटोि किनषे कषे  

वलए प्र्योर वक्या जाता ह।ै bitmap शबद की उतपवत्त कमप्यटूि प्रोगावमंर की शबदावली सषे हुई ह,ै अथा्भत वबट्स का एक मानवरत्र, वबट्स की एक सथावनक 

मानवरवत्रत सािणी। अब, pixmap कषे  साथ, इसका तातप्य्भ  आमतौि पि वपक्सलस की एक सथावनक मानवरवत्रत सािणी सषे होता ह।ै Raster इमषेज को 

आमतौि पि bitmaps ्या pixmaps कषे  रूप में संदवर्भत वक्या जा सकता ह,ै राहषे वसनथषेवटक हो ्या फोटोगावफक, फाइल में हों ्या मषेमोिी में। जसैषे वक 

Photoshop कषे वल bitmaps का प्र्योर किती ह,ै जो वक वडवजटल कैमिा ्या सकैनि जसैषे बाह्य स्ोतों की इमषेज होती ह।ै

Vector

दाई ंओि आप रुन सकतषे हैं वक आप अपनी इमषेज कषे  वलए कौन-सा फॉमदेट राहतषे हैं। दो 

ववंडोज में सषे बाई ंवाली में मूल इमषेज होरी औि दाई ंवाली में वह नई इमषेज वजसषे कलि 

रिज़ोल्यशून कषे  अनुसाि सषेव वक्या जाएरा।

जब आप कलि रिज़ोल्यशून रुनें, तो save पि वक्लक किें  तथा इमषेज को एक नए 

फोलडि में सषेव किें  (प्रोजषेक्ट वदशा-वनददेशों को दषेखें)

ध्यान दें: ्वि आपकी इमजे बकैग्ाउंड म ें ट्ासपरेनसी हो तो आपको वकलक करके 

ट्ासपरेनसी बटन का च्न करना होगा। उसके बाि आपकी इमजे .gif फाइल के रूप में 

सहेजी जाएगी।

कमप्यटूि गावफक्स में इमषेज दशा्भनषे कषे  वलए Vector गावफक्स में वज्योमवैट्कल 

वप्रवमवटवस - जसैषे वक वबनदु, िषे खाएं, कवस्भ तथा आकृवत अथवा पोलीरन(नस) - का 

प्र्योर वक्या जाता ह,ै जो वक रवणती्य समीकिणों पि आिारित होतषे हैं। Vector गावफक 

फॉमदेट raster गावफक्स कषे  संपिूक होतषे हैं। raster गावफक्स, जो वक वपक्सषेल की एक 

सािणी कषे  रूप में इमषेज का वनरूपण होतषे हैं, वजनहें आमतौि पि फोटोगावफक इमषेजस कषे  

वनरूपण हषेतु प्र्योर वक्या जाता ह।ै कई ऐसषे अवसि आतषे हैं जब Vector टूल तथा फॉमदेट्स 

कषे  साथ का्य्भ  किना सबसषे अच्ा होता ह,ै वहीं कई ऐसषे अवसि री आतषे हैं जब raster 

टूल तथा फॉमदेट्स कषे  साथ का्य्भ  किना सवपोत्तम होता ह।ै कई बाि दोनों फॉमदेट्स का एक 

साथ री प्र्योर वक्या जाता ह।ै दोनों प्रौद्ोवरवक्यों कषे  लारों व सीमाओ,ं तथा दोनों कषे  

बीर कषे  संबंि की समझ होनषे सषे संराववत तौि पि इन टूलस का कुशलतापवू्भक एवं 

प्ररावी तिीकषे  सषे उप्योर वक्या जा सकता ह।ै जसैषे वक Flash एवं Illustrator, दोनों में 

bitmaps एवं vector इमषेजस, का प्र्योर वक्या जा सकता ह।ै

तित्र 5.1.8: फाइि सेि करें

तित्र 5.1.9: Vector

5.1.7 Abobe Illustrator पर ्कायटि ्करना

अपने bitmaps ्को Vector में पररिर्तटि्त ्कीरजये

Adobe illustrator खोलें तथा रुनें वक आप वकस प्रकाि का डॉक््यमूेंट खोलना राहतषे हैं। आप हाल ही में खोला र्या कोई आइटम को रुन सकतषे हैं  

अथवा कोई नई फाइल बना सकतषे हैं। उपिोक्त वरत्र में “print document” सलषेक्ट वक्या र्या ह।ै हम डॉक््यमूेंट सपवैसवफकषे शंस खोलतषे हैं तथा ok पि वक्लक 

कितषे हैं।
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इसकषे  टूल, पलैषेट तथा लषेआउट काफी हद तक Photoshop कषे  जसैषे ही हैं, लषेवकन वफि री आपकषे  वलए न्यषे होंरषे। 

टॉप मनै्य ूबाि पि live trace का ववकलप रुनकि आप अपनी पसंद का live trace ववकलप रुन सकतषे हैं।

तित्र 5.1.10(a): bitmap को Vector में

तित्र 5.1.10 (b): bitmap को Vector में
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वनमनवलवखत उदाहिण में हमनषे live trace: color 6 रुना ह,ै आप अंति दषेख सकतषे हैं।

तित्र 5.1.11: live trace

तित्र 5.1.12: इमपोरटिंग

ऊपि वसथत इमषेज एक bitmap ह,ै तथा नीरषे की इमषेज एक Vector गावफक ह।ै अब आप वनरली इमषेज को रुन सकतषे हैं तथा इसषे एक Vector कषे  रूप में 

प्र्योर किनषे कषे  वलए इसषे Flash में प्र्योर कि सकतषे हैं, अथवा आप इसषे एक *swf फाइल (Flash मूवी) कषे  रूप में एक्सपोट्भ  कि सकतषे हैं, तावक आप इसषे बाद 

में Flash में एक Flash मूवी (कषे वल एक फ्षे म) कषे  रूप में इमपोट्भ  कि सकें ।
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यूरनट 5.2: Flash पर ्कायटि ्करना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. 2D एवनमषेशन की तकनीकों कषे  प्र्योर कषे  बािषे  में जाननषे में

2. Flash सॉफटवषे्यि पि का्य्भ  किनषे में ।

5.2.1 Adobe Flash से पररचय

Flash: 

• खासतौि सषे वषेब पि इसतषेमाल किनषे कषे  वलए एक मलटीमीवड्या गावफक्स प्रोगाम ह।ै

• Flash आपको वषेब पि िोरक "मूवीज" बनानषे में सक्म बनाता है

• Flash, vector गावफक्स का इसतषेमाल किता ह,ै वजसका अथ्भ होता ह ैगावफक्स को सपष्टता/रुणवत्ता खोए वबना वकसी री आकाि तक बढा्या जा 

सकता है

• Flash कषे  वलए वकसी प्रोगावमंर कुशलता की आवश्यकता नहीं होती औि इसषे सीखना आसान होता ह।ै

जब आप Flash लॉनर कितषे हैं तो आपको एक वषेलकम सक्रीन वदखाई पडता ह।ै ्यह सक्रीन कु् शॉट्भकट पषेश किता ह।ै ्यह ऐसा वदखता ह:ै

तित्र 5.2.1: ्टारटिंग पिंिो

यूरनट ्ेक उद्ेशय  
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वकसी Flash फाइल पि काम शुरू किनषे कषे  वलए, आप अब फाइल मषेन ूका इसतषेमाल कि सकतषे हैं ्या वषेलकम सक्रीन पि वकसी आइटम पि वक्लक कि 

सकतषे हैं। जसैषे

• File >Open का इसतषेमाल कि आप *.fla फाइल खोलें वजसपि आप काम कि िहषे हों

• फाइल मषेन्य ूसषे ्या बटन सषे आप "recent" आइटम खोलें।

• एक नई Flash फाइल बनाएँ

5.2.2 Flash िेस्कटॉप ्का िआेउट

तित्र 5.2.2: Flash िे्कटॉप
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5.2.3 Adobe Flash Library

Flash में काम कितषे सम्य आप खुद ही कई प्रकाि कषे  वसंबलस/संकषे त 

खोज सकतषे हैं जसैषे वक मूवी वक्लपस, बटन तथा गावफक्स। इतनषे सािषे  

संकषे तों पि नज़ि िखना कवठन हो सकता ह,ै पि Flash आपको एक ऐसी 

सुवविा प्रदान किता ह ै जो इसषे आसान बनाता ह ै - वह ह,ै लाइरिषेिी। 

Library एक कें रिीकृत लोकषे शन होता ह,ै जहाँ आप संकषे तों को उसी तिह 

सषे दषेख सकतषे हैं, रिाउज़ कि सकतषे हैं, जोड सकतषे हैं, वडलीट कि सकतषे 

हैं तथा व्यववसथत कि सकतषे हैं जसैषे वक आप अपनषे कमप्यटूि पि फाइल 

मूव औि एवडट कितषे हैं।

Window | Library में नषेववरषेट किनषे कषे  वलए Ctrl + L दबाएँ। आपको 

Library पनैल वदखाई पडता ह।ै वनमनवलवखत गावफक बताता ह ै वक 

हिषे क आइकन औि Library का हि खंड क््या वनरूवपत किता ह।ै

Library में ्कोई आइटम जोड़ना

जब वकसी संकषे त का वनमा्भण होता ह ैआपका लाइरिषेिी अपनषे आप इसमें आइटम जोड दषेता ह।ै वक्लक कि ्या र्यन कि अपनषे ड्ॉइंर एरि्या पि एक टषेक्सट 

बनाएँ। टषेक्सट रुननषे कषे  बाद, F8 दबाएँ ्या Modify > Convert to Symbolवसंबल पि जाएँ। 

कंवट्भ टु वसंबल डा्यलॉर बॉक्स वदखाई दषेरा । गावफक का ऑपशन वसलषेक्ट किें  औि नाम कषे  फीलड में एक नाम “text” एंटि किें :

OK दबाएं। कंवट्भ टु वसंबल डा्यलॉर बॉक्स रा्यब हो जाएरा औि आपका टषेक्सट 

ऑबजषेक्ट अब एक गावफक हो जाता ह।ै पि Library पि एक रैंडि लें। आप दषेखेंरषे, वक 

अब आपको आइटम वलसट में नषेम टषेक्सट कषे  साथ एक गावफक वसंबल वदखाई दषेता ह:ै

तित्र 5.2.3: Flash िे्कटॉप

तित्र 5.2.4: पसंबि/संकेि में रूपांिररि करें/बदिें

तित्र 5.2.5
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एक दूसिा तिीका री ह ैवजसकषे  जरिए आप अपनषे Library मषे आइटम जो ड सकतषे हैं। न्य ूवसंबल आइकन पि वक्लक किें , वक्रएट न्य ूवसंबल डा्यलॉर बॉक्स 

में जानकािी रिें  औि वसंबल को वबना पहलषे रिण में प्रदवश्भत वकए, सीिा अपनषे Library में जोडें।

हालांवक दोनों ही तिीकषे  सषे आप जो री संकषे त बनातषे ्या कंवट्भ कितषे हैं वह आपकी लाइरिषेिी में एड/जुड हो जातषे हैं। जब Library में कोई आइटम होता ह,ै तो 

ज़रूिी नहीं ह,ै वक इस आइटम का इसतषेमाल होता ह।ै वासतव में, हमािषे  उदाहिण में हमािी Library में तीन आइटम हैं, तब री उनमें सषे कोई सटषेज पि प्रदवश्भत 

नहीं ह।ै हालांवक, आप इवतमनान िखें। आपकी Library सषे आइटम प्रदवश्भत किना काफी सिल होता ह।ै

आप्की Library से आइटम प्रदरशटि्त ्करना

आपकषे  सटषेज पि आपकी Library सषे कोई आइटम प्रदवश्भत किना उतना ही सिल होता ह ै

वजतना वक ड्ैर औि ड्ॉप किना। बस एक आइटम रुनें, ्यानी अपनी Library सषे सक्भ ल मूवी 

वक्लप रुनें औि उसषे अपनषे सटषेज पि ड्ैर किें । आपको अब अपनषे सटषेज पि घषेिा वदखाई पडषेरा:

आप समान आइटम कषे  कई इंसटेंसषेस को ड्ैर कि सकतषे हैं। वफि सषे लाइरिषेिी में एकसक्भ ल 

मूवी वक्लप पि वक्लक कि उसषे सटषेज पि ड्ैर किें । आप दषेखेंरषे, वक आपकषे  सटषेज पि अब 

आपकषे  सक्भ ल मूवी वक्लप की दो कॉपीज़/ प्रवत्याँ हैं।

्यवद आप वनण्भ्य लषेतषे हैं वक आपकषे  सटषेज पि दो सक्भ लस होंरषे ्या कोई री सक्भ ल नहीं होरा, 

तो बस अपनषे सक्भ ल/सक्भ लस रुनें औि वडलीट-की दबाएँ। अपनषे सटषेज सषे कोई आइटम वडलीट 

किनषे सषे वह आपकी Library सषे वडलीट नहीं होता ह,ै पि इसकषे  ववपिीत- आपकी Library सषे 

कोई आइटम वडलीट किनषे सषे वह सटषेज सषे वडलीट हो जाता ह।ै

अपनी Library से आइटम रििीट ्करना

अपनी Library सषे कोई आइटम वडलीट किनषे कषे  वलए सबसषे पहलषे Library में आइटम रुनें। 

आइटम का जब र्यन हो जाता ह,ै तो Library में Delete बटन दबाएँ।

5.2.3 मूिी रकि्पस

मूवी वक्लपस को 'मूवीज़ कषे  रीति मूवीज़ कषे  रूप में परिरावषत 

वक्या जाता ह,ै वजसकी प्रॉपटशीज़ तथा टाइमलाइन मुख्य मूवी 

सषे सवतंत्र होतषे हैं।' आप वजतना राहें अपनषे मुख्य मूवी में उतनषे 

मूवी इंसटेंसषेस पा सकतषे हैं औि ्यहाँ तक वक आप उस इमपोट्भ 

की हुई मूवी वक्लप को अपनी मज़शी सषे अपनषे मषेन सटषेज पि कई 

बाि ड्ैर कि सकतषे हैं। ्यषे 'टाइमलाइन सवतंत्र’ होतषे हैं। आप 

उनका सॉट््भस कषे  टषेमपलषेट्स कषे  रूप में वफि सषे इसतषेमाल कि 

सकतषे हैं औि हि नई मूवी, वजसमें री आप उनहें पुल कितषे हैं, 

कषे  वलए उनहें वववशष्ट तौि पि एवडट कि सकतषे हैं, मूल वक्लपस में वबना कोई बदलाव वकए। जिा सोरें वक ्यह आपकषे  लोड टाइम कषे  वलए क््या कि सकता 

ह ैऔि मूवी वक्लपस का इसतषेमाल किनषे सषे आपकषे  पास वकतनी लोरशीलता/फलषेवक्सवबवलटी होती ह।ै मूवी वक्लपस का इसतषेमाल किनषे सषे आप सम्य की 

बरत कि सकतषे हैं।

तित्र 5.2.6: आइटम प्रदरशटिि करना

तित्र 5.2.7: आइटम तििीट करना

तित्र 5.2.8: मूिी तकिपस
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वनवश्चत रूप सषे आपनषे अब तक .flaʼs कषे  बािषे  में जान वल्या होरा, जो हिषे क लषे्यि कषे  वलए कषे वल एक फ्षे म का इसतषेमाल किता ह,ै तब री मूवी जवटल रीज़ 

होती ह,ै क््योंवक हिषे क लषे्यि की वक्लपस की अपनी प्रॉपटशीज़ औि टाइमलाइंस होती हैं। ्यषे काफी आसान लरता ह,ै लषेवकन मूवी वक्लपस औि ्यषे कैसषे काम 

किती ह,ै ्यह समझना असंरव तो नहीं, पि मुवशकल ज़रूि हो सकता ह,ै अरि आपकषे  वलए Flash नई रीज़ ह ैतो।

मूवी वक्लपस को मुख्य मूवी कषे  Library 'Ctrl + L’ पि उनकषे  ऊपि डबल वक्लक किकषे  ्या 'Control | Test Movie’ का इसतषेमाल कि वप्रव्यडू किकषे  मूवी 

को एवडट वक्या जा सकता ह।ै

अपनी मौजदूा मूवी कषे  रीति एक मूवी वक्लक बनानषे कषे  वलए 'Insert | New Symbol’ का इसतषेमाल किें  औि 'movie clip' वसलषेक्ट किें  औि उसषे कोई नाम 

दें। OK दबाएं।

अब आपकषे  पास आपकी मूवी वक्लप बनानषे कषे  वलए एक न्या सटषेज औि टाइमलाइन ह।ै ्यवद आप इस नई मूवी को अपनषे मषेन टाइमलाइन में इसतषेमाल किना 

राहतषे हैं तो लषे्यस्भ औि गावफक्स जोडें। पिूा हो जानषे पि, सीन 1 पि वापस जाएँ, वक्लक कषे  वलए एक न्या लषे्यि बनाएँ औि इसषे लाइरिषेिी सषे सटषेज पि ड्ैर 

किें । अब उसषे अपनी मुख्य मूवी में पलषे किवानषे कषे  वलए 'Control | Test Movie’ का इसतषेमाल किें । आप सटषेज पि मूवी वक्लपस को प्रराववत वकए वबना वकसी 

री रीज़ को अपनी मुख्य मूवी में जोड सकतषे हैं। मूवी वक्लपस का बकैगाउंड्स तब तक पािदश्भक होरा जब तक वक आप उनमें एक बकैगाउंड इमषेज न 

डाल दषेतषे हैं।

तित्र 5.2.10: तसमबि एतिट करना

तित्र 5.2.9: मूिी तकिप बनाएुँ

अपनषे वसंबलों/ संकषे तों को एवडट किनषे कषे  वलए अपनी टाइमलाइन में सबसषे ऊपि दाई ंओि वदए आइकन पि वक्लक किें ।

पि ्यवद आपनषे पहलषे ही अपनी मुख्य मूवी कषे  बाहि कु् मूवी बनाई हो वजसषे आप मूवी वक्लपस कषे  रूप में इसतषेमाल किना राहतषे हों तो। 

.fla सर्भ कि इमपोट्भ  किनषे कषे  वलए वजसषे आप इसतषेमाल में लाना राहतषे हैं, 'File | Open as Library' का इसतषेमाल किें । अब ्यह Library में इस वसंबल/संकषे त 

कषे  रूप में प्रकट होता ह ैवजसषे आप वजतनी बाि राहें उतनी बाि सटषेज पि ड्ैर आउट कि सकतषे हैं। आप वजस री मूवी वक्लप को इमपोट्भ  कितषे हैं, ्या बनातषे 

हैं उसमें सषे प्रत्यषेक कषे  वलए न्या लषे्यि बनाना न रलूें, औि अपनी मूवी दषेखनषे कषे  वलए आप 'Control | Test Movie' का इसतषेमाल किें । अब मूवी वक्लप को 

समझना उतना कवठन नहीं िहा ्या उतना िहस्यम्य नहीं िहा वजतना ्यह वदखाई पडती ह।ै

्कीफे्मस ्की वयाखया

• बिैं्क ्कीफे्मस: बलैंक कीफ्षे म टाइमलाइन पि एक ओपन सक्भ ल कषे  रूप में वदखाई पडता ह।ै इसका अथ्भ ह ैवक उस कीफ्षे म कषे  सटषेज पि कोई आट्भवक्भ  

नहीं ह।ै

• ्कीफे्म: कीफ्षे म टाइमलाइन पि एक सोवलड सक्भ ल कषे  रूप में वदखाई पडता ह।ै इसका अथ्भ ह ैवक सटषेज पि कोई कंटेंट ह।ै

• फे्म: आप वववरनन लषे्यस्भ पि ढषेि सािषे  फ्षे मस िख सकतषे हैं।

• किीयर ्कीफे्मस: ्यह कीफ्षे म को टाइमलाइन सषे वमटा दषेता ह।ै ्यह सरी कंटषेट को सटषेज रिमूव फ्षे मस सषे हटाता ह:ै उन फ्षे मस का र्यन किें  वजनहें आप 

हटाना राहतषे हैं औि Insert>Remove Frames.Timeline का र्यन किें

• टाइमिाइन: लषे्यस्भ औि फ्षे मस का इसतषेमाल कितषे हुए सम्य कषे  साथ टाइमलाइन मूवी कंटषेट को वन्ंयवत्रत औि व्यववसथत किता ह।ै जब टाइमलाइन 

में लषे्यस्भ की संख्या उससषे अविक हो वजनती वक वडसपलषे की जा सकती ह,ै तो सक्रॉलबाि उपलबि हो जातषे हैं।
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5.2.4 फे्म बाय फे्म एरनमेशन

1. ध्यान िहषे दें वक आपका mymovie.fla अरी री ओपन हो। आप 'My Frog Movie' फ्षे ज़ वलखनषे जा िहषे हैं, 

तावक ्यह एक बाि में एक ही फ्षे म वदखषे, तो रिश टूल (कोई री आकाि औि कोई री िंर) वपक किें ।

2. सटषेज पि एक M. Notice ड्ॉ किें  वक आपकी टाइमलाइन पि आपका बलैंक कीफ्षे म अब कीफ्षे म में बदल 

रुका ह।ै

तित्र 5.2.11: कीफे्म

तित्र 5.2.12: फे्म 1 पर M

3. टाइमलाइन पि फ्षे म 2 रुनें औि एक न्या कीफ्षे म इंसट्भ किें । My शबद बनानषे कषे  वलए Y जोडें।

तित्र 5.2.13: फे्म 2 पर Y

तित्र 5.2.14: अनय अक्र

4. हिषे क वण्भ कषे  वलए न्या कीफ्षे म इंसट्भ किना जािी िखें, जब तक वक फ्षे ज़ पिूा 

न हो जा्यषे: My Frog Movie 

• सटजे: ्यह वह सथान होता ह ैजहाँ आपकी िरना जीववत हो उठती ह ैऔि एवडट किनषे कषे  वलए प्रदवश्भत की जाती ह।ै मषेन्य ूसषे Modify | Movie का 

र्यन कि सटषेज का आकाि बदलें औि अपनी मज़शी सषे रौडाई औि ऊँराई की सषेवटंर बदलें।

• Onion Skinning बटन: ओवन्यन वसकंस टाइमलाइन में पोवजशवनंर कषे  वलए कई लषे्यिों में आपकषे  एवनमषेशन कषे  सरी लषे्यस्भ को दषेखनषे की अनुमवत 

दषेता ह।ै वडमड लषे्यस्भ एवडट नहीं वकए जा सकतषे हैं।

• ्कीफे्म: सटषेज पि मौजदू हि रीज़ में, जहां कोई रीज़ बदलती ह ैवह ह ैकीफ्षे म। कीफ्षे म एवनमषेशन में बदलावों को परिरावषत किता ह।ै हिषे क लषे्यि में 

पहला फ्षे म सवतः ही एक कीफ्षे म होता ह।ै वनवम्भत कीफ्षे म Flash में एक सॉवलड सक्भ ल कषे  रूप में वदखाई पडता ह।ै खाली कीफ्षे म खोखलषे सक्भ ल कषे  

रूप में वदखाई पडतषे हैं।

• ्पिहेेि: टाइमलाइन पि मौजदू पलषेहषेड आपकी पिूी मूवी कषे  वलए एक मूवषेबल शुरुआती तथा समापन वबंदु होता ह।ै आप अपनी मूवी को दषेखनषे कषे  वलए 

औि एवडवटंर कषे  वलए फ्षे म बदलावों की पहरान में मदद पानषे कषे  वलए पलषेहषेड को टाइमलाइन पि वक्लक तथा मूव कि सकतषे हैं। अपनी मूवी को उसकषे  

वनमा्भण औि एवडवटंर सटषेज कषे  दौिान वकसी री सम्य रलानषे कषे  वलए, 'enter’ की पि वक्लक किें ।
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5. टाइमलाइन दषेखें - आपकषे  पास 11 फ्षे मस होनषे रावहए- लररर एक सषेकंड की एवनमषेशन! - पलषेहषेड को वापस अपनषे पहलषे कीफ्षे म पि ड्ैर किें ।

6. Control > Play कषे  तहत अपनी मूवी पलषे किें ।

5.2.4 मोशन tween

Flash में एवनमषेशन टाइमलाइन कषे  रािों ओि घमूता ह।ै अपनी टाइमलाइन में आप वकसी ववशषेष ईवेंट कषे  वलए एक आिंर वबंदु औि एक समापन वबंदु 

वववनददेवशत कि सकतषे हैं। मैं टाइम कषे  सथान पि पवाइंट शबद का इसतषेमाल किता हंू, क््योंवक Flash में टाइम की अविािणा वासतववक दुवन्या सषे अलर 

होती ह।ै वासतववक दुवन्या में, आप टाइम की रणना वकसी रीज़ कषे  किनषे में लरषे सषेकंड ्या वमनट अथवा घंटषे कषे  रूप में कितषे हैं। Flash में टाइम की मुख्य 

माप फ्षे मस कषे  इद्भ -वरद्भ  घमूती ह ैऔि वकसी एवनमषेशन कषे  सषेकंड/वमनट आपकी फ्षे म दि सषे अलर होतषे हैं।

तो, मोशन tweening इन सब में कहाँ वफट बठैता ह?ै जब आप Flash में कोई सिल एवनमषेशन बनातषे हैं, आप हमषेशा एक आिंर फ्षे म तथा एक समापन फ्षे म 

का वववनददेश किें । उदाहिण कषे  वलए आप फ्षे म 1 पि आपकषे  सटषेज कषे  बाएं वसिषे  पि एक बॉल को वनवद्भष्ट कि सकतषे हैं।

आप तब एक कीफ्षे म बनातषे हैं, उदाहिण कषे  वलए फ्षे म 20 पि, औि उसी बॉल को आप अपनषे सटषेज कषे  दाएँ वसिषे  पि मूव किें ।

्यवद आप अपनषे एवनमषेशन का प्रीव्य ूकितषे हैं, तो आप अपनी बॉल अपनषे सटषेज की बाई ंओि शुरू होता दषेखेंरषे औि अरानक जसैषे वक आप फ्षे म 20 पि पहंुरतषे 

हैं वह दाई ंओि नज़ि आती ह।ै बॉल कषे  शुरुआती औि अंवतम पोवजशंस कषे  बीर सुरम ट्ांजीशन नहीं होता। ्यहीं मोशन tweening काम आती ह।ै 

मोशन tweening फ्षे म 1 तथा फ्षे म 20 पि आपकी बॉल कषे  बीर एक ट्ांजीशन पदैा किता किती ह।ै Flash सवतः ही इसकी रणना कि लषेता ह ैवक आपकी 

बॉल का फ्षे म 2 औि 19 कषे  बीर क््या पोवजशन होरा, तावक जब आप अपना एवनमषेशन प्रीव्य ूकिें , तो आपकी बॉल िीिषे -िीिषे  अपनी आिंवरक बाई ंपोवजशन 

सषे अपनी दाई ंपोवजशन पि मूव किें । आपको शुरुआती औि समापन फ्षे म को वनवद्भष्ट किना होता ह।ै Flash बाकी का काम संराल लषेता ह!ै

तित्र 5.2.15: पिेहेि

तित्र 5.2.16: फे्म 1 पर ऑबजे़कट

तित्र 5.2.17: फे्म 20 पर ऑबजे़कट
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Tweening उदाहरण पेश ्करें

• एक नीला सक्भ ल बनाएँ औि उसषे वसमबल (गावफक) में बदलें।

• ्यह सवक्भ ल कषे वल आपकषे  सटषेज कषे  बीर में वसथत होना रावहए।

• अपनी टाइमलाइन फ्षे म 25 पि वक्लक किें  औि इंसट्भ कीफ्षे म का वसलषेक्ट किें ।

• आपको फ्षे म 25 पि एक कीफ्षे म वदखाई पडना रावहए। अब फ्षे म 50 पि एक कीफ्षे म इंसट्भ किें । 

आपकी टाइमलाइन में फ्षे म 1 पि एक कीफ्षे म वदखाई पडना रावहए।

• फ्षे म 25, तथा फ्षे म 50 आइए अपनषे सक्भ ल कषे  आकाि को बदलतषे हैं। अपनी टाइमलाइन पि फ्षे म 25 पि 

वापस जाएँ, अपनषे सक्भ ल पि िाइट वक्लक किें  औि फ्ी ट्ांसफॉम्भ  का र्यन किें । आपकषे  सक्भ ल कषे  

रािों ओि सकषे ल औि सक््य ू बॉक्स वदखाई पडनषे रावहए। उनमें सषे वकसी एक बॉक्स कषे  कोनषे पि 

वक्लक किें  औि बाहि की ओि ड्ैर किें :

• ्यवद आप अपनषे एवनमषेशन का प्रीव्य ूCtrl + Enter की मदद सषे दषेखनषे वालषे थषे, तो आप दषेखेंरषे वक आपका 

सक्भ ल ्ोटषे सषे शुरू होरा औि अरानक बडा बन जाएरा औि वफि अपनषे ्ोटषे आकाि पि वापस लौट 

आएरा। आइए इसषे औि बषेहति बनातषे हैं।

• फ्षे म 1 सषे फ्षे म 50 तक अपनषे टाइमलाइन कषे  सरी फ्षे म का र्यन किें । वकसी री रुनषे हुए फ्षे म पि िाइट 

वक्लक किें  औि Create Motion Tween वसलषेक्ट किें ।

• इस बात पि ध्यान दें वक जब आप अपनषे एवनमषेशन का प्रीव्य ूकितषे हैं, सक्भ ल सुरमतापवू्भक ्ोटषे सषे बडषे 

औि वफि वापस ्ोटषे आकाि की ओि एवनमषेट किता ह।ै

तित्र 5.2.18: की फे्मस इंसटटि करें

तित्र 5.2.19: आकार बदिना

तित्र 5.2.20: मोशन tween बनाना

ध्यान दें: आपके पास ्रवत ले् र और ्रवत फे्म केिल एक ऑब्केट ही होना चावहए, अन्था आपका एवनमशेन tweening कारगर नहीं होगा। साथ ही 

आपको सभी इमे् ों (bitmaps) तथा ग्ावफकस (vectors) को फलशै टाइमलाइन में इस्तमेाल करन ेस ेपिू्स इनहें वसमबल में बिलना होगा।

5.2.5 Flash Shape Tween

्यह पाठ आपको "shape tween" बनानषे कषे  तिीकषे  कषे  बािषे  में बताएरा, वजसकषे  वलए दो शषेपस वलए जातषे हैं औि उनहें एक सषे दूसिषे  में औि दूसिषे  सषे पहलषे में मॉफ्भ  

किनषे कषे  वलए इसतषेमाल वक्या जाता ह।ै शषेप tweening एक शबद ह ैवजसका इसतषेमाल Macromedia Flash में वक्या जाता ह,ै वजसका अथ्भ होता ह ैएक शषेप 

सषे दूसिषे  शषेप में ट्ांजीशन किना।

अपना tween बनानषे सषे पहलषे आपको उस शषेप की आवश्यकता होरी वजनका इसतषेमाल tween इफैक्ट पदैा 

किनषे में वक्या जा्यषेरा। सबसषे पहलषे, अपनषे टाइमलाइन कषे  फ्षे म 1 में सिल आ्यत बनाएँ, जसैा वक नीरषे 

हमािषे  पास ह।ै

टाइमलाइन ववंडो में फ्षे म 25 रुनें औि एक कीफ्षे म इंसट्भ किें । फ्षे म 50 रुनें औि एक अन्य कीफ्षे म इंसट्भ किें । 

्यह ध्यान दें वक फ्षे म 1 सषे 50 कषे  बीर एक शषेडषेड एरि्या ह।ै ्यह आपका "सवक्र्य/एवक्टव" एरि्या ह ैऔि 

आपका एवनमषेशन इसी एरि्या में बननषे जा िहा ह।ै

तित्र 5.2.21
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हम अपनषे शषेप को एक सषे दूसिषे  शषेप में मॉफ्भ  किना राहतषे हैं। इसकषे  ववपिीत आइए हम अपनषे िषे ड बॉक्स को नीलषे 

सक्भ ल में मॉफ्भ  कितषे हैं। मध्य फ्षे म ्यानी फ्षे म 25 का र्यन किें , औि मौजदूा िषे ड बॉक्स कषे  शीष्भ  पि कोई बडा नीला 

सक्भ ल बनाएँ, तावक ्यह पिूी तिह सषे कवि हो जाए। फ्षे म 25 में Oval Tool का इसतषेमाल कि, वशफट दबाएँ, लषेफट 

वक्लक किें  तथा ड्ैर कि एक बडा नीला सक्भ ल बनाएँ। फ्षे म 25 कषे  वलए आपका सटषेज अब ऐसा वदखाई पडना रावहए।

टाइमलाइन ववंडो में लषेफट-वक्लक कितषे हुए 2-24 कषे  बीर का कोई फ्षे म रुनें। प्रॉपटीज़ ववंडो में आपको tween किनषे 

कषे  वलए एक ववकलप वदखाई पडषेरा। वत्भमान में ्यह नन (none) पि सषेट वक्या होता ह।ै tween ड्ॉप डाउन सलषेक्टि 

सषे शषेप का र्यन किें ।

अब फ्षे म 26 पि एक अन्य कीफ्षे म इंसट्भ किें । 27-49 फ्षे म कषे  बीर वकसी पि लषेफट वक्लक किें  औि एक बाि वफि प्रॉपटीज़ ववंडो सषे शषेप tween रुनें।

्यवद आपकषे  पास अपनषे टाइमलाइन ववंडो में सॉवलड लाइन कषे  बजाए कोई डॉटषेड लाइन हो, तो इस बात का ध्यान िखें वक आप इस वबंदु तक वनददेशों का 

सटीक रूप सषे पालन किें रषे।

Control मषेन्य ूसषे Control < Test Movie रुनें।

ध्यान दें: इस बात का ध्ान रखें वक आपके ग्ावफकस शपेस होन ेचावहएं और आप ्वि शपे tween का इस्तमेाल करना चाहत ेहैं, तो आपको उनहें वसबंल 

में नहीं बिलना चावहए।

शेप टकेसट

आप टषेक्सट को अन्य टषेक्सट का शषेप दषे सकतषे हैं ्या टषेक्सट को गावफक इमषेज में शषेप किें  ्या इसकषे  उलट किें । बस ऊपि बताए रिणों का ही पालन किें । 

हालांवक आपको टषेक्सट को वकसी शषेप में अलर-अलर तोडना होरा। ऐसा किनषे कषे  वलए आपको Flash top Menu पि जाकि Modify > Break apart का 

ऑपशन वसलषेक्ट किना होरा।

आपको ्यह वक्र्या दुहिानषे की आवश्यकता होरी, क््योंवक जब आप पहली बाि टषेक्सट को रिषेक अपाट्भ  कितषे हैं तो टषेक्सट को एकल अक्िों में तोडतषे हैं, औि 

दूसिी बाि अक्िों को शषेप में तोडा जाता ह।ै

तित्र 5.2.22: 1 फे्म से 50 िुनें

तित्र 5.2.23

तित्र 5.2.24: शेप िुनें

तित्र 5.2.25: शेप त्टिन िुनना

तित्र 5.2.26
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5.2.6 Mask बनाना
Masking वकसी लषे्यि कषे  वहससों को प्रकट किनषे का एक सिल तिीका होता ह।ै

सटरेट्क Masks

्यहाँ इसषे बनानषे का तिीका बता्या र्या ह:ै

• Flash खोलें औि एक न्या flash डॉक््ुयमेंट बनाएँ।

• टाइमलाइन पि एक लषे्यि होता ह ै वजसका नाम “Layer 1” होता ह,ै वकसी इमषेज को 

इसी लषे्यि पि िखें। ठीक ह,ै अब आपको लषे्यि 1 कषे  ऊपि एक न्या लषे्यि बनाना होरा।

• न्या लषे्यि बन जानषे कषे  बाद, Modify > Timeline > Layer प्रॉपटशीज़ पि जाएँ औि टाइप 

कषे  रूप में 'Mask' रुनकि ok पि वक्लक किें ।

तित्र 5.2.27: माप्कंग

ध्यान दें: ्वि आप िो बार ब्के अपाट्स करत ेहैं तो टेकस्ट में सयुिार नहीं ला पाएँग।े

शेप इमेजस (bitmaps)

वकसी इमषेज को शषेप दषेनषे कषे  क्रम में आपको उसषे vector में बदलना होरा। आप ऐसा

• Illustrator (ऊपि दषेखें, illustrator Live trace) में कि सकतषे हैं ्या

• आप flash में image go to Modify > Bitmap > Trace Bitmap का र्यन कि सकतषे हैं।

• इससषे आपकी इमषेज vector ्या Brake apart में बदल जाएरी।

ध्यान दें: उपरोक्त विवि स ेवकसी इमजे को vector म ें बिलन ेकी सलाह नहीं िी जाती, क्ोंवक न्ा vector image एक बड़ी फाइल होगी और सभंितः ्ह 

एवनमशेन स्पीड के वलए समस््ा पिैा कर िेगी। आपको ्रबल सलाह िी जाती ह ैवक आप vector म ें बिलन ेके बजाए Illustrator का इस्तमेाल करें ।

• वनरलषे लषे्यि (लषे्यि 1) पि जाएँ औि वफि Modify > Timeline > Layer properties पि जाएँ औि लषे्यि टाइप कषे  रूप में 'Masked' रुनकि ok पि वक्लक 

किें । अब आपकषे  पास दो लषे्यस्भ बन रए हैं, टॉप लषे्यि 'Mask’ ह ैजहाँ वासतववक मावसकंर उतपनन होरा औि सबसषे नीरषे का लषे्यि 'Masked’ लषे्यि, 

जहां इमषेज वसथत होती ह।ै

ध्यान दें: ्वि आपकी टाइमलाइन पर िो ले् स्स हों, तो पहल ेले् र पर राइट वकलक करें  और Mask का च्न करें । आप पाएँग ेवक िूसरा ले् र अपन ेआप 

masked बन जाता ह।ै ्वि आपके पास िो स ेअविक ले् स्स हों तो केिल mask की तरह काम करन ेिाला ले् र और उसके नीच ेका ले् र masked बन 

जाएगा। अन् ले् रों की मावस्कंग के वलए आपको चरण IV को ियुहराना होगा।

तित्र 5.2.28 (a): िेयर 1 तित्र 5.2.28 (a): िेयर 2
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5.2.7 टकेसट मारस्ंकग 

अब एक शषेप का वनमा्भण किें , जसैषे वक 'Mask' लषे्यि (टॉप लषे्यि) पि एक आ्यताकाि ्या 

एक अंडाकाि शषेप। ्यहाँ इससषे कोई फक्भ  नहीं पडता वक उस शषेप को कौन-सा िंर ्या 

आउटलाइन कलि वद्या जाता ह,ै क््योंवक शषेप एक वह वहससा होरा वजसकषे  नीर इमषेज 

वदखाई पडषेरी; औि कोई री वह रीज़ जो शषेप नहीं ह ैबलैंक ऑफ कि दी जाएरी।

अब Ctrl + Enter दबाकि ्या दोनों लषे्यस्भ को लॉक कि अपनषे मासक की जाँर किें ।

ध्यान दें: एक अच्ी ्युवक्त ्ह ह,ै वक मास्क के वलए टेकस्ट का इस्तमेाल करें । ्ह करन े

के वलए टॉप ले् र पर कयु ् टेकस्ट बनाएँ और उस े्रीव् ूकरें । अब टेकस्ट के अिंर इमजे 

होना चावहए।

• चरण 1: Flash खोलें औि इस उदाहिण कषे  वलए Modify > Movie सषे वक्भ  एरि्या को 

300 x 250 का साइज़ दें, बकैगाउंड कलि कषे  रूप में काला रुनें। 'File | Import' की 

मदद सषे कोई बकैगाउंड इमषेज इमपोट्भ  किें  औि बकैगाउंड की तुलना में कोई बडी 

इमषेज रुनें। सटषेज कवि किनषे कषे  वलए इमषेज का र्यन कि उसषे िीसाइज़ किें , Modify 

> Transform > Scale’ पि जाएँ। लषे्यि 'लीवस’ का र्यन कि उसषे नाम दें। फ्षे म िषे ट पि 

वक्लक किकषे  इसषे 20 fps में बदलें।

• चरण 2: पहलषे लषे्यि कषे  ऊपि न्या लषे्यि जोडें। टषेक्सट टूल रुनें औि सटषेज कषे  मध्य में 

'leaves’ शबद टाइप किें । हमनषे Arial Black, bold, size 92, कलि बलकै का इसतषेमाल 

वक्या। र्यवनत टषेक्सट लषे्यि कषे  साथ 'Modify > Layer’ रुनें, लषे्यि को 'mask' का नाम 

दें औि 'mask' र्यन को डॉट किें । OK पि वक्लक किें ।

• चरण 3: 'leaves' लषे्यि रुनें औि Modify > Layer' का र्यन किें  औि 'masked’ को 

डॉट किें । OK पि वक्लक किें । टषेक्सट कषे  जरिए Masked लषे्यि (leaves)दषेखनषे कषे  वलए 

'Control > Test Movie' का र्यन किें ।

• चरण 4: हम वहाँ रुक सकतषे हैं औि कु् एवनमषेशन जोड सकतषे हैं, तो एक कदम आरषे बढतषे हैं औि मासक को सटषेज पि मूव किातषे हैं। 'leaves’ लषे्यि 

कषे  फ्षे म 40 पि वक्लक किें  औि 'F5' पि वक्लक कि टाइमलाइन एक्सटेंड किें , वफि लषे्यि लॉक कि दें तावक आप उसषे रलती सषे एवडट न कि दें। Mask 

लषे्यि रुनें औि फ्षे म 40 पि एक कीफ्षे म 'F6’ जोडें। 'Windows > Panel > Frame’ रुनकि फ्षे म पनैल खोलें।

र्यवनत लषे्यि कषे  साथ, फ्षे म पनैल सषे लषे्यि पि मोशन tween डालें। फ्षे म 1 पि वक्लक किें  औि टषेक्सट को सटषेज कषे  दाएँ वसिषे  पि वखसकाएँ। फ्षे म 40 पि 

वक्लक किें  औि टषेक्सट को सटषेज की दाई ंओि वखसकाएँ। लषे्यि लॉक किें  औि आपको मासक वदखाई पडषेरा। रिवाइंड कि अपनी मूवी को रलाएँ औि वसथि 

इमषेज पि टषेक्सट िोल दषेखें।

तित्र 5.2.29: माप्कंग की जाुँि करें

तित्र 5.2.30: टेक्ट माप्कंग

तित्र 5.2.31: कवै रेकटर

तित्र 5.2.32: िेयर िुनें
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5.2.8 सीन पर ्काम ्करना
Flash ऑथरिंर एनवा्यिनमेंट में, टाइमलाइन की एक सीिीज को वरवनित किनषे कषे  वलए वजससषे होकि SWF फाइल आरषे बढती ह,ै सीन का इसतषेमाल कि 

सकतषे हैं। gotoAndPlay() कषे  दूसिषे  पिैामीटि ्या gotoAndStop() वववि्यों का इसतषेमाल कि आप पलषेहषेड पि रषेजषे जानषे हषेतु वकसी सीन को वववनददेश कि 

सकतषे हैं। सरी FLA फाइलस कषे वल आिंवरक सीन कषे  साथ आिंर होती हैं, पि आप नई सीन बना सकतषे हैं।

सीन का इसतषेमाल किना हमषेशा सवपोत्तम तिीका नहीं होता ह,ै क््योंवक सीन की कई सािी खावम्याँ री होती हैं। Flash डॉक््ुयमेंट्स वजसमें कई सािी सीन 

होती हैं, मेंटषेन किना कवठन होता ह,ै खासकि मलटीऑथि एनवा्यिनमेंट में। कई सािषे  सीन बैंडववड्थ में अप्ररावी री हो सकती ह,ै क््योंवक प्रकाशन 

प्रवक्र्या सरी सीनों का एकल टाइमलाइन में ववल्य कि दषेती ह।ै इससषे सरी सीनों का उत्तिोत्ति/एक कषे  बाद एक डाउनलोड होता ह,ै रलषे ही उनहें करी पलषे 

न वक्या जाए। इन कािणों सषे, मवलटपल टाइमलाइन आिारित कषे  अलावा मवलटपल सीन कषे  इसतषेमाल को अक्सि प्रोतसावहत नहीं वक्या जाता।

MovieClip क्लास की सीन प्रॉपटशी कई प्रकाि कषे  Scene ऑबजषेक्ट लौटाती ह,ै जो SWF फाइल में सरी सीन को वनरूवपत कितषे हैं। currentScene प्रॉपटशी 

एक सीन ऑबज़षेक्ट वापस किती ह ैजो उस सीन को वनरूवपत किता ह ैजो वत्भमान में रल िही हो। सीन क्लास में कई प्रॉपटशीज़ होती हैं, जो वकसी सीन कषे  

बािषे  में सरूना दषेती हैं। लषेबलस प्रॉपटशी कई प्रकाि कषे  FrameLabel ऑबजषेक्ट लौटाती ह,ै जो उस सीन में फ्षे म लषेबलस को वनरूवपत कितषे हैं। नषेम प्रॉपटशी वसटं्र 

कषे  रूप में सीन का नाम लौटाती ह।ै numFrames प्रॉपटशी एक int लौटाती ह,ै जो उस सीन में फ्षे मस की कुल संख्या को वनरूवपत कितषे हैं।

तित्र 5.2.33: सीन के साथ काम करना

5.2.9 Sound Forge: साउंि एरिरटंग

ि्कटि सपेस: जब आप पहली बाि Sound Forge ओपन कितषे हैं, तो आपका वक्भ सपषेस खाली हो जाएरा।

तित्र 5.2.34: िकटि ्पेस
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जब आप कोई साउंड फाइल ओपन कितषे हैं, वह इस ववंडो में वदखषेरी।

टूलबाि: वक्भ सपषेस कषे  टॉप पि दो टूलबास्भ होतषे हैं: एक एवडवटंर कषे  वलए (एवडवटंर टूलबाि) तथा एक साउंड फाइलों की रिकॉवडयंर औि पलषेबकै को वन्ंयवत्रत 

किनषे कषे  वलए (्यानी ट्ांसपोट्भ  टूलबाि)।

फाइल खोलना: आपकषे  पास फाइल खोलनषे कषे  दो ववकलप होतषे हैं।

• एक न्यी फाइल बनाएँ: नए मटैीरि्यल की रिकॉवडयंर कषे  वलए प्र्ुयक्त एक खाली फाइल।

• पहलषे सषे मौजदू साउंड फाइल खोलें (एक सैंपल, राना इत्यावद)।

• न्यी साउंड फाइल बनानषे कषे  वलए ्या तो टूलबाि पि New बटन पि वक्लक किें , ्या 

फाइल मषेन्य ूपुल डाउन किें  औि न्य ूवसलषेक्ट किें  नए का र्यन किें :

• फाइल सषेव किना: ्यह सुवनवश्चत कि लें वक आपकी डषेटा ववंडो 

(अरला सषेक्शन दषेखें) रुना जाए। फाइल मषेन्य ूपुल डाउन किें  

औि Save As का र्यन किें ।

तित्र 5.2.35: िकटि ्पेस

तित्र.5.2.36: फाइि खोिना

तित्र 5.2.37: फाइि सेि करना
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र्कसी मूिी में साउंि एरिट ्करना

Adobe Flash वनमनवलवखत साउंड फॉमदेट “read” कि सकता ह:ै MP3 – QuickTime – WAV 

– TIFF

• अपनी साउंड अपनी लाइरिषेिी में इमपोट्भ  किें , जसैा वक आप इमषेजों कषे  साथ कितषे हैं। बस 

टॉप मषेन्य ूपि जाएँ औि File > Import to Library पि जाएँ।

• बहुत ही बुवन्यादी परिर्य कषे  रूप में, वकसी र्यवनत .wav फाइल को आपकषे  .fla में 

इमपोट्भ  किना आसान होता ह।ै साउंड जब इमपोट्भ  की जाती ह,ै ्यह लाइरिषेिी सषे एक 

ववकलप कषे  रूप में उपलबि होरी (्यवद आप इसषे खुद कषे  लषे्यि पि इमपोट्भ  कितषे हैं) ्या 

'साउंड’ पनैल सषे एक ववकलप कषे  रूप में उलपबि होरी।

अपनषे मुख्य टाइमलाइन में एक बकैगाउंड लपू कषे  रूप में वकसी साउंड का इसतषेमाल किनषे कषे  वलए, उसकषे  वलए एक पथृक लषे्यि का वनमा्भण किें  औि तब 

उसषे इमपोट्भ  किें  ्या इसषे लाइरिषेिी सषे सटषेज पि ड्ैर किें । लराताि सषे पलषे किनषे कषे  वलए, 'Sync' को सटाट्भ  कषे  रूप में औि 'Loops' को 999 पि सषेट किें । एक बाि 

पलषे किनषे औि उसकषे  बाद िोकनषे कषे  वलए 'Loops' को 0 पि िखें। आप साउंड को फ्षे ड इन औि आउट पि री सषेट कि सकतषे हैं।

आप वकसी ्ोटी साउंड को वकसी ईवेंट पि री असाइन कि सकतषे हैं। उदाहिण कषे  वलए ्यवद आप बटन कषे  'ओवि’ सटषेट पि वकसी साउंड को र्यन कि उसषे 

असाइन कितषे हैं तो एक बटन माउस-ओवि पि बीप कि सकता ह।ै

अपनी मूवी में साउंड वसंक्रोनाइज़ किनषे का दूसिा तिीका ह ै साउंड लषे्यि कषे  

अंवतम कीफ्षे म को ड्ैर कि औि उसषे मूव किकषे  टाइमलाइन को एडजसट किना।

तित्र 5.2.38: साउंि

तित्र 5.2.39: बवैकग्ाउंि के रूप में साउंि

तित्र 5.2.40: शॉटटि साउंि 

तित्र 5.2.41: दसूरा िरीका
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साउंड को फषे ड इन तथा फषे ड आउट किनषे कषे  वलए साउंड प्रॉपटशीज़ 'effect' 

टबै का इसतषेमाल किें ।

5.2.9 बटन बनाना
वन्यवमत HTML की तिह, बटन कषे वल सिल नषेववरषेशन इंटिफषे स सषे कहीं ज्यादा होतषे हैं। Flash में कोई ऑबज़षेक्ट एक बटन हो सकता ह।ै बटन न कषे वल 

प्र्योक्ता को दूसिषे  पषेज पि लषे जानषे की व्यावहारिक वववि्याँ प्रदान किता, बवलक ्यषे कु् वनवश्चत उननत फंक्शन कॉल वकए जा सकनषे की वसथवत में एक 

इंटिफषे स का री वनमा्भण किता ह।ै नीरषे वदए ट््ुयटोरि्यल में आप बटन वक्रएट किना औि ओवि, डाउन तथा वहट सटषेट्स जोडना सीखेंरषे।

• सबसषे पहलषे, Flash में एक नई मूवी वक्रएट किें । ्यह काफी सिल प्रवक्र्या होती ह,ै 

इसवलए “intro” सोस्भ कोड नहीं होरा। 

• न्या Flash डॉक््ुयमेंट खोलनषे कषे  बाद, Insert > New Symbol पि जाएँ। पॉप अप 

होनषे वाली ववंडो सषे बटन सषे ववकलप रुनें औि उसषे ऐसा नाम दें वजसषे ्याद किना 

आसान हो। OK पि वक्लक किें । नीरषे वदए इमषेज दषेखें।

• ्यह कि लषेनषे कषे  बाद, आप दषेखेंरषे वक आपकी टाइमलाइन बटन की प्रॉपटशीज़ को 

समा्योवजत किनषे कषे  वलए बदल रुका ह।ै इस उदाहिण कषे  वलए, Frame marked 

“Up” पि वक्लक किें  औि ड्ॉइंर एरि्या में सक्भ ल ड्ॉ किें । साथ ही, अन्य फ्षे म 

माक्ड्भ  "Over", "Down", तथा "Hit" पि वक्लक किें  औि कीफ्षे म इंसट्भ किें । आप ओवि तथा डाउन सटषेट्स कषे  वलए सक्भ ल कलि को बदल सकतषे हैं, 

वजससषे आप उस बटन को काम किता दषेख सकें । 

तित्र 5.2.42: Effect टवैब

तित्र 5.2.43: नई मूिी

तित्र 5.2.44: बटनस के तिए अनय किर

• अब, आपको किना ्यह ह ैवक मूवी को आप अपनषे मषेन टाइमलाइन में जोडें। ्याद 

िखें वक ्यह बटन एक नए वसमबल कषे  रूप में इंसट्भ वक्या र्या था औि उसषे मषेन 

मूवी कषे  कािरि होनषे कषे  वलए मषेन मूवी में िखा जाना रावहए। सबसषे ऊपि बाई ंओि 

सीन 1 बटन पि वक्लक कि उसषे मषेन मूवी पि लषे जाएँ। तित्र 5.2.45: सीन 1 बटन
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• ्यवद आपनषे इस बटन को वकसी नई मूवी सषे आिंर वक्या ह,ै तो आपकी टाइमलाइन तथा ड्ॉइंर एरि्या खाली वदखनषे रावहए। बटन जोडनषे कषे  वलए, 

Window > Library वक्लक किें , ्या Library Window लॉनर किनषे कषे  वलए (Ctrl + L on keyboard) पि वक्लक किें । अब, आपको किना ्यह ह ैवक 

आप लाइरिषेिी कषे  इंसटैंस “बटन” को टाइलमाइन पि ड्ैर किें । बस एक वक्लक कि ड्ैर किें ! 

• पहलषे लषे्यि में आपकी टाइमलाइन में एक औि कषे वल एक कीफ्षे म होना रावहए। सक्रीन पि होनषे कषे  दौिान बटन वदखाई री पडना रावहए। बटन कैसषे 

काम किता ह ै्यह दषेखनषे कषे  वलए Ctrl + Enter दबाएँ ्या File > Publish Preview > HTML पि जाएँ।

बटन एकशनरसक्र्पट

• आपकषे  बटन कषे  वलए सामान्य एक्शनवसक्रपट

• Flash में एक्शन पनैल खोलें, बटन का र्यन किें  औि एक्शंस पनैल पि टाइप

• रुनें।

• एक्शन पनैल पि Movie clip control > on > release पि जाएँ।

• वफि एक सपषेस ्ोडें औि Timeline control > gotoAndPlay > ऑन किें  “औि वववनवद्भष्ट किें

• वक्लक किनषे पि आप कहाँ ट्ांसफि किना राहतषे हैं।

तित्र 5.2.44(a): बटन एकशनत्क्पट
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अपनी िाइनि मूिी ्को एकसपोटटि ्करें

• File > Export movie पि जाएँ

• एक नई ववंडो वदखषेरी होरी, अपनी मूवी को एक नाम दें औि अपनी मूवी को एक्सपोट्भ  वकए जानषे हषेतु फॉमदेट कषे  प्रकाि का र्यन किें ।

ध्यान दें: आप काम कैस ेसौंप ेंग ेऔर वकस फॉममेट म ें सौंप ेंग ेइस पर अविक जानकारी पान ेके वलए ्रोजकेट गाइडलाइंस पर जाएँ।

तित्र 5.2.44 (b): बटन एकशनत्क्पट

तित्र 5.2.45: बटन एकशनत्क्पट
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अभयास

रिसटॉटमेि पसटिपेरकटि ्की रोटरेटंग और ्करेरकटंग

ऊपि प्रदवश्भत परिणाम पानषे कषे  वलए इमषेज को क्रॉप किें । नीरषे एक सक्रीन शॉट ह,ै जो उस वसलषेक्शन कषे  काफी वनकट ह,ै जो आपको किना होरा। आिंवरक 

र्यन किनषे कषे  बाद आप कू्रक्ड ऐरंल सही किनषे कषे  वलए इसषे घुमाना राहतषे हों, तो पस्भपषेवक्टव एडजसट किनषे कषे  वलए टॉप कॉन्भस्भ  को मूव किें । ्यह ध्यान 

दें वक र्यन सीमा का सबसषे नीरषे का वकनािा घि कषे  आिाि कषे  साथ अलाइन वक्या जाता ह ैऔि वकनािषे  घि कषे  वकनािों कषे  साथ अलाइंड वकए जातषे हैं। 

्याद िखें वक अपनी रवत पि काब ूपानषे कषे  वलए हैंडलस ड्ैर कितषे सम्य आप वशफट-की का इसतषेमाल कि सकतषे हैं। इससषे आपको पस्भपषेवक्टव एडजसट 

कितषे सम्य सबसषे ऊपिी औि सबसषे वनरलषे वकनािषे  को अलाइन किनषे में मदद वमलषेरी।

ध्यान दें: ्वि आप सेंटर पिाइंट मिू करत ेहैं, ्ा कॉन्सर हैंडल को गलत तरीके स ेरखत ेहैं, तो Photoshop एक एरर मसे ै्  ्रिवश्सत करेगा। ्वि आप इस 

Error को िेखत ेहैं, तो आपको कॉन्सर हैंडल को ररपोवजशन कर प युनः ्र्ास करना होगा।

क्रॉवपंर सषे पहलषे क्रॉवपंर कषे  बाद
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प्ररैकटस एकसरसाइज़ 1

र्यन टूल कषे  साथ क्रॉवपंर किना

Photoshop में, आप वकसी माकशी सषेलषेक्शन टूलस कषे  साथ वकए रए वकसी र्यन को क्रॉप री कि सकतषे हैं, हालांवक क्रॉप की रई इमषेज हमषेशा एक 

आ्यताकाि आकृवत में होरी, जो सषेलषेक्शन माकशी कषे  सबसषे बाहिी क्षेत्र की पुवष्ट किती ह।ै सषेलषेक्शन जब ऐवक्टव हो, Image > Crop का र्यन किें ।

बाई ंओि प्रदवश्भत नतीजषे पानषे कषे  वलए प्रवैक्टस इमषेज का र्यन किें । दाई ंओि Image > Crop रुननषे कषे  बाद की इमषेज का एक सक्रीन शॉट ह।ै क्रॉवपंर  

सषे पहलषे।

क्रॉवपंर सषे पहलषे क्रॉवपंर कषे  बाद

इमेज मरैनपुिशेन 

चरण 1: जेंटल सकाई गषेवडएंट बनानषे कषे  वलए गषेवडएंट टूल का इसतषेमाल किें । वदन कषे  

सम्य, वा्ुयमंडली्य सं्योजन इत्यावद कषे  आिाि पि िंर वरनन होंरषे, पि ििती ्या ऐसी ही 

रीज़ कषे  वलए सबसषे नीरषे हलका आसमानी िंर िखें औि शीष्भ  पि फीका पडता रहिा 

आसमानी।।

चरण 2: बादल, मषेिी वववि कु् ्यूं ह:ै कहीं सषे री बादलों कषे  झंुड (मषेघपंुज) की उचर-

रुणवत्ता वाली फोटोगाफी हावसल किें  (ध्यान िखें, वक आप कॉपीिाइट ्या िॉ्यलटी लषेज/

वन्यमों का पालन कि िहषे हों)।

अब उन सरी को समान कैनवस पि लाएँ, तावक वषे एक-दूसिषे  पि लररर आच्ावदत सषे हों 

औि एक अि्भ-ववश्वसनी्य बादल की िरना किें , हिषे क लषे्यि सषे रुजिें  औि CTRL+SHIFT+U (Desaturate) का इसतषेमाल किें  औि लषे्यि को सक्रीन पि सषेट 

किें , आपको कई सािषे  वर्भ  औि अन्य रद्ापन री वदखाई पडेंरषे, हिषे क लषे्यि कषे  साथ वफि सषे आरषे बढना सही ह ैऔि तबतक रिाइटनषेस-कंट्ासट समा्योवजत 

किना होरा, जबतक वक वर्भ कषे  वकनािषे  फीकषे  न होनषे लरषे (रिाइटनषेस कम, कंट्ासट अविक), ध्यान िखें वक आप बादलों को ्ा्यावरत्र/वसलुएट्स में सफषे द 

में बनाएँ।

बादलों कषे  वनमा्भण कषे  वकनािषे  पि उसषे िखें वजनकषे  वरा्भकाि वकनािषे  रा्यब हो रए हों (नीरषे दषेखें) औि वफि अन्य को सही सथान पि िखें। 
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चरण 3: अरला वमशण। अब जबवक आपकषे  बादल पिूी तिह सषे डीसरुैिषे टषेड, सक्रीन पि सषेट हों, सक्रीन औि कंट्ासट-समा्योवजत हों, तो आपको उनहें वमवशत 

किना होरा। सपष्ट वकनािों वालषे बादल (जसैा वक ऊपि ह)ै में ज्यादा कु् किनषे की ज़रूित नहीं ह,ै , पि वजस पि सटॉक फोटो का सकाई-वहससा पिूा तिह 

सषे फीका पडनषे में ववफल िहा हो, उनकषे  वलए आपको इिषे ज़ि औि समज़ टूल कषे  साथ काम किना होरा, मैं इसकषे  वलए वनमनवलवखत रिशों कषे  इसतषेमाल की 

सलाह दंूरा:

्यषे रिश इिषे वजं़र, समवजं़र तथा रिवशंर कषे  वलए कािरि होतषे हैं। ्याद िखें, बादलों में आ्यतन होता ह,ै इसवलए ्यवद आप रीज़ों को वमटातषे हैं औि उनकषे  

प्राकृवतक शषेवडंर को बदलतषे हैं तो आपको थोडा शषेड किना होरा। साथ ही, क्लाउड लषे्यस्भ को घुमानषे का री प्र्यास किें , तावक प्रकाश एक ही वदशा सषे 

आता प्रतीत हो। रहिषे  िंर कषे  वकसी पतलषे लषे्यि पि रिश किें , औि ्यवद आवश्यक हो तो शषेवडंर कषे  वलए समज़ किें । साथ ही, बादलों को अविक अवतच्ावदत 

औि अविक वहाइट आउट होनषे सषे िोकें । ्यवद आपको वाकई रमकीलषे परै का एक रुच् वमलता ह,ै तो कु् क्लाउड लषे्यि को वमटाएँ तावक वषे फीकषे  पड जाएँ 

औि तब उनहें समज़-बलेंड किें । रलषे ही बादल सफषे द होतषे हों, पि उनसषे आंखें नहीं रौंवि्यातीं औि न ही वषे अपना प्रकाश फषे कतषे हैं। अपनषे बादलों की रिवशंर 

कषे  सम्य करी वबलकुल सफषे द का इसतषेमाल न किें ।



111110

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

अरला रार फषे डषेड-पलनैषेट इफैक्ट की जानकािी दषेरा। ्यह एक सिल मामला ह।ै

सबसषे पहलषे, एक गह हावसल किें , मैं एक अलर, जवटल प्रवक्र्या सषे अपना खुद का बनाता हँू, पि ढषेि सािषे  पलनैषेट ट््यटूोरि्यल उपलबि हैं - ्यवद आपको 

पलनैषेट ्या गह बनाना न आता हो तो आप उनमें सषे वकसी एक का अनुसिण किें । अपनषे गह को बाहि वनकालें (दाएँ दषेखें)। कृप्या पिूी काली िात वाली 

तिफ दषेखें।

अब, पलनैषेट लषे्यि को डीसरुैिषे ट किें , जो फलटै होना रावहए (वसंरल लषे्यि) CTRL+SHIFT+U का इसतषेमाल किें । आपको अपनषे पलनैषेट कषे  वलए अच्ा 

एहसास लानषे कषे  वलए उसकषे  रिाइटनषेस-कंट्ासट को समा्योवजत किनषे की ज़रूित हो री सकती ह ैऔि नहीं री ।

अब, पलनैषेट को अपनषे सकाई-एंड-क्लाउड्स कैनवस पि लाएँ औि उसषे सक्रीन पि सषेट किें । प्रबल दृश्य क्रषे सेंट पानषे कषे  वलए आवश्यकतानुसाि लषेवल ्या 

रिाइटनषेस/कंट्ासट एडजसट किें । आप सकाई कषे  नीलषेपन को दषेख सकतषे हैं वक इसमें एक अच्ा लुक ह,ै मानो वदन कषे  सम्य राँद वदखाई पडता हो।

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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6. 3D एरनमेशन बनाएँ

्यवूनट 6.1- 3D एवनमषेशन बनाएँ

्यवूनट 6.2 – ऑबजषेक्ट बनाना, मवैनपुलषेट किना तथा दषेखना

्यवूनट 6.3- Maya 3D सीन दषेखना

्यवूनट 6.4- पॉलीरोनल मॉडवलंर

्यवूनट 6.5- NURBS मॉडवलंर

्यवूनट 6.6- एवनमषेशन

्यवूनट 6.7- पॉलीरोन टषेक्सररिंर

्यवूनट 6.8- िें डरिंर
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. वसक्वेंस तथा सीन/शॉट्स त्ैयाि किनषे में वडजाइन, 3D एवनमषेशन तथा वफलम-मषेवकंर कषे  वसद्धांतों को अपनानषे में।

2. मोशन/पिफॉममेंस कैपरि सटूवड्यो सषे प्राप्त मोशन कैपरि डषेटा कषे  साथ काम किनषे में (डषेटा क्लीन अप किनषे औि एवनमषेशन डषेटा को 3D मॉडल कषे  वलए 

मपै किनषे में)।

3. प्रीव्य ूकषे  वलए एक प्रोटोटाइप वक्भ  प्रोडक्ट/प्री-ववजु़अलाइज़षेशन त्ैयाि किनषे में।

4. वडज़ाइन वववनददेशों तथा प्रोड््यसूि रिीफ को ध्यान में िखतषे हुए बनषे हुए एवनमषेशन का समीक्ातमक रूप सषे मूल्यांकन किनषे में।

5. 3D एवनमषेशन तकनीकों कषे  साथ रि्यवलवसटक 3D एवनमषेशन (मोशन कैपरि + की फ्षे म एवनमषेशन) जसैा वक beowulf, avatar तथा gollum में 

इसतषेमाल वक्या र्या था औि सषेमी-रि्यवलवसटक एवनमषेशन- little krishna औि brave, toon एवनमषेशन का उदाहिण ह ैkung-fu panda, ट्षेवडशनल तथा 

Stop Motion टषेक्नीक कषे  वसम्ुयलषेशन का उप्योर किें , जसैषे वक vineta cucini, amaron battery इत्यावद कषे  ववज्ापनों में इसतषेमाल वक्या र्या था।

6. 3D रवत औि पिफॉममेंस पदैा किें , वजनकषे  वलए सहमत टाइमलाइन कषे  रीति 3D एवनमषेशन सॉफटवषे्यि कषे  इसतषेमाल की आवश्यकता होती ह।ै

रनष्कषटि 
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यूरनट 6.1: 3D एरनमेशन बनाएँ

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Maya सॉफटवषे्यि की मदद सषे 3D एवनमषेशन एंड-प्रोडक्ट त्ैयाि किनषे में।

2. वसक्वेंस तथा सीन/शॉट्स त्ैयाि किनषे में वडजाइन, 3D एवनमषेशन तथा वफलम-मषेवकंर कषे  वसद्धांतों को अपनानषे में।

6.1.1 Maya यूज़र इंटरिेस

6.1.2 Maya आरंभ ्करना

3D एवनमषेशन कषे  वलए दुवन्या रि में कई सॉफटवषे्यि टूलस का इसतषेमाल वक्या जाता ह।ै Maya उनमें सषे एक ह।ै  इस ्यवूनट में हम Maya की मदद सषे 3D 

एवनमषेशन बनानषे की वववि सीखेंरषे।

्यह आपको फीरस्भ का उप्योर किनषे औि टूलस तथा एवडटस्भ कषे  परिरालन में मदद किता ह,ै जो आपको अपनषे वत्रववमी्य वसतुओ,ं सीन एवनमषेट किनषे, 

तथा Maya कषे  रीति इफैक्ट त्ैयाि किनषे तथा पषेश किनषे में सक्म बनातषे हैं। 

Windows पर Maya आरंभ ्करना

• अपनषे डषेसकटॉप पि Maya आइकन पि डबल वक्लक किें ।

• (Windows 2000 Professional) Windows Start menu, सषे Programs > Autodesk > Autodesk Maya 2008 > Maya 2008 (Maya Complete ्या Maya 

Unlimited) रुनें।

• (Windows XP Professional) Windows Start menu, सषे All Programs > Autodesk > Autodesk Maya 2008 > Maya 2008 (Maya Complete ्या Maya 

Unlimited) रुनें।

म्ैक OS X पर Maya आरंभ ्करना

• अपनषे डषेसकटॉप पि Maya आइकन पि डबल वक्लक किें ।

• अपनषे Dock पि Maya आइकन पि वक्लक किें ।

• Apple Finder menu सषे Go > Applications रुनें औि तब Maya आइकन रिाउज़ किें  औि Maya राल ूकिनषे कषे  वलए उसपि डबल वक्लक किें ।

Linux पर Maya आरंभ ्करना

• अपनषे डषेसकटॉप पि Maya आइकन पि डबल वक्लक किें ।

• शषेल ववंडो पि: Maya टाइप किें ।

Maya इंटरिेस सीखना

• मषेन्यजू़ कषे  साथ काम किें । 

• सटषेटस लाइन बटन का इसतषेमाल किें ।

• Shelf एक्सषेस किें । 

• Channel Box तथा Layer Editor खोजें।

यूरनट ्ेक उद्ेशय  
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• animation controls, the Command Line तथा the Help Line की पहरान किें ।

• Toolbox तथा Quick Layout बटन का इसतषेमाल किें ।

• Secret मषेन्यजू़ की खोज किें । 

Maya एक प्रोगाम ह,ै वजसषे Autodesk द्ािा त्ैयाि वक्या ह,ै वजसका इसतषेमाल मॉडल बनानषे, एवनमषेट किनषे तथा 3D सीन दषेनषे में वक्या जाता ह।ै Maya कषे  

साथ बनषे 3D सीन मूवीज़, टषेलीववज़न, ववज्ापनों, रषेमस, प्रोडक्ट ववजु़अलाइज़षेशन तथा वषेब पि वदखाई पडतषे हैं। Maya कषे  साथ, आप अपनषे खुद कषे  3D सीन 

त्ैयाि औि एवनमषेट कि सकतषे हैं औि उनहें वसटम इमषेज ्या एवनमषेशन सीक्वेंस में पषेश कि सकतषे हैं।

 Maya कषे  कई संसकिण मौजदू हैं औि उनकषे  बीर का अंति उनमें सषे प्रत्यषेक में उपवसथत फीरिों कषे  कािण होता ह।ै Maya कषे  व्यावसाव्यक संसकिण में हि 

वह रीज़ शावमल होती ह,ै जो आपको 3D सीन औि एवनमषेशन वक्रएट किनषे औि िें डि किनषे कषे  वलए रावह्यषे। Maya कषे  एक उननत संसकिण में Fluid 

Effects, Cloth, Hair तथा Fur features री शावमल हैं। Maya का एक मुक्त रूप सषे उपलबि संसकिण री ह ैवजसषे पस्भनल लवनयंर एवडशन कहा जाता ह।ै 

पस्भनल लवनयंर एवडशन Maya Complete कषे  समान ही होता ह,ै अंति कषे वल इतना ह ैवक इसकी सरी िें डरिंगस पि एक वॉटिमाक्भ  शावमल ह,ै जो इसषे Maya 

सीखना शुरु किनषे कषे  वलए एक शानदाि जरह बनातषे हैं।

पहली नज़ि में Maya इंटिफषे स थोडा डिानषे वाला लर सकता ह,ै क््योंवक इसमें हि जरह बटन, कंट्ोलस तथा पिैामीटस्भ वमलतषे हैं, पि ्यवद आप ध्यान सषे 

दषेखेंरषे तो पाएँरषे वक सरी कंट्ोलस लॉवज़कल सषेट में वरशीकृत होतषे हैं। कंट्ोलस कषे  इन वववरनन सषेटों सषे परिवरत होनषे सषे इंटिफषे स कषे  साथ काम किना काफी 

आसान हो जाता ह।ै

इंटिफषे स कषे  सबसषे ऊपि वकनािषे  पि मषेन्यजू़ होतषे हैं औि एक टूलबाि बटन होता ह,ै वजसषे Status Line कहा जाता ह।ै आप वजस मोड पि काम कितषे हैं उसकषे  

आिाि पि मषेन्यजू़ बदल सकता ह।ै Status Line कषे  नीरषे बटन की एक टबैड कताि होती ह।ै बटनों की इस कताि को Shelf कहा जाता ह,ै औि ्यह कई 

कमांड कषे  सषेट को एकवत्रत किनषे का एक सुवविाजनक तिीका दषेता ह।ै इंटिफषे स की दाई ंओि पिैामीटि का एक पनैल होता ह ैवजसषे Channel Box कहा 

जाता ह।ै ्यषे पिैामीटि ऐवट्ब्ुयट्स कषे  नाम सषे जानषे जातषे हैं, जो रुनी हुई वववरनन वसतुओ ंकषे  अनुरूप बदलतषे िहतषे हैं। Channel Box कषे  नीरषे Layer Editor 

वसथत होता ह।ै

इंटिफषे स कषे  सबसषे नीरषे Range Slider तथा animation controls पाए जातषे हैं, वजनका इसतषेमाल वकसी एवनमषेशन सीक्वेंस कषे  वववरनन फ्षे मस कषे  बीर 

वववनवद्भष्ट किनषे तथा वखसकनषे में वक्या जाता ह;ै साथ ही, सबसषे नीरषे Command Line तथा Help Line होतषे हैं, वजनका इसतषेमाल टषेक्सरुअल कमांड एंटि 

किनषे में वक्या जाता ह।ै अंत में, इंटिफषे स की बाई ंओि बटनों का क्वैतज कॉलम Toolbox तथा Quick Layout बटन कषे  रूप में जाना जाता ह।ै इन बटनों का 

इसतषेमाल सीन ऑबज़षेक्ट का र्यन किनषे औि उनहें रूपांतरित किनषे औि साथ ही इंटिफषे स लषेआउट बदलनषे में वक्या जाता ह।ै

इंटिफषे स कषे  साथ काम शुरू किनषे कषे  वलए एक संकलपना वजसषे समझना आपकषे  वलए ज़रूिी ह,ै वह ्यषे वक समान कमांड को एक्सषेस किनषे कषे  कई तिीकषे  

होतषे हैं। उदाहिण कषे  वलए, आप Create, Polygon Primitives, Sphere menu command का इसतषेमाल कि अथवा Polygons shelf में Polygon Sphere बटन 

का इसतषेमाल कि एक सफषे ्यि का वनमा्भण कि सकतषे हैं। ्यह वडजाइन जानबझू कि दी रई होती ह ैतावक प्रवशकु् वकसी कमांड को एक्सषेस किनषे की एक 

सहज वववि का इसतषेमाल कि सकें  औि एडवांसड प्र्योक्ताओ ंको ऐसी एक्सषेस वववि हावसल हो सकषे  जो उनहें तषेज़ी सषे काम किनषे में सक्म बनाए, क््योंवक 

इससषे वषे शॉट्भकट सीख जातषे हैं।

एडवांसड-्यजू़ि कमांड्स को तवरित रूप सषे एक्सषेस किनषे का एक तिीका ह ैSecret मषेन्य ूका इसतषेमाल किना। ्यषे संदर्भ-वववशष्ट पॉप-अप मषेन्य ूतब प्रकट 

होतषे हैं जब आप इंटिफषे स पि िाइट वक्लक कितषे हैं। कमांड एक्सषेस किनषे का दूसिा सबसषे तीव्र तिीका ह ैकीबोड्भ  शॉट्भकट का इसतषेमाल किना, वजसषे 

हॉटकी कहा जाता ह।ै

Maya प्र्योक्ताओ ंको इंटिफषे स को कसटमाइज़ किनषे का ववकलप दषेता ह।ै कसटमाइज़षेशन ऑपशन का इसतषेमाल कि, आप कमांड आइकंस का एक कसटम 

सषेट त्ैयाि कि सकतषे हैं, कीबोड्भ  शॉट्भकट्स परिरावषत कि सकतषे हैं औि मषेन्यजू को री बदल सकतषे हैं। कई सािषे  कसटमाइज़षेशन ऑपशन Window, 

Settings/Preferences मषेन्य ूमें मौजदू होतषे हैं।

6.1.2.1 मेनयूज़ ्ेक सा्थ ्काम ्करें
जब आपनषे Maya पि न्या-न्या काम किना शुरू वक्या हो, तो मषेन मषेन्य ूकमांड्स ही वह पहली जरह होती हैं, जहाँ आपको कमांड ढँूढनी रावहएं। कमांड्स 

को टषेक्सट कषे  रूप में वलसट वक्या जाता ह,ै वजससषे तबतक उन कमांड्स को खोजना आसान बन जाता ह,ै जबतक वक आप वववरनन बटनों कषे  का्य्भ  कषे  बािषे  

में रली-रांवत सीख नहीं लषेतषे हैं। हिषे क मषेन्य ूमें कई सब-मषेन्य ूशावमल हो सकतषे हैं। सब-मषेन्य ूको एक ्ोटषे, दाई ंओि इंवरत किनषे वालषे ऐिो सषे पहराना जाता 

ह,ै जो मषेन्य ूकषे  दाएँ वसिषे  पि वसथत होता ह।ै



117116

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

मेंनू सेट्स बदिना

मषेन्यजू़ डाइनषेवमक होतषे हैं औि र्यवनत मषेन्य ूसषेट कषे  आिाि पि बदलतषे िहतषे हैं। आप ड्ॉप-डाउन वलसट की मदद 

सषे मषेन्य ूसषेट कषे  बीर बदलाव ला सकतषे हैं, ड्ॉप-डाउन वलसट वरत्र 1-1 में वदखाए अनुसाि Status Line की वबलकुल 

बाई ंओि होती ह।ै इसकषे  ववकलपों में शावमल होतषे हैं Modeling, Rigging, Animation, FX, Rendering तथा मषेन्य ू

सषेट ड्ॉप-डाउन वलसट को कसटमाइज़ किनषे का एक ववकलप।

सुझाव: हिषे क मषेन्य ू सषेट में एक संबद्ध हॉटकी होती ह।ै मॉडवलंर कषे  वलए हॉटकी ह ै F2, रिवरंर कषे  वलए F3, 

एवनमषेशन कषे  वलए F4, FX कषे  वलए F5 तथा िें डरिंर कषे  वलए F6।

पहलषे ्ह मषेन्य,ू File, Edit, Modify, Create, Display, तथा Window, सरी मषेन्य ूसषेट में उपलबि होतषे हैं।

्कीबोिटि हॉट्की दखेना

कई मषेन्य ूकमांड्स में एक कीबोड्भ  हॉटकी होती ह ैजो मषेन्य ूकी बाई ंओि होती ह,ै जसैा वक वरत्र 1-2 में वदखा्या 

र्या ह।ै कीबोड्भ  पि इन हॉटकी को दबानषे सषे कमांड सवक्र्य होती ह।ै हॉटकी वकसी कमांड को सवक्र्य किनषे का 
तित्र 6.1.1: तित्र 1-1

एक तवरित तथा आसान तिीका दषेता ह ैऔि उनकषे  बािषे  में सीख लषेनषे सषे आप अविक सक्म बन जाएँरषे। आप Hotkey Editor का इसतषेमाल कि हॉटकी 

कसटमाइज़ कि सकतषे हैं, वजसषे आप Window, Settings / Preferences, Hotkeys मषेन्य ूकमांड में ओपन कि सकतषे हैं।

तित्र 6.1.2: तित्र 1-2

Option Dialog Boxes ्को एकसेस ्करना

कई मषेन्य ूमें एक ्ोटा बॉक्स आइकन री होता ह ैजो वरत्र 1-2 में वदखाए अनुसाि मषेन्य ूकी बाई ंओि होता ह।ै ्यषे बॉक्स आइकंस र्यवनत कमांड कषे  वलए 

एक Options dialog box ओपन किें रषे। ्यषे Options dialog boxes, जसैषे वक वरत्र 1-3 में वदखा्या र्या Group Options dialog box, में ऐसषे पिैामीटस्भ होतषे हैं 

वजनहें आप बदल सकतषे हैं। इनमें Apply बटन री मौजदू होतषे हैं जो डा्यलॉर बॉक्स बंद वकए वबना आपको वदए हुए पिैामीटिों कषे  साथ कमांड लार ूकिनषे 

में मदद कितषे हैं। ऑपशन डा्यलॉर बॉक्स कषे  मान अनवित होतषे हैं। वजस री मान को बदला जाता ह,ै उस कमांड कषे  अरली बाि इसतषेमाल होनषे पि उनकी 

सषेवटंर को बनाए िखषेरा। आप डा्यलॉर बॉक्स मषेन्य ूमें एवडट, िीसषेट सषेवटंगस मषेन्य ूकमांड का इसतषेमाल कि वकसी ऑपशन डा्यलॉर बॉक्स को उसकषे  

वडफॉलट मानों पि िीसषेट कि सकतषे हैं।

तित्र 6.1.3: तित्र 1-3
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रटयर-ऑि मेनयू ्का इस्तमेाि ्करना 

अविकति मषेन्य ूकषे  सबसषे ऊपि एक डबल लाइन वसथत होती ह,ै वजसषे वट्यि-ऑफ मषेन्य ूकहा जाता ह।ै इस लाइन 

पि वक्लक किनषे सषे मषेन्य ूएक वट्यि-ऑफ मषेन्य ूबन जाता ह ैऔि ्यह वरत्र 1-4 में वदखाए अनुसाि एक अलर 

पनैल पि वदखाई पडता ह,ै वजसषे आप उसकषे  टाइटल बाि पि ड्ैर कि वखसका सकतषे हैं। वट्यि-ऑफ मषेन्य ू

सुवविाजनक होतषे हैं, क््योंवक वषे मषेन्य ूकमांड को एक वक्लक में एक्सषेस ्योग्य बनातषे हैं, पि आपको वकसी औि 

रीज़ को कवि वकए वबना वट्यि-ऑफ मषेन्य ूको खुला ्ोडनषे कषे  वलए सपषेस की ज़रूित होरी।

ध्यान दें: वट्यि-ऑफ मषेन्य ूको ्ोटा किनषे कषे  वलए, वट्यि-ऑफ मषेन्य ूपि कीबोड्भ  हॉटकी प्रदवश्भत नहीं होती।

तित्र 6.1.4: तित्र 1-4
टूलस बनाम एकशन ्को समझना

्यवद आप मषेन्य ूपि ध्यान दषेतषे हैं, तो आप कई ऐसषे कमांड्स दषेखेंरषे जो वड्भ  टूल में समाप्त हो जातषे हैं। टूलस जब रुनषे जातषे हैं, तो तब तक एवक्टव िहतषे हैं, जब 

तक दूसिा टूल न रुना जा्यषे, लषेवकन ऐक्शंस कषे वल एक ही बाि सवक्र्य होतषे हैं। पहलषे प्र्योर वक्यषे र्यषे टूल आसान पुनर्भ्यन कषे  वलए टूलबॉक्स कषे  सबसषे 

नीर वदखाए जातषे हैं। वकसी टूल बटन पि डबल-वक्लक किनषे सषे, वरत्र 1-5 में Move टूल कषे  वलए वदखाए अनुसाि, इंटिफषे स की दाई ंओि टूल सषेवटंर इंटिफषे स 

ओपन हो जाता ह।ै आप Status Line की दाई ंओि वसथवत शो/हाइड Tool Settings बटन का इसतषेमाल कि री टूल सषेवटंर ओपन कि सकतषे हैं। टूल सषेवटंर 

री अनवित बनषे िहतषे हैं औि टूल सषेवटंर इंटिफषे स कषे  शीष्भ  पि Reset Tool बटन का इसतषेमाल कि उनहें िीसषेट वक्या जा सकता ह।ै

तित्र 6.1.5: तित्र 1-5
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ट्युटोररयि 1: पॉवलरन सफषे ्यि बनानषे कषे  वलए वकसी मषेन्य ूकमांड का इसतषेमाल किें ।

1. चरण 1: वक्रएट मषेन्य ूपि वक्लक किें  औि वफि Polygon Primitives सब-मषेन्य ूका र्यन किें  औि सफषे ्यि मषेन्य ूकी दाई ंओि वसथत ऑपशंस आइकन 

पि वरत्र 1-3 में वदखाए अनुसाि वक्लक कि ऑपशन डा्यलॉर बॉक्स खोलें।  

2. चरण 2: Polygon Sphere Options डा्यलॉर बॉक्स में Apply बटन पि वक्लक किें ।  Workspace कषे  मूल में एकल सफषे ्यि ऑबजषेक्ट प्रकट होरा। 

3. चरण 3: डा्यलॉर बॉक्स सषे बाहि वनकलनषे कषे  वलए Close बटन पि वक्लक किें ।   

4. चरण 4: वक्रएट मषेन्य ूपि वक्लक किें  औि तब Polygon Primitives सब-मषेन्य ूका र्यन किें  औि Cone मषेन्य ूकमांड पि वक्लक किें । Cone ऑबजषेक्ट, 

सफषे ्यि को ओवलपै कि िहषे सीन सषे जुड जाता ह।ै

5. चरण 5: ऑबजषेक्ट्स को शषेडषेड ऑबजषेक्ट्स कषे  रूप में दषेखनषे कषे  वलए की 5 दबाएँ। ऑबजषेक्ट्स वरत्र 1-6 में वदखाए अनुसाि एक सिल वक्रसटल बॉल 

कषे  सदृश होतषे हैं।  

6. चरण 6: फाइल रुनें, सषेव सीन ऐज़ रुनें औि फाइल को Crystal ball.mb कषे  रूप में सषेव किें ।

तित्र 6.1.6: तित्र 1-6

6.1.2.2 Status Line बटन ्का इस्तमेाि ्करें

मषेन्य ूकषे  सीिा नीरषे बटनों की एक लंबी कताि होती ह ैवजसषे साथ वमलाकि Status Line कषे  नाम सषे जाना जाता ह।ै ्यषे बटन वन्यत होतषे हैं औि उनहें बदला 

नहीं जा सकता ह,ै पि आप उनहें ्ुपा सकतषे हैं। बटनों को ऐसषे समूहों में बांटा जाता ह,ै वजनहें एक ववराजक बाि सषे पथृक वक्या जाता ह।ै वरत्र 1-7 में वदखाए 

अनुसाि इन बटन समूहों में शावमल होतषे हैं- बाएं सषे दाएं Menu Set वलसट, File बटनस, Selection Mode मषेन्य,ू Selection Mode बटनस, Selection Mask 

बटनस, Snapping बटनस, History बटनस, Rendering बटनस, Transform वफलड्स, तथा Show/Hide Editors बटनस। इनमें सषे ज्यादाति बटन समूहों की 

ररा्भ  उन पाठों में की जाती ह,ै जो उनकषे  फीरस्भ की जानकािी दषेतषे हैं।
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तित्र 6.1.7: तित्र 1-7

पॉप-अप हेलप ्का इस्तमेाि ्करना

जब आप पहली बाि Status Line बटन का इसतषेमाल किना शुरु कितषे हैं, ्यह जानना जिा कवठन होता 

ह ैवक कौन सा बटन वकस तिह का का्य्भ  किता ह,ै पि आप बटन कषे  शीष्भक को एक पॉप-अप हषेलप कषे  

रूप में दषेख सकतषे हैं, वजसकषे  वलए आपको बटन कषे  ऊपि माउस कस्भि लषे जाना होरा, इसषे वरत्र 1-8 में 

प्रदवश्भत वक्या र्या ह।ै पॉप-अप हषेलप संपणू्भ  इंटिफषे स में सरी बटनों कषे  वलए उपलबि होता ह।ै तित्र 6.1.8: तित्र 1-8

ध्यान दें: ्यवद पॉप-अप हषेलप सही तिह सषे राल ून हो, तो आप उसषे वनवष्क्र्य कि सकतषे हैं, ्या इसकषे  वडसपलषे टाइम को Window, Settings/Preferences, 

Preferences मषेन्य ूकमांड कषे  साथ खुली वप्रफषे िें स डा्यलॉर बॉक्स में मौजदू हषेलप पनैल की मदद सषे सषेट कि सकतषे हैं।

्कसटिर किू ्की खोज ्करना

एक अन्य कािरि ववजु़अल क्ल ूह ै्यह जब वकसी उपलबि िाइट-वक्लक पॉप-अप मषेन्य ूवालषे interface 

बटन कषे  ऊपि होता ह ैतो कस्भि बदलता ह।ै ्यह न्या कस्भि, कस्भि ऐिो कषे  नीरषे एक ्ोटा मषेन्य ूआ्यकन 

री वदखाता ह,ै वजसषे वरत्र 1-9 में वदखा्या र्या ह।ै जब ्यह आइकन प्रकट होता ह,ै तो आप ववकलपों कषे  

अवतरिक्त मषेन्य ूको एक्सषेस किनषे कषे  वलए िाइट-वक्लक कि सकतषे हैं। कु् वनवश्चत टूलस कषे  इसतषेमाल पि 

री कस्भि बदलता ह।ै

तित्र 6.1.9: तित्र 1-9
एकसपेंरिंग और ्कॉिरै्पसंग आइ्कन बटन रिुप

Status Line में हिषे क बटन गुप को एक उदग िषे खा सषे ववरावजत वक्या जाता ह,ै वजसकषे  मध्य में एक ्ोटा आ्यत वसथत होता ह।ै इस ववराजक को शो/हाइड 

बाि कहतषे हैं औि ्यवद आप उसकषे  ऊपि वक्लक किें , तो उस सषेक्शन में शावमल सरी बटन व्प जाएँरषे। बटनों को वफि सषे प्रकट किनषे कषे  वलए पुनः वक्लक 

किें । वरत्र 1-10 कई कॉलषेपसषेड औि expanded बटन सषेट दशा्भता ह।ै

तित्र 6.1.10: तित्र 1-10

र्कसी सीन ्को ओपन और सेि ्करना

मषेन्य ूसषेट र्यन सरूी की दाई ंओि बटनों का एक सषेट होता ह,ै वजसषे आप कोई न्या सीन वक्रएट किनषे, वकसी मौजदूा सीन को ओपन किनषे ्या उसषे सषेव 

किनषे में इसतषेमाल कि सकतषे हैं। ओपन तथा सषेव बटन दोनों ही एक फाइल डा्यलॉर बॉक्स ओपन किें रषे, जसैा वक वरत्र 1-11 में वदखा्या र्या ह,ै वजसमें 

आप डा्यिषे क्टिी तथा फाइल नषेम रुन सकतषे हैं। सषेव हो जानषे पि फाइल नषेम टाइटल बाि पि प्रकट होरा।
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तित्र 6.1.11: तित्र 1-11

एरिटसटि ओपन ्करना

Status Line की दाई ंओि राि Sidebar बटन होतषे हैं, वरत्र 1-12 में प्रदवश्भत अनुसाि, जो वकसी बटन गुप 

सषे जुडषे  नहीं होतषे औि वषे हमषेशा वदखाई पडतषे हैं। इन Sidebar बटनों का इसतषेमाल उस साइडबाि पनैल को 

वदखानषे औि ्ुपानषे में वक्या जाता ह,ै जो Attribute Editor, Tool Settings, तथा Channel Box/Layer 

Editor समषेत व्य ूपनैल की दाई ंओि वदखाई दषेतषे हैं। Attribute Editor में वकसी र्यवनत वसतु कषे  वलए सरी 

ऐवट्ब्ुयट्स की सरूी होती Tool Settings में र्यवनत टूल कषे  वलए कॉवनफरि वकए जानषे ्योग्य सरी 

सषेवटंगस की सरूी होती ह,ै Channel Box ऐवट्ब्यट्ूस का एक सबसषेट होता ह ै वजसषे एवनमषेट वक्या जा तित्र 6.1.12: तित्र 1-12

सकता ह,ै इसषे कीएबल माना जाता ह ैऔि Layer Editor आपको सीन ऑबज़षेक्ट को लषे्यस्भ में ववरावजत किनषे की अनुमवत दषेता ह।ै

ध्यान दें: Preferences डा्यलॉर बॉक्स कषे  इंटिफषे स पनैल में आप हिषे क एवडटि को मुख्य ववंडो कषे  बजाए एक पथृक ववंडो कषे  रूप में खुलनषे का ववकलप र्यन 

कि सकतषे हैं।

इंटरिेस एिीमेंट्स ्को रदखाना और छुपाना

इंटिफषे स एलीमेंट कषे  टॉप (्या बाई ंओि) डॉटषेड डबल लाइन पि डबल-वक्लक किनषे सषे वरत्र 1-13 में लाइन कषे  वलए वदखाए अनुसाि, आप इंटिफषे स एलीमेंट 

को ्ुपा री सकतषे हैं। शो/हाइड बाि पि िाइट-वक्लक किनषे औि उसकषे  ऊपि mouse बटन को होलड डाउन किनषे सषे, सरी इंटिफषे स एलीमेंट्स का एक पॉप-

अप मषेन्य ूप्रसतुत होता ह।ै आप Display, UI Elements मषेन्य ूका इसतषेमाल कि इंटिफषे स एलीमेंट को वफि सषे प्रकट कि सकतषे हैं। सरी UI एलीमेंट्स को एक 

साथ ्ुपानषे कषे  वलए आप Display, UI Elements, Hide UI Elements मषेन्य ूकमांड का इसतषेमाल कि सकतषे हैं।

तित्र 6.1.13: तित्र 1-13
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ट्युटोररयि 1: फाइल ओपन किना

1. चरण 1: पॉप-अप हषेलप जबतक Open a scene का संदषेश न दषे, तबतक बाई ंओि Status Line बटन पि माउस वफिाएँ।

2. चरण 2: इस बटन पि वक्लक किें । वरत्र 1-11 में वदखाए अनुसाि एक फाइल डा्यलॉर बॉक्स प्रकट होता ह।ै

3. चरण 3: उस डा्यिषे क्टिी को खोजें जहां Skateboard.mb फाइल वसथत हो।

4. चरण 4: Skateboard.mb फाइल नषेम पि वक्लक किें  औि वफि Open बटन पि वक्लक किें ।  सषेव की हुई फाइल वफि, वरत्र 1-14 में वदखाए अनुसाि 

Maya में लोड हो जाती ह।ै

ध्यान दें: Maya कोई फाइल ओपन किषे  उससषे पहलषे ्यह आपको मौजदूा फाइल सषेव किनषे का मौका दषेता ह।ै

तित्र 6.1.14: तित्र 1-14

ट्युटोररयि 2: फाइल सषेव किना

1. चरण 1: वक्रएट मषेन्य ूपि वक्लक किें  औि वफि Polygon Primitives सब-मषेन्य ूका र्यन किें  औि सफषे ्यि मषेन्य ूपि वक्लक कि सकषे टबोड्भ  सीन में एक 

सफषे ्यि जोडें।

2. चरण 2: पॉप-अप हषेलप जबतक Save the current scene का संदषेश न दषे, तबतक बाई ंओि Status Line बटन पि माउस वफिाएँ।

3. चरण 3: इस बटन पि वक्लक किें ।  फाइल सवतः ही मौजदूा फाइल को रिपलषेस किकषे  सषेव हो जाती ह।ै सषेव हो जानषे पि फाइल नषेम टाइटल बाि पि 

प्रकट होता ह।ै

ध्यान दें: आप File, Save As मषेन्य ूकमांड का इसतषेमाल कि वकसी नए फाइल नषेम कषे  साथ सीन सषेव कि सकतषे हैं।

ट्युटोररयि 3: वक्भ पलषेस इंटिफषे स को मवैक्समाइज किें

1. चरण 1: Status Line की बाई ंओि डॉटषेड डबल लाइन पि िाइट वक्लक किें  औि Status Line का र्यन किें ।   Status Line ्ुप जाती ह।ै 

2. चरण 2: Shelf, Channel Box तथा Toolbox कषे  वलए डैशड लाइंस पि डबल वक्लक किें  तथा अन्य इंटिफषे स पि अन्य ववकलप रुनें। 

3. चरण 3: इंटिफषे स कषे  नीरषे वसथत कंट्ोलस कषे  वलए डैश वाली डबल लाइनों पि िाइट वक्लक किें  औि प्रत्यषेक का र्यन किें । तब वरत्र 1-15 में वदखाए 

अनुसाि सरी इंटिफषे स एलीमेंट्स ्ुप जाएँरषे औि Workspace मवैक्समाइज़ हो जाएरा।

4. चरण 4: Display, UI Elements, Status Line मषेन्य ूकमांड रुनें। Status Line इंटिफषे स एलीमेंट वफि सषे प्रकट होता ह।ै

5. चरण 5: शषेष इंटिफषे स एलीमेंट्स को वफि सषे प्रकट किनषे कषे  वलए आप Display, UI Elements, Show UI Elements मषेन्य ूकमांड का इसतषेमाल किें ।
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तित्र 6.1.15: तित्र 1-15

6.1.2.3 Shelf एकसेस ्करें  

Shelf सटषेिॉ्यड्स पि एक टूलबाि की तिह होता ह।ै इसमें बटनों कषे  कई टबैड पनैल होतषे हैं। बटनों कषे  वववरनन सषेट रुननषे कषे  वलए, बस एक टबै पि वक्लक 

किें  औि इसकषे  सषेट में मौजदू बटन वदखाई पडेंरषे। वरत्र 1-16 पॉलीरोंस टबै कषे  वलए बटन दशा्भता ह।ै

तित्र 6.1.16: तित्र 1-16

Shelf मेनयू ्का इस्तमेाि ्करना

Shelf कषे  बाई ंओि दो मषेन्य ूआइकन होतषे हैं। सबसषे ऊपि का मषेन्य ूएक वमनी टबै की तिह वदखाई पडता ह ैऔि आप इसका इसतषेमाल वकसी मषेन्य ूसषे एक 

Shelf टबै रुननषे में कि सकतषे हैं। सबसषे नीरषे का मषेन्य ूआइकन एक ऐिो होता ह।ै आप इसका इसतषेमाल सरी Shelf टबैस को ्ुपानषे में, Shelf Editor ओपन 

किनषे में, shelves बनानषे औि वडलीट किनषे में, वकसी custom shelf लोड किनषे में तथा सरी shelves सषेव किनषे में कि सकतषे हैं। आप Shelf टबैस को 

्ुपाकि कु् इंटिफषे स सपषेस को सषेव कि सकतषे हैं। ऐसा किनषे कषे  वलए Shelf मषेन्य ूसषे Shelf Tabs मषेन्य ूकमांड का र्यन कि ववकलप को टॉरल ऑफ किें ।

Shelves बनाना और रििीट ्करना

Shelf मषेन्य ूका इसतषेमाल shelves बनानषे औि वडलीट किनषे में री वक्या जा सकता ह।ै New Shelf मषेन्य ूकमांड 

एक सिल डा्यलॉर बॉक्स ओपन किता ह,ै जसैा वक वरत्र 1-17 में वदखा्या र्या ह,ै वजसमें आप नए shelf का 

नाम दषे सकतषे हैं। वफि टबै कषे  दाएं वसिषे  पि न्या खाली shelf (एमपटी shelf) वदखाई दषेरा। Delete Shelf मषेन्य ू

कमांड रुननषे सषे वत्भमान में र्यवनत shelf वडलीट हो जाएरा।

तित्र 6.1.17: तित्र 1-17र्कसी Shelf में आइ्कन ्त्था मेनयू ्कमांि्स जोड़ना

बटन रुनकि औि उसषे माउस कषे  बीर वालषे बटन कषे  साथ पसंदीदा shelf कषे  टबै पि ड्ैर कितषे हुए आप वकसी एक shelf सषे दूसिषे  shelf में बटन जोड सकतषे 

हैं। Ctrl/Command तथा Shift की हषेलड डाउन कषे  साथ मषेन्य ूकमांड पि वक्लक कि मषेन्य ूकमांड मौजदूा shelf में जोडा जा सकता ह।ै आप टबै कषे  दाएँ वसिषे  

पि माउस कषे  बीर वालषे बटन कषे  साथ shelf आइकन को Delete Shelf आइकन (जो एक ्ोटषे ट्शै कैन की तिह वदखाई पडता ह)ै पि ड्ैर कि shelf आइकन 

वडलीट कि सकतषे हैं।

ध्यान दें: Maya माउस कषे  तीनों बटनों का इसतषेमाल किता ह।ै ्यवद आप दो बटनों औि एक सक्रोल वहील वालषे माउस का इसतषेमाल कि िहषे हैं, तो सक्रोल 

वहील वमड्ल माउस बटन कषे  रूप में काम किता ह।ै ्यवद दो बटनों वालषे माउस में सक्रोल वहील नहीं हो तो आप Ctrl/Command (कमांड) key औि लषेफट 
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माउस बटन का इसतषेमाल वमड्ल माउस बटन कषे  रूप में कि सकतषे हैं। Macintosh एक-बटन माउस कषे  वलए, कमांड-की औि माउस बटन, वमड्ल माउस 

बटन कषे  रूप में काम कितषे हैं औि ऑपशन-की तथा माउस बटन, दाएँ माउस बटन कषे  रूप में काम कितषे हैं।

र्कसी Shelf में िआेउट्स ्त्था रसक्र्पट्स जोड़ना

आप वकसी shelf में कसटम लषेआउट्स जोड सकतषे हैं। आप वजस कसटम लषेआउट को होलड किना राहतषे हैं उसकषे  वलए वलए shelf रुनें औि वफि Panel मषेन्य ू

सषे Panels, Panel Editor का र्यन किें । लषेआउट टबै में, वरत्र 1-18 में वदखाए अनुसाि, उस कसटम लषेआउट का र्यन किें  वजसषे आप मौजदूा shelf में जोडना 

राहतषे हैं औि Add To Shelf बटन पि वक्लक किें । आप माउस कषे  वमड्ल बटन की मदद सषे Script Editor सषे वसक्रपट ड्ैर कि सकतषे हैं औि उनहें वकसी shelf 

में डाल सकतषे हैं। Shelf पि वसक्रपट्स ‘MEL’ लषेबल वालषे बटन कषे  रूप में प्रकट होता ह,ै जो Maya Expression Language का संवक्प्त रूप ह,ै ्यह Maya की 

वसक्रवपटंर राषा होती ह।ै

तित्र 6.1.18: तित्र 1-18

Shelf Editor ्का इस्तमेाि ्करना

Shelves मषेन्य ूमें एक ववकलप मौजदू होता ह,ै जो Shelf Editor डा्यलॉर बॉक्स खोलषेरा। इस एवडटि का इसतषेमाल कि, वरत्र 1-19 में वदखाए अनुसाि आप 

टबैस तथा shelves कषे  क्रम को पुनव्य्भववसथत कि सकतषे हैं औि उनहें नाम दषे सकतषे हैं, हिषे क shelf कषे  रीति आइकन एवडट किें  औि shelves कषे  वलए 

सषेवटंगस बदलें।

तित्र 6.1.19: तित्र 1-19
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ट्युटोररयि 1: New Shelf बनाएँ

1. चरण 1: Shelf मषेन्य ूपि वक्लक किें  औि New Shelf का र्यन किें ।   Create New Shelf डा्यलॉर बॉक्स प्रकट होता ह।ै

2. चरण 2: नए shelf कषे  वलए MyShelf नाम टाइप किें  औि OK पि वक्लक किें । Shelf कषे  दाएं वसिषे  पि, टाइप वकए नाम कषे  साथ एक न्या टबै वदखाई 

दषेता ह।ै

ट्युटोररयि 2: New Shelf को पोपुलषेट किें

1. चरण 1: MyShelf को सवक्र्य किनषे कषे  वलए इस टबै का र्यन किें ।

2. चरण 2: वशफट तथा Ctrl/कमांड-की होलड डाउन किें , Create, NURBS Primitives, Sphere का र्यन किें । नए shelf में एक सफषे ्यि आइकन जुड 

जाता ह।ै

3. चरण 3: Create मषेन्य ूमें अन्य वप्रवमवटव ऑबजषेक्ट्स कषे  साथ रिण 2 को दुहिाएँ।   वरत्र 1-20 में वदखाए अनुसाि, न्यषे shelf पि प्रत्यषेक र्यवनत मषेन्य ू

कमांड वदखाई दषेती ह।ै

4. चरण 4: Panel, Panel Editor panel मषेन्य ूकमांड रुनें। Panel Editor डा्यलॉर बॉक्स प्रकट होता ह।ै

5. चरण 5: लषेआउट टबै रुनें औि वफि Four View ववकलप का र्यन किें । वफि Add to Shelf बटन पि वक्लक किें  औि वफि Close बटन पि वक्लक किें ।   

जब Four View ववकलप का र्यन वक्या जाता ह,ै तब व्य ूववंडो बदल जाती ह ैऔि राि पथृक व्य ूप्रदवश्भत किना आिंर किती ह।ै Add to Shelf बटन 

पि वक्लक किनषे कषे  बाद, मौजदूा shelf पि एक न्या आइकन प्रकट होता ह।ै

6. चरण 6: टूलबॉक्स में Move टूल खोजें औि वमड्ल माउस बटन की मदद सषे आइकन को नए shelf पि ड्ैर किें ।   वमड्ल माउस बटन की मदद सषे 

आइकन को ड्ैर किनषे सषे वह आइकन मौज ूshelf में जुड जाता ह।ै वरत्र 1-20 न्या shelf प्रदवश्भत किता ह।ै

7. चरण 7: Shelf मषेन्य ूसषे Save All Shelves का र्यन किें ।  

तित्र 6.1.20: तित्र 1-20

6.1.2.4 Channel Box ्त्था Layer Editor खोजें

जब वकसी ऑबजषेक्ट का र्यन वक्या जाता ह,ै इसकषे  कीएबल ऐवट्ब्यट्ूस (्या रनैलस) वरत्र 1-21 में वदखाए 

अनुसाि, इंटिफषे स की दाई ंओि Channel Box में वदखाई पडतषे ता ह।ै हिषे क ऐवट्ब्यटू कषे  साथ एक मान जुडा होता 

ह।ै ्यषे मान प्रा्यः संख्याएँ होतषे हैं, पि वषे ऑन ्या ऑफ, ्या एक कलि जसैषे सटषेट हो सकतषे हैं। आप रनैल कषे  मान 

को र्यन कि, एक वरनन मान डाल कि औि एंटि की दबाकि इन मानों को बदल सकतषे हैं।

ध्यान दें: Layer Editor कषे  नीरषे double-arrow बटन दबाकि Channel Box तथा Layer Editor को ववसततृ तथा 

संकुवरत कि सकतषे हैं।

तित्र 6.1.21: तित्र 1-21
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ऐरट्बयूट्स ्का चयन ्करें  

आप टाइटल पि वक्लक कि एक वसंरल ऐवट्ब्यटू रुन सकतषे हैं। र्यवनत होनषे पि ऐवट्ब्यटू टाइटल िषे खांवकत हो जाता ह।ै Ctrl/Command key को होलड 

डाउन कि औि कई ऐवट्ब्यट्ूस पि वक्लक किनषे सषे आपको एक ही बाि में एकाविक ऐवट्ब्यट्ूस रुननषे की अनुमवत वमलती ह;ै आप कई सािषे  ऐवट्ब्यट्ूस को 

रुननषे कषे  वलए उनकषे  ऊपि माउस ड्ैर कि सकतषे हैं। 

Channel Sliders ्का इस्तमेाि ्करना

आप Channel Box में ऐवट्ब्यटू का र्यन कि ऐवट्ब्यटू मानों को िोरक तिीकषे  सषे बदल सकतषे हैं औि तब उनहें व्य ूपनैल में वमड्ल माउस बटन की मदद सषे 

ड्ैर कि सकतषे हैं। वरत्र 1-22 में वदखाए अनुसाि, Channel Box कषे  ऊपि वसथत बटन का इसतषेमाल कि, आप रनैल सलाइडि सषेवटंगस को Slow, Medium, 

्या Fast पि सषेट कि सकतषे हैं। सषेवटंर वजतनी अविक होरी , ड्ैर किनषे पि ऐवट्ब्यटू उतनी की तषेज़ी सषे बदलषेरा। आप कोई लीवन्यि ्या हाइपिबोवलक 

सलाइडि सषेवटंर का री र्यन कि सकतषे हैं। लीवन्यि सषेवटंर ऐवट्ब्यटू मानों को माउस कषे  साथ ड्ैर किनषे पि िैवखक रूप सषे बदलता ह,ै पि हाइपिबोवलक 

सषेवटंर, माउस द्ािा ड्ैर वकए जानषे पि मान को अविक तषेज़ी सषे बदलता ह।ै

ध्यान दें: आप += औि एक संख्या एंटि कि उसषे मौजदूा मान की उस मात्रा में जोड सकतषे हैं। उदाहिण कषे  वलए वकसी ऐवट्ब्यटू फीलड में 5.0 कषे  िषे वड्यस 

मान कषे  वलए +=2 टाइप किनषे सषे ्यह बदलकि 7.0 हो जाता ह।ै आप सापषेवक्क मानों को घटानषे, रुणा किनषे तथा ववराजन किनषे कषे  वलए -=, *= तथा /= 

का री इसतषेमाल कि सकतषे हैं।

तित्र 6.1.22: तित्र 1-22

ऐरट्बयूट्स िॉ्क ्करना

लॉक वकए हुए ऐवट्ब्यट्ूस को बदला नहीं जा सकता ह।ै आप वकसी ऐवट्ब्यटू को र्यन कि औि रनैल मषेन्य ूसषे Lock Selected मषेन्य ूकमांड रुनकि उस 

ऐवट्ब्यटू को लॉक कि सकतषे हैं। वरत्र 1-23 में वदखाए अनुसाि, लॉक हुए ऐवट्ब्यटू “grayed out,” कषे  रूप में वदखाई पडेंरषे । Channels, Unlock Selected 

मषेन्य ूकमांड की मदद सषे वकसी री लॉक वकए ऐवट्ब्यटू को अनलॉक कि सकतषे हैं।

तित्र 6.1.23: तित्र 1-23
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ियेसटि जोड़ना और रििीट ्करना

वरत्र 1-24 में वदखाए अनुसाि, Layer Editor, सीन एलीमेंट्स को कई लषे्यिों में बांटता ह,ै वजससषे उनहें वदखाना औि ्ुपाना आसान बन जाता ह।ै Layer 

Editor में Create a New Layer बटन पि वक्लक किनषे सषे एक नई लषे्यि बनती ह।ै आप हिषे क लषे्यि को कोई नाम, वडसपलषे टाइप तथा कलि दषे सकतषे हैं। 

Layers मषेन्य ूकी मदद सषे लषे्यस्भ वडलीट किें । वकसी लषे्यि को वडलीट किनषे सषे उसकषे  ऑबज़षेक्ट्स वडलीट नहीं होतषे। Layer Editor कषे  सबसषे ऊपि Display 

तथा Render layers बनानषे कषे  ववकलप मौजदू होतषे हैं। Render layers की ररा्भ  आरषे की जाएरी।

तित्र 6.1.24: तित्र 1-24

र्कसी ियेर में ऑबज़ेकट्स जोड़ना

आप वकसी लषे्यि पि िाइट वक्लक कि तथा पॉप-अप मषेन्य ूसषे Add Selected Objects रुनकि र्यवनत ऑबज़षेक्ट्स को जोड सकतषे हैं। आप वकसी लषे्यि में 

सरी ऑबज़षेक्ट्स को रुननषे कषे  वलए औि वकसी लषे्यि सषे ऑबज़षेक्ट्स हटानषे कषे  वलए री Layers मषेन्य ूका इसतषेमाल कि सकतषे हैं। अर्यवनत वकए जानषे पि 

ऑबज़षेक्ट्स लषे्यि कलि गहण कि सकतषे हैं।

सभी ियेर ऑबज़ेकट्स ्को छुपाना

Layer Editor में पहलषे कॉलम पि वक्लक कि लषे्यि ऑबजषेक्ट्स को ्ुपा सकतषे हैं। ्यह कॉलम लषे्यि ऑबज़षेक्ट्स कषे  वलए वववजवबवलटी सषेट किता ह ैऔि 

एक सिल button बटन ह ै वजसषे आप टन्भ ऑन ्या ऑफ कि सकतषे हैं। जब लषे्यि ऑबज़षेक्ट्स वदखाई पडता ह ैतो V अक्ि वदखाई पडता ह ैऔि लषे्यि 

ऑबज़षेक्ट्स ्ुपषे होनषे पि कॉलम खाली होता ह।ै

सभी ियेर ऑबज़ेकट्स ्को फ्ीज़ ्करना

 दूसिषे  कॉलम को Normal, Template ्या Reference पि सषेट वक्या जा सकता ह।ै लषे्यि जब एक टषेमपलषेट होता ह ैतो इस कॉलम में T अक्ि प्रकट होता ह।ै 

टषेमपलषेट्स लषे्यस्भ को तब रुना ्या वखसका्या नहीं जा सकता ह,ै जब वषे टषेमपलषेट्स कषे  रूप में होतषे हैं। References प्रॉक्सी ऑबज़षेक्ट्स होतषे हैं, जो जवटल 

ऑबज़षेक्ट्स कषे  वलए होतषे हैं। तीसिा कॉलम लषे्यि कलि होता ह।ै इस कॉलम (्या लषे्यि कषे  नाम) पि डबल वक्लक किनषे सषे Edit Layer डा्यलॉर बॉक्स 

खुलता ह,ै जसैा वक वरत्र 1-25 में वदखा्या र्या ह,ै जहाँ आप एक न्या कलि रुन सकतषे हैं, लषे्यि कषे  ऐवट्ब्यट्ूस ्या लषे्यि का नाम बदल सकतषे हैं।

तित्र 6.1.25: तित्र 1-25
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ट्युटोररयि 1: Channel Box ऐवट्ब्यट्ूस बदलें

1. चरण 1: File, Open Scene रुनें। Rocket.mb फाइल को खोजकि उसषे ओपन किें । इस फाइल में वगड ऑरिवजन पि कें वरित एक सिल िॉकषे ट शावमल 

होता ह।ै िॉकषे ट ऑबज़षेक्ट कषे  वलए सरी ऐवट्ब्यटू Channel Box में वदखाई पडतषे हैं। 

2. चरण 2: Translate X attribute में 5 एंटि किें  औि Enter की दबाएँ। िॉकषे ट ऑबज़षेक्ट एक्स-एवक्सस पि पांर ्यवूनट्स वखसकता ह।ै

3. चरण 3: Channel Box में Translate Y एवट्ब्यटू पि वक्लक किें  औि वमड्ल माउस बटन की मदद सषे Workspace में ऊपि की ओि ड्ैर किें ।   िॉकषे ट 

ऑबज़षेक्ट Y-एवक्सस पि माउस द्ािा ड्ैर की रई दूिी तक बढता ह ैऔि ऐवट्ब्यटू का मान बदल जाता ह,ै इसषे वरत्र 1-26 में वदखा्या र्या ह।ै 

4. चरण 4: फाइल रुनें, Save Scene As रुनें औि फाइल को Translated rocket.mb कषे  रूप में सषेव किें ।

तित्र 6.1.26: तित्र 1-26

ट्युटोररयि 2: New Layer बनाएँ औि िीनषेम किें

1. चरण 1: Layer Editor में Create a New Layer बटन पि वक्लक किें । Layer Editor में एक न्या लषे्यि वदखाई पडता ह।ै

2. चरण 2: एवडट लषे्यि डा्यलॉर बॉक्स ओपन किनषे कषे  वलए लषे्यि पि डबल वक्लक किें ।

3. चरण 3: नए लषे्यि में कोई नाम टाइप किें  औि Save बटन पि वक्लक किें ।  

ट्युटोररयि 3: New Layer में ऑबज़षेक्ट्स जोडना

1. चरण 1: सफषे ्यि ऑबज़षेक्ट बनानषे कषे  वलए Create, Polygon Primitives, Sphere वसलषेक्ट किें

2. चरण 2: सरी ऑबज़षेक्ट्स को रुननषे कषे  वलए Edit, Select All मषेन्य ूकमांड रुनें।

3. चरण 3: Layer Editor में नए लषे्यि पि िाइट वक्लक किें  औि पॉप-अप मषेन्य ूसषे Add Selected Objects रुनें। सरी ऑबज़षेक्ट्स नए लषे्यि में जुड  
जातषे हैं।

4. चरण 4: Layer Editor में पहलषे कॉलम पि वक्लक किें , वजसमें V वदखाई पडता ह।ै   लषे्यि पि सरी ऑबज़षेक्ट्स व्पषे होतषे हैं।
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6.1.2.5 Animation controls, Command Line ्त्था Help Line

इंटिफषे स कषे  सबसषे नीरषे कई सािषे  इंटिफषे स कंट्ोलस होतषे हैं, वजनका इसतषेमाल वववरनन एवनमषेशन फ्षे मस सषे होकि मूव किनषे में वक्या जाता ह ैइसकषे  नीरषे 

एक कमांड लाइन होती ह,ै जहाँ आप लार ूवकए जानषे वालषे कमांड्स टाइप कि सकतषे हैं। इंटिफषे स सषे नीरषे एक Help Line होती ह,ै जहाँ संदर्भ-वववशष्ट 

सरूना प्रदवश्भत होती ह।ै

एरनमेशन फे्म ्का चयन ्करना

वरत्र 1-27 में दशा्भए अनुसाि, इंटिफषे स कषे  सबसषे नीरषे टाइम सलाइडि पि सरी मौजदूा एवनमषेशन फ्षे मस वदखाई पडतषे हैं। बलकै टाइम माक्भ ि ड्ैर कि ्या टाइम 

सलाइडि की दाई ंओि कषे  फीलड में फ्षे म नमबि एंटि कि आप वववरनन फ्षे मस कषे  बीर मूव कितषे हैं।

तित्र 6.1.27: तित्र 1-27

एरनमेशन रें ज सेट ्करना

वरत्र 1-28 में वदखाए अनुसाि टाइम सलाइडि कषे  नीरषे िें ज सलाइडि होता ह।ै इस सलाइडि का इसतषेमाल किनषे सषे आप एवनमषेशन फ्षे मस कषे  ववशषेष िें ज पि 

ध्यान कें वरित कि सकतषे हैं। िें ज सलाइडि कषे  वखसकनषे सषे टाइम सलाइडि बदलता ह।ै

तित्र 6.1.28: तित्र 1-28

एरनमेशन चिाना

वरत्र 1-29 में दशा्भए अनुसाि, एवनमषेशन फ्षे म वलै्य ूकी दाई ंओि पलषेइंर, रिवाइंवडंर तथा एवनमषेशन फ्षे मस में मूव किनषे कषे  वलए कई कंट्ोलस होतषे हैं। इन 

बटनों का इसतषेमाल किनषे सषे आप एवनमषेशन आिंर (्या समापन), एक फ्षे म पी ष्े  लौटनषे (्या आरषे बढनषे), एक की (key) पी ष्े  लौटनषे (्या आरषे बढनषे) ्या 

एवनमषेशन को आरषे पलषे किनषे (्या पी ष्े  पलषे किनषे) में सक्म होंरषे।

तित्र 6.1.29: तित्र 1-29

Animation Preferences ्को एकसेस ्करना

Go to End button कषे  नीरषे एक बटन होता ह,ै वजसषे वरत्र 1-30 में वदखा्या र्या ह,ै जो Preferences dialog box ओपन किता ह,ै जसैा 

वक वरत्र 1-31 में वदखा्या र्या ह।ै इस डॉ्यलॉर बॉक्स में Maya की सरी प्रषेफ़िें सषेज़ शावमल होती हैं, पि इस बटन का इसतषेमाल कि 

जब इसषे खोला जाता ह,ै तो Timeline कैटरिी वसलषेक्ट हो जाती ह,ै वजससषे आप एवनमषेशन प्रषेफिें सषेज़ बदल सकतषे हैं।
तित्र 6.1.30: तित्र 1-30
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तित्र 6.1.31: तित्र 1-31

ट्युटोररयि 1: एवनमषेशन रलाएँ

1. चरण 1: फाइल रुनें, सीन ओपन किें  औि फाइल को Billiard balls.mb. कषे  रूप में ओपन किें । इस फाइल में एक सिल एवनमषेटषेड सीन शावमल  

होता ह।ै

तित्र 6.1.32: तित्र 1-32
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2. चरण 2: टाइम सलाइडि में टाइम माक्भ ि पि वक्लक किें  औि उसषे बाई ंओि ड्ैर किें । सीन में ऑबज़षेक्ट्स मूव कितषे हैं, क््योंवक फ्षे म बढ जातषे हैं। 

एवनमषेशन सीक्वेंस का एक फ्षे म वरत्र 1-32 में वदखा्या र्या ह।ै

3. चरण 3: Play Forwards बटन पि वक्लक किें । संपणू्भ  एवनमषेशन सीक्वेंस बाि-बाि पलषे होरा।

4. चरण 4: एवनमषेशन िोकनषे कषे  वलए Stop बटन पि वक्लक किें ।

6.1.2.6 Toolbox ्त्था Quick Layout बटन ्का इस्तमेाि ्करें

वरत्र 1-33 में दशा्भए अनुसाि, इंटिफषे स की बाई ंओि बटनों का एक कॉलम होता ह,ै वजसषे टूलबॉक्स 

कषे  रूप में जाना जाता ह।ै टूलबॉक्स कषे  नीरषे कई layout बटन होतषे हैं, वजनहें सामूवहक रूप में Quick 

Layout बटन कितषे हैं।

ऑबजेकट ्को रसिकेट ्करना

टूलबॉक्स में पहलषे दो बटनों का इसतषेमाल सीन में ऑबज़षेक्ट्स रुननषे में वक्या जाता ह।ै ्यषे Select 

Objects टूल औि Lasso टूल होतषे हैं। Select Object टूल आपको ऑबजषेक्ट्स पि वक्लक कि ्या एक 

आ्यताकाि बॉड्भि ड्ैर कि उनहें रुननषे की अनुमवत दषेता ह।ै Lasso टूल आपको अपनषे मनपसंद 

ऑबजषेक्ट पि वकसी फ्ीहैंड आउटलाइन ड्ैर किनषे की अनुमवत दषेता ह।ै

Select Objects टूल कषे  साथ ऑबजषेक्ट्स पि वक्लक किनषे कषे  दौिान वशफट-की होलड डाउन किनषे 

सषे ऑबज़षेक्ट्स सषेलषेक्शन सषेट पि जुड जाएरा। सरी र्यवनत ऑबजषेक्ट्स सफषे द वदखाई पडेंरषे, 

कषे वल अंवतम ऑबज़षेक्ट कषे  साथ ऐसा नहीं होता ह,ै जो हलकषे  हिषे  िंर में वदखाई पडता ह।ै ्यह हलका 

हिा ऑबजषेक्ट को की-ऑबजषेक्ट कषे  रूप में जाना जाता ह।ै

ट्ांसिॉमटि टूलस ्का इस्तमेाि ्करना

Toolbox Move, Rotate, तथा Scale टूलस री शावमल होतषे हैं। जब इनमें सषे वकसी टूलस को रुना 

जाता ह,ै मवैनपुलषेटि उस र्यवनत ऑबजषेक्ट कषे  कें रि (वपवट पवाइंट) में वदखाई पडषेरा। इन टूलों कषे  

साथ, आप र्यवनत ऑबजषेक्ट को रूपांतरित कि सकतषे हैं। वरत्र 1-34 में Move टूल कषे  वलए वदखाए 

अनुसाि, मवैनपुलषेटि आपको एकल अक् पि टूल को रूपांतरित किनषे की अनुमवत दषेता ह।ै आप 

मवैनपुलषेटि कषे  समीप प्रदवश्भत ट्ांसफॉम्भ  वलै्य ूपि री वक्लक कि सकतषे हैं औि कीबोड्भ  का इसतषेमाल 

कि नए मानों को री एंटि कि सकतषे हैं।

ध्यान दें: जब वकसी ट्ांसफॉम्भ  टूलस पि वकसी ट्ांसफॉम्भ  हैंडल का र्यन वक्या जाता ह,ै ्यह पीला 

हो जाता ह।ै आप middle mouse बटन का इसतषेमाल कि र्यवनत हैंडल को ड्ैर कि सकतषे हैं।

तित्र 6.1.33: तित्र 1-33

तित्र 6.1.34: तित्र 1-34मरैनपुिटेसटि ्को समझना

हिषे क ट्ांसफॉम्भ  मवैनपुलषेटस्भ में कलि-आिारित घटक होतषे हैं जो आपको एकल अक् पि वकसी ट्ांसफॉम्भ  को िोकनषे की अनुमवत दषेरा- लाल X-अक् कषे  वलए 

होता ह,ै हिा- Y-अक् कषे  वलए तथा नीला Z-अक् कषे  वलए होता ह,ै जसैषे वरत्र 1-35 में दशा्भ्या र्या ह।ै र्यवनत मवैनपुलषेटि अक् पीला वदखाई पडषेरा औि ड्ैवरंर 

सषे र्यवनत अक् पि वसतु रूपांतरित हो जाएरा।

तित्र 6.1.35: तित्र 1-35
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ट्ांसफ़ॉम्भि मवैनपुलषेटस्भ कषे  अलावा कई अन्य मवैनपुलषेटस्भ होतषे हैं। उदाहिण कषे  वलए, जब वकसी सपॉट लाइट ऑबजषेक्ट का र्यन वक्या जाता ह,ै आप वकसी 

मवैनपुलषेटि को सक्म बना सकतषे हैं, जो व्य ूमें ड्ैवरंर द्ािा अपनी लाइट प्रॉपटशीज़ को बदलनषे की अनुमवत दषेता ह,ै जसैषे वक इसका फॉलऑफ कोन, वदशा 

तथा तीव्रता। ऑबज़षेक्ट मवैनपुलषेटस्भ को टूलबॉक्स में Show Manipulator बटन पि वक्लक कि सवक्र्य बना्या जाता ह।ै

टूलबॉक्स में Show Manipulator Tool कषे  नीरषे एक अन्य बटन होता ह,ै जो इसतषेमाल वकए रए अंवतम टूल को िोकता ह।ै ्याद िखें वक कोई मषेन्य ूआइटम 

्या बटन वजसमें इसकषे  नाम का वड्भ  टूल शावमल होता ह,ै तबतक सवक्र्य बना िहता ह ैजबतक वक अन्य टूल का र्यन न कि वल्या जा्यषे औि ्यह टूलबॉक्स 

कषे  सबसषे नीरषे प्रकट होरा।

ध्यान दें:  टूलबॉक्स का अंवतम सलॉट मषेन्य ूसषे र्यवनत टूलस कषे  वलए आिवक्त िहता ह।ै टूलबॉक्स टूलस इस सलॉट को अविगवहत नहीं किषे रा।

िआेउट्स बदिना

तित्र 6.1.36: तित्र 1-36
िआेउट ्कसटमाइज ्करना

आप लषेआउट बदल सकतषे हैं वजसषे हिषे क बटन लषेआउट बटनों पि िाइट-वक्लक कि तथा पॉप-अप मषेन्य ूसषे लषेआउट रुनकि ओपन किता ह।ै ्यवद आप Quick 

Layout बटनों कषे  नीरषे Model View बटन पि िाइट वक्लक कितषे हैं, तो आप प्रदवश्भत पषेनों (panes) की संख्या का र्यन कि सकतषे हैं। ्यवद एकाविक पषेन 

का र्यन वक्या जाता ह,ै तो Model View बटन आपकषे  द्ािा र्यवनत पषेनों की संख्या में ववरावजत हो जाएरा। Model View बटन पि वक्लक किनषे सषे आप 

वक्लक वकए रए व्य ूमें प्रदवश्भत व्य ूको बदल सकतषे हैं।

वयू पनैलस ्की रीसाइरजं़ग ्त्था एरिरटंग

ट्युटोररयि 1: कोई ऑबजषेक्ट रुनें

1. चरण 1: Five spheres.mb फाइल ओपन किें  इस फाइल में पांर सफषे ्यि ऑबज़षेक्ट्स शावमल होतषे हैं।

2. चरण 2: सलषेक्ट पि वक्लक किें  औि वफि सेंटि सफषे ्यि पि वक्लक किें । इस सीन में सफषे ्यि हलकषे  हिषे  िंर का हो जाता ह ैऔि इसकषे  ऐवट्ब्यट्ूस रनैल 

बॉक्स में वदखाई पडतषे हैं।

3. चरण 3: वशफट की होलड डाउन किें  औि वफि सीन में अन्य सफषे ्यस्भ पि वक्लक किें ।  वरत्र 1-38 में वदखाए अनुसाि, सीन कषे  सरी सफषे ्यि सलषेक्ट 

वक्यषे र्यषे हैं औि वजस अंवतम सफषे ्यि पि वक्लक वक्या जाता ह ैवह हलकषे  हिषे  िंर का हो जाता ह।ै

जब एकाविक व्य ूपनैलस वदखाई पडतषे हैं, आप पनैलस कषे  बीर वडवाइडस्भ ड्ैर कि एकल पनैल को 

िीसाइज़ कि सकतषे हैं। एक सम्य में कषे वल एक व्य ूपनैल सवक्र्य हो सकता ह।ै

ध्यान दें: Spacebar का इसतषेमाल किनषे सषे ऐवक्टव व्य ूपनैल द्ािा संपणू्भ  Workspace को रिनषे औि 

वप्लषे लषेआउट पि वापस लौटनषे कषे  बीर टॉरल कि सकतषे हैं। उदाहिण कषे  वलए, ्यवद Four View 

लषेआउट का र्यन वक्या जाता ह ैऔि टॉप व्य ूपनैल सवक्र्य व्य ूपनैल होता ह,ै तो Spacebar दबानषे सषे 

टॉप व्य ूपनैल मवैक्समाइज़ हो जाता ह।ै

आप वकसी पनैल कषे  व्य ूको बदलनषे कषे  वलए पनैल मषेन्य ूपि पनैल मषेन्य ूकमांड का इसतषेमाल कि 

सकतषे हैं। हिषे क व्य ूपनैल कषे  शीष्भ  पि आपको पनैल मषेन्य ूवमलषेरी। वरत्र 1-37 में बताए अनुसाि पनैल 

डा्यलॉर बॉक्स खोलनषे कषे  वलए Panels, Saved Layouts, Edit Layouts मषेन्य ूकमांड। इस डा्यलॉर 
तित्र 6.1.37: तित्र 1-37

बॉक्स कषे  साथ आप न्या पनैल बना सकतषे हैं औि कसटम लषेआउट्स एवडट कि सकतषे हैं।

टूलबॉक्स कषे  नीरषे कई बटन होतषे हैं, वजसषे वरत्र 1-36 में वदखा्या र्या ह,ै जो Maya इंटिफषे स कषे  

लषेआउट को तषेज़ी सषे बदलनषे की अनुमवत दषेता ह।ै वडफॉलट लषेआउट ववकलपों में शावमल होता ह-ै 

Single Perspective View, Four View, Perspective/Outliner, Perspective/Graph Editor, 

Hypershade/Perspective, तथा Perspective/Hypergraph/Graph। इन लषेआउट बटनों कषे  नीरषे वसथत 

ऐिो बटन अवतरिक्त लषेआउट ववकलपों कषे  एक पॉप-अप मषेन्य ूको वनरूवपत किता ह।ै
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तित्र 6.1.38: तित्र 1-38

ट्युटोररयि 2: कोई ऑबज़षेक्ट रूपांतरित किें

1. चरण 1: Five spheres.mb फाइल ओपन किें ।

2. चरण 2: सलषेक्ट पि वक्लक किें  औि वफि सेंटि सफषे ्यि पि वक्लक किें ।

3. चरण 3: टूलबॉक्स में मूव टूल पि वक्लक किें  औि हिषे  (Y-अक्) को ऊपि की ओि ड्ैर किें । 

4. चरण 4: सीन में सफषे ्यि ऊपि की ओि बढता ह।ै 

तित्र 6.1.39: तित्र 1-39
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5. चरण 5: टूलबॉक्स में सकषे ल टूल पि वक्लक किें  औि लाल (X-अक्) को दाई ंओि ड्ैर किें ।

6. चरण 6: वरत्र 1-39 में वदखाए अनुसाि सफषे ्यि X-अक् पि लंबा हो जाता ह।ै

7. चरण 7: फाइल रुनें, सषेव सीन ऐज़ रुनें औि फाइल को Elongated sphere.mb कषे  रूप में सषेव किें ।

ट्युटोररयि 3: इंटिफषे स लषेआउट बदलें

1. चरण 1: आप Status Line की दाई ंओि वसथवत शो/हाइड Channel Box बटन पि वक्लक किें ।

2. चरण 2: वक्वक लषेआउट बटन में Four Views बटन पि वक्लक किें ।   वरत्र 1-40 में वदखाए अनुसाि लषेआउट राि व्यजू़ वदखानषे कषे  वलए परिववत्भत हो 

जाता ह।ै

तित्र 6.1.40: तित्र 1-40

6.1.2.7 Secret मेनयूज़ ्का प्ता िगाएं

जब आप मषेन्य ू कमांड कषे  प्रवत अभ्यसत हो जातषे हैं, तो आप व्पषे हुए मषेन्य ू का इसतषेमाल कि तषेज़ी सषे काम किना सीख सकतषे हैं। जब आप सीन में 

ऑबज़षेक्ट्स पि िाइट वक्लक कितषे हैं तो ्यषे मषेन्य ूमें वववरनन कमांड पॉप-अप होतषे हैं।

मार्किं ग मेनयू ्को एकसेस ्करना

कई आम/कॉमन कमांड को जल् दी सषे एक्सषेस किनषे कषे  वलए, आप व्य ूपनैल पि िाइट वक्लक कि 

औि मषेन्य ूवदखनषे तक माउस बटन को होलड डाउन कि, एक मावकयं र मषेन्य ूओपन कि सकतषे हैं। 

आप वफि वववरनन मषेन्य ूऑपशंस कषे  बीर कस्भि को मूव कि सकतषे हैं औि इवच्त मषेन्य ूकमांड 

रुननषे कषे  वलए माउस बटन ्ोड/रिलीज़ कि सकतषे हैं। वरत्र 1-41 पॉवलरोन सफषे ्यि ऑबज़षेक्ट कषे  

वलए मावकयं र मषेन्य ूदशा्भता ह।ै

ध्यान दें: व्य ूपनैल में वक्लक कितषे सम्य q की (key) पि होलड डाउन कि आप वसलषेक्शन ऑपशंस 

की मावकयं र मषेन्य ूएक्सषेस कि सकतषे हैं। आप इसी तिीकषे  सषे अन्य कसटम मावकयं र मषेन्य ूरी एक्सषेस 

कि सकतषे हैं, जसैषे वक Move Tool options (w), Rotate Tool options (e), Scale Tool options (r), 

Polygon Brush options (o), Select All menu (a), तथा Menu Sets (h).

तित्र 6.1.41: तित्र 1-41
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मार्किं ग मेनयू ्को ्कसटमाइज़ ्करना

आप मावकयं र मषेन्य ूकी रीज़ों को बदल सकतषे हैं, वकसी मावकयं र मषेन्य ूको एक हॉटकी असाइन कि सकतषे हैं ्या Marking Menu Settings डा्यलॉर बॉक्स 

का इसतषेमाल कि हॉटबॉक्स में मावकयं र मषेन्य ूजोड सकतषे हैं, इसषे वरत्र 1-42 में वदखा्या र्या ह।ै Window, Settings/Preferences, Marking Menus मषेन्य ू

कमांड का इसतषेमाल कि आप इस डा्यलॉर बॉक्स को एक्सषेस कि सकतषे हैं।

तित्र 6.1.42: तित्र 1-42

Hotbox ्का इस्तमेाि ्करना

Hotbox वरत्र 1-43 में वदखा्या र्या ह,ै जो 

कसटमाइज़ वकए जानषे ्योग्य मषेन्य ूका एक 

पणू्भ  सषेट होता ह,ै वजसषे आप सपषेसबाि को 

दबाकि औि होलड कि एक्सषेस कि सकतषे 

हैं। Hotbox में Hotbox Controls ववकलप का 

इसतषेमाल किकषे  आप Hotbox में प्रकट होनषे 

वालषे मषेन्य ूकमांड का र्यन कि सकतषे हैं।

तित्र 6.1.43: तित्र 1-43
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Hotbox ्को ्कसटमाइज़ या अनु्ूकरि्त ्करना

्यवद आप Hotbox सषे Hotbox Controls ववकलप का र्यन कितषे हैं, तो Hotbox में शावमल किनषे कषे  वलए मषेन्य ूसषेट का र्यन कि सकतषे हैं। आप “शो ्या 

हाइड ऑल मषेन्य”ू का री र्यन अि सकतषे हैं।

ट्युटोररयि 1: मावकयं र मषेन्य ूको एक्सषेस किना

1. चरण 1: सफषे ्यि ऑबज़षेक्ट बनानषे कषे  वलए Create, Polygon Primitives, Sphere वसलषेक्ट किें  

2. चरण 2: व्य ूपनैल को वडसलषेक्ट किनषे कषे  वलए सफषे ्यि सषे दूि व्य ूपनैल पि वक्लक किें ।

3. चरण 3: सफषे ्यि पि िाइट वक्लक किें  औि पॉप-अप मावकयं र मषेन्य ूसषे Select रुनें। सफषे ्यि ऑबज़षेक्ट सलषेक्ट हो जाता ह।ै

ट्युटोररयि 2: Hotbox का इसतषेमाल किें

1. चरण 1: कस्भि को व्य ूपनैल कषे  कें रि में लषे जाएँ औि सपषेसबाि दबाकि होलड किें । वरत्र 1-44 में वदखाए अनुसाि Hotbox उस जरह मध्य में वदखाई 

पडता ह,ै जहाँ कस्भि वसथत होता ह।ै

2. चरण 2: कस्भि को वक्रएट बटन पि ड्ैर किें  औि Polygon Primitives, Sphere कमांड का र्यन किें । सफषे ्यि ऑबज़षेक्ट व्य ूपनैल में वदखाई पडता ह।ै

3. सपषेस बाि ्ोडें।

तित्र 6.1.44: तित्र 1-44

6.1.3 NURBS स्तह पर ्काम ्करना

NURBS, नॉन-्यवूनफॉम्भ  िषे शनल B-सपलाइन का संवक्प्त रूप ह।ै ्यषे सपलाइन रवणती्य रूप सषे परिरावषत िषे खाएं होती हैं, वजनहें मवैनपुलषेट कि आप अनोखी 

आकृवत्याँ बना सकतषे हैं। NURBS सतह, NURBS कवकों सषे बना एक ठोस ऑबज़षेक्ट होता ह।ै NURBS सतह जवैवक वसतुओ ंकषे  मॉडवलंर कषे  वलए उप्योरी 

होती ह,ै जसैषे वक फूल तथा पषेड, जहां सतहें एक-दूसिषे  पि लुढकती हैं।

 NURBS सतहों को NURBS वक्रों की तिह ही उनकषे  कंट्ोल ववट्भसषेज (CVs) को मूव किकषे  एवडट वक्या जा सकता ह।ै ्यह दषेखनषे कषे  वलए वववरनन CVs 

कैसषे जुडषे  होतषे हैं, आप NURBS सतहों कषे  वलए हलस री वडसपलषे कि सकतषे हैं। िाइट-वक्लक मावकयं र मषेन्य ूका इसतषेमाल कि आप उन सरी घटकों को दषेखनषे 

का ववकलप रुन सकतषे हैं, जो NURBS सतह बनातषे हों। 

NURBS सतहों कषे  वलए अन्य आम घटक हैं आइसोपिैामवैट्क कवस्भ (संक्षेप में आइसोपामस्भ)। आइसोपामस्भ प्रवतवनवि िषे खाएँ होती हैं जो वसतु की सतह 

वदखाती ह।ै आइसोपाम्भ  की वदशा को U औि V कॉवड्भनषेट वससटम की मदद सषे परिरावषत वक्या जाता ह,ै जहां U-direction आइसोपाम्भ  क्वैतज (हॉरिज़ॉनटल) 

रूप सषे रमन किता ह ैऔि V-direction आइसोपाम्भ  लमबवत् (ववट्भकल) रूप सषे रमन किता ह।ै

Rough resolution (1-की दबानषे सषे इनषेबलड/सक्म) पि आइसोपामस्भ की संख्या काफी कम हो जाती ह,ै लषेवकन Fine resolution (3-की दबानषे सषे सक्म) पि 

कई अवतरिक्त आइसोपामस्भ वदखाई पडतषे हैं। नए आइसोपामस्भ का वनमा्भण वकसी मौजदूा आइसोपाम्भ  को नए आइसोपाम्भ  की लोकषे शन को वरवनित किनषे हषेतु 

ड्ैर किकषे  आसानी सषे वक्या जा सकता ह।ै वरवनित आइसोपामस्भ Surfaces, Insert Isoparms menu कमांड की मदद सषे सथाई बना्या जा सकता ह।ै

आइसोपामस्भ कषे  बीर का सथान परै कहलाता ह।ै हिषे क परै में दो साइड/वकनािषे  होतषे हैं। जो वकनािा िें डि वक्या जाता ह,ै उसषे व्पषे vector की वदशा सषे 

वनिा्भ रित वक्या जाता ह,ै वजसषे नॉम्भल कहा जाता ह।ै ्यह परै फषे स पि लमबवत् फैलता ह।ै
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NURBS सतहों का वनमा्भण Create, NURBS Primitives मषेन्य ूकी मदद सषे ्या NURBS कव्भ पि एक Surfacesसफदे स मषेन्य ूकमांड कषे  इसतषेमाल सषे वक्या जा 

सकता ह।ै NURBS सफदे स बन जानषे पि आप Surfaces मषेन्य ूमें मौजदू ऑपिषे शंस की मदद सषे इस पि काम कि सकतषे हैं।

Surfaces मषेन्य ूमें मौजदू कु् ऑपिषे शंस आपको सतहों को जोडनषे तथा अलर किनषे, अलाइन किनषे, खोलनषे औि बंद किनषे, ववसताि किनषे ऑफसषेट तथा 

वफलषेट किनषे की अनुमवत दषेतषे हैं। इन ऑपिषे शनों कषे  इसतषेमाल सषे पहलषे एक ्या अविक सफदे सों का र्यन किना होता ह।ै Help Line बताती ह ैवक वकसी 

ऑपिषे शन का इसतषेमाल किनषे कषे  वलए क््या रुना जाए।

Surfaces मषेन्य ूमें कई सािषे  टूल तथा कमांड री शावमल होतषे हैं, वजनका इसतषेमाल Surface Editing tool, the Sculpt Geometry tool, तथा Break व Smooth 

Tangent commands समषेत NURBS surfaces को एवडट किनषे में वक्या जाता ह।ै Surface Editing टूल आपको वकसी सफदे स लोकषे शन पि वक्लक किनषे  

औि इसषे वकसी मवैनपुलषेटि सषे मूव किनषे ्या इसकषे  टैंजेंट को बदलनषे की अनुमवत दषेता ह।ै Sculpt Geometry टूल आपको एक परिवत्भनशील, इंट्वैक्टव  

रिश कषे  प्र्योर सषे सफदे स को पुश, पुल ्या समूथ किनषे की अनुमवत दषेता ह।ै रिषेवकंर टैंजेंट्स आपको NURBS सफदे सों पि हाड्भ  एवजज़ वक्रएट किनषे की अनुमवत 

दषेता ह।ै

 वट्वमंर, NURBS सफदे सषेज पि व्रि डालनषे/होलस एड किनषे की प्रवक्र्या ह।ै इसषे NURBS कव्भ कषे  साथ वट्म वकए जानषे वालषे एरि्या को वरवनित कि वक्या 

जाता ह।ै ्यषे कवस्भ सफदे स सषे जुडषे  होनषे रावहए, जो एक अन्य सफदे स कषे  बीर कषे  इंटिसषेक्शन को वरवनित कि ्या वकसी लाइव ऑबज़षेक्ट पि ड्ाइंर कि वक्या 

जाता ह।ै 

Booleans दो ओविलवैपंर NURBS सफदे सों कषे  बीर कषे  इंटिसषेवक्टंर वॉल्यमू को सं्योवजत किनषे, घटानषे औि एक्सट्कै्ट का तिीका प्रदान किता ह।ै 

NURBS सफदे सों को साथ वसटर किनषे सषे सफदे स जुड जातषे हैं, तावक एक को वहलानषे सषे दूसिा री वहलषे। Maya आपको Global Stitch कमांड का इसतषेमाल 

किनषे ्या ऑबज़षेक्ट्स को पवाइंट, एवजज़ द्ािा वसटर किनषे की अनुमवत दषेता ह।ै

Modify, Convert मषेन्य ूका इसतषेमाल कि आप वववरनन मॉडवलंर टाइपस कषे  बीर रूपांतिण री कि सकतषे हैं। ्यह मषेन्य ूआपको NURBS, polygons, तथा 

subdivision सफदे सषेज़ कषे  बीर रूपांतिण की अनुमवत दषेता ह।ै

6.1.3.1 NURBS Primitives सीखें

सिलतम NURBS सफदे सषेज़ वप्रवमवटव ऑबज़षेक्ट्स होतषे हैं, वजनहें Create, NURBS Primitives मषेन्य ूकषे  इसतषेमाल सषे बना्या जा सकता ह।ै NURBS primitives 

में शावमल होतषे हैं sphere, cube, cylinder, cone, plane, तथा torus (जो एक डफनट कषे  आकाि जसैा होता ह)ै, इसषे वरत्र 2-1 में वदखा्या र्या ह।ै सलषेक्ट 

किनषे पि वप्रवमवटव ऑबज़षेक्ट वगड कषे  ओरिवजन पि वदखाई पडता ह।ै 

तित्र 6.1.45: तित्र 2-1
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सिेयसटि ्त्था कयूबस बनाना

 NURBS सफषे ्यि वप्रवमवटव कषे  वलए, आप उस अक् का र्यन कि सकतषे हैं वजसकषे  रािों ओि सफषे ्यि वसथत होता ह।ै एक पावश्भ्यल सफषे ्यि वक्रएट किनषे कषे  

वलए आप Sphere Options डा्यलॉर बॉक्स का इसतषेमाल कि सटाट्भ  तथा एंड सवीप ऐरंल वलै्यजू बदल सकतषे हैं, वजसषे वरत्र 2-2 में दशा्भ्या र्या ह।ै िषे वड्यस 

वलै्य ूसफषे ्यि का आकाि तथा सषेक्शन की संख्या वनिा्भ रित किता ह ैऔि सपनै उन आइसोपामस्भ को परिरावषत किता ह ैवजनहें सफषे ्यि में दशा्भ्या जाता ह।ै 

क््यबू NURBS वप्रवमवटव में समान ओरिएंटषेशन अक् शावमल होता ह।ै आप क््यबू की रौडाई, लंबाई तथा ऊंराई मानों को वववनददेवशत कि सकतषे हैं औि U 

तथा V परैषेज ऑपशन आइसोपामस्भ की संख्या सषेट कितषे हैं।

तित्र 6.1.46: तित्र 2-2

Cylinders ्त्था Cones बनाना 

वसवलंडि तथा कोन NURBS वप्रवमवटवस में पावश्भ्यल ऑबज़षेक्ट्स बनानषे कषे  वलए Start तथा End Sweep Angles सषेवटंगस शावमल होती हैं। आप िषे वड्यस तथा 

हाइट वलै्य ूरी एंटि कि सकतषे हैं औि वकसी ऑबज़षेक्ट में टॉप, बॉटम ्या दोनों पि कैप मौजदू ह,ै वक नहीं। सषेक्शन तथा सपनै की संख्या उन परैों की संख्या 

वनिा्भ रित किती ह,ै जो ऑबज़षेक्ट का वनमा्भण कितषे हैं। 

Plane और Torus बनाना 

Plane NURBS वप्रवमवटवस कषे  वलए, आप रौडाई औि लंबाई कषे  वलै्य ूसषेट कि सकतषे हैं। Torus NURBS वप्रवमवटव कषे  वलए, आप सटाट्भ  व एंड सवीप ऐरंल 

वलै्यजू़ औि साथ ही िषे वड्यस औि माइनि िषे वड्यस वलै्यजू सषेट कि सकतषे हैं।

आइसोपामसटि इंसटटि ्करना 

आिंर में आइसोपामस्भ की संख्या सषेगमेंट्स औि सपनै की संख्या द्ािा सषेट वक्या जाता ह,ै पि आप Surfaces, Insert Isoparms मषेन्य ूकमांड का इसतषेमाल 

कि एक NURBS वप्रवमवटव में अविक परै जोड सकतषे हैं। ्यवद आप मावकयं र मषेन्य ू सषे आइसोपामस्भ वडसपलषे मोड का र्यन कितषे हैं, तो आप वकसी  

मौजदूा आइसोपाम्भ  सषे उस सथान पि ड्ैर कि सकतषे हैं, जहाँ आप नए आइसोपाम्भ  को वसथत किना राहतषे हैं। वरत्र 2-3 में वदखाए अनुसाि इस सथान को 

पीली डैशड लाइन सषे वरवनित वक्या जाता ह।ै ्यवद आप सवक्र्य/इनषेबलड At Selection ववकलप कषे  साथ Insert Isoparms मषेन्य ूकमांड लार ूकितषे हैं, तो एक 

नए आइसोपाम्भ  का वनमा्भण होता ह।ै Between Selections ववकलप आपको संपणू्भ  ऑबज़षेक्ट कषे  वलए U ्या V वदशा कषे  वलए आइसोपामस्भ बनानषे की अनुमवत 

दषेता ह।ै



139138

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

तित्र 6.1.47: तित्र 2-3

ट्युटोररयि 1: Primitives सषे Candle बनाएँ 

1. चरण 1: वक्वक लषेआउट बटन में Four Views बटन पि वक्लक किें ।

2. चरण 2: Create, NURBS Primitives, Cylinder मषेन्य ूकमांड की मदद सषे वसवलंडि का वनमा्भण किें ।

3. चरण 3: सकषे ल टूल पि वक्लक किें  औि हिषे  Y-अक् मवैनपुलषेटिको ड्ैर कि वसवलंडि की ऊंराई बढाएं। 

4. चरण 4: Create, NURBS Primitives, Cylinder मषेन्य ूकमांड की मदद सषे एक अन्य वसवलंडि ऑबज़षेक्ट का वनमा्भण किें । 

5. चरण 5: सकषे ल टूल की मदद सषे टॉप व्य ूमें सेंटि हैंडल ड्ैर कि वसवलंडि कषे  डा्यमीटि को घटाएँ औि वफि वसवलंडि को लंबा किनषे कषे  वलए हिषे  Y-अक् 

मवैनपुलषेटि को ऊपि की ओि ड्ैर किें । मूव टूल का र्यन किें  औि हिषे  Y-अक् मवैनपुलषेटि को ड्ैर कि ्ोटषे वसवलंडि को बडषे वसवलंडि कषे  ऊपि मूव 

किें । बडा वसवलंडि कैं डल कषे  वलए होता ह ैऔि ्ोट वसवलंडि ववक कषे  वलए। 

6. चरण 6: Create, NURBS Primitives, Cylinder मषेन्य ूकमांड की मदद सषे एक अन्य वसवलंडि ऑबज़षेक्ट का वनमा्भण किें । 

7. चरण 7: सकषे ल टूल की मदद सषे टॉप व्य ूमें सेंटि हैंडल ड्ैर कि वसवलंडि कषे  डा्यमीटि को बढाएँ औि तब वसवलंडि की ऊंराई को कम किनषे कषे  वलए 

हिषे  Y-अक् मवैनपुलषेटि को नीरषे की ओि ड्ैर किें । मूव टूल का र्यन किें  औि हिषे  वाई-अक् मवैनपुलषेटि को ड्ैर कि बडषे फलटै वसवलंडि को कैं डल कषे  

बषेस पि मूव किें ।

8. चरण 8: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे सफषे ्यि ऑबज़षेक्ट का वनमा्भण किें ।

9. चरण 9: मूव टूल का र्यन किें  औि सफषे ्यि को फं्ट व्य ूमें ऊपि की ओि कैं डल ववक कषे  टॉप पि ड्ैर किें ।

10. चरण 10: Status Line में Select by Component बटन पि वक्लक किें ।

11. चरण 11: फं्ट व्य ूमें सरी टॉप CV पवाइंट्स पि ड्ैर किें  औि हिषे  Y-अक् मवैनपुलषेटि की मदद सषे इनहें फं्ट व्य ूमें ऊपि की ओि मूव किें ।

12. चरण 12: सफषे ्यि पि सबसषे टॉप CV पवाइंट का र्यन किें  औि उसषे फं्ट व्य ूमें ऊपि औि बाई ंओि मूव किें  । एवडट वक्या र्या सफषे ्यि, वरत्र 2-4 में 

वदखाए अनुसाि एक सिल मोमबत्ती की लौ कषे  सदृश होता ह।ै

13. चरण 13: File रुनें, Save Scene As रुनें औि फाइल को Primitive candle.mb कषे  रूप में सषेव किें ।
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तित्र 6.1.48: तित्र 2-4

ट्युटोररयि 2: आइसोपामस्भ जोडें 

1. चरण 1: Create, NURBS Primitives, Cone मषेन्य ूकमांड की मदद सषे कोन ऑबज़षेक्ट का वनमा्भण किें ।

2. चरण 2: कोन ऑबज़षेक्ट पि िाइट वक्लक किें  औि पॉप-अप मावकयं र मषेन्य ूसषे आइसोपामस्भ रुनें।

3. चरण 3: वफि बॉटम सक्भ ल सषे ऊपि की ओि कोन की ओि लररर आिी दूिी तक वक्लक औि ड्ैर किें । जहाँ न्या आइसोपाम्भ  वसथवत होता ह ैवहाँ 

पीली डॉटषेड लाइन वदखाई पडती ह।ै

4. चरण 4: Surfaces, Insert Isoparms का र्यन किें । ऑबज़षेक्ट में एक न्या आइसोपाम्भ  जुड जाता ह।ै

5. चरण 5: कोन ऑबज़षेक्ट पि िाइट वक्लक किें  औि पॉप-अप मावकयं र मषेन्य ूसषे पुनः आइसोपामस्भ रुनें।

6. चरण 6: बॉटम सक्भ ल औि नए आइसोपाि दोनों को सलषेक्ट किनषे कषे  वलए, दोनों पि सषे ड्ैर किें  । सलषेक्ट वक्यषे जानषे पि आइसोपाम्भ  पीला हो  

जाता ह।ै

तित्र 6.1.49: तित्र 2-5
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6.1.3.2 NURBS Surfaces ्को एरिट ्करना 

NURBS सफदे स बन जानषे पि आप इसकषे  Surface को इसकषे  घटकों को रुन कि औि रूपांतरित कि सीिषे एवडट कि सकतषे हैं। ऑबज़षेक्ट कषे  CVs को 

रूपांतरित किनषे सषे इन वप्रवमवटवस की मूल आकृवत एवडट हो जाती ह।ै वकसी ऑबज़षेक्ट कषे  CVs को दषेखनषे कषे  वलए, Status Line में Select by Component 

Type बटन पि वक्लक किें  (्या F8 key दबाएँ); ऑबज़षेक्ट पि िाइट वक्लक कि औि मावकयं र मषेन्य ूसषे कंट्ोल ववट्भसषेज का र्यन कि वप्रवमवटव कषे  CVs का 

र्यन किें । Move, Rotate, तथा Scale tools की मदद सषे र्यवनत CVs को रूपांतरित वक्या जा सकता ह।ै

घट्कों ्का चयन ्करना

NURBS सफदे सषेज में उतनषे ही CVs हो सकतषे हैं, वजतनषे वक NURBS, इसषे वरत्र 2-6 में वदखा्या र्या ह,ै इससषे वबलकुल वही CVs रुनना कवठन हो जाता ह,ै 

जो आप राहतषे हैं। इस समस्या सषे वनजात पानषे कषे  वलए, आप Selection मषेन्य ूमें सषे कमांड्स का इसतषेमाल कि सकतषे हैं। Selection menu में Grow CV 

Selection, Shrink CV Selection, Select CV Selection Boundary, तथा Select Surface Border कमांड शावमल होती हैं। जब आप एवडट किनषे कषे  वलए 

NURBS surface घटकों का र्यन कितषे हैं, तो ्यषे कमांड वाकई कािरि हो सकती हैं।

ध्यान दें: एक र्यवनत CV कषे  साथ, एडजषेसेंट (बिाबि वाला) CV रुननषे कषे  वलए आप ऐिो-की का इसतषेमाल कि सकतषे हैं।

7. चरण 7: Surfaces, Insert Isoparms, Options का र्यन किें ।

8. चरण 8: Between Selections ववकलप रुनें औि # Isoparms to Insert value को 5 पि सषेट किें । Insert बटन पि वक्लक किें । पाँर नए आइसोपामस्भ 

बनतषे हैं औि दो सलषेक्ट वक्यषे हुए आइसोपामस्भ कषे  बीर समान दूिी पि वसथत होतषे हैं, वजसषे वरत्र 2-5 पि दशा्भ्या र्या ह।ै

9. चरण 9: File रुनें, Save Scene As रुनें औि फाइल को New isoparms.mb कषे  रूप में सषेव किें ।

तित्र 6.1.50: तित्र 2-6

Surface Editing Tool ्का इस्तमेाि ्करना

Surfaces, Surface Editing, Surface Editing tool सलषेक्ट किकषे  आप सफदे स कषे  वकसी री वबंदु पि वक्लक कि सकतषे हैं औि मवैनपुलषेटस्भ का एक सषेट 

वदखाई दषेरा (वरत्र 2-7 में वदखाए अनुसाि) जो सलषेक्ट वक्यषे र्यषे वबंदु को मूव किनषे की अनुमवत दषेता ह।ै Point Position हैंडल ड्ैर किनषे सषे वबंदु मूव होता 

ह ैऔि वमड्ल माउस बटन सषे Slide Along Curve मवैनपुलषेटि ड्ैर किनषे सषे Point Position हैंडल आइसोपाम्भ  पि सलाइड होता ह/ैवखसकता ह।ै Tangent 

Direction पि वक्लक किनषे सषे वसवरषेज़ U align, V-align, and normal-aligned tangent कषे  बीर टॉरल होता ह।ै Tangent Direction हैंडल को मवैनपुलषेट कि 

सफदे स पवाइंट कषे  टैंजेंट को री बदला जा सकता ह।ै डॉटेंड एवक्सस लाइंस पि वक्लक किनषे सषे टैंजेंट इस अक् पि अलाइन हो जाता ह।ै
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तित्र 6.1.51: तित्र 2-7

Sculpt Geometry Tool ्का इस्तमेाि ्करना 

Sculpt Geometry tool सफदे सषेज़ मषेन्य ूमें उपलबि होता ह,ै जो आपको सफदे स CVs को पुश, पुल, 

समूथ तथा इिषे ज़ किनषे की अनुमवत दषेता ह।ै वरत्र 2-8 में वदखाए अनुसाि, Tool Settings डा्यलॉर 

बॉक्स का इसतषेमाल कि, आप सकलपट टूल का िषे वड्यस, ओपषेवसटी तथा शषेप रुन सकतषे हैं। र्यन 

वकए जानषे पि, एक लाल मवैनपुलषेटि आपको रिश िषे वड्यस का आकाि वदखाता ह ैऔि िषे वड्यल 

सक्भ ल सषे अलर इंवरत किनषे वाला ऐिो आपको वदखाता ह ै वक रिश सफदे स को वकतनी दूि 

वखसकाता ह।ै तब आप वकसी वसतु की सतह को ववरूवपत ्या वडफॉम्भ  किनषे कषे  वलए उसकी सतह 

पि पेंट कि सकतषे हैं

ध्यान दें: b की को होलड डाउन कि ड्ैर किनषे सषे आप रिश िषे वड्यस को पािसपरिक रूप सषे बदल 

सकतषे हैं; आप रिश दूिी को री बदल सकतषे हैं। 

Surfaces ्को सरि बनाना तित्र 6.1.52: तित्र 2-8

Surfaces, Rebuild Surfaces मषेन्य ूकमांड वकसी सफदे स की जवटलता को कम किती ह।ै ्यह ववकलप कई वरनन रिवबलड ववकलप प्रदान किता ह ैऔि आप 

कषे वल U ्या V वदशा िीवबलड कि सकतषे हैं। 

टैंजेंट ्की ब्ेर्ंकग ्त्था समूरदंग

वडफॉलट रूप सषे, NURBS सफदे सषेज़ अपनषे सतह पि वरकनषे होतषे हैं, क््योंवक सरी CVs कषे  बीर कषे  टैंजेंट पवाइंट्स अलाइन वसथवत में िहतषे हैं, पि ्यवद एक हाड्भ  

एज (सख् ़त वकनािा) बनाना राहतषे हैं, तो आप Surfaces, Surface Editing, Break Tangents मषेन्य ूकमांड का इसतषेमाल कि वकसी र्यवनत आइसोपाम्भ  कषे  

वलए टैंजेंट को तोड सकतषे हैं। Surfaces, Surface Editing, Smooth Tangents मषेन्य ूकमांड का इसतषेमाल वकसी टूटषे आइसोपाम्भ  को वरकना बनानषे में वक्या 

जा सकता ह।ै

ट्युटोररयि 1: NURBS घटकों को एवडट किें  

1. चरण 1: Create, NURBS Primitives, Plane मषेन्य ूकमांड की मदद सषे वकसी पलषेन ऑबज़षेक्ट का वनमा्भण किें ।

2. चरण 2: Status Line में Select by Component Type बटन पि वक्लक किें  (्या F8 key बटन दबाएँ)।

3. चरण 3: मूव टूल का र्यन किें  वशफट की को होलड डाउन किें  औि पलषेन ऑबज़षेक्ट कषे  ववपिीत कोनों पि CVs का र्यन किें ।



143142

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

4. चरण 4: तब हिषे  Y-अक् मवैनपुलषेटि की मदद सषे दो CVs को ऊपि की ओि ड्ैर किें । पलषेन ऑबज़षेक्ट की सतह CVs की मूवमेंट का अनुसिण किनषे 

हषेतु मुड जाती ह।ै

5. चरण 5: वशफट की होलड डाउन किें  औि वफि अन्य दो ववपिीत कोनषे वालषे CVs का र्यन किें ।

6. चरण 6: हिषे  Y-अक् मवैनपुलषेटि की मदद सषे इन दो CVs को नीरषे की ओि ड्ैर किें ।

7. चरण 7: इस सतह को शषेड वक्या हुआ दषेखनषे कषे  वलए 5 key दबाएँ वजसषे वरत्र 2-9 में वदखा्या र्या ह।ै

8. चरण 8: File रुनें, Save Scene As रुनें औि फाइल को Bent plane object.mb कषे  रूप में सषेव किें ।

तित्र 6.1.53: तित्र 2-9

ट्युटोररयि 2: Surface Editing Tool का इसतषेमाल किें  

1. चरण 1: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे सफषे ्यि ऑबज़षेक्ट का वनमा्भण किें ।

2. चरण 2: Quick Layout बटन सषे Model View पि वक्लक किें  औि पॉप-अप मषेन्य ूसषे Top View कमांड रुनें।

तित्र 6.1.54: तित्र 2-10



145144

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

3. चरण 3: Surfaces, Surface Editing, Surface Editing Tool मषेन्य ूकमांड का र्यन किें ।

4. चरण 4: सफषे ्यि पि बाएँ वकनािषे  पि वक्लक किें  सफषे ्यि को लंबा किनषे कषे  वलए Point Position हैंडल को बाई ंओि ड्ैर किें ।

5. चरण 5: वफि Tangent Distance हैंडल को सलषेक्ट किें  औि तब तक ड्ैर किें , जब तक वक ्यह Point Position हैंडल कषे  शीष्भ  पि न वसथत हो जाए।

6. चरण 6: सफषे ्यि कषे  दाएँ वकनािषे  कषे  वलए रिण 4 औि 5 दोहिाएं ।

7. चरण 7: Model View बटन पि पुनः वक्लक किें  औि Perspective view का र्यन किें । वफि शषेडषेड ऑबज़षेक्ट्स दषेखनषे कषे  वलए 5-की दबाएँ। सफषे ्यि 

ऑबज़षेक्ट, वरत्र 2-10 में वदखाए अनुसाि एक फुटबॉल की तिह वदखाई दषेरा।

8. चरण 8: File रुनें, Save Scene As रुनें औि फाइल को Football.mb.कषे  रूप में सषेव किें ।

ट्युटोररयि 3: Sculpt Geometry Tool का इसतषेमाल किें  

1. चरण 1: Create, NURBS Primitives, Cylinder, Options menu command का र्यन कि NURBS Cylinder Options डा्यलॉर बॉक्स ओपन किें । 

िषे वड्यस मान 5 पि, हाईट 15 पि, सषेक्शन संख्या को 20 पि तथा सपषेन संख्या को 10 पि सषेट किें । कैपस कषे  दोनों ववकलप रुनें औि Create बटन पि 

वक्लक किें ।

2. चरण 2: र्यवनत पलषेन ऑबज़षेक्ट पि ज़मू इन किनषे कषे  वलए key दबाएँ।

3. चरण 3: Surfaces, Sculpt Geometry Tool मषेन्य ूकमांड का र्यन किें । टूलबॉक्स में टूल पि डबल वक्लक किें  औि Tool Settings पनैल सषे Pull 

ववकलप का र्यन किें ।

4. चरण 4: ‘B’ key होलड डाउन किें  औि टूल िषे वड्यस को लररर 2.0 पि ड्ैर किें । वफि ‘m’ key होलड डाउन किें  औि Max Displacement मान को 

लररर 2.0 पि ड्ैर किें । वसवलंडि सफदे स कषे  ऊपि कस्भि वखसकानषे सषे िषे वड्यस का आकाि वदखाई पडता ह ैऔि सतह सषे इंवरत किता ऐिो Max 

Displacement को दशा्भता ह।ै

5. चरण 5: सकलपट कस्भि को वसवलंडि कषे  साइड पि लषे जाएँ औि सफदे स सषे एक सषेक्शन को दूि खींरनषे कषे  वलए, कई बाि ड्ैर किें । ्यह खींरा र्या 

सषेक्शन कैिषे क्टि की नाक होती ह।ै

6. चरण 6: व्य ूको तबतक घुमाएँ जबतक वक वखंरा हुआ एरि्या सीिा व्य ूकषे  सामनषे न आ जाए। टूल सषेवटंगस पनैल में पुश बटन का र्यन किें  औि 

वखंरषे एरि्या को नीरषे ड्ैर कि एक मँुह बनाएँ।

7. चरण 7: ‘b’ key होलड डाउन किें  औि िषे वड्यस को लररर 1.0 पि सषेट किें  औि वफि आइ सॉकषे ट (आखों कषे  कोटि) बनानषे कषे  वलए नाक वालषे एरि्या 

कषे  ऊपि दो सथान ड्ैर किें ।

तित्र 6.1.55: तित्र 2-11
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8. चरण 8: Create, NURBS Primitives, Cylinder, Sphere menu command का र्यन किें  औि sphere को एक आइ सॉकषे ट में िखें।

9. चरण 9: सफषे ्यि को अरी री र्यवनत िखतषे हुए, Edit, Duplicate menu command का र्यन किें  औि डुवपलकषे ट सफषे ्यि को दूसिषे  आइ सॉकषे ट में िखें। 

सामान्य कैिषे क्टि फषे स ऑबज़षेक्ट को वरत्र 2-11 में वदखा्या र्या ह।ै 

10. चरण 10: File रुनें, Save Scene As रुनें औि फाइल को Sculpted face.mb.कषे  रूप में सषेव किें । वरत्र 2-11 सकलपटषेड फषे स

ट्युटोररयि 4: एक हाड्भ  एज बनाएँ 

1. चरण 1: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे सफषे ्यि ऑबज़षेक्ट का वनमा्भण किें । 

2. चरण 2: Sphere पि िाइट वक्लक किें  औि पॉप-अप मावकयं र मषेन्य ूसषे आइसोपाम्भ  रुनें। 

3. चरण 3: लमबवत् (ववट्भकल) रलतषे वकसी आइसोपाम्भ  को रुननषे कषे  वलए उस पि ड्ैर किें ।

4. चरण 4: आइसोपाम्भको सलषेक्ट वक्यषे हुए, Surfaces, Surface Editing, Break Tangent मषेन्य ूको दो बाि रुनें। 

5. चरण 5: Sphere पि िाइट वक्लक किें  औि पॉप-अप मावकयं र मषेन्य ूसषे Control Vertex रुनें।

6. चरण 6: सेंटि CV का र्यन किें , जो पवू्भ  में रुनषे रए आइसोपाम्भ  पि वसथत होता ह ैऔि उसषे सफषे ्यि कषे  कें रि सषे दूि ड्ैर किें ।

7. चरण 7: शषेडषेड ऑबज़षेक्ट को दषेखनषे कषे  वलए 5-की दबाएँ। वदए हुए आइसोपाम्भ  कषे  वलए टैंजेंट टूटनषे सषे, ऑबज़षेक्ट में अवतरिक्त CVs जोड वदए जातषे ह,ै 

वजससषे र्यवनत आइसोपाम्भ  एक हाड्भ  एज बन जाता ह।ै

8. चरण 8: Create, NURBS Primitives, Sphere menu command का र्यन किें  औि sphere को वकसी एक आँख कषे  रूप में िखें।

9. चरण 9: सफषे ्यि को अरी री र्यवनत िखतषे हुए, Edit, Duplicate menu command का र्यन किें  औि डुवपलकषे ट सफषे ्यि को दूसिी आँख की वसथवत 

में िखें।

10. चरण 10: File रुनें, Save Scene As रुनें औि फाइल को Bird head.mb कषे  रूप में सषेव किें ।  

तित्र 6.1.56: तित्र 2-12
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6.1.3.3 Boolean Tools ्का इस्तमेाि ्करें

जब NURBS सतह ओविलपै/अवतच्ावदत होतषे हैं, तो आप Surfaces, Booleans मषेन्य ूका इसतषेमाल कि दो ऑबज़षेक्ट्स कषे  बीर जोडनषे, घटानषे ्या इंटिसषेक्शन 

का पता लरानषे कषे  वलए प्र्योर वक्यषे जा सकनषे वालषे तीन टूलस में सषे एक का र्यन कि सकतषे हैं। इन तीनों में सषे कोई एक टूल सलषेक्ट वक्यषे हुए, आप पहलषे 

ऑबज़षेक्ट ्या ऑबज़षेक्ट्स को रुननषे कषे  वलए वक्लक कि सकतषे हैं औि वफि दूसिषे  ऑबज़षेक्ट ्या ऑबज़षेक्ट्स को रुननषे सषे पहलषे एंटि-की दबाएं । इनमें सषे हिषे क 

टूल कषे  वलए ऑपशन डा्यलॉर बॉक्स (वरत्र 2-13 में Union टूल कषे  वलए प्रदवश्भत) आपको इनपुट वडलीट किनषे औि पिूा होनषे पि टूल सषे बाहि वनकलनषे की 

अनुमवत दषेता ह।ै

धयान दें: Boolean टूलस एक बाि में कषे वल दो NURBS सफदे सषेज पि काम कि सकता ह।ै

तित्र 6.1.57: तित्र 2-13

Union Tool ्ेक सा्थ सिमे सेज़ संयोरज्त ्करना: जब Union टूल का इसतषेमाल दो ओवलवैपंर/ अवतच्ावदत सतहों पि वक्या जाता ह,ै इंटिसषेवक्टंर/

प्रवतच ष्ेदी िषे खाएँ हट जाती हैं औि परिणामी ऑबज़षेक्ट एक वसंरल ऑबज़षेक्ट कषे  रूप में काम किता ह।ै 

Subtract Tool ्ेक सा्थ Surface Parts ्को हटाना: Subtract टूल दूसिषे  र्यवनत ऑबज़षेक्ट कषे  ओवलवैपंर/अवतच्ावदत वहससषे को पहलषे र्यवनत ऑबज़षेक्ट 

सषे हटाता ह।ै वजस क्रम में ऑबज़षेक्ट्स का र्यन होता ह ै्यह अहम होता ह।ै र्यन क्रम को उलटनषे सषे नतीजा बदल जाता ह।ै 

Intersect Tool ्ेक सा्थ Surface Intersection बनाना: Intersect Tool दो अवतच्ावदत सतहों कषे  प्रवतच ष्ेदी वहससषे को ्ोडकि, बाकी सरी कु्  

हटाता ह।ै 

ट्युटोररयि 1: Boolean Union Surfaces का वनमा्भण किना 

1. चरण 1: File रुनें, सीन ओपन किें  औि Boolean.mb. नाम वाली फाइल ओपन किें । 

2. चरण 2: Surfaces, Booleans, Union Tool मषेन्य ूकमांड का र्यन किें । 

3. चरण 3: वफि सफषे ्यि ऑबज़षेक्ट का र्यन किें  औि एंटि-की दबाएँ। 

तित्र 6.1.58: तित्र 2-14
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4. चरण 4: वकसी एक वसवलंडि ऑबज़षेक्ट्स पि वक्लक किें  औि ऑबज़षेक्ट्स को एक साथ ्यवून्यन (सं्योवजत) किनषे कषे  वलए वफि सषे एंटि की दबाएँ।

5. चरण 5: अन्य दो वसवलंडि कषे  वलए रिण 2-4 दुहिाएँ। अंवतम ऑबज़षेक्ट को वरत्र 2-14 में वदखा्या र्या ह।ै

6. चरण 6: File रुनें, Save Scene As रुनें औि फाइल को Boolean union.mb.कषे  रूप में सषेव किें ।

ट्युटोररयि 2: Boolean Subtract Surfaces का वनमा्भण किना 

1. चरण 1: File रुनें, सीन ओपन किें  औि Boolean.mb. नाम वाली फाइल ओपन किें ।

2. चरण 2: Surfaces, Booleans, Subtract Tool मषेन्य ूकमांड का र्यन किें ।

3. चरण 3: सफषे ्यि ऑबज़षेक्ट का र्यन किें  औि एंटि-की दबाएँ।

4. चरण 4: वकसी एक वसवलंडि ऑबज़षेक्ट्स पि वक्लक किें  औि एक ऑबज़षेक्ट को दूसिषे  सषे घटानषे कषे  वलए वफि सषे एंटि की दबाएँ।

5. चरण 5: अन्य दो वसवलंडि कषे  वलए रिण 2-4 दुहिाएँ। अंवतम ऑबज़षेक्ट को वरत्र 2-15 में वदखा्या र्या ह।ै.

6. चरण 6: File रुनें, Save Scene As रुनें औि फाइल को Boolean union.mb कषे  रूप में सषेव किें ।

तित्र 6.1.59: तित्र 2-15

ट्युटोररयि 3: Boolean Intersect Surfaces का वनमा्भण किना

1. चरण 1: File रुनें, सीन ओपन किें  औि Boolean.mb नाम वाली फाइल ओपन किें ।

2. चरण 2: Surfaces, Booleans, Intersect Tool मषेन्य ूकमांड का र्यन किें ।

3. चरण 3: वफि सफषे ्यि ऑबज़षेक्ट का र्यन किें  औि एंटि-की दबाएँ।

4. चरण 4: वकसी एक वसवलंडि ऑबज़षेक्ट्स पि वक्लक किें  औि एक ऑबज़षेक्ट को दूसिषे  सषे प्रवतच ष्ेद किनषे कषे  वलए वफि सषे एंटि की दबाएँ।

5. चरण 5: अन्य दो वसवलंडि कषे  वलए रिण 2-4 दुहिाएँ। अंवतम ऑबज़षेक्ट को वरत्र 2-16 में वदखा्या र्या ह।ै.

6. चरण 6: File रुनें, Save Scene As रुनें औि फाइल को Boolean intersect.mb कषे  रूप में सषेव किें ।
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तित्र 6.1.60: तित्र 2-16

6.1.4 Keyframes ्ेक सा्थ एरनमेट ्करना

सिल 3D एवनमषेशन आश्च्य्भजनक रूप सषे आसान होता ह।ै रूंवक Maya, 3D सीन में ऑबज़षेक्ट्स का सही सथान जानता ह,ै ्यह वकसी ऑबज़षेक्ट कषे  लोकषे शन 

को तषेज़ी सषे औि आसानी सषे इंटिपोलषेट कि सकता ह,ै क््योंवक ्यह सपषेस में दो वरनन वबंदुओ ंकषे  बीर मूव किता ह।ै सपषेस में इन लोकषे शन को कीफ्षे मस कहा 

जाता ह ैऔि ्यषे वकसी ऑबज़षेक्ट की रवत कषे  साथ इसकी मध्यवतशी वसथवत्यों को परिरावषत कितषे हैं।

 आप वकसी ऑबज़षेक्ट की वसथवत, घणू्भन, सकषे ल तथा वकसी री कीएबल ऑबज़षेक्ट ऐवट्ब्यटू कषे  वलए कीफ्षे मस सषेट कि सकतषे हैं। सरी keys वक्रएट हो जानषे 

कषे  बाद, इंटिफषे स कषे  सबसषे नीरषे टाइम सलाइडि पि वदखाई पडती हैं। आप इन keys को अन्य ऑबज़षेक्ट्स पि कॉपी तथा पषेसट कि सकतषे हैं औि वफि उनहें 

आवश्यकतानुसाि वशफट औि सकषे ल कि सकतषे हैं।

 एवनमषेशन बन जानषे पि, आप इसषे Time Slider में टाइम फ्षे मस में सक्रोल किकषे  दषेख सकतषे हैं। एवनमषेशन का एक प्रीव्य ूव्य ूपनैल में वदखाई पडता ह।ै वकसी 

एवनमषेशन सीक्वेंस की मूववंर में Animation Controls री उप्योरी होतषे हैं। ्यवद व्य ूपनैल को प्या्भप्त तषेज़ी सषे सीन अपडषेट किनषे में कोई समस्या होती ह ैतो 

आप Playblast फीरि का इसतषेमाल कि वकसी बफि को मौजदूा सीन कषे  सनपैशॉट रषेज सकतषे हैं। 

कई ऐसषे फीरस्भ हैं जो एवनमषेटषेड ऑबज़षेक्ट्स को दषेखनषे में आसान बनातषे हैं। इन फीरस्भ में मोशन ट्षेलस शावमल हैं, जो ऑबज़षेक्ट की मोशन की ट्जैषेक्टिी 

प्रदवश्भत किता ह ैऔि ghosting अपनी रवत में आरषे बढतषे हुए एवनमषेटषेड ऑबज़षेक्ट की प्रवत्यों को प्रदवश्भत किता ह।ै 

कीफ्षे वमंर कषे  अलावा ऑबज़षेक्ट्स एवनमषेट किनषे का एक अन्य तिीका ह ैवकसी ऑबज़षेक्ट को मोशन पाथ सषे जोडना ह।ै वह ऑबज़षेक्ट वफि पाथ का पालन 

किता ह।ै इससषे एक कव्भ खींरना आसान हो जाता ह,ै जो सटीक रूप सषे बताता ह ैवक ऑबज़षेक्ट कहां मूव किता ह।ै 

आप Graph Editor में री एवनमषेटषेड सींस को एवडट कि सकतषे हैं, जहां सरी ऑबज़षेक्ट मोशन तथा ऐवट्ब्यटू बदलाव गाफड कव्भ कषे  रूप में प्रदवश्भत होतषे हैं 

औि सरी keys पवाइंट होतषे हैं। आप इन कवस्भ तथा पवाइंट्स को उनकी समूथनषेस बदलकि औि उनकषे  टैंजेंट्स कषे  साथ काम किकषे  एवडट कि सकतषे हैं।

6.1.4.1 ्कीफे्मस सेट ्करें

आप वकसी ऑबज़षेक्ट को उसकी आिंर अवसथा में लाकि औि एक key सषेट कि औि वफि उसषे उसकी अंवतम अवसथा में लाकि औि एक अन्य key सषेट कि, 

keys कषे  प्र्योर एवनमषेट कि सकतषे हैं। Maya तब दो keys कषे  बीर हमषेशा इनहीं दो अवसथाओ ंकषे  बीर इंटिपोलषेट किता ह।ै Keys आपको सुव्यववसथत keys 

की सीवमत संख्या कषे  साथ काफी जवटल एवनमषेशन सीक्वेंस बनानषे में सक्म बनाता ह।ै
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ध्यान दें: सरी एवनमषेशन मषेन्य ूकमांड्स Animation Menu Set में पाए जातषे हैं।

सेरटंग ्कीज़ 

जब कोई ऑबज़षेक्ट सटीक वसथवत में होता ह,ै तो आप Animate, Set Key मषेन्य ूकमांड का इसतषेमाल कि वत्भमान सम्य कषे  वलए एक key को सषेट कि सकतषे 

हैं। आप Attribute Editor ्या Channel Box में वकसी ऐवट्ब्यटू पि िाइट-वक्लक किकषे  औि पॉप-अप मषेन्य ूसषे Key Selected ्या Key All का र्यन किकषे  री 

keys सषेट कि सकतषे हैं। ऐसषे ऐवट्ब्यट्ूस वजनकषे  keys सषेट होतषे हैं, वषे Attribute Editor तथा Channel Box में हलकषे  रिूषे  िंर में शषेडषेड िहतषे हैं, इसषे वरत्र 3-1 में 

वदखा्या र्या ह।ै सषेवटंर-कीज़ कषे  वलए Tip The S key हॉट-की होती ह।ै

तित्र 6.1.61: तित्र 3-1

Auto Key ्का इस्तमेाि ्करना 

आप ऐसषे ऐवट्ब्यट्ूस कषे  वलए सवरावलत रूप सषे keys बनानषे कषे  वलए Auto Key मोड का इसतषेमाल कि सकतषे हैं, वजनकी पहलषे सषे 

कम सषे कम एक key ह।ै Auto Key toggle को सक्म किनषे कषे  वलए, वजसषे वरत्र 3-2 में वदखा्या र्या ह,ै Range Slider कषे  दाएँ वसि 

पि Auto Key बटन पि वक्लक किें । एवक्टव/सवक्र्य होनषे पि बटन लाल हो जाता ह।ै जब Auto Key एवक्टव हो जा्यषे, तो आप कोई 

न्या टाइम रुन सकतषे हैं ्या वकसी ऐवट्ब्यटू को अपडषेट कि सकतषे हैं औि Set Keys मषेन्य ूकमांड कषे  इसतषेमाल कषे  वबना ही key 

अपनषे आप बन जाती ह।ै 
तित्र 6.1.62: तित्र 3-2

ध्यान दें:  Auto Key को इनषेबल किनषे/सक्म बनानषे सषे पहलषे आपको र्यवनत ऑबज़षेक्ट कषे  वलए कीफ्षे म बनानषे की ज़रूित होरी, अन्यथा ्यह काम नहीं 

किषे रा।   

Keys ्का चयन ्करना 

र्यवनत ऑबज़षेक्ट कषे  वलए Keys, Time Slider में पतली लाल िषे खाओ ंकषे  रूप में प्रकट होतषे हैं। ्यवद आप Time Slider में इन लाल िषे खाओ ंपि वक्लक कितषे 

हैं, वत्भमान टाइम उस सम्य पि मूव हो जाता ह ैऔि key सलषेक्ट हो जाती ह।ै र्यवनत keys नीलषे िंर की वदखाई पडती हैं, इसषे वरत्र 3.3 में दशा्भ्या र्या ह।ै 
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्यवद आप Shift key होलड डाउन कितषे हैं औि कई keys पि ड्ैर कितषे हैं, तो र्यवनत टाइम लाल हो जाता ह ैऔि उस सषेगमेंट कषे  रीति सरी keys सलषेक्ट 
हो जाती ह,ै जसैा वरत्र 3-4 में दशा्भ्या र्या ह।ै आप र्यवनत एरि्या कषे  रीति ्या उसकषे  दोनों वसिषे  पि वसथत ऐिो को ड्ैर किकषे  र्यवनत टाइम को वशफट ्या 
सकषे ल कि सकतषे हैं। 

ध्यान दें: Preference डा्यलॉर बॉक्स कषे  Timeline पनैल में Key Tick Size सषेवटंर का इसतषेमाल कि, आप Time Slider में प्रदवश्भत keys की मोटाई/
वथकनषेस को बढा सकतषे हैं। आप Colors डा्यलॉर बॉक्स कषे  एवनमषेशन पनैल में key कलि री बदल सकतषे हैं, Window, Settings/Preferences, Preferences, 
Colors मषेन्य ूकमांड कषे  साथ ओपन किें ।

तित्र 6.1.63: तित्र 3-4

Keys ्को ्कॉपी ्करना 

आप Keys Clipboard की मदद सषे फाइलों कषे  बीर र्यवनत ऑबज़षेक्ट कषे  वलए Keys कषे  सषेट को कॉपी औि पषेसट कि सकतषे हैं। keys को Clipboard पि कॉपी 

किनषे कषे  वलए, Edit, Keys, Cut Keys ्या Edit, Keys, Copy Keys मषेन्य ू कमांड रुनें। वत्भमान सीन बंद किनषे औि एक नए सीन खोलनषे पि Keys, 

Clipboard पि ही बनषे िहतषे हैं। आप Edit, Keys, Paste Keys मषेन्य ूकमांड का प्र्योर कि र्यवनत ऑबज़षेक्ट पि keys पषेसट कि सकतषे हैं। 

Keys रििीट ्करना 

Edit, Keys, Delete Keys मषेन्य ूकमांड र्यवनत ऑबज़षेक्ट कषे  वलए सरी Keys वडलीट किता ह।ै अर्यवनत ऑबज़षेक्ट कषे  वलए सषेट की रई Keys सषेट ्यूं ही 

बनी िहती हैं। 

Keys सनरैपंग ्करना 

Edit, Keys, Snap Keys मषेन्य ू कमांड सरी र्यवनत keys को उनकषे  

वनकटवतशी मान ्या टाइम पि सनपै किता ह।ै कई सलषेक्टषेड keys की 

सकषे वलंर कषे  बाद ्यह खासतौि सषे उप्योरी होता ह।ै वरत्र 3-5 में वदखाए 

अनुसाि, Snap Keys Options डा्यलॉर बॉक्स सषे आप कषे वल र्यवनत 

Keys ्या सरी Keys को सनपै कि सकतषे हैं। आप कषे वल Times, Values 

्या दोनों को सनपै किनषे का री ववकलप रुन सकतषे हैं।

तित्र 6.1.64: तित्र 3-5
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ट्युटोररयि 1: Keys सषेट किें  

1. चरण 1: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे एक NURBS सफषे ्यि ऑबज़षेक्ट का वनमा्भण किें ।

2. चरण 2: फ्षे म 1 में Time Slider कषे  साथ, एवनमषेट, Set Key मषेन्य ूकमांड का र्यन किें । Channel Box में सरी ट्ांसफ्ॉम्भ  ऐवट्ब्यट्ूस हलकषे  रिूषे  िंर में 

वदखाई पडतषे हैं, जो वदखाता ह ैवक उनकषे  साथ keys जुडषे हुए हैं।

3. चरण 3: टाइम सलाइडि में टाइम को फ्षे म 25 पि ड्ैर किें । ध्यान दें वक ्यवद फ्षे म 25 न वदखाई पडषे, तो उसकषे  वदखाई पडनषे तक Range Slider कषे  दाएँ 

वसिषे  को ड्ैर किें । ्यवद Range फ्षे म 50 पि नहीं पहंुरता ह,ै तो Range Slider की दाई ंओि वसथत टषेक्सट फीलड में 50 एंटि किें ।

4. चरण 4: Channel Box में ScaleX, ScaleY, तथा ScaleZ ऐवट्ब्यट्ूस को 5.0. में बदलें।

5. चरण 5: वफि सषे एवनमषेट, Set Key मषेन्य ूकमांड का र्यन किें ।

6. चरण 6: टाइम सलाइडि में टाइम को फ्षे म 50 पि ड्ैर किें ।

7. चरण 7: Channel Box में ScaleX, ScaleY, तथा ScaleZ एवट्ब्यट्ूस को वापस 1.0. पि लषे आएं।

8. चरण 8: वफि सषे एवनमषेट, Set Key मषेन्य ूकमांड का र्यन किें ।

9. चरण 9: Time Slider माक्भ ि आरषे-पी ष्े  ड्ैर किें । Time Slider ड्ैर किनषे सषे सफषे ्यि बढता ्या घटता ह।ै

10. चरण 10: File रुनें, Save Scene As रुनें औि फाइल को Growing sphere.mb. कषे  रूप में सषेव किें ।

ट्युटोररयि 2: Auto Key को इसतषेमाल किें  

1. चरण 1: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे एक NURBS सफषे ्यि ऑबज़षेक्ट का वनमा्भण किें

2. चरण 2: Time Slider फ्षे म 1 पि होनषे की वसथवत में, Channel Box में makeNurbsSphere1 इनपुट नोड पि वक्लक किें , Start Sweep ऐवट्ब्यटू पि 

वक्लक किें  औि वफि िाइट-वक्लक किें  औि पॉप-अप मषेन्य ूसषे Key Selected रुनें। 

3. चरण 3: इंटिफषे स कषे  नीरषे दाएं वकनािषे  पि Auto Key बटन पि वक्लक किें । 

4. चरण 4: टाइम सलाइडि में टाइम को फ्षे म 25 पि ड्ैर किें । 

5. चरण 5: Start Sweep वलै्य ूको 180 कि दें। 

6. चरण 6: टाइम सलाइडि में टाइम को फ्षे म 50 पि ड्ैर किें । 

7. चरण 7: Start Sweep वलै्य ूको 359 कि दें। 

8. चरण 8: Time Slider माक्भ ि आरषे-पी ष्े  ड्ैर किें । वरत्र 3-6 में 

वदखाए अनुसाि Time Slider ड्ैर किनषे सषे सफषे ्यि िीिषे  सषे रा्यब हो 

जाता ह।ै

9. चरण 9: File रुनें, Save Scene As रुनें औि फाइल को Sweeping 

sphere.mb. कषे  रूप में सषेव किें । 

तित्र 6.1.65: तित्र 3-6
ट्युटोररयि 3: Move कीज़ 

1. चरण 1: Create, NURBS Primitives, Sphere मषेन्य ूकमांड की मदद सषे NURBS सफषे ्यि ऑबज़षेक्ट बनाएँ औि वफि कोई NURBS पलषेन ऑबज़षेक्ट्स 

बनाएं औि पलषेन ऑबज़षेक्ट को सफषे ्यि सषे बडा बनानषे कषे  वलए सकषे ल किें ।

2. चरण 2: सफषे ्यि रुनें औि Status Line में Select by Component Type बटन पि वक्लक किें । 

3. चरण 3: उन सरी CV को ड्ैर किें , जो उनहें रुननषे कषे  वलए सफषे ्यि कषे  फं्ट व्य ूमें वनरलषे वहससषे को बनातषे हों।
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4. चरण 4: एवनमषेट, Set Key मषेन्य ूकमांड का र्यन किें ।

5. चरण 5: टाइम सलाइडि में टाइम को फ्षे म 3 पि ड्ैर किें । 

6. चरण 6: Side व्य ू में CVs को ऊपि की ओि ड्ैर किें  तथा एवनमषेट, Set Key मषेन्य ू कमांड का वफि सषे र्यन किें । ्यह उदाहिण दशा्भता ह ै वक 

कमपोनेंट्स औि साथ ही ऑबज़षेक्ट्स को एवनमषेट वक्या जा सकता ह।ै CVs कषे  वनरलषे वहससषे को ऊपि की ओि ड्ैर कि, सफषे ्यि को तीन फ्षे म पि 

वसकोडा जा िहा ह।ै

7. चरण 7: Status Line में Select by Object Type बटन पि वक्लक किें । 

8. चरण 8: सफषे ्यि का र्यन किें  तथा Front व्य ूमें इसषे ऊपि की ओि लषे जाएँ औि एवनमषेट, Set Key मषेन्य ूकमांड का र्यन किें । 

9. चरण 9: Time Slider को फ्षे म 10 पि ड्ैर किें , सफषे ्यि को पुनः पलषेन ऑबज़षेक्ट पि लषे जाएँ औि एवनमषेट, Set Key मषेन्य ूकमांड का वफि सषे र्यन किें  

(्या हॉटकी दबाएँ)। सफषे ्यि अब पलषेन ऑबज़षेक्ट पि वदखाई पड िहा ह।ै 

10. चरण 10: Status Line में पुनः Select by Component Type बटन पि वक्लक किें । 

11. चरण 11: उनहीं CVs का र्यन किें  वजनका र्यन पहलषे वक्या र्या था औि Shift key होलड डाउन कि Time Slider में सषेट keys पि ड्ैर किें । 

12. चरण 12: पहली Key कषे  फ्षे म 7 पि होनषे तक र्यवनत Keys को दाई ंओि ड्ैर किें । Shift key को होलड डाउन कितषे हुए Set Keys पि ड्ैर किनषे सषे 

र्यवनत Keys लाल हो उठतषे हैं तथा कु् बलकै ऐिोज़ वडसपलषे होतषे हैं, वजनका इसतषेमाल आप र्यवनत Keys को मूव ्या सकषे ल किनषे में कि सकतषे हैं। 

13. चरण 13: Time Slider माक्भ ि आरषे-पी ष्े  ड्ैर किें । सफषे ्यि बषेस पलषेन पि वरिता ह ैजहाँ ्यह पलषेन ऑबज़षेक्ट्स कषे  साथ टकिानषे सषे वसकुड जाता ह,ै इसषे 

वरत्र 3-7 में वदखा्या र्या ह,ै File रुनें, Save Scene As रुनें औि फाइल को Falling sphere.mb कषे  रूप में सषेव किें ।

तित्र 6.1.66: तित्र 3-7
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6.1.4.2 एरनमेशन दखेें 

कषे वल ्यह पता लरानषे कषे  वलए वक आपनषे कोई रलती की ह,ै आप फाइनल एवनमषेशन पषेश किनषे में काफी सािा सम्य लरा दषेतषे हैं, तो ्यह बिबाद कितषे हों, 

तो ्यह काफी औि वनिाशापणू्भ  हो सकता ह।ै एवनमषेशन प्रीव्य ूकिनषे सषे रलवत्यों को पहलषे ही दूि किनषे में मदद वमल सकती ह।ै 

एरनमेशन प्रीवयू ्करना

इंटिफषे स कषे  बॉटम में एवनमषेशन कंट्ोलस में Play Forward बटन पि वक्लक कि (वरत्र 3-8 में प्रदवश्भत) एवक्टव व्य ू

पनैल में फ्षे मस कषे  ज़रि्यषे एवनमषेशन प्रीव्य ू किना। आप एवनमषेशन को उलटषे क्रम/रिवस्भ में दषेखनषे कषे  वलए Play 

Backwards बटन पि री वक्लक कि सकतषे हैं। ्यवद आप Time Slider हैंडल रुनतषे औि ड्ैर कितषे हैं, तो वववरनन 

फ्षे मस कषे  बीर ड्ैर किनषे सषे व्य ूपनैल अपडषेट हो जाता ह।ै

तित्र 6.1.67: तित्र 3-8एरनमेशन ्की िूरपंग

्यवद आप Animation Preferences बटन पि वक्लक कितषे हैं, Auto Key बटन सषे अरला, Preferences डा्यलॉर बॉक्स का Timeline पनैल वदखाई दषेता ह,ै 

इसषे वरत्र 3-9 में वदखा्या र्या ह।ै इस डा्यलॉर बॉक्स में आप फ्षे मों की वह संख्या सषेट कितषे हैं जो Time Slider में वदखती ह।ै Preferences डा्यलॉर बॉक्स 

में तीन Looping ऑपशंस री शावमल होतषे हैं —Once, Oscillate, तथा Continuous Play Forward बटन वक्लक किनषे पि Once ववकलप एवनमषेशन को एक 

बाि रलाता ह।ै Oscillate एवनमषेशन को बाि-बाि आरषे बढाता औि पी ष्े  लाता ह ैऔि Continuous एवनमषेशन को बाि-बाि आरषे रलाता ह।ै 

ध्यान दें: आप Time Slider ्या Animation Controls पि िाइट वक्लक कि वकसी पॉप-अप मषेन्य ूसषे री लवूपंर ववकलप एक्सषेस कि सकतषे हैं।

तित्र 6.1.68: तित्र 3-9
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Ghosting इनेबि ्करें  

Ghosting एक एवनमषेशन तकनीक ह,ै वजसमें आप वप्लषे तथा/्या आनषे वालषे फ्षे मस में वकसी ऑबज़षेक्ट की पोवजशन दषेखतषे हैं, इसषे सफषे ्यि कषे  संदर्भ  में 3-10 

में वदखा्या र्या ह।ै ्यह वकसी ऑबज़षेक्ट कषे  मोशन कषे  टाइवमंर पि काम कितषे सम्य मददराि सावबत होता ह।ै Ghosting को सक्म बनानषे कषे  वलए, 

Visualize, Ghost Selected मषेन्य ूकमांड का र्यन किें । वरत्र 3-11 में वदखाए अनुसाि, Ghost Options डा्यलॉर बॉक्स में आप सटीक रूप सषे रुन सकतषे 

हैं, वक कौन सषे फ्षे म घोसटषेड हैं ्या वत्भमान फ्षे म वकतनषे फ्षे म पहलषे औि वकतनषे फ्षे म बाद वदखा्या र्या ह।ै घोवसटंर वडसषेबल/अक्म किनषे कषे  वलए, Visualize, 

Unghost Selected ्या Animate, Unghost All मषेन्य ूकमांड्स का इसतषेमाल किें । 

सभी मेनयू ्कमांि्स।

तित्र 6.1.69: तित्र 3-10

तित्र 6.1.70: तित्र 3-11
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Motion Trails बनाना

वरत्र 3-12 में दशा्भए अनुसाि, Motion Trails वह ट्जैषेक्टिी पाथ होता ह ैवजस पि कोई एवनमषेटषेड ऑबज़षेक्ट फ्षे मस कषे  बीर मूव कितषे हुए रलता ह।ै मोशन ट्षेल 

बनानषे कषे  वलए Visualize, Create Editable Motion Trail मषेन्य ूकमांड बनाएँ। Motion Trail Options डा्यलॉक्स बॉक्स में आप मोशन ट्षेल कषे  वलए आिंर 

व अंत सम्य सषेट कि सकतषे हैं औि Line, Locator, ्या Points कषे  वलए Draw Style ववकलप। आप Show Frame Numbers को सलषेक्ट औि वडसलषेक्ट री 

कि सकतषे हैं।

तित्र 6.1.71: तित्र 3-12

Playblast ्का इस्तमेाि ्करना 

Window, Playblast मषेन्य ूकमांड हिषे क फ्षे म कषे  वलए एवक्टव व्य ूपनैल का एक सक्रीनशॉट कैपरि किता ह।ै एक प्रीव्य ूएवनमषेशन वक्रएट किनषे कषे  वलए ्यषे 

फ्षे मस वफि एक साथ वसटर कि वद्यषे जातषे हैं, जो वडफॉलट वससटम मूवी पलषे्यि में पलषे की जाती ह।ै Playblast का इसतषेमाल किना सुवविाजनक होता ह,ै 

क््योंवक जवटल सीन को व्य ूपनैल में अपनषे व्य ूको अपडषेट किनषे में कु् सम्य लरता ह।ै वरत्र 3-13 में वदखाए अनुसाि, Playblast Options डा्यलॉर बॉक्स 

का इसतषेमाल किनषे सषे, आप Time Range, Viewer, तथा Display Size ऑपशंस रुन सकतषे हैं। आप कषे वल प्रीव्य ूको एक फाइल में सषेव किनषे का री ववकलप 

रुन सकतषे हैं।

तित्र 6.1.72: तित्र 3-13
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ट्युटोररयि 1: एवनमषेशन प्रीव्य ूकिना

1. चरण 1: File रुनें, Open Scene मषेन्य ूकमांड रुनें औि Simple airplane.mb फाइल को लोकषे ट किें ।

2. चरण 2: टाइम सलाइडि को फ्षे म 10 पि ड्ैर किें ।

3. चरण 3: ए्यिपलषेन र्यवनत किनषे कषे  साथ, Animate, Ghost Selected, Options मषेन्य ूकमांड का र्यन किें । 

4. चरण 4: Ghost Options डा्यलॉर बॉक्स में, Type of Ghosting list सषे Custom Frame Steps रुनें। सटषेप साइज़ को 3 किें  औि Ghost बटन पि  

वक्लक किें ।

5. चरण 5: Animation Controls में Play Forward बटन दबाएँ। वरत्र 3-14 में वदखाए अनुसाि, घोवसटंर कषे  साथ एवनमषेशन लपूस बाि-बाि सक्म  

होता ह।ै 

6. चरण 6: File रुनें, Save Scene As रुनें औि फाइल को Airplane with ghost.mb कषे  रूप में सषेव किें । 

तित्र 6.1.73: तित्र 3-14

ट्युटोररयि 2: Playblast का इसतषेमाल किें  

1. चरण 1: File रुनें, Open Scene मषेन्य ूकमांड रुनें औि Simple airplane.mb फाइल को लोकषे ट किें  

औि खोलें।

2. चरण 2: Window, Playblast मषेन्य ूकमांड रुनें। एवनमषेशन का हिषे क फ्षे म Playblast buffer में कैपरि 

होता ह ै औि एवनमषेटषेड फ्षे मस को वडफॉलट वससटम वीवड्यो पलषे्यि में, जसैषे वक Windows Media 

Player में प्रदवश्भत वक्या जाता ह,ै वजसषे वरत्र 3-15 में वदखा्या र्या ह।ै

तित्र 6.1.74: तित्र 3-15
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6.1.4.3 Motion Paths ्की मदद से एरनमेट ्करें

Key framing कषे  साथ काम किना आसान होता ह,ै पि करी-करी कोई पाथ परिरावषत किना औि उस पाथ को वकसी ऑबज़षेक्ट को उस पाथ पि रलाना 

ज्यादा आसान हो सकता ह।ै मोशन पा्थस कव्भ होतषे हैं वजनसषे आप ्यह परिरावषत कि सकतषे हैं, वक वकसी ऑबज़षेक्ट को सीन में कैसषे मूव किना ह।ै

Motion Path Keys बनाना 

आप सीन कषे  पास ऑबज़षेक्ट ड्ैर किकषे  औि Animate, Motion Paths, Set Motion Path Key मषेन्य ूकमांड का इसतषेमाल किकषे  एक मोशन पाथ बना सकतषे 

हैं। ्यह कमांड मौजदूा टाइम फ्षे म कषे  वलए र्यवनत ऑबज़षेक्ट हषेतु मोशन पाथ key िख दषेती ह।ै ऑबज़षेक्ट को वकसी अन्य लोकषे शन पि लषे जानषे औि इस 

कमांड का वफि सषे इसतषेमाल किनषे सषे एक औि key का वनमा्भण होता ह ैऔि key को जोडनषे वाला कव्भ खींरा जाता ह।ै हिषे क मोशन पाथ key कव्भ पि एक 

पवाइंट कषे  रूप में काम किती ह।ै वरत्र 3-16 में कई मोशन पाथ keys कषे  साथ एक सफषे ्यि मोशन पाथ पि रलता हुआ वदखा्या र्या ह।ै

तित्र 6.1.75: तित्र 3-16

Motion ड्ॉ ्करना 

आप वकसी NURBS कव्भ का इसतषेमाल एक मोशन पाथ कषे  रूप में कि सकतषे हैं। वडफॉलट रूप सषे, NURBS कव्भ पि पहला वबंदु संलगन ऑबज़षेक्ट कषे  वलए 

आिंर पवाइंट वरवनित किता ह।ै आप Create मषेन्य ूमें पा्यषे र्यषे वकसी कव्भ वक्रएशन टूल का इसतषेमाल किकषे  मोशन पाथ बना सकतषे हैं, वजसमें CV Curve 

tool, EP Curve tool, तथा Pencil Curve tool शावमल होतषे हैं। 

र्कसी Motion Path से ऑबज़ेकट अटचै/ संिगन ्करना 

वकसी मोशन पाथ सषे कोई ऑबज़षेक्ट जोडनषे कषे  वलए, आपको पहलषे वषे ऑबज़षेक्ट ्या ऑबज़षेक्ट्ससलषेक्ट किनषे होंरषे, जो अटरै किनषे ह ैऔि वफि उस NURBS 

पाथ का र्यन किना होरा वजसका इसतषेमाल आप मोशन पाथ कषे  वलए किना राहतषे हैं। मोशन पाथ कव्भ हमषेशा आवखिी में सलषेक्ट किना रावह्यषे। अंवतम 

र्यन होना रावहए। Animate, Motion Paths, Attach to Motion Path मषेन्य ूकमांड का र्यन किें । वरत्र 3-17 में एक NURBS सफषे ्यि वदखा्या र्या ह,ै वजसषे 

मोशन पाथ सषे जोडा र्या ह।ै Play Forward बटन पि वक्लक किनषे सषे वदखता ह,ै वक कैसषे वह सफषे ्यि उस पिूषे  मोशन पाथ पि रल िहा ह।ै
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तित्र 6.1.76: तित्र 3-17

अटचैि Motion Path ्को एिजसट ्करना 

जब कोई वसतु वकसी मोशन पाथ सषे अटरै की जाती ह,ै तो आप Time Slider ड्ैर किकषे  मोशन पाथ पि उस ऑबज़षेक्ट को मूव किा सकतषे हैं। अटचैड मोशन 

पाथ एडजसट किनषे कषे  वलए, आप Move tool कषे  साथ अटचैड ऑबज़षेक्ट को मूव किा सकतषे हैं औि Animate, Motion Paths, Set Motion Path Key मषेन्य ू

कमांड की मदद सषे एक न्या मोशन पाथ बना सकतषे हैं। वरत्र 3-18 एक मौज़दूा अटचैड पाथ में की रई एडजसटमेंट को दशा्भता ह।ै

तित्र 6.1.77: तित्र 3-18
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Motion Path पर चि्त ेहुए र्कसी ऑबज़ेकट ्की रििॉरमिंग 

जब कोई वसतु वकसी मोशन पाथ का अनुसिण किती ह,ै तो आप ऑबज़षेक्ट का र्यन कि सकतषे हैं औि Constrain, Motion Paths, Flow Path Object मषेन्य ू

कमांड का र्यन कि सकतषे हैं। ्यह कमांड र्यवनत ऑबज़षेक्ट कषे  रािों ओि एक लवैटस प्रकट किता ह।ै मोशन पाथ पि बढनषे पि ्यह लवैटस ववरूवपत हो 

जाता ह।ै इस लवैटस को ऑलटि किकषे , इस बात पि वन्ंयत्रण िख सकतषे हैं, वक मोशन पाथ का अनुसिण कितषे हुए ऑबज़षेक्ट वडफॉम्भ  कैसषे होरा। वरत्र 3-19 

में एक टोिस ऑबज़षेक्ट वदखाई पडता ह,ै जो अपनषे रािों ओि वसथत लवैटस कषे  साथ मोशन पाथ का अनुसिण किता ह।ै

तित्र 6.1.78: तित्र 3-19

ट्युटोररयि 1: Motion Path बनाना 

1. चरण 1: Create, NURBS Primitives, Cone मषेन्य ूकमांड की मदद सषे NURBS कोन ऑबज़षेक्ट का वनमा्भण किें । 

2. चरण 2: Animate, Motion Paths, Set Motion Path Key मषेन्य ूकमांड का र्यन किें । 

तित्र 6.1.79: तित्र 3-20
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3. चरण 3: Time Slider को फ्षे म 5 पि ड्ैर किें  औि कोन को उसकी मौजदूा वसथवत सषे दूि ड्ैर किें । 

4. चरण 4: Constrain, Motion Paths, Set Motion Path Key मषेन्य ूकमांड का वफि सषे र्यन किें ।

5. चरण 5: रिण 3 औि 4 को कई औि बाि दुहिाएँ। प्रत्यषेक की मोशन पाथ कषे  वलए एक कव्भ पवॉइंट की तिह काम किती ह।ै

6. चरण 6: Play Forward बटन दबाएँ। कोन ऑबज़षेक्ट्स मोशन पाथ कव्भ का अनुसिण किता ह,ै जसैा वक वरत्र 3.20 में वदखा्या र्या ह।ै

7. चरण 7: File रुनें, Save Scene As रुनें औि फाइल को path.mb कषे  रूप में सषेव किें ।

रििॉलट पसटिपेरकटि वयू पनैि ्ेक अनय अियि:

• पनैल पि नीरषे persp वलखा होता ह ैजो दशा्भता ह ैवक आप पस्भपषेवक्टव कैमिा व्य ूसषे Maya 

सीन दषेख िहषे हैं।

• पनैल कषे  ऊपिी बाएँ कोनषे पि पनैल का अपना मनै्य ूबाि होता ह।ै ्यषे मषेन्य ूआपको उस 

वववशष्ट पनैल सषे संबंवित टूल औि फंक्शन कषे  एक्सषेस दषेतषे हैं।

• दो मोटी िषे खाओ ंकषे  साथ वगड वडसपलषे होता ह,ै जो मा्या सीन कषे  कें रि में एक-दूसिषे  को 

काटती हैं। सेंट्ल लोकषे शन ओरिवजन कहलाती ह।ै ओरिवजन Maya की 3D दुवन्या का 

कें रि होता ह ैऔि सरी वसतु कषे  वदशातमक मानों की माप इसी सथान सषे की जाती ह।ै

Maya में, अन्य कई 3D एवपलकषे शनों की तिह ही, तीनों आ्यामों को X, Y औि Z अक्ों कषे  रूप 

तित्र 6.1.80: पसटिपेतकटि व्ू

में वदखा्या जाता ह।ै ओरिवजन 0, 0, 0 की X, Y, Z पोवजशन पि वसथत होता ह।ै वगड री X, Z पलषेन पि वसथत होती ह।ै हम इसषे पलषेन कहतषे हैं क््योंवक आप 

इस 3D पोवजशन कषे  अनुवदश वसथत एक कालपवनक, समतल, वद्-आ्यामी वर्भ दषेख सकतषे हैं।

Maya X, Y औि Z अक्ों को एक कलि सकीम में प्रदवश्भत किता ह:ै X कषे  वलए लाल, Y कषे  वलए हिा औि Z कषे  वलए नीला। Maya इस कलि सकीम का 

इसतषेमाल ्यह दशा्भनषे में किता ह ैवक आप उस ववशषेष आइटम को एक्सषेस कि िहषे हैं जो कु् हद तक X, Y औि Z सषे संबंवित ह।ै

तित्र 6.1.81: 3D व्ू

मेन मेनयू बार

Maya में मनै्य ू, मनै्य ूसषेट में समूवहत होतषे हैं। इन मषेन्य ूसषेट का प्र्योर मषेन मषेन्य ूबाि सषे वक्या जाता है

मषेन मषेन्य ूबाि Maya टाइटल बाि कषे  नीरषे सीिषे Maya इंटिफषे स कषे  ऊपि प्रदवश्भत होता ह ैऔि र्यवनत मषेन्य ूसषेट 

प्रदवश्भत किता ह।ै प्रत्यषेक मषेन्य ूसषेट Maya कषे  अंदि एक मॉड््यलू सषे संबंवित होता ह:ै Animation, Polygons, 

Surfaces, Rendering औि Dynamics मॉड््यलूस संबंवित ववशषेषताओ ं औि टूलस को समूवहत किनषे की एक 

वववि ह।ै 

तित्र 6.1.82: मुखय सिेकटर

ज्योंही अप मषेन्य ूसषेट कषे  बीर वसवर कितषे हैं, मषेन्य ूका दा्याँ रार बदल जाता ह,ै लषेवकन बा्याँ रार ्यूं ही बना िहता ह;ै बा्याँ मषेन्य ूसरी मषेन्य ूसषेट कषे  वलए 

समान होतषे हैं। बाई ंओि कषे  मषेन्य ूमें File, Edit, Modify, Create, Display, तथा Window, होतषे हैं।
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तित्र 6.1.83: मेनयू

रिरशष्ट मेनयू सेट सिकेट ्करने ्ेक रिए

• Status line पि, ड्ॉप-डाउन मषेन्य ूसषे Animation सलषेक्ट किें । Main Menu, Animation मॉड््यलू सषे जुडषे  मषेन्य ूप्रदवश्भत किनषे कषे  वलए बदल जाता ह।ै 

ववशषेष रूप सषे, मषेन्य ूटाइटल जसैषे Animate, Deform, Skeleton, Skin इत्यावद प्रदवश्भत होतषे हैं।

• मषेन्य ूसलषेक्टि की मदद सषे, ड्ॉप-डाउन सरूी सषे Polygons रुनें। Main Menu, Polygons कषे  वलए मषेन्य ूसषेट दशा्भनषे कषे  वलए बदल जाता ह।ै मषेन्य ूटाइटल 

जसैषे Select, Mesh, Edit Mesh इत्यावद प्रदवश्भत होतषे हैं।

Polygons मेनयू सेट से रप्ररमरटि 3D ऑबजेट बनाने ्ेक रिए

तित्र 6.1.84: तप्रतमरटि 3D ऑबजे़कट 

• Create > Polygon Primitives > Interactive Creation सलषेक्ट किें  औि सुवनवश्चत किें  वक इस आइटम 

कषे  बरल में रषेकमाक्भ  प्रदवश्भत नहीं ह।ै

• Main Menu बाि सषे, Create > Polygon Primitives > Cube सलषेक्ट किें । Maya 3D क््यबू वप्रवमवटव 

ऑबज़षेक्ट का वनमा्भण किता ह ैऔि इसषे Maya वक्भ पलषेस कषे  सेंटि (ओरिवजन) में िखता ह।ै

Status Line

Status Line में, जो Main Menu बाि कषे  ठीक नीरषे वसथत होता ह,ै अनषेक प्रकाि कषे  आइटम होतषे हैं, वजनमें सषे अविकांश का इसतषेमाल Maya में मॉडषेवलंर ्या 

ऑबज़षेक्ट्स कषे  साथ काम किनषे कषे  दौिान वक्या जाता ह।ै अविकांश Status Line आइटम गावफकल आइकन द्ािा वनरूवपत होतषे हैं। आइकन Maya 

इंटिफषे स में सथान की बरत कितषे हैं औि ज्यादा इसतषेमाल होनषे वालषे टूलस कषे  वलए तवरित एक्सषेस की सुवविा दषेतषे हैं।

तित्र 6.1.85: Status line

• Status line पि पहला आइटम: मषेन्य ूसषेट कषे  बीर रुननषे कषे  वलए Menu Selector का इसतषेमाल वक्या जाता ह।ै

• सक्भ ल वकए हुए आइकन का दूसिा समूह दृश्य को वनरूवपत किता ह ैऔि इसका इसतषेमाल आपकषे  Maya दृश्यों का वनमा्भण किनषे, खोलनषे औि सषेव 

किनषे में वक्या जाता ह।ै

• बटनों कषे  तीसिषे  औि रौथषे समूह का उप्योर ्यह वन्ंयवत्रत किनषे कषे  वलए वक्या जाता ह ैवक आप वकस प्रकाि ऑबज़षेक्ट औि ऑबज़षेक्ट कषे  अव्यवों का 

र्यन कितषे हैं। आप बाद कषे  पाठों में ऑबज़षेक्ट कषे  र्यन कषे  बािषे  में औि अविक सीखेंरषे।

• आइकन कषे  पाँरवें समूह का प्र्योर ऑबज़षेक्ट औि अव्यवों कषे  वलए सनपै मोड कषे  वन्ंयत्रण कषे  वलए वक्या जाता ह।ै आप इस अध्या्य में बाद कषे  पाठ में 

इन टूलस का इसतषेमाल किना शुरू किें रषे।

• अंवतम खंड में तीन बटन हैं वजसका इसतषेमाल एवडटस्भ को वदखानषे औि व्पानषे कषे  वलए वक्या जाता ह,ै वजसमें Attribute Editor, Channel Box, Layer 

Editor औि Tool Settings शावमल हैं। 

तित्र 6.1.86: िाइन
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तित्र 6.1.87: बार

शेलि

शषेलफ Status line कषे  ठीक नीरषे वसथत होता ह।ै Maya शषेलफ उन टूल औि आइटम को सटोि 

किनषे कषे  वलए उप्योरी ह,ै वजनका उप्योर आप बाि-बाि कितषे हैं ्या वजनहें आपनषे अपनषे 

प्र्योर कषे  वलए कसटमाइज़ वक्या ह।ै आप बाि-बाि इसतषेमाल वक्यषे जानषे वालषे टूल औि 

आइटम को ऐसी लोकषे शन पि िख सकतषे हैं, जहां सषे ्यषे करी री आसानी सषे एक्सषेस वक्यषे 

जा सकें । Maya में आपकषे  इसतषेमाल कषे  वलए कु् आइटम पहलषे सषे कॉवनफरि वकए हुए 

होतषे हैं।
तित्र 6.1.88: शेल्फ

शेलि से टूि ्का प्रयोग ्कर्ेक ऑबज़ेकट बनाना

• शषेलफ सषे, Surfaces टवै सलषेक्ट किें  तावक उस शषेलफ पि वसथत टूल दषेख सकें ।

• Create > NURBS Primitives > Interactive Creation सलषेक्ट किें  औि सुवनवश्चत किें  वक आइटम कषे  बरल में रषेकमाक्भ  प्रदवश्भत नहीं ह।ै

• शषेलफ सषे, NURBS सफषे ्यि आइकन को वक्लक किकषे  सलषेक्ट किें , जो बाएं वसिषे  पि वसथत ह।ै

• Maya सफषे ्यि वप्रवमवटव ऑबज़षेक्ट का वनमा्भण किता ह ैऔि क््यबू कषे  ही समान पोवजशन में Maya वक्भ सपषेस कषे  कें रि में िखता ह।ै

तित्र 6.1.89: Surface टवैब सिेकट करना

तित्र 6.1.90: टूि पॉप-अप

 जब ऑबज़षेक्ट इस तिह वदखाई दषेता ह,ै तो हम इसषे सलषेक्टषेड ्या एवक्टव कहतषे हैं।

तित्र 6.1.91: ऑबजे़कट
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Channel Box रदखाने या रछपाने ्ेक रिए

• Channel Box व्पानषे कषे  वलए, Status line कषे  दाएं वसिषे  सषे Show/Hide Channel Box आइकन पि वक्लक किें ।

• Channel Box रा्यब हो जाता ह ैऔि पस्भपषेवक्टव सीन व्य ूथोडा फैल जाता ह।ै व्पषे हुए Channel Box कषे  साथ, आपकषे  पास सीन व्य ूमें काम किनषे कषे  

वलए अविक जरह ह।ै

तित्र 6.1.92: Channel box

• Channel Box वदखानषे कषे  वलए, Status line कषे  दाएं वसिषे  सषे Show/Hide Channel Box आइकन पि वक्लक किें । Channel Box सीन व्य ूमें वदखाई  

दषेता ह।ै

अपना ्कायटि सेि ्करना

• Maya प्रोजषेक्ट कषे  साथ काम कितषे सम्य अपनषे का्य्भ  को बाि-बाि सषेव किनषे की आदत डालें। इस तिह सषे, कोई रलती होनषे पि आप अपनषे का्य्भ  का 

पुिाना वज्भन खोल सकतषे हैं।

• आपकषे  द्ािा वक्भ सपषेस पि बनाई रई हि रीज़ को Maya सीन कषे  रूप में प्रसतुत किता ह।ै इसमें ऑबज़षेक्ट, लाइट, कैमिा औि आपकी का्य्भ  सषेशन सषे 

जुडी सामवग्याँ शावमल होती हैं।

अपना Maya सीन सेि ्करने ्ेक रिए

• File > Save Scene सलषेक्ट किें ।

• फाइल रिाउज़ि प्रकट होता ह,ै वजसमें वडफॉलट डा्यिषे क्टिी सरूीबद्ध होता ह ैजहाँ आप अपना सीन सषेव कि सकतषे हैं।

• टाइप: फाइल नषेम टषेक्सट बॉक्स में Lesson1 टाइप किें ।

• सषेव पि वक्लक किें ।

Maya आपकी फाइल को आपकषे  Maya वडफॉलट प्रोजषेक्ट डा्यिषे क्टिी कषे  अंदि सीन डा्यिषे क्टिी में सषेव किता ह।ै Maya ओटोमवैटक रूप सषे .mb ऐक्सटेंशन 

कषे  साथ फाइल सषेव किता ह।ै .mb ऐक्सटेंशन दशा्भता ह ैवक सीन Maya बाइनिी फाइल कषे  रूप में सषेव हुआ था: ्यह Maya सीन कषे  वलए वडफॉलट फाइल 

टाइप होता ह।ै

Maya से एरकज़ट ्करना

इससषे पहलषे वक आप Maya सषे बाहि वनकलें, सुवनवश्चत किें  वक आपनषे उस का्य्भ  को सषेव कि वल्या ह ैवजसकी आपको बाद में री ज़रूित ह ैऔि वजस पि 

आप बाद में री काम ज़ािी िखना राहतषे हैं।

Maya से एरकज़ट ्करने ्ेक रिए

• मषेन मषेन्य ूसषे File > Exit सलषेक्ट किें । 

Maya वनमनवलवखत दो में सषे कोई एक का्य्भ  किता ह:ै

• ्यवद आप Exit सषे तुिंत पहलषे अपना सीन सषेव कितषे हैं, तो Maya बाहि वनकल जाता ह।ै

• ्यवद आपनषे अपना सीन हाल में सषेव नहीं वक्या ह,ै तो सक्रीन पि ्यह पू् तषे हुए मसैषेज प्रॉमपट प्रदवश्भत होता ह ैवक आप अपनषे परिवत्भनों को सषेव किना 

राहतषे हैं ्या नहीं। Save, Don’t Save ्या Cancel पि वक्लक किें ।
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यूरनट 6.2: ऑबज़ेकट बनाना, मरैनपुिटे ्करना ्त्था दखेना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

• 3D वप्रवमवटव ऑबज़षेक्ट बनानषे में।

• मषेवनपुलषेशन औि एवडवटंर कषे  उद्षेश्यों कषे  वलए ऑबज़षेक्ट सलषेक्ट किनषे में।

• अपनषे माउस की मदद सषे ऑबज़षेक्ट को वखसकानषे (मूव) औि घुमानषे (िोटषेट) में।

6.2.1 नया सीन बनाना

6.2.2 रप्ररमरटि ऑबज़ेकट

न्या खाली सीन बनाकि टषेपमलषेट प्रोजषेक्ट शुरू किें । न्या सीन बनानषे कषे  वलए:

• Maya सटाट्भ  किें  (्यवद ्यह पहलषे सषे नहीं रल िहा तो):

» Maya सटाट्भ  होनषे पि, ्यह अपनषे आप एक न्या सीन बनाता ह।ै

» ्यवद Maya पहलषे सषे िन कि िहा था, तो रिण 2 औि 3 अपनाएँ।

• मषेन मषेन्य ूसषे, File > New Scene सलषेक्ट किें ।

• Maya वनमनवलवखत प्रॉमपट प्रदवश्भत किता ह।ै

• No पि वक्लक किें । Maya एक न्या सीन बनाता ह ैऔि वप्लषे सीन की हि रीज़ों को वडलीट कि दषेता ह।ै

Maya अनषेक प्रकाि कषे  वप्रवमवटव टाइप औि शषेप प्रदान किता ह ैजसैषे क््यबू, सफषे ्यि, वसवलंडि औि पलषेन।

तित्र 6.2.1: प्रोजेकट

तित्र 6.2.2: सीन सेि करना

तित्र 6.2.3: तप्रतमरटि ऑबजे़कट

यूरनट ्ेक उद्ेशय  
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बेस ्ेक रिए पॉरिगोन रसरिंिर बनाने ्ेक रिए

• Polygons मषेन्य ूसषेट सलषेक्ट किें

• मषेन मषेन्य ूसषे, Create > Polygon Primitives > Cylinder > _सलषेक्ट किें , एक ववकलप ववंडो प्रदवश्भत होता ह।ै

• Polygon Cylinder Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत ववकलप सषेट किें :

» िषे वड्यस (वत्रज्या): 10

» ऊंराई: 1

» अक् खंड: 8

» उंराई ववराजन/वर्भ: 1

» कैप खंड: 1

» एवक्सस/अक्: Y

• Polygon Cylinder Options ववंडो में, Create पि वक्लक किें ।

• Maya एक वसवलंडि वप्रवमवटव ऑबज़षेक्ट बनाता ह ैजो आकाि में ऑक्टोरोनल होता ह ैऔि Maya वक्भ सपषेस कषे  बीर वसथत होता ह।ै ्यह वसवलंडि 20 

इकाई रौडा औि एक इकाई ऊंरा होता ह ैऔि इसकषे  आठ पषृ्ठ रार होतषे हैं।

6.2.3 टूिबॉकस
टूिबॉकस: िआेउट शॉटटि्कट

टूलबॉक्स Maya ्यजू़ि इंटिफषे स सषे बाई ंओि वसथत होता ह।ै इसमें वसैषे आइकन मौजदू होतषे हैं 

जो आपकषे  ऑबज़षेक्ट को Maya में रूपांतरित किनषे कषे  वलए (सषेलषेक्शन, मूव, िोटषेट, सकषे ल) 

औि व्य ू औि पनैल लषेआउट बदलनषे कषे  वलए लषेआउट शॉट्भकट कषे  टूलस खोलतषे हैं Quick 

Layout बटन शॉट्भकट आपको एक अलर पनैल सलषेक्ट किनषे ्या अन्य लषेआउट पि जानषे की 

अनुमवत दषेतषे हैं।

• टूलबॉक्स सषे, Four View लषेआउट शॉट्भकट पि वक्लक किें ।

तित्र 6.2.4: तसपिंिर

तित्र 6.2.5: टूिबॉकस



167166

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

• वक्भ सपषेस फोि-व्य ूलषेआउट में बदल जाता ह।ै पस्भपषेवक्टव व्य ूऊपिी दाएँ कोनषे में वसथत होता ह ैऔि अन्य व्य ूऑबज़षेक्ट को ऊपि, सामनषे औि बरल सषे 

वदखातषे हैं।

• साइड व्य ूको बडा किनषे कषे  वलए, साइड व्य ूपि माउस कस्भि िखें औि अपनषे कीबोड्भ  का सपषेसबाि टपै किें ।

टूिबॉकस: ट्ांसिॉममेशन टूलस

• आपको आिाि को Y वदशा में थोडा ऊपि लषे जाना होरा, तावक ्यह X, Z पलषेन पि वसथत हो जाए। ऐसा किनषे 

कषे  वलए Move ट्ांसफॉमदेशन टूल का प्र्योर किें  जो टूलबॉक्स में वसथत होता ह।ै

• टूल का नाम Maya ववंडो कषे  नीरषे Help Line में री प्रदवश्भत होता ह।ै

ऑबज़ेकट ्का रसिकेशन और िी-रसिकेशन

• इससषे पहलषे वक आप वकसी ऑबज़षेक्ट को रूपांतरित किें , आपको सुवनवश्चत किना होरा वक ्यह सलषेक्ट वक्या हुआ ह।ै ऑबज़षेक्ट को डीसलषेक्ट किनषे 

कषे  वलए, सलषेक्ट वकए हुए क्षेत्र कषे  बाहि कही री वक्लक किें ।

तित्र 6.2.6: फोर व्ू

तित्र 6.2.7: ट्ांसफॉममेशन टूल्स

तित्र 6.2.7: शॉटटिकट की

तित्र 6.2.7: ऑबजेकट रूपांिररि करें
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सीि नयू में बेस रप्ररमरटि सिकेट ्करने ्ेक रिए

• अपनषे बाएं माउस बटन की मदद सषे, सीन व्य ूमें ऑबज़षेक्ट कषे  वा्यिफ्षे म आउटलाइन पि वक्लक किें ।

• अपनषे बाएं माउस बटन सषे, ऑबज़षेक्ट वा्यिफ्षे म कषे  एक कोनषे का बाउंवडंर बॉक्स ्या वकनािा ड्ैर किें ।

जब वा्यिफ्षे म आउटलाइन का िंर रमकतषे हिषे  िंर में प्रदवश्भत होनषे लरता ह ैतो ्यह सलषेक्ट हो जाता ह।ै ्यवद ्यह सलषेक्ट नहीं होता ह,ै तो इसका िंर रहिषे  

नीलषे िंर का होता ह।ै

बेस/आधार ्की पोज़ीशन एिजसट ्करने ्ेक रिए Move Tool ्का उपयोग ्करने ्ेक रिए

• टूलबॉक्स सषे Move Tool सलषेक्ट किें ।

• मूव मषेवनपुलषेटि आइकन सीन व्य ूमें वप्रवमवटव वसवलंडि पि प्रदवश्भत होता ह।ै

• साइड व्य ूमें, वप्रवमवटव वसवलंडि को Y वदशा में ऊपि की ओि लषे जानषे कषे  वलए हिा Y मषेवनपुलषेटि हैंडल ड्ैर किें । इसषे प्या्भप्त ऊपि किें  तावक बषेस 

वसवलंडि का वनरला रार X अक् की लाइन में आ जाए।

अब बषेस वसवलंडि को थोडा घुमाना पडता ह ैवजससषे बषेस का आरषे का रार वगड लाइन कषे  समानांति हो जाता ह।ै रूंवक ऑक्टारोन (अष्ठफलक) का प्रत्यषेक 

फलक वतृ्त का 45 वडगी वनरूवपत किता ह,ै इसवलए आपको इसका लररर आिा घुमाना होता ह ैअथा्भत 22.5 वडगी।

आधार (बेस) ्की पोज़ीशन एिजसट ्करने हे्तु Rotate Tool ्का उपयोग ्करने ्ेक रिए

• व्य ूमें माउस कस्भि िखकि औि अपनषे कीबोड्भ  का सपषेसबाि टपै किकषे  सरी राि व्य ूप्रदवश्भत किें । राि दृश्य वाला पनैल/फोि व्य ूपनैल प्रदवश्भत  

होता ह।ै

• माउस कस्भि टॉप व्य ूपि िखें औि एक बाि सपषेसबाि टपै किें । टॉप व्य ूवक्भ सपषेस में वदखाई पडता है

तित्र 6.2.8: Moov टूि का प्रयोग करें

• बषेस वसवलंडि वसलषेक्ट वक्यषे हुए ही, टूलबॉक्स सषे Rotate टूल रुनें। सीन व्य ूमें वप्रवमवटव 

वसवलंडि पि िोटषेट मषेवनपुलषेटि आइकन प्रदवश्भत होता ह।ै

• टॉप व्य ूमें, वप्रवमवटव वसवलंडि को घुमानषे कषे  वलए हिा Y मषेवनपुलषेटि रिंर ड्ैर किें  तावक बषेस 

वसवलंडि का एक फलक वगड कषे  साथ संिषे वखत हो जाए जसैा वक नीरषे कषे  वरत्र में वदखा्या 

र्या ह।ै आप वसवलंडि को इसकषे  Y अक् कषे  रािों ओि घुमा िहषे हैं।

तित्र 6.2.9: रोटेट मेतनपुिेटसटि

तित्र 6.2.10: टॉप व्ू
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6.2.4 Channel Box

Channel Box एक एवडवटंर पनैल ह ैजो आपको वकसी ऑबजषेक्ट की रूपांतिण सरूना इत्यावद प्रदान किता ह।ै ्यह वकसी री प्रकाि कषे  ऑबजषेक्ट कषे  वलए 

तीन अलर-अलर क्षेत्रों पि सरूना प्रदान किता ह:ै ट्ांसफॉमदेशन नोड, शषेप नोड औि इनपुट नोड।

Channel Box ्की मदद से बेस ्को मूि और रोटटे ्करने ्ेक रिए

• बषेस वसवलंडि को वसलषेक्ट वक्यषे हुए ही, Channel Box में ट्ांसफॉमदेशन ऐवट्व्यटू 

दषेखें। ववशषेष रूप सषे, Translate Y औि Rotate Y कषे  मान दषेखें।

• Channel Box में, फीलड पि वक्लक किकषे  औि सही सांवख्यक मान डालकि 

ऐवट्ब्यटू मानों को इस प्रकाि एडजसट/समा्योवजत किें  वक वषे ऊपि कषे  वरत्र कषे  

साथ मषेल खानषे लरें। इससषे बषेस आपकषे  Maya सीन में सही तिीकषे  सषे वसथत हो 

जाता ह।ै

• Maya नषे वसवलंडि वप्रवमवटव को नाम दषे वद्या था, जब ्यह पहली बाि बना था। 

वसवलंडि को िीनषेम किें , जो आपकषे  प्रोजषेक्ट कषे  वहसाब सषे ज्यादा अथ्भपणू्भ  हो।

Channel Box ्की मदद से रसरिंिर रप्ररमरटि ्को रीनेम ्करें

• Channel Box में, pCylinder1 नाम वालषे फीलड पि वक्लक किें ।

• न्या नाम: templeBase टाइप किकषे  वप्रवमवटव ऑबजषेक्ट का नाम बदलें औि एंटि दबाएँ।

6.2.5 ऑबजेकट ्का िुर्पि्ेकट बनाना

वकसी मौजदूा ऑबजषेक्ट का डुवपलकषे ट बनाना, इसषे पिूा वफि सषे बना्यषे वबना ही, इसकी हू-ब-हू कॉपी बनानषे की एक उप्योरी वववि ह।ै जब आप वकसी 

आइटम का डुवपलकषे ट बनातषे हैं तो कॉपी में मूल की ववशषेषताएँ समावहत होती हैं। Duplicate टूल की मदद सषे आप कॉपी पि अवतरिक्त ट्ांसफॉमदेशन (move, 

rotate, scale) एपलाई कि सकतषे हैं।

टमे्पिटे बेस िुर्पि्ेकट ्करने ्ेक रिए

• व्य ू में माउस कस्भि िखकि औि सपषेसबाि टपै किकषे  सरी राि व्य ू प्रदवश्भत किें । वफि इस व्य ू में बषेस प्रदवश्भत किनषे कषे  वलए पस्भपषेवक्टव व्य ू में  

वक्लक किें ।

• सलषेक्ट हुए मषेन मषेन्ुय सषे templeBase कषे  साथ, Edit > Duplicate Special > रुनें। Duplicate Special Options ववंडो प्रदवश्भत होती ह।ै

• Duplicate Special Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत ववकलप सषेट किें :

» ट्ांसलषेट: 0 1.0 0

» िोटषेट: 0 0 0

तित्र 6.2.11: तखसकाएुँ और घुमाएुँ (Move और Rotate)

तित्र 6.2.12: तप्रतमरटि ऑबजेकट का नाम बदिें/रीनेम
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» सकषे ल: 0.9 1.0 0.9

» ज्योमषेट्ी का प्रकाि: कॉपी

» गुप अंडि: पषेिें ट

• Duplicate Options ववंडो में, Duplicate Special पि वक्लक किें ।

Maya templeBase ऑबजषेक्ट का एक डुवपलकषे ट बनाता ह ैजो X, Z अक्ों में मूल कषे  सकषे ल का 0.9 होता 

ह ैऔि templeBase सषे एक ्यवूनट ऊपि होता ह।ै सकषे ल ऑपिषे शन कषे  परिणामसवरूप, टषेमपलषेट कषे  वलए 
बषेस अब सटषेपड रूप में प्रदवश्भत होता ह।ै

Maya मूल नाम कषे  आिाि पि डुवपलकषे ट ऑबजषेक्ट कषे  नाम का ट्कै िखता ह ैऔि डुवपलकषे ट हुए ऑबजषेक्ट का नाम बदलकि templeBase1 िखता ह।ै

तित्र 6.2.13: ्केपिंग

रट्पपरणयां 
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यूरनट 6.3: Maya 3D सीन दखेना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Maya सॉफटवषे्यि पि 3D एवनमषेशन तकनीकों कषे  एपलीकषे शन में - Maya 3D सीन दषेखना।

2. वक्भ पलो ओविव्य ूकषे  बािषे  में सववसताि बता्यें।

6.3.1 ्ैकमरा टूलस

अब तक कषे  पाठों में, जब आपनषे ऑबजषेक्ट को टॉप, फं्ट ्या साइड व्य ूसषे दषेखा, तो आप सीन को ऑथपोगावफक व्य ूकषे  जरिए दषेख िहषे थषे। ऑथपोगावफक व्य ू

वद्आ्यामी वदखता ह,ै क््योंवक ऑबजषेक्ट एक ही सम्य में कषे वल दो अक्ों कषे  समानांति प्रक्षेपों कषे  जरिए प्रदवश्भत होता ह।ै 

जब आप सीन को पस्भपषेवक्टव व्य ूकषे  जरिए दषेखतषे हैं, तो आप सीन को तीन-आ्यामी रूप में दषेखतषे हैं। पस्भपषेवक्टव व्य ूइस बात को वसम्ुयलषेट किता ह ैवक 

आपका सीन कैमिषे  की नज़ि सषे कैसी वदखषेरा।

पसटिपेरकटि वयू

Maya में, आप आरासी कैमिा कषे  सषेट कषे  जरिए सीन दषेखतषे हैं। ्यषे कैमिा ्या तो 

ऑथपोगावफक ्या पस्भपषेवक्टव होतषे हैं। Camera टूलस की मदद सषे आप एडजसट कि 

सकतषे हैं, वक इन कैमिों सषे सीन कैसषे वदखें।

तित्र 6.3.1: 2 ऐतकसस व्ू

तित्र 6.3.2: पसटिपेतकटि व्ू

यूरनट ्ेक उद्ेशय  
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6.3.2 ि्कटि फिो अििो्कन

कॉलम अनषेक वप्रवमवटव सषे बनषे होतषे हैं जो पोज़ीशन में मूवड, सकषे लड औि िोटषेटषेड होतषे हैं। जसैषे 

ही पहला कॉलम बनषे, प्रत्यषेक कॉमपोनेंट का नाम औि पोज़ीशन वबलकुल सही हो, आप इसषे 

समूवहत/गुप कि सकें रषे औि अन्य कॉलम बनानषे कषे  वलए डुवपलकषे ट कि सकें रषे।

पेिेसटि ्ेक रिए पॉरिगोन रसरिंिर बनाना

• मषेन मषेन्य ूसषे, Create > Polygon Primitives > Cube सलषेक्ट किें । 

• Polygon Cube Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि 

वनमनवलवखत ववकलप सषेट किें :

» रौडाई: 1.75

» ऊंराई: 0.6

» डषेपथ (रहिाई): 1.75

• अन्य रारों को उनकषे  वडफॉलट सषेवटंगस में िहनषे दें।

• Polygon Cube ववकलप ववंडो में, Create पि वक्लक किें ।

Maya कयूब रप्ररमरटि रनमाटिण ्कर्ता ह ैऔर इसे मूि (ओरररजन) पर रख्ता है

• साइड व्य ूमें, क््यबू को ऊपि की ओि मूव किें  (Y अक्) तावक ्यह टषेमपल बषेस की ऊपिी सतह पि वटक जाए। 

• Channel Box में, क््यबू का नाम बदलि (िीनषेम) columnPedestal िखें।

शाफट ्ेक रिए पॉरिगोन रसरिंिर बनाना

• मषेन मषेन्य ूसषे, Create > Polygon Primitives > Cylinder > _ सलषेक्ट किें ।

• Polygon Cylinder Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि 

वनमनवलवखत ववकलप सषेट किें :

» िषे वड्यस (वत्रज्या): 0.5

» ऊंराई: 6

» अक् खंड: 1

» अन्य रारों को उनकषे  वडफॉलट सषेवटंगस में िहनषे दें

» Polygon Cylinder Options ववंडो में, Create पि वक्लक किें ।

तित्र 6.3.3: पहिा कॉिम नाम

तित्र 6.3.4: पेिे्टि के तिए पॉतिगोन कयूब

तित्र 6.3.5: शाफट के तिए पॉतिगोन तसपिंिर
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6.3.3 ऑबजेकट ्का समूहन (रिुरपंग)

• साइड व्य ूमें, वसवलंडि को ऊपि की ओि मूव किें  (Y अक्) तावक ्यह columnPedestal की ऊपिी सतह पि वटक जाए।

• Channel Box में, क््यबू का नाम बदल कि columnShaft िखें।

शिैेि मोि में ऑबजेकट दखेना

अरी तक, आप ऑबजषेक्ट को वडफॉलट वा्यिफ्षे म में दषेख िहषे थषे। वा्यिफ्षे म मोड में, ऑबजषेक्ट सािािण वा्यि आउटलाइन को ्ोडकि पािदशशी वदखाई दषेता 

ह ैजो उनकी पोज़ीशन औि सामान्य आकाि को दशा्भता ह।ै Maya शडैषेड रूप में ऑबजषेक्ट प्रदवश्भत किनषे कषे  वलए अनषेक ववकलप प्रदान किता ह।ै

अपनषे सीन का वडसपलषे इस प्रकाि बदलें तावक ऑबजषेक्ट शडैषेड ऑबजषेक्ट की तिह वदखाई दषे।

समू्थ शिैेि मोि में ऑबजेकट प्रदरशटि्त ्करने ्ेक रिए

• पस्भपषेवक्टव व्य ूबडा/एनलाज्भ किें  औि सीन को डॉली औि टंबल किें  तावक आप आसानी सषे दषेख सकें  वक अब तक आपनषे क््या-क््या वक्या ह।ै

• पनैल मषेन्य ूसषे, Shading > Smooth Shade All सलषेक्ट किें । आपनषे सीन में ऑबज़षेक्ट्स अपािदशशी रहिषे  िसूि िंर में प्रदवश्भत होंरषे। इस पाठ कषे  शषेष 

वहससषे में आप ऑबजषेक्ट कषे  साथ ्या तो शडैषेड ्या अनशडैषेड मोड में काम कि सकतषे हैं।

जब आपको अनषेक ऑबजषेक्ट को एक ्यवूनट कषे  रूप में मूव, सकषे ल औि िोटषेट होता ह,ै तो आसान होता ह ै्यवद वषे एक साथ समूवहत हों वजससषे वषे एक ्यवूनट 

कषे  रूप में बदल जाएँ।

Maya में अविकांश वप्रवमवटव ऑबजषेक्ट समूवहत ऑबजषेक्ट कषे  रूप में होतषे हैं। उदाहिण कषे  वलए, NURBS क््यबू वप्रवमवटव में 6 समतल सक्वा्यि ्या पलषेन होतषे 

हैं जो एकसाथ एक ्यवूनट कषे  रूप में समूवहत होतषे हैं। जब पलषेन ऑबजषेक्ट एकसाथ समूवहत होतषे हैं, तो वषे एक अनुक्रम का वनमा्भण कितषे हैं।

अनुक्रम उन नोड्स ्या ऑबजषेक्ट का एक संकलन ह ैजो समान उद्षेश्य कषे  वलए एकसाथ वमलकि एक ्यवूनट बनातषे हैं। ऑबजषेक्ट्स उनकषे  अंदि की समान 

ववशषेषताएँ औि ऐवट्ब्यटू; उदाहिण कषे  वलए मूव, सकषे ल औि िोटषेट, वकस प्रकाि साझा किें , इसकषे  वण्भन किनषे कषे  वलए अनुक्रम उप्योरी होतषे हैं।

्कॉिम हे्तु ऑबजेकट्स ्को समूरह्त ्करने ्ेक रिए

• नीरषे वद्यषे र्यषे ववकलपों में सषे कोई एक किकषे , कॉलम बनानषे वालषे राि ऑबजषेक्ट एक साथ वसलषेक्ट किें :

» अपनषे बाएँ माउस बटन की मदद सषे, सीन व्य ूमें रािो ऑबजषेक्ट सषेलषेक्ट होनषे तक प्रत्यषेक ऑबजषेक्ट पि वशफट-वक्लक किें ।

» अपनषे बाएँ माउस बटन की मदद सषे, ऑथपोगावफ़क व्य ूमें कॉलम ऑबजषेक्ट्स कषे  रािों ओि एक बडा बाउंवडंर बॉक्स ड्ैर किें ।

» ्यह महतवपणू्भ  ह ैवक आप अपनषे वसलषेक्शन कषे  रार कषे  रूप में कोई templeBase सलषेक्ट न किें । ्यवद आप रलती सषे कोई बषेस ऑबजषेक्ट सलषेक्ट 

कि लषेतषे हैं तो उनहें डीसलषेक्ट किें ।

तित्र 6.3.6: शवैिेि मोि में ऑबजेकट
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• मषेन मषेन्य ूसषे, Edit > Group >_ सलषेक्ट किें ।

• Group ववकलप ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत ववकलप सषेट किें :

» गुप अंडि: पषेिें ट

» अन्य रारों को उनकषे  वडफॉलट सषेवटंगस में िहनषे दें

• Group Options window में, Group पि वक्लक किें ।

• Maya ऑबजषेक्ट को अनुक्रम (हाइिाकशी) में एकसाथ समूवहत किता ह।ै आनषे वालषे रिणों में आप अनुक्रम कषे  बािषे  में औि अविक सीखेंरषे।

6.3.4 Hypergraph
Hypergraph वह ववंडो ह ैजो दशा्भती ह ैवक आपकषे  सीन में नोड्स औि उनकषे  कनषेक्शन वकस प्रकाि व्यववसथत हैं। आप Hypergraph में ऑबजषेक्ट हाइिाकशी 

औि वडपेंडेंसीज दषेखतषे हैं। ्यह दषेखनषे कषे  वलए Hypergraph का उप्योर किें  वक जब आप ऑबजषेक्ट समूवहत कितषे हैं तो क््या होता ह।ै 

Hypergraph दखेने ्ेक रिए

• व्य ूमषेन्य ूसषे, Panels > Layouts > Two Panes Stacked सलषेक्ट किें । सीन व्य ूदो व्यइंूर पनैल में ववरावजत होता ह ै- प्रत्यषेक का अपना अलर व्य ूमषेन्य ू

होता ह।ै आप ऊपिी व्य ूमें सीन औि दूसिषे  में Hypergraph दषेखनषे कषे  वलए इनहें सषेट किें रषे।

• वनरलषे पनै मषेन्य ूसषे, Panels > Hypergraph Panel > Hypergraph Hierarchy सलषेक्ट किें । Hypergraph पनैल सीन व्य ूपनैल कषे  नीर प्रदवश्भत होरा।

• Hypergraph पनैल कषे  ऊपिी रार में, Scene Hierarchy आइकन रुनें तावक सुवनवश्चत कि सकें  वक Hypergraph सीन अनुक्रम प्रदवश्भत कि िहा ह।ै

• Hypergraph पनैल में, View > Frame All सलषेक्ट किें । Hypergraph सीन कषे  सरी ऑबजषेक्ट कषे  वलए अनुक्रम प्रदवश्भत किता ह।ै सीन में ऐवंटटीज 

दषेखनषे की ्यह वववि आपकषे  सीन कषे  सरी वववरनन नोड्स दषेखनषे कषे  वलए संपणू्भ  गावफकल एप्रोर प्रदान किती ह।ै

तित्र 6.3.7: Hypergraph देखना

तित्र 6.3.8: नोडस
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Hypergraph में पेरें ट मोि ्का नाम बदिने ्ेक रिए

• Hypergraph में, group1 नोड पि वक्लक किें  तावक ्यह एवक्टव हो जाए। सीन व्य ूमें, अनुक्रम कषे  ऊपिी (पषेिें ट) सति पि वसथत समूह सलषेक्ट किनषे पि 

कॉलम समूह कषे  सरी ऑबजषेक्ट सलषेक्ट हो जातषे हैं।

• Hypergraph में, group1 को वनरूवपत किनषे वालषे ऊपिी नोड पि िाइट-वक्लक किें  औि पॉप-अप मषेन्य ूसषे Rename वक्लक किें । नोड में एक ्ोटा 

टषेक्सट बॉक्स प्रकट होता ह।ै

• न्यषे नाम कषे  रूप में कॉलम एंटि किें । अब कॉलम समूवहत होता ह,ै आपको इसषे टषेमपल बषेस कषे  एक कोनषे पि िखना होरा।

्कॉिम ्को टमेपि बेस पर रखने ्ेक रिए

• अपनषे कीबोड्भ  पि 4 “की” टपै किकषे  ऑबजषेक्ट कषे  वडसपलषे को वा्यिफ्षे म मोड में बदलें। ्यह एक कीबोड्भ  शॉट्भकट होता ह।ै कमांड इवमपलमेंट किनषे कषे  

वलए मषेन्य ूसषे आइटम सलषेक्ट किनषे कषे  बदलषे आप वसंरल की का उप्योर कि सकतषे हैं।

• Hypergraph में, टॉप नोड में कॉलम सलषेक्ट किें  तावक कॉलम सीन व्य ूमें सवक्र्य हो जाए।

• सीन व्य ूमें, टषेमपल बषेस कषे  आरषे कषे  कोनषे पि कॉलम वसथत किनषे कषे  वलए Move टूल का उप्योर किें  जसैा नीरषे वदखा्या र्या ह।ै

पहलषे कॉलम कषे  पोज़ीशन में होनषे पि, आप कॉलम की कॉपी वक्रएट कि सकतषे हैं औि बषेस कषे  साथ वालषे कोनषे में पोज़ीशन कि सकतषे हैं।

्कॉिम ्की िुर्पि्ेकट ्कॉपी बनाने ्ेक रिए

• Hypergraph में कॉलम सलषेक्ट वक्यषे हुए ही, मषेन मषेन्य ूसषे Edit > Duplicate Special >_ रुनें।

» Duplicate Special Options ववंडो प्रदवश्भत होती ह।ै

• Duplicate Special Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत ववकलप सषेट किें :

» कॉपी की संख्या: 1

» अन्य रारों को उनकषे  वडफॉलट सषेवटंगस में िहनषे दें।

• Duplicate Special Options ववंडो में, Duplicate Special पि वक्लक किें ।

» Hypergraph व्य ूसीन में अवतरिक्त कॉलम ऑबजषेक्ट वदखानषे कषे  वलए अपडषेट होता ह।ै कॉपी मूल समूह का प्रीवफक्स नाम री लषे लषेती ह ैऔि ्यह 

Column1 नाम सषे लषेबल होती ह।ै

सीन व्य ू ्यह दशा्भता ह ै वक वासतव में कु् री डुवपलकषे ट नहीं हुआ था। जब कोई ऑबजषेक्ट वबना वकसी ट्ांसफॉमदेशन कषे  डुवपलकषे ट होता ह ै तो कॉपी 

ओरिवजनल कषे  समान ही पोज़ीशन होती ह।ै दोनों ऑबजषेक्ट एक दूसिषे  कषे  ऊपि िहतषे हैं।

तित्र 6.3.9: पोज़ीशन ककया हआ कॉिम
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िुर्पि्ेकट ्कॉिम ्को बेस पर पोज़ीशन ्करने हे्तु मूि ्करने ्ेक रिए

• Hypergraph में, सुवनवश्चत किें  वक Column1 इसकषे  टॉप नोड पि वक्लक किकषे  वसलषेक्ट वक्या जा्यषे, वजससषे ्यह सीन व्य ूमें सलषेक्टषेड हो जा्यषे।

• सीन व्य ूमें, टषेमपल बषेस कषे  बिाबि में कोनषे पि Column1 वसथत किनषे कषे  वलए Move टूल का उप्योर किें । 

• टूलबॉक्स सषे, Four View लषेआउट शॉट्भकट पि वक्लक किें । वक्भ सपषेस फोि-व्य ूलषेआउट में बदल जाता ह ैऔि Hypergraph अब प्रदवश्भत नहीं होता।

रसिकेशन मोि्स और मास्क

जब आप वकसी ऑबजषेक्ट को इसकषे  हाइिाकशी कषे  अंदि कषे  वकसी ववशषेष सति पि सलषेक्ट किना राहतषे हैं तो Hypergraph ववंडो को खोलकि िखना हमषेशा 

उप्योरी सावबत होता ह।ै Maya आपको आपकी ववशषेष ज़रूित कषे  अनुसाि वववरनन वसलषेक्शन मोड्स में आइटम सलषेक्ट किनषे की अनुमवत दषेता ह।ै

तीन मुख्य प्रकाि कषे  वसलषेक्शन मोड होतषे हैं: हाइिाकशी, ऑबजषेक्ट औि कॉमपोनेंट अन्य ऑबजषेक्ट कषे  वसलषेक्शन को सीवमत किनषे ्या मासक किनषे कषे  वलए 

आप इन मोड्स का उप्योर कि सकतषे हैं तावक कषे वल वही आइटम वसलषेक्ट हो जो आप राहतषे हैं। जब आप सषेलषेक्शन मासक का उप्योर का कितषे हैं तो 

आप उन आइटम को वफलटि कितषे हैं ्या मासक कितषे हैं वजनहें आप वसलषेक्शन में नहीं शावमल किना राहतषे हैं।

तित्र 6.3.10: पोज़ीशन में दो कॉिम

तित्र 6.3.11: तसिेकशन मोडस और मा्क

जब आप पहली बाि Maya राल ूकितषे हैं, तो वडफॉलट वसलषेक्शन मोड ऑबजषेक्ट पि सषेट होता ह।ै ्यह Maya कषे  साथ बहुत सािषे  वसलषेक्शन कामों में उप्योरी 

होता ह,ै साथ ही कु् अपवाद री होतषे हैं।

हाइरा्ककी और ्कॉरमबनेशन रसिकेशन मास्क ्का प्रयोग ्करने ्ेक रिए

• Status Line पि, Select by Hierarchy and Combinations आइकन रुनें।

• Selection Mask आइकन तीन वसलषेक्शन ववकलप दशा्भनषे कषे  वलए अपडषेट होता ह।ै

• Status Line पि, Select by Hierarchy आइकन रुनें।

• हाइिाकशी द्ािा वसलषेक्शन सुवनवश्चत किता ह ैवक जब आप आइटम सलषेक्ट किें  तो वषे अपनषे पषेिें ट ्या रूट नोड पि सलषेक्ट हों ।

• सीन व्य ूमें, Column औि Column1 पि वशफट-वक्लक किें  तावक वषे एक साथ सलषेक्ट हो जाएँ।
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6.3.5 रपिट पॉइंट

वपवट पवॉइंट 3D सपषेस में एक वववशष्ट पोज़ीशन ह ैवजसका इसतषेमाल ऑबजषेक्ट कषे  ट्ांसफॉमदेशन कषे  वलए एक संदर्भ कषे  रूप में वक्या जाता ह।ै सरी ऑबजषेक्ट 

(कव्भ, सफदे स, गुप) कषे  वपवट पवॉइंट होतषे हैं।

दो ्कॉिम ्को समूरह्त ्करने ्ेक रिए

• सुवनवश्चत किें  वक Column औि Column1 सलषेक्ट वकए हुए हैं।

• मषेन मषेन्य ूसषे, Edit > Group > सलषेक्ट किें । 

• Group Options window में, Edit > Reset Settings सलषेक्ट किें । वनमनवलवखत ववकलपों को सषेट किें : गुप अंडि: पषेिें ट

• Group Options window में, Group पि वक्लक किें ।

Maya ऑबजषेक्ट को हाइिाकशी में एक दूसिषे  कषे  साथ समूवहत किता ह ैऔि वपवट पवॉइंट ओरिवजन पि वसथत होता ह।ै (जब वपवट पवॉइंट Move Tool कषे  

ओरिवजन में सथान बदलता ह)ै

समूह िुर्पि्ेकट और रोटटे ्करने ्ेक रिए

• कॉलम गुप को वसलषेक्ट वक्यषे हुए मषेन मषेन्य ूसषे Edit > Duplicate Special > _ रुनें।

• Duplicate Special Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि 

वनमनवलवखत ववकलप सषेट किें :

• िोटषेट: 0 90 0

• कॉपी की संख्या: 3

• Duplicate Special Options ववंडो में, Duplicate Special पि वक्लक किें । कॉलम डुवपलकषे ट होतषे हैं औि प्रत्यषेक कॉपी कषे  साथ 90 वडगी सषे िोटषेट  

कितषे हैं।

्कॉमपोनेंट और ऐरट्बयूट

आपको बषेस औि कॉलम कषे  वडसपलषे को टषेमपलषेट मोड में बदलना होरा तावक टषेमपलषेट रूफ पि अविक आसानी 

सषे काम कि सकें ।

बेस और ्कॉिम ्को टमे्पिटे ्करने ्ेक रिए

• साइड व्य ूमें, वसलषेक्शन मासक को हाइिाकशी में सषेट िखषे हुए, अपनषे सीन कषे  सरी ऑबजषेक्ट सलषेक्ट किें ।

• मषेन मषेन्य ूसषे, Display > Object Display > Template सलषेक्ट किें । वसलषेक्ट वक्यषे र्यषे ऑबजषेक्ट टषेमपलषेट 

हो जातषे हैं। ।

तित्र 6.3.12: समूह घुमाएुँ/ग्ुप रोटेट करें

तित्र 6.3.13: बेस और कॉिम को टेमपिेट करें
एंटबैिचर ्ेक रिए टॉरस रप्ररमरटि बनाने और पोज़ीशन ्करने ्ेक रिए

• मषेन मषेन्य ूसषे, Create > NURBS Primitives > Torus > _ सलषेक्ट किें ।

• NURBS Torus Options window में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत 

ववकलप सषेट किें :

» िषे वड्यस (वत्रज्या): 8.5

» माइनि िषे वड्यस: 0.5

» सषेक्शन की संख्या: 24

• NURBS Torus Options window में, Create पि वक्लक किें ।

• Channel Box में, टॉिस वप्रवमवटव एंटबैलरि का नाम बदलें/िीनषेम किें ।

• एंटबैलरि को सीन में लंबवत वखसकाएँ/ववट्भकली मूव किें  तावक कॉलम कषे  ऊपि वसथत हो जाए।

तित्र 6.3.14: टॉरस तप्रतमरटि एंटवैबििर
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6.3.6 ्कॉमपोनेंट्स
• Maya कषे  सरी ऑबजषेक्ट में ट्ांसफॉम्भ  औि शषेप मोड होता ह।ै

• एंटबैलरि कषे  आकाि को आिािरतू सकषे ल ट्ांसफॉमदेशन सषे पिषे  बदलनषे कषे  वलए, आपको इसकी कॉमपोनेंट सरूना बदलनी होरी।

एंटबैिचर ्ेक ्कॉमपोनेंट सिकेट ्करने ्ेक रिए

• साइड व्य ूमें, एंटबैलरि कषे  वनकट कषे  दृश्य कषे  वलए डॉली इन किें ।

• वसलषेक्शन मोड को कॉमपोनेंट मोड पि सषेट किें ।

• एंटबैलरि कषे  वा्यिफ्षे म पि िाइट-वक्लक किें  औि पॉप-अप मषेन्य ूसषे Control Vertex रुनें।

• पॉप-अप हुआ मषेन्य ूमावकयं र मषेन्य ूहोता ह ै वजससषे ऑबजषेक्ट सषे संबंवित ऑपिषे शन का तवरित वसलषेक्शन होता ह ैजहाँ आप माउस पि िाइट-वक्लक  

कितषे हैं।

• शीषकों कषे  ऊपिी पंवक्त कषे  रािों ओि एक वसलषेक्शन बॉक्स ड्ैर किें  तावक वषे सलषेक्ट हो जाएँ।

• Move Tool की मदद सषे, एंटबैलरि का आकाि बदलनषे कषे  वलए शीषकों को ऊपि की ओि वखसकाएँ जसैा वक नीरषे वदखा्या र्या ह।ै

• CVs का वडसपलषे कैं सल किनषे कषे  वलए, एंटबैलरि कषे  वा्यिफ्षे म पि एक बाि वफि िाइट-वक्लक किें  औि पॉप-अप मषेन्य ूसषे Object Mode रुनें।

तित्र 6.3.15: एंटवैबििर के कॉमपोनेंट

टषेमपल कषे  वलए रूफ एंटबैलरि कषे  ऊपि वसथत होता ह।ै टषेमपल कषे  वलए रूफ का वनमा्भण एक आिषे सफषे ्यि वप्रवमवटव सषे वक्या जाता ह।ै

टमेपि ्ेक रिए रूि ्का रनमाटिण ्करने ्ेक रिए

• Create > NURBS Primitives > Sphere > सलषेक्ट किें ।

• NURBS Sphere Options ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत ववकलप सषेट किें :

» सटाट्भ  सवीप कोण: 0

» एंड सवीप कोण: 180

» िषे वड्यस (वत्रज्या): 8.75

» सषेक्शन की संख्या: 8

» सपैंस की संख्या: 4

NURBS Sphere Options ववंडो में, Create पि वक्लक किें ।

• half-sphere templeRoof का नाम बदलें।

रूफ को X अक् कषे  रािों ओि -90 वडगी घुमाना होता ह ैऔि एंटबैलरि कषे  ऊपि वसथत किना होता ह।ै
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एंटबैिचर पर रूि ्को घुमाने और पोज़ीशन ्करने ्ेक रिए

• साइड व्य ूमें, रूफ को इस प्रकाि घुमाएं वक डोम रार ऊपि की ओि िहषे।

• रूफ को इस प्रकाि वखसकाएँ तावक ्यह एंटबैलरि कषे  ऊपिी वकनािषे  कषे  वनकट वसथत िहषे।

• रूफ को Z अक् (नीला मषेवनपुलषेटि हैंडल) कषे  अनुवदश सकषे ल किें  तावक सफषे ्यि का रूप हलका 

दब जाए।

ऑबजेकट ्को अनटमे्पिटे ्करने ्ेक रिए

• Status Line पि, Select by Hierarchy and Combinations बटन रुनें।

• Status Line पि, Select by hierarchy: template बटन रुनें।

• Select by hierarchy: टषेमपलषेट सुवनवश्चत किता ह ैवक वसलषेक्शन द्ािा कषे वल टषेमपलषेट वकए हुए ऑबजषेक्ट ही प्रराववत होंरषे।

• सीन व्य ूमें, सीन में सरी ऑबजषेक्ट कषे  रािों ओि वसलषेक्शन बॉक्स ड्ैर किें  तावक टषेमपलषेट हुए ऑबजषेक्ट एकसाथ सलषेक्ट हो जाएँ।

• मषेन मषेन्य ूसषे, Display > Object Display > Untemplate सलषेक्ट किें ।

• Status Line पि, Select by hierarchy: root बटन रुनें।

ऐरट्बयूट एरिटर

ऐवट्ब्यटू एवडटि आपनषे सीन कषे  ऑबजषेक्ट औि सामवग्यों कषे  वलए वववरनन नोड्स औि ऐवट्ब्यटू कषे  बािषे  में जानकािी प्रदान किता ह।ै

तित्र 6.3.16: एंटवैबििर पर रूफ

तित्र 6.3.17: अनटेमपिेट ऑबजेकट

ऐरट्बयूट एरिटर ्की मदद से ऑबजेकट ऐरट्बयूट दखेने ्ेक रिए

• सीन व्य ूमें, templeRoof सलषेक्ट किें  तावक ्यह सलषेक्टषेड ऑबजषेक्ट बन जाए।

• ऐवट्ब्यटू एवडटि दषेखनषे कषे  वलए, Status line पि Show/Hide आइकन पि वक्लक किें ।

• ऐवट्ब्यटू एवडटि templeRoof कषे  वलए ऐवट्ब्यटू प्रदवश्भत किता ह।ै templeRoof कषे  वववरनन 

ऐवट्ब्यटू अलर-अलर टबैस कषे  अंतर्भत प्रकट होतषे हैं। प्रत्यषेक टबै एक नोड को वनरूवपत 

किता ह।ै

तित्र 6.3.18: ऐरट्बयूट

तित्र 6.3.19: ऐरट्बयूट एतिटर
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• TempleRoof टबै पर रकि्क ्कर्ेक इस्ेक ऐरट्बयूट दखेें। ्यह टबै ट्ांसफॉम्भ  नोड कहलाता ह,ै क््योंवक इस टबै पि सबसषे महतवपणू्भ  ऐवट्ब्यटू 

templeRoof कषे  ट्ांसफॉमदेशन को वन्ंयवत्रत किता ह।ै Maya कषे  प्रत्यषेक वदखाई दषेनषे वालषे ऑबजषेक्ट में कैमिा औि लाइट सवहत एक ट्ांसफॉम्भ  मोड होता 

ह।ै

• TempleRoofShape टबै पर रकि्क ्कर्ेक इस्ेक ऐरट्बयूट दखेें। ्यह टबै शषेप नोड कहलाता ह ै क््योंवक जब ऑबजषेक्ट पहली बाि बनता ह,ै तो 

ऐवट्ब्यट्ूस ऑबजषेक्ट का ज्यावमती्य आकाि ्या रौवतक ववशषेषताएं सथावपत किता ह ै। अविकति ऑबजषेक्ट में शषेप नोड होतषे हैं, कु् में नहीं होतषे हैं, 

जसैषे कॉलम ऑबजषेक्ट कषे  वलए समूह। शषेप नोड में अन्य प्रकाि कषे  ऐवट्ब्यटू री शावमल हो सकतषे हैं जसैषे ऑबजषेक्ट वडसपलषे ऐवट्ब्यटू।

• makeNurbSphere टबै पर रकि्क ्कर्ेक इस्ेक ऐरट्बयूट दखेें। ्यह एक इनपुट मोड ह ैवजसमें ऑबजषेक्ट कषे  वनमा्भण इवतहास/कंसट्क्शन वहसट्ी सषे 

संबंवित ऐवट्ब्यटू शावमल होतषे हैं। इनपुट नोड कषे  ऐवट्ब्यटू ऑबजषेक्ट कषे  वलए कंसट्क्शन वहसट्ी में दूसिषे  अनुवतशी नोड कषे  वलए पास कि वद्या जाता ह ै

- इस मामलषे में templeRoofShape को पास कि वद्या र्या।

• अंर्तम दो नोि आरंरभ्क/इनीरशयि Shading Group और lambert1 हैं। ्यवद आप उनहें नहीं दषेख पातषे हैं, तो वडसपलषे एिो पि वक्लक किें । 

initialShadingGroup औि lambert1 वडफॉलट नोड हैं जो वकसी ऑबजषेक्ट की वडफॉलट शवैडंर सामगी सषे संबद्ध होतषे हैं। ऑबजषेक्ट कषे  शुरुआती िंर औि 

शवैडंर सषे संबंवित अन्य सषेवटंगस कषे  वनिा्भिण कषे  वलए Maya उनका इसतषेमाल किता ह।ै

6.3.7 सिमे स सामरिी

वकसी ऑबजषेक्ट कषे  िंर, रमक औि पिावत्भकता का वन्ंयत्रण इसकी सफदे स सामगी (इसषे शडैि ्या शवैडंर सामगी कहतषे हैं) द्ािा होता ह/ै। मटैीरि्यल 

ऐवट्ब्यटू इस बात सषे संबंवित होता ह ैवक Maya कषे  3D कमप्यटूि जरत में ऑबजषेक्ट प्रकाश कषे  प्रवत वकस प्रकाि सवाराववक रूप सषे वसम्ुयलषेट किता ह।ै

टमैपि ऑबजेकट ्ेक रिए नई सामरिी रनधाटिरर्त ्करने ्ेक रिए

• एंटबैलरि कषे  वा्यिफ्षे म पि िाइट-वक्लक किें  औि पॉप-अप मषेन्य ूसषे Object Mode रुनें।

• अपनषे सीन में सरी ऑबजषेक्ट को वसलषेक्ट किनषे कषे  वलए उनकषे  रािों ओि एक वसलषेक्शन बॉक्स को ड्ैर किें ।

• Status Line सषे, मषेन्य ूसलषेक्टि की मदद सषे Rendering मषेन्य ूसषेट सलषेक्ट किें ।

• Main Menu, Rendering कषे  वलए मषेन्य ूसषेट दशा्भनषे कषे  वलए बदल जाता ह।ै

• मषेन मषेन्य ूसषे, Lighting/Shading > Assign New Material > Blinn सलषेक्ट किें ।

तित्र 6.3.20: एंटवैबििर का िायरफे्म
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• ऐवट्ब्यटूि एवडटि में, blinn1 शषेवडंर मटैीरि्यल का नाम बदलकि templeShader किें ।

शरैिंग सामरिी ्का ऐरट्बयूट एरिट ्करने ्ेक रिए

• ऐवट्ब्यटू एवडटि में, Color शबद कषे  दाई ंओि वसथत िसूि बॉक्स में वक्लक किें ।

तित्र 6.3.21: शवैपिंग सामग्ी का ऐरट्बयूट एतिट करें

तित्र 6.3.22: Color Chooser प्रदरशटिि होिा हवै।

• Color Chooser प्रदवश्भत होता ह।ै

• कलि वहील/िंरीन पवह्यषे (षटकोण) कषे  अंदि वक्लक किें  औि सैंड कलि प्राप्त किनषे कषे  

वलए पवॉइंटि ड्ैर किें । सटीक िंर इस पाठ कषे  वलए महतवपणू्भ  नहीं ह।ै

• रजूि को बंद किनषे कषे  वलए एक्सषेपट पि वक्लक किें । आप बाद कषे  पाठों में Maya की 

शवैडंर औि टषेक्ररिंर क्मताओ ंकषे  बािषे  में अविक सीखेंरषे।

तित्र 6.3.23

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

• ऐवट्ब्यटू एवडटि मषेन्य ूमें, सलषेक्टषेड मषेन्य ूआइटम रुनें औि सरूी सषे templeBase रुनें। templeBase 

कषे  ववशषेषताएँ ऐवट्ब्यटू एवडटि में प्रदवश्भत होती ह।ै

• TempleShader नोड टबै पि वक्लक किकषे  इसकषे  ऐवट्ब्यटू दषेखें।

• ्यवद आप उनहें नहीं दषेख पातषे हैं, तो टबै कषे  दाई ंओि वडसपलषे एिो पि वक्लक किें ।

• Show/Hide आइकन की मदद सषे ऐवट्ब्यटू एवडटि बंद किें ।
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यूरनट 6.4: पॉरिगोनि मॉिरिंग

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Maya सॉफटवषे्यि पि 3D एवनमषेशन तकनीकों का अनुप्र्योर- पॉवलरोन मॉडवलंर।

2. Maya में वववरनन प्रकाि कषे  मॉडवलंर सफदे स सषे परिवरत हों।

यूरनट ्ेक उद्ेशय  

6.4.1 मॉिरिंग 

मॉडवलंर एक ऐसी प्रवक्र्या ह ैवजसकषे  वलए उतकृष्ठ दृश्य कौशल औि मॉडवलंर टूलस में ववशषेषज्ता की ज़रूित होती ह।ै आकाि, आकृवत औि ववविण औि 

अनुपात कषे  अथ्भ में अपनषे फॉम्भ  की मॉडवलंर कषे  सम्य आप वजतना सटीक होतषे हैं, अंवतम सीन उतना ही वासतववक लरषेरा।

Maya में तीन मॉडवलंर सफदे स प्रकाि हैं:

1. पॉवलरोन

2. NURBS

3. सबवडववजन सफदे स

पॉवलरोन सफदे स तीन ्या अविक साइडषेड फलटै सफदे स का एक नषेटवक्भ  ह ैवजसषे फषे स कहा जाता ह,ै जो आपस में कनषेक्ट हो कि एक पॉली मषेश बनातषे हैं। 

पॉवलरोन मषेश में शीष्भ  (वटटैक्स), पषृ्ठ (फषे स) औि वकनािषे  (एज) होतषे हैं।

तित्र 6.4.1: मॉिपिंग सफमे स



183182

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

6.4.3 मॉिरिंग रप्रिरें स सेट ्करना

अपना पॉवलरोन मॉडल बनानषे सषे पहलषे इस पाठ कषे  जरिए बषेहति का्य्भ  किनषे कषे  वलए कु् वडफॉलट सषेवटंर को बदल दें।

• Window > Settings/Preferences > Preferences सलषेक्ट किें ।

» Maya ्यजू़ि वप्रफिें स ववंडो प्रदवश्भत होता ह।ै

• वप्रफिें स ववंडो कषे  कैटषेरिीज सषेक्शन में पॉवलरोन सलषेक्ट किें ।

• पॉवलरोन वडसपलषे सषेवटंर में, वनमनवलवखत सषेट किें :

» सीमा वकनािा: ऑन

» वकनािषे  की रौडाई: 4

» इससषे बॉड्भि एवजज़ पॉवलरोन मषेश पि मुख्य रूप सषे प्रदवश्भत होतषे हैं। बॉड्भि एवजज़ को वववशष्ट रूप सषे प्रदवश्भत किनषे सषे, आप अपनषे मॉडल कषे  

अन्य वकनािों (एवजज़) सषे इनमें अंति कि सकतषे हैं औि तु्रवट्यों को दूि सकतषे हैं।

• वप्रफिें स ववंडो कषे  कैटषेरिीज सषेक्शन में वसलषेक्शन रुनें।

• पॉवलरोन वसलषेक्शन सषेवटंर में, वनमनवलवखत सषेट किें :

» इनकषे  साथ फषे स सलषेक्ट किें : संपणू्भ  फषे स

» Whole फषे स सषेवटंगस सषे आप फषे स पि कहीं री वक्लक किकषे  पॉवलरोन फषे स सलषेक्ट कि सकतषे हैं (Center सषेवटंर में आपको फषे स कषे  बीर कषे  डॉट 

पि वक्लक किना पडता ह)ै। इसकषे  अलावा, सीन में जब फषे स सलषेक्ट वक्या जाता ह,ै तब पिूा फषे स हाइलाइटषेड प्रदवश्भत होता ह।ै

» सषेवटंर ववंडो बंद किनषे कषे  वल Save बटन पि वक्लक किें ।

» वप्रवमवटवस कषे  वलए Interactive Creation option ऑफ किें : Create > Polygon Primitives > Interactive Creation (no check mark) सलषेक्ट किें ।

तित्र 6.4.3: तप्रतमरटव्स के तिए Interactive Creation तिकल्प

फं्ट और साइि ऑ्थथोरिारि्क वयू में रेफ्ें स इमेज िोि ्करने ्ेक रिए

• टूलबॉक्स में, लषेआउट शॉट्भकट बाि सषे Four View पि वक्लक किें । पस्भपषेवक्टव व्य ूऊपिी दाएँ कोनषे में वसथत होता ह ैऔि अन्य व्य ूआपकषे  सीन को 

ऊपि, सामनषे औि साइड सषे वदखातषे हैं।

• फं्ट व्य ूपनैल मषेन्य ूमें View > Image Plane > Import Image सलषेक्ट किें ।

• HelmetFront.jpg नाम की इमषेज फाइल सलषेक्ट किें । ्यह इमषेज आपकषे  Maya सॉफटवषे्यि कषे  साथ इंसटॉलड Getting Started Lesson Data directory में 

पाई जा सकती ह:ै

 Getting Started Lesson Data/Polygon Modeling/source images
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• रिाउज़ि में, Open बटन पि वक्लक किें ।

HelmetFront.jpg फं्ट व्य ूमें नज़ि आता ह ैऔि हषेलमषेट की ड्ॉइंर दशा्भता ह।ै

• साइड व्य ूपनैल मषेन्य ूमें View > Image Plane > Import Image सलषेक्ट किें ।

• HelmetSide.jpg नाम की इमषेज फाइल सलषेक्ट किें । ्यह इमषेज आपकषे  Maya सॉफटवषे्यि कषे  साथ इंसटॉलड GettingStartedLessonData directory में पाई 

जा सकती ह:ै

GettingStartedLessonData/PolygonModeling/sourceimages

• रिाउज़ि में, Open बटन पि वक्लक किें ।

साइड व्य ूमें HelmetSide.jpg नज़ि आता ह।ै

तित्र 6.4.4: HelmetSide.jpg

रेिरें स इमेज ्की पारदरशटि्ता बदिने ्ेक रिए

• फं्ट व्य ूपनैल मषेन्य ूमें View > Select Camera सलषेक्ट किें । फं्ट ऑथपोगावफक व्य ूकषे  वलए कैमिा सलषेक्ट होता ह।ै

• Status line पि Show/Hide Channel Box आइकन पि वक्लक किकषे  Channel Box वडसपलषे किें । Channel Box फं्ट ऑथपोगावफक व्य ूकषे  वलए कीएबल 

ऐवट्ब्यटू प्रदवश्भत किता ह।ै

• इनपुट सषेक्शन में, इमषेज पलषेन कषे  वलए ऐवट्ब्यटू दशा्भनषे कषे  वलए ImagePlane1 पि वक्लक किें ।

• Alpha Gain ऐवट्ब्यटू का मान 0.25 सषेट किें । इमषेज आंवशक रूप सषे पािदशशी प्रदवश्भत होता ह।ै

• साइड व्य ूपनैल मषेन्य ूमें, कैमिा सलषेक्ट किें  औि साइड व्य ूइमजषे पलषेन कषे  वलए Alpha Gain सषेवटंर में वही परिवत्भन किें  जसैा वक आपनषे फं्ट व्य ूइमजषे 

पलषेन कषे  वलए वक्या ह।ै

6.4.4 Polygon Primitive बनाना
संदर्भ कषे  रूप में इमषेज पलषेन की मदद लषेकि क््यबू वप्रवमवटव सषे हषेलमषेट मषेश का शीष्भ  रार बनाएं। वप्रवमवटव ऑबजषेक्ट 3D शुरू किनषे की एक वववि ह ैक््योंवक 

उनहें अन्य रूपों में परिववत्भत वक्या जा सकता ह।ै

हेिमेट मेश ्ेक रिए कयूब रप्ररमरटि बनाना

• सुवनवश्चत किें  वक आप पस्भपषेवक्टव व्य ूमें काम कि िहषे हैं।

• Create > Polygon Primitives > Cube > _ सलषेक्ट किें ।

• ववकलप ववंडो में, Edit > Reset Settings सलषेक्ट किें  औि वफि वनमनवलवखत सषेट किें :

» रौडाई: 14
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कयूब रप्ररमरटि ्को समू्थ ्त्था सबरििाइि ्करना

• सीन व्य ूमें क््यबू को वसलषेक्ट वक्यषे हुए, Mesh > Smooth > _ रुनें, औि वदखाई पडनषे वालषे ववंडो में 

वनमनवलवखत ववकलप सषेट किें :

» ऐड वडवीजन: एक्सपोनेंवश्यली

» वडवीजन लषेवलस: 2

• Smooth बटन पि वक्लक किें

क््यबू वप्रवमवटव समूथ वक्या जाता ह ैऔि रािों कोनो पि रोल बना्या जाता ह।ै क््यबू री ्ोटषे-्ोटषे फषे सों में 

ववरावजत वक्या र्या ह।ै

पॉलीरन (बहुरुज) फषे स अब री राि-रुजाओ ंवालषे हैं बावजदू इसकषे  वक उनकषे  आकाि औि वसथवत समूथ ऑपिषे शन द्ािा मॉवडफाई वकए रए हैं।

6.4.5 शेिेि मोि में मॉिरिंग

शषेडषेड मोड में पॉवलरन मषेश की मॉडवलंर आपको 3D वॉल्यमू की बषेहति समझ प्रदान किती ह ैवक मॉडल कैसषे ऑक््ुयपाई किता ह ैऔि कैसषे सतह की 

बािीवक्यां प्रकट होती हैं। 

प्रत्यषेक व्य ूमें आप वकसी ऑबजषेक्ट की शषेवडंर वन्ंयवत्रत कि सकतषे हैं। उदाहिण कषे  वलए, आप कषे वल पसपदेवक्टव व्य ूमें शषेडषेड रूप में ऑबजषेक्ट प्रदवश्भत कि 

सकतषे हैं, औि ऑथपोगावफक व्य ूको वा्यिफ्षे म मोड में ऑबजषेक्ट प्रदवश्भत किनषे कषे  वलए सषेट कि सकतषे हैं। साथ ही आप वडसपलषे सषेवटंगस शषेडषेड औि वा्यिफ्षे म 

वडसपलषे में एक साथ प्रदवश्भत किनषे कषे  वलए सषेट कि सकतषे हैं।

िायरफे्म ्ेक शेिेि मोि में हेिमेट मेश प्रदरशटि्त ्करना

• पस्भपषेवक्टव व्य ूमें, हषेलमषेट मषेश पि िाइट वक्लक किें  औि वदखाई पडनषे वालषे मावकयं र मषेन्य ूसषे ऑबजषेक्ट मोड सलषेक्ट किें । इससषे सलषेक्शन मोड Objects 

में बदल जाता ह।ै

• हषेलमषेट मषेश सलषेक्ट किें ।

• पस्भपषेवक्टव व्य ूमें, पनैल मषेन्य ूसषे Shading > Smooth Shade All सलषेक्ट किें । हषेलमषेट मषेश समूथ शषेडषेड मोड में प्रदवश्भत होता ह।ै

• पनैल मषेन्य ूसषे, Shading > Wireframe on Shaded सलषेक्ट किें । मषेश औि शषेवडंर पि वा्यिफ्षे म प्रकट होता ह ै(राहषे मषेश सलषेक्ट वक्या र्या हो ्या नहीं)।

तित्र 6.4.6: कयूब तप्रतमरटि ्मूथ ककया गया

» ऊंराई: 14

» डषेपथ (रहिाई): 14

» रौडाई ववराजन/वर्भ: 1

» उंराई ववराजन/वर्भ: 2

» रहिाई ववराजन/वर्भ: 1

• Create बटन पि वक्लक किें ।

आपकषे  द्ािा वनवद्भष्ट डाइमेंशन कषे  साथ मूल (ओरिवजन) तथा मध्य कषे  रािों ओि एक उपखंड (सबवडववज़न) 

पि क््यबू वप्रवमवटव बना्या जाता ह।ै क््यबू वप्रवमवटव में राि-रुजाओ ंवालषे पॉलीरन फषे स होतषे हैं वजनहें क्वाड 

कहा जाता ह।ै क्वाड पॉलीरन का उप्योर 3D कैिषे क्टि मॉडल कषे  साथ बाि-बाि वक्या जाता ह ैक््योंवक वषे 

आसानी सषे समूथ होतषे हैं औि वकसी कंकाल/ढांरें सषे बाउंड/सथावपत वक्यषे जानषे पि अच्ी तिह सषे वडफॉम्भ /

ववरूवपत होतषे हैं। तित्र 6.4.5: कयूब तप्रतमरटि
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शिैेि X-Ray मोि में हेिमेट मेश प्रदरशटि्त ्करना

• हषेलमषेट कषे  सलषेक्ट िहतषे, साइड व्य ूकषे  पनैल मषेन्य ूसषे वनमनवलवखत रुनें:

• Shading > Smooth Shade All

• Shading > Wireframe on Shaded

• Shading > X-Ray.

हषेलमषेट मषेश वा्यिफ्षे म कषे  साथ अि्भपािदशशी शषेडषेड वडसपलषे में अपडषेट होता ह।ै आप मषेश कषे  पी ष्े  2D इमषेज दषेख 

सकतषे हैं।

• फं्ट व्य ूकषे  वलए री वप्लषे रिण को दुहिाएं।
तित्र 6.4.7: शेिेि X-Ray मोि

तित्र 6.4.8: िायरफे्म

6.4.6 मॉिि रसरमट्ी

• जब करी आप कोई ऑबजषेक्ट मॉडल कितषे हैं, तो आपको फॉम्भ  सषे उपलबि हो िही वकसी वसवमट्ी का लार उठाना रावहए।

• मषेश कषे  बाएं अि्भरार सषे फषे स वडलीट किें

• शीष्भ  व्य ूमें, मषेश पि िाइट वक्लक किें  औि वदखाई पडनषे वालषे मावकयं र मषेन्य ूसषे फषे स सलषेक्ट किें ।

• हषेलमषेट मषेश कषे  बाएं अि्भरार पि फषे सषेज को सलषेक्ट किनषे कषे  वलए उनकषे  रािों ओि सषे एक बाउंवडंर बॉक्स ड्ैर किें ।

• वडलीट-की दबाऍ ं

• सलषेक्ट वकए हुए फषे स वडलीट हो जातषे हैं।

तित्र 6.4.9: मॉिि तसतमट्ी
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6.4.7 पेंरटंग द्ारा ्ंकपोनेंट चयन ्करना
पेंट रसिकेशन टूि ्की मदद से रििीट ्करने ्ेक रिए िेस चयन ्करना

• टूलबॉक्स में, पेंट वसलषेक्शन टूल आइकन पि वक्लक किें ।

तित्र 6.4.10: पेंट तसिेकशन टूि आइकन

• साइड व्य ूमें, हषेलमषेट मषेश पि िाइट वक्लक किें  औि वदखाई पडनषे वालषे मावकयं र मषेन्य ूसषे फषे स सलषेक्ट किें ।

• साइड व्य ूमें, मषेश कषे  सामनषे औि वनरलषे रार में (वरत्र दषेखें) वदखाई पडनषे वालषे फषे सषेज कषे  ऊपि माउस ड्ैर कि फषे सषेज को पेंट सलषेक्ट किें ।

तित्र 6.4.11

• र्यवनत फषे वसस को हटानषे कषे  वलए Delete की दबाएं।

• अपनषे काम की समीक्ा कषे  वलए पस्भपषेवक्टव व्य ूको टंबल किें ।

• पॉलीरन मषेश की बाहिी परिवि कषे  साथ लरषे वकनािषे  वजसषे बॉड्भि एज कहा जाता ह,ै मषेश पि रीतिी वकनािषे  की तुलना में एक मोटी लाइन सषे दशा्भ्या 

जाता ह।ै पाठ की शुरुआत में आप ्यह वडसपलषे सषेवटंर सषेट कितषे हैं, इसवलए आप इस प्रकाि कषे  एवजज़ औि अन्य एवजज़ में रषेद कि सकतषे हैं।

6.4.8 एज िूप सिकेट ्करना

शीष्भ  व्य ूमें, X एवक्सस कषे  वबलकुल ऊपि औि नीरषे कषे  एवजज़ की कतािें  औि Z एवक्सस की दाई ंकताि सीिी नहीं हैं। आप इन कतािों (वजनहें एज लपू कहा 

जाता ह)ै में वकनािों को Move टूल की मदद सषे वगड में सनपै कि संिषे वखत किना राहेंरषे। एज लपू उन पॉवलरन एवजज़ का पाथ होती ह,ै जो साझा शीष्भ 

वबंदुओ ंसषे क्रम में जुडषे  हुए हैं। जब आप पॉलीरन की मदद सषे मॉडल कितषे हैं तो एज लपू वसलषेक्शन बहुत ही उप्योरी होता ह।ै

हेिमेट मेश पर र्कनारे संरेरख्त ्करना

• शीष्भ  व्य ूमें, मषेन मषेन्य ूसषे Select > Select Edge Loop टूल का र्यन कि पहला क्वैतज 

एज लपू सलषेक्ट किें  जो X एवक्सस कषे  सीिषे नीरषे वदखाई पडता ह,ै औि वफि जसैा वक 

ऊपि वरत्र में वदखा्या र्या ह ैएज लपू पि डबल-वक्लक किें । एज लपू सलषेक्ट हुआ।

तित्र 6.4.12: एज िूप सिेकट करें

• वगड इंटिसषेक्शन पवाइंट । जब कई सािषे  कंपोनेंट सलषेक्ट वकए जातषे हैं, तो आप उनहें वगड कषे  जरिए एक ही बाि में एक दूसिषे  कषे  साथ संिषे वखत कि 

सकतषे हैं।

• सटषेटस लाइन पि, आइकन पि वक्लक कि सनपै टु वगड राल ूकिें ।
तित्र 6.4.13: आइकन पर तकिक करें
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• टूलबॉक्स में, मूव टूल पि डबल-वक्लक कि इसकी टूल सषेवटंर दशा्भ एं।

• Move Snap सषेवटंगस में, Retain कंपोनेंट सपषेवसंर सषेवटर बंद किें ।

• शीष्भ  व्य ूमें, नीलषे एिो को मूव टूल मवैनपुलषेटि पि नीरषे की ओि एक ्ोटी दूिी तक वक्लक-ड्ैर किें ।

• एज लपू तुिंत वनरली वगड लाइन में सनपै होता ह।ै ्यह उस सथान पि वसथत नहीं ह ैजहाँ आप राहतषे हैं, लषेवकन लपू में सरी वकनािषे  वजनहें आपनषे रुना 

ह ैएक दूसिषे  सषे संिषे वखत हो जातषे हैं।

• सटषेटस लाइन पि, आइकन पि वक्लक कि सनपै टु वगड बंद किें ।

• शीष्भ  व्य ूमें, Move टूल कषे  को एवक्टव िखषे हुए ही, मवैनपुलषेटि एिो ऊपि की ओि एक ्ोटी दूिी तक ड्ैर किें  वजससषे एज लपू लररर अपनषे मूल सथान 

(जो वक X एवक्सस कषे  नीरषे दूसिी वगड लाइन पि होना रावहए) में सथावपत हो जाए।

• ऊपि बताए रए रिणों की मदद सषे, X एवक्सस सषे ऊपि वदखाई दषेनषे वालषे अन्य एज लपू संिषे वखत किें  औि वफि एज लपू को सीिषे Z एवक्सस की दाई ं

ओि संिषे वखत किें । (आवश्यकतानुसाि, सनपै टु वगड ऑन ्या ऑफ किना ्याद िखें।)

• जब आप ्यह पिूा कि लें, तो X तथा Z एवक्सस कषे  वनकटतम एज लपू संिषे वखत होतषे हैं।

तित्र 6.4.14: Moov Tool आइकन पर तकिक करना

तित्र 6.4.15: एज िूप अिाइंि/संरेतखि

ऑ्थथोरिारि्क वयूज़ में ्ंकपोनेंट एरिट ्करना

कंपोनेंट वसलषेक्शन औि ट्ांसफॉमदेशन पॉलीरन मषेश कषे  आकाि को एवडट किनषे की एक मौवलक वववि ह।ै जब आप मॉडल कितषे हैं, तो आपको वववरनन 

सीन व्यजू में काम कितषे हुए पॉलीरन कंपोनेंट की बाि-बाि जांर किनी पडती ह ैऔि वफि उनकी वसथवत (शीष्भ  वबंदुओ,ं वकनािों औि फषे सषेज को) को 

सुिािना होता ह ैतावक वषे इमषेज पलषेन कषे  संदर्भ  वरत्र सषे मषेल खाएं।

हेिमेट ्ेक पीछे शीषटि रबंदुओ ं्को मनैुअि रूप से पुनवयटििरस्थ्त ्करना

• हषेलमषेट पि िाइट वक्लक किें  औि वदखाई पडनषे वालषे मावकयं र मषेन्य ूसषे Vertex (शीष्भ  वबंदु) सलषेक्ट किें ।
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तित्र 6.4.16: शीरटि पबंद ुिुनें

• साइड व्य ूमें, पी ष्े  कषे  वनरलषे वकनािषे  पि (वरत्र दषेखें) शीष्भ  वबंदुओ ंको रािों ओि एक बाउंवडंर बॉक्स ड्ैर कि ववट्भवसस का एक जोडा सलषेक्ट किें ।

• टूलबॉक्स में, Move टूल पि वक्लक किें ।

• साइड व्य ूमें Move टूल मवैनपुलषेटि पि नीलषे ऐिो को दाई ंओि तब तक वक्लक-ड्ैर किें  जब तक वक शीष्भ  वबंदु पुनव्य्भववसथत न हो जाएं तावक आपका 

हषेलमषेट इमषेज पलषेन कषे  संदर्भ  सकषे र सषे मषेल खा्यषे।

• वसवमट्ी एवक्सस कषे  अनुिषे ख शीष्भ  वबंदु औि साथ ही इसकषे  बिाबि वाला शीष्भ  वबंदु मूव किकषे  आप 

्यह सुवनवश्चत कितषे हैं, वक हषेलमषेट की शषेप बिकिाि िहषे।

• हषेलमषेट कषे  पी ष्े  शीष्भ  वबंदुओ ंकषे  अन्य ्ुयगमों कषे  वलए 2 सषे 4 तक दोहिाएं सुवनवश्चत किें  वक एज लपू 

एक दूसिषे  की तुलना में समूथ वदखाई पडषे।

तित्र 6.4.17: ्मूथ कदखिा हवै

• साइड व्य ूमें, हषेलमषेट कषे  ऊपि तथा सामनषे वसथत शीष्भ  वबंदुओ ंकषे  अन्य ्ुयगम सलषेक्ट किें  

औि उनहें एक ही तिह सषे मूव किें , वजससषे वषे संदर्भ  वरत्र सषे मषेल खाएं। फषे श शीलड कषे  ऊपि 

वसथत शीष्भ  वबंदुओ ंको अरी पुनव्य्भववसथत न किें ।

तित्र 6.4.18: शीरटि पबंदओुं के अनय युगम सिेकट करें

हेिमेट पर रनचि ेबॉिटिर एज पुनवयटििरस्थ्त ्करना

• साइड व्य ूमें, मषेन मषेन्य ूसषे Select > Select Border Edge टूल का र्यन कि हषेलमषेट पि सबसषे वनरला हॉरिज़ॉनटल एज लपू सलषेक्ट किें , औि वफि जसैा 

वक नीरषे वरत्र में वदखा्या र्या ह ैलपू पि पहलषे औि वफि आवखिी एज पि वक्लक किें ।

• Move टूल की मदद सषे, सलषेक्ट वकए हुए एज लपू को नीरषे की ओि तब तक ड्ैर किें  जब तक की बाई ंओि कषे  शीष्भ  वबंदु संदर्भ  सकषे र में वदखाए रए 

वनरलषे वकनािषे  सषे मोटषे तौि पि मषेल न खानषे लरें।
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• साइड व्य ूमें, Move टूल की मदद सषे एज लपू पि वसथत शषेष बरषे शीष्भ  वबंदुओ ंको अलर-अलर सलषेक्ट 

औि पुनव्य्भववसथत किें , वजससषे वषे संदर्भ  सकषे र सषे मषेल खानषे लरें।

िेस शीलि ्ेक ऊपरी र्कनारे पर बॉिटिर एज संपारद्त ्करना

• सलषेक्ट मषेन्य ूसषे, Select Border Edge Tool रुनें।

• साइड व्य ूमें, पहलषे बॉड्भि एज पि वक्लक किें  वजसका उप्योर फषे स शीलड कषे  ऊपिी वकनािषे  (एज) कषे  रूप 

में होरा, वफि अंवतम बॉड्भि एज पि वक्लक किें । बीर कषे  बॉड्भि एज सलषेक्ट हो रए।

• टूलबॉक्स में, Rotate टूल कषे  आइकन पि वक्लक कि उसषे सलषेक्ट किें ।

• साइड व्य ूमें, वामावत्भ  (क्लॉकवाइज़) वदशा में िोटषेट मवैनपुलषेटि को तब तक वक्लक-ड्ैर किें  जब तक 

की बॉड्भि एज मोटषे तौि पि उसी कोण सषे न घमू जाएं जो संदर्भ सकषे र में संरत वकनािषे  (एज) का ह।ै

• बॉड्भि एज वसलषेक्ट वक्यषे हुए ही, Move टूल पि वफि सषे वक्लक किें  औि हिषे  मवैनपुलषेटि 

को ऊपि की ओि ड्ैर किें  तावक वह संदर्भ सकषे र में बॉड्भि एज कषे  सथान सषे मषेल खा्यषे।

• हषेलमषेट कषे  ऊपिी सममुख रार पि शीष्भ  वबंदुओ ं कषे  ्ुयगम पुनव्य्भववसथत किें  तावक वषे 

संदर्भ  सकषे र सषे सुमषेवलत हो जाएं।

तित्र 6.4.19: तनििे बॉिटिर एज को पुनव्टिित्थि करें

तित्र 6.4.20: बिे हए शीरषों को िुनें और ्थान-
पररििटिन (रीपोज़ीशन) करें 

तित्र 6.4.21: बॉिटिर तसरे (एज) को िुनें 

तित्र 6.4.22: बॉिटिर तसरे को तखसकाएं 

हेिमेट ्ेक बगि ्ेक रहससे पर रस्थ्त शीषटि रबंदुओ ं ्को हेिमेट ्की साइि पर रीपोज़ीशन/्करना, 

रजससे िह स्ेकच से मेि खाये

• फं्ट व्य ूवडसपलषे किें ।

• फं्ट व्य ूमें, उन सरी शीष्भ  वबंदुओ ंका र्यन किें  जो हषेलमषेट की बाह्य िषे खा सषे बाहि वसथत हैं जसैा वक 

संदर्भ सकषे र में वदखा्या र्या ह।ै 
तित्र 6.4.23: िुनना
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• फं्ट व्य ूमें, इन शीष्भ  वबंदुओ ंको बाई ंओि लषे जाएं जब तक वक वषे संदर्भ  सकषे र में हषेलमषेट कषे  सवा्भ विक 

ववसततृ वहससषे सषे मषेल न खानषे लरें।

तित्र 6.4.24: बाईं ओर तखसकाना

6.4.9 पसटिपेरकटि वयू में संपादन घट्क (एरिरटंग ्कमपोनेंट्स)

ओथपोगावफक व्य ूकी तुलना में पस्भपषेवक्टव व्य ूमें पॉलीरोन कमपोनेंट्स घटकों का सथान-परिवत्भन किना अविक रुनौतीपणू्भ  हो सकता ह ैक््योंवक जसैषे ही 

आप 3D व्य ूको ट्कै, डॉली ्या टमबल कितषे हैं वसैषे ही आपका फ्षे म ऑफ िषे फिें स बदल जाता ह।ै

मेश पर र्कसी शीषटि ्को मेश ्की रदशा में रखस्काना

• मषेश का पिीक्ण कितषे सम्य आप पस्भपषेवक्टव व्य ूको तब तक डॉली औि टमबल कितषे 

िहें जब तक वक आपको ऐसषे शीष्भ  नहीं वमल जातषे जो वक मषेश में सषे अवांव्त तिीकषे  सषे 

बाहि की ओि वनकलषे हुए हों।

तित्र 6.4.25: बाईं ओर तखसकाना

• मूव सषेवटंर एवडटि को प्रदवश्भत/वडसपलषे किनषे कषे  वलए टूलबॉक्स में मूव टूल पि डबल वक्लक किें ।

• मूव सषेवटंर एवडटि में मूव सषेक्शन में नॉम्भल ऑपशन को ऑन किें ।

तित्र 6.4.26: बाईं ओर तखसकाना

• पस्भपषेवक्टव व्य ू में, आप वजस शीष्भ  का सथान परिवत्भन किना राहतषे हैं उस पि वक्लक किें । शीष्भ 

हाइलाइट हो जाता ह ैऔि मूव मनैीपुलषेटि वदखाई दषेता ह ैजो वक ्यह दशा्भता ह ैवक इस मोड में तीन 

वदशाओ ंमें मूवमेंट हो सकती ह।ै

• U औि V हैंडल शीष्भ  को अपनषे संबंद्ध वसिों कषे  अनुसाि सलाइड कितषे हैं। जबवक N हैंडल शीष्भ  को ्या 

तो मषेश कषे  नज़दीक लषे जाता ह ै्या वफि उससषे दूि, वजस री वदशा में आप अपनषे माउस को मूव किें ।

तित्र 6.4.27: U और v हैंिि
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• शीष्भ  की आवश्यकता अनुसाि N हैंडल को अंदि ्या बाहि की तिफ ड्ैर किें । ्यह किनषे कषे  बाद मषेश का पिीक्ण किनषे कषे  वलए व्य ूको डॉली ्या टमबल 

किें  औि आवश्यक संशोिन किें ।

• मषेश पि वकसी अन्य बाहि ्या अंदि की ओि कषे  शीषकों कषे  वलए ऊपि वालषे रिण तब तक दोहिाएँ जब तक वक मषेश समूथ नहीं हो जाता ह।ै

• अरलषे सषेक्शन पि जानषे सषे पहलषे मूव टूल पि डबल वक्लक किें  औि मूव सषेवटंर को वडफॉलट वलड्भ  सषेवटंर पि वापस लषे आएं।

6.4.10 पॉिीगोन बनाना

हषेलमषेट का सामनषे का वनरला रार (वह रार जो हषेलमषेट पहननषे वालषे कषे  मँुह औि जबडषे की िक्ा किता ह)ै बनानषे कषे  वलए आप सामनषे कषे  वनरलषे रार कषे  

क्रॉस सषेक्शन कषे  वलए वक्रएट Polygon टूल का इसतषेमाल किकषे  मनुैअल रूप सषे शीषकों को िखकि पॉलीरोन बनाएंरषे। 

पॉलीरोन कषे  वलए शीषकों को िखना

• साइड व्य ूमें, Mesh > Create Polygon Tool >Polygon टूल रुनें। वक्रएट Polygon टूल सषेवटंगस एवडटि वदखाई दषेरा।

• टूल सषेवटंगस एवडटि में वनमनवलवखत ववकलपों को सषेट किें :

» वबंदुओ ंकी संख्या सीवमत िखें: ऑन

» वबंदुओ ंकी सीवमत संख्या: 6

• सलाइड व्य ूमें प्रोफाइल कषे  वलए ्ह वबंदुओ ंको िखें जो वक हषेलमषेट कषे  सामनषे कषे  वनरलषे रार कषे  क्रॉस सषेक्शन में वदखाई दषेतषे हैं (नीरषे तसवीि दषेखें)। 

सुवनवश्चत किें  वक इस रिण कषे  वलए आप शीषकों को घडी की ववपिीत वदशा (एंटी-क्लॉक्वाइज़) में िखें।

• पॉलीरोन फषे स पिूा हो जानषे कषे  बाद वक्रएट Polygon टूल को बंद किनषे कषे  वलए q की दबाएं।

तित्र 6.4.28: मेश को ्मूथ करना

तित्र 6.4.29: पॉिीगोन फेस बनाना
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सामने ्ेक रनचि ेभाग ्ेक रिए पॉिीगोन िेस ्को बाहर रन्कािना।

• सीन व्य ूको एकल/वसंरल पस्भपषेवक्टव व्य ूमें ववसतारित/एन् लाज्भ किें ।

• पॉलीरोन फषे स को वसलषेक्ट वक्यषे हुए, Edit Mesh > Extrude रुनें। र्यवनत फषे स पि एक्सट्रू ड मनैीपुलषेटि वदखाई दषेता ह।ै

• पस्भपषेवक्टव व्य ूमें, मषेश कषे  एक सषेक्शन को फषे स सषे (िनातमक X) लररर आिी वगड इकाई की दूिी पि बाहि वनकालनषे कषे  वलए मनैीपुलषेटि पि नीलषे 

तीि को ड्ैर किें ।

• वफि सषे एक्सट्रू ड किनषे कषे  वलए g की दबाएं।

• िोटषेट मनैीपुलषेटि को प्रदवश्भत/वडसपलषे किनषे कषे  वलए उस बडषे वतृ्त पि वक्लक किें  जो वक मनैीपुलषेटि को घषेिषे  िहता ह ैऔि उसकषे  बाद िषे फिें स सकषे र 

(तसवीि दषेखें) में वद्यषे कोण सषे एक्सट्रू शन कोण का वमलान किनषे कषे  वलए एक्सट्रू शन कोण को घुमानषे कषे  वलए हिषे  वतृ्ताकाि मनैीपुलषेटि को ड्ैर किें । 

इसकषे  बाद मषेश कषे  दूसिषे  रार को बाहि वनकालनषे कषे  वलए दूसिी बाि तीि मनैीपुलषेटि को ड्ैर किें ।

तित्र 6.4.30: एकसट्रूपिंग

तित्र 6.4.31: एकसट्रूशन के कोण को घुमाइए

• G की वफि सषे दबाएं औि मषेश कषे  एक्सट्रू डषेड रार को वखसकानषे, घुमानषे ्या नापनषे कषे  वलए मनैीपुलषेटि का इसतषेमाल किकषे  तीसिा एक्सट्रू डषेड क्षेत्र 

बनाएं तावक िषे फिें स की तुलना में आप इसषे सही सथान पि िख सकें ।

तित्र 6.4.32: िीसरा एकसट्रूिेि भाग बनाना



193192

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

एकसट्रू िेि मेश पर से अनािशय्क िेस हटाना

• जब तक आप सामनषे कषे  वनरलषे रार को नहीं दषेख लषेतषे तब तक पस्भपषेवक्टव व्य ूको टमबल कितषे िहें। 

तित्र 6.4.33: आंिररक फेसरों को तसिेकट और तििीट करना

• एक्सट्रू शन कषे  दोनों वसिों कषे  फषे स सवहत हाल ही में एक्सट्रू डषेड की रए मषेश कषे  अंदि कषे  फषे स को 

रुनें। ्यषे फषे स वनरलषे रार कषे  एक्सट्रू डषेड रारों को बनानषे कषे  वलए आवश्यक थषे लषेवकन इसकषे  

बाद ज़रूिी नहीं हैं।

• र्यवनत फषे वसस को हटानषे कषे  वलए Delete की दबाएं।

• जब आपका काम पिूा हो जाएरा तब वनरलषे रार कषे  एक्सट्रू डषेड रार औि हषेलमषेट मषेश की बीर 

जरह खाली जरह मौजदू िहषेरी।

तित्र 6.4.34: दो मेशरों के बीि खािी जगह मौजूद हवै

हेिमेट मेश ्ेक रनचि ेर्कनारों ्को बाहर रन्कािना

• पस्भपषेवक्टव व्य ूमें हषेलमषेट मषेश कषे  वनरलषे वकनािों को Select > Select Border Edge टूल का इसतषेमाल किकषे  रुनें।

• Edit Mesh > Extrude रुनें, इसकषे  बाद ऐसषे वकनािों की पंवक्त बनानषे कषे  वलए जो वक र्यवनत वनरलषे वकनािों पि लंबवत हों, हषेलमषेट कषे  अंदि की वदशा 

में नीलषे तीि मनैीपुलषेटि को ड्ैर किें । इन वकनािों को एक वगड इकाई की रहिाई सषे एक्सट्रू ड किें ।

िेस शीलि ्ेक रिए ऊपरी और साइि ्ेक रसरों ्को एकसट्रू ि ्करना

• पस्भपषेवक्टव व्य ूमें हषेलमषेट मषेश कषे  ऊपिी औि साइड कषे  वसिों को Select > Select Border Edge Tool (नीरषे तसवीि दषेखें) का इसतषेमाल किकषे  रुनें।

• Edit Mesh > Extrude रुनें औि इसकषे  बाद वसिों को बनानषे कषे  वलए, जो वक फषे स शीलड कषे  ऊपिी औि साइड कषे  वसिों पि लंबवत हैं, हषेलमषेट कषे  अंदि 

की वदशा में नीलषे तीि को एक्सट्रू ड मनैीपुलषेटि पि ड्ैर किें । इन वकनािों को एक वगड इकाई की रहिाई सषे एक्सट्रू ड किें

तित्र 6.4.35: ऊपरी और साइि के तसररों को अंदर की िरफ एक्ट्यूि करें
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रेिरें स स्ेकच से रमिान ्करने ्ेक रिए शीषषों ्को रनचि ेऊपरी भाग पर रखस्काएं।

तित्र 6.4.36: ऊपरी और साइि के तसररों को अंदर की िरफ एक्ट्यूि करें

तित्र 6.4.37: िाररों शीरषों का ियन करें

• पस्भपषेवक्टव व्य ूमें हषेलमषेट पि दा्यां वक्लक किें  औि वसलषेक्शन टाइप को ववट्भवसस किनषे कषे  वलए वटदेक्स मोड वसलषेक्ट किें ।

• हषेलमषेट कषे  वनरलषे सामनषे वालषे रार कषे  राि शीषकों को रुनें जो वक समरूपता (नीरषे तसवीि दषेखें) अक् कषे  नज़दीक हैं औि मूव टूल का इसतषेमाल किकषे , 

मूव टूल कषे  हिषे  तीि को ड्ैर किकषे  वसलषेक्ट वक्यषे र्यषे शीषकों को ऊपि की ओि मूव किें ।

तित्र 6.4.38: शीरषों को ऊपर की िरफ तखसकाएं

• वनरलषे रार कषे  उन शीषकों को एडजसट किें , वजनहें ज़रूित कषे  अनुसाि वसलषेक्ट किकषे  औि मूव किकषे  थोडा िीपोज़ीशन किना पड सकता ह।ै
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6.4.11 रसरों ्को जोड़ना (रब्रजंग)

आरषे आप वनरलषे सामनषे वालषे रार को हषेलमषेट मषेश सषे जोडषेरें। आप Bridge ववशषेषताओ ं(Edit Mesh > Bridge) की सहा्यता सषे मषेशषेस बना सकतषे हैं जो वक 

मषेश कषे  एक ्या अविक बॉड्भि एवजज़/वसिों को जोडें।

वरिज फीरि का इसतषेमाल कितषे सम्य आपको ध्यान िखना रावहए वक:

• जोडषे जानषे वालषे वसिषे  एक ही पॉलीरोन मषेश में हों। इसका मतलब ्यह ह ैवक वरिज पिफॉम्भ  किनषे सषे पहलषे आप कमबाइन फीरि का इसतषेमाल किकषे  दो 

मषेशों को एक बनाएं।

• वरिज वक्यषे जानषे वालषे क्षेत्र कषे  दोनों ओि आप बॉड्भि एवजज़ की बिाबि संख्या वसलषेक्ट किें

हेिमेट ्ेक साइि ररजन (क्ेत्र) पर एज िू्पस िािना

• Edit Mesh > Insert Edge Loop Tool का र्यन किें । इनसट्भ एज लपू टूल सषेवटंगस एवडटि वदखाई दषेरा।

• टूल सषेवटंगस एवडटि में वनमनवलवखत ववकलपों को सषेट किें । पोज़ीशन बना्यषे िखषे: एज सषे सापषेक् दूिी

• पस्भपषेवक्टव व्य ूमें, नीरषे तसवीि में वदखाए अनुसाि वसिषे  कषे  नीरषे वसथत हषेलमषेट कषे  साइड रिजन कषे  एज को वक्लक-ड्ैर किें । माउस बटन को ्ोडषे  

वबना माउस को ऊपि की ओि, लररर एक वतहाई दूिी तक एज कषे  साथ-साथ लषे जाएँ औि वफि एज लपू इनसट्भ किनषे/डालनषे कषे  वलए माउस बटन 

को ्ोड दें।

तित्र 6.4.39: साइि एज को ड्वैग करें

• इनसट्भ एज लपू टूल कषे  एवक्टव िखषे हुए ही उसी एज कषे  टॉप कषे  वनकट वसथत हषेलमषेट कषे  साइड कषे  रार को वक्लक-ड्ैर किें  औि वसिषे  कषे  साथ-साथ 

लररर दो वतहाई दूिी का एक दूसिा एज लपू इनसट्भ किें /जोडें।

तित्र 6.4.40: साइि एज को ड्वैग करें
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हेिमेट ्ेक िोअर फं्ट (रनचि ेसामने ्ेक रहससे) और साइि ररजन (र्कनारे िािा क्ेत्र) ्ेक बीच रब्ज 

्करना (जोड़ना)

• Select > Select Border Edge Tool रुनें औि इसकषे  बाद मषेश कषे  लोअि फं्ट औि साइड रिजन कषे  उन 

वहससों, जहां आप वरिवजंर मषेश कंसट्क्ट किना राहतषे हैं, कषे  बॉड्भि एवजज़ पि वक्लक किें ।

• Edit Mesh > Bridge का र्यन किें । 

• वरिज ऑपशनस ववंडो में वडववज़न को 0 पि सषेट किें  औि उसकषे  बाद वरिज वक्रएट किनषे कषे  वलए Bridge बटन पि वक्लक किें ।

• वसलषेक्ट मोड पि वापस लौटनषे कषे  वलए q की दबाएं औि एवजज़ को अनवसलषेक्ट किनषे कषे  वलए मषेश में कहीं री वक्लक किें ।

6.4.12 मेश में पॉिीगोन जोड़ना/एि ्करना

हषेलमषेट पि सुिक्ातमक फषे स शीलड कषे  वलए आप एपेंड टु पॉलीरोन टूल का इसतषेमाल किकषे  एक बडा बहु-पक्ी्य (मलटी-साइडषेड) पॉलीरोन बनाएंरषे औि 

उसकषे  बाद उसषे कई सािषे  राि साइड वालषे पॉलीरोन (क्वाड) में इस प्रकाि ववरावजत किें रषे वक न्यषे पॉलीरोन हषेलमषेट मषेश कषे  मौजदूा फोि-साइडषेड टॉपोलॉजी 

सषे वमलता जुलता हो।

एपेंि टु Polygon Tool ्का इस्तमेाि ्कर्ेक िेस शीलि बनाना

• पस्भपषेवक्टव व्य ूको टमबल किें  तावक आप फषे स शीलड कषे  रािों तिफ कषे  सरी एवजज़/ वसिों को दषेख सकें ।

• Edit Mesh > Append to Polygon Tool वसलषेक्ट रुनें। 

• एपेंड टु पॉलीरोन टूल सषेवटंगस ववंडो में न्य ूफषे सषेस पलानि को बंद िखें। अरि पलानि ववकलप ऑन होरा, तो एपेंड टु पॉलीरोन टूल मलटी-साइडषेड 

पॉलीरोन नहीं बना पा्यषेरा, क््योंवक जो एवजज़ आपनषे वसलषेक्ट वक्यषे हैं, वषे पलानि रार नहीं बनातषे हैं।

• पस्भपषेवक्टव व्य ूमें, वजस मषेश को आप एपेंड किना राहतषे हैं उसषे दशा्भनषे कषे  वलए हषेलमषेट मषेश टॉप इनि (रीतिी) बॉड्भि एज पि एक बाि वक्लक किें  औि 

उसकषे  बाद एपेंड ऑपिषे शन शुरू किनषे कषे  वलए उसी वसिषे  पि दोबािा वक्लक किें  (नीरषे तसवीि दषेखें)।

• फषे स शीलड कषे  बॉटम एज (वनरलषे वसिषे ) पि वक्लक किें  जो वक उस वसिषे  कषे  ववपिीत ह ैवजस पि आपनषे अरी-अरी वक्लक वक्या था। एक पॉलीरोन 

वदखाई दषेता ह ैजो वक दोनों वसिों/एवजज़ को फैला दषेता ह।ै

तित्र 6.4.41: तसिेकट एतजज़

तित्र 6.4.42: अनतसिेकट एतजज़
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6.4.13 पॉिीगोन िेरसस ्को रस्पिट ्करना

• फषे स शीलड (नीरषे तसवीि दषेखें) कषे  ओपवनंर कषे  रािों ओि कषे  बरषे हुए बॉड्भि एवजज़ को घडी की रवत की ववपिीत वदशा में वक्लक किना तब तक जािी 

िखें जब तक वक आप अंवतम एज/वसिषे  तक नहीं पहँुर जातषे।

• फषे स शीलड की परिवि बॉड्भि एवजज़ पि वक्लक किना खतम किनषे कषे  बाद टूल सषे बाहि वनकलनषे कषे  वलए q की दबाएं।

मलटी-साइडषेड पॉलीरोन पिूा हो र्या ह ैऔि मौजदूा मषेश में जोड वद्या र्या ह।ै मलटी-साइडषेड पॉलीरोन को n-gons री कहा जाता ह।ै

इस पाठ कषे  शुरुआत में आपनषे मषेश में एज लपूस डालकि हषेलमषेट को वसपलट वक्या ह।ै वसपलट पॉलीरोन टूल का इसतषेमाल किकषे  आप मषेश कषे  परिसीवमत 

क्षेत्र/लोकलाइज् ़ड एरि्या को वसपलट कि सकतषे हैं।

िेस शीलि ्को िरटटि्किी रस्पिट/िंबि्त रिभारज्त ्करना

• Edit Mesh > Split Polygon Tool >_ रुनें।

» वसपलट पॉलीरोन टूल सषेवटंगस एवडटि वदखाई दषेता ह।ै

• वनमनवलवखत ववकलपों को सषेट किें :

» कषे वल एज सषे वसपलट किें : ऑन

» एज पि सनवैपंर पवाइंट्स प्र्योर किें : ऑन

» सनवैपंर टॉलिें स: 100

तित्र 6.4.43: मेश पर एपेंि होने िािे मल्टी-साइिेि फेस

तित्र 6.4.44: मेश पर एपेंि होने िािे मल्टी-साइिेि फेस
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• पस्भपषेवक्टव व्य ूमें कैमिा को टमबल किें  तावक आप फषे स शीलड कषे  अपि इनि एवजज़/ऊपिी आंतरिक वसिषे  औि लोअि इनि एवजज़/ वनरलषे आंतरिक 

वसिषे , दोनों दषेख सकें ।

• वसपलट शुरुआत को दशा्भनषे कषे  वलए (नीरषे तसवीि दषेखें) फषे स शीलड कषे  टॉप इनि एज को वक्लक-ड्ैर किें । वटदेक्स/शीष्भ  को पोज़ीशन किनषे कषे  वलए 

माउस को तब तक ड्ैर किें , जब तक वटदेक्स एज कषे  दाई ंओि रुक न जा्यषे।

• वसपलट की समावप्त को दशा्भनषे कषे  वलए (तसवीि दषेखें) हषेलमषेट मषेश कषे  लोअि इनि एज को वक्लक-ड्ैर किें । माउस को दाई ंओि ड्ैर किें , जब तक वटदेक्स 

एज कषे  दाई ंओि रुक न जा्यषे।

• फषे स को वसपलट किनषे कषे  वलए y की दबाएं।

• वसपलट पॉलीरोन टूल को वफि सषे वसलषेक्ट किनषे कषे  वलए g की दबाएं औि वफि नीरषे तसवीि में बताए 

अनुसाि अन्य सथानों पि फषे स शीलड को लंबवत ववरावजत/ववट्भकली वसपलट किना जािी िखें।

िेस शीलि ्को क्रै्तज रूप से रिभारज्त/हॉररज़ॉनटिी रस्पिट ्करना

• पस्भपषेवक्टव व्य ूमें, सपवलट पॉलीरोन टूल कषे  एवक्टव िहतषे हुए हॉरिज़ॉनटल वसपलट क्वैतज की सटाट्भ  लोकषे शन दशा्भनषे कषे  वलए इनि साइड एज को 

वक्लक-ड्ैर किें  (तसवीि दषेखें)।

• साइड व्य ूमें, फषे स शीलड कषे  फं्ट ववट्भकल बॉड्भि एज को वक्लक-ड्ैर किें  d (्यह बॉड्भि एज समरूपता अक् (एवक्सस ऑफ वसवमट्ी) पि होता ह)ै औि 

माउस बटन को एज कषे  साथ-साथ रलातषे हुए मध्य-वबंदु पि तब ्ोडें जब शीष्भ  सवाराववक रूप सषे सनपै होतषे हैं (जसैषे वक कोई रंुबक इनहें उस सथान 

की ओि आकवष्भत कि िहा हो)।

तित्र 6.4.45: इनर एतजज़ को ड्वैग करें

तित्र 6.4.46: एक पांि साइि िािा पॉिीगोन

तित्र 6.4.47: त्पिटटंग
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• फषे सषेस को वसपलट किनषे कषे  वलए y की दबाएं।

• सपवलट पॉलीरोन टूल सषे बाहि वनकलनषे कषे  वलए q की दबाएं।

िेस शीलि ्का शेप/आ्कार एिजसट ्करना

• साइड व्य ूमें, फषे स शीलड कषे  सामनषे वालषे रार पि वसथत बीर वालषे दो शीषकों का र्यन किें  औि मूव टूल का इसतषेमाल किकषे  शीषकों को थोडा सा बाहि 

(+Z) की तिफ मूव किें  (तसवीि दषेखें)।

• पस्भपषेवक्टव व्य ूमें, फषे स शीलड पि बरषे हुए बीर वालषे शीषकों को, एक सम्य में एक, वसलषेक्ट किें  औि मूव सषेवटंर ऑपशन को नॉम्भल पि सषेट किकषे  मूव 

टूल का इसतषेमाल किकषे  थोडा सा बाहि की ओि िीपोज़ीशन किें ।

• अरलषे रिण पि जानषे सषे पहलषे मूव टूल कषे  मूव सषेवटंगस टू वलड्भ  को रिसषेट किें ।

तित्र 6.4.48: त्पिटटंग

तित्र 6.4.49: फेस शील्ि का आकार एिज्ट करें 

र्तरछे/िायगनि ररिि िेंट्स ्ेक रिए मरलटपि एरजज़ इनसटटि ्करना

• Edit Mesh > Insert Edge Loop Tool > _ रुनें।

• इनसट्भ एज लपू टूल ऑपशंस ववंडो में वनमनवलवखत सषेट किें :

» मवलटपल एज लपूस: ऑन

» एज लपूस की संख्या: 4

» ऑटो कमपलीट: ऑफ

्यषे सषेवटंगस आपको उस फषे स पि राि समान अंतिाल/दूिी वालषे एवजज़ इनसट्भ किनषे की सुवविा प्रदान किती हैं, जहाँ आप राहतषे हैं वक आपकषे  वगल वेंट्स 

वदखाई दें।

• पस्भपषेवक्टव व्य ूमें, फषे स कषे  बॉड्भि एज को वक्लक किें  जहाँ वगल वेंट्स वदखाई देंरषे औि उसकषे  बाद उस बॉड्भि एज कषे  ठीक सामनषे वालषे बॉड्भि एज को 

वक्लक किें ।
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• एज लपू इंसश्भन पिूा किनषे कषे  वलए y की दबाएं।

• एवजज़ को वडवसलषेक्ट किनषे कषे  वलए ऑफ द मषेश पि वक्लक किें /मषेश को ऑफ किें  ।।

• टूल सषे बाहि वनकलनषे औि वसलषेक्शन मोड में वापस जानषे कषे  वलए q की दबाएं।

वगल वेंट्स कषे  वति्ा/डा्यगनल वदखनषे कषे  वलए आप दाई ंओि सषे ववट्भवसस वसलषेक्ट किें  औि मूव टूल का प्र्योर किकषे  उनहें नीरषे की ओि मूव किें ।

मूि टूि ्का इस्तमेाि ्कर्ेक िरटटिरसस ्को एज ्ेक सा्थ-सा्थ मूि ्करना

• हषेलमषेट मषेश पि िाइट-वक्लक किें  औि वसलषेक्शन मोड को बदल कि वटदेक्स कि दें।

• वगल फीरि कषे  दाई ंओि ववट्भवसस वसलषेक्ट किें ।

• मूव टूल कषे  सषेवटंर एवडटि को प्रदवश्भत/वडसपलषे किनषे कषे  वलए मूव टूल आइकन पि डबल वक्लक किें । 

मूव टूल कषे  सषेवटंगस एवडटि में Set to Edge बटन पि वक्लक किें । ववट्भवसस असथाई रूप सषे अनसलषेक्टषेड 

नज़ि आतषे हैं। मूव टूल आपसषे अपषेक्ा किता ह ैवक आप एक ऐसा एज रुनें, जो मूवमेंट कषे  अक् कषे  वलए 

संदर्भ हो।

• ऐसषे एज पि वक्लक किें , जो उनहीं एवजज़ की लाइन में हो, वजससषे आपनषे ववट्भवसस वसलषेक्ट की ह।ै

• मूव टूल मनैीपुलषेटि वदखाई दषेता ह ैऔि आपकषे  द्ािा वसलषेक्ट वक्यषे र्यषे एज कषे  साथ अलाइन ह।ै ववट्भवसस वफि सषे सलषेक्टषेड वदखाई दषेनषे लरतषे हैं, जो 

वक इस बात का संकषे त हैं, वक मूव टूल अब उन ववट्भवसस को उस एवक्सस कषे  साथ-साथ मूव किनषे कषे  वलए सषेट ह,ै जो आपकषे  द्ािा वसलषेक्ट वक्यषे र्यषे 

एज द्ािा परिरावषत ह।ै

• ववट्भवसस को मूव किनषे कषे  वलए लाल तीि को मूव मनैीपुलषेटि पि नीरषे की ओि ड्ैर किें  तावक वगल कषे  वलए फषे सषेस का आकाि अविक वति्ा/

डा्यगनल हो सकें ।

तित्र 6.4.50: तग्ि िें्टस

तित्र 6.4.51: तग्ि िें्टस
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• ववट्भवसस को वडवसलषेक्ट किनषे कषे  वलए मषेश को ऑफ किें

• अरलषे सषेक्शन पि जानषे सषे पहलषे, मूव टूल पि डबल वक्लक किें  औि Reset बटन पि वक्लक किकषे  टूल सषेवटंर को रिसषेट किें ।

ररिि िीचर ्ेक रिए िेसेस ्को एकसट्रू ि ्करना

तित्र 6.4.52

• हषेलमषेट मषेश पि िाइट-वक्लक किें  औि वसलषेक्शन मोड को बदल कि फषे सषेस किें ।

• वगल फीरि कषे  बॉटम/नीरषे सषे शुरुआत कितषे हुए, तसवीि में वदखाए अनुसाि दो वति ष्े  फषे सषेस को 

वशफट-वसलषेक्ट किें ।

• Edit Mesh > Extrude रुनें। एक्सट्रू ड मनैीपुलषेटि वदखाई दषेता ह।ै

• वगल कषे  वलए दो रिसषेसड वेंट्स बनानषे कषे  वलए हषेलमषेट की ओि कु् दूिी तक एक्सट्रू ड मनैीपुलषेटि पि 

नीलषे तीि को ड्ैर किें ।

तित्र 6.4.53: पििे तिरछे फेसरों को तशफट-तसिेकट करें

तित्र 6.4.54: तग्ि के तिए दो ररसे्ि िें्टस
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6.4.14 एज िू्पस ्को टरमटिनेट ्करना

जब आपनषे वगल वेंट्स कषे  वलए एवजज़ को इनसट्भ वक्या तब बिाबि वाला फषे स राि साइड में सषे आठ साइड में बदल र्या। शषे्यड्भ  एज/साझा वसिों कषे  साथ हुई 

वसपलवटंर कषे  रलतषे ऐसा हुआ।

मलटी-साइिेि पॉिीगोन ्को ्तीन िोर-साइिेि पॉिीगोन में मनैयुअिी रस्पिट ्करना

• Edit Mesh > Split Polygon Tool रुनें।

• पस्भपषेवक्टव व्य ूमें टॉप वगल वेंट कषे  टॉप साइड एज पि वक्लक-ड्ैर किें । अपनषे माउस को ड्ैर किें , वजससषे वटदेक्स एज कषे  बॉटम पि पोज़ीशन हो।

• मलटी-साइडषेड पॉलीरोन कषे  सबसषे ऊपिी वसिषे  को वक्लक-ड्ैर किें  औि वटदेक्स को एज कषे  दाएं वसिषे  की ओि सलाइड किें ।

• फषे स को वसपलट किनषे कषे  वलए y की दबाएं।

» सपवलट एज कषे  ऊपि का रार पॉलीरोन की तिह वदखाई दषेता ह ैलषेवकन वासतव में वगल वेंट पि एवजज़ होनषे कषे  कािण ्यह राि साइड वाला ह।ै

• वनरलषे वगल वेंट पि साइड एज को अपनषे माउस सषे उसी प्रकाि वक्लक ड्ैर किकषे  वसपलट किें , वजससषे वटदेक्स एज कषे  टॉप पि पोज़ीशन हो।

• एक्सट्रू ड फीरि सषे बाहि वनकलनषे कषे  वलए q की दबाएं।

• समरूपता अक् पि वसथत वगल वेंट्स कषे  दोनों साइड फषे स को वशफट -वसलषेक्ट किें  औि उनहें वडलीट 

किषे  दें (नीरषे तसवीि दषेखें)। हषेलमषेट कषे  ववपिीत आिषे रार को बनानषे कषे  वलए इन फषे सों की ज़रूित 

नहीं होरी।

• अरलषे खंड में जानषे सषे पहलषे अपना काम सषेव कि लें।

तित्र 6.4.55: दो साइि िािे फेसरों को तििीट करें

तित्र 6.4.56: फेस को त्पिट करें
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• मलटी-साइडषेड पॉलीरोन कषे  बॉटम एज को वक्लक ड्ैर किें  औि वटदेक्स को एज कषे  दाएं वसिषे  पि सलाइड किें  (तसवीि दषेखें) ।

• फषे स को वसपलट किनषे कषे  वलए y की दबाएं।

आपका मलटी-साइडषेड पॉलीरोन अब तीन फोि-साइडषेड फषे स में वसपलट हो र्या ह ैऔि हषेलमषेट मषेश की संपणू्भ  क्वाड टोपोलॉजी वसैी ही बनी हुई ह।ै

• सपवलट पॉलीरोन टूल सषे बाहि आनषे कषे  वलए q की दबाएं।

तित्र 6.4.57: साइि एज को त्पिट करें

6.4.15 ्ंकसट्कशन रहसट्ी ्को रििीट ्करना

अपनी कंसट्क्शन वहसट्ी कषे  ज़रि्यषे मा्या ऑपशंस, एवट्ब्यट्ूस तथा वकसी ऑबजषेक्ट में वक्यषे र्यषे ट्ांसफॉमदेशन का ट्कै िखता ह।ै कंसट्क्शन वहसट्ी उप्योरी 

ह,ै जब आप सफदे स पि काम कि िहषे हों औि मॉडल वडवषेलपमेंट कषे  प्रािंवरक रिण कषे  वकसी एवट्ब्यटू को एवडट किना राहतषे हों।

हेिमेट मेश पर ्ंकसट्कशन रहसट्ी रििीट ्करने ्ेक रिए

• मषेश पि िाइट-वक्लक किें  औि सषेलषेक्शन मोड को ऑबजषेक्ट में बदलें औि हषेलमषेट मषेश रुनें।

• रनैल बॉक्स प्रदवश्भत किें  ्यवद ्यह पहलषे सषे नहीं ह,ै तो औि इनपुट सषेक्शन में प्रदवश्भत हो िही वहसट्ी नोड्स की वलसट देंखें।

• Edit > Delete by Type > History रुनें।

हषेलमषेट मषेश पि कंसट्क्शन वहसट्ी वडलीट हो जाती ह।ै दषेखें वक इनपुट कषे  अंतर्भत आइटमों की सरूी में कषे वल एक ही आइटम शषेष ह ै- polySurfaceShape 

node।

तित्र 6.4.58: कं्ट्कशन तह्ट्ी तििीट करना
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6.4.16 मेश ्को रमरर ्कॉपी ्करना

जब आप अपनषे आिषे पॉवलरन मॉडल फाइनल कि रुकषे  हों, (औि इसका वनमा्भण इवतहास वडलीट कि दषेतषे हैं) तो आप सामनषे कषे  आिषे वसमषेट्ी कषे  अक् पि इसषे 

कॉपी किकषे  वक्रएट किना राहेंरषे, वजससषे आपकषे  पास पिूा मॉडल आ जा्यषे। Mirror Geometry (Mesh > Mirror Geometry) की मदद सषे आप पॉवलरोन मषेश 

की वमिड्भ  कॉपी त्ैयाि कि सकतषे हैं।

यह सुरनरश्च्त ्करने ्ेक रिए र्क बॉिटिर िरटटिरसस रसमेट्ी ्ेक अक् ्ेक सा्थ-सा्थ ही हैं।

• फं्ट व्य ूको बडा किें , वजससषे आप उन ववट्भवसस को दषेख सकें , जो वसमषेट्ी कषे  अक् कषे  अनुवदश वसथत होतषे हैं। मषेश पि ्यवद कोई शीष्भ  Y अक् कषे  अनुवदश 

बाहि वनकला होता ह,ै तो आपको सनपै टु वगड फीरि कषे  साथ मूव टूल की मदद सषे इनहें Y अक् तक काटना होरा।

• फं्ट व्य ूमें , उन सरी शीषकों का र्यन किें  वजनहें बाउंवडंर बॉक्स र्यन की मदद सषे समवमवत अक् (Y अक्) कषे  अनुवदश वसथत होना रावहए।

• सटषेटस लाइन पि, सनपै टु वगड राल ूकिें ।

• टूलबॉक्स में, मूव टूल पि डबल-वक्लक किकषे  इसकी सषेवटंर को प्रदवश्भत किें  औि सुवनवश्चत किें  वक रिटषेन कमपोनेंट सपषेवसंर सषेवटंर बनद ह।ै फं्ट व्य ू

में, लाल ऐिो को दाई ंओि कु् दूिी तक मूव टूल मवैनपुलषेटि पि वक्लक-ड्ैर किें ।

शीष्भ  ततकाल दाई ंओि वगड लाइन तक कट जाता ह।ै शुरुआत में वषे उस सथान पि वसथत नहीं होंरषे जहाँ आप राहतषे हैं, लषेवकन आप दषेखेंरषे वषे सरी शीष्भ 

वजनहें आपनषे रुना ह,ै संिषे वखत/अलाइंड हो जातषे हैं।

• मवैनपुलषेटि को तब तक बाई ंओि ड्ैर किें  जब तक वक वह शीष्भ  Y अक् तक सनपै न हो जाए।

• सटषेटस लाइन पि, सनपै टु वगड बंद किें ।

• शीषकों को अनवसलषेक्ट/अर्यवनत किनषे कषे  वलए मषेश को ऑफ किें ।

पॉरिगोन मेश ्को रमरर ्कॉपी ्करने ्ेक रिए

• मषेश पि िाइट-वक्लक किें , वसलषेक्शन मोड को ऑबजषेक्ट में बदलें औि वफि हषेलमषेट मषेश रुनें।

• Mesh > Mirror Geometry > _ रुनें, वनमनवलवखत ववकलप सषेट किें  औि वफि Mirror बटन पि वक्लक किें ।

» वमिि डा्यिषे क्शन: -X

» असली कषे  साथ ववल्य: ऑन

» शीषकों का ववल्य: ऑन

मषेश -X कषे  अनुवदश कॉपी हो जाता ह ैतावक मॉडल का सामनषे का आिा रार वक्रएट हो सकषे । दो मषेश सं्ुयक्त होकि एक हो जातषे हैं औि शीषकों का ववल्य हो 

जाता ह ैवजससषे वषे शषे्यड्भ  हो जातषे हैं।

• अरलषे खंड में जानषे सषे पहलषे अपना काम सषेव कि लें।

इस वबंदु पि, हषेलमषेट मॉडल का लो रिज़ोल्यशून वज्भन पिूा हो जाता ह।ै अरलषे खंड में आप प्रीव्य ूदषेखेंरषे वक सबवडव प्रॉक्सी फीरि की मदद सषे मॉडल हाइ 

रिज़ोल्यशून पि कैसा नज़ि आता ह।ै

तित्र 6.4.59: मवैतनपुिेटर ड्वैग करें
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6.4.17 समू्थेि मेश ्ेक सा्थ ्काम ्करना
सबरिि प्रॉकसी ्की मदद से हाइ ररज़ोलयूशन समू्थेि मॉिि रक्रएट ्करना

• मषेश पि िाइट-वक्लक किें , वसलषेक्शन मोड को ऑबजषेक्ट में बदलें औि वफि हषेलमषेट मषेश रुनें।

• Proxy > Subdiv Proxy > _ रुनें, औि वनमनवलवखत सषेट किें :

» वडवीजन लषेवलस: 2

» वमिि वबहषेवव्यि: कोई नहीं

» सबवडव प्रॉक्सी शषेडि: िवख्यषे

• Smooth बटन पि वक्लक किें ।

ओरिवजनल मषेश की ही पोज़ीशन पि हषेलमषेट मषेश की एक हाइ रिज़ोल्यशून, समूथषेड कॉपी बन जाती ह।ै 

इस पोज़ीशन पि दो वज्भनों को दषेखना संरव होता ह ै(औि आप वकसी एक को ्या दोनों को प्रदवश्भत 

किनषे कषे  वलए टॉरल कि सकतषे हैं) लषेवकन इस पाठ में आप हाइ रिज़ोल्यशून वज्भन का र्यन किें रषे 

औि इसषे थोडा सा बाई ंओि मूव किें रषे।

• ऑबजषेक्ट मोड में मषेश कषे  दोनों वज़्भन, हाइ तथा लो रिज़ोल्यशून को सलषेक्ट किें ।

• हाइ तथा लो रिज़ोल्यशून वज़्भनों कषे  बीर टॉरल किनषे कषे  वलए की दबाएं (्यह 1 की कषे  बाई ंओि 

होती ह)ै

• दोनों वज्भनों की बीर वडसपलषे टॉरल किना तब उप्योरी होता ह ैजब आप वकसी एक ्या दूसिषे  को 

दषेखना राहतषे हैं।

• वडसपलषे टॉरल किनषे कषे  वलए ~ की दबाएँ वजससषे दोनों दुबािा वदखाई दषेनषे लरतषे हैं।

• ऑबजषेक्ट मोड में कषे वल समूथ वज्भन सलषेक्ट किें  औि इसषे लररर 25 ्यवूनट (X = -25) बाई ंओि वखसकाएँ।

• ज्योंही आप हषेलमषेट मषेश कषे  लो रिज़ोल्यशून वज्भन को एवडट कितषे हैं आपको इसकषे  पी ष्े  समूथ वज्भन पि इससषे होनषे वालषे अपडषेट वदखाई देंरषे।

तित्र 6.4.60: संपूणटि मॉिि का तनमाटिण करें

तित्र 6.4.61

तित्र 6.4.62: ्मूथ िजटिन तखसकाएुँ/मूि करें
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6.4.18 मेश पर एरजज़ ्की क्रीरजंग और हािमेरनंग

आप अपनषे पॉवलरोन मषेश कषे  एवजज़ को क्रीज़ औि हाडदेन कि सकतषे हैं। एवजज़ की हाडदेवनंर औि क्रीवजंर ्यह त्य किता ह ैवक फषे वसस/पषृ्ठों कषे  बीर मषेश 

ट्ांवजशन वकस प्रकाि आपकषे  मॉडल की वासतववकता को बढाता ह।ै

मेश पर हािटि और सॉफट एज प्रदरशटि्त ्करने ्ेक रिए

• लो रिज़ोल्यशून मषेश पि िाइट-वक्लक किें , वसलषेक्शन टाइप को ऑबजषेक्ट मोड में बदलें औि वफि हषेलमषेट मषेश रुनें।

• Display > Polygons > Soft/Hard Edges रुनें।

हषेलमषेट पि वा्यिफ्षे म मषेश डैश् ड तथा सॉवलड, दोनों लाइनें वडसपलषे किनषे कषे  वलए अपडषेट हो जाता ह।ै डैश् ड लाइनें उन एवजज़ को इंवरत किती हैं, वजनहें 

सॉफट शषेवडड कषे  रूप में वडसपलषे किनषे कषे  वलए सषेट वक्या र्या ह।ै सॉवलड लाइंस उन एवजज़ को इंवरत किती हैं, वजनहें हाड्भ  शषेवडड कषे  रूप में वडसपलषे किनषे 

कषे  वलए सषेट वक्या र्या ह।ै

• मषेश पि एवजज़ को सॉफट किना

• हषेलमषेट कषे  लो रिज़ोल्यशून वज़्भन को सलषेक्ट वक्यषे हुए ही Normals > Soften Edge का र्यन किें ।

हषेलमषेट मषेश पि सरी एवजज़ सौम्य तिीकषे  सषे शषे ड किनषे कषे  वलए सषेट वकए रए हैं। वा्यिफ्षे म मषेश डैश् ड लाइंस कषे  रूप में वडसपलषे होनषे कषे  वलए अपडषेट हो जाता 

ह,ै जो वक इस बात का संकषे त ह,ै वक सर एवजज़ को सॉफट शषेड कषे  वलए सषेट वक्या र्या ह।ै

िेस शीलि ्ेक आस-पास ्ेक एरजज़ ्को ्कठोर/हािटिन ्करना

• लो रिज़ोल्यशून मषेश पि दा्याँ वक्लक किें  औि एज को वसलषेक्शन मोड पि सषेट किें ।

• फषे स शीलड की परिवि कषे  आस-पास आंतरिक वकनािों/इनि एवजज़ को सलषेक्ट किें  ।

तित्र 6.4.63: सॉतिि और िवैश् ि फे्म िाइनें

तित्र 6.4.64: िवैश् ि फे्म िाइनें
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्कीप हािटि एज एरट्बयूट ऑन ्करना

• पस्भपषेवक्टव व्य ूमें हषेलमषेट मषेश का कषे वल समूथषेड हाइ रिज़ोल्यशून वज़्भन सलषेक्ट किें ।

• रनैल बॉक्स में इनपुट सषेक्शन में इसकषे  एवट्ब्यट्ूस प्रदवश्भत किनषे कषे  वलए वलसटषेड प्रॉक्सी पि वक्लक किें ।

• कीप हाड्भ  एज एवट्ब्यटू ऑन पि सषेट किें ।

अब समूथषेड हाइ रिज़ोल्यशून वज़्भन पि फषे स शीलड औि शषेष हषेलमषेट कषे  बीर शाप्भि ट्ांवज़शन वदखाई दषेता ह।ै

• वगल वेंट्स कषे  वलए सरी एवजज़ सलषेक्ट किें  औि उनहें री हाड्भन /कठोि किें ।

तित्र 6.4.65

तित्र 6.4.66: एतजज़ को हािटि करना

मेश पर एरजज़ ्को क्रीज़ ्करना

• फषे स शीलड पि वनमन बाह्य वकनािों/लोअि आउटि एवजज़ का र्यन किें  (्वव दषेखें)।

• Edit Mesh > Crease Tool का र्यन किें ।

• सीन व्य ूमें बीर का माऊस बटन दबाएँ औि सलषेक्ट वक्यषे हुए एवजज़ पि क्रीज़ एड किनषे कषे  वलए माउस को दाई ंओि ड्ैर किें ।

• अपना काम सषेव किें ।



209208

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

तित्र 6.4.67: मोटी िाइनें नज़र आना
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यूरनट 6.5: NURBS मॉिरिंग

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Maya सॉफटवषे्यि-NURBS पि 3D एवनमषेशन तकनीक कषे  एवपलकषे शन में।

2. NURBS मॉडवलंर पि Maya कषे  साथ काम किना।

6.5.1 पररचय 

NURBS (नॉन-्यवूनफॉम्भ  िषे शनल B-सपलाइंस) कवस्भ औि सफदे स को रवणती्य रूप सषे ववण्भत किनषे की वववि का उप्योर किता ह ैजो 3D एवपलकषे शन कषे  

वलए उप्ुयक्त होती हैं। NURBS, उनकषे  द्ािा बनाए जानषे वालषे समूथ आरदेवनक फॉमस्भ कषे  द्ािा जानषे जातषे हैं।

NURBS सतहों को वववरनन तकनीकों कषे  ज़रिए तषेज़ी सषे मॉडल औि एवडट वक्या जा सकता ह।ै NURBS सतह को एक ्या उससषे अविक NURBS कव्भ का 

उप्योर किकषे  बना्या जाता ह ैजो आपकी वांव्त सतह कषे  वलए आकाि की प्रोफाइल को वनिा्भ रित कितषे हैं औि वफि एक वववशष्ट वनमा्भण वववि का प्र्योर 

किकषे  वफवनश् ड सफदे स की िरना की जाती ह।ै

NURBS सतह बनानषे की सिल तकनीक ह ैवांव्त फॉम्भ  कषे  प्रोफाइल कषे  वलए कव्भ का वनमा्भण किें  औि वफि Maya में उपलबि वववरनन NURBS सफदे वसंर 

टूलस में सषे वकसी एक का उप्योर किकषे  सफदे स का वनमा्भण किना। इस अध्या्य में NURBS कव्भ औि रिवोलव टूल का उप्योर किकषे  आप एक एर होलडि 

बनातषे हैं।

यूरनट ्ेक उद्ेशय  

6.5.2 प्रोिाइि ्किटि ्का रनमाटिण ्करना

रिवोलव कुम् हाि कषे  घमूतषे पवह्यषे सषे बत्भन को आकाि दषेनषे की तकनीक कषे  समान ही एक सामान्य मॉडवलंर तकनीक 

ह।ै आपको सबसषे पहलषे ओथपोगावफक व्य ूमें एक प्रोफाइल कव्भ का वनमा्भण किना रावहए औि सफदे स बनानषे कषे  वलए 

रिवोल् व टूल का उप्योर किें ।

प्रोिाइि ्किटि ्का रनमाटिण ्करना

• सुवनवश्चत किें  वक आपनषे पषृ्ठ 165 पि “अध्या्यों कषे  वलए त्ैयाि किना” में वदए रए रिणों को पणू्भ  कि 

वल्या वक्या ह।ै

• सीन कषे  मवलटपल व्यजू़/कई सािषे  दृश्य दषेखनषे कषे  वलए Panels > Layouts > Four Panes का र्यन किें ।

तित्र 6.5.1: किटि का तनमाटिण करना

तित्र 6.5.2: प्रोफाइि किटि बनाना
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• Create > CV Curve Tool का र्यन किें । कव्भ ड्ॉ किनषे कषे  वलए उप्योर वक्या जानषे वाला ्यह टूल सबसषे आम टूल ह।ै 

• फं्ट व्य ूमें वरत्र में वदखाए अनुसाि, नमबड्भ  पोज़ीशंस पि वक्लक किें । सुवनवश्चत किें  वक पहली औि अंवतम वसथवत्याँ वगड कषे  Y अक् (फं्ट व्य ूवगड की 

सबसषे माटी ववट्भकल लाइन) पि हों। 

पोज़ीशन 9, 10 तथा 11 कषे  वलए एक ही जरह पि तीन बाि वक्लक किें । कव्भ में शाप्भ  पवाइंट/तीक्ण वबनदु ्या कोना बनानषे कषे  वलए ्यह ज़रूिी ह।ै

आवखिी वक्लक वकए रए वबनदु की वसथवत बदलनषे कषे  वलए आप इसषे माऊस कषे  बीर कषे  बटन सषे ड्ैर कि सकतषे हैं। 

• सीन व्य ूमें वजन वबनदुओ ंपि आपनषे वक्लक वक्या वषे पिूषे  हुए कव्भ कषे  कंट्ोल ववट्भवसस (CV) बन जातषे हैं।

6.5.3 ररिोलि सिमे स ्का रनमाटिण ्करना

• आउट लाइनि में सरूी में आपकषे  रिवोल् व वक्यषे र्यषे कव्भ (curve1) को इसकषे  नाम पि 

वक्लक किकषे  रुनें। सीन व्य ूमें कव्भ प्रकावशत हो जाता ह।ै

• फं्ट व्य ूमें िाइट-वक्लक किें  औि मावकयं र मषेन ूसषे कंट्ोल वटदेक्स का र्यन किें । कव्भ कषे  

वलए CV वदखाई दषेरा।

• अपनी आवश्यकता कषे  अनुसाि कव्भ कषे  आकाि को एडजसट किनषे कषे  वलए एक ्या 

अविक CV का र्यन किें  औि मूव किें । ।

अरि आपको फं्ट व्य ूमें CV कषे  र्यन में समस्या होती ह ैतो इसषे पस्भपषेवक्टव व्य ूमें कैमिा को 

आवश्यकतानुसाि डॉली औि टंबल किकषे  सलषेक्ट किें ।

इससषे एर होलडि कषे  आकाि में बदलाव आता ह ैक््योंवक ्यह इसकी कंसट्क्शन वहसट्ी कषे  ज़रि्यषे 

कव्भ कषे  आकाि सषे जुडा ह/ैवलंक् ड ह।ै

• ज़रूित हो, तो सीन को रववष््य में समीक्ा कषे  वलए सषेव किें ।

• आउटलाइनि ववंडो बंद किें ।

रिवोलव सफदे स टूल कषे  साथ सफदे स बनानषे कषे  वलए कव्भ को अक् पि िोटषेट वक्या जाता ह।ै उप्योरकता्भ  रिवोल्यशून कषे  अक् को वनिा्भ रित कि सकता ह।ै

ररिोलि सिमे स ्का रनमाटिण ्करना

• कव्भ को सलषेक्ट िखषे हुए ही Surfaces > Revolve का र्यन किें । ्यह रिवोलवड प्रोफाइल कव्भ सषे एर होलडि सफदे स का वनमा्भण किता ह।ै पस्भपषेवक्टव 

व्य ूमें परिणामों का पिीक्ण किें । 

Maya प्रोफाइल कव्भ को वडलीट नहीं किता। बाद कषे  रिणों में आप सफदे स कषे  आकाि को बदलनषे कषे  वलए प्रोफाइल कव्भ को संपावदत किें रषे।

• सफदे स का र्यन किें  औि रनैल बॉक्स में इसका नाम बदलकि एरहोलडि किें ।

• पवांइटि को पस्भपषेवक्टव व्य ूमें िखषे हुए, 5 दबाएँ (Shading > Smooth Shade All कषे  वलए)।

्यह एर होलडि को पस्भपषेवक्टव व्य ूमें वा्यिफ्षे म की बजा्य शषेडषेड सफदे स कषे  रूप में प्रदवश्भत किता ह।ै

्ंकसट्कशन रहसट्ी ्ेक सा्थ सिमे स ्को एरिट ्करना 

• Window > Outliner का र्यन किें । आउटलाइनि वदखाई दषेता ह ैऔि सीन में आइटमस की सरूी को प्रदवश्भत किता ह।ै

तित्र 6.5.3: कं्ट्कशन तह्ट्ी



211210

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

6.5.4 NURBS सिमे स सकल्पट ्करना

6.5.5 आसानी से दखेने ्ेक रिए सिमे स सामरिी/मटैीररयि ्को संशोरध्त ्करना

सफषे ्यि (वतृ्त) को सक्लपट किनषे कषे  वलए त्ैयाि किना

• सुवनवश्चत किें  वक आपनषे पषृ्ठ 165 पि “अध्या्यों कषे  वलए त्ैयाि किना” में वदए रए रिणों 

को पणू्भ  कि वल्या वक्या ह।ै

• Create > NURBS Primitives > Sphere > सलषेक्ट किें । options window में Edit > Reset 

Settings सलषेक्ट किें  औि वनमन वलै्य ूएंटि किें :

» िषे वड्यस (वत्रज्या): 6

» सषेक्शन की संख्या: 30

» सपैंस की संख्या: 30

• िषे वड्यस वगड ्यवूनट्स में सफषे ्यि का आकाि सषेट कि दषेता ह।ै वलै्य ू6 िखनषे सषे इतना बडा 

सफषे ्यि बन जाता ह,ै वक इसकषे  आाकि की तुलना कषे  वलए वगड प्र्योर की जा सकषे ।

• सफषे ्यि एरहषेड का का नाम िखें। 

• सफषे ्यि को इसकि साइड पि 90 वडगी िोटषेट किें  (Z को घुमाएँ: 90)। इससषे सफषे ्यि का CV 

एक सािािण वसि तथा रषेहिा मॉडल किनषे कषे  वलए वबलकुल ठीक सषे पोज़ीशन हो जाता ह।ै 

इसका कािण आप बाद में इस अध्या्य में जानेंरषे।

• एरहषेड को अंडषे का आकाि दषेनषे कषे  वलए सफषे ्यि कषे  वलए ScaleX को 1.3 ्या इसी कषे  लररर 

पि सषेट किें ।

रूंवक आप इस अध्या्य में सहज सफदे स मॉडवलंर किें रषे, एरहषेड को रिाइट हाइलाइट्स कषे  साथ वडसपलषे किना अच्ा िहषेरा, वजससषे आप अपनषे द्ािा वक्यषे 

र्यषे बदलावों का प्रराव सपष्ट रूप सषे दषेख सकें ।

Blinn सिमे स मटैीररयि असाइन ्करना

• एरहषेड को सलषेक्ट वक्यषे हुए समूथ शषेवडंर वाला सफदे स वडसपलषे किनषे कषे  वलए 5 दबाएं।

• एरहषेड पि िाइट-वक्लक किें  औि Assign New Material > Blinn का र्यन किें । वबलन मटैीरि्यल कषे  वलए एवट्ब्यटू एवडटि तुिंत प्रदवश्भत होरा।

• कलि एवट्ब्यटू सलाइडि को दाई ंओि लररर 3/4 ड्ैर किें , इसेंवट्वसटी को 0 पि सषेट किें  औि ववंडो को बंद कि दें।

तित्र 6.5.4: प्रोफाइि किटि बनाना

तित्र 6.5.5: ्फेयर िवैयार करें

तित्र 6.5.6: एगहेि
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6.5.6 मूिभू्त संरचना रनमाटिण ्त्कनी्क बुरनयादी/बेरस्क स्करल्पटंग ्त्कनी्कें

बेरस्क स्करल्पटंग ऑप्रेशंस से बेरस्क स्करल्पटंग ्का अभयास ्करना

• एरहषेड को सलषेक्ट वक्यषे हुए ही, Edit NURBS > Sculpt Geometry Tool सलषेक्ट किें । टूल सषेवटंगस ववंडो में िीसषेट वक्लक किें  औि सुवनवश्चत किें  वक 

सकलपट पिैामीटस्भ वडसपलषे हों। 

• सफदे स पि प्रत्यषेक राि ऑप्रषेशंस कषे  साथ प्र्योर किें । परिणाम कषे  बािषे  में वरंता न किें । बस अपनषे माऊस कषे  सट्ोक की प्रवतवक्र्या सषे परिवरत हों जाएं।

• इिषे ज़ ऑपिषे शन का र्यन किें  औि Flood बटन पि वक्लक किें । ्यह आपकषे  सािषे  परिवत्भनों को वमटा दषेरा।

• पुल ऑप्रषेशन सलषेक्ट किें  औि 0.25 का िषे वड्यस (U) एंटि किें , वफि वबना एक दूसिषे  को क्रॉस वक्यषे होरिज़ॉनटल आइसोपामस्भ कषे  एक जोडषे कषे  बीर  

ड्ैर किें । 

इसका कोई प्रराव नहीं होता, क््योंवक सट्ोक िषे वड्यस का वकसी री आइसोपामस्भ कषे  CV सषे  

कोई संपक्भ  नहीं हुआ। आप वकसी री ऑपिषे शन का उप्योर किें , कषे वल CV ही सट्ोक सषे प्रराववत 

होतषे हैं। 

• िषे वड्यस (U) को 2 किें  औि पहलषे वालषे सट्ोक्स दोहिाएं ।

• आपकषे  द्ािा सफदे स पि पहलषे वकए रए बदलावों को फलड इिषे ज़ किें

• 0.5 कषे  िषे वड्यस (U) कषे  साथ पुल ऑप्रषेशन सलषेक्ट किें । ववट्भकल आइसोपामस्भ कषे  साथ ड्ैर 

किें । तुलना किनषे कषे  वलए एक होरिज़ॉनटल आइसोपामस्भ री साथ में ड्ैर किें ।

इस वरत्र का सनपैशॉट लषेनषे सषे पहलषे हम वडसपलषे टषेब पि शषेडषेड पि वा्यिफ्षे म को नन/None पि 

सषेट कितषे हैं (Window > Setting/Preferences > Preferences)। ्यह सफदे स आइसोपामस्भ की 

हाइलाइवटंर को बंद कि दषेता ह,ै वजससषे सफदे स कषे  परिवत्भनों को दषेखना आसान हो जाता ह।ै 

जसैषे आप सकलपट वज्योमषेट्ी टूल कषे  बािषे  में सीखतषे हैं, शो वा्यिफ्षे म कषे  वलए ऑन औि ऑफ 

सषेवटंगस को बदलनषे पि ववराि किें ।

• आपकषे  द्ािा सफदे स पि पहलषे वकए रए बदलावों को फलड इिषे ज़ किें

• कैमिा व्य ूको इस तिह िोटषेट किें , वक घुमाएँ वक व्य ूएवक्सस का X अक् आपकी तिफ हो। वफि सषे एक ववट्भकल पुल सट्ोक ड्ॉ किें । 

• सरी परिवत्भनों को वफि सषे इिषे ज़ किें , वफि कैमिा को न्यषे व्य ूमें िीपोज़ीशन किें , वजससषे व्य ूएवक्सस का Z अक् आपकी तिफ हो।

तित्र 6.5.7: NURBS संपाकदि करें

तित्र 6.5.8: तत्रजया बदिें

तित्र 6.5.9: शेिेि पर िायरफे्म
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अर्तररति स्करल्पटंग ्त्कनी्कों ्का अभयास ्करना

सकलपट वज्योमषेट्ी टूल कषे  सकलपट पिैामीटि सषेक्शन में मकै्स वडसपलषेसमेंट को 2 पि सषेट किें ।

• एक ववट्भकल पुल सट्ोक ड्ॉ किें ।

• मकै्स वडसपलषेसमेंट को बदलकि 1 कि दें।

• पास में ही एक औि ववट्भकल सट्ोक ड्ॉ किें ।  मकै्स वडसपलषेसमेंट वह अविकतम दूिी त्य किता ह,ै वजतना वक सफदे स कषे  CVs को एक वसंरल सट्ोक 

कषे  साथ पुश (्या पुल) वक्या जा सकषे रा। 

• सफदे स कषे  परिवत्भनों को इिषे ज़ किें ।

• मकै्स वडसपलषेसमेंट को 2 पि सषेट किें ।

• एक ववट्भकल पुल सट्ोक ड्ॉ किें ।

• ओपषेवसटी को उसकी वडफॉलट वलै्य ू1 सषे बदलकि 0.2 पि सषेट कि दें।

• पास में ही एक औि ववट्भकल सट्ोक ड्ॉ किें ।

» एक रिज दूसिषे  सषे उंरी ह।ै ओपषेवसटी वलै्य ू मकै्स वडसपलषेसमेंट कषे  प्रराव को मापती ह।ै 

उदाहिण कषे  वलए 0.2 ओपषेवसटी कषे  साथ हि सट्ोक में मकै्स वडसपलषेसमेंट सषेवटंर का इफैक्ट 

लररर कषे वल 0.2 रुना ही होरा। । 

» आमतौि पि पुश ्या पुल कितषे सम्य लो ओपषेवसटी वलै्य ूप्र्योर किना सबसषे अच्ा होता ह।ै 

आप अनषेक सट्ोक्स कषे  साथ ववरूपण को िीिषे  िीिषे  बढा सकतषे हैं।

» अरि आप सफदे स कषे  वसफ्भ  ्ोटषे सषे क्षेत्र को प्रराववत किना राहतषे हैं तो उस क्षेत्र में सट्ोक 

किनषे कषे  बजाए वक्लक किनषे कषे  वलए अपनषे माऊस का उप्योर किें । अरि रिश का िषे वड्यस 

औि ओपषेवसटी कम हैं तो आपको दो आइसोपामस्भ कषे  वनकटतम ववच ष्ेदन वबनदु पि वक्लक 

किनषे की ज़रूित होरी।

• ओपषेवसटी 1 पि सषेट वक्यषे हुए सफदे स कषे  सरी परिवत्भनों को वमटा दें ।

तित्र 6.5.10

तित्र 6.5.11: शेिेि पर िायरफे्म
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6.5.7 ना्क ्की रचना ्करना

6.5.8 आई सॉ्ेकट ्की रचना ्करना/बनाना

अब आप सािािण सी नाक बनानषे कषे  साथ एरहषेड का रषेहिा बनाना शुरू किें रषे।

्ैकरेकटर ्ेक रिए ना्क ्की रचना ्करना

• पस्भपषेवक्टव व्य ूको इस तिह वसथत किें  वक व्य ूएवक्सस का Z-अक् आपकी तिफ पवाइंट कि 

िहा हो।

• सकलपट वज्योमषेट्ी टूल को िीसषेट किें ।

• पुल ऑपिषे शन का र्यन किें  औि वनमनवलवखत ववकलपों को सषेट किें । वत्रज्या: 1Opacity: 

0.2

• रौवस्यन रिश प्रोफाइल सषेवटंर का र्यन किें  तावक आपकषे  सट्ोक में सॉफट, फषे डषेड एज हों: 

• एरहषेड कषे  बीर कषे  वबनदु कषे  ऊपि सषे, नाक कषे  ऊपि सषे नोक तक – लररर दो होरिज़ॉनटल 

आइसोपामस्भ कषे  बीर की दूिी कषे  बिाबि - ववट्भकली सट्ोक किें  (वनमन इलसट्षेशन दषेखें)। 

नाक कषे  वरिज को बनानषे कषे  वलए कई सट्ोक का उप्योर किें । कु ष्ेक बाि नाक की नोक कषे  

आइ सॉकषे ट ऑखंों कषे  वलए इनसषेट (ऑखंें वबठानषे कषे  वलए जरह) तथा बकैड्ॉप उपलबि किाता ह।ै

्ैकरकटर ्ेक रिए आइ सॉ्ेकट बनाना 

• पुश ऑपिषे शन वसलकै्ट किें । 

• बाकी सवैटंगस वसैषे ही िहनषे दें, जसैषे नोज़ कषे  वलए िखी थीं।

• एक जसैषे आई सॉकषे ट का जोडा बनानषे कषे  वलए टूल सषेवटंगस ववंडो में सट्ोक सषेवटंगस वडसपलषे किें  

औि रिफ़लषेक्शन ऑन किें ।

• रिफ़लषेक्शन एवक्सस को X पि सषेट किें  औि सकलपट आइकॉन को एरहषेड पि वसथत किें । 

एरहषेड पि पुश आइकॉन का एक समान जोडा वदखाई दषेरा। 

• आई सॉकषे ट कषे  वलए अपषेवक्त पोज़ीशन एडजसट किें । वांव्त जरह पि कई बाि माउस  

वक्लक किें । 

6.5.9 आइब्ोज़ ्की रचना ्करना/बनाना

आइरिोज़ सषे ्यह वनिा्भ रित होता ह ैवक रषेहिा वकतना कठोि ्या सौम्य वदखाई दषेरा।

्ैकरकटर ्ेक रिए आइब्ोज़ ्की रचना ्करना

• पुल ऑपिषे शन वसलकै्ट किें । रिफ़लषेक्शन समषेत, वही ऑपशन सषेवटंगस प्र्योर किें , जो आइ सॉकषे ट कषे  वलए की थीं।

• सकलपट आइकॉन्  को आँखों कषे  ऊपि वसथवत किें  औि क्वैतज/हॉरिज़ॉनटल सट्ोक्स ड्ॉ किें । आवश्यकता होनषे पि उन जरहों पि वक्लक किें  जहां आप 

आइरिो बनाना राहतषे हैं। आवश्यकतानुसाि आइरिोज़ को समूथ किें ।

तित्र 6.5.12: नाक की रिना करना

दावहनी तिफ औि वफि कु ष्ेक बाि बाई ंतिफ होरिज़ॉनटल सट्ोवकंर सषे नथुनषे (नोवसट्लस) बनाएं।

तित्र 6.5.13: आइ सॉकेट की रिना करना/बनाना
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6.5.10 मुँह ्की रचना ्करना/बनाना

इस अध्या्य में मूलरतू क्षेत्र कषे  वलए वनवद्भष्ट 30 सषेक्शनों औि 30 सपनैस कषे  साथ मँुह कषे  क्षेत्र में 

आइसोपामस्भ कषे  बीर की बडी सी जरह होंठों को कोई सौम्ँय आकाि दषेना असंरव बना दषेती ह।ै

• इस समस्या सषे वनपटनषे कषे  वलए, मँुह की िरना शुरु किनषे सषे पहलषे आपको मँुह वालषे क्षेत्र 

में आइसोपामस्भ ज़रूि डालनषे रावहएं।

अर्तररति आइसोपामटि िािने (इनसटटि) ्ेक रिए

• एरहषेड पि िाइट-वक्लक किें  औि मावकयं र मनै्य ूसषे आइसोपाम्भ  वसलकै्ट किें ।

• टूलबॉक्स सषे सषेलषेक्ट टूल का र्यन किें ।

• नाक कषे  नीरषे क्वैतज आइसोपाम्भ  पि वक्लक किें  औि इससषे नीरषे अरलषे दो पि वशफ़ट-

वक्लक किें , वजससषे ्यषे पीलषे हो जाएं।

• Edit NURBS > Insert Isoparms > रुनें। ऑपशंनस ववंडो में वबट्वीन सषेलषेक्शंस ऑन किें , 

#आइसोपामस्भ टु इनसट्भ कषे  वलए 2 एंटि किें  औि वफि इनसट्भ पि वक्लक किें ।

्यह कुल राि अवतरिक्त आइसोपामस्भ कषे  वलए, वसलकै्टस वक्यषे र्यषे आइसोपामस्भ कषे  हि जोडषे कषे  

बीर में दो अवतरिक्त्य आइसोपामस्भ इंसट्भ कि दषेता ह।ै ्यह मँुह कषे  क्षेत्र में सौम्यता पदैा किनषे कषे  

वलए प्या्भप्त सीवी प्रदान कि दषेता ह।ै

तित्र 6.5.14: आइब्ोज़ की रिना करना/बनाना

तित्र 6.5.15: मुुँह ग़िना/की रिना करना

तित्र 6.5.16: अतिररक्त आइसोपामसटि

तित्र 6.5.17: आइसोपामसटि िािें/इंसटटि करें
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्ैकरकटर/पात्र/ऱ्करदार ्ेक रिए मुँह ्की रचना ्करना

• पुनः सकलपट वज्यॉमषेट्ी टूल वसलकै्ट किें । 

• पुश ऑपिषे शन वसलकै्ट किें । िषे वड्यस (U) कषे  वलए 0.2 एंटि किें । सुवनवश्चत किें  वक सट्ोक 

टबै में रिफलषेशन ऑन हो। 

• होंठों कषे  बीर वनशान कषे  वलए उप्ुयक्त क्षेत्र कषे  बीर सषे शुरू कितषे हुए, मध्य सषे बाहि की 

ओि सट्ोक किें । सबसषे बवढ्या ्यह िहषेरा, वक एक दूसिषे  कषे  ऊपि डुऍल आइकॉन (दूसिषे  

शबदों में, कषे वल एक ही आइकॉन वदखाई दषेता ह)ै सषे सट्ोक किना शुरू किें  । 

• पुल ऑपिषे शन वसलकै्ट किें  औि िषे वड्यस (U) को 0.3 पि सषेट किें । पहलषे वालषे रिण कषे  

वलए इसतषेकमाल की रई तकनीक सषे ही ऊपि वाला होंठ सट्ोक किें । वनरलषे होंठों कषे  

वलए ्यही दोहिाएँ।

6.5.11 चेहरे ्की अनय रिशेष्ताओ/ंमुखा्ृकर्तयों ्को गढ़ना

अब आपकषे  पास अन्य मुखाकृवत्यॉ ंजोडनषे का ववकलप ह।ै इन सुझावों पि ववराि किें :

• ठोडी, राल औि माथषे जसैी मुखाकृवत्यों कषे  वलए 1 सषे अविक िषे वड्यस का उप्योर किें  औि मवैक्समम वडसलषेकि 

समेंट को 0.5 औि 1 कषे  बीर िखकि शुरु किें ।

• जहॉ ंरी आप कु् अवतरिक्तस वववशषृ्टता डालना राहें, सकलपट वज्यॉमषेट्ी टूल कषे  साथ आइसोपाम्भ  इंसट्भ किें ।

अपने दृशय में पहि ेसे मौजूद मॉिलसि इमपोटटि ्करने ्ेक रिए

अरि आपनषे वप्लषे अध्या्य में एरहोलडि दृश्य/सीन सषेव वक्या था, तो आप इस एरहषेड दृश्य में एर होलडि इमपोट्भ  कि 

सकतषे हैं औि वफि एरहषेड को एर होलडि में पोज़ीशन/वसथत कि दें।

• एर होलडि को एरहषेड दृश्य में इमपो्ट्भ  किनषे कषे  वलए फ़ाइल > इमपोट्भ  औि वफि एरहोलडि वालषे दृश्य का नाम 

वसलकै्टषे किें । दृश्य को इमपोिट्भ  किनषे पि उस दृश्य सषे सरी ऑबजषेक्ट्स इमपोहट्भ हो जातषे हैं।

• सनर वफट कषे  वलए आवश्यकतानुसाि एर होलडि (्या एर हषेड) कषे  सकषे ल को बढाएँ (्या घटाएँ)

तित्र 6.5.17: आइसोपामसटि िािें/इंसटटि करें

तित्र 6.5.18: िेहरे की अनय 
तिशेरिाओं/मुखाकृतियरों को ग़िना

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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यूरनट 6.6: एरनमेशन

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. Maya सॉफटवषे्यि – एवनमषेशन पि 3D एवनमषेशन तकनीकों कषे  एवपलकषे शन में

6.6.1 पररचय

6.6.2 ्पिबे्ैक रें ज सेट ्करना

जब आप कोई कीफ्षे म (्या की) सषेट कितषे हैं तो आप ऑबजषेक्ट की ववशषेषताओ ं(उदाहिण कषे  वलए, ट्ॉसंलषेट, िोटषेट, सकषे ल, कलि आवद) को एक वनवद्भष्ट सम्य 

पि एक वलै्य ू(मान) असाइन कितषे हैं।

अविकांश एवनमषेशन प्रणावल्याँ, फ्षे म को माप की मूलरतू ्यवूनट कषे  तौि पि उप्योर किती हैं क््योंवक हि फ्षे म को रवत का भ्रम पदैा किनषे कषे  वलए एक कषे  

बाद एक तुिंत रला्या जाता ह।ै

एवनमषेशन को रलानषे कषे  वलए उप्योर वक्या जानषे वाला फ्षे म िषे ट (फ्षे म प्रवत सकैें ड) उस माध्यम पि आिारित होता ह,ै वजस पि एवनमषेशन पलषेए बकै की 

जा्यषेरी (उदाहिण कषे  वलए वफलम, टीवी, वीवड्यो रषेम आवद)

जब आप वरनन मानों कषे  साथ वववरनन सम्य पि कई की सषेट कितषे हैं तो मा्या हि फ्षे म कषे  रलनषे कषे  साथ उन सम्य अंतिालों में एट्ीब्यटू वलै्य ूजॅनॅिषे ट 

किता ह।ै परिणाम होता ह,ै उन ऑबजकै्ट्स तथा एट्ीब्यट्ूस कषे  सम्य कषे  साथ हुआ बदलाव ्या रवत।

दृशय आरंभ ्करने ्ेक रिए

• सुवनवश्चत किें  वक आपनषे पषृ्ठ 217 पि “अध्या्यों कषे  वलए त्ैयाि किना” में वदए रए रिणों को पणू्भ  कि वल्या वक्या ह।ै

• Keyframing.mb नामक दृश्य/सीन फाइल खोलें। 

्यह फाइल आपकषे  मा्या सॉफटवषे्यि द्ािा इंसटॉल की रई GettingStartedLessonData डा्यिषे क्टिी ्या उस ड्ाइव सषे आपको वमल जा्यषेरी, जहां आपनषे रषेवटंर 

सटािटषेड फाइलस कॉपी की थीं। 

GettingStartedLessonData/Anim/Keyframing.mb

तित्र 6.6.1: दृ् य

यूरनट ्ेक उद्ेशय  
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दृश्य में एक बॉल ऑबजषेक्ट ह,ै जो अरी गाउंड पलषेन कषे  वकनािषे  कषे  नजदीक X – एवक्सस पि वसथत ह।ै 

दृशय ्ेक रिए ्पिबे्ैक रें ज सेट ्करना

बॉल को एवनमषेट किनषे कषे  वलए आप पलषेबकै िें ज कषे  वववरनन सम्यों पि इसकी वसथवत को की/सषेट कितषे हैं।

पलषेबकै िें ज टाइम औि िें ज सलाइडि द्ािा वनिा्भ रित होती ह।ै टाइम औि िें ज सलाइडि कंट्ोलस कषे  ज़रि्यषे आप अपनी एवनमषेशन को पलषेबकै ्या सक्रोल कि 

सकतषे हैं अथवा अपनी एवनमषेशन कषे  वकसी वववशवष्ट सम्य वबनदु/वकसी वववशष्ट क्ण पि जाकि कीफ्षे म सषेट कि सकतषे हैं।

• नीरषे वदए वरत्र में वदखा्यषे र्यषे पलषेबकै कंट्ोलस को दषेखें।

टाइम सलाइडि पलषेबकै िें ज औि रुनषे हुए ऑबजषेक्ट कषे  वलए आपकषे  द्ािा सषेट की हुई कीज़ को दशा्भता ह।ै कीज़ लाल िंर की िषे खा कषे  रूप में वदखाई रई हैं। 

टाइम सलाइडि कषे  दाई ंओि का बॉक्स आपको एवनमषेशन कषे  वत्भमान फ्षे म (सम्य) को सषेट किनषे की सुवविा दषेता ह।ै 

पलषेबकै कंट्ोलस एवनमषेशन पलषेबकै को वन्ंयवत्रत किता ह।ै आप पलषे औि रिवाइंड (वफि सषे शुरू किनषे) कषे  वलए पािंपरिक बटनों को पहरान ही सकतषे हैं। 

stop बटन कषे वल तरी वदखाई दषेता ह,ै जब एवनमषेशन रल िही/पलषे हो िही हो। ्यह जाननषे कषे  वलए वक कौन-सा बटन क््या काम किता ह,ै माऊस पॉइंटि को 

इसकषे  ऊपि िोक कि िखें।

एवनमषेशन Preferences बटन पलषेबकै सपीड जसैी एवनमषेशन प्रषेफषे िें स सषेवटंगस कषे  वलए ववंडो दशा्भता ह।ै

िें ज सलाइडि, आपकषे  द्ािा play बटन वक्लक वक्यषे जानषे पि, फ्षे मस की िें ज को वन्ंयवत्रत किता ह।ै

• पलषेबकै एंड टाइम बॉक्स (ऊपि दषेखें) में 72 एंटि किें । 

• मोशन वपक्रि वफलम कषे  वलए 24 फ्षे म प्रवत सषेकंड (fps) की फ्षे म दि इसतषेमाल की जाती ह।ै वीवड्यो कषे  वलए फ्षे म दि, प्र्योर वक्यषे जा िहषे फॉमदेट कषे  

आिाि पि, 30 fps (NTSC) ्या 25 fps (PAL) हो सकता ह।ै

• 1 सषे 72 तक की पलषेबकै िें ज में आप तीन सषेकंड का एवनमषेशन बना सकतषे हैं। (72 फ्षे मस को 24 फ्षे म प्रवत सषेकंड सषे ववरावजत किनषे पि = 3 सषेकंड्स।) 

इस अध्या्य में आपको जो सम्य वमलषेरा, वह एक शॉट्भ  एवनमषेशन बनानषे कषे  वलए प्या्भप्त ह।ै

6.6.3 ्कीफे्मस सेट ्करना
वनमनवलवखत रिणों में आप बॉल की मूवमेंट की आिंवरक तथा अंवतम वसथवत/पोज़ीशंस को सषेट किनषे कषे  वलए कीफ्षे मस का उप्योर किें रषे।

• आिंवरक तथा अंवतम कीफ्षे मस सषेट किना 

• पलषेबकै िें ज की शुरुआत में जानषे कषे  वलए rewind बटन पि वक्लक किें । इससषे वत्भमान फ्षे म बदलकि 1 हो जाता ह।ै

• पहलषे बॉल सलषेक्ट किें  औि उसकषे  बाद Animate > Set Key सलषेक्ट किें । (कीबोड्भ  शॉट्भकट: s)

• ्यह बॉल कषे  सरी बदलाव ववशषेषताओ/ंट्ांसफॉम्भ  एवट्ब्यट्ूस कषे  वलए फ्षे म 1 पि की सषेट कि दषेता ह।ै ट्ांसफॉम्भ  एवट्ब्यट्ूस X, Y, Z मूव एवट्ब्यट्ूस हैं। 

हालांवक इस अध्या्य में आप बॉल कषे  कषे वल ट्ांसलषेट X तथा Y एवट्ब्यट्ूस को ही एवनमषेट कितषे हैं, सरी ट्ांसफॉम्भ  एट्ीब्यट्ूस की कीइंर किनषे सषे आप 

वनवद्भष्ट एट्ीब्यटू को की किनषे में लरनषे वालषे सम्य को बरा सकतषे हैं।

तित्र 6.6.2: पिेबवैक कंट्ोल्स
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• टाइम सलाइडि में फ्षे म 1 पि लाल िंर कषे  वरनह पि ध्यान दें वजसषे वटक कषे  नाम सषे जाना जाता ह।ै ्यह वटक फ्षे म 1 कषे  वलए की सषेट किनषे पि वदखाई 

दषेता ह।ै बॉल सलषेक्ट हो जानषे कषे  बाद टाइम सलाइडि कषे  वटक दशा्भतषे हैं, वक आपकषे  कीज़ कहां सषेट की हैं।

• फ्षे म 72 पि जाएँ। इसषे किनषे का आसान तिीका टाइम सलाइडि में वांव्त सथान पि वक्लक किना ह।ै

• नीरषे वदखाए रए वरत्र कषे  अनुसाि, बॉल को गाउंड कषे  दाएं वकनािषे  पि वसथत किनषे कषे  वलए, मूव टूल कषे  साथ बॉल कषे  X-एवक्सस हैंडल को ड्ैर किें ।

• फ्षे म 72 पि की सषेट किें । (s दबाएँ।)

• आिंर में जाएँ औि एवनमषेशन पलषे किें ।

आपकषे  द्ािा सषेट की रई 2 कीज़ सषे, मा्या पोज़ीशंस कषे  बीर मोशन पदैा किता ह।ै वडफॉलट रूप सषे एवनमषेशन फ्षे म 1 सषे 72 तक लराताि रलती िहती ह।ै 

इस रिण में बॉल बाड/मषेड सषे रुज़िती ह।ै

• कु् बाि दषेख लषेनषे कषे  बाद एवनमषेशन को िोकनषे कषे  वलए पलषेबकै कंट्ोलस पि वसथत stop बटन दबाएं। 

इंटरमीरिएट ्कीफे्मस सेट ्करना

• फ्षे म 33 ्या ऐसषे ही वकसी फ्षे म पि जाएं, जब बॉल बाड कषे  बीर में रुकती ह।ै

• मूव टूल कषे  साथ बॉल कषे  Y एवक्सस हैंडल को इसकषे  बाड कषे  थोडा ऊपि होनषे तक ड्ैर किें ।

• की सषेट किें । (s दबाएँ।)

• एवनमषेशन रलाएं/पलषे किें ।

बॉल अब गाउंड सषे ऊपि, बाड कषे  ऊपि होती हुई उडती ह ैऔि की वक्यषे र्यषे सटाट्भ, वमडल तथा एंड पोज़ीशन कषे  बीर समदू आक्भ  में वापस गाउंड में आ जाती ह।ै

• पलषेबकै को समाप्त किनषे कषे  वलए stop बटन दबाएँ। 

तित्र 6.6.3: आरंतभक और अंतिम पोज़ीशंस को सेट करें

तित्र 6.6.4: इंटरमीतियट कीफे्म सेट करें
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बाद कषे  रिणों में हि की को सषेट किनषे कषे  बाद एवनमषेशन रलाएं। सामान्यतः हि की कषे  बाद अपनषे काम की प्ररवत जांरना उप्योरी होता ह,ै खासतौि पि 

जब आप सीख िहषे हों।

बॉि ्को बाउनस ्करने ्ेक रिए ्कीफे्मस सेट ्करना

• फ्षे म 50 पि जाएँ। इस सम्य बॉल गाउंड की सतह आिषे दावहनषे रार कषे  बीर कषे  मध्य रार कषे  ऊपि एक पोज़ीशन पि ह।ै

• बॉल को मूव किें , वजससषे ्यह गाउंड पि आ जा्यषे।

• की सषेट किें ।

• फ्षे म 60 पि जाएँ।

• बॉल को वफि सषे ऊपि मूव किें , लषेवकन उतना ऊपि नहीं, वजतनी वक बाड की उंराई ह।ै

• की सषेट किें । जब आप एवनमषेशन पलषे कितषे हैं तो बॉल बाड कषे  ऊपि सषे रुजितषे हुए दूसिी ओि बाउनस किती ह।ै 

तित्र 6.6.5: कीफे्म सेट करें

तित्र 6.6.6: बॉि को ऊपर िे जाएुँ
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6.6.4 रिाि एरिटर ्का उपयोग ्करना

रिाि एरिटर ्का उपयोग ्कर्ेक एरनमेशन ्किटि ्को एरिट ्करना

• बॉल सलषेक्ट किकषे  Window > Animation Editors > Graph Editor सलषेक्ट किें ।

गाफ एवडटि कई एवनमषेशन कव्भ दशा्भता ह,ै बॉल कषे  हि की वक्यषे र्यषे एवट्ब्यटू कषे  वलए एक कव्भ।

• गाफ एवडटि कषे  बाएँ कॉलम में कषे वल ट्ांसलषेट X औि ट्ांसलषेट Y एवट्ब्यट्ूस को वशफट-सलषेक्ट किें ।

अब गाफ एवडटि में कषे वल ट्ांसलषेट X औि ट्ांसलषेट Y कषे  वलए एवनमषेशन कव्भ वदखाई देंरषे।

• एवनमषेशन कव्भ को बीर में प्रदवश्भत किनषे कषे  वलए View > Frame Selection (गाफ एवडटि ववंडो में) सलषेक्ट किें । अरि आप गाफ में औि ववविण दषेखना 

राहतषे हैं तो गाफ व्य ूको ट्कै तथा डॉली किनषे कषे  वलए अपनषे माउस का उप्योर किें ।

• फ्षे म 50 पि ट्ांसलषेट Y (हिा) कव्भ पि वबनदु रुनें। इससषे टैंजेंट हैंडलस की जोडी वबनदु पि वदखाई दषेनषे लरती ह।ै नई प्रदवश्भत सीिी िषे खा का हि अंवतम 

वबनदु टैंजेंट हैंडल ह।ै इस हैंडल की सहा्यता सषे आप की पॉइंट कषे  वनकट कवदेरि को वन्ंयवत्रत कि सकतषे हैं।

• गाफ एवडटि में, Keys > Break Tangents सलषेक्ट किें ।

इससषे आप हि टैंजेंट हैंडल को, सवतंत्र रूप सषे एक जरह सषे दूसिी जरह लषे जा सकतषे हैं।

• दाएँ टैंजेंट हैंडल को सलषेक्ट किें , औि थोडा सा ऊपि सिकानषे कषे  वलए मूव टूल का उप्योर किें । बाएँ टैंजेंट हैंडल कषे  साथ री ऐसा ही किें । ध्यान िहषे, 

वक आप की पॉइंट न सलषेक्ट कि दें।

तित्र 6.6.7: एतनमेशन किटि

तित्र 6.6.8:  ट्ांसिेट X और ट्ांसिेट Y
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इससषे बाउनस रुरुतवाकष्भण औि लोर कषे  प्रराव का आरास दषेता हुआ औि री शाप्भ  हो जाता ह।ै

6.6.4 एट्ीबयूट ्का समय बदिना

बॉल अपना िासता बषेहद िीमी रवत सषे त्य किती प्रतीत हो िही ह।ै वनमनवलवखत रिणों में आप इसकी रवत को तषेज़ किनषे कषे  वलए गाफ एवडटि का उप्योर 

किें रषे। खास तौि पि, आप बॉल कषे  एवनमषेशन सषे इसका सफि तीन सषेकंड (72 फ्षे म) कषे  बजाए दो सषेकंड (48 फ्षे म) में समाप्त किवा देंरषे।

बॉि ्की मूिमेंट ्ेक एरनमेशन ्को ्तजे़ ्करना

• वसलषेक्शन बॉक्स को दोनों कव्भ कषे  सरी की पॉइंट्स कषे  आस-पास ड्ैर किें । 

• सकषे ल टूल का र्यन किें ।

• फ्षे म 1 (0 कषे  थोडी दाएँ ओि) पि गाफ में कहीं री माऊस कषे  बीर वालषे बटन को वक्लक किकषे  

होलड किें ।

• प्रश्नवारक वरनह कषे  आइकॉन पि ध्यान दें। इस आइकॉन की वसथवत दशा्भती ह,ै वक सकषे वलंर 

वकस वबनदु सषे हुई ह।ै (रूंवक आपको फ्षे म 1 की तिफ एवनमषेशन को अंदि की ओि सकषे ल किनषे 

की ज़रूित ह,ै आपको अपना ड्ैर ऑपिषे शन फ्षे म 1 सषे शुरू किना होरा।)

• माऊस कषे  बटन को वबना ्ोडषे, बाई ंओि तब तक ड्ैर किें  जब तक दोनों कव्भ पि सबसषे दाई ं

ओि कषे  की पॉइंट्स लररर फ्षे म 48 पि वसथत न हो जाएँ। (सलषेक्ट किनषे पि सबसषे दा्याँ की 
पॉइंट पीला हो जाता ह।ै)

6.6.5 एरनमेशन ्को िाइनट्यून ्करना/रनखारना

वनमनवलवखत दो वरत्र परिवत्भन/सुिाि कषे  बाद कव्भ कषे  उदाहिण को प्रदवश्भत कितषे हैं। दोनों गाफ समरूप हैं कषे वल दूसिी वरत्र में कव्भ वबनदुओ ंको सलषेक्ट 

वक्या र्या ह।ै दूसिी आकृवत टैंजेंट हैंडल की वसथवत को दशा्भती ह।ै

तित्र 6.6.9:  दाएुँ टैंजेंट का ियन करना

तित्र 6.6.10:  बॉि की मूिमेंट

तित्र 6.6.11 (a):  एतनमेशन को फाइन ट्ून करना
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6.6.6 अर्तररति ्कीफे्म और सटरेट्क चनैिों ्को रििीट ्करना
सटरेट्क चनैिों ्को रििीट ्करने ्ेक रिए

मषेन मनै्य ूसषे Edit > Delete All by Type > Static Channels सलषेक्ट किें । ्यह सीन में मौजदू सरी ऑबजषेक्ट्स कषे  वलए अनावश्यक कीज़ को हटा दषेरा। 

वकैवलपक रूप सषे आप वकसी रुनषे हुए ऑबजषेक्ट कषे  वलए सटषेवटक रनैलों को Edit > Delete by Type > Static Channels में जाकि हटा सकतषे हैं।

तित्र 6.6.11 (b):  एतनमेशन को फाइन ट्ून करना

तित्र 6.6.12:  ्टेरटक िवैनिरों को तििीट करना

6.6.7 एरनमेशन ्को ्पिबे्ैक ्करने रिए ्पिबेिासट ्का इस्तमेाि ्करना

जब आप वकसी सीन को पलषे कितषे हैं तब आपको एवनमषेशन का एक िफ अनुमान वदखाई दषेता ह।ै हि फ्षे म को िें डि किनषे औि इस उद्षेश्य सषे वडज़ाइन वकए 

रए पलषेबकै ्यवूटवलटी सषे फ्षे म को वसक्वेंस में पलषे किनषे की तुलना में पलषेबकै की रवत औि रुणवत्ता सही नहीं ह।ै

ए्कदम सही समय ्ेक सा्थ एरनमेशन दखेें

• Window > Playblast सलषेक्ट किें

• अरलषे कु् सषेकंड कषे  दौिान मा्या पिूषे  एवनमषेशन को फ्षे म दि फ्षे म प्रोसषेस किषे रा। प्रोसषेस पिूा होनषे कषे  बाद एक पलषेबकै ववंडो वदखाई दषेरी।

• एवनमषेशन दषेखनषे कषे  वलए इस ववंडो में वदख िहषे play बटन पि वक्लक किें ।

• पिूा होनषे कषे  बाद पलषेबलासट ववंडो को बंद कि दें।
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यूरनट 6.7: पॉिीगोन टकेसचररंग

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. मा्या सॉफटवषे्यि-पॉलीरोन टषेक्सररिंर पि 3D एवनमषेशन तकनीक का प्र्योर किनषे में।

6.7.1 कै्र्कर बॉकस मॉिि बनाना

कयूब रप्ररमरटि ्का इस्तमेाि ्कर्ेक कै्र्कर बॉकस बनाना

• Create > Polygon Primitives > Cube > _ सलषेक्ट किें ।

• पॉलीरोन क््यबू ऑपशपन ववंडो में Edit > Reset Settings सलषेक्ट किें  वनमनवलवखत ववकलप सषेट किें  औि उसकषे  बाद वक्रएट पि वक्लक किें :

» रौडाई: 8

» ऊंराई: 10

» डषेपथ (रहिाई): 3

» रौडाई ववराजन/वर्भ: 1

» उंराई ववराजन/वर्भ: 1

» रहिाई ववराजन/वर्भ: 1

» एवक्सस/अक्: Y

» UV बनाएं: ऑन

» सामान्यीकिण: ऑफ

सीन व्य ूमें क््यबू वप्रवमवटव एक आ्यताकाि बॉक्स कषे  रूप में नज़ि आता ह।ै जब वक्रएट UVs ऑपशन ऑन िहता ह,ै तो ्यह सुवनवश्चत किता ह ैवक वप्रवमवटव 

ऑबजषेक्ट वडफॉलट UV टषेक्सरि को-ऑवड्भनषेट्स कषे  एक सषेट सषे बना्या र्या हो। मा्या में सरी पॉलीरोन वप्रवमवटव, वक्रएशन कषे  सम्य ही UV टषेक्सरि  

को-ऑवड्भनषेट्स बनानषे का ववकलप प्रदान कितषे हैं। 

• रनैल बॉक्स का इसतषेमाल किकषे  ट्ांसलषेट Y एवट्ब्यटू को 5 पि सषेट किें  तावक कै्रकि बॉक्स को पुनसथा्भ वपत किकषे  X एवक्सस अक् पि वक्या  

जा सकषे ।

यूरनट ्ेक उद्ेशय  

तित्र 6.7.1:  क्वै कर बॉकस मॉिि बनाना
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6.7.2 पॉिीगोन मेश पर टकेसचर मपै ए्पिाई ्करना

मा्या में, िें डि की रई तसवीि में सतह वसैी वदखाई दषेती ह ैजसैी शषेवडंर सामगी आपनषे इसतषेमाल की ह।ै वडफॉलट शषेवडंर सामगी जो वक सतह पि लराई 

जाती ह ैवह िंर, पािदवश्भता औि रमक जसैी मूलरतू ववशषेषताएँ प्रदान किती ह।ै

कै्र्कर बॉकस में शेरिंग सामरिी असाइन ्करने ्ेक रिए

सीन व्य ूकषे  पनैल मनै्य ूमें जाकि Shading > Smooth Shade All सलषेक्ट किें । ्यह कै्रकि बॉक्स को वडफॉलट गषे, समूथ शषेवडंर मटैीरि्यल में दशा्भता ह,ै जो 

वडफॉलट लाइवटंर कषे  प्र्योर सषे प्रकावशत होता ह।ै समूथ शषेड ऑल को ऑन किनषे सषे वो असाइंड शषेवडंर मटैीरि्यल वदखनषे लरषेरा, जो आप वनमन रिणों में 

कै्रकि बॉक्स में एपलाई किें रषे।

• सीन व्य ू में, कै्रकि बॉक्स कषे  वकसी री रार पि िाइट-वक्लक किें  औि मावकयं र मनै्यू ्सषे Assign New Material > Lambertमटैीरि्यल सलषेक्ट किें ।

तित्र 6.7.2: पॉिीगोन मेश पर टेकसिर मवैप

• एक न्या लमैबट्भ शषेवडंर मटैीरि्यल बन जाएरा औि कै्रकि बॉक्स को असाइन हो जाएरा। 

एवट्ब्यटू एवडटि वदखाई दषेरा औि नए लमैबट्भ शषेवडंर मटैीरि्यल कषे  वलए वववरनन 

एवट्ब्यट्ूस प्रदवश्भत किषे रा।

तित्र 6.7.3: नयू िवैमबटटि शेपिंग मवैटीररयि

• pCube1 वप्रवमवटव का नाम बदलकि: cracker_box कि दीवजए।
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न्या लमैबट्भ मटैीरि्यल उस वडफॉलट गषे मटैीरि्यल सषे वमलता जुलता ह ैजो कै्रकि बॉक्स को पहलषे असाइन वक्या र्या था।

• एवट्ब्यटू एवडटि में, lambert2 बॉक्स पि डबल वक्लक किें  औि उसकषे  बाद शषेवडंर मटैीरि्यल का नाम बदलनषे कषे  वलए box_material टाइप किें ।

शषेवडंर मटैीरि्यल का नाम बदलनषे सषे बाद में ज़रूित पडनषे पि आपको इसषे पहराननषे में आसानी होती ह।ै मा्या में रीज़ों को अनठूषे  तिीकषे  सषे नाम दषेना एक 

उप्योरी आदत ह।ै

• एवट्ब्यटू एवडटि में, कलि सलाइडि को पिूी तिह सषे दाई ंओि लषे जाएँ तावक कलि बॉक्स सफषे द वदखाई दषे।

तित्र 6.7.4: शेपिंग मवैटीररयि का नाम बदिें

• बॉक्स मॉडल को असाइन शषेवडंर मटैीरि्यल री सीन व्य ूमें अपडषेट हो जाता ह,ै इसवलए थोडा 

रमकदाि वदखनषे लरता ह।ै

• कलि सलाइडि कषे  दाएं ओि वसथत Map बटन पि वक्लक किें । वक्रएट िें डि नोड ववंडो वदखाई 

दषेरी औि इसकषे  साथ ही बॉक्स मटैीरि्यल कषे  कलि रनैल में वववरनन टषेक्सरि ऑपशंस आ  

जातषे हैं, जो आप एपलाई (्या कनकै्ट) कि सकतषे हैं। 2D टषेक्सरि की सरूी सषे PSD फाइल पि 

वक्लक किें ।

तित्र 6.7.5: शेपिंग मवैटीररयि का नाम बदिें

तित्र 6.7.6: PSD फाइि पर तकिक करें



227226

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

यूरनट 6.8: रें िररंग

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. मा्या सॉफटवषे्यि-िें डरिंर पि 3D एवनमषेशन तकनीकों को एपलाई किनषे में।

6.8.1 सीन रें िर ्करना

एक इमषेज प्रोड््यजू़ किनषे कषे  वलए िें डरिंर में कई घटक शावमल होतषे हैं:

• शषेवडंर मटैीरि्यल औि टषेक्सरि

• लाइवटंर औि शडैो

• कैमिा औि एवनमषेशन

• िें डरिंर वववि

• ववजु़अल इफैक्ट्स

• सुवनवश्चत किें  वक आपनषे पषृ्ठ 429 पि “अध्या्यों कषे  वलए त्ैयाि किना” में वदए रए 

रिणों को पणू्भ  कि वल्या वक्या ह।ै

• Apple.mb नाम की सीन फाइल खोलें। 

• ्यह फाइल आपको मा्या सॉफटवषे्यि कषे  साथ इंसटॉल हुई GettingStartedLessonData 

डा्यिषे क्टिी पि ्या वफि उस ड्ाइव में वमल जा्यषेरी, जहां आपनषे रषेवटंर सटािटषेड फाइलस 

कॉपी की हुई हैं:

GettingStartedLessonData/Rendering/Apple.mb

दृश्य में एक सषेब पलषेन पि पडा ह,ै औि एक अन्य पलषेन बकैगाउंड ह।ै दृश्य में एक कैमिा 

अलर-अलर दूरि्यों सषे सषेब कषे  रािों ओि रक्कि लरानषे कषे  वलए एवनमषेटषेड ह।ै (Apple.mb 

सीन का इसतषेमाल किनषे की बजा्य आप अपनषे वकसी ऑबजषेक्ट सषे री ऐसा ही सीन त्ैयाि 

कि सकतषे हैं)।

तित्र 6.8.1(a): रेंिटरंग इमेज तित्र 6.8.1(b): रेंिटरंग इमेज तित्र 6.8.1(c): रेंिटरंग इमेज

तित्र 6.8.2: सीन रेंिर करना

यूरनट ्ेक उद्ेशय  
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• Window > Settings/Preferences > Preferences सलषेक्ट किें ।

• टाइमलाइन कैटरिी पि वक्लक किें  औि सुवनवश्चत किें  वक पलषेबकै सपीड ऑपशन रि्यल-टाइम (30 fps) पि हो, इसवलए आपका एवनमषेशन 24 फ्षे मस 

प्रवत सषेकंड की वडफॉलट दि सषे पलषेबकै होरा। 

• वप्रफषे िें स ववंडो बंद किें ।

• एवनमषेटषेड कैमिषे  का प्र्योर आप अध्या्य में बाद में किें रषे, उससषे पहलषे नहीं। अरलषे रिणों में आप शषेवडंर मटैीरि्यल वक्रएट किकषे  सषेब औि पलषेन को 

कलि किें रषे।

6.8.2 ऑबजेकट ्ेक रिए शेरिंग मटैीररयि बनाना

• पस्भपषेवक्टव व्य ूमें Shading > Smooth Shade All सलषेक्ट किें

• पस्भपषेवक्टव व्य ूमें सषेब कषे  तनषे को उसकी ज्योमषेट्ी पि वक्लक किकषे  सलषेक्ट किें । (ध्यान 

िखें वक सषेब का वसफ्भ  तना ही सलषेक्ट हो।)

तित्र 6.8.3: सीन रेंिर करना

तित्र 6.8.4: पसटिपेतकटि व्ू

तित्र 6.8.5: सेब के िने को िुनें
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6.8.3 माया सॉफटिेयर रें िर ्का इस्तमेाि ्कर्ेक रें िररंग ्करना

• िें डरिंर मषेन ूसषेट सषे Lighting/Shading > Assign New Material > Lambert सलषेक्ट किें । लमैबट्भ मटैीरि्यल कषे  वलए एवट्ब्यटू एवडटि वदखाई दषेता ह।ै 

लमैबट्भ मटैीरि्यल वबना शाइनी हाईलाइट कषे  मटै सतह बनाता ह।ै बाद कषे  अध्या्यों में आप मटैीरि्यल औि उनकषे  एवट्ब्यट्ूस कषे  ववष्य में औि अविक जानेंरषे।

• कलि कषे  दाई ंओि कषे  गषे बॉक्स पि वक्लक किें ।

कलि रजू़ि ववंडो वदखाई दषेरी।

• कलि वहील कषे  अंदि वक्लक किें  औि रिूषे  िंर पि ड्ैर किें ।  कलि रजू़ि में सषे रुना हुआ िंर सषेब कषे  

तनषे में एपलाई हो जाएरा।

• ववंडो को बंद किनषे कषे  वलए Accept पि वक्लक किें ।

• एवट्ब्यटू एवडटि में लमैबट्भ शषेवडंर मटैीरि्यल को िीनषेम किकषे  appleStem_lambert कि दें।

पिूषे  एवनमषेशन को िें डि किनषे में काफी सम्य लर सकता ह,ै इसवलए अच्ा िहषेरा, वक पहलषे मा्या सॉफटवषे्यि की सहा्यता सषे अपनषे मॉवनटि पि कु् फ्षे मस 

की िें डरिंर टषेसट कि लें औि परिणामों का वनिीक्ण किें ।

्ैकमरा वयूज़ में रसिच ्करना और एरनमेशन ्को ्पिबे्ैक ्करना

• पस्भपषेवक्टव व्य ूमें Panels > Perspective > apple_camera सलषेक्ट किें ।

» apple_camera कषे  लेंस सषे सीन कैसा वदखषेरा ्यह दशा्भनषे कषे  वलए व्य ूअपडषेट हो जाता ह।ै

• टाइम सलाइडि पलषेबकै कंट्ोलस में Play बटन पि वक्लक किें ।

» पलषेबकै कषे  दौिान एवनमषेटषेड कैमिा सषेब को ट्कै औि टमबल किता िहता ह।ै

• वजस फ्षे म को आपको टषेसट िें डि किना ह,ै उस पि एवनमषेशन को िोकें ।

एरनमेशन ्ेक ि्तटिमान फे्म ्ेक रें िर ्का परीक्ण ्करने ्ेक रिए

तित्र 6.8.6: ग्े बॉकस

तित्र 6.8.7: किर िूज़र पिंिो
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• िें डि व्य ूववंडो में Options > Render Settings सलषेक्ट किें । 

• िें डि सषेवटंगस ववंडो में िें डि में सषे ड्ॉप डाउन सरूी सषे मा्या सॉफटवषे्यि सलषेक्ट किें ।

• िें डि सषेवटंगस ववंडो में मा्या सॉफटवषे्यि टबै सलषेक्ट किें ।

• एंटी-अलाइवज़नर क्वावलटी सषेक्शन में क्वावलटी ड्ॉप डाउन सरूी सषे प्रोडक्शन क्वावलटी सलषेक्ट किें ।

्यह सषेवटंर िें डि की रई इमषेज की खुिदुिी सतह औि वसिों को समूथ किकषे  उचर-सतिी्य परिणाम 

दषेती ह।ै

• िें डि सषेवटंगस ववंडो को बंद किें ।

• िें डि सषेवटंगस ववंडो में Render > Render > Current (apple_camera) सलषेक्ट किें ।

• एवनमषेशन कषे  फ्षे म नंबि 120 पि जाएं जहां आपको सषेब अलर वसथवत में वदखाई दषेरा।

• िें डि व्य ूमें Render > Render > Current (apple_camera) सलषेक्ट किें ।

6.8.4 एरनमेशन फे्मस ्की रसकिेंस ्को बचै रें िररंग ्करना

बचै रें िररंग ्ेक रिए रें िर सेरटंगस ्को सेट ्करना

• िें डि व्य ूववंडो में, िें डि सषेवटंगस ववंडो को प्रदवश्भत किनषे कषे  वलए Options > Render Settings सलषेक्ट किें ।

• िें डि सषेवटंगस ववंडो में, कॉमन टबै सलषेक्ट किें  औि उसकषे  बाद इमषेज फाइल आउटपुट सषेक्शन को खोलें।

• इमषेज फाइल आउटपुट सषेक्शन में वनमनवलवखत ववकलप सषेट किें :

तित्र 6.8.8: रेंिर सेटटंगस

तित्र 6.8.9: उच्च गुणित्ा
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» िाइि नेम प्रीरिकस: Apple नाम टाइप किें । ्यह नाम बरै िें डरिंर द्ािा बनाए रए फाइल नामों का आिाि होरा। 

» फे्म/एरनमेशन एकसटेंशन: name.#.ext सलषेक्ट किें  ्यह नाम वदखाता ह ैवक फाइल का नाम का फॉमदेट इस प्रकाि होरा prefix.frameNumber.

fileFormat उदाहिण कषे  वलए पिूी 200 फ्षे म की एवनमषेशन की बरै िें डरिंर सषे Apple.0001.iff, Apple.0002.iff, Apple.00200.iff आवद बनेंरषे।

» इमेज िॉममेट: मा्या IFF (.iff) सलषेक्ट किें , मा्या का मानक इमषेज फाइल फॉमदेट। एवनमषेशन की प्रीव्यइंूर तथा कमपोवज़वटंर सवहत, आपको आरषे 

जो री काम किना हो, आप .iff फॉमदेट का इसतषेमाल कि सकतषे हैं। अरि आपको अलर फॉमदेट की ज़रूित ह ैतो आप िें डि सषेवटंगस में .iff कषे  

सथान पि उसषे वलख सकतषे हैं।

» प्रारंरभ्क फे्म/सटाटटि फे्म: 1 एंटि किें , एवनमषेशन सीक्वेंस का बरै िें डि वक्या जानषे वाला पहला फ्षे म।

» एंि फे्म/अंर्तम फे्म: 60 एंटि किें , बरै िें डि होनषे वाला अंवतम फ्षे म। (सरी 200 फ्षे मस को िें डि किनषे में काफी सम्य लर सकता ह।ै)

» फे्म पेरिंग: 4 एंटि किें । इससषे फाइलनषेम कषे  फ्षे मनमबि वहससषे में नमबि सषे पहलषे 0 (शनू्य) लराकि इसषे राि अंकों का बना वद्या जा्यषेरा। 

उदाहिण कषे  वलए, फाइलों कषे  नाम Apple.0001.iff सषे लषेकि Apple.0050.iff हो जाएंरषे। 

» रें िर ्करने योगय ्ैकमरा: वजस कैमिा व्य ूको आप िें डि किना राहतषे हैं उसषे रुननषे कषे  वलए ड्ॉप डाउन सरूी सषे apple_camera सलषेक्ट किें ।

िें डि सषेवटंगस को सषेट किनषे कषे  बाद कॉमन टबै का ऊपिी रार बरै िें डरिंर कषे  दौिान बननषे वाली फाइलों कषे  वलए सही पाथ औि फाइल नाम प्रदवश्भत किता 

ह।ै जांर किें  वक ्यह जानकािी सही ह ै्या नहीं। 

• िें डि सषेवटंगस ववंडो को बंद किें ।

एरनमेशन फे्म रें िर ्को बचै ्करने ्ेक रिए

• दृश्य को सषेव किें ।

बरै िषे नडरिंर सषे पहलषे दृश्य को सषेव किना एक अच्ा अभ्यास सावबत होता ह।ै ्यह तब उप्योरी होता ह ै्यवद बरै िषे नडरिंर कषे  बाद, आपको वडसपलषे सवैटंर 

में परिवत्भन किना हो औि पुन: िें डि किना हो। बरै िषे नडरिंर सषे पहलषे दृश्य को सषेव किकषे , आप ्यह जाननषे कषे  वलए दृश्य का पिीक्ण कि सकतषे हैं वक बरै 

िें डि किनषे पि वकस ववकलप की सवैटंगस उप्योर अिीन थीं।

• िें डरिंर मषेन ूमें Render > Batch Render > _र्यन किें  Render > Batch Render > _। बरै िें डि फ्षे म ववंडो वदखाई दषेता ह।ै

• सरी उपलबि प्रोसषेसस्भ कषे  उप्योर को ्योग्य किें , वफि बरै िें डि पि वक्लक किें  औि बरै िषे नडरिंर को आिंर किनषे कषे  वलए इसषे बंद किें । 

(सरी उपलबि प्रोसषेसस्भ कषे  उप्योर का ववकलप MAYA को िें डि पिूा किनषे कषे  वलए सरी उपलबि प्रोसषेसस्भ का उप्योर किनषे की सुवविा प्रदान किता ह।ै)

बचै रें िर ्की रस्थर्त ्को जांचने ्ेक रिए

• की वसथवत की जाँर कषे  वलए, र्यन किें  Window > General Editors > Script Editor। वसक्रपट एवडटि ववंडो का आकाि बढाएं। ्यह ववंडो िें डि वकए 

जानषे वालषे फ्षे मस कषे  वलए लॉर का पिूा होना दशा्भती ह।ै 

तित्र 6.8.10: उच्च गुणित्ा
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• MAYA परिणामी फाइलस को वडफ़ॉलट इमषेवजज़ डा्यिषे क्टिी में डालती ह।ै फाइलस कषे  वनमनवलवखत नाम होतषे हैं:

» Apple.0001.iff

» Apple.0002.iff

» Apple.0003.iff

» Apple.0050.iff

इमषेवजज़ डा्यिषे क्टिी उसी सथान पि वसथत होती ह ैजहाँ दृश्य डा्यिषे क्टिी वसथत होती ह।ै आप MAYA कषे  वलए प्रोजषेक्ट सषेवटंर में परिवत्भन किकषे  एक वरनन 

मार्भ  वनिा्भ रित कि सकतषे हैं। प्रोजषेक्ट कषे  बािषे  में अविक जानकािी कषे  वलए MAYA सहा्यता दषेखें।

• वनमन संदषेश आनषे पि वसक्रपट एवडटि को बंद कि दें:

// परिणाम: िें डरिंर संपणू्भ  हुई। जानकािी कषे  वलए mayaRenderLog.txt दषेखें //

• mayaRenderLog.txt फाइल में एडवांसड ्यजू़स्भ कषे  वलए िें डरिंर आंकडषे वनवहत होतषे हैं।

6.8.5 रें ििटि फे्मस ्का सीकिेंस दखेना

एक वववड्यो ्या वफलम की रवत पि बरै िें डड्भ  वरत्र दषेखनषे कषे  वलए आप MAYA की FCheck इमषेज व्यइंूर ्यवूटवलटी का उप्योर कि सकतषे हैं।

रें ििटि फे्मस ्का सीकिेंस दखेने ्ेक रिए FCheck ्का उपयोग ्करने ्ेक रिए

• Select File > View Sequence पि जाएँ। एक फाइल रिाउज़ि ववंडो वदखाई दषेरी।

• फाइल रिाउज़ि की सहा्यता सषे, अपनषे वत्भमान प्रोजषेक्ट कषे  वलए इमषेवजज़ डा्यिषे क्टिी पि जाएँ (्या जहाँ आपनषे एपपल कषे  वलए वरत्रों का सीक्वेंस सषेव 

वक्या ह।ै)

• सीक्वेंस में प्रथम वरत्र रुननषे कषे  वलए Apple.001.iff इमषेज फाइल का र्यन किें  औि Open पि वक्लक किें । FCheck इमषेज व्यइंूर ्यवूटवलटी वदखाई 

दषेरी औि 50 फ्षे मस का िें डड्भ  सीक्वेंस एक एनीमषेटषेड लपू कषे  रूप में रलता ह।ै

• एवनमषेशन दषेखनषे कषे  बाद ववंडो को बंद कि दें

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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7. Stop Motion एरनमेशन

्यवूनट 7.1 Stop Motion द्ािा रवत को िोकना
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. वसक्रपट औि वनददेशक कषे  वनददेशों कषे  अनुसाि Stop Motion कैिषे क्टज़्भ (कठपुतवल्यां ्या मॉडल) का एवनमषेशन बनाना।

2. एवनमषेशन की प्रवक्र्या कषे  दौिान िरनातमक ववरािों का ्योरदान दषेना।

3. Stop Motion एवनमषेशन तकनीकों का उप्योर किना।

4. Stop Motion Pro द्ािा रवत को िोकना, Stop Motion Pro सॉफटवषे्यि द्ािा Stop Motion एवनमषेशन तकनीकों का उप्योर किना।

रनष्कषटि 
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यूरनट 7.1: Stop Motion Pro द्ारा गर्त ्को रो्कें

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. वसक्रपट औि वनददेशक कषे  वनददेशों कषे  अनुसाि Stop Motion कैिषे क्टज़्भ (कठपुतवल्यां ्या मॉडल) का एवनमषेशन बनाना।

2. एवनमषेशन की प्रवक्र्या कषे  दौिान िरनातमक ववरािों का ्योरदान दषेना।

7.1.1 Stop Motion Pro

7.1.2 ए्क नई प्रोिकशन/शॉट बनाना

Stop Motion एवनमषेशन प्रत्यषेक ववृद्धशील परिवत्भन को वफलमातषे सम्य कैमिषे  कषे  सामनषे अवसथि ्या बदलती मुख्य सामगी द्ािा बनाई जाती ह।ै इन वरत्रों 

का पलषेबकै एक भ्रम, एवनमषेशन कषे  समान राव उतपनन किता ह।ै

जब आप एक नई एवनमषेशन बनाना राहतषे हों, तो आपको एक प्रोडक्शन का नाम बनानषे की आवश्यकता होरी, आपकी असल वफलम उसी प्रोडक्शन में 

वफलमाई जाएरी। आप बाद में अपनी प्रोडक्शन में नए शॉट्स जोड सकतषे हैं। 

Stop Motion Pro को सटाट्भ  किें  औि आपको वषेलकम डा्यलॉर वदखाई दषेरा। Create a new Production/Shot का र्यन किें , वफि OK पि वक्लक किें ।

जब एक बाि आप नई प्रोडक्शन/शॉट बना लषेतषे हैं, आपको कैपरि सवैटंर डा्यलॉर वदखाई दषेता ह।ै ्यह डा्यलॉर आपको ्यह वदखानषे कषे  वलए बना्या र्या 

तित्र 7.1.1: एक नया प्रोिकशन/शॉट बनाएं

तित्र 7.1.2: एक नया प्रोिकशन/शॉट बनाएं

यूरनट ्ेक उद्ेशय  



237236

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

ह ै वक एवनमषेशन बनातषे सम्य Stop Motion Pro उप्योर किनषे कषे  वलए आपकषे  पास कौन सा हाड्भवषे्यि 

उपलबि ह।ै

वववड्यो कैपरि काड्भ /कनषेक्ट वकए रए कैमिषे  कषे  आिाि पि कैपरि कषे  कई तिीकषे  वदखाई दषेतषे हैं।  आपकषे  

का्य्भ  किनषे कषे  ढंर कषे  अनुसाि सबसषे उप्ुयक्त तिीकषे  का र्यन किें

ध्यान दें: कयु ् विकलप केिल तब ही विखाई िेत ेहैं जब उनके ्रकार का हाड्सि े् र कनकेट वक्ा जाए।

कैमिा कनकै्शन पि नवीनतम जानकािी कषे  वलए हमािी वषेबसाइट पि िषे फषे ि किें ।

आपकषे  कैमिषे  सषे मषेल खातषे कैपरि ढंर का र्यन किें  वफि फ्षे म का आकाि वनिा्भ रित किें  (्यवद आवश्यक हो) औि OK पि वक्लक किें ।

अपना कैमिा सषेट अप किें  तावक ऐसी वकसी री वसतु को बदल सकें  वजसषे आप आसानी सषे हाथ में उठा सकतषे हैं – वखलौना राडी, कप, पषेन ्या ऐसी कोई 

अन्य वसतु। मॉडल को ्ोटषे कदमों पि वहला कि, हि सम्य पि फोटो लषेकि (वजसषे “कैपररिंर” कहतषे हैं) आप अपनी प्रथम एवनमषेशन बनानषे जा िहषे हैं। इन 

वरत्रों का पलषेबकै एक भ्रम, एवनमषेशन कषे  समान राव उतपनन किता ह!ै

तित्र 7.1.3: कवै पिर सवैटटंग

तित्र 7.1.4: कवै पिर का ियन करें
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फ्षे म कैपरि किनषे कषे  वलए, आप लाइव मोड में होनषे रावहएं। मषेन टूलबाि पि, live बटन पि वक्लक किें  औि लाइव मोड दशा्भनषे कषे  वलए इसमें िौशनी जरषेरी। 

्यवद आप कैमिषे  कषे  सामनषे अपना हाथ लाएं तो आपको ्यह सक्रीन पि रलतषे हुए वदखाई दषेरा। एक फ्षे म कैपरि किनषे कषे  वलए, capture बटन पि वक्लक किें

जब एक फ्षे म कैपरि वक्या जाता ह,ै तो फ्षे म काउंटि बढ जाता ह।ै अब कैमिषे  कषे  सामनषे की वसतु में परिवत्भन किें ।

आप onionskin फंक्शन द्ािा पहलषे कैपरि वकए रए फ्षे म औि वत्भमान लाइव वीवड्यो कषे  बीर अंति दषेख सकतषे हैं। Onionskin ववज़ीवबवलटी बढानषे कषे  वलए 

onionskin सलाइडि को बाई ंओि लषे जाएँ।

रवलए ऑबजषेक्ट को एवनमषेट किें । ऑबजषेक्ट को सीिी िषे खा में वहलाएं, फ्षे म में प्रत्यषेक ्ोटी हिकत को कैपरि किनषे कषे  वलए capture बटन पि वक्लक किें । 

इसषे 10 बाि किें , 10 फ्षे म कैपरि किें ।

अब एक शॉट लें औि एक फ्षे म कैपरि किें ; हम बाद में ्यह फ्षे म हटा देंरषे। प्रत्यषेक फ्षे म में ऑबजषेक्ट की वरनन वसथवत पि अन्य 10 ्या अविक फ्षे म कैपरि किें ।

7.1.3 एरनमेशन चिाना

एवनमषेशन रलानषे कषे  वलए आपको सटोड्भ  मोड में होना रावहए। मषेन टूलबाि पि, stored बटन पि वक्लक किें  औि सटोड्भ  मोड दशा्भनषे कषे  वलए इसमें एक िौशनी 

जरषेरी।

एवनमषेशन को पलषे किनषे कषे  वलए play बटन पि वक्लक किें । ध्यान दें वक पलषेबकै कषे  दौिान शॉट में 

आपका हाथ वदखाई दषेता ह।ै एवनमषेशन में आरषे ्या पी ष्े  जानषे कषे  वलए next ्या previous बटन पि  

वक्लक किें ।

मषेन टूलबाि पि पलषे दि (एवनमषेशन कषे  पलषेबकै की रवत) fps (फ्षे मस प्रवत सषेकंड) ववंडो में वदखाई दषेती ह।ै 

रवलए प्रवत सषेकंड फ्षे मस की संख्या को बढाकि एवनमषेशन की रवत को तीव्र किें । अपनषे माउस द्ािा fps 

ववंडो पि दाएं बटन सषे वक्लक किें , आपको एक ड्ॉप डाउन मषेन ूवदखाई दषेरा।

7.5 fps का ववकलप रुनें। अब मषेन टूलबाि पि play बटन दबाएँ। आप दषेखेंरषे वक आपकी एवनमषेशन का 

पलषेबकै िीमा हो र्या ह ै(क््योंवक ्यह 15 फ्षे मस की बजाए 7.5 फ्षे मस प्रवत सषेकंड की दि पि रलता ह)ै। 

उसी तिीकषे  सषे fps को दोबािा 15 fps पि बदलें।

तित्र 7.1.5: फे्म कवै पिर करें

तित्र 7.1.6: एतनमेशन ििाना

तित्र 7.1.7: पिे दर
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7.1.4 एरनमेशन ्को एरिट ्करना

जब एवनमषेशन का पलषेबकै वक्या जाता ह ैतो शॉट में आपका हाथ वदखाई दषेता ह।ै रवलए इनवबलट एवडवटंर टूलस द्ािा एवनमषेशन सषे अपना हाथ हटा दें।

अपनी एवनमषेशन एवडट किनषे कषे  वलए, आपको एवडटि मोड में होना रावहए। मषेन टूलबाि पि, editor बटन पि वक्लक किें  औि एवडटि मोड दशा्भनषे कषे  वलए 

इसमें एक िौशनी जरषेरी।

प्रत्यषेक फ्षे म की थंबनषेल वदखाई दषेती ह।ै

्यवद आवश्यक हो तो एवडटि में थंबनषेलस में नषेववरषेट किनषे कषे  वलए Windows सक्रोल बाि (थंबनषेल इमषेवजस कषे  दाई ंओि) का उप्योर किें । माउस कषे  बाएँ 

बटन सषे उस फ्षे म पि वक्लक किें  वजसमें आपका हाथ वदखाई दषेता ह।ै फ्षे म लाल िंर में हाईलाइट होरा। साइड टूलबाि पि, एक्शन पि माउस का बा्याँ बटन 

दबाएँ। अब आप एवडटि ववंडो कषे  दाई ंओि Hide बटन द्ािा फ्षे म को हाईड कि सकतषे हैं।

वह फ्षे म वजसमें आपका हाथ वदखाई दषेता ह,ै इसमें पीलषे िंर की एक वति्ी िषे खा वदखाई दषेरी औि फ्षे मस कषे  पलषेबकै कषे  दौिान ्यह वदखाई नहीं दषेरी। आप 

इसषे play बटन पि वक्लक किकषे  रषेक कि सकतषे हैं औि एवनमषेशन दषेख सकतषे हैं।

तित्र 7.1.8: एतनमेशन एतिट करना
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7.1.5 साउंि ट््ैक ्ेक सा्थ एरनमेशन बनाना

7.1.6 ऑरियो ्ेक सा्थ एरनमेशन

• सबसषे पहलषे ऑवड्यो ट्कै कषे  साथ एवनमषेशन रलाकि दषेखें औि सुनें। एवनमषेशन दषेखनषे  

कषे  वलए

 आपको Microsoft “Windows Media Player” खोलना होरा। ऐसा आप Windows Start 

menu, Windows Media Player पि जाकि कि सकतषे हैं। मीवड्या पलषे्यि में File|Open 

का र्यन किें  औि वनमन मूवी खोलें:

C:\Program Files\Stop Motion Pro v7\assets\Quickstart\quickstart_movie.mpg

• ्यह कैिषे क्टि कषे  ऑबजषेक्ट में बदलनषे की 3 सषेकंड की एवनमषेशन ह।ै आप एवनमषेशन बनानषे 

कषे  वलए वही ऑवड्यो ट्कै का उप्योर किें रषे।

• एवनमषेट किनषे कषे  वलए एक कैिषे क्टि खोजना – आप पलावसटक की वसतु, वखलौना राडी, 

पेंवसल का शाप्भनि – जो री आपकषे  पास हो, का उप्योर कि सकतषे हैं। आपको कैिषे क्टि कषे  वलए वमलानषे कषे  वलए एक ऑबजषेक्ट की आवश्यकता होरी, 

्यह एक कप, बक्सा ्या टषेलीफोन, औि वफि सषे, आपकषे  पास जो री हो उसषे ही उप्योर कि सकतषे हैं।

• Stop Motion Pro में एक नई प्रोडक्शन/शॉट शुरू किें  प्रोडक्शन को एक नाम दें My animation औि वॉक कै्रश का शॉट लें औि OK पि वक्लक किें ।

• कैपरि पिैामीटि वनिा्भ रित किें  जसैा वक आपनषे Task 1 में वक्या था। एक बाि जब आप अपनषे कैमिषे  सषे लाइव व्य ूलषे लषेतषे हैं, तो वह ऑबजषेक्ट वनिा्भ रित 

किें  जो सक्रीन पि वदखाई दषेरा। अपनषे कैिषे क्टि को सक्रीन कषे  बा्यीं ओि किें , वबलकुल शॉट सषे बाहि।

• मषेन टूलबाि पि अपनी फ्षे मस प्रवत सषेकंड (fps) दि दषेखें। ्यह सुवनवश्चत किें  वक fps 15 पि सषेट ह।ै ्यवद आप एडजसट किना राहें तो fps बटन पि माउस 

कषे  दाएं बटन सषे वक्लक किें , आपको एक ड्ॉप डाउन मषेन ूवदखाई दषेरा, 15 fps रुनें।

एवनमषेशन शुरू किनषे सषे पहलषे, हमें अपना ऑवड्यो ट्कै जोडना होरा औि सुवनवश्चत किना होरा वक 

्यह सही सम्य पि रलषे। ऐसा किनषे कषे  वलए, Tools|Audio sync मषेन ूका र्यन किें ।

• वनमनवलवखत WAV फाइल रुनें:

C:\Program Files\Stop Motion Pro v7\assets\Quickstart\walk_crash_ow.wav

ऑवड्यो वसंक ववंडो हिषे  िंर की तिंरदाि िषे खा, ऑवड्यो ट्कै कषे  ववजु़अल प्रवतरूप कषे  रूप में एक wav 

ऑवड्यो फाइल वदखाएरी। ऑवड्यो फाइल सुननषे कषे  वलए ऑवड्यो वसंक ववंडो पि पलषे बटन पि वक्लक 

किें । नीरषे वदए वरत्र में आप कु् नोइस दषेख सकतषे हैं वजसषे हम अपनी एवनमषेशन में synchronize 

किना राहतषे हैं। ऑवड्यो फाइल एक व्यवक्त कषे  कदमों की आवाज़ कषे  साथ शुरू होती ह ैवजससषे एक 

कप टूट जाता ह,ै वह व्यवक्त वफि कहता ह:ै “ओ!”

तित्र 7.1.9: साउंि ट्वैक के साथ एतनमेशन

तित्र 7.1.10: ऑतियो ट्वैक के साथ एतनमेटटंग

ऑवड्यो तिंर कषे  नीरषे ्ोटी ववट्भकल िषे खाएं ्यह दशा्भती हैं वक एवनमषेशन कषे  वासतववक फ्षे म कहाँ होंरषे।

ऑवड्यो का सही सम्य पि रलना औि बंद होना सुवनवश्चत किनषे कषे  वलए हमें वववड्यो फ्षे म औि ऑवड्यो फ्षे म दोनों कषे  साथ फ्षे म 1 कषे  साथ “synchronize” 

किना होरा।
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रवलए इसषे अरी कितषे हैं। हिी तिंर पि बाएं बटन सषे वक्लक किें  औि फ्षे म 1 पि आनषे तक माउस को बा्यीं ओि ड्ैर किें । ऑवड्यो वसंक ववंडो पि sync बटन 

पि वक्लक किें । ऑवड्यो वसंक ववंडो टूलबाि ऐसा वदखाई दषेरा:

अब आप ऑवड्यो ट्कै कषे  साथ अपनषे कैिषे क्टि को एवनमषेट किना शुरू कि सकतषे हैं। दो फ्षे म कैपरि किें , अपना “person” कैिषे क्टि िीिषे  सषे शॉट में लाएं। दो 

अन्य फ्षे म लें औि दोबािा कैिषे क्टि को मूव किें ।

वषे फ्षे म जो आपनषे कैपरि वकए हैं वषे सलषेटी िंर में वदखाई दषेतषे हैं, वत्भमान सटोड्भ  फ्षे म सफषे द िंर में हाईलाइट होतषे हैं। ्यह आपको सपष्ट किता ह ैवक आप साउंड 

ट्कै में कहाँ तक पहंुरषे हैं।

कु् सम्य लें ्यह दषेखनषे कषे  वलए वक ऑवड्यो ट्कै में क््या हो िहा ह:ै मुख्य 

सम्य वह ह ैजब कैिषे क्टि ऑबजषेक्ट सषे टकिाता ह।ै

्यह साउंडट्कै में ्यह वबलकुल 2 सषेकंड ह।ै प्रत्यषेक फ्षे म कैपरि कितषे सम्य 

कैिषे क्टि को रािों ओि घुमाएं, 2 सषेकंड में ऑबजषेक्ट तक पहँुरनषे का लक््य 

िखें।

्यवद आपको ऐसा किना हो, तो ्यह दषेखनषे कषे  वलए सैंपल वववड्यो की समीक्ा किें  वक हमनषे वकस प्रकाि इस साउंड ट्कै कषे  साथ एवनमषेशन वक्या ह।ै हमािी 

एवनमषेशन दषेखनषे कषे  वलए हमें Microsoft “Windows Media Player” खोलना होरा। अपनषे Windows कषे  Start menu पि जाएँ औि Windows Media Player 

पि दषेखें। मीवड्या पलषे्यि में File|Open का र्यन किें  औि वनमन मूवी खोलें:

तित्र 7.1.11: छोटी िरटटिकि िाइनस

तित्र 7.1.12:  हरी िरंग

तित्र 7.1.13:  ऑतियो पसंक
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C:\Program Files\Stop Motion Pro v7\assets\Quickstart\quickstart_movie.mpg

फ्षे मस को कॉपी, पषेसट ्या हाईड किनषे कषे  वलए एवडटि कषे  उप्योर पि ववराि किें  (जसैा वक आपनषे का्य्भ  1 में सीखा ह)ै का्य्भक्रमों कषे  सम्य में सुिाि किें । 

इस दृश्य को दो बाि एनीमषेट किनषे कषे  प्र्यास कषे  वलए त्ैयाि िहें। आप दषेखेंरषे वक आपकी एवनमषेशन में एक शॉट सषे दूसिषे  तक बहुत परिवत्भन आएरा। अपनषे 

शॉट्स को अलर-अलर नाम दें तावक बाद में आप अपनी उननवत की समीक्ा कि सकें ।

7.1.7 ए्क मूिी बनाना

अपना एवनमषेशन सीक्वेंस बनानषे कषे  बाद इसषे कई एपलीकषे शंस पि एक्सपोट्भ  वक्या जा सकता 

ह।ै ्यवद आप अपनी एवनमषेशन को DVD, ईमषेल ्या वषेब पि डालना राहतषे हैं, ्या ्यवद आप वववड्यो 

एवडवटंर सॉफटवषे्यि द्ािा इसमें टाइटल, फषे ड इन/आउट, वडज़ौलव म्यवूज़क ्या अन्य साउंड ट्कै 

जोडना राहें, तो ्यह उप्योरी हो सकता ह।ै

• Stop Motion Pro सषे अपनी एवनमषेशन की आउटपुट कषे  वलए मषेन मषेन ूमें File|Make movie 

का र्यन किें । मूवी बनाएं डा्यलॉर वदखाई दषेरा।

• इस उदाहिण कषे  वलए, ्यह सुवनवश्चत किें  वक आपनषे ऑवड्यो फाइल का उप्योर किें  

ववकलप का र्यन वक्या ह ैवजसमें वह ऑवड्यो फाइल शावमल ह ैजो आपनषे अपनी आउटपुट 

मूवी में अपनी एवनमषेशन में उप्योर वक्या ह।ै

• सरी फ्षे मस रुनें।

• आउटपुट मूवी की ऊंराई औि रौडाई वनिा्भ रित किें  (अरी कषे  वलए इसषे ्ोड दें) OK पि 

वक्लक किें ।

• अपनी एवनमषेशन को my animation.wmv नाम दें औि इसषे अपनषे डैसकटॉप पि सषेव किें ।

अब आप इस फाइल को दषेखनषे कषे  वलए Windows Media player ्या एवडट किनषे कषे  वलए 

Windows Movie Maker में खोल सकतषे हैं। 

अपनी एवनमषेशन को वफलमाना पिूा किनषे पि आप अरलषे रिण में जा सकतषे हैं, इसषे एक मूवी में बदलना।

तित्र 7.1.14:  ऑतियो पसंक शॉ्टस

तित्र 7.1.15:  मूिी बनाना
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7.1.8 ए्क ऑरियो ट््ैक रर्कॉिटि ्करना

7.1.9 Chroma key

अपनी एवनमषेशन पि आपकी अपनी आवाज़ रिकॉड्भ  किना बहुत मज़षेदाि होता ह।ै ऑवड्यो रिकॉड्भि औि एक माइक्रोफोन कषे  साथ, एवनमषेशन कषे  दौिान 

डा्यलॉर औि साउंड इफ़षे क्ट जोडना आसान होता ह।ै

• मषेन मषेन ूTools|Audio recorder रुनें औि ऑवड्यो रिकॉड्भि ववंडो वदखाई दषेरी।

• ्यह सुवनवश्चत किें  वक माइक्रोफोन आपकषे  कंप्यटूि सषे जुडा ह।ै

• अपनी ऑवड्यो रिकॉवडयंर सषेट अप किनषे कषे  वलए शीष्भ  बाई ंओि सषे तीन ड्ॉप डाउन मषेन ू(वडवाइस, इनपुट औि फॉमदेट) का उप्योर किें ।

• Recording Start / Stop बटन दबाएँ। जब आप माइक्रोफोन में बोलतषे हैं तो आपको रिकॉवडयंर सति कषे  इंवडकषे टि (दो हिी बास्भ) को दषेखना रावहए। 

रिकॉवडयंर िोकनषे कषे  वलए Start/Stop बटन पि दोबािा वक्लक किें । आप ऑवड्यो फाइलस को सषेव कि सकतषे हैं (बाद में एवडवटंर कषे  वलए) ्या उनहें 

ऑवड्यो वसंक ववंडो में अपनी वत्भमान एवनमषेशन में सवरैावलत रूप सषे syncronise कि सकतषे हैं।

• रिकॉवडयंर औि पलषेव्ंयर कषे  दौिान पलषे सटोड्भ  फ्षे मस कषे  रूप में वरवनहत बॉक्स को रकै कि सकतषे हैं, ऑवड्यो रिकॉड्भ  कितषे सम्य वफलमाई रई एवनमषेशन 

का उप्योर मार्भदश्भन कषे  तौि पि कि सकतषे हैं।

रिकॉवडयंर पिूी होनषे पि, आप अपनषे आप ऑवड्यो वसंक टूल में ऑवड्यो फाइल को इमपोट्भ  कि सकतषे हैं, वजसषे आप मार्भदश्भन कषे  तौि पि उप्योर कि  

सकतषे हैं।

अपनी लाइव वववड्यो में अन्य वरत्र कषे  साथ िंरों की एक ववशषेष सीमा को Chroma key द्ािा प्रवतसथावपत किें । इसषे गीन सक्रीन ्या बल ू सक्रीन री  

कहतषे हैं।

्यह नीरषे वदए वरत्र में दशा्भ्या र्या ह ैवक कैिषे क्टि (नीला िंर) कषे  आसपास बकैगाउंड स्ूया्भसत कषे  वरत्र कषे  साथ कहाँ प्रवतसथावपत होरा।

तित्र 7.1.16:  ऑतियो ररकॉिटिर
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Chroma key टूल कषे  उप्योर कषे  वलए, मषेन मषेन ूTools|Chroma key रुनें औि Chroma key ववंडो वदखाई दषेरी। Chroma key फंक्शंस कषे  उप्योर कषे  वलए 

आपको Chroma key फाइल को सटोड्भ  फ्षे म कषे  साथ synchronise किना रावहए।

• मषेन टूलबाि पि सलाइडि बाि द्ािा सटोड्भ  फ्षे म रुनें।

• Chroma key ववंडो पि सलाइडि बाि ्या पलषेबकै बटन द्ािा सटोड्भ  फ्षे म रुनें।

• वसंक पि वक्लक किें  औि बटन पीलषे िंर में हाईलाइट हो जाएरा।

• जब synchronize हो जाएँ, तो लॉक वकए रए सटोड्भ  फ्षे म नंबि औि इससषे जुडषे  क्रोम की कषे  लॉक वकए रए सटोड्भ  फ्षे म नंबि क्रोम की ववंडो में वदखाई 

दषेतषे हैं।

• जब आप मषेन टूलबाि द्ािा सटोड्भ  फ्षे मस में जाएं तो क्रोम की वसंक में िहषेरी।

Chroma key िंर का र्यन किनषे वालषे बटन को रुनें औि लाइव वववड्यो ववंडो में माउस कषे  बाएं बटन को उस िंर पि वक्लक किें  वजसषे Chroma key वरत्र 

सषे प्रवतसथावपत वक्या जाना ह।ै tolerance slider की सहा्यता सषे लाइव वववड्यो इमषेज कषे  साथ Chroma key फुटषेज को वमवशत किना संरव हो जाता ह।ै

तित्र 7.1.17: बाएुँ: Chroma key से पहिे

तित्र 7.1.18: बाएुँ: Chroma key के उपयोग के बाद
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8. ्कायटिस्थि में सिास्थय एिं 
सुरक्ा बनाये रखना

्यवूनट 8.1 का्य्भसथल में सवास्थ्य एवं सुिक्ा बना्यषे िखना

MES/N 1014
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इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. संरठन कषे  वत्भमान सवास्थ्य, सुिक्ा तथा िक्ा नीवत्यों एवं प्रवक्र्याओ ंको समझनषे तथा इनका अनुपालन किनषे में।

2. अपनषे व्यवसा्य सषे जुडी सुिवक्त का्य्भ  पद्धवत्यों को समझनषे में।

3. सवास्थ्य एवं सुिक्ा सषे संबंवित सिकािी वन्यमों एवं नीवत्यों को समझनषे में, वजनमें बीमािी, दुघ्भटना, आरज़नी ्या परिसि खाली किानषे कषे  वलए 

आपातकालीन प्रवक्र्याएं री शावमल हैं।

4. का्य्भसथल में सवास्थ्य एवं सुिक्ा कषे  वलए वजममषेदाि व्यवक्त्यों का पता लरानषे में, वजनमें आपातकालीन वसथवत में समपक्भ  वक्यषे जानषे वालषे लोर री 

शावमल हैं।

5.  सुिक्ा संकषे तों, जसैषे फा्यि अलाम्भ  औि सीढी, फा्यि वाड्भन सटषेशन, फसट्भ एड तथा मषेडीकल कक् जसैषे सथानों का पता लरानषे में।

6.  आपकषे  का्य्भसथल कषे  ऐसषे पहलुओ ंकी पहरान किनषे में, जो आपकषे  ्या अन्य लोरों कषे  सवासथ् ्य तथा सुिक्ा कषे  वलए जोवखम बन सकतषे हैं।

7. एहवत्याती उपा्यों कषे  माध्यम सषे का्य्भसथल में सव्ंय औि अन्य लोरों कषे  वलए सवास्थ्य एवं सुिक्ा सुवनवश्चत किनषे में।

8. सवास्थ्य, सुिक्ा तथा िक्ा को सुिािनषे कषे  अवसिों की पहरान तथा वववनवद्भष्ट व्यवक्त सषे उनकी वसफारिश किनषे में।

9. व्यवक्त कषे  प्राविकािों की सीमाओ ंमें बीमािी, दुघ्भटनाओ,ं आर ्या वकसी अन्य प्राकृवतक आपदा जसैषे जोवखमों की सुिवक्त तिीकषे  सषे पहरान किें  तथा 

उनहें ठीक किनषे में।

रनष्कषटि 
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यूरनट 8.1: ्कायटिस्थि में सिास्थय एिं सुरक्ा बनाये रखना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. एहवत्याती उपा्यों कषे  माध्यम सषे का्य्भसथल में सव्ंय औि अन्य लोरों कषे  वलए सवास्थ्य एवं सुिक्ा सुवनवश्चत किनषे में।

2. व्यवक्त कषे  प्राविकािों की सीमाओ ंमें बीमािी, दुघ्भटनाओ,ं आर ्या वकसी अन्य प्राकृवतक आपदा जसैषे जोवखमों की सुिवक्त तिीकषे  सषे पहरान किें  तथा 

उनहें ठीक किनषे में।

3. का्य्भसथल में सवास्थ्य एवं सुिक्ा कषे  वलए वजममषेदाि व्यवक्त्यों का पता लरानषे में, वजनमें आपातकालीन वसथवत में समपक्भ  वक्यषे जानषे वालषे लोर री 

शावमल हैं।

8.1.1 पररचय
जब इमाित कषे  अनदि ठहिना सुिवक्त न िहषे तो ऐसी वसथवत में आपातकालीन रिक्तीकिण की आवश्यकता होती ह।ै प्रत्यषेक संरठन में एक खाली किानषे 

की प्रवक्र्या होती ह।ै प्रत्यषेक संरठन में, संरठन परिसि कषे  रीति ही अथवा संरठन परिसि सषे बाहि एक सुिवक्त सथान होता ह,ै जहां पि वकसी 

आपातकालीन रिक्तीकिण की वसथवत में सरी कम्भरारि्यों को एकवत्रत होना होता ह।ै टीम लीडि टीम का नषेततृव किता ह,ै औि उनहें सुिवक्त सथान पि 

लषे जाता ह।ै ऐसषे मामलों में तुिंत सुिवक्त सथान पि एकत्र हो जाना बषेहद महतवपणू्भ  होता ह।ै 

्यवद आप उवरत सम्य पि सुिवक्त सथान पि नहीं पहंुरतषे हैं, तो आपकी सुिक्ा कषे  वलए वजममषेदाि टीम लीडि आपको खोजनषे कषे  वलए वकसी को रषेजषेरा। 

इससषे उस व्यवक्त का जीवन खतिषे  में आ जा्यषेरा।

ररतिी्करण ्की रस्थर्तयां 

रिक्तीकिण की आवश्यकता वाली आपात-वसथवत्यों में शावमल ह:ै 

• आरज़नी 

• ववसफोटक 

• बाढ 

• रकंूप 

• समुरिी तफूान 

• बवंडि 

• ववषाक्त सामगी का उतसज्भन 

• दंरषे/उपरिव 

• का्य्भसथल वहंसा

प्रतये्क ्कमपनी ्ेक पास हो्ती ह:ै

• ए्क ररतिी्करण नीर्त। सरी टीम लीडिों (TL) की ्यह वजममषेदािी होती ह ैवक वषे अपनषे कम्भरारि्यों को इसकषे  बािषे  में सवूरत किें । आपकषे  टीम लीडि 

(TL) जब आपको इनकषे  बािषे  में आपको सवूरत कि िहषे हों तो आप उनकी बातों को ध्यान सषे सुनषे। असाविानी कषे  कािण जीवन संकट में पड सकता 

ह।ै 

• आपा्त रस्थर्तयों ्ेक रिए ए्क रनरदटिष्ट स्थान। सुवनवश्चत किें  वक ्यषे सथान आपको पता हो। 

• रि्किांग वयरतियों ्ेक रिए ए्क “रमत्र प्रणािी (बिीरससटम)”। ्यवद आप वकसी व्यवक्त कषे  वमत्र (बडी) हैं, तो सुवनवश्चत किें  वक आपकषे  साथ, 

आपका वमत्र री परिसि सषे सुिवक्त बाहि वनकल आ्या हो। 

तित्र 8.1.1:  ररक्तीकरण की त्थतियां

यूरनट ्ेक उद्ेशय  
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• ्कायटि क्ेत्रों में ररतिी्करण मागषों ्ेक सा्थ फिोर ्पिान। सुवनवश्चत किें  वक आप इसषे समझतषे हों तावक आवश्यकता पडनषे पि इसका उप्योर कि सकें । 

• ए्कत्री्करण स्थान। रिक्तीकिण कषे  पश्चात आपको इन सथानों पि एकवत्रत होनषे की आवश्यकता होती ह।ै 

• आिरध्क ररतिी्करण अभयास। सुवनवश्चत किें  वक उन अभ्यासों कषे  दौिान आप सरी बातों पि ध्यान दें। आपको अपना जीवन बराना ह ैऔि आप 

दूसिों का जीवन बरानषे में री सहा्यक हो सकतषे हैं। 

8.1.2 बनािटी अभयास/ ररतिी्करण

8.1.3 रचर्कतसीय आपा्त्कािीन रस्थर्तयां

अवगन सुिक्ा तथा रिक्तीकिण ्योजनाओ ं में आपातकालीन वसथवत्यों में सटाफ कषे  कत्भव्यों तथा वजममषेदारि्यों का वण्भन वक्या र्या ह।ै सटाफ को इन 

कत्भव्यों एवं वजममषेदारि्यों कषे  बािषे  में मालमू हो, ्यह सुवनवश्चत किनषे में सहा्यता हषेतु सतत् प्रवशक्ण की आवश्यकता होती ह।ै बनावटी आरज़नी की वसथवत 

पदैा किनषे सषे कम्भरारि्यों को इस बात कषे  प्रदश्भन का अवसि वमलता ह ै वक वषे अपनषे उन कत्भव्यों एवं वजममषेदारि्यों का सुिवक्त तथा कुशल ढंर सषे 

वनष् पादन कि सकतषे हैं। ्यह उनकषे  वलए ्यह वदखानषे का सम्य री होता ह ैवक वषे का्य्भसथल सुिक्ा िणनीवत्यों सषे परिवरत हैं, तथा अपनषे संिक्णािीन 

व्यवक्त्यों की सुिक्ा किनषे हषेतु आपकषे  कषे नरि की अवगन सुिक्ा तथा वनर्भमन सुवविाओ ंका लार उठा सकतषे हैं।

अवगनशमन अभ्यास को एक कृवत्रम आपातवसथवत में कम्भरारि्यों की प्रवतवक्र्या कषे  मूल्यांकन हषेतु त्ैयाि 

वक्या र्या ह।ै ्यषे आपकषे  कषे नरि की अवगन सुिक्ा/रिक्तीकिण ्योजनाओ ंतथा कम्भरािी प्रवशक्ण का्य्भक्रमों 

का री एक इवमतहान होतषे हैं। सरी अवगनशमन अभ्यास सुरारू रूप सषे नहीं रलतषे हैं। ्यवद कम्भरािी तथा 

प्रबंिन उनसषे सीखतषे हैं तथा अपनी तु्रवट्यों को सुिाितषे हैं तो ठीक ह,ै कोई बात नहीं। इसवलए ्यह 

महतवपणू्भ  बात ह ैवक हम प्रत्यषेक बनावटी अभ्यास की समीक्ा की जाए तावक सामनषे आनषे वाली वकसी 

री समस्या का समािान वक्या जा सकषे । संरवत: अपणू्भ  ्या पुिानषे पड रुकषे  अवगनशमन/रिक्तीकिण 

्योजनाओ ं कषे  कािण समस्याएं हैं। समरवत: कम्भरारि्यों को अवतरिक्त प्रवशक्ण प्रदान किनषे की 

आवश्यकता ह।ै 

अवगनशमन त्ैयािी ्योजना कषे  दो प्रमुख अंर वनमनवलवखत हैं: 

1. एक आपातकालीन काि्भ वाई ्योजना, वजसमें बता्या र्या हो वक आर लरनषे की वसथवत में क््या 

किना ह।ै 

2. एक आरज़नी िोकथाम ्योजना, वजसमें बता्या र्या हो, वक आर लरनषे सषे िोकनषे कषे  वलए क््या 

किना ह।ै 

आपको अपनी तथा अन्य लोरों की सुिक्ा हषेतु संरठन द्ािा आ्योवजत वकए जानषे वालषे अवगनशमन 

अभ्यास में सहरावरता किनी रावहए। ्यषे बनावटी अभ्यास आर लरनषे की वसथवत में संरठन की काि्भ वाई 

्योजना तथा सुिक्ा संकषे त-वरनहों को समझनषे में आपकी सहा्यता कितषे हैं।

आपातकालीन वसथवत्यों कषे  वलए सरी लोर ्योजना बनातषे हैं। इसी वजह सषे हम अपनषे पास एक प्राथवमक वरवकतसा वकट िखतषे हैं। वसैषे का्य्भसथल पि लोरों 

को काफी तनाव तथा शािीरिक रवतवववि्यों सषे रुज़िना पडता ह।ै इसकषे  कािण कु् वरवकतसी्य आपातकालीन वसथवत्यां उतपनन हो सकती हैं। इसवलए 

बषेहति होरा, वक प्राथवमक वरवकतसा उपा्यों तथा उनहें सव्ंय व अन्य लोरों पि वक्र्यावनवत किनषे कषे  ज्ान कषे  साथ त्ैयाि िहें। इस मॉड््यलू में आपको ्यही 

सरूना प्रदान की जाएरी। ऐसषे वनणा्भ्यक अवसिों पि की जानषे वाली काि्भ वाई को समझनषे कषे  वलए इन वरवकतसी्य आपातकालीन प्रवक्र्याओ ंपि ध्यान दें। 

इन सत्रों कषे  दौिान ध्यान दें। आप सव्ंय अपना व अपनषे वमत्रों का जीवन बरानषे में सक्म हो सकतषे हैं।

तित्र 8.1.2:  बनािटी अभयास



249248

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

8.1.2.1 रचर्कतसीय आपा्त्कािीन रस्थर्त ्का सामना ्करना

एक वरवकतसी्य आपातकालीन वसथवत एक दुघ्भटनातमक क्वत अथवा एक वरवकतसी्य संकट होता ह।ै इसकषे  कु् उदाहिण वनमनवलवखत हैं: 

• व्यवक्त सांस नहीं लषे िहा ह ै

• सट्ोक ्या हृद्याघात 

• तषेज़ िक्तस्ाव 

• आघात 

• ववषाक्तीकिण 

• जलना 

एक वरवकतसी्य आपातकालीन वसथवत में आपको ततकाल ध्यान दषेनषे की आवश्यकता होती ह,ै कई बाि तो आपातकालीन सषेवा को बुलानषे सषे पहलषे री। 

इसवलए अपनी सव्ंय तथा अन्य लोरों की सुिक्ा हषेतु आपको आपातकालीन वरवकतसी्य सषेवा (EMS) नमबि ज्ात होना बषेहद ज़रूिी ह।ै 

रनमनरिरख्त ्कायटि न ्करें  

• पीवडत व्यवक्त को कु् खानषे ्या पीनषे कषे  वलए दषेना 

• पीवडत व्यवक्त को अवरुद्ध किना। 

• पीवडत व्यवक्त कषे  रषेहिषे  पि वकसी प्रकाि का रिव व्डकना ्या उडषेलना। 

• पीवडत व्यवक्त को वकसी दूसिषे  सथान पि लषे जाना (जब तक वक ्यह पीवडत व्यवक्त को सुिवक्त िखनषे का एकमात्र तिीका न हो)। 

रतिस्ाि 

• एक डा्यिषे क्ट प्रषेशि बैंडषेज सषे घाव पि सीिा दबाव डालें। 

• िक्तस्ाव को िीमा किनषे कषे  वलए घाव को ऊपि उठाएं। 

• िक्तस्ाव को कम किनषे में सहा्यता किनषे हषेतु आवश्यक होनषे पि प्रषेशि पवाइंट्स पि अवतरिक्त दबाव डालें। 

बेहोशी

• बषेहोशी, अथा्भत् जब एक संवक्प्त अववि कषे  वलए व्यवक्त रषेतनाशनू्य हो जा्यषे। ऐसा तब होता ह ैजब मवसतष्क को िक्त प्रवाह असथा्यी तौि पि कम  

हो जा्यषे।

• एक संवक्प्त अववि कषे  वलए रषेतनाशनू्य होनषे सषे फश्भ पि वरिनषे कषे  कािण होनषे वाली दुघ्भटना। 

• िीमी नबज़। 

• पीली, ठंडी तवरा तथा पसीना आना। 

बेहोशी ्ेक ्कारण:

• बहुत कम मात्रा में रोजन तथा रिव्यों का सषेवन किना (वनज्भलीकिण)। 

• वनमन िक्तराप। 

• वनरिा का अराव। 

• अत्यविक थकान। 

बेहोशी ्ेक रिए प्रा्थरम्क रचर्कतसा: 

• पीवडत व्यवक्त को पीठ कषे  बल वलटाएं तथा उसकी टांरों को हृद्य सति सषे ऊपि उठाएं। 

• जांर कि सुवनवश्चत किें  वक पीवडत व्यवक्त का वा्ुयमार्भ  अवरुद्ध न हो। 

• दषेखें, वक सांस लषेनषे, खांसी किनषे ्या वहलनषे-डुलनषे जसैी कोई हिकत हो। 
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• कपडों को ढीला किें  (टाई, कॉलि, बषेलट आवद)। 

• ्यवद एक वमनट कषे  अनदि होश नहीं आता ह,ै तो EMS को कॉल किें । 

आघा्त 

जब िक्तवह-तंत्र में कोई कमी आती ह,ै तथा ऊतकों तक प्या्भप्त ऑक्सीजन नहीं पहंुरती ह,ै तो आघात लरता ह।ै ्यवद इस वसथवत का तुिंत उपराि न वक्या 

जाए, तो महतवपणू्भ  अंर खिाब हो सकतषे हैं, वजसकषे  कािण अंतत: मतृ्ुय री हो सकती ह।ै र्य औि पीडा आपकषे  आघात की वसथवत को औि री बदति बना 

दषेतषे हैं। 

आघा्त ्ेक रिए प्रा्थरम्क रचर्कतसा: 

• पीवडत व्यवक्त को वलटाए िखें (्यवद समरव हो)। 

• पिैों को 10-12 इंर ऊपि उठाएं, ्यवद पीठ में क्वत हो ्या अवसथ्यां रंर हो तो वफि पिैों को ऊपि न उठाएं। 

• शिीि का तापमान संतुवलत िखनषे कषे  वलए पीवडत व्यवक्त को कवि किें । 

• पीवडत व्यवक्त को प्या्भप्त मात्रा में ताजी वा्ुय औि खुला सथान प्रदान किें । 

• पीवडत व्यवक्त ्यवद उवलट्यां किना शरु कि दषेता ह,ै तो उसषे उसकषे  बॉईं तिफ िखें। 

• कसषे हुए कपडों को ढीला किें । 

मांसपेरशयों में ऐठंन 

• ऐठंन को प्ररावहीन किनषे कषे  वलए प्रराववत मांसपषेशी को खींरतषे हुए सीिा किें । 

• ऐठंी हुई मांसपषेशी पि दृढतापवू्भक मावलश किें । 

• प्रराववत सथान पि नम ऊष्मा का प्र्योर किें । 

• ऐठंन ्यवद वफि री बनी िहती ह,ै तो वरवकतसी्य सहा्यता लें। 

• आिाम किें - पीडा उतपनन किनषे वाली रवतवववि्यों एवं वक्र्याकलापों सषे बरें। 

• बफ्भ  का प्र्योर किें - ्यह पीडा औि सजून को कम किनषे में सहा्यक होती ह।ै 

• कमप्रषेशन- इलावसटक िैप ्या बैंडषेज पहननषे सषे पडनषे वालषे हलकषे  दबाव सषे सजून कम होनषे में सहा्यता वमल सकती ह।ै 

• ऊपि उठाना- प्रराववत अंर को ऊपि उठाकि हृद्य कषे  सति तक लषे जानषे सषे पीडा एवं सजून में कमी आती ह।ै 

अरस्थभंग 

अवसथ की वनिनतिता में वकसी रंजन ्या दिाि को अवसथरंर कहतषे हैं।

रिस्थापन

वकसी जोड पि एक ्या अविक अवसथ्यों कषे  सथान-परिवत्भन को ववसथापन कहतषे हैं। आमतौि पि ्यह कंिों, कोहनी, अंरठूषे , अंरुवल्यों, तथा वनरलषे जबडषे में 

होता ह।ै 

रिस्थापन एिं अरस्थभंग ्ेक रिए प्रा्थरम्क रचर्कतसा:

• प्रराववत वहससषे को वहलनषे-डुलनषे न दें। 

• प्रराववत वहससषे को वसथि किें ।

• कपडषे को एक लटकन (वसलंर) कषे  रूप में प्र्योर किें । 

• बोड्भ  को एक लटकन (वसलंर) कषे  रूप में प्र्योर किें । 

• पीवडत व्यवक्त को साविानीपवू्भक सट्षेरि पि वलटाएं। 

• एक वरवकतसक बुलाएं। 



251250

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

8.1.4 प्रा्थरम्क रचर्कतसा

प्राथवमक वरवकतसा बॉक्स को सुसपष्ट रूप सषे वरनहांवकत किकषे  ऐसषे सथान पि िखना रावहए, 

जहां वह वकसी आपातवसथवत में तुिंत वमल सकषे । ्यषे का्य्भसथल पि वकसी री सथान सषे 100 

मीटि सषे अविक दूि नहीं होना रावहए। वासतव में, ्यषे वकट वकसी वॉश-बषेवसन कषे  वनकट अथवा 

वकसी प्या्भप्त िोशनी वालषे सथान पि होनषे रावहएँ। इनमें िखी जानषे वाली रीज़ों की वन्यवमत 

जांर की जानी रावहए तथा उप्योर की जा रुकी वसतुओ ंको वफि सषे रि वद्या जाना रावह्यषे। 

आमतौि पि एक प्राथवमक वरवकतसा बॉक्स की सामवग्यों का वववन्यमन काननू द्ािा वक्या 

जाता ह,ै जो वक कमपनी कषे  आकाि तथा संराववत औद्ोवरक जोवखमों पि वनर्भि किता ह।ै 

एक सामान्य वकट में एक िलूिोिी तथा जलिोिी वडबबषे में वनमनवलवखत रीज़ें शावमल हो 

सकती हैं: 

• िोराणुहीन बैंडषेज, प्रषेशि बैंडषेज, ड्षेवसंर (रषेज पड्ैस), तथा वसलगस। इनहें अलर-अलर लपषेटा तथा एक िलूिोिी वडबबषे ्या बरै में िखा होना रावहए। 

्ोटषे-मोटषे जलनषे एवं कटनषे का उपराि किनषे कषे  वलए हमषेशा ही अलर-अलर आकािों की प्या्भप्त मात्रा अवश्य उपलबि होनी रावहए। बैंडषेज एवं ड्षेवसंर 

को बांिनषे कषे  वलए मषेवडकल एडहषेवसव टषेप (वसट्प पलासटि) की री आवश्यकता होती ह।ै 

• घाव को साफ किनषे कषे  वलए रुई। 

• कैं री, वरमटी (वसपवलंटि कषे  वलए), तथा सषेफटी वपन। 

• एक आई बाथ तथा आई वॉश बोतल। 

• तुिंत उप्योर वकए जा सकनषे वालषे एनटीसषेवपटक सोल्यशून तथा क्रीम। 

• सािािण वबना वप्रवसक्रपशन वाली दवाएं जसैषे वक एवसपरिन तथा एनटवैसड।

• प्राथवमक वरवकतसा उपराि कषे  बािषे  में जानकािी दषेनषे वाली एक बुकलषेट ्या लीफलषेट।

प्राथवमक वरवकतसा कषे  वलए कु् प्रवशक्ण की आवश्यकता होती ह,ै पिंतु अविकांश सथानों पि इसकी व्यवसथा किना आसान ह।ै प्राथवमक वरवकतसा कषे  

वलए वजममषेदाि व्यवक्त्यों कषे  नाम तथा सथान (टषेलीफोन नंबि समषेत) का ववविण एक नोवटस बोड्भ  पि लरा्या जाना रावहए। कम्भरारि्यों की सहरावरता, 

ववशषेष तौि पि आपाकालीन वसथवत्यों में, की कडी वसफारिश की जाती ह,ै तथा प्रत्यषेक व्यवक्त को वरवकतसी्य सहा्यता प्राप्त किनषे की प्रवक्र्या ज्ात होनी 

रावहए। ्ोटी सथापनाएं, वजनकषे  पास सव्ंय की सुवविाएं नहीं हैं, उनहें वकसी वनकट कषे  क्लीवनक ्या असपताल सषे संपक्भ  िखना रावहए, तावक कोई दुघ्भटना 

घवटत होनषे की वसथवत में वरवकतसी्य सहा्यता प्राप्त किनषे में अविक सम्य न लरषे, बषेहति होरा वक ्यह दूिी 30 वमनट सषे काफी कम सम्य की िहषे। 

क्लीवनक ्या असपताल तक जानषे कषे  परिवहन की री पहलषे सषे व्यवसथा होनी रावहए। आवश्यक होनषे पि एक बाह्य एमबुलेंस री बुलाई जा सकती ह।ै सट्षेरि 

उपलबि होना री वां्नी्य ह।ै

तित्र 8.1.3:  प्राथतमक तिककतसा बॉकस

रट्पपरणयां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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9. संचार/संिाद ्कौशि एिं 
वयािसारय्क ्कौशि

्यवूनट 9.1- संराि कौशल

्यवूनट 9.2- पषेशषेवि कौशल



255254

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

इस मॉड््यलू कषे  अंत में, आप वनमन में सक्म होंरषे:

1. वसक्रपट औि कैिषे क्टि वण्भन को पढें  औि समझें।

2. समान उननवत सुवनवश्चत किनषे कषे  वलए का्य्भ  ्योजना औि प्रोडक्शन का्य्भक्रम पढें।

3. सह्योवर्यों सषे सपष्ट संवाद किें  औि उनहें प्ररावी रूप सषे सह्योर जो वप्लषे ्या अरलषे दृश्यों/शॉट्स का का्य्भ  कि िहषे हैं।

4. वनदषेशक, एवनमषेशन प्य्भवषेक्क औि वनमा्भता द्ािा वकए जानषे वालषे आवश्यक संशोिनों को समझें।

5. प्रोडक्शन कषे  दौिान पषेश आई ंरुनौवत्यों पि ररा्भ  किें  औि रववष््य कषे  प्रोजषेक्ट्स में इस तिह की रुनौवत्यों का सामना किनषे कषे  तिीकों पि ररा्भ  किें ।

6. जहां आवश्यक हो वहाँ सामूवहक रूप सषे एवं सवतनत्र रूप सषे का्य्भ  किनषे में समथ्भ होनषे कषे  वलए वनण्भ्य लषेना।

7. शॉट रिषेक अप औि ्योजना कषे  प्र्यास औि शॉट कषे  प्रत्यषेक ततव कषे  वलए आवश्यक सम्य की समझ िखें।

8. व्यवक्तरत सम्य सीमाओ ंकी ्योजना कैसषे बनानी ह ैऔि उनहें प्राथवमकता कैसषे दषेनी ह ैऔि सम्य पि ववतिण कैसषे किना ह।ै

9. टीम कषे  सदस्य कषे  रूप में प्ररावी ढंर सषे का्य्भ  किना औि संपणू्भ  टाइमलाइनों को हावसल किनषे में मदद किना।

10. का्य्भ-उतपादों औि का्यकों को आवश्यकताओ ंकषे  आिाि पि प्राथवमकता कषे  क्रम में िखना।

रनष्कषटि 
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यूरनट 9.1: संचार ्कौशि

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. वसक्रपट औि कैिषे क्टि वण्भन को पढें  औि समझें।

2. सह्योवर्यों सषे सपष्ट संवाद किें  औि उनहें प्ररावी रूप सषे सह्योर जो वप्लषे ्या अरलषे दृश्यों/शॉट्स का का्य्भ  कि िहषे हैं।

3. प्रोडक्शन कषे  दौिान पषेश आई ंरुनौवत्यों पि ररा्भ  किें  औि रववष््य कषे  प्रोजषेक्ट्स में इस तिह की रुनौवत्यों का सामना किनषे कषे  तिीकों पि ररा्भ  किें ।

9.1.1 पररचय

9.1.2 संचार ्कौशि ्की मूि बा्तों ्को समझना

सिल तौि पि संराि जानकािी को एक सथान सषे दूसिषे  सथान तक सथानांतरित 

किनषे का ज़रि्या ह।ै

हालांवक ्यह एक सिल परिराषा ह,ै पिनतु जब हम एक ववष्य कषे  बािषे  में संवाद किनषे 

कषे  बािषे  में सोरतषे हैं तब ्यह एक बहुत जवटल हो जाती ह।ै संराि की कई वववरनन 

शषेवण्यां हैं औि ्यषे एक सम्य में एक ्या एक सषे अविक हो सकती हैं।

प्ररावी ढंर सषे संवाद किनषे की क्मता संबंिों, वशक्ा औि का्य्भ  में महतवपणू्भ  होता ह।ै 

आप में संराि कषे  अच ष्े  कौशल ववकवसत किनषे में सहा्यता कषे  वलए कु् कदम औि 

सुझाव इस प्रकाि हैं।

• जानें र्क िास्ति में संचार कया ह:ै संराि एक प्रषेषक औि प्राप्तकता्भ  कषे  मध्य वववरनन तिीकों (वलवखत शबद, अशावबदक संकषे त, शबदों को बोलनषे) 

कषे  माध्यम सषे संकषे तों/संदषेशों कषे  सथानातिण की प्रवक्र्या ह।ै इसकषे  आलावा ्यह हमािषे  द्ािा संबंिों को सथावपत औि संशोवित किनषे कषे  वलए उप्योर 

की जानषे वाली व्यवसथा री ह।ै

• अपने मन ्की बा्त ्कहने ्का साहस रखें: इस बात में ववश्वास वक आप वाता्भलाप में एक साथ्भक ्योरदान दषे सकतषे हैं। हि वदन अपनी िा्य औि 

रावनाओ ंकषे  बािषे  में जाननषे कषे  वलए सम्य वनकालें तावक आप उनहें अन्य लोरों को प्या्भप्त रूप सषे व्यक्त कि सकें । वषे व्यवक्त, जो इसवलए बोलनषे सषे 

घबिातषे हैं क््योंवक उनहें लरता ह ैवक उनकी बात साथ्भक सावबत नहीं होरी, उनहें डिना नहीं रावहए। ऐसा हो सकता ह ैवक कोई रीज़ एक व्यवक्त कषे  

वलए महतवपणू्भ  हो औि वकसी अन्य व्यवक्त कषे  वलए ऐसा न हो औि वकसी औि कषे  वलए बहुत महतवपणू्भ  हो।

तित्र 9.1.1:  संिार कौशि

यूरनट ्ेक उद्ेशय  
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• अभयास: उननत संराि कौशल का ववकास सिल बातरीत कषे  साथ शुरू होता ह।ै संराि कौशल सामावजक सषे लषेकि पषेशषेवि तक कषे  रूप में हि िोज़ 

अभ्यास वक्या जा सकता ह।ै नए कौशल परिष्कृत होनषे में सम्य लरता ह,ै लषेवकन हि बाि संप्रषेषण कौशल उप्योर कितषे सम्य आप खुद को नए 

अवसिों औि रावी साझषेदारि्यों कषे  प्रसतुत कितषे हैं।

9.1.3 अपने दशटि्कगणों से जुड़ना

• नेत्र संप्कटि  बनाना/आँखों में दखेना। राहषे आप बोल िहषे हों ्या सुन िहषे हों, वजस व्यवक्त सषे आप बातरीत 

कि िहषे हैं, उसकी आंखों में आंखें डालकि बात किना वाता्भलाप को अविक सफल बना सकता ह।ै  

आंखों का संपक्भ  रूवर दशा्भता ह ैऔि बदलषे में आपकषे  पाट्भनि को री आपमें रूवर लषेनषे कषे  वलए प्रोतसावहत 

किता ह।ै

 सजरतापवू्भक शोता की एक आंख में दषेखना औि वफि दूसिी में दषेखना इसमें सहा्यक तकनीक ह।ै दोनों 

कषे  बीर वनराह वफिाना, आपकी आंखों को प्रखि वदखाता ह।ै एक अन्य तिकीब ्यह ह ैवक शोता कषे  रषेहिषे  

पि एक “T” की कलपना किें , वजसमें पडी लाइन रौंहों पि औि खडी लाइन नाक की सीि में नीरषे की 

ओि आती हुई हो। अपनी आंखों सषे “T” जोन में सकैन कितषे िहें।

• हाि-भाि ्का उपयोग ्करें । आपकषे  हाथों औि रषेहिषे  सषे प्रकट वकए जानषे वालषे हाव-राव इसमें शावमल हैं। 

अपनषे पिूषे  शिीि को संवाद की मुरिा में लाएं। व्यवक्त्यों औि ्ोटषे समूहों सषे ्ोटषे हाव-रावों का उप्योर किें । 

समबोिन वाला समूह बडा होनषे पि हाव-राव री बडषे हो जानषे रावहए।

• रमररि्त संदशे म्त दें। आपकषे  शबदों, हाव-रावों, रषेहिषे  की अवरव्यवक्त्यों औि ल्य में तालमषेल होना रावहए। 

वकसी को अनुशावसत कितषे सम्य मुसकिाना, वमवशत संदषेश दषेता ह ैऔि इसवलए ्यह अप्ररावी िहता ह।ै 

्यवद आपको कोई नकािातमक संदषेश दषेना हो, तो अपनषे शबदों, रषेहिषे  की अवरव्यवक्त्यों औि ल्य का 

तालमषेल शबदों सषे बनाएं।

• अपने शरीर ्ेक िहजे ्को ि्ेकर सजग रहें। शािीरिक राषा, ढषेि सािषे  शबदों सषे कहीं ज्यादा प्ररावशाली संदषेश दषे सकती ह।ै आपकी रुजाएं आिाम सषे 

पाश्व्भ में िखतषे हुए खुली मुरिा, आस-पास कषे  लोरों को बताती ह ैवक आप सुलर हैं औि उनकी बात सुननषे कषे  वलए त्ैयाि हैं।

» दूसिी ओि बंिी बांहें औि झुकषे  कंिषे वाता्भलाप में अरूवर ्या संप्रषेषण की अवनच्ा प्रकट कितषे हैं। ऐसी शािीरिक राषा द्ािा प्रा्यः संवाद शुरू होनषे 

सषे पहलषे िोका जा सकता ह ैजो लोरों को बता दषेती ह ैवक आप बात नहीं किना राहतषे।

» उवरत राव-रंवरमा औि सुलर मुरिा, कवठन वाता्भलाप प्रवाह री अविक सुरारू बना सकती ह।ै

• रचनातम्क दृरष्ट्कोणों और रिश्ासों ्का प्र्कटी्करण। बातरीत में आपकषे  दृवष्टकोण का इस पि बडा असि पडता ह ैवक आप वकस तिह खुद को 

त्ैयाि औि वकस तिह दूसिों सषे बात कितषे हैं। दूसिों कषे  प्रवत ईमानदाि, ि्ैय्भवान, आशावादी, ववनम्र, सममानपणू्भ , औि उदाि बनें। दूसिों की रावनाओ ं

कषे  प्रवत संवषेदनशील िहें औि दूसिों की क्मताओ ंमें ववश्वास किें ।

• सुनने ्ेक प्रभािी ्कौशि रि्करस्त ्करना। न कषे वल आपको प्ररावी ढंर सषे बोलना आना रावहए, बवलक दूसिों की बात री अवश्य सुननी रावहए 

औि सामनषे वाला वजस बािषे  में कह िहा ह,ै उसकी बात ध्यान दषेकि समझनी रावहए। इस तिह सषे मत सुनें वक उनकी बात पिूी होतषे ही आप अपनषे उन 

ववरािों ्या समवृत्यों को प्रकट किनषे लरें जो दूसिों कषे  बोलतषे सम्य आपकषे  वदमार में उपजी थीं।

तित्र 9.1.2: आंखरों का संपकटि

तित्र 9.1.3: हाि-भाि का उपयोग करें
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9.1.4 अपने शबदों ्का उपयोग ्करना

9.1.5 संिाद प्ररक्रया

• अपने शबदों ्को वयति ्करें । सपष्ट बोलें औि बडबडाएं नहीं। ्यवद लोर सदवै आपसषे आपकी बात दोहिानषे को कहतषे हों, तो खुद को बषेहति तिीकषे  सषे 

पषेश किनषे का तिीका खोजना ज्यादा शषेष्ठ ह।ै

• अपने शबदों ्का सही उचचारण ्करें । लोर आपकी शबदावली सषे आपकी क्मता का आकलन किें रषे। ्यवद आपको ठीक पता न हो वक वकसी शबद 

को कैसषे कहना ह,ै तो उसका उप्योर मत किें । िोजाना नए शबद पढतषे हुए अपनी शबदावली को बषेहति बनाएं

• सही शबदों ्का इस्तमेाि ्करें । ्यवद आपको वकसी शबद का अथ्भ ठीक पता न हो तो उसका उप्योर मत किें । शबदकोश उठाएं औि िोजाना एक न्या 

शबद सीखनषे की आदत बनाएं। वदन में अपनी बातरीत में कु् बाि इसषे उप्योर किें ।

• अपनी बोिने ्की गर्त धीमी ्करें । अरि आप जलदी-जलदी बोलेंरषे तो लोर आपको नव्भस औि हडबडा्या हुआ मानेंरषे। हालांवक ध्यान िखें वक इतना 

िीमषे री न हों वक लोर आपकी मदद कषे  वलए अपनी तिफ सषे आपकी बात पिूी किनषे लरें।

• अपनी आिाज़ रि्करस्त ्करें । ऊंरी ्या रिरि्याहट रिी आवाज़, अविकािपणू्भ  नहीं मानी जाती ह।ै वासतव में, ऊंरी औि मुला्यम आवाज़ आपको वकसी 

आक्रामक सहकमशी का वशकाि वदखा सकती ह,ै ्या दूसिषे  आपको रंरीिता सषे नहीं लेंरषे। अपनी आवाज़ का लहजा नीरा िखनषे का अभ्यास किें । रानषे 

का प्र्यास किें , लषेवकन ऐसा कितषे हुए अपनषे सरी पसंदीदा रानषे िीमषे सुि में राएं। इसका अभ्यास किें , औि वफि एक सम्य बाद आपकी आवाज़ नीरी 

होनषे लरषेरी।

• अपनी आिाज़ जीिं्त बनाएं। नीिसता सषे बरें औि रवतशीलता अपनाएं। आपकषे  लहजषे में क्रम सषे उताि-रढाव आना रावहए। िषे वड्यो डीजषे, इसका एक 

बषेहतिीन उदाहिण ह।ै

• उरच्त िॉलयूम ्का उपयोग ्करें । ऐसषे वॉल्यमू का उप्योर किें  जो परिवसथवत कषे  अनुसाि उप्ुयक्त हो। जब आप अकषे लषे औि वनकट हों तो अविक 

नमा्भहट सषे बोलें। जब आप बडषे समूहों सषे ्या बडी जरहों पि बोल िहषे हों तो तषेज़ बोलें।

संवाद प्रवक्र्या कषे  अनषेक घटक हैं। आइए एक नज़ि डालें।

• प्रेष्कः प्रषेषक वह पक् होता ह ैजो संदषेश रषेजता ह।ै वलंडसषे, वनससंदषेह, प्रषेषक होरी। उसषे संदषेश की री आवश्यकता होरी, जो संप्रषेवषत की जानषे वाली 

सरूना होती ह।ै वलंडसषे को उसका संदषेश एनकोड री किना होरा, वजसकषे  अंतर्भत वह प्रषेवषत की जानषे वाली सरूना कषे  अपनषे ववरािों को ऐसषे रूप में 

रूपांतरित किषे री, वजसषे प्रषेवषत वक्या जा सकषे , जसैषे वक शबद।

• संिाद माधयमः संवाद माध्यम री रुनना होता ह,ै जो वक संदषेश प्रषेषण का तिीका होता ह।ै संवाद माध्यम में बोलना, वलखना, वीवड्यो प्रसािण, 

ऑवड्यो प्रसािण, ईमषेल, पाठ संदषेशों औि फैक्स कषे  माध्यम सषे इलषेक्ट्ॉवनक प्रसािण, औि ्यहां तक वक अमौवखक संवाद जसैषे वक शािीरिक राषा री 

शावमल हैं। वलंडसषे को अपनषे संवाद का लक््य री समझना होरा। ्यह पक् गाही कहलाता ह।ै

• रिाहीः गाही को संदषेश वडकोड किनषे (समझनषे) में अवश्य सक्म होना रावहए, अथा्भत वह अपनी मानवसक प्रवक्र्या द्ािा संदषेश को समझ लषेनषे कषे  

ला्यक हो। ्यवद आप वडकोड नहीं कि सकतषे, तो संदषेश ववफल िहता ह।ै उदाहिण कषे  वलए, वकसी ऐसी ववदषेशी राषा में संदषेश रषेजनषे पि वजसषे गाही 

ठीक सषे समझ न सकषे , वडकोवडंर ववफल हो जाती ह।ै

• प्रर्तरक्रयाः करी-करी गाही, प्रषेषक को प्रवतवक्र्या दषेता ह,ै अथा्भत गाही द्ािा प्रषेषक को एक संदषेश वापस रषेजा जाता ह।ै उदाहिण कषे  वलए, वलंडसषे की 

टीम का कोई सदस्य वलंडसषे कषे  संदषेश में प्राप्त वकसी सरूना को सपष्ट किनषे कषे  वलए प्रश्न कषे  रूप में प्रवतवक्र्या दषे सकता ह।ै

अब इन सरी घटकों को व्यववसथत किकषे  संवाद प्रवक्र्या का मॉडल त्ैयाि किें :

• प्रषेषक, सरूना एनकोड किता ह।ै

• प्रषेषक, संवाद माध्यम रुनता ह ैवजससषे संदषेश रषेजना होता ह।ै

• गाही, संदषेश प्राप्त किता ह।ै

• गाही, संदषेश वडकोड किता ह।ै
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• गाही, प्रषेषक को प्रवतवक्र्या दषे सकता ह।ै

9.1.6 7 संिाद प्ररक्रया ्ेक मुखय ्तति

संवाद प्रवक्र्या कषे  सात मुख्य ततव ्यषे हैं: (1) प्रषेषक (2) ववराि (3) एनकोवडंर (4) संवाद माध्यम (5) गाही (6) वडकोड किना, औि (7) प्रवतवक्र्या। संवाद को 

ऐसी प्रवक्र्या कषे  रूप में सपष्ट वक्या जा सकता ह ैजो वकसी संरठन में वववरनन पदिािक व्यवक्त्यों कषे  बीर पािसपरिक सामंजस्य प्राप्त किनषे कषे  वलए त्थ्यों 

्या ववरािों कषे  आदान-प्रदान सषे संबंवित होती ह।ै संवाद प्रवक्र्या कोई वसथि घटना नहीं बवलक रवतशील प्रकृवत की होती ह।ै इस तिह सषे संवाद प्रवक्र्या को 

एक सतत्  औि रवतशील आपसी व्यवहाि माना जाना रावहए, जो अनषेक परिवत्भनी्य कािकों को प्रराववत किती औि उनसषे प्रराववत होती ह।ै

1. प्रेष्कः अन्य कषे  समक् सरूना औि ववराि प्रसतुत किनषे कषे  इिादषे सषे संदषेश प्रषेवषत किनषे का इच्ुक व्यवक्त प्रषेषक ्या संप्रषेषक कहलाता ह।ै

2. रिचारः ्यह संवाद की ववष्यवसतु होता ह।ै ्यह िा्य, दृवष्टकोण, अनुरवूत, नज़रि्या, आदषेश, ्या सुझाव हो सकता ह।ै

3. एन्कोरिंगः रूंवक संवाद की ववष्यवसतु सदै्धांवतक औि अमूत्भ  होती ह,ै इसवलए इसषे आरषे पहंुरानषे कषे  वलए कु् वनवश्चत प्रतीकों जसैषे वक शबदों, का्यकों, 

्या वरत्रों आवद का उप्योर आवश्यक होता ह।ै ववष्यवसतु का इन प्रतीकों में रूपांतिण एनकोवडंर प्रवक्र्या कहलाता ह।ै

4. संिाद माधयमः संवाद में रूवर िखनषे वालषे व्यवक्त को अपषेवक्त सरूना, ववराि इत्यावद प्रषेवषत किनषे कषे  वलए माध्यम रुनना होता ह।ै ्यह सरूना, गाही 

तक वनवश्चत माध्यमों द्ािा प्रसारित किनी होती ह ैजो ्या तो औपरारिक ्या अनौपरारिक हो सकतषे हैं।

5. रिाहीः गाही वह व्यवक्त होता ह ैजो संदषेश प्राप्त किता ह ै्या वजसकषे  वलए संदषेश प्रषेवषत वक्या जाता ह।ै वांव्त उद् दषेश्य प्राप्त किनषे कषे  वलए गाही को 

सव्भशषेष्ठ संरव तिीकषे  सषे संदषेश समझनषे का प्र्यास किना होता ह।ै

6. रि्कोरिंगः संप्रषेषक सषे संदषेश, ्या संवाद कषे  प्रतीक प्राप्त किनषे वाला व्यवक्त उसषे इस प्रकाि सषे परिववत्भत किनषे का प्र्यास किता ह ैवक वह पिूी तिह 

समझनषे कषे  वलए उसका अथ्भ वनकाल सकषे ।

7. प्रर्तरक्रयाः प्रवतवक्र्या, ्यह सुवनवश्चत किनषे की प्रवक्र्या होती ह ैवक गाही नषे संदषेश प्राप्त कि वल्या ह ैऔि प्रषेषक की वां्ना कषे  अनुसाि उसका उप्ुयक्त 

अथ्भ समझ वल्या ह।ै

9.1.7 सुनने ्ेक ्कौशि

• सुनना, सबसषे महत्वपणू्भ  संवाद कौशल है

• हम कदावरत वकसी अन्य प्रकाि कषे  कौशल कषे  बजा्य अपनषे सुननषे कषे  कौशल उप्योर किनषे में अविक सम्य व्यतीत कितषे हैं

तित्र 9.1.4: संिाद प्रकक्या
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• अन्य कौशलों की तिह, सुननषे कषे  वलए री अभ्यास किना होता है

• सही ढंर सषे सुनना, एक सवक्र्य प्रवक्र्या है

• सुननषे कषे  वलए ध्यान दषेना होता ह।ै

प्रभािी ढंग से सुनना

प्ररावी ढंर सषे सुनना, धववन्यों का ववश्षे षण किनषे, उनहें पहरान्योग्य पटैनकों में व्यववसथत 

किनषे, पटैनकों की व्याख्या किनषे औि अथ्भ वनकालतषे हुए संदषेश को समझनषे की प्रवक्र्या ह।ै

हमािषे  दवैनक जीवन में लोरों कषे  साथ हमें अनुरव होनषे वाली अनषेक समस्याएं प्रमुख रूप सषे 

अप्ररावी ढंर सषे सुननषे, ्या सुननषे कषे  अराव कषे  कािण ही होती हैं।

सुनने ्ेक बारे में भांर्तयां

• सुनना, मषेिी समस्या नहीं ह!ै

• सुनना औि बस सुनाई पडना समान बातें हैं

• अच ष्े  पाठक अच ष्े  शोता होतषे हैं

• समाट्भ  लोर अच ष्े  शोता होतषे हैं

• सुनना, आ्ुय कषे  साथ बषेहति बनता है

• सुननषे कषे  कौशल सीखना कवठन ह ै

सुनने ्ेक उद् दशेय

• सीखना

• अपनी समझ बढाना

• सलाह ्या पिामश्भ दषेना

• वकसी की बोरि्यत दूि किना

• संरीत सुनना

सुनने ्का महत्ि

• प्ररावी ढंर सषे सुनषे वबना संवाद पिूा नहीं होता

• सजर शोता, वक्ता को बषेहति बोलनषे कषे  वलए प्रषेरित किता है

• अच्ा शोता, वकसी लापिवाह शोता की अपषेक्ा बषेहति सीखता है

• अच्ा शोता, असपष्ट बातों को समझकि सपष्ट अथ्भ वनकाल सकता है

• अच्ा शोता, पक्पात, पवू्भमान्यताओ ंऔि दृवष्टकोणों की पडताल किना सीखता ह।ै

तित्र 9.1.5: प्रभािी ढंग से सुनना

चरण 1 - सुनाई दनेा: सुना जाना, सुननषे की प्रवक्र्या का प्रथम अवनवा्य्भ  रिण ह ैऔि ्यह धववन कषे  संवषेदी बोि सषे संबंवित ह।ै इसकषे  बाद शोता, ज्ात हुई 

धववन को प्रक्रवमत किता ह।ै प्ररावी ढंर सषे सुननषे कषे  वलए सजरता सषे औि एकागता सषे सुना जाना रावहए।

चरण 2 - छानना: सुनी रई धववन्यों को महससू किना औि ्ानना, अरला रिण ह।ै सुनषे रए संदषेश को वांव्त ्या अवांव्त कषे  रूप में वरशीकृत वक्या 

जा सकता ह।ै अवांव्त संदषेश को िद् द कि वद्या जाता ह।ै ्यहां व्यवक्त की वनण्भ्य क्मता रवूमका वनराती ह,ै अथा्भत, ्ाननषे की प्रवक्र्या वषैव्यक होती ह ै

औि व्यवक्त ्यह रुनता ह ैवक उसषे अपनषे वलए क््या साथ्भक बरा कि िखना ह।ै

9.1.7.1 सरक्रय हो्कर सुनने ्की प्ररक्रया 
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प्ररावी ढंर सषे सुननषे की रूकावटें दो तिह की होती हैं:

1. रौवतक रूकावटें

2.  लोरों सषे संबंवित रूकावटें

» दवैहक रूकावटें

» मानवसक रूकावटें       

भौर्त्क रू्कािटें

• शोि

9.1.7.2 प्रभािी ढंग से सुनने ्की रू्कािटें

चरण 3 - समझना: शोता इसषे समझता ह ैवक वक्ता क््या कहनषे का प्र्यास कि िहा ह।ै ्यह रवतवववि अवशोषण, गहण, ्या समावषेवशत/सवांरीकृत किना 

कही जा सकती ह।ै शोता अपनषे ज्ान, अनुरव, दृवष्टबोि, औि बोिातमक शवक्त का उप्योर किता ह।ै

चरण 4 - याद रखना: सवांरीकृत संदषेश रववष््य में समिण कषे  वलए समवृत में संवरत वक्या जाता ह।ै

चरण 5 - प्रर्तरक्रया दनेा: संवाद कषे  बाद तुिंत ्या दषेि सषे, ्यह दशा्भनषे कषे  वलए संदषेश पि प्रवतवक्र्या दी जाती ह ै वक संदषेश प्राप्त कि औि समझ वल्या  

र्या ह।ै

तित्र 9.1.6: सुनने की प्रकक्या
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• दुब्भल धववन्यां

• दोषपणू्भ  ्यांवत्रक ्ुयवक्त्यां

• बाि-बाि रवतिोि

• बठैनषे की असुवविाजनक व्यवसथा

• असुवविाजनक वाताविण

• संदषेश अत्यविक होना

दरैह्क रू्कािटें

• सिास्थय ्की दशा: शोता औि वक्ता कषे  सवास्थ्य की दशाएं, सुननषे की साम्थ्य्भ को प्रराववत किती हैं। बुखाि, दद्भ , ्या वकसी अन्य तिह की शािीरिक 

पिषे शानी, व्यवक्त कषे  वलए आिाम सषे सुनना ्या बोलना कवठन बना दषेती ह।ै

• अक्म्ताः शवण बािाएं, खिाब ढंर सषे सुननषे का कािण बन सकती हैं। इसी प्रकाि, वक्ता कषे  वाणी ववकाि री शोता कषे  वलए वकृ्तता को असंरत बना 

सकतषे हैं। वक्ता का बोलनषे का अंदाज री शोता कषे  वलए समझना कवठन बना सकता ह।ै

• धयान इधर-उधर भट्कनाः मानव मवसतष्क लररर 500 शबद प्रवत वमनट की दि सषे प्रक्रवमत कि सकता ह,ै जबवक वक्ता लररर 150 शबद प्रवत 

वमनट की दि सषे ही बोल सकता ह।ै इन दोनों कषे  बीर काफी अंति होनषे की वजह सषे शोता का मन रटकनषे कषे  वलए प्या्भप्त सम्य वमल जाता ह।ै

मानरस्क रू्कािटें

• ितिा ्की क्म्ता ्को ि्ेकर अरनरश्च्त होना: ववरत अनुरवों ्या स्ोतों सषे प्राप्त इनपुटों कषे  आिाि पि, शोता कषे  मन में वक्ता की क्मता को लषेकि पहलषे 

सषे ही िािणा बनी हो सकती ह।ै वह सोर सकता ह ैवक वक्ता को अच्ा ज्ान नहीं ह,ै ्या रहनता औि साम्थ्य्भ का अराव ह।ै इसवलए शोता वह नहीं 

सुनता जो वक्ता कहना राहता ह।ै

• वयरतिग्त परेशारनयां: करी-करी शोता व्यवक्तरत वरंताओ ंव पिषे शावन्यों सषे वघिा होता ह।ै इससषे वक्ता द्ािा कही जा िही बात समझना कवठन हो 

जाता ह।ै

• दृरष्ट्कोणः ''्यह सब पता ह ैवालषे दृवष्टकोण'' कषे  रूप में शोता काफी अहंकें वरित हो सकता ह ैऔि वह नहीं सुन सकता क््योंवक उसषे लरता ह ैवक वक्ता 

जो कहना राहता ह ैवह उसषे पहलषे सषे जानता ह।ै

• अधीर्ताः शोता में दूसिषे  व्यवक्त की बात पिूी होनषे दषेनषे कषे  वलए प्या्भप्त ि्ैय्भ  नहीं हो सकता ह।ै वह असहनशील हो सकता ह ै्या अपनषे वबंदु ररा्भ  में लानषे 

कषे  वलए उतसुक हो सकता ह।ै परिणामसवरूप उसकी बोलनषे की इच्ा, उसकी सुननषे की इच्ा पि रािी पडती ह ैजो एक रूकावट का काम किती ह।ै

• भािनातम्क अिरोधः कु् वनवश्चत ववरािों में हमािषे  रहिाई सषे जमषे हुए ववश्वास, हमािषे  वलए ऐसषे ववराि सुनना कवठन बना दषेतषे हैं जो हमािषे  ववश्वास 

कषे  ववपिीत होतषे हैं। हम ऐसषे वकसी ववराि को रलत तिह सषे सुन सकतषे हैं ्या ्यह हमािषे  वदमार में हमािी िािणाओ ंकषे  अनुसाि ववरूवपत हो सकता ह ै

्या हम इसषे वबलकुल अनसुना किकषे  िोक सकतषे हैं। अनषेक बाि, प्रा्यः हम वकसी रीज़ सषे जुडी दद्भरिी ्यादों की वजह सषे उसषे पिूी तिह सषे खुद सषे दूि 

िोक दषेतषे हैं।

अचछे रिो्ता बनने ्ेक रिए सुझाि

• बोिने िाि ेवयरति ्की ओर अपना पूरा धयान िगाएं। वखडकी की तिह, ्या कमिषे  की अन्य रवतवववि्यों पि ध्यान न दें।

• सुरनरश्च्त ्करें  र्क आप्का मन ्कें ररि्त रहे। ्यवद आपको लरषे वक वह व्यवक्त अब जो कहषेरा, वह तो आपको पहलषे सषे ही पता ह,ै तो आपका ध्यान 

आसानी सषे रटक सकता ह,ै जबवक आप रलत हो सकतषे हैं। ्यवद आपको लरषे वक आपका ध्यान रटक िहा ह,ै तो अपनषे शिीि की मुरिा बदलें औि वक्ता 

कषे  शबदों पि कें वरित होनषे का प्र्यास किें ।

• अपनी बा्त ्कहना शुरू ्करने से पहि ेितिा ्को उस्की बा्त पूरी ्कर िनेे दें। वक्ता जो री कहना राहतषे हैं, वबना हसतक्षेप कषे  वह पिूी बात कहनषे 

का अवसि वमलना पसंद कितषे हैं। हसतक्षेप किनषे पि ऐसा प्रकट होता ह ैवक आप सुन नहीं िहषे हैं, राहषे वासतव में आप सुन िहषे हों। 

• बोिना शुरू ्करने से पहि ेसुनने ्का ्कायटि पूरा ्करें ! अरली बाि आपको जो कहना ह,ै वही सोरनषे में ्यवद आप व्यसत िहेंरषे तो आप वासतव में 

सुन नहीं सकतषे हैं। 
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िहजाः आप द्ािा उप्योर वक्या जानषे वाला वॉल्यमू, संप्रषेवषत की जानषे वाली रावनाओ ंका सति औि प्रकाि, तथा आप द्ािा रुवनंदा शबदों पि वद्या र्या 

जोि आवद बातें लहजषे में शावमल हैं। ्यवद आप उतसाह कषे  वबना औि एकिसता रिषे  लहजषे में बोलतषे हैं, तो वनवश्चत रूप सषे िोरी बोि हो जाएंरषे।

जागरू्क्ता: मौवखक संवाद कषे  वलए, एक ववष्य अवश्य रावहए होता ह,ै प्रवतवक्र्या किनषे कषे  वलए, बात कहनषे कषे  वलए, औि इसषे शुरू किनषे कषे  वलए।

वया्करणः इसकी आवश्यकता इसवलए होती ह,ै तावक आप वाता्भलाप में सही वाक््य व्यववसथत कि सकें । मौवखक औि वलवखत रूप में वकसी राषा में 

ववशषेषज्ता प्राप्त किनषे का सही तिीका सीखनषे कषे  वलए री व्याकिण उप्योरी ह।ै

शबदाििीः प्या्भप्त शबदावली न होनषे पि आप प्ररावी ढंर सषे संवाद, ्या अपनषे ववरािों को मौवखक व वलवखत रूप में व्यक्त नहीं कि सकतषे। शबदावली कषे  

वबना कु् री संप्रषेवषत नहीं वक्या जा सकता।

उचचारणः उचरािण, आपकषे  बोलतषे सम्य सपष्ट राषा बोलनषे का तिीका ह।ै ्यह सविववज्ान सषे जुडी उस प्रवक्र्या सषे संबंवित ह ैवजसकषे  अनुसाि, व्याकिण 

कषे  घटक ऐसषे ततवों औि वसद्धांतों कषे  आिाि पि बनषे होतषे हैं जो इसका वनिा्भिण कितषे हैं वक वकसी राषा में धववन्यां वकस तिह परिववत्भत होती औि पटैन्भ 

बनाती हैं। लोरों कषे  बोलतषे सम्य, वकसी ववशषेष राषा में शबदों को वकस तिह सपष्ट रूप सषे उतपनन वक्या जाना ह,ै इसका अध्य्यन ही उचरािण ज्ान ह।ै 

• समझबोि

• व्याकिण

• शबदावली

• उचरािण

• िािा प्रवाह होना

• शािीरिक राषा

• वकृ्तता दि

• मुखय रिचारों ्को सुनना। मुख्य ववराि सबसषे महत्वपणू्भ  वबंदु होतषे हैं जो वक्ता बताना राहता ह।ै वषे बातरीत कषे  आिंर में ्या अंत में कहषे जा सकतषे हैं, 

औि कई बाि दोहिाए जा सकतषे हैं। इस तिह कषे  शबदों सषे शुरू होनषे वालषे कथनों पि ववशषेष ध्यान दें जसैषे वक, ''मैं इस पि जोि दषेता हंू वक...'' ्या ''ध्यान 

िखनषे वाली बात ्यह ह ैवक...''

• प्रश्न पूछें। ्यवद आप वक्ता की कही बात उवरत प्रकाि सषे न समझ पाएं, तो प्रश्न पू् ें । उदाहिण कषे  वलए, आप कह सकतषे हैं, ''जब आपनषे कहा वक दो 

एक जसैषे जषेरिा, तो क््या आपका मतलब ्यह था वक दोनों पि िारि्यां अलर-अलर तिह की हैं?' 

• प्रर्तरक्रया दें। सीिषे बठैें  औि वक्ता की आंखों में दषेखें। आप समझ िहषे हैं, ्यह प्रकट किनषे कषे  वलए ्यदा-कदा वसि वहलाएं। वकसी उवरत वबंदु पि आप 

मुसकिा, त्योिी रढा, हंस ्या रुप िह सकतषे हैं। ्यषे सब वक्ता को ्यह जतानषे कषे  तिीकषे  हैं वक आप सरमुर सुन िहषे हैं। ्याद िखें, आप अपनषे कानों सषे ही 

नहीं, अपनषे रषेहिषे  सषे री सुनतषे हैं। 

9.1.8 बोिने ्ेक ्कौशि
बोलना वह कौशल ह ैवजसकी पषेशषेवि माहौल में सबसषे ज्यादा बाि ज़रूित होती ह।ै प्ररावी ढंर सषे बोलना, कहषे रए शबदों कषे  माध्यम सषे अपनषे संदषेश को 

दश्भकरणों कषे  सममुख प्ररावी ढंर सषे व्यक्त किनषे की दक्ता ह।ै बोलना, िरनातमक अथ्भ में एक अंतवक्र्भ ्यातमक प्रवक्र्या ह,ै वजसमें सरूनाओ ंको मौवखक 

उतपावदत, प्राप्त औि प्रक्रवमत किना शावमल ह।ै

आप्की नौ्करी में बोिने ्का महत्ि

एक एवनमषेटि कषे  रूप में, बोलनषे में प्ररावशाली बनना बहुत महत्वपणू्भ  ह।ै तो, आप िोवर्यों सषे कैसषे बोलतषे हैं, ्यह िोरी कषे  मन में एक ्वव अंवकत किता ह।ै 

आपको िोरी सषे ववनम्रता सषे बोलना होरा तावक उनको ठषेस न लरषे। लषेवकन ्यवद आप िोवर्यों को ठषेस पहंुराए वबना उनहें कु् वनददेश दषेना राहतषे हों, तो 

आपको जोि दषेकि बोलना होरा। अभ्यास, प्ररावी ढंर सषे बोलनषे कषे  वलए ज़रूिी ह।ै

बोिने ्ेक ्कौशि ्ेक घट्क

बोलनषे कषे  कौशल कषे  महत्वपणू्भ  घटक ्यषे हैं:

• लहजा

तित्र 9.1.7: बोिने का कौशि
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बोलतषे सम्य, संवाद की प्रवक्र्या समझनषे में आसान बनानषे कषे  वलए उचरािण एक बहुत महत्वपणू्भ  रवूमका वनराता ह।ै

धाराप्रिाह होनाः िािाप्रवाह होनषे को िािाप्रवाह औि शुद्धतापवू्भक बोलनषे की साम्थ्य्भ कषे  रूप में सपष्ट वक्या जा सकता ह।ै संकोर, पुनिाववृत्त, औि सव्ंय-

सुिाि कषे  वबना सामान्य रवत सषे बोलना ही िािाप्रवाह होनषे का अथ्भ ह।ै िािाप्रवाह होनषे कषे  वलए ्यह महतवपणू्भ  ह ैवक आप "वो क््या कहतषे हैं", "मषेिा मतलब", 

"उम", "अि", "आह" जसैषे वफलस्भ का उप्योर न किें ।

शरीर ्की भाषा: शिीि की राषा का अथ्भ ह ैशिीि की मुरिा, हाव-राव, रषेहिषे  की राव-रंवरमा औि आवाज़ कषे  लहजषे कषे  जरिए संवाद किना। शिीि की राषा 

आपकषे  शबदों कषे  अनुरूप होनी रावहए; नहीं तो संरव ह ैवक वह गाहकों को भ्रवमत कि दषेरी। अपनषे शबदों का समथ्भन किनषे औि आपका संदषेश सही प्रकाि 

सषे समझा जाए ्यह सुवनवश्चत किनषे कषे  वलए शिीि की राषा का सकािातमक होना महतवपणू्भ  ह।ै

बोिने ्की गर्त: बोलनषे की रवत िीमी होनषे सषे वाता्भलाप अरुवरकि बन जाता ह।ै मध्यम रवत औि उप्ुयक्त आवाज़ कषे  साथ बोलें। एवनमषेटि को अपनी 

आवाज़ की रवत, िोरी की रवत कषे  साथ वमलानी रावहए। एक एवनमषेटि कषे  रूप में, प्ररावी संवाद (सुननषे औि बोलनषे का कौशल) का प्रदश्भन किनषे कषे  वलए, 

आपको रावहए वक आप:

• ि्ैय्भ  कषे  साथ सुनें औि िोरी कषे  जो री प्रश्न हों उनका उत्ति दें।

• अवलोकनों को नस्भ को बताएं। जब आपको िोरी की वसथवत में कोई असामान्यता ्या कोई अजीब बात वदखाई दषे, तो सीिषे संबंवित व्यवक्त को  

सरूना दें। 

• िोरी कषे  साथ का्य्भवववि्यों की ररा्भ  किें  औि उसषे दवैनक रवतवववि्यों, जसैषे साज-संवाि, नहाना, वनष्कासन, परिवहन आवद कितषे सम्य सहज 

अनुरव किाएं।

9.1.9 पढ़ने ्का ्कौशि

• पढना, रंडारित जानकािी ्या ववरािों का अथ्भ पुनः प्राप्त किनषे की एक प्रवक्र्या ह।ै

• वलवखत ्या ्पी हुई सामगी को शांवत कषे  साथ ्या तषेज़ी सषे बोलकि पढनषे की वक्र्या ्या कौशल: "अवतरिक्त पठन हषेतु सुझाव"; "पढनषे का कौशल"।

• वलवखत ्या ्पी हुई सामगी वजसषे पढा जा सकता ह:ै "वह मुख्य तौि पि जाससूी कहावन्यां पढता था"।

पढनषे का कौशल पाठकों को वलवखत सामगी को अथ्भ में बदलनषे औि पठन सवतनत्रता, बोि एवं िािाप्रवावहता कषे  लक््य प्राप्त किनषे में समथ्भ बनाता ह।ै ्यवद 

पढनषे कषे  कौशल का अराव प्रतीत हो, तो पढनषे कषे  कौशल का आकलन किनषे की अनुशंसा की जाती है

पढ़ने ्का उद्ेशय और महति

• ज्ान अवज्भत किना 

• पढनषे सषे मानवसक ववकास में मदद वमलती है

• वाता्भलाप कौशल का सुिाि होता है

• पाठकों को न्यषे शबदों का अथ्भ समझनषे में मदद वमलती है

• शबदावली, राषा कौशल ववकवसत किना

• ्यवद पाठक को वकसी ववष्य कषे  बािषे  में कु् नहीं पता ह,ै तो उसकषे  वलए जानकािी को पकडना मुवशकल होरा।

पठन ्को समझने ्का मागटि

1. शबद पुकािना - शबद संिरनाओ ंको पहराननषे की ्योग्यता।

2. शबदों को समझें - शबदों कषे  संदर्भ  कषे  अंदि उनका अथ्भ समझनषे की ्योग्यता।

एक कषे  वबना दूसिषे  का कोई वजदू नहीं होता ह।ै 
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9.1.10 िखेन ्कौशि
िखेन कया ह?ै 

लषेखन संवाद का एक माध्यम ह ैजो संकषे तों एवं प्रतीकों को वलवपबद्ध किनषे कषे  माध्यम सषे राषा को वनरूवपत किता ह।ै लषेखन कौशल संवाद का एक 

महतवपणू्भ  रार ह।ै लषेखन कौशल अच्ा होनषे सषे आप अपना संदषेश आमनषे-सामनषे कषे  ्या टषेलीफोन वाता्भलाप की तुलना में कहीं अविक बडी संख्या में लोरों 

तक सपष्टता एवं आसानी सषे पहंुरा सकतषे हैं।

िेटा एंट्ी ऑपरेटर ्ेक रिए िखेन ्कौशि ्का महति 

एक एवनमषेटि कषे  तौि पि आप अपनषे लषेखन कौशल का उप्योर मषेल व रिपोट्भ  वलखनषे औि का्य्भसथल पि प्ररावी ढंर सषे संवाद किनषे कषे  वलए किें रषे। ्यह 

मॉड््यलू सामान्य लषेखन कषे  साथ आिमर होरा औि वफि हम रिपोट्भ  लषेखन का अभ्यास किें रषे। प्ररावी रिपोट्भ  लषेखन कई नौकरि्यों की पहली शत्भ होती ह।ै 

एक एवनमषेटि कषे  तौि पि प्ररावी लषेखन कौशल होना बहुत महतवपणू्भ  ह ैक््योंवक आपको अकसि ही संरठन कषे  अंदि अन्य लोरों कषे  साथ मषेल ्या वलवखत 

रिपोटकों कषे  जरिए संवाद किना होरा। अच्ा लषेखन कौशल आपकी मदद किता ह ैक््योंवक: 

1. अच्ी शबदावली औि वत्भनी एवं व्याकिण का उतकृष्ट ज्ान तु्रवट मुक्त डषेटा बनाए िखनषे में मदद कितषे हैं। 

2. इससषे वलवखत मषेल, रिपोट्भ  आवद की सहा्यता सषे मनैषेजमेंट कषे  साथ आंतरिक संवाद में मदद वमलती ह।ै 

जब री आप कु् वलख िहषे हों, तो ्यह महतवपणू्भ  ह ैवक आप ्योजना बनाएं, व्यववसथत किें  औि वलखें:

• समसत उप्योरी जानकािी एकत्र किें  

• त्य किें  वक क््या रीज़ें महतवपणू्भ  हैं 

• रुनें वक वकन रीज़ों को ्ोड दषेना ह ै

• जानकािी को तक्भ संरत ढंर सषे समूहबद्ध किें  

संरक्प्त िखेन शिैी ्ेक रिए 

• अनावश्यक शबद हटा दें 

पठन ्ेक प्र्कार 

1. उद्षेश्य कषे  अनुसाि पठन

» पाठ््य में कोई वववशष्ट जानकािी तलाशना

» इसमें आप “पढनषे सषे ज्यादा ्ोडतषे हैं।”

» इसषे खोज कि पढना (सर्भ िीवडंर) री कहतषे हैं

» कोई वववशष्ट जानकािी तलाशना

» कोई वववशष्ट जानकािी तलाशना

2. सिसिी तौि पि पढना

» संपणू्भ  पाठ््य की सामान्य समझ

» उद्षेश्य पि आिारित पठन का सबसषे तषेज़ प्रकाि

» रुित-सवदेक्ण पठन (िैवपड-सवदे िीवडंर) री कहतषे हैं

तित्र 9.1.8: पठन के प्रकार
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• पुनः वलखें
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यूरनट 9.2: वयािसारय्क ्कौशि

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. जहां आवश्यक हो वहाँ सामूवहक रूप सषे एवं सवतनत्र रूप सषे का्य्भ  किनषे में समथ्भ होनषे कषे  वलए वनण्भ्य लषेना।

2. शॉट रिषेक अप औि ्योजना कषे  प्र्यास औि शॉट कषे  प्रत्यषेक ततव कषे  वलए आवश्यक सम्य की समझ िखें।

3. व्यवक्तरत सम्य सीमाओ ंकी ्योजना कैसषे बनानी ह ैऔि उनहें प्राथवमकता कैसषे दषेनी ह ैऔि सम्य पि ववतिण कैसषे किना ह।ै

4. टीम कषे  सदस्य कषे  रूप में प्ररावी ढंर सषे का्य्भ  किना औि संपणू्भ  टाइमलाइनों को हावसल किनषे में मदद किना।

5. का्य्भ-उतपादों औि का्यकों को आवश्यकताओ ंकषे  आिाि पि प्राथवमकता कषे  क्रम में िखना।

9.2.2 रनणटिय िनेा

अपनषे का्य्भ  को अक्त िखनषे औि प्ररावी ढंर सषे का्य्भ  किनषे कषे  वलए, आपको नीरषे बताए 

रए वबनदुओ ंका प्रबंिन किना होरा। रवलए उनहें एक-एक किकषे  समझतषे हैं।

लोर अकसि कहतषे हैं वक उनहें वनण्भ्य लषेनषे में कवठनाई होती ह।ै

दुरा्भग्य सषे हम सरी को हमषेशा ही वनण्भ्य लषेनषे होतषे हैं, ्यषे वनण्भ्य मामूली री हो सकतषे हैं, जसैषे 

लंर में क््या खाना ह,ै औि ऐसषे री जो जीवन बदल सकतषे हों, जसैषे कहां औि वकस रीज़ की 

पढाई किना ह,ै औि वकससषे शादी किनी ह।ै

कु् लोर अविक सषे अविक जानकािी खोजतषे िहतषे हैं ्या अविक सषे अविक लोरों सषे 

उनकी िा्य लषेतषे िहतषे हैं औि ऐसा किकषे  वषे वनण्भ्य टालतषे जातषे हैं।

कु् अन्य लोर वोट किवा कि, सरूी में वपन लरा कि ्या वसक्का उ्ाल कि वनण्भ्य लषेतषे हैं।

रनणटिय िनेा कया ह?ै

अपनषे सबसषे सिल अथ्भ में, वनण्भ्य लषेना दो ्या अविक वक्र्या मारकों में सषे एक को रुननषे का का्य्भ  ह।ै

समस्या हल किनषे की अविक व्यापक प्रवक्र्या में, वनण्भ्य लषेनषे में समस्या कषे  संराववत समािानों में सषे र्यन किना शावमल होता ह।ै वनण्भ्य सहज-ज्ान 

प्रवक्र्या ्या तका्भिािी प्रवक्र्या, ्या इन दोनों कषे  सं्योजन कषे  द्ािा वलए जा सकतषे हैं।

सहज-ज्ान

सहज-ज्ान का अथ्भ ह ैसंराववत वक्र्या मारकों कषे  बािषे  में अपनी ‘अनदि की आवाज़’ को सुनना। हालांवक लोर इसषे जादुई ‘अनुरवूत’ जसैषे कु् बतातषे हैं, पि 

सहज-ज्ान असल में वप्लषे अनुरवों औि आपकी व्यवक्तरत मान्यताओ ंका एक सं्योजन होता ह।ै अपनषे सहज-ज्ान को ववराि में लषेना उवरत ह,ै क््योंवक 

्यह जीवन कषे  बािषे  में आपकी सीख को दशा्भता ह।ै हालांवक ्यह हमषेशा ही वासतववकता पि आिारित नहीं होता ह,ै ्यह आपकी िािणाओ ंपि री आिारित 

होता ह,ै वजनमें सषे कई िािणाओ ंकी शुरूआत बरपन में हुई होती ह ैऔि इसवलए ज़रूिी नहीं वक वषे िािणाएं परिपक्व हों।

इसवलए ्यह ठीक िहषेरा वक आप अपनी अनदि की आवाज़ को ठीक सषे जाँर लें, ववशषेषकि तब जब वकसी खास वक्र्या मार्भ  कषे  ववरुद्ध आपको कोई 

शवक्तशाली अनुरवूत हो िही हो, तावक आप ्यह दषेख सकें  वक आप इस बात का पता लरा सकतषे हैं ्या नहीं वक वह अनुरवूत क््यों हो िही ह ैऔि क््या वह 

उवरत ह।ै

तित्र 9.2.1: तनणटिय िेना

यूरनट ्ेक उद्ेशय  
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्त्कटि -रि्त्कटि

तक्भ -ववतक्भ  का अथ्भ ह ैवनण्भ्य किनषे कषे  वलए अपनषे सामनषे मौजदू त्थ्यों औि आंकडों का उप्योर किना। तक्भ -ववतक्भ  की जडें ्यहां-औि-अरी में तथा त्थ्यों 

में हैं। हालांवक, ्यह वनण्भ्य कषे  रावानातमक पहलुओ ंको नजिअंदाज कि सकता ह,ै औि ववशषेष रूप सषे, अतीत कषे  ऐसषे मुद्ों को नज़िअंदाज कि सकता ह ै

जो वनण्भ्य को अमल में लानषे कषे  तिीकषे  को प्रराववत कि सकतषे हैं।

सहज-ज्ान वनण्भ्य लषेनषे का एक पणू्भतः सवीकृत सािन ह,ै हालांवक आमतौि पि ्यह तब अविक उवरत होता ह ैजब वनण्भ्य सािािण प्रकृवत का हो ्या फौिन 

वल्या जाना हो।

अविक जवटल वनण्भ्यों कषे  वलए एक अविक औपरारिक, संिवरत पद्धवत की आवश्यकता होती ह,ै वजसमें आमतौि पि सहज-ज्ान औि तक्भ -ववतक्भ , दोनों 

शावमल होतषे हैं। ्यह महतवपणू्भ  ह ैवक वकसी परिवसथवत की आवषेरी प्रवतवक्र्याओ ंकषे  प्रवत साविान िहा जाए।

प्रभािी ढंग से रनणटिय िनेा

राहषे व्यवक्तरत सति पि हो ्या संरठन कषे  सति पि, वनण्भ्यों का अमल में लानषे ्योग्य होना ज़रूिी होता ह।ै इसवलए ्यह ज़रूिी ह ैवक आप वनण्भ्य कषे  प्रवत 

व्यवक्तरत रूप सषे प्रवतबद्ध हों औि अन्य लोरों को उसकषे  लारों का ववश्वास वदला सकतषे हों।

इसवलए प्ररावी ढंर सषे वनण्भ्य लषेनषे की प्रवक्र्या को ्यह सुवनवश्चत किनषे की आवश्यकता होती ह ैवक आप वसैा किनषे में समथ्भ हों।

प्रभािी ढंग से रनणटिय िनेा र्कन चीज़ों से रु्क स्क्ता ह?ै

ऐसी कई समस्याएं हैं जो प्ररावी ढंर सषे वनण्भ्य लषेनषे को िोक सकती हैं। इनमें शावमल हैं:

1. पयाटिप्त जान्कारी न होना: ्यवद आपकषे  पास प्या्भप्त जानकािी नहीं ह ैतो आपको ऐसा लर सकता ह ैवक आप वबना वकसी आिाि कषे  वनण्भ्य लषे िहषे हैं। 

थोडा सम्य वनकाल कि आवश्यक डषेटा इकट्ा किें , रलषे ही सम्य-सीमाएं कडी क््यों न हों। ्यवद आवश्यक हो तो, ्यह पहरानें वक कौन-सी जानकािी 

आपकषे  वलए सबसषे महतवपणू्भ  होरी औि उसी कषे  अनुसाि जानकािी इकट्ा किनषे की अपनी प्रवक्र्या को प्राथवमकता कषे  क्रम में िखें।

2. अतयरध्क जान्कारी होना: ठीक उलटी समस्या, पि ्यह अकसि मौजदू होती ह:ै इतनी सािी वविोिारासी जानकािी होना वक ‘महतवपणू्भ  रीज़ों को 

दषेख पाना’ असंरव हो जाता ह।ै

 करी-करी इसषे एनावलवसस पिैावलवसस कहतषे हैं, औि इसका उप्योर संरठन कषे  ऐसषे वनण्भ्यों में ववलंब किनषे की ्ुयवक्त कषे  रूप में री वक्या जाता ह ै

वजनमें वनण्भ्य लषेनषे सषे पहलषे अविकाविक जानकािी की ज़रूित होती ह।ै

 प्रा्यः इस समस्या का हल, कौन-सी जानकािी वासतव में महतवपणू्भ  ह ैऔि क््यों, ्यह त्य किनषे कषे  वलए सरी को साथ लाकि, औि वनण्भ्य लषेनषे कषे  

वलए एक सपष्ट सम्य-सीमा, वजसमें जानकािी इकट्ा किनषे का रिण री शावमल होता ह,ै त्य किकषे  वक्या जा सकता ह।ै

3. अतयरध्क िोग होना: सवमवत द्ािा वनण्भ्य लषेना कवठन होता ह।ै हि वकसी का अपना दृवष्टकोण, अपनी मान्यताएं होती हैं। औि हालांवक ्यह जानना 

महतवपणू्भ  ह ैवक वषे दृवष्टकोण क््या हैं, औि वषे क््यों व कैसषे महतवपणू्भ  हैं, पि कोई वनण्भ्य लषेनषे कषे  वलए वकसी एक व्यवक्त द्ािा उत्तिदाव्यतव वल्या जाना 

आवश्यक हो सकता ह।ै करी-करी, कोई वनण्भ्य किना, कु् री वनण्भ्य नहीं किनषे सषे बषेहति होता ह।ै

4. रनरह्त सिा्थटि: वनण्भ्य लषेनषे की प्रवक्र्याएं अकसि वनवहत सवाथकों कषे  अिीन पाई जाती हैं। ्यषे वनवहत सवाथ्भ  प्रा्यः खुललमखुलला प्रकट नहीं वकए जातषे, 

पि वषे एक महतवपणू्भ  बािा हो सकतषे हैं। रूंवक वषे खुललमखुलला प्रकट नहीं वकए जातषे हैं, इसवलए उनकी पहरान किना कवठन होता ह,ै औि इसी वजह 

सषे उनहें हल किना री कवठन होता ह,ै पि करी-करी वकसी ऐसषे व्यवक्त, जो प्रवक्र्या सषे बाहि हो पि लररर समान पद पि हो, कषे  साथ उनकी 

्ानबीन किनषे सषे हल तक पहंुर पाना संरव हो जाता ह।ै

 सरी वहतिािकों कषे  साथ, आमतौि पि प्रवक्र्या में सह्योर कषे  वलए एक बाहिी फैवसवलटषेटि कषे  साथ, तक्भ संरत/सहज-ज्ान संबंिी पहलुओ ं की 

्ानबीन किनषे सषे री मदद वमल सकती ह।ै

5. भािनातम्क जुड़ाि: लोर अकसि ्यथा वसथवत सषे बहुत अविक जुडषे होतषे हैं। वनण्भ्यों में बदलाव की संरावनाएं होती हैं, जो बहुत सषे लोरों को कवठन 

मालमू दषे सकती हैं।

6. ्कोई भािनातम्क जुड़ाि नहीं: करी-करी कोई वनण्भ्य लषेना इसवलए कवठन होता ह ैक््योंवक आपको वकसी री ववकलप सषे कोई फक्भ  ही नहीं पडता। 

इस मामलषे में, वनण्भ्य लषेनषे की संिवरत प्रवक्र्या सषे मदद वमल सकती ह,ै वजसमें उठाए जानषे वालषे कदमों कषे  कु् ऐसषे बषेहद वासतववक लारों एवं हावन्यों 

की पहरान की जाती ह ैवजनकषे  बािषे  में आपनषे शा्यद पहलषे नहीं सोरा था।
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 इनमें सषे कई मुद्ों को संिवरत वनण्भ्य प्रवक्र्या द्ािा हल वक्या जा सकता ह।ै इससषे वनमनांवकत में मदद वमलषेरी:

» अविक जवटल वनण्भ्यों को सिल रिणों में बाँटना;

» ्यह दषेखना वक वनण्भ्यों तक कैसषे पहँुरा जाता ह;ै औि

» सम्य-सीमाओ ंकी पवूत्भ  कषे  वलए वनण्भ्य लषेनषे की प्रवक्र्या की ्योजना बनाना।

वनण्भ्य लषेनषे की कई वववरनन तकनीकें  ववकवसत की जा रुकी हैं, वजनमें सािािण अनुरववसद्ध िीवत्यों सषे लषेकि बषेहद जवटल का्य्भवववि्यां तक शावमल हैं।  

कौन-सी वववि प्र्योर की जाएरी ्यह इस बात पि वनर्भि किता ह ैवक वनण्भ्य की प्रकृवत क््या ह ैऔि वह वकतना जवटल ह।ै

9.2.3 रिशे्षी एिं आिोचनातम्क रचं्तन

ववश्षे षी औि आलोरनातमक वरंतन एक प्रवक्र्या ह ैवजसका उप्योर जानकािी कषे  बािषे  में सोरनषे, उसका मूल्यांकन किनषे औि एक वनष्कष्भ तक पहँुरनषे 

कषे  वलए वक्या जाता ह।ै इसका अथ्भ ह ैवक आपको सवतः ही ्यह नहीं मान लषेना रावहए वक जानकािी विै/मान्य ह,ै सत्य ह,ै लार ूहोती ह ै्या सही ह।ै इसकषे  

बजाए, आपको प्रमाण एकत्र किनषे रावहए, सरी पहलुओ ंका तक्भ संरत एवं वनष्पक् ढंर सषे ववश्षे षण किना रावहए, औि वह री खुलषे मन सषे, तावक आप 

अपनषे सव्ंय कषे  वनष्कष्भ तक पहंुर सकें ।

डषेटा एंट्ी ऑपिषे टि कषे  वलए ववश्षे षी औि आलोरनातमक वरंतन का महतव 

एवनमषेटि कषे  तौि पि, आपको वससटम में वववरनन सॉफटवषे्यिों पि का्य्भ  किना होरा। इस का्य्भ  को प्ररावी ढंर सषे किनषे कषे  वलए, डषेटा को बस copy  

paste किनषे सषे काम नहीं रलषेरा, बवलक आपको जानकािी का ववश्षे षण औि मूल्यांकन री किना होरा। इसवलए इस कौशल सषे वनमनांवकत में मदद 

वमलती ह-ै 

• अपनी का्य्भ  आवश्यकताओ ं को पिूा किनषे औि संबंवित जानकािी प्रदान किनषे कषे  वलए ज़रूितों, आवश्यकताओ ं औि वनर्भिताओ ं कषे  अनुसाि 

जानकािी औि रवतवववि्यों का ववश्षे षण किना। 

• वववरनन वसथवत्यों कषे  समािान प्रदान किनषे कषे  वलए का्य्भ  पि एक ववसततृ एवं िरनातमक ढंर सषे अपना मत प्रदान किना।

9.2.4 योजना बनाएं एिं संगरठ्त ्करें

्योजना बनानषे औि संरवठत किनषे सषे ऑवफस में आपकषे  सम्य 

का प्ररावी ढंर सषे उप्योर हो पाता ह ैक््योंवक आप प्रोजषेक्ट कषे  

आिमर सषे उसकषे  पणू्भ  होनषे तक फोकस बनाए िखतषे हैं। का्य्भ 

रवतवववि्यों औि प्रोजषेक्ट कषे  वलए व्यापक ्योजना होनषे सषे ्यह 

सुवनवश्चत होता ह ै वक आप सफलता कषे  वलए सरी आवश्यक 

कदम उठाएंरषे। संरवठत किनषे कषे  सािनों सषे आपको रवतवववि 

कषे  वन्योजन की प्ररवत पि नज़ि िखनषे की सुवविा वमलती ह।ै 

संरवठत किनषे की ्योजना, रवतवववि्यों को पिूा किनषे में 

रवूमका वनरानषे वालषे अन्य टीम सदस्यों कषे  साथ पिसपि सह्योर 

औि जानकािी साझा किनषे को री सिल बनाती ह।ै अपनी 

संरवठत किनषे की वववि में थोडा-सा बदलाव किनषे सषे आप अपनषे 

ऑवफस कषे  वलए सबसषे प्ररावी वन्योजन तंत्र बना सकतषे हैं।

तित्र 9.2.2: योजना बनाएं एिं संगरठि करें
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9.2.4.1 योजना बनाने और संगरठ्त ्करने ्ेक चरण 
चरण 1: प्रत्यषेक का्य्भ  रवतवववि सषे संबंवित वन्योजन प्रवक्र्या का दा्यिा औि लक््य पहरानें। त्य किें  वक रवतवववि ्या प्रोजषेक्ट की सफलता कषे  वलए 

आपको क््या हावसल/पणू्भ  किनषे की आवश्यकता ह।ै ्यवद वह टीम प्रोजषेक्ट ह ैतो का्य्भ  में रवूमका वनरानषे वालषे कम्भरारि्यों की पहरान किें ।

चरण 2: रवतवववि कषे  प्रमुख/बडषे का्यकों को ऐसषे ्ोटषे-्ोटषे रिणों में तोडें वजनहें आपको का्य्भ  पणू्भ  किनषे हषेतु किना होरा, मूलतः आपको प्रोजषेक्ट कषे  वलए 

किनषे वालषे का्यकों की सरूी (टू-डू वलसट) बनानी ह।ै ्यवद का्यकों पि आपकषे  साथ अन्य कम्भरािी का्य्भ  कि िहषे हैं, तो हि व्यवक्त को एक रवूमका औि उसकषे  

वववशष्ट दाव्यतव सौंप दें, तावक का्य्भराि ववरावजत हो जाए।

चरण 3: का्य्भ  रवतवववि को पणू्भ  किनषे की सम्य सीमा त्य किें । रवतवववि कषे  प्रत्यषेक अलर-अलर का्य्भ  कषे  वलए एक पणू्भ  होनषे की तािीख त्य कि दें, ्यह 

सुवनवश्चत किनषे कषे  वलए वक सरी रीजें सम्यबद्ध ढंर सषे पिूी हो जाएं। सम्य-सीमा आनषे सषे पहलषे सरी संबद्ध का्यकों को पिूा किनषे कषे  वलए सव्ंय को प्या्भप्त 

सम्य दें।

चरण 4: प्रोजषेक्ट कषे  का्यकों की हि अंवतम वतवथ अपनषे कैलेंडि पि वलख लें, ्या अपनषे कमप्यटूि में रिमाइंडि सषेट कि लें जो सम्य सीमा पास आनषे कषे  साथ-

साथ आपकी सक्रीन पि प्रकट होतषे िहें।

चरण 5: पहरानें वक का्य्भ  रवतवववि्यों में आपका सामना वकन संराववत समस्याओ ं्या बािाओ ंसषे हो सकता ह।ै प्रोजषेक्ट पटिी पि बनाए िखनषे हषेतु उन 

मुद्ों सषे बरनषे की का्य्भ  ्योजना बनाएं।

चरण 6: प्रमुख/बडी का्य्भ  रवतवववि्यों, जो कंपनी की सफलता कषे  वलए बहुत महतवपणू्भ  हैं, कषे  वलए वकसी ऑनलाइन प्रोजषेक्ट मनैषेजमेंट प्रोगाम का उप्योर 

किें । ्यषे प्रोगाम जवटल प्रोजषेक्ट ्या कई टीम सदस्यों वाली रवतवववि्यों कषे  वलए ववशषेष रूप सषे प्ररावी होतषे हैं। प्ररवत पि नज़ि िखी जाती ह ैऔि सरी 

कम्भरारि्यों को प्रोगाम कषे  जरिए अपडषेट वमलती िहती हैं।

चरण 7: जब प्रोजषेक्ट पि का्य्भ  किनषे वालषे अन्य लोरों सषे सवक्र्य सहरावरता औि फीडबकै की आवश्यकता हो तो वन्योजन बठैकें  (मीवटंर) आ्योवजत 

किें । सम्य का उप्योर प्ररावी ढंर सषे किनषे कषे  वलए बठैकों को लक््य पि कषे वनरित औि उतपादक बनाए िखें।

चरण 8: प्रोजषेक्ट पि का्य्भ  कि िहषे अन्य सरी कम्भरारि्यों को वन्यवमत रूप सषे अपडषेट एवं सरूनाएं रषेजतषे िहें। इससषे सरी टीम सदस्यों को नवीनतम 

सरूना वमलती िहती ह ैऔि वषे अपनी का्य्भ  सवूर्यों (टू-डू वलसट) एवं सम्य-सीमाओ ंको आवश्यकतानुसाि अपडषेट कि पातषे हैं।

9.2.5 समय प्रबंधन

अविक प्ररावी का्य्भ  एवं उतपादकता हावसल किनषे कषे  वलए अपनषे सम्य को व्यववसथत किनषे, 

संरवठत किनषे, सम्य वनिा्भ रित किनषे औि बजट वनिा्भ रित किनषे की कला को सम्य प्रबंिन 

कहा जाता ह।ै

अतः सम्य प्रबंिन में प्ररावशीलता, कुशलता ्या उतपादकता बढानषे पि फोकस कषे  साथ, 

वववशष्ट रवतवववि्यों पि वबताए जानषे वालषे सम्य की मात्रा पि सजर ढंर सषे वन्ंयत्रण वक्या 

जाता ह।ै

इस प्रकाि, सम्य प्रबंिन सषे व्यवक्त को अविक संरवठत औि अविक उतपादक बननषे में मदद 

वमलती ह।ै 

• सम्य प्रबंिन, वववशष्ट रवतवववि्यों पि वबताए जानषे वालषे सम्य की मात्रा को सजर ढंर 

सषे वन्ंयवत्रत किनषे की प्रवक्र्या ह,ै जो ववशषेषकि कुशलता ्या उतपादकता बढानषे कषे  वलए की जाती ह।ै 

• वववशष्ट का्यकों, प्रोजषेक्ट एवं लक््यों को हावसल कितषे सम्य, सम्य का प्रबंिन किनषे कषे  वलए प्र्योर वकए जानषे वालषे वववरनन कौशलों, सािनों/टूलस 

एवं तकनीकों सषे सम्य प्रबंिन में सहा्यता वमल सकती ह।ै

समय प्रबंधन कयों?

• सम्य बरानषे कषे  वलए।

• तनाव घटानषे कषे  वलए।

तित्र 9.2.3: समय प्रबंधन
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• हमािा का्य्भ  आउटपुट बढानषे कषे  वलए।

• हमािषे  जॉब दाव्यतवों पि अविक वन्ंयत्रण पानषे कषे  वलए।

समय ्का प्रभािी ढंग से उपयोग ्ैकसे ्करें ?

• प्ररावी वन्योजन।

• लक््य एवं उद्षेश्य त्य किना।

• सम्य-सीमाएं त्य किना।

• दाव्यतव सौंपना।

• रवतवववि्यों कषे  महतव कषे  अनुसाि उनहें प्राथवमकता कषे  क्रम में िखना।

• सही रवतवववि पि सही मात्रा में सम्य व्यतीत किना।

समय प्रबंधन ्की प्ररक्रया

• अपनषे सम्य का मूल्य आँकें ।

• रवतवववि लॉर बनाना।

• लक््य त्य किना।

• वन्योजन।

• प्राथवमकता कषे  क्रम में िखना।

• सम्य-वनिा्भिण (शषेड््यवूलंर)।

अपने समय ्का मूलय आँ्कना: अपनी प्रवत वष्भ  लारत की रणना किकषे  वासतववक मूल्य समझें

प्रवत वष्भ  लारत = (वषेतन + कि + ऑवफस सथान + ऑवफस उपकिण + आपकषे  द्ािा अवज्भत लार)

गर्तरिरध िॉग बनाना: 

• जॉब ऑड्भिों पि वदन कषे  दौिान व्यतीत सम्य का एक ्यथाथ्भवादी आकलन किें ।

• महतवपणू्भ /नाजुक क्षेत्रों का पता लराएं।

• हमािषे  वदन का उचर लवबि वाला सम्य खोजना।

तित्र 9.2.4: समय का प्रभािी ढंग से प्रयोग करना

तित्र 9.2.5: समय प्रबंधन 

तित्र 9.2.6: अपने समय का मूल्य आुँकना

तित्र 9.2.7: गतितितध िॉग बनाना

िक्य ्तय ्करना: 

• जीवन लक््य त्य किनषे सषे अपनषे जीवन मार्भ  औि अपनषे कैरि्यि पथ का मानवरत्र बनानषे में 

मदद वमलती ह।ै

• अपनषे जीवन लक््य को ्ोटषे-्ोटषे लक््यों में तोडें।

• एक दवैनक का्य्भसरूी (टू-डू वलसट) बनाएं। तित्र 9.2.8: िक्य िय करना
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तित्र 9.2.9: तनयोजन

• अपनी सरूी को िोजाना संशोवित एवं अपडषेट किें  औि अपनषे प्रदश्भन का मूल्यांकन किें ।

रनयोजन:

• एक का्य्भ  ्योजना - अपनषे लक््य हावसल किनषे कषे  वलए की जानषे वाली रीज़ों की एक सरूी 

- त्ैयाि किें ।

प्रा्थरम्क्ता ्ेक क्रम में रखना:

• एक का्य्भसरूी (टू-डू वलसट) बनाएं।

• का्य्भ  को किनषे सषे पहलषे उसकषे  मूल्य पि ववराि किें  - क््या वह आपकषे  सम्य औि 

कंपनी संसािनों को व्य्य किनषे कषे  ्योग्य ह।ै

• अपनषे का्य्भ  को प्राथवमकता कषे  क्रम में िखें - सबसषे महतवपणू्भ  का्यकों को सबसषे पहलषे 

पिूा वक्या जाना रावहए वजसकषे  बाद अन्य का्य्भ  वकए जानषे रावहए। 

समय-रनधाटिरण (शेि्यूरिंग):

• आप वकतना का्य्भ  कि सकतषे हैं इसका एक ्यथाथ्भवादी आकलन त्ैयाि किें ।

• उपलबि सम्य का सवपोत्तम उप्योर किनषे की ्योजना बनाएं।

तित्र 9.2.10: प्राथतमकिा के क्म में रखना

• ‘अप्रत्यावशत का्यकों’ सषे वनपटनषे कषे  वलए थोडा आकवसमकता सम्य सुिवक्त िखें।

• सव्ंय कषे  द्ािा औि अन्य कषे  द्ािा प्रवतबद्धता सषे बर कि तनाव को न्यनूतम किें ।

समय प्रबंधन मरैट्कस

तित्र 9.2.11: समय प्रबंधन मवैरट्कस
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9.2.6 टीम ि्कटि
• टीमका्य्भ , समान मान्यता कषे  तहत वकसी एक वववशष्ट उद्षेश्य कषे  वलए एक टीम कषे  रूप में साथ वमलकि का्य्भ  कि िहषे लोरों की अविािणा ह।ै

• ्यवद आपको साथ वमलकि का्य्भ  किना ह ैतो कहीं अविक अंतवटै्यवक्तक (इंटिपस्भनल) कौशलों की आवश्यकता होरी।

• टीम, एक-दूसिषे  को पिूा किनषे वालषे कौशलों सषे ्ुयक्त लोरों का एक ्ोटा समूह होती ह,ै जो एक ऐसषे साझा उद्षेश्य की प्रावप्त कषे  वलए सवक्र्य रूप सषे साथ 

वमलकि का्य्भ  कितषे हैं वजसकषे  वलए वषे खुद को सामूवहक रूप सषे जवाबदषेह ठहिातषे हैं।

• टीमें, आिुवनक संरठनों में क्रांवतकािी बदलावों कषे  पी ष्े  कषे  प्रमुख बलों में सषे एक होती हैं।

टीम्कायटि ्की प्र्ृकर्त

• टीम सदस्य कषे  साथ वमलकि इस प्रकाि सषे सवक्र्य ढंर सषे का्य्भ  कितषे हैं वक उनकषे  सरी कौशलों का उप्योर एक साझा उद्षेश्य की प्रावप्त में हो  

जाता ह।ै

• टीमका्य्भ  वकसी री उचर प्रदश्भन किनषे वाली टीम का कषे नरिी्य आिाि ह।ै

रवलए टीमका्य्भ  कषे  सबसषे महतवपणू्भ  घटक - आपको इसकषे  बािषे  में कैसा महससू होता ह ै- पि ववराि किकषे  शुरूआत कितषे हैं! टीमका्य्भ  न कषे वल आपकषे  

कौशलों पि, बवलक आपकषे  िव्ैयषे पि री वनर्भि किता ह।ै

साझा दारयति

• इससषे टीम सदस्य टीम कषे  प्रदश्भन औि उसकषे  परिणाम कषे  वलए समान रूप सषे वजममषेदाि महससू कितषे हैं। 

• इससषे व्यवक्त्यों को टीम का्यकों को पिूा किनषे कषे  वलए प्राथवमक रवूमकाएं वमलती हैं औि टीम कषे  लक््यों व का्यकों को पणू्भ  किनषे कषे  वलए जो री कु् 

आवश्यक ह ैउसषे किनषे कषे  वलए वषे लरीलषे बनषे िह पातषे हैं। 

खुिा संिाद

• इससषे रिोसषे, खुलषेपन औि ईमानदाि संवाद का माहौल बनता ह ैतथा बना िहता ह।ै 

• टीम सदस्यों को आपस में खुल कि बातरीत किनषे दें। 

• फीडबकै/प्रवतपुवष्ट का आदान-प्रदान किनषे को बढावा दें। 

• टीम सदस्यों को अपनी रलतफहवम्यों तथा द्नद्ों को दूि किनषे का अवसि दें। 

रनमन ्को अपने धयान में रखें

• टीमवक्भ  कामकाज़ी माहौल को बषेहति बनाता ह।ै 

• टीमवक्भ  संवाद में वनिनतिता बनाए िखता ह।ै 

• टीमवक्भ  तनाव सषे िाहत दषेता ह।ै 

• टीमवक्भ  तु्रवट्यों को कम किता ह।ै 

• टीमवक्भ  पिसपि संवाद बनाए िखता ह।ै 

प्रभािी टीम सदसयों ्की रिशेष्तायें

• टीम सदस्य परिणाम हावसल किनषे में सहा्यक होतषे हैं। 

• टीम सदस्य दूसिों की कीमत/मषेहनत पि ‘‘बाज़ी मािनषे’’ ्या दूसिों की मषेहनत का शषे्य लषेनषे सषे बरतषे हैं। 

• टीम सदस्य दूसिों कषे  आइवड्या पि ववराि किनषे कषे  वलए री त्ैयाि िहतषे हैं। 

• टीम सदस्य जानकािी तथा ववरािों का आदान-प्रदान कितषे हैं। 

• टीम सदस्य दूसिों कषे  ्योरदान को री समथ्भन दषेतषे हैं। 
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9.2.7 रिाह्क-्कें रिस्थ्ता/्कें रिीय्ता
्यद्वप गाहक-कें रिी्यता नई नहीं ह,ै ्यह अन्य कई कषे  साथ-साथ, वडवजटल माकदे वटंर ट्ांसफॉमदेशन, कॉपपोिषे ट ‘कसटमि कलरि’, गाहक अनुरव (प्रबंिन), 

गाहक-अवरमुख व्यापाि दृवष्टकोण तथा गाहक लाइफ साइवकल (सषेवा इत्यावद सवहत) कषे  संदर्भ  में प्र्योर की जाती ह।ै

गाहक-कें रिसथता/कें रिी्यता ्यह एक ऐसा शबद ह,ै वजसषे हम सवद्यों सषे प्र्योर कितषे आ िहषे हैं - औि शा्यद ऐसषे ही कई शबद औि री – वबना इनकषे  बािषे  में 

ज्यादा कु् सोरषे-समझषे, बवलक कािोबाि में प्रत्यक् रूप सषे इसका इसतषेमाल कितषे हैं। पहला सवालः गाहकों पि कें वरित होनषे का क््या अथ्भ ह?ै

्यह वनर्भि किता ह।ै हममें सषे अविकांश लोर इसषे गाहक को कें रि में िखनषे कषे  अथ्भ में प्र्योर कितषे हैं। सम्य सषे पथृक, उसषे समझतषे हुए, गाहकों पि महज 

कें वरित होनषे कषे  बजा्य, गाहक मूल्य सवृजत किनषे औि वासतव में गाहकों को सवपोपरि प्राथवमकता दषेनषे सषे ्यह सवा्भ विक औि सबसषे सथा्यी व्यावसाव्यक 

मूल्य सवृजत किता ह।ै इस अथ्भ में ्यह सामान्य राषा ह।ै गाहकों पि कें वरित। जसैषे वक नजृावतकें वरित, अहंकें वरित, रकूें वरित, ्या सौिकें वरित।

रिाह्कों पर ्कें ररि्त ्ंकपनी ्ेक गुण

अनषेक कंपवन्यां खुद को गाहकों पि कें वरित बताना पसंद किती हैं, औि इसकषे  उप्ुयक्त कािण होतषे हैं। अपनषे गाहकों को प्राथवमकता दषेनषे वाली कंपवन्यां 

बषेहति व्यावसाव्यक परिणाम प्राप्त किती हैं, लोरों सषे अविक तािीफें  पाती हैं, औि बाज़ाि में अविक नवप्रवत्भक उतपाद पषेश किती हैं। लषेवकन जहां अनषेक 

कंपवन्यां गाहकों पि कें वरित होनषे का दावा किती हैं, वहीं ऐसी कंपवन्यों की वासतववक संख्या बहुत कम होती ह।ै तो, आप कैसषे जानेंरषे वक क््या आपकी 

कंपनी ऐसा अनुरव प्रदान कि िही ह,ै जो आपकषे  गाहकों को आनंवदत किता हो? सर में गाहकों पि कें वरित कंपवन्यों पि ववराि कितषे सम्य 5 ववशषेषताएं 

दषेखनी रावहएः

1. सुिभः गाहकों पि कें वरित कंपवन्यां, गाहकों कषे  वलए उनसषे संपक्भ  किना आसान बनाती हैं, जहां री, जब री गाहक ऐसा किना राहें। इसका अथ्भ ह ै

वक अपनी साइट औि गाहक समुदा्य को रवतशील औि खोज अनुकूवलत बनाएं, वक उप्ुयक्त सोशल मीवड्या साइटों पि आपकी मौजदूरी हो, औि 

्यह वक आपकषे  गाहकों को एकदम सपष्ट पता हो वक वषे वकस तिह आपसषे संपक्भ  किें रषे।

 इसका ्यह री अथ्भ ह ैवक उनसषे मतै्रीपणू्भ  औि समझनषे में आसान तिीकषे  सषे संवाद वक्या जाए, औि उद्ोर जरत कषे  तकनीकी अप्ररवलत शबदों औि 

रोलमोल सी प्रवतवक्र्याओ ंसषे इसषे बोवझल न बना्या जाए।

2. प्रर्तरक्रयाशीिः आपकषे  गाहकों को आपसषे जो अपषेक्ाएं हैं, उन पि सोशल मीवड्या का काफी प्रराव पडता ह।ै न कषे वल वषे हि बाि, अपनषे पसंदीदा 

वकसी री माध्यम सषे आपसषे संपक्भ  किनषे पि प्रवतवक्र्या राहतषे हैं, बवलक इसषे तुिंत री पानषे की आशा कितषे हैं! आप अविकाविक माध्यमों पि अपनी 

मौजदूरी बनाकि वजसकी आप तक्भ संरत ढंर सषे वनरिानी कि सकें  औि इन वाता्भलापों को आपकषे  गाहक समुदा्य की ओि मोडकि इसषे संराल 

सकतषे हैं। औि ्याद िखें, कषे वल पहली बाि ही उनकषे  संपक्भ  किनषे पि प्रवतवक्र्या दषेना काफी नहीं होता ह।ै आपको हि बाि प्रवतवक्र्या दषेनी होरी, औि 

कोई नई बात होतषे ही सबको तुिंत अवरत किाना होरा।

3. समानुभूर्तपूणटिः अरि आप समानुरवूतपवू्भक प्रवतवक्र्या नहीं कितषे, तो इससषे कोई फक्भ  नहीं पडता वक आपनषे वकतनी तषेजी सषे प्रवतवक्र्या दी! सोरें 

वक वकसी समस्या पि अपनषे वकसी वमत्र सषे वकस तिह बात कितषे हैं। हां, आप इसषे सुलझानषे में उनकी मदद किना राहतषे हैं। लषेवकन पहलषे आप ्यह 

सुवनवश्चत किना राहतषे हैं वक उनको अहसास हो वक आप सुन िहषे हैं, आप समझ िहषे हैं औि आप पिवाह कितषे हैं। अपनषे गाहकों सषे री ्यही तिीका 

अपनाएं, औि वषे आपकषे  वमत्रों की तिह ही आपकषे  प्रवत वनष्ठावान बनषे िहेंरषे।

4. सुसंग्तः आपका ववरार पथृक-पथृक खानों में बंटा हो, तो आपकषे  गाहकों को तषेज, सही सरूना दषे पाना कवठन हो जाता ह।ै कोई ्यह जानना राह 

सकता ह ैवक आपका अरला उतपाद कब जािी होरा, कोई दूसिा ्यह जानना राह सकता ह ैवक आपकी नवीनतम गाफी्य सरूना में कही बात आप 

कब पिूी कि पाएंरषे, औि कोई अन्य वकसी ववशषेष पकैषे ज में शावमल ववशषेषताओ ंकषे  बािषे  में ज्यादा जानना राह सकता ह।ै जब तक आपकी कंपनी में 

उवरत आंतरिक संवाद औि सह्योर नहीं होरा, आप इन प्रश्नों कषे  उत्ति तषेजी सषे ्या ईमानदािी सषे नहीं दषे पाएंरषे। इसकषे  वलए हम वद सवैटसफैक्टिी नामक 

आंतरिक समुदा्य का उप्योर कितषे हैं। आप क््या उप्योर कितषे हैं? 

5. ्तजेः आपकी कंपनी को गाहकों की प्रवतवक्र्याओ,ं ववरािों, औि हां आलोरना कषे  वलए री खोलनषे का सबसषे महत्वपणू्भ  वबंदु ्यह ह ैवक इसषे आपकी 

आंतरिक ववराि-प्रवक्र्या औि ववकास प्रवक्र्या सषे रुजिनषे दें। करी-करी आपकषे  गाहक कोई ऐसी बात कह सकतषे हैं वक वजसकी आपको उममीद न 

िही हो। इसका मतलब ्यह नहीं ह ैवक आपको उनकषे  हि बाि कषे  अनुिोिों कषे  अनुसाि ही खुद को ढालना होरा। लषेवकन आपकी रावी ्योजनाओ ंमें 

उनकी वटपपवण्यों की प्रमुख रवूमका होनी रावहए। ्यवद ऐसा नहीं ह,ै तो प्रवतवक्र्याओ ंका क््या लार ह?ै
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10. रोज़गार और उद्यरम्ता 
्कौशि

्यवूनट 10.1 – व्यवक्तरत शवक्त्यां एवं मूल्य प्रणाली 

्यवूनट 10.2 – वडवजटल साक्िता: पुनिाववृत्त

्यवूनट 10.3 – पसैषे का महतव

्यवूनट 10.4 – िोज़राि औि सव-िोज़राि कषे  वलए त्ैयािी किना 

्यवूनट 10.5 – उद्वमता को समझना

्यवूनट 10.6 – उद्मी बननषे की त्ैयािी किना
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इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. सवास्थ्य कषे  अथ्भ की व्याख्या किनषे में

2. सामान्य सवास्थ्य संबंिी समस्याओ ंकी सरूी बनानषे में

3. आम सवास्थ्य संबंिी समस्याओ ंकी िोकथाम कषे  उपा्यों पि ररा्भ  किनषे में

4. सवच्ता कषे  अथ्भ की व्याख्या किनषे में

5. सवच् राित अवर्यान कषे  उद्षेश्य को समझनषे में

6. आदत कषे  अथ्भ की व्याख्या किनषे में

7. एक सुिवक्त का्य्भ  वाताविण सथावपत किनषे कषे  तिीकों पि ररा्भ  किनषे में

8. कम्भरारि्यों द्ािा अपनाई जानषे वाली महतवपणू्भ  सुिक्ा आदतों पि ररा्भ  किनषे में

9. आतम-ववश्षे षण कषे  महतव की व्याख्या किनषे में

10. मासलो’स वहिािकी ऑफ नीड्स सषे प्रषेिणा को समझनषे में

11. उपलवबि प्रषेिणा कषे  अथ्भ पि ररा्भ  किनषे में

12. उपलवबि प्रषेिणा वालषे उद्वम्यों की ववशषेषताओ ंकी सरूी बनानषे में

13. आप को प्रषेरित किनषे वालषे वववरनन कािकों की सरूी बनानषे में

14. ररा्भ  किनषे में वक सकािातमक िव्ैया कैसषे बनाए िखा जाए

15. आतम-ववश्षे षण में िव्ैयषे/नज़रि्यषे की रवूमका पि ररा्भ  किनषे में

16. अपनी शवक्त औि कमजोरि्यों की सरूी बनानषे में

17. ईमानदाि लोरों कषे  रुणों पि ररा्भ  किनषे में

18. उद्वम्यों में ईमानदािी कषे  महतव का वण्भन किनषे में

19. एक मजबतू का्य्भ  नवैतकता कषे  ततवों पि ररा्भ  किनषे में

20. ररा्भ  किनषे में वक अच्ी का्य्भ  नवैतकता को कैसषे बढावा वद्या जाए

21. बषेहद िरनातमक लोरों की ववशषेषताओ ंकी सरूी बनानषे में

22. बषेहद उननवतशील लोरों की ववशषेषताओ ंकी सरूी बनानषे में

23. सम्य प्रबंिन कषे  लारों पि ररा्भ  किनषे में

24. प्ररावी सम्य प्रबंिकों कषे  रुणों की सरूी बनानषे में

25. प्ररावी सम्य प्रबंिन तकनीक का वण्भन किनषे में

26. क्रोि प्रबंिन कषे  महतव पि ररा्भ  किनषे में

27. क्रोि प्रबंिन िणनीवत का वण्भन किनषे में

28. क्रोि प्रबंिन कषे  सुझावों पि ररा्भ  किनषे में

29. तनाव कषे  कािणों पि ररा्भ  किनषे में

30. तनाव कषे  लक्णों पि ररा्भ  किनषे में

31. तनाव प्रबंिन कषे  सुझावों पि ररा्भ  किनषे में

32. कंप्यटूि कषे  बुवन्यादी रारों को पहरननषे में

33. कीबोड्भ  कषे  बुवन्यादी रारों को पहराननषे में

प्रमुख अभयास रनष्कषटि 
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34. कंप्यटूि की बुवन्यादी शबदावली को ्याद िखनषे में

35. कंप्यटूि की बुवन्यादी शबदावली को ्याद िखनषे में

36. कंप्यटूि की बुवन्यादी कंुवज्यों कषे  का्यकों को ्याद िखनषे में

37. MS Office की प्रमुख एपलीकषे शंस पि ररा्भ  किनषे में

38. Microsoft Outlook कषे  लारों पि ररा्भ  किनषे में

39. ई-कॉमस्भ कषे  वववरनन प्रकािों पि ररा्भ  किनषे में

40. खुदिा ववक्रषे ताओ ंऔि गाहकों कषे  वलए ई-कॉमस्भ कषे  लारों की सरूी बनानषे में

41. ररा्भ  किनषे में, वक वडवजटल इंवड्या अवर्यान सषे राित में ई-कॉमस्भ को कैसषे बढावा वमलषेरा

42. व्याख्या कि सकें रषे वक आप एक ई-कॉमस्भ मंर पि एक उतपाद ्या सषेवा कैसषे बषेरेंरषे

43. पसैषे बरानषे कषे  महतव पि ररा्भ  कि सकें रषे

44. पसैषे बरानषे कषे  लारों पि ररा्भ  कि सकें रषे

45. बैंक खातों कषे  प्रमुख प्रकािों पि ररा्भ  कि सकें रषे

46. बैंक में खाता खोलनषे की प्रवक्र्या का वण्भन किनषे में

47. सथाई औि परिवतशी लारत कषे  बीर अंति सपष्ट कि सकें रषे

48. वनवषेश ववकलपों कषे  प्रमुख प्रकािों का वण्भन कि सकें रषे

49. बीमा उतपादों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

50. किों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

51. ऑनलाइन बैंवकंर कषे  उप्योरों पि ररा्भ  कि सकें रषे

52. इलषेक्ट्ॉवनक िन हसतांतिण कषे  प्रमुख प्रकािों पि ररा्भ  कि सकें रषे

53. साक्ातकाि कषे  वलए त्ैयािी किनषे कषे  वववरनन रिणों पि ररा्भ  कि सकें रषे

54. प्ररावी रिज्यमूषे बनानषे कषे  वववरनन रिणों पि ररा्भ  कि सकें रषे

55. साक्ातकाि में अक्सि पू् षे  जानषे वालषे सवालों पि ररा्भ  कि सकें रषे

56. ररा्भ  कि सकें रषे वक साक्ातकाि में अक्सि पू् षे  जानषे वालषे सवालों का जवाब कैसषे वद्या जाए

57. बुवन्यादी का्य्भसथल शबदावली पि ररा्भ  कि सकें रषे

58. उद्मशीलता की अविािणा पि ररा्भ  कि सकें रषे

59. उद्मशीलता कषे  महतव पि ररा्भ  कि सकें रषे

60. उद्मशीलता की ववशषेषताओ ंकी ररा्भ  कि सकें रषे

61. उद्मों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

62. एक प्ररावी नषेता कषे  रुणों की सरूी बना सकें रषे

63. प्ररावी नषेततृव कषे  लारों पि ररा्भ  कि सकें रषे

64. एक प्ररावी टीम कषे  रुणों की सरूी बना सकें रषे

65. प्ररावशाली ढंर सषे सुननषे कषे  महतव पि ररा्भ  कि सकें रषे

66. प्ररावी तिीकषे  सषे सुननषे की प्रवक्र्या पि ररा्भ  कि सकें रषे

67. प्ररावशाली ढंर सषे बात किनषे कषे  महतव पि ररा्भ  कि सकें रषे

68. ररा्भ  कि सकें रषे वक प्ररावशाली ढंर सषे कैसषे बात की जाए

69. ररा्भ  कि सकें रषे वक समस्याओ ंको वकस प्रकाि हल वक्या जाए
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70. समस्या सुलझानषे कषे  महतवपणू्भ  रुणों की सरूी बना सकें रषे

71. समस्या सुलझानषे कषे  कौशल आंकलन कषे  तिीकों पि ररा्भ  कि सकें रषे

72. नरैोवशएशन कषे  महतव पि ररा्भ  कि सकें रषे

73. ररा्भ  कि सकें रषे वक नरैोवशएट कैसषे वक्या जाए

74. ररा्भ  कि सकें रषे वक नए व्यापाि अवसिों की पहरान कैसषे की जाए

75. ररा्भ  कि सकें रषे वक नए व्यापाि अवसिों की पहरान अपनषे व्यवसा्य कषे  रीति कैसषे की जाए

76. उद्मी कषे  अथ्भ को समझ सकें रषे

77. वववरनन प्रकाि कषे  उद्वम्यों का वण्भन कि सकें रषे

78. उद्वम्यों की ववशषेषताओ ंकी सरूी बना सकें रषे

79. उद्वम्यों की सफलता की कहावन्यां ्याद कि पाएंरषे

80. उद्मशीलता की प्रवक्र्या पि ररा्भ  कि सकें रषे

81. उद्मशीलता ईकोवससटम का वण्भन कि सकें रषे

82. उद्मशीलता ईकोवससटम में सिकाि की रवूमका पि ररा्भ  कि सकें रषे

83. राित में वत्भमान उद्मशीलता ईकोवससटम पि ररा्भ  कि सकें रषे

84. मषेक इन इंवड्या अवर्यान कषे  उद्षेश्य को समझ सकें रषे

85. उद्वमता औि जोवखम लषेनषे की क्मता कषे  बीर संबंि पि ररा्भ  कि सकें रषे

86. उद्मशीलता औि लरीलषेपन कषे  बीर संबंि पि ररा्भ  कि सकें रषे

87. एक लरीलषे उद्मी की ववशषेषताओ ंका वण्भन कि सकें रषे

88. ररा्भ  कि सकें रषे वक असफलता सषे कैसषे वनपटा जाए

89. ररा्भ  कि सकें रषे वक ववपणन (माकदे ट) शोि कैसषे वक्या जाए

90. माकदे वटंर कषे  4 P का वण्भन कि सकें रषे

91. ववराि उतपवत्त कषे  महतव पि ररा्भ  कि सकें रषे

92. बुवन्यादी व्यापाि शबदावली को ्याद कि सकें रषे

93. CRM की आवश्यकता पि ररा्भ  कि सकें रषे

94. CRM कषे  लारों पि ररा्भ  कि सकें रषे

95. नषेटववकयं र की आवश्यकता पि ररा्भ  कि सकें रषे

96. नषेटववकयं र कषे  लारों पि ररा्भ  कि सकें रषे

97. लक््यवनिा्भिण कषे  महतव को समझ सकें रषे

98. अलपकावलक, मध्यम अववि औि लंबी अववि कषे  लक््यों कषे  बीर अंति कि सकें रषे

99. ररा्भ  कि सकें रषे वक एक व्यवसा्य ्योजना कैसषे वलखी जाए

100. ववत्ती्य ्योजना प्रवक्र्या की व्याख्या कि सकें रषे

101. अपनषे जोवखम को प्रबंवित किनषे कषे  तिीकों पि ररा्भ  कि सकें रषे

102. बैंक सषे ववत्त कषे  वलए आवषेदन किनषे की प्रवक्र्या औि औपरारिकताओ ंका वण्भन कि सकें रषे

103. ररा्भ  कि सकें रषे वक अपनषे उप्रकम का प्रबंिन कैसषे वक्या जाए

104. ऐसषे महतवपणू्भ  प्रश्नों की सरूी बना सकें रषे जो प्रत्यषेक उद्मी को उप्रकम शुरू किनषे सषे पहलषे पू् नषे रावहए
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यूरनट 10.1: वयरतिग्त शरति और मूलय प्रणािी

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. सवास्थ्य कषे  अथ्भ की व्याख्या किनषे में

2. सामान्य सवास्थ्य संबंिी समस्याओ ंकी सरूी बनानषे में

3. आम सवास्थ्य संबंिी समस्याओ ंकी िोकथाम कषे  उपा्यों पि ररा्भ  किनषे में

4. सवच्ता कषे  अथ्भ की व्याख्या किनषे में

5. सवच् राित अवर्यान कषे  उद्षेश्य को समझनषे में

6. आदत कषे  अथ्भ की व्याख्या किनषे में

7. एक सुिवक्त का्य्भ  वाताविण सथावपत किनषे कषे  तिीकों पि ररा्भ  किनषे में

8. कम्भरारि्यों द्ािा अपनाई जानषे वाली महतवपणू्भ  सुिक्ा आदतों पि ररा्भ  किनषे में

9. आतम-ववश्षे षण कषे  महतव की व्याख्या किनषे में

10. मासलो’स वहिािकी ऑफ नीड्स सषे प्रषेिणा को समझनषे में

11. उपलवबि प्रषेिणा कषे  अथ्भ पि ररा्भ  किनषे में

12. उपलवबि प्रषेिणा वालषे उद्वम्यों की ववशषेषताओ ंकी सरूी बनानषे में

13. आप को प्रषेरित किनषे वालषे वववरनन कािकों की सरूी बनानषे में

14. ररा्भ  किनषे में वक सकािातमक िव्ैया कैसषे बनाए िखा जाए

15. आतम-ववश्षे षण में िव्ैयषे/नज़रि्यषे की रवूमका पि ररा्भ  किनषे में

16. अपनी शवक्त औि कमजोरि्यों की सरूी बनानषे में

17. ईमानदाि लोरों कषे  रुणों पि ररा्भ  किनषे में

18. उद्वम्यों में ईमानदािी कषे  महतव का वण्भन किनषे में

19. एक मजबतू का्य्भ  नवैतकता कषे  ततवों पि ररा्भ  किनषे में

20. ररा्भ  किनषे में वक अच्ी का्य्भ  नवैतकता को कैसषे बढावा वद्या जाए

21. बषेहद िरनातमक लोरों की ववशषेषताओ ंकी सरूी बनानषे में

22. बषेहद उननवतशील लोरों की ववशषेषताओ ंकी सरूी बनानषे में

23. सम्य प्रबंिन कषे  लारों पि ररा्भ  किनषे में

24. प्ररावी सम्य प्रबंिकों कषे  रुणों की सरूी बनानषे में

25. प्ररावी सम्य प्रबंिन तकनीक का वण्भन किनषे में

26. क्रोि प्रबंिन कषे  महतव पि ररा्भ  किनषे में

27. क्रोि प्रबंिन िणनीवत का वण्भन किनषे में

28. क्रोि प्रबंिन कषे  सुझावों पि ररा्भ  किनषे में

29. तनाव कषे  कािणों पि ररा्भ  किनषे में

30. तनाव कषे  लक्णों पि ररा्भ  किनषे में

31. तनाव प्रबंिन कषे  सुझावों पि ररा्भ  किनषे में

यूरनट ्ेक उद्ेशय 
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10.1.1 सिास्थय, आद्तें, सिचछ्ता: सिास्थय कया है
ववश्व सवास्थ्य संरठन (WHO) कषे  अनुसाि, सवास्थ्य "पणू्भ  शािीरिक, मानवसक औि सामावजक आिोग्यता की वसथवत ह,ै न वक कषे वल िोर ्या दुब्भलता का 

अराव।" इसका अथ्भ ह ैवक सवसथ होनषे का अथ्भ ्यह नहीं होता ह ैवक आप असवसथ नहीं हैं - इसका अथ्भ ्यह री ह ैवक आपको रावनातमक रूप सषे शांत होना 

रावहए औि शािीरिक रूप सषे वफट महससू किना रावहए। उदाहिण कषे  वलए, आप ्यह नहीं कह सकतषे वक आप सवसथ हैं क््योंवक आपको को सदशी ्या खांसी 

जसैी शािीरिक बीमारि्यां नहीं ह।ै आपको ्यह री सोरना होरा वक, क््या आप शांत, तनाव-मुक्त औि प्रसननवरत्त महससू कि िहषे हैं।

आम सिास्थय संबंधी समसयाएँ

कु् आम सवास्थ्य संबंिी समस्याएँ हैं:

• एलजशी

• दमा

• तवरा संबंिी िोर

• अवसाद औि वरंता

• मिुमषेह

• खांसी, जुकाम, रला खिाब

• नींद कम आना

• मोटापा

10.1.1.1 सिास्थय संबंधी समसयाओ ं्की रो्क्थाम ्ेक रिए सुझाि 

खिाब सवास्थ्य की िोकथाम किना वकसी िोर ्या बीमािी कषे  वलए उपा्य किनषे सषे हमषेशा बषेहति होता ह।ै आप इसकषे  द्ािा सवसथ िह सकतषे हैं:

• फल, सवबज्यों औि वररि्यों जसैषे सवसथ खाद् पदाथ्भ  खाकि

• असवसथ औि शक्भ िा्ुयक्त खाद् पदाथकों का सषेवन कम किकषे

• हि िोज़ प्या्भप्त पानी पी कि

• िमू्रपान ्या शिाब का सषेवन न किकषे

• एक वदन में कम सषे कम 30 वमनट व्या्याम किकषे , एक सप्ताह में 4-5 बाि

• आवश्यकता अनुसाि टीकाकिण किाकषे

• ्योर व्या्याम औि ध्यान का अभ्यास किकषे

इनमें सषे आप वकतनषे सवास्थ्य मानकों का पालन कितषे हैं? आप पि लार ूहोनषे वालों पि वनशान लराएँ।

1. हि िात कम सषे कम 7-8 घंटषे सोतषे हैं। 
2. सुबह उठ कि सबसषे पहलषे औि सोनषे सषे ठीक पहलषे ईमषेल रषेक किनषे सषे बरतषे हैं। 
3. करी रोजन नहीं ्ोडतषे हैं - सही सम्य पि वन्यवमत रूप सषे रोजन कितषे हैं। 
4. प्रत्यषेक वदन थोडा-बहुत पढतषे हैं। 
5. जंक फूड सषे अविक घि पि पका्या र्या खाना खातषे हैं 
6. बठैषे  िहनषे की तुलना में खडषे अविक िहतषे हैं। 
7. सुबह उठ कि सबसषे पहलषे एक वरलास पानी पीतषे हैं औि सािा वदन कम सषे कम 8 वरलास पानी पीतषे हैं। 
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10.1.1.2 सिचछ्ता कया ह?ै

8. वन्यवमत जाँर कषे  वलए डॉक्टि औि दंत वरवकतसक कषे  पास जातषे हैं। 
9. एक सप्ताह में कम सषे कम 5 बाि 30 वमनट कषे  वलए व्या्याम कितषे हैं। 
10. अविक वावतत पषे्य पदाथकों कषे  सषेवन सषे बरतषे हैं। 

ववश्व सवास्थ्य संरठन (WHO) कषे  अनुसाि, "सवच्ता ऐसी वसथवत औि अभ्यास हैं, जो सवास्थ्य को बनाए िखनषे औि िोरों कषे  प्रसाि को िोकनषे में मदद 

किती हैं।" सिल शबदों में, सवच्ता का अथ्भ ्यह सुवनवश्चत किना ह ैवक आप वह सब कितषे हैं जो आपकषे  आसपास कषे  वाताविण को साफ िखनषे कषे  वलए 

आवश्यक ह,ै वजससषे आप कीटाणुओ ंऔि बीमारि्यों कषे  प्रसाि की संरावना को कम कि सकें ।

उदाहिण कषे  वलए, अपनषे घि में िसोई कषे  बािषे  में सोरें। अच्ी सवच्ता सुवनवश्चत किनषे का अथ्भ ह ैवक िसोई हमषेशा साफ औि दार िवहत ह,ै रोजन ढक कि 

िखा जाता ह,ै बत्भन िो वदए जातषे हैं औि करिषे  का वडबबा करिषे  सषे लबालब रिा हुआ नहीं िहता। ऐसा किनषे सषे हम रहूों ्या वतलरट्षे जसैषे कीटों को आकवष्भत 

किनषे की संरावना को कम कि दषेतषे हैं, औि कवक तथा अन्य िोर फैलानषे वालषे जीवाणुओ ंकषे  ववकास को िोक दषेतषे हैं।

इनमें सषे आप वकतनषे सवास्थ्य मानकों का पालन कितषे हैं? आप पि लार ूहोनषे वालों पि वनशान लराएँ।

1. िोज़ साबुन सषे नहातषे हैं - औि सप्ताह में 2-3 बाि शमैप ूसषे अपनषे बाल िोतषे हैं। 
2. हि िोज़ साफ, िुलषे हुए अंतव्भ्रि पहनतषे हैं। 
3. सुबह औि सोनषे सषे पहलषे अपनषे दाँत रिश कितषे हैं। 
4. वन्यवमत रूप सषे अपनषे हाथ औि पिैों कषे  नाखनू काटतषे हैं। 
5. शौराल्य जानषे कषे  बाद साबुन सषे हाथ िोतषे हैं। 
6. ्यवद आप को बहुत पसीना आता ह,ै तो अपनषे अंडिआम्भ  पि दुरयंि िोिी वडओडोिें ट का प्र्योर कितषे हैं। 
7. खाना पकानषे ्या खानषे सषे पहलषे साबुन सषे अपनषे हाथ िोतषे हैं। 
8. जब आप बीमाि होतषे हैं तो घि पि िहतषे हैं, तावक आपकी बीमािी की रपषेट में अन्य लोरों री ना आ जाएं। 
9. रंदषे कपडों को वफि सषे पहननषे सषे पहलषे उनहें कपडषे िोनषे कषे  साबुन सषे िोतषे हैं। 
10. जब आपको खांसी ्या ्ीकें  आती हैं तो अपनषे नाक को एक वटश्य/ूअपनषे हाथ सषे ढक लषेतषे हैं। 
हि लराए रए वनशान कषे  वलए सव्ंय को 1 अंक दषेकि दषेखें वक आप वकतनषे सवसथ औि सवच् हैं! वफि अपनषे अंकों पि ध्यान दें वक उनका क््या अथ्भ ह।ै

आप्ेक अं्क

• 0-7/20: आप को वफट औि ठीक िहनषे कषे  वलए बहुत कवठन काम किनषे की आवश्यकता ह!ै इसषे दवैनक अच्ी आदतों का अभ्यास किनषे कषे  वलए एक 

शुरुआत बनाएं औि दषेखें वक आप वकतना बषेहति महससू कितषे हैं!

• 7-14/20: बुिा नहीं ह,ै लषेवकन सुिाि की रंुजाइश ह!ै कोवशश किें  औि अपनी वदनर्या्भ  में कु् औि अच्ी आदतें जोडें।

• 14-20/20: बहुत अच्ा! अच्ा काम कितषे िहें! आपका शिीि औि मन आपको िन्यवाद किता ह!ै
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10.1.1.3 सिचछ भार्त अरभयान

10.1.1.4 आद्तें कया हैं?

सव्ंय कषे  वलए अच्ी सवच्ता औि सवास्थ्य पद्धवत्यों का पालन किनषे कषे  महतव पि हम पहलषे ही ररा्भ  कि रुकषे  हैं। लषेवकन, सवसथ औि सवच् िहनषे कषे  वलए 

हमािषे  वलए इतना ही प्या्भप्त नहीं ह।ै हमें इन मानकों का अपनषे घिों, अपनषे आस-पास औि समग रूप सषे पिूषे  दषेश में री प्रसाि किना होरा।

2 अक्टूबि 2014 को प्रिानमंत्री शी निषे नरि मोदी द्ािा शुरू वक्या र्या 'सवच् राित अवर्यान' वासतव में ऐसा किनषे में ववश्वास िखता ह।ै इस वमशन का 

उद्षेश्य रवल्यों औि राित की सडकों को साफ किना औि साफ-सफाई कषे  समग सति को बढाना ह।ै वत्भमान में इस वमशन में दषेश रि कषे  4,041 शहि औि 

नरि शावमल हैं। हमािषे  लाखों लोरों नषे एक सवच् राित कषे  वलए संकलप वल्या ह।ै आप को री प्रवतज्ा लषेनी रावहए, औि अपनषे दषेश को साफ िखनषे कषे  वलए 

हि संरव प्र्यास किना रावहए!

आदत एक तिह का व्यवहाि होती ह ैवजसषे अक्सि दोहिा्या जाता ह।ै हम सरी में कु् अच्ी आदतें औि कु् बुिी आदतें होती हैं। जॉन ड्ाइडन द्ािा कही 

रई बात को मन में िखें: "हम पहलषे अपनी आदतें बनातषे हैं, औि वफि हमािी आदतें हमें बनाती हैं।" ्यही कािण ह ैवक ्यह बहुत महतवपणू्भ  ह ैवक आप अच्ी 

आदतों को जीवन का वहससा बनाएँ, औि ध्यानपवू्भक बुिी आदतों सषे बरें।

कु् आदतें वजनहें आपको अपनी वदनर्या्भ  का वहससा बनाना रावहए:

• हमषेशा सकािातमक िव्ैया िखें

• व्या्याम को अपनी वदनर्या्भ  का वहससा बनाना

• प्रषेिक औि प्रषेिणादा्यक कहावन्यां पढना

• मुसकुिाना! वजतनी बाि संरव हो उतनी बािषे  मुसकुिानषे की आदत डाल लें

• परिवाि औि दोसतों कषे  वलए सम्य वनकालें

• सुबह जलदी उठें  औि िात को जलदी सोएँ

कु् बुिी आदतें जो आपको तुिंत ्ोड दषेनी रावहएं:

• नाशता ना किना

• अक्सि सनकै्स खाना, रलषे आप को रखू ना ही लरी हो

• बहुत ज्यादा वसा वाला औि मीठा रोजन खाना

• िमू्रपान किना, शिाब पीना औि नशा किना

• अपनी आ्य सषे अविक पसैा खर्भ किना

• महतवहीन बातों कषे  बािषे  में वरंता किना

• दषेि िात तक जारना औि सुबह दषेिी सषे उठना

10.1.1.5 सुझाि 
• वनमन सवसथ औि सवच् पद्धवत्यों का पालन किनषे सषे आप सव्ंय को हि िोज़ मानवसक औि शािीरिक रूप सषे अच्ा महससू किें रषे।

• सवच्ता सवास्थ्य का दो-वतहाई ह ै- इसवलए अच्ी सवच्ता सषे आप को मज़बतू औि सवसथ िहनषे में मदद वमलषेरी!
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10.1.2 सुरक्ा: ए्क सुररक््त ्कायटिस्थि ्तयैार ्करने ्ेक रिए सुझाि

10.1.2.1 परक्रामय/रिरनमेय ्कमटिचारी सुरक्ा आद्तें

10.1.3 आतम-रिशे्षण - रियैा, उपिरबध प्रेरणा

10.1.2.2 सुझाि 

्यह सुवनवश्चत किना प्रत्यषेक वन्योक्ता का दाव्यतव ह ैवक उसकषे  का्य्भसथल पि उचरतम संरव सुिक्ा प्रोटोकॉल का पालन होता हो। जब एक व्यवसा्य 

सथावपत किना हो, तो मावलकों को इसषे ध्यान में िखना रावहए:

• वरिनषे औि घमूनषे जानषे सषे बरनषे कषे  वलए शम-दक्ता की दृवष्ट सषे त्ैयाि फनशीरि औि उपकिणों का उप्योर किें

• रािी वसतुओ ंको उठानषे ्या ढोनषे सषे बरनषे कषे  वलए ्यांवत्रक सहा्यता प्रदान किें

• खतिनाक का्यकों कषे  वलए सुिक्ा उपकिण पास िखें

• आपातकालीन वनकास वनिा्भ रित किें  औि सुवनवश्चत किें  वक वषे आसानी सषे सुलर हो

• सवास्थ्य कोड वनिा्भ रित किें  औि सुवनवश्चत किें  वक उनहें लार ूवक्या जाए

• का्य्भसथल में औि उसकषे  आस-पास वन्यवमत रूप सषे सुिक्ा वनिीक्ण की प्रथा का पालन किें

• सुवनवश्चत किें  वक वन्यवमत रूप सषे ईमाित का वनिीक्ण वक्या जाए

• का्य्भसथल सुिक्ा पि ववशषेषज् सलाह प्राप्त किें  औि उसका पालन किें

्यह सुवनवश्चत किना प्रत्यषेक वन्योक्ता का दाव्यतव ह ैवक उसकषे  का्य्भसथल पि उचरतम संरव सुिक्ा प्रोटोकॉल का पालन होता हो। जब एक व्यवसा्य 

सथावपत किना हो, तो मावलकों को इसषे ध्यान में िखना रावहए:

• असुिवक्त वसथवत्यों की सरूना तुिंत प्य्भवषेक्क को दें

• सुिक्ा संबंिी खतिों को पहरानें औि उनकी सरूना दें जो वफसलनषे, लडखडानषे, औि वरिनषे का कािण बन सकतषे हैं

• सरी रोटों औि दुघ्भटनाओ ंकी सरूना प्य्भवषेक्क को दें

• आवश्यकता अनुसाि सही सुिक्ा उपकिण पहनें

• जानें वक सुिक्ा उद्षेश्यों कषे  वलए प्रदान वकए रए उपकिण का उप्योर सही ढंर सषे कैसषे वक्या जाए

• ऐसी वक्र्याओ ंपि ध्यान दें औि उनसषे बरें वजनसषे अन्य लोरों को खतिा हो सकता है

• वदन कषे  दौिान कु् सम्य कषे  वलए आिाम किें  औि सप्ताह में कु् सम्य कषे  वलए काम सषे दूि िहें

• जानकािी प्राप्त किें  वक का्य्भसथल पि आपात वसथवत कषे  सम्य में वकस आपातकालीन नंबि पि कॉल की जाए

• अफिा तफिी में वनकासी सषे बरनषे कषे  वलए वन्यवमत रूप सषे वनकासी अभ्यासों का अभ्यास किें

सही मा्यनषे में अपनी पिूी क्मता हावसल किनषे कषे  वलए, आप को अपनषे अंदि झाँकनषे औि पता लरानषे की आवश्यकता ह ैवक वासतव में आप वकस तिह कषे  

व्यवक्त हैं। अपनषे व्यवक्ततव को समझनषे कषे  इस प्र्यास को आतम-ववश्षे षण कषे  रूप में जाना जाता ह।ै इस तिह सषे खुद का आंकलन किनषे सषे आपको अपनषे 

ववकास में मदद वमलषेरी, औि इससषे आप को अपनषे रीति ऐसषे क्षेत्रों की पहरान किनषे में री मदद वमलषेरी वजनमें आपको उनहें औि ववकवसत किनषे, बदलनषे, 

्या ्ोडनषे की आवश्यकता ह।ै आप अपनषे अंदि झाँककि सव्ंय को बषेहति समझ सकतषे हैं वक आपको क््या प्रषेरित किता ह,ै आपका िव्ैया कैसा ह,ै औि 

आपकी शवक्त्याँ औि कमज़ोरि्यां क््या हैं।
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10.1.3.1 प्रेरणा कया ह?ै

10.1.3.2 मासिो’स रहरार्की ऑि नीि्स (Maslow’s Hierarchy of Needs)

सिल शबदों में कहें, प्रषेिणा आपकषे  वक्र्या किनषे का कािण ह ै्या आप का वकसी वववशष्ट तिीकषे  सषे व्यवहाि किना ह।ै ्यह समझना बहुत महतवपणू्भ  ह ैवक 

सरी लोर एक समान रीज़ों सषे प्रषेरित नहीं होतषे हैं - लोर कई तिह की अलर-अलर रीज़ों सषे प्रषेरित होतषे हैं। हम इसषे मासलो’स वहिािकी ऑफ नीड्स 

(Maslow’s Hierarchy of Needs) को दषेखकि बषेहति समझ सकतषे हैं।

प्रवसद्ध अमषेरिकी मनोवजै्ावनक इरिाहीम मासलो (Abraham Maslow) समझना राहता था वक लोरों को क््या प्रषेरित किता ह।ै उनका मानना   था वक लोरों 

की पाँर प्रकाि की ज़रूितें होती ह,ै इसमें बहुत बुवन्यादी आवश्यकताओ ं(वजनहें दवैहक आवश्यकताएं कहा जाता ह)ै सषे लषेकि सबसषे महतवपणू्भ  ज़रूितें 

शावमल हैं जो आतम-ववकास (वजनहें आतम वासतववकीकिण ज़रूितें कहा जाता ह)ै कषे  वलए आवश्यक हैं। दवैहक औि आतम-ववकास की आवश्यकताओ ंकषे  

बीर तीन अन्य ज़रूितें होती हैं - सुिक्ा आवश्यकता, अपनषेपन औि प्याि की आवश्यकता, औि सममान की  आवश्यकता। इन आवश्यकताओ ं को 

सामान्यता पांर सतिों वालषे एक वपिावमड कषे  रूप में दशा्भ्या जाता ह ैऔि इसषे मासलो’स हाइिाकशी ऑफ नीड्स (Maslow’s Hierarchy of Needs) कषे  रूप में 

जाना जाता ह।ै

जसैषे वक आप वपिावमड में दषेख सकतषे हैं, सबसषे वनरला सति सबसषे बुवन्यादी आवश्यकताओ ंको दशा्भता ह।ै मासलो का मानना   था वक हमािा व्यवहाि, 

हमािी बुवन्यादी आवश्यकताओ ंसषे प्रषेरित होता ह,ै जब तक वषे ज़रूितें पिूी नहीं हो जाती। ्यषे ज़रूितें पिूी होनषे कषे  बाद, हम अरलषे सति पि रलतषे हैं औि अरलषे 

सति की आवश्यकताओ ंसषे प्रषेरित होतषे हैं। रवलए इसषे एक उदाहिण कषे  साथ बषेहति समझतषे हैं।

तित्र 10.1.1: मा्िो’स तहरारकी ऑफ नीडस (Maslow’s Hierarchy of Needs)



285284

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

10.1.3.3 उपिरबध प्रेरणा ्को समझना

रूपा एक बहुत ही रिीब परिवाि सषे संबंि िखती ह।ै उसकषे  पास करी प्या्भप्त रोजन, पानी, अपनापन ्या आिाम नहीं िहा। मासलो कषे  अनुसाि, जब तक रूपा 

सुवनवश्चत नहीं हो जाती वक उसकी ्यह आवश्यकताएं पिूी हो जाएंरी, तब तक वह अरलषे सति की आवश्यकताओ ंकषे  बािषे  में सोरषेरी री नहीं - उसकी 

सुिक्ा संबंिी आवश्यकताएं। लषेवकन, जब उसषे रिोसा हो जाता ह ैवक उसकी बुवन्यादी आवश्यकताएं पिूी हो जाएंरी, तो वह अरलषे सति पि जाएरी औि 

वफि उसका व्यवहाि सुिक्ा औि िक्ा की उसकी आवश्यकता अनुसाि प्रषेरित होरा। जब उसकी ्यह आवश्यकताएं पिूी हो जाती हैं, तो रूपा अरलषे सति पि 

जाएरी, औि रिशतों औि वमत्रों की अपनी आवश्यकताओ ंसषे प्रषेरित होती ह।ै इस आवश्यकता कषे  पिूा होनषे कषे  बाद, रूपा रौथषे सति की आवश्यकताओ ंपि 

ध्यान कषे वनरित किषे री - उसकी सममान संबंिी आवश्यकताएं वजसकषे  बाद वह पांरवें औि अंवतम सति की ओि जाएरी - अपनी पिूी क्मता अनुसाि हावसल 

किनषे की इच्ा।

अब हम जानतषे हैं वक लोर, बुवन्यादी, मनोवजै्ावनक औि आतम-पवूत्भ  आवश्यकताओ ंसषे प्रषेरित होतषे हैं। हालांवक, कु् लोर बषेहद रुनौतीपणू्भ  प्रावप्त्यों की 

उपलवबि सषे री प्रषेरित होतषे हैं। ्यह उपलवबि प्रषेिणा ्या 'उपलवबि की आवश्यकता' कषे  रूप में जाना जाता ह।ै

उपलवबि प्रषेिणा का सति प्रत्यषेक व्यवक्त कषे  वलए अलर-अलर होता ह।ै ्यह महतवपणू्भ  ह ैवक उद्वम्यों में उपलवबि प्रषेिणा का सति ऊँरा होना रावहए - कु् 

महतवपणू्भ  औि अवद्ती्य प्राप्त किनषे की रहिी इच्ा। ्यह री उतना ही महतवपणू्भ  ह ै वक वषे ऐसषे लोर रतशी किें  जो सव्ंय री रुनौवत्यों औि सफलता सषे 

अत्यविक प्रषेरित होतषे हैं।

आप्को कया प्रेरर्त ्कर्ता ह?ै

ऐसी कौन-सी रीज़ें हैं जो वासतव में आपको प्रषेरित किती हैं? ऐसी पांर रीज़ों की सरूी बनाएँ जो आपको प्रषेरित किती हैं। ्याद िखें, वक जवाब ईमानदािी 

सषे दें!

मैं इनसे प्रेरर्त हंू:
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..................................................................................................................................................................................
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उपिरबध प्रेरणा िाि ेउद्यरमयों ्की रिशेष्ताएँ

• उपलवबि प्रषेिणा वालषे उद्वम्यों को वनमन अनुसाि ववण्भत वक्या जा सकता ह:ै

• व्यवक्तरत उपलवबि कषे  वलए जोवखम लषेनषे सषे नहीं डितषे हैं

• रववष््य उनमुख लरीलषेपन औि अनुकूलता रुनौवत्यां अच्ी लरती हैं

• सकािातमक प्रवतक्रम/फीडबकै कषे  मुकाबलषे नकािातमक प्रवतक्रम/फीडबकै को अविक महत्व दषेतषे हैं

• जब लक््यों को प्राप्त किनषे की बात आती ह ैतो बहुत वज़द्ी होतषे हैं

• अत्ंयत साहसी

• बषेहद िरनातमक औि अवरनव/उननवतशील

• बषेरनै - लराताि अविक प्राप्त किनषे कषे  बािषे  में सोरतषे हैं

• समस्याओ ंको सुलझानषे कषे  वलए व्यवक्तरत रूप सषे वजममषेदािी लषेतषे हैं

इन्ेक बारे में सोचें:

• आप में इनमें सषे वकतनषे रुण हैं?

• क््या आपकषे  ज़हन में ऐसा कोई उद्मी आता ह ैवजसमें ्यह रुण हों?

10.1.3.4 स्कारातम्क रियैा ्ैकसे रि्करस्त र्कया जाए

10.1.3.5 रियैा कया ह?ै

अच्ी खबि ्यह ह ैवक िव्ैया एक पसंद/ववकलप ह।ै इसवलए अपनषे िव्ैया को सुिािना, वन्ंयवत्रत किना औि बदलना संरव ह,ै अरि हम ऐसा किनषे का 

वनण्भ्य कि लें! वनमनवलवखत सुझाव सकािातमक मानवसकता को प्रोतसावहत किनषे में मदद कितषे हैं:

• ्याद िखें वक आप अपनषे िव्ैया को वन्ंयवत्रत कितषे हैं, ना वक आपकषे  आस-पास कषे  लोर

• वदन में कम सषे कम 15 वमनट कु् सकािातमक पढनषे, दषेखनषे औि सुननषे कषे  वलए समवप्भत किें

• नकािातमक लोरों सषे बरषे, जो कषे वल वशका्यत कितषे हैं औि अपनषे आप को कोसनषे सषे बरें

• अपनी शबदावली का सकािातमक शबदों कषे  साथ ववसताि किें  औि अपनषे मन सषे नकािातमक बातों को वनकाल दें

• सिाहना किें  औि आप में, आपकषे  जीवन में, औि अन्यों में क््या अच्ा ह,ै उस पि कें वरित िहें

• अपनषे आप को पीवडत समझना बंद किें  औि सवक्र्य होना शुरू किें

• कलपना किें  वक आप सफल हो िहषे हैं औि अपनषे लक््य प्राप्त कि िहषे हैं

अब हमनषे समझ वल्या ह ैवक प्रषेिणा आतम-ववश्षे षण कषे  वलए इतनी महतवपणू्भ  क््यों ह,ै रवलए दषेखतषे हैं वक हमािा िव्ैया खुद को समझनषे में क््या रवूमका 
वनराता ह।ै िव्ैयषे को आपकी वकसी कषे  बािषे  में ्या वकसी रीज़ कषे  बािषे  में सोरनषे औि महससू किनषे की प्रववृत्त (सकािातमक ्या नकािातमक) कषे  रूप में ववण्भत 
वक्या जा सकता ह।ै िव्ैया जीवन कषे  हि पहल ूमें सफलता का आिाि ह।ै हमािा िव्ैया हमािा सबसषे अच्ा दोसत ्या हमािा सबसषे बडा दुशमन हो सकता ह।ै 
सिल शबदों में:

"जीिन में ए्क मात्र अक्म्ता गि्त रियैा ही हो्ती ह।ै"

जब आप एक व्यवसा्य शुरू कितषे हैं, तो आप सुवनवश्चत होतषे हैं वक आपको बुिषे  सम्य औि असफलताओ ंसषे लषेकि अच ष्े  सम्य औि सफलताओ ंजसैी वववरनन 
प्रकाि की रावनाओ ंका समाना किना होरा। आपका िव्ैया वह होता ह ैजो कवठन सम्य में आपकषे  साथ होरा औि सफलता की वदशा में मार्भदश्भन किषे रा। 
िव्ैया री संक्रामक ह।ै ्यह आपकषे  वनवषेशकों सषे लषेकि आपकषे  कम्भरारि्यों औि आपकषे  गाहकों तक, आपकषे  आस-पास सरी को प्रराववत किता ह।ै एक 
सकािातमक िव्ैया का्य्भसथल में ववश्वास का वनमा्भण किनषे में मदद किता ह ैजबवक एक नकािातमक िव्ैया आपकषे  लोरों को संराववत रूप सषे प्रषेिणाहीन 
कि सकता ह।ै
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10.1.4 ईमानदारी और ्कायटि नरै्त्क्ता: ईमानदारी कया ह?ै

10.1.3.6 आप्की शरतियां और ्कमज़ोररयां कया हैं

आतम ववश्षे ष्ण किनषे एक अन्य तिीका ह ैईमानदािी सषे अपनी शवक्त्यों औि कमज़ोरि्यों को पहरानना। इससषे आपको अपनषे सवपोत्तम लार कषे  वलए अपनी 

शवक्त्यों का उप्योर किनषे औि अपनी कमज़ोरि्यों को कम किनषे में मदद वमलषेरी।

नीरषे वदए रए दो कॉलम में अपनी सरी शवक्त्यों औि कमज़ोरि्यों को वलखें। खुद कषे  साथ ईमानदाि िहना ्याद िखें!

शरतियां ्कमज़ोररयां

10.1.3.7 सुझाि 

• उपलवबि प्रषेिणा सीखी जा सकती ह।ै

• रलवत्यां किनषे सषे मत डिें ।

• आपनषे जो शुरू वक्या उसषे खतम किनषे कषे  वलए खुद को प्रवशवक्त किें ।

• बडा सोरें।

ईमानदािी वनष्पक् औि सचरा होनषे की रुणवत्ता ह।ै इसका अथ्भ इस प्रकाि सषे बोलना औि का्य्भ  किना ह ै वजससषे ववश्वास बढता हो। एक व्यवक्त वजसषे 

ईमानदाि कहा जाता ह ैउसषे सचरा औि वनष्कपट माना जाता ह ैऔि ऐसा व्यवक्त जो िोखषेबाज ्या कुवटल नहीं ह ैऔि रोिी ्या िोखा नहीं किता ह।ै 

ईमानदािी कषे  दो आ्याम हैं - एक ह ैसंवाद में ईमानदािी औि अन्य ह ैआरिण में ईमानदािी।

ईमानदािी एक अत्ंयत महतवपणू्भ  रुण ह,ै क््योंवक इससषे मन की शांवत वमलती ह ैऔि ववश्वास पि आिारित रिशतषे बनतषे हैं। दूसिी तिह, बषेईमान होनषे सषे वरंता 

होती ह ैऔि अववश्वास औि संघष्भ  सषे रिषे  रिशतषे बनतषे हैं।
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10.1.4.1 ईमानदार िोगों ्ेक गुण

10.1.4.2 उद्यरमयों में ईमानदारी ्का महति

10.1.4.3 ्काम नरै्त्क्ता कया ह?ै

ईमानदाि व्यवक्त्यों में कु् अलर ववशषेषताएं होती हैं। ईमानदाि लोरों कषे  बीर कु् आम रुण हैं:

• वषे नहीं सोरतषे वक अन्य लोर उनकषे  बािषे  में क््या सोरतषे हैं। वषे खुद में ववश्वास कितषे हैं - वषे ध्यान नहीं दषेतषे वक उनहें उनकषे  व्यवक्ततव कषे  वलए पसंद वक्या 

जा िहा ह ै्या नापसंद वक्या जा िहा ह।ै

• वषे अपनषे ववश्वास पि अवडर िहतषे हैं। वषे अपना ईमानदाि दृवष्टकोण दषेनषे कषे  वलए दो बाि नहीं सोरेंरषे, रलषे ही वषे जानतषे हैं वक उनका नज़रि्या 

अलपसंख्यक कषे  साथ वनवहत हैं।

• वषे अवत संवषेदनशील होतषे हैं। इसका अथ्भ ्यह ह ैवक वषे अपनी ईमानदाि िा्य कषे  वलए कठोि समझषे जानषे कषे  कािण दूसिों सषे प्रराववत नहीं होतषे हैं।

• वषे रिोसषेमंद, साथ्भक औि सवसथ वमत्रता कितषे हैं। ईमानदाि लोर सामान्यता अपनषे आस-पास ईमानदाि वमत्र ही िखतषे हैं। उनहें ववश्वास होता ह ैवक 

उनकषे  वमत्र हि सम्य सचरषे औि उनकषे  साथ खडें िहेंरषे।

उनकषे  सावथ्यों को उन पि रिोसा होता ह।ै उनहें ऐसषे लोरों कषे  रूप में दषेखा जाता ह,ै वजन पि सचराई कषे  वलए औि वनष्पक् फीडबकै औि सलाह कषे  वलए 

रिोसा वक्या जा सकता ह।ै

• ईमानदारी और ्कमटिचारी: जब उद्मी अपनषे कम्भरारि्यों कषे  साथ ईमानदाि संबंि बनातषे हैं, इससषे का्य्भसथल में औि अविक पािदवश्भता आती ह,ै 

वजससषे काम का प्रदश्भन सति बढता ह ैऔि बषेहति परिणाम वमलतषे हैं।

• ईमानदारी और रनिेश्क: उद्वम्यों कषे  वलए, वनवषेशकों कषे  साथ ईमानदाि होनषे का अथ्भ कषे वल शवक्त्याँ साझा किना नहीं ह,ै बवलक खुलकि वत्भमान 

औि संराववत कमज़ोरि्यों, समस्या क्षेत्रों औि समािान िणनीवत्यों का खुलासा किना ह।ै ध्यान िखें वक वनवषेशकों को सटाट्भ-अप का बहुत अच्ा 

अनुरव ह ैऔि उनहें पता ह ैवक सरी नई कंपवन्यों को समस्याएं आती हैं। उनहोंनषे दावा वक्या वक सब कु् पिूी तिह सषे ठीक औि सुरारू रूप सषे रलना 

अविकति वनवषेशकों कषे  वलए एक खतिषे  का वनशान ह।ै

• अपने आप ्ेक सा्थ ईमानदारी: अपनषे आप कषे  साथ बषेईमान होनषे कषे  सखत परिणाम हो सकतषे हैं ववशषेष रूप सषे उद्वम्यों कषे  मामलषे में। उद्वम्यों को 

सफल बननषे कषे  वलए, ्यह महतवपणू्भ  ह ैवक वषे हि सम्य उनकी वसथवत कषे  बािषे  में ्यथाथ्भवादी िहें औि अपनषे उद्म कषे  हि पहल ूका सटीकता सषे आंकलन 

किें  वक वासतव में ्यह वकसवलए ह।ै

उद्वम्यों में सबसषे महतवपणू्भ  ववशषेषताओ ंमें सषे एक ईमानदािी ह।ै जब उद्मी अपनषे गाहकों, कम्भरारि्यों औि वनवषेशकों कषे  साथ ईमानदाि िहतषे हैं, ्यह 

दशा्भता ह ैवक वषे उन का सममान कितषे हैं वजनकषे  साथ वषे काम कितषे हैं। ्यह री महतवपणू्भ  ह ैवक उद्मी अपनषे आप कषे  साथ री ईमानदाि िहें। रवलए नज़ि 

डालतषे हैं वक कैसषे ईमानदाि होनषे सषे उद्वम्यों को बहुत लार होंरषे।

• ईमानदारी और रिाह्क: जब उद्मी अपनषे गाहकों कषे  साथ ईमानदाि होतषे हैं, इससषे मज़बतू संबंिों को बल वमलता ह,ै वजससषे व्यापाि बढता ह ैऔि 

एक मज़बतू गाहक नषेटवक्भ  बनता ह।ै

का्य्भसथल पि नवैतक होनषे का अथ्भ अपनषे सरी वनण्भ्यों औि संवाद में ईमानदािी, वनष्ठा औि सममान जसैषे मूल्यों को प्रदवश्भत किना ह।ै इसका अथ्भ ह ैवक 

झठू बोलना, िोखा दषेना औि रोिी किना जसैषे नकािातमक रुणों का प्रदश्भन नहीं किना ह।ै

का्य्भसथल में नवैतकता कंपनी कषे  मुनाफषे  में एक बडी रवूमका वनराती ह।ै ्यह उचर मनोबल औि टीम वक्भ  कषे  रूप में एक उद्म कषे  वलए बहुत महतवपणू्भ  ह।ै 

्यही कािण ह ैवक ज्यादाति कंपवन्यां वववशष्ट का्य्भसथल नवैतक वदशा-वनददेश की रूप िषे खा त्ैयाि किती हैं वजनका उनकषे  कम्भरारि्यों को अवनवा्य्भ  रूप 

सषे पालन किना होता ह।ै ्यह वदशा-वनददेश सामान्यता एक कंपनी की कम्भरािी पुवसतका में िषे खांवकत होतषे हैं।
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10.1.4.4 ए्क मज़बू्त ्कायटि नरै्त्क्ता ्ेक ्तति

10.1.4.5 अचछी ्कायटि नरै्त्क्ता ्को बढ़ािा ्ैकसे रदया जाए

एक उद्मी को मज़बतू का्य्भ  नवैतकता का प्रदवश्भत किना होरा, साथ ही कषे वल उन व्यवक्त्यों को रतशी किना रावहए, जो का्य्भसथल में समान सति कषे  

नवैतक व्यवहाि में ववश्वास िखतषे हैं औि प्रदवश्भत कितषे हैं। मज़बतू का्य्भ  नवैतकता कषे  कु् ततव हैं:

• वयािसारय्क्ता: इसमें वह सब कु् शावमल ह ै वजसमें आप अपनषे आप को कॉपपोिषे ट सषेवटंर में उसी प्रकाि प्रदवश्भत कितषे हैं, वजस प्रकाि आप 

का्य्भसथल में अन्य लोरों सषे व्यवहाि कितषे हैं।

• मानय्ता: इसका अथ्भ ह ैसंतुवलत औि कूटनीवतक िहना रलषे ही वसथवत वकतनी ही तनावपणू्भ  ्या अवसथि हो।

• रनभटिर्ता: इसका अथ्भ हमषेशा अपनषे शबदों पि का्यम िहें, रलषे ही वह वकसी बठैक कषे  वलए सम्य पि पहंुरना हो ्या सम्य पि का्य्भ  पिूा किना हो।

• समपटिण: इसका अथ्भ ह ैवक जब तक वनिा्भ रित का्य्भ  पिूा ना हो जाए तब तक का्य्भ  ना ्ोडना औि उतकृष्टता कषे  उचरतम संरव सति पि का्य्भ  पिूा 

किना।

• दृढ़्ता: इसका अथ्भ ह ैवक व्यविानों को, रुकावट की बजा्य रुनौती कषे  रूप में लषेना औि वांव्त परिणाम प्राप्त किनषे कषे  उद्षेश्य औि लरीलषेपन कषे  साथ 

आरषे बढना।

• जिाबदहेी: इसका अथ्भ ह ैअपनषे का्यकों औि उनकषे  परिणामों कषे  वलए वजममषेदािी लषेना, ना वक अपनी रलवत्यों कषे  वलए बहानषे बनाना।

• रिनम्र्ता: इसका अथ्भ ह ैवक सबकषे  प्र्यासों औि मषेहनत को सवीकाि किना, औि प्रावप्त्यों का शषे्य उनसषे साझा किना।

एक उद्मी कषे  रूप में, ्यह महतवपणू्भ  ह ैवक आप सपष्ट रूप सषे परिरावषत किें  वक आप का्य्भसथल पि प्रत्यषेक टीम सदस्य औि व्यवक्त सषे वकस प्रकाि कषे  

व्यवहाि की अपषेक्ा कितषे हैं। आप को ्यह सपष्ट किना रावहए वक आप कम्भरारि्यों सषे वनमन अनुसाि सकािातमक का्य्भ  नवैतकता का प्रदश्भन किनषे की 

अपषेक्ा कितषे हैं:

• ईमानदारी: एक व्यवक्त को सौंपा र्या सािा का्य्भ  वबना वकसी री ्ल ्या झठू कषे , पिूी ईमानदािी कषे  साथ वक्या जाना रावहए।

• अचछा रियैा: टीम कषे  सरी सदस्यों को आशावादी, ऊजा्भवान औि सकािातमक होना रावहए।

• रिश्सनीय्ता: कम्भरारि्यों को वदखाना रावहए वक वह वहीं ह ैजहां उनहें होना रावहए।

• अचछी ्कायटि संबंधी आद्तें: कम्भरारि्यों को हमषेशा अच्ी तिह सषे त्ैयाि होना रावहए, करी री अनुवरत राषा का उप्योर नहीं किना रावहए, हि 

सम्य पषेशषेवि कषे  रूप में का्य्भ  तथा व्यवहाि किना रावहए

• पहि: कषे वल का्य्भ  किना ही प्या्भप्त नहीं ह।ै हि टीम कषे  सदस्य को सवक्र्य होना होरा औि पहल किनी होरी।

• रिश्सनीय्ता: ववश्वास रिै पिक्राम्य ह।ै ्यवद एक कम्भरािी पि रिोसा नहीं वक्या जा सकता ह,ै तो ्यह कम्भरािी को बाहि किनषे का सम्य ह।ै

• सममान ्करना: कम्भरारि्यों को कंपनी, काननू, अपनषे काम, अपनषे सह्योवर्यों औि खुद का सममान किनषे की ज़रूित ह।ै

• सतयरनष्ठा: प्रत्यषेक औि हि टीम का सदस्य पिूी तिह सषे नवैतक होना रावहए औि उसषे हि सम्य उपिोक्त बोड्भ  व्यवहाि का प्रदश्भन किना रावहए।

• दक््ता: दक् कम्भरािी एक कंपनी को आरषे बढानषे में मदद कितषे हैं, जबवक अकुशल कम्भरािी सम्य औि संसािनों की बबा्भदी कितषे हैं।
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10.1.4.6 सुझाि 

10.1.5.1 सुझाि 

• जब री कोई आपको सचराई बताए औि जो आपनषे सुना वो आपको अच्ा ना लरषे, तो रुससा मत किें ।

• हमषेशा अपनी रलवत्यों की वजममषेदािी सवीकाि किनषे कषे  वलए त्ैयाि िहें।

10.1.5 रचनातम्क्ता और निाचार

िरनातमकता क््या है

िरनातमकता का अथ्भ कु् अलर सोरना ह।ै इसका अथ्भ ह ै रीज़ों को नए तिीकषे  सषे ्या अलर-अलर दृवष्टकोण सषे दषेखना औि वफि इन ववरािों को 

वासतववकता में परिववत्भत किना। िरनातमकता कषे  दो रार होतषे हैं: सोर औि उतपादन। कषे वल एक ववराि होना आपको कलपनाशील बनाता ह,ै िरनातमक 

नहीं। हालांवक, एक ववराि होना औि उस पि काि्भ वाई किना आपको िरनातमक बनाता ह।ै

बेहद रचनातम्क िोगों ्की रिशेष्ताएं

िरनातमक लोरों की कु् ववशषेषताएं हैं:

• वषे कलपनाशील औि रंरल होतषे हैं 

• वषे समस्याओ ंको अलर-अलर कोणों सषे दषेखतषे हैं 

• वषे ्ोटषे-्ोटषे ववविण पि री ध्यान दषेतषे हैं

• वषे वकसी री काम सषे बहुत कम ऊबतषे हैं

• वषे वन्यम औि वदनर्या्भ  सषे नफित कितषे हैं

• उनहें ख्याली पुलाव पकाना अच्ा लरता है

• वषे बहुत उतसुक होतषे हैं

निाचार कया ह?ै

नवाराि की कई अलर-अलर परिराषाएं हैं। सिल शबदों में, नवाराि का अथ्भ ह ैएक ववराि को समािान में परिववत्भत किना वजससषे उप्योवरता बढती ह।ै 

इस का अथ्भ ्यह री हो सकता ह ैवक एक नए उतपाद, सषेवा ्या प्रवक्र्या को का्या्भनव्यन किकषे  ्या एक मौजदूा उतपाद, सषेवा ्या प्रवक्र्या में महतवपणू्भ  सुिाि 

किकषे  इसकी उप्योवरता बढाना।

बेहद निाचार/उननर्तशीि िोगों ्की रिशेष्ताएं

बषेहद नवाराि लोरों की कु् ववशषेषताएं हैं:

• उनहें रीज़ों को अलर तिीकषे  सषे किनषे में मज़ा आता है

• उनहें शॉट्भकट लषेनषे में ववश्वास नहीं है

• उनहें अपिंपिारत होनषे का डि नहीं है

• वषे अत्यविक सवक्र्य औि दृढी हैं

• वषे संरवठत, सतक्भ  औि जोवखम सषे बरनषे वालषे हैं

• खुद को पुन:ऊवज्भत किनषे औि ताज़ा परिप्रषेक््य हावसल किनषे कषे  वलए अपनषे िरनातमक काम सषे वन्यवमत रूप सषे अंतिाल लें।

• अक्सि प्रोटोटाइप का वनमा्भण किें , उनका पिीक्ण किें , प्रवतवक्र्या प्राप्त किें  औि आवश्यक परिवत्भन किें ।
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10.1.6 समय प्रबंधन

10.1.6.1 प्रभािी समय प्रबंध्कों ्ेक गुण

सम्य प्रबंिन की प्रवक्र्या अपनषे सम्य को व्यववसथत किना ह,ै औि त्य किना ह ैवक वववरनन रवतवववि्यों कषे  बीर अपना सम्य कैसषे बाँटा जाए। अच्ा 

सम्य प्रबंिन समाट्भ  तिीकषे  सषे काम किना (कम सम्य में अविक काम किना) औि कडी मषेहनत किनषे (अविक काम कषे  वलए अविक सम्य तक काम 

किना) कषे  बीर अंति ह।ै

प्ररावी सम्य प्रबंिन सषे कुशल का्य्भ  उतपादन वमलता ह,ै रलषे ही आपको कम सम्य सीमा औि उचर दबाव वसथवत्यों का सामना किना हो। दूसिी ओि, 

अपनषे सम्य को प्ररावी रूप सषे प्रबंवित ना किनषे सषे अकुशल उतपादन होता ह ैऔि तनाव औि वरंता बढ जाती ह।ै

सम्य प्रबंिन कषे  लार

सम्य प्रबंिन सषे वनमन जसैषे बडषे लार हो सकतषे हैं:

• बषेहति उतपादकता 

• उचर दक्ता

• बषेहति पषेशषेवि प्रवतष्ठा 

• कम तनाव

• कैरि्यि में उननवत की अविक संरावनाएं 

• लक््य प्राप्त किनषे कषे  वलए अविक सषे अविक अवसि

सम्य को प्ररावी ढंर सषे प्रबंवित ना किनषे कषे  वनमन अवां्नी्य परिणाम हो सकतषे हैं:

• सम्य सीमा में काम पिूा ना होना 

• अकुशल का्य्भ  आउटपुट

• काम की रुणवत्ता कम होना 

• खिाब पषेशषेवि प्रवतष्ठा

• कैरि्यि रुक जाता ह ै

• तनाव औि वरंता में ववृद्ध होती है

प्ररावी सम्य प्रबंिकों में सषे कु् लक्ण हैं:

• वषे परि्योजनाओ ंको जलदी शुरू कितषे हैं वषे दवैनक लक््य वनिा्भ रित कितषे हैं

• वषे आवश्यकता अनुसाि, बषेहति परिणाम हावसल किनषे कषे  वलए ्योजनाओ ंको संशोवित कितषे हैं

• वषे लरीलषे औि खुलषे ववरािों वालषे होतषे हैं

• वषे पहलषे ही लोरों को सवूरत कि दषेतषे हैं, ्यवद उनकी मदद की आवश्यकता होरी

• वषे जानतषे हैं वक मना कैसषे वक्या जाता है

• वषे वववशष्ट सम्य सीमा कषे  साथ का्य्भ  को रिणों में बांट लषेतषे हैं

• वषे लराताि लंबी अववि कषे  लक््यों की समीक्ा कितषे िहतषे हैं

• वषे आवश्यकता पडनषे पि वकैवलपक समािान कषे  बािषे  में सोरतषे हैं

• वषे आवश्यकता पडनषे पि मदद मांरतषे हैं। वषे बकैअप ्योजना बनातषे हैं
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10.1.6.2 प्रभािी समय प्रबंधन ्त्कनी्कें

10.1.7 क्रोध प्रबंधन

आप वनवश्चत सम्य प्रबंिन तकनीकों का अभ्यास कि अपनषे सम्य का प्रबंिन वषेहति तिीकषे  सषे कि सकतषे हैं कु् उप्योरी सुझाव हैं:

• रदन ्की योजना ्ेक सा्थ वयिधानों ्की भी योजना बनाएँ। अपनी सम्य ्योजना को समझनषे कषे  वलए अपनषे आप को कम सषे कम 30 वमनट दें। 

अपनी ्योजना में, व्यविानों कषे  वलए कु् सम्य वनिा्भ रित किें ।

• जब आप्को ए्क रनरश्च्त समय में ्काम पूरा ्करना हो ्तो ए्क "्तंग न ्करें  (Do Not Disturb)" सं्ेक्त िगाएं।

• र्कसी भी चीज़ से धयान भंग न होने दें। बजतषे फोनों, रटै संदषेशों का जवाब ना दषेनषे, सामावजक मीवड्या साइटों की अनदषेखी किनषे कषे  वलए अपनषे 

आप को प्रवशवक्त किें ।

• अपने ्काम ्को र्कसी ्को सौंप दें। इससषे ना कषे वल अपना काम तषेज़ी सषे किनषे में मदद वमलषेरी, बवलक इससषे आप को अपनषे आस-पास कषे  अवद्ती्य 

कौशल औि क्मताएं री वदखाई देंरी।

• टािना बनद ्करें । अपनषे आप को ्याद वदलाएं वक ववलंब सामान्यता डि ्या असफलता ्या इस ववश्वास कषे  कािण होता ह ैवक आप काम उस तिीकषे  सषे 

पिूा नहीं कि सकतषे जसैषे आप किना राहतषे थषे।

• प्रा्थरम्क्ता रनधाटिरर्त ्करें । प्रत्यषेक का्य्भ  की तातकावलकता ्या महतव सति कषे  क्रम में पिूा किनषे कषे  अनुसाि सरूी बनाएं। वफि एक-एक किकषे  

प्रत्यषेक का्य्भ  को पिूा किनषे पि ध्यान कें वरित किें ।

• अपने ्काम ्की गर्तरिरधयों ्का ए्क िॉग बना ्कर रखें। अपनी दक्ता औि हि िोज़ वकतना सम्य बबा्भद होता ह ैवनिा्भ रित किनषे में मदद कषे  वलए 

लॉर का ववश्षे ष्ण किें ।

• समय ्की बबाटिदी ्को ्कम ्करने ्ेक रिए समय प्रबंधन ्ेक िक्य वनिा्भ रित किें ।

10.1.6.3 सुझाि 
• हमषेशा पहलषे सबसषे महतवपणू्भ  का्यकों को पिूा किें ।

• हि िोज़ कम सषे कम 7-8 घंटषे की नींद लें।

• अपनषे वदन की शुरुआत जलदी किें ।

• ्ोटषे, महतवहीन ववविण पि बहुत अविक सम्य बबा्भद मत किें ।

• अपनषे वलए रए हि काम कषे  वलए एक सम्य सीमा वनिा्भ रित किें ।

• का्यकों कषे  बीर तनाव को कम किनषे कषे  वलए अपनषे आप को कु् सम्य दें।

क्रोि प्रबंिन एक प्रवक्र्या ह ैवजसमें:

1. ऐसषे संकषे त पहराननषे सीखषे जातषे हैं जो दशा्भतषे हैं वक आप ्या वकसी औि को क्रोि आ िहा है

2. एक सकािातमक तिीकषे  सषे वसथवत को शांत किनषे कषे  वलए सबसषे उवरत काि्भ वाई किें । क्रोि प्रबंिन का अथ्भ क्रोि को दबाना नहीं ह।ै

क्रोध प्रबंधन ्का महति

क्रोि एक पिूी तिह सषे सामान्य मानव रावना ह।ै वासतव में, जब इसषे सही तिीकषे  सषे प्रबंवित वक्या जाता ह,ै तो क्रोि एक सवसथ रावना री बन सकती ह।ै 

लषेवकन, अरि इस पि ध्यान नहीं वद्या जाए, तो क्रोि हमसषे अनुप्ुयक्त का्य्भ  किा सकता ह ैऔि इसकषे  परिणाम सवरूप हम ऐसी बातें कि ्या बोल जातषे हैं 

वजनका हमें बाद में प्तावा होरा।
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10.1.7.1 क्रोध प्रबंधन रणनीर्तयां

चरम सीमा पर क्रोध:

• आप्को शारीरर्क रूप से नुकसान पहंुचा स्क्ता ह:ै इससषे हृद्य िोर, मिुमषेह, प्रवतिक्ा प्रणाली कमज़ोि, अवनरिा, औि उचर िक्तराप हो सकता ह।ै

• आप ्को मानरस्क रूप से नुकसान पहंुचा स्क्ता ह:ै ्यह आपको उलझन में डाल सकता ह ैऔि आपकषे  तनाव, अवसाद औि मानवसक सवास्थ्य 

समस्याओ ंका कािण बन सकता ह।ै

• आप्ेक ्ैकररयर ्को नु्कसान पहंुचा स्क्ता ह:ै इससषे आपकषे  सह्योवर्यों, मावलकों, गाहकों में अलराव की रावना पदैा हो सकती ह ैवजससषे सममान 

में कमी आ सकती ह।ै

• आप्ेक संबंधों ्को नु्कसान पहंुचा स्क्ता ह:ै इससषे आपकषे  परिवाि औि वमत्रों का आप पि रिोसा किना कवठन हो जाता ह,ै अपनषे साथ ईमानदाि 

िहें औि अपनषे आस-पास सहज महससू किें ।

्यही कािण ह ैवक क्रोि प्रबंिन, ्या क्रोि को उवरत रूप सषे प्रबंवित किना इतना महतवपणू्भ  ह।ै

्यहां कु् िणनीवत्यां हैं जो आप को अपनषे क्रोि को वन्ंयवत्रत किनषे में मदद कि सकती हैं:

रणनीर्त 1: रिरिाम

रहिी सांस लषेना औि सुकून दषेनषे वाली तसवीिें  दषेखना क्रोि जसैी रावनाओ ंको शांत किनषे में अदु्त रुप सषे काम किता ह।ै इन सािािण श्वास व्या्यामों 

का अभ्यास किें :

• अपनषे डा्याफ्ाम सषे एक रहिी सांस लें (अपनषे सीनषे सषे सांस ना लें)

• कलपना किें  वक आपकी सांस आपकषे  पषेट सषे ऊपि आ िही है

• 'शांत िहो' ्या 'सब ठीक ह'ै जसैषे शांत किनषे वालषे शबद दोहिातषे िहें (शबद दोहिातषे सम्य रहिी सांस लषेना ्याद िखें)

• एक सुकून वालषे पल की कलपना किें  (्यह आपकी समवृत सषे ्या आपकी अपनी कलपना हो सकती ह)ै

दवैनक रूप सषे इस शांत िहें तकनीक का पालन किें , ववशषेष रूप सषे जब आपको लरषे वक आप को क्रोि आ िहा ह।ै

रणनीर्त 2: संज्ानातम्क पुनगटिठन

संज्ानातमक पुनर्भठन का अथ्भ अपनषे सोरनषे कषे  तिीकषे  को बदलना ह।ै क्रोि आपसषे शाप वदला सकता ह,ै कसम वखला सकता ह,ै अवतिंजन किा सकता 

ह ैऔि बहुत नाटक किवा सकता ह।ै जब ऐसा होता ह,ै तो अपनषे आप को अपनषे क्रोिी ववरािों को तावक्भ क ववरािों कषे  साथ बदलनषे कषे  वलए मज़बिू किें । 

उदाहिण कषे  वलए, 'सब कु् बबा्भद हो र्या ह'ै सोरनषे कषे  बजा्य अपनी मानवसकता बदलें औि अपनषे आप सषे कहें '्यह दुवन्या का अंत नहीं ह ैऔि क्रोि सषे 

कोई समािान नहीं होरा'।

रणनीर्त 3: समसया ्को सुिझाना

वकसी समस्या कषे  वलए क्रोवित होना वजसषे आप वन्ंयवत्रत नहीं कि सकतषे हैं, पिूी तिह सषे सवाराववक प्रवतवक्र्या ह।ै करी-करी, कोवशश किनषे कषे  बाद री, 

पषेश आई समस्या का कोई समािान नहीं हो सकता ह।ै ऐसषे मामलों में, समस्या को सुलझानषे पि ध्यान कें वरित किना बंद कि दें औि इसकषे  बजा्य समस्या 

सषे वनपटनषे औि उसका सामना किनषे पि ध्यान कें वरित किें । अपनषे आप को ्याद वदलाएं वक आप वसथवत सषे वनपटनषे कषे  वलए पिूी कोवशश किें रषे, लषेवकन 

अरि आपको वांव्त समािान नहीं वमलता ह,ै तो आप अपनषे आप को दोष नहीं देंरषे।

रणनीर्त 4: बेह्तर संिाद

जब आप क्रोि में होतषे हैं, तो रलत वनष्कष्भ पि पहंुरना बहुत आसान होता ह।ै इस तिह कषे  मामलषे में, आपको वकसी तिह सव्ंय पि काब ूिखना होरा, वक 

आप कोई प्रवतवक्र्या न दें। कु् री कहनषे सषे पहलषे, ध्यान सषे सोरें वक आप क््या कहना राहतषे हैं। अपनषे जहन में आनषे वाली पहली बात कहनषे सषे बरें। सव्ंय 

को दूसिषे  की बात ध्यान सषे सुननषे कषे  वलए मजबिू किें । वफि जवाब दषेनषे सषे पहलषे बातरीत कषे  बािषे  में सोरें।

रणनीर्त 5: अपना माहौि बदिना

्यवद आपको लरषे वक आपका माहौल आपकषे  क्रोि का कािण ह ैतो कु् सम्य कषे  वलए अपनषे आप को इस माहौल सषे दूि कि लें। अपनषे वलए री थोडा सम्य 

वनकालनषे का सवक्र्य प्र्यास किें , खासतौि सषे बषेहद व्यसत तथा तनावपणू्भ  वदनों में। थोडा सम्य शांवत सषे अकषे लषे में वबतानषे सषे वनवश्चत ही आपको मन शांत 

किनषे में मदद वमलषेरी।
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10.1.7.2 क्रोध प्रबंधन ्ेक रिए सुझाि 
• वनमनवलवखत सुझाव आपको अपनषे क्रोि पि वन्ंयत्रण िखनषे में मदद किें रषे:

• क्रोि में कु् री कहनषे सषे पहलषे अच्ी तिह सषे सोर लें।

• शांत होनषे कषे  बाद अपनषे क्रोि का कािण एक मुखि, लषेवकन रिै झरडाल ूतिीकषे  सषे व्यक्त किें ।

• जब आपको लरषे वक आप क्रोवित हो िहषे हैं तो दौड ्या तषेज़ रलनषे जसैषे शािीरिक व्या्याम किें ।

• ्ोटषे ्ोटषे अंतिालों को अपनी दवैनक वदनर्या्भ  का वहससा बनाएँ ववशषेष रूप सषे तनावपणू्भ  वदनों कषे  दौिान। अपना ध्यान क्रोि पदैा किनषे वाली समस्या 

कषे  समािान पि कें वरित किें , न वक इस बात पि वक समस्या आपको क्रोवित कि िही ह।ै

10.1.8 ्तनाि प्रबंधन

10.1.8.1 ्तनाि ्ेक िक्ण

हम कहतषे हैं, वक हम ‘’तनावगसत’’ हैं, जब हमािषे  ऊपि बहुत ज्यादा काम होतषे हैं औि इनकषे  बोझ सषे जझूनषे की अपनी क्मता कषे  बािषे  में हम वनवश्चत नहीं होतषे। 

ऐसी कोई री रीज़ जो हमािषे  सुख को रुनौती दषेती ह ै्या उसकषे  वलए खतिा ह ैउसषे तनाव कषे  रूप में परिरावषत वक्या जा सकता ह।ै ्यह ध्यान िखना महतवपणू्भ 

ह ै वक तनाव सकािातमक औि नकािातमक दोनों हो सकता ह।ै सकािातमक तनाव हमें आरषे बढनषे की प्रषेिणा दषेता ह,ै जबवक नकािातमक तनाव हमािषे  

मानवसक औि शािीरिक सवास्थ्य को प्रराववत किता ह।ै ्यही कािण ह ैवक इस नकािातमक तनाव को प्ररावी ढंर सषे प्रबंवित किना बहुत महतवपणू्भ ह।ै

्तनाि ्ेक ्कारण

तनाव आंतरिक औि बाह्य कािकों कषे  कािण हो सकता ह।ै

्तनाि ्ेक आं्तरर्क ्कारण:

• लराताि वरंता

• कठोि सोर

• अवासतववक अपषेक्ाएं

• वनिाशावाद

• अपनषे बािषे  में नकािातमक बातें किना

• आि ्या पाि का िव्ैया

्तनाि ्ेक बाहरी ्कारण:

• जीवन कषे  प्रमुख परिवत्भन

• रिशतों में कवठनाइ्याँ

• बहुत काम होना

• काम पि ्या सकूल में कवठनाइ्याँ

• ववत्ती्य कवठनाइ्याँ

• बचरों औि/्या परिवाि कषे  बािषे  में वरंता

तनाव कई तिीकों सषे ज़ावहि हो सकता ह।ै तनाव कषे  संज्ानातमक, रावनातमक, शािीरिक औि व्यावहारिक लक्णों पि एक नज़ि डालें।
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10.1.8.2 ्तनाि प्रबंधन ्ेक रिए सुझाि 

संज्ानातम्क िक्ण भािनातम्क िक्ण

• समवृत समस्याएं

• एकागता मुद्षे

• वनण्भ्य का अराव

• वनिाशावाद

• वरंता

• लराताि वरंता

• अवसाद

• व्याकुलता

• वरडवरडापन

• अकषे लापन

• वरंता

• क्रोि

शारीरर्क िक्ण वयिहारर्क िक्ण

• पीडा औि दद्भ

• दसत ्या कबज़

• जी वमरलाना

• रक्कि आना

• सीनषे में दद्भ  औि/्या तषेजी सषे वदल िडकना

• लराताि ठंड ्या फल ूहोनषे जसैा महससू किना

• रखू अविक ्या कम लरना

• अविक सोना ्या कम सोना

• सामावजक रूप सषे अलर थलर होना

• वजममषेदारि्यों की उपषेक्ा किना

• शिाब ्या वसरिषे ट पीना

• नाखनू रबानषे, तषेज़ रलनषे जसैी बषेरनै आदतें

वनमनवलवखत सुझाव आपको अपनषे तनाव का प्रबंिन बषेहति तिीकषे  सषे किनषे में मदद कि सकतषे हैं:

• ऐसषे अलर-अलर तिीकों को वलख लें वजनसषे आप अपनषे तनाव कषे  वववरनन स्ोतों सषे वनपट सकतषे हैं।

• ्याद िखें वक आप सब कु् वन्ंयवत्रत नहीं कि सकतषे हैं, लषेवकन आप अपनी प्रवतवक्र्या को वन्ंयवत्रत कि सकतषे हैं।

• रुससषे सषे, िक्ातमक ्या वनवष्क्र्य तिीकषे  सषे प्रवतवक्र्या दषेनषे की बजा्य रावनाओ,ं दृवष्टकोणों तथा िािणाओ ंपि ररा्भ  किें ।

• जब री आपको को तनाव महससू हो, तब ध्यान, ्योर ्या ताई री जसैी सुकून दषेनषे वाली तकनीकों का अभ्यास किें ।

• अपनषे वदन का कु् सम्य व्या्याम को दें।

• फलों औि सवबज्यों जसैषे सवसथ आहािों का सषेवन किें । असवास्थ्यकि रोजन ववशषेष रूप सषे रीनी की बडी मात्रा ्ुयक्त आहािों सषे बरें।

• अपनषे वदन को वन्योवजत किें , तावक आप कम तनाव कषे  साथ अपनषे सम्य का बषेहति प्रबंिन कि सकें ।

• आवश्यकता पडनषे पि लोरों औि रीज़ों को न कहना सीखें।

• अपनषे शौक औि रुवर्यों को कु् सम्य दषेनषे कषे  वलए सम्य त्य किें ।

• सुवनवश्चत किें  वक आप कम सषे कम 7-8 घंटषे की नींद लें।

• कैफीन का सषेवन कम किें ।

• अपनषे परिवाि औि दोसतों कषे  साथ अविक सम्य वबताएँ।
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यूरनट 10.2: रिरजटि साक्र्ता: पुनरािरृति

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. कंप्यटूि कषे  बुवन्यादी रारों को पहरननषे में

2. कीबोड्भ  कषे  बुवन्यादी रारों को पहराननषे में

3. कंप्यटूि की बुवन्यादी शबदावली को ्याद िखनषे में

4. कंप्यटूि की बुवन्यादी शबदावली को ्याद िखनषे में

5. कंप्यटूि की बुवन्यादी कंुवज्यों कषे  का्यकों को ्याद िखनषे में

6. MS Office की प्रमुख एपलीकषे शंस पि ररा्भ  किनषे में

7. Microsoft Outlook कषे  लारों पि ररा्भ  किनषे में

8. ई-कॉमस्भ कषे  वववरनन प्रकािों पि ररा्भ  किनषे में

9. खुदिा ववक्रषे ताओ ंऔि गाहकों कषे  वलए ई-कॉमस्भ कषे  लारों की सरूी बनानषे में

10. ररा्भ  किनषे में, वक वडवजटल इंवड्या अवर्यान सषे राित में ई-कॉमस्भ को कैसषे बढावा वमलषेरा

11. वण्भन किनषे में, वक आप ई-कॉमस्भ पलषेटफाम्भ  पि एक उतपाद ्या सषेवा कैसषे बषेरेंरषे

यूरनट ्ेक उद्ेशय 

10.2.1 ्ंक्पयूटर और इंटरनेट ्ेक बारे में बुरनयादी बा्तें

तित्र 10.2.1: कंपयूटर के भाग

तित्र 10.2.2: कीबोिटि के भाग
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10.2.1.1 ्ंक्पयूटर ्ेक बुरनयादी भाग

10.2.1.2 बुरनयादी इंटरनेट शबद

10.2.1.3 बुरनयादी ्ंक्पयूटर ्ंुकरजयाँ

1. Central Processing Unit (CPU): कंप्यटूि का मवसतष्क। ्यह प्रोगाम कषे  वनददेशों को समझता ह ैऔि उनहें अंजाम दषेता ह।ै

2. हािटि ड्ाइि:  एक वडवाइस जो बडी मात्रा में डषेटा संगवहत किती ह।ै

3. मॉरनटर: एक वडवाइस वजसमें कंप्यटूि सक्रीन शावमल होती ह ैजहां सरूना दृवष्टरत रूप सषे प्रदवश्भत होती ह।ै

4. िेस्कटॉप: ऑपिषे वटंर वससटम लोड होनषे कषे  बाद प्रदवश्भत होनषे वाली पहली सक्रीन।

5. ब्ैकरिाउंि: एक ्वव जो डषेसकटॉप कषे  बकैगाउंड में होती ह।ै

6. माउस: एक हैंड-हषेलड वडवाइस जो मॉवनटि पि आइटम की ओि संकषे त किनषे कषे  वलए इसतषेमाल होती ह।ै

7. सपी्कर: एक वडवाइस जो आपको कंप्यटूि सषे आवाज सुननषे में सक्म बनाती ह।ै

8. रपं्रटर: एक वडवाइस जो एक कंप्यटूि कषे  आउटपुट को कारज़ों पि वप्रनट किकषे  वनकालता ह।ै

9. आइ्कॉन: एक ्ोटी सी तसवीि ्या ्वव जो आपकषे  कंप्यटूि पि वकसी प्रोगाम, सॉफ़टवषे्यि अथवा फंक्शन इत्यावद का वरनह होती ह।ै

10. ्कसटिर: एक तीि जो इंवरत किता ह ैवक आप सक्रीन पि कहाँ हैं।

11. प्रोरिाम मनैयू: आपकषे  कंप्यटूि पि प्रोगामों की सरूी वजसषे सटाट्भ  मनै्य ूसषे उप्योर वक्या जा सकता ह।ै

12. टास्कबार: कंप्यटूि सक्रीन कषे  तल पि एक हॉरिज़ॉनटल बाि जो वत्भमान में प्र्योर की जा िही एपलीकषे शंस को सरूीबद्ध किता ह।ै

13. ररसाइ्कि रबन: वडलीट की रई फाइलों कषे  वलए एक असथा्यी रंडािण।

• इंटरनेट: कंप्यटूि नषेटवक्भ  का एक व्यापक, अंतिा्भष्ट्ी्य संगह जो जानकािी हसतांतरित किता ह।ै

• िलिटि िाइि िेब: एक प्रणाली जो आपको इंटिनषेट पि जानकािी एक्सषेस किनषे दषेती ह।ै

• िेबसाइट: वलड्भ  वाइड वषेब (औि इंटिनषेट) पि एक सथान वजसमें वकसी वववशष्ट ववष्य कषे  बािषे  में जानकािी होती ह।ै

• होम पेज: एक वषेबसाइट कषे  बािषे  में जानकािी प्रदान किता ह ैऔि आपको वषेबसाइट कषे  अन्य पषृ्ठों कषे  वलए वनददेश दषेता ह।ै

• रिं्क/हाइपररिं्क: एक हाइलाइटषेड ्या िषे खांवकत आइकॉन, गावफक, ्या टकै्सट जो आप को वकसी अन्य फाइल ्या वसतु पि लषे जाता ह।ै

• िेब एड्ेस/ URL: एक वषेबसाइट कषे  वलए पता।

• एड्ेस बॉकस: रिाउज़ि ववंडो में एक बॉक्स जहाँ आप एक वषेब एड्षेस वलख कि सकतषे हैं।

• ऐरो ्कीज़: इन कंुवज्यों को अपनषे कस्भि को सथानांतरित किनषे कषे  वलए दबाएँ।

• सपेस बार: एक खाली जरह सवममवलत हो जाती ह।ै

• एंटर/ररटनटि: आपकषे  कस्भि को नई लाइन पि लषे जाता ह।ै

• रशफट: ्यवद आप कोई बडा (कैवपटल) अक्ि ्या एक कंुजी का ऊपि वाला वरनह टाइप किना राहतषे हैं तो इस कंुजी को दबाएँ।

• ्ैक्पस िॉ्क: ्यवद आप राहतषे हैं वक सरी अक्ि जो आप टाइप कितषे हैं वषे कैवपटल अक्िों में हो तो इस कंुजी को दबाएँ। वावपस ्ोटषे अक्िों को टाइप 

किनषे कषे  वलए इसषे वफि सषे दबाएँ।

• ब्ैकसपेस: आपकषे  कस्भि कषे  बाई ंओि सब कु् वमटा दषेता ह।ै
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10.2.1.4 सुझाि 

10.2.2.1 सुझाि 

• जब .com पतषे पि जाएं, तो http:// ्या www री टाइप किनषे की कोई ज़रूित नहीं ह।ै कषे वल वषेबसाइट का नाम टाइप किें  औि उसकषे  बाद Ctrl + Enter 

दबाएँ। (उदाहिण: www.apple.com पि जानषे कषे  वलए टाइप किें  'appleapple' औि वफि Ctrl + Enter दबाएँ)

• शबदों / टकै्सट का आकाि बढानषे ्या घटानषे कषे  वलए Ctrl कंुजी + ्या - को दबाएँ।

• एक वषेब पषृ्ठ को वफि सषे लोड ्या रिफ्षे श किनषे कषे  वलए F5 ्या Ctrl + R दबाएँ।

10.2.2 MS Office और ईमेि
MS Office ्ेक बारे में

MS Office ्या Microsoft Office Microsoft द्ािा ववकवसत कंप्यटूि प्रोगाम का एक सुइट ह।ै हालांवक सरी उप्योरकता्भओ ंकषे  वलए उपलबि ह,ै ्यह ्ात्रों, 

घिषे ल ूउप्योरकता्भओ ंऔि व्यापारिक उप्योरकता्भओ ंकषे  वलए ववशषेष रूप सषे वववरनन संसकिण उपलबि किाता ह।ै सरी प्रोगाम Windows औि Macintosh 

कषे  साथ संरत (कमपवैटबल) में हैं।

सबसे िो्करप्रय ऑरिस उतपाद

सबसषे लोकवप्र्य औि साव्भरौवमक रूप सषे इसतषेमाल वकए जानषे वालषे MS Office एपलीकषे शंस में सषे कु् हैं:

1. Microsoft Word: इससषे वकसी डॉक््यमूेंट में टाइप वक्या जा सकता ह ैऔि इमषेज री डाली जा सकती हैं।

2. Microsoft Excel: उप्योरकता्भ  एक सप्रषेडशीट में डषेटा दज्भ कि सकतषे हैं, रणना कि सकतषे हैं औि गाफ बना सकतषे हैं।

3. Microsoft PowerPoint: इसमें वलखा जा सकता ह,ै तसवीिें  तथा मीवड्या डाला जा सकता ह ैऔि सलाइड शो औि प्रजै़ेंटषेशन बनाई जा सकती ह।ै

4. Microsoft Outlook: इसकषे  ज़रि्यषे ईमषेल रषेजी तथा रिसीव की जा सकती हैं।

5. Microsoft OneNote: इससषे आप वबलकुल कारज़ औि पषेन कषे  अहसास कषे  साथ नोट्स औि ड्ॉइंगस बना सकतषे हैं।

6. Microsoft Access: इसकषे  ज़रि्यषे आप कई सािवण्यों (टषेबल) में डषेटा संगवहत कि सकतषे हैं।

Microsoft Outlook कयों चुनें

एक लोकवप्र्य ईमषेल प्रबंिन ववकलप ववशषेष रूप सषे का्या्भल्यों में, Microsoft Outlook में एड्षेस बुक, नोटबुक, वषेब रिाउज़ि औि कैलेंडि री शावमल हैं। इस 

प्रोगाम कषे  कु् प्रमुख लार इस प्रकाि हैं:

• ए्की्ृक्त खोज प्रोरिाम: आप सरी Outlook प्रोगामों में डषेटा की खोज किनषे कषे  वलए कीवड््भस का उप्योर कि सकतषे हैं।

• अरध्क सुरक्ा: आपका ईमषेल हकैस्भ, जंक मषेल औि वफवशंर वषेबसाइट ईमषेल सषे सुिवक्त ह।ै

• ईमेि रसंर्ंकग: आपकषे  मषेल को आपकषे  कैलेंडि, कॉनटकै्ट वलसट, One Note कषे  नोट औि आपकषे  फोन कषे  साथ वसंक किता ह।ै

• ईमेि ्का ऑििाइन उपयोग: इंटिनषेट नहीं ह?ै कोई बात नहीं! ईमषेल ऑफलाइन वलखें औि कनषेक्ट होनषे पि उनहें रषेजें।

• ईमषेल का जवाब दषेनषे कषे  वलए एक शॉट्भकट वववि कषे  रूप में Ctrl + R दबाएँ।

• कषे वल बहुत महतवपणू्भ  ईमषेल कषे  वलए अपनी डषेसकटॉप नोवटवफकषे शन सषेट किें ।

• संदषेशों का र्यन किें  औि Insert key दबाकि, जलदी सषे मसैषेज फ़लरै किें ।

• बाि-बाि रषेजी जानषे वाली ईमषेलस पुन:उप्योर किनषे कषे  वलए एक टषेमपलषेट कषे  रूप में सषेव किें ।

• सुवविाजनक रूप सषे महतवपणू्भ  ईमषेलस को फाइलों कषे  रूप में सषेव किें ।
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10.2.3 ई-्कॉमसटि

10.2.3.1 ई-्कॉमसटि ्ेक िाभ

ई-्कॉमसटि कया है

ई-कॉमस्भ इलषेक्ट्ॉवनक रूप में इंटिनषेट पि सामान औि सषेवाएँ बषेरना ्या खिीदना ह ै्या पसैषे ्या डषेटा का हसतांतिण ह।ै ई-कॉमस्भ "इलषेक्ट्ॉवनक कॉमस्भ" का 

संवक्प्त रूप ह।ै

ई-्कॉमसटि ्ेक उदाहरण:

• ऑनलाइन शॉवपंर ऑनलाइन नीलामी

• ऑनलाइन वटकषे वटंर

• इलषेक्ट्ॉवनक रुरतान

• इंटिनषेट बैंवकंर

ई-्कॉमसटि ्ेक प्र्कार

ई-कॉमस्भ को लषेनदषेन में प्रवतरावर्यों कषे  प्रकाि कषे  आिाि पि वरशीकृत वक्या जा सकता ह।ै ई-कॉमस्भ कषे  मुख्य प्रकाि हैं:

• वयापार से वयापार (B2B): लषेनदषेन किनषे वालषे दोनों पक् व्यापाि हैं।

• उपभोतिा से वयापार (B2C): व्यवसा्य इलषेक्ट्ॉवनक रूप सषे उपरोक्ताओ ंको वसतु ्या सषेवाएं बषेरतषे हैं।

• उपभोतिा से उपभोतिा (C2C): उपरोक्ता वसतुएँ खिीद अथवा बषेरकि दूसिषे  उपरोक्ताओ ंकषे  साथ कािोबाि कितषे हैं।

• उपभोतिा से वयापार (C2B): उपरोक्ता उतपादों ्या सषेवाओ ंका वनमा्भण कितषे हैं जो ऐसी कंपवन्यों कषे  वलए उपलबि होतषे हैं वजनहें वबलकुल वसैषे ही 

उतपाद औि सषेवाएं रावहए।

• वयापार से प्रशासन (B2A): कंपवन्यों औि लोक प्रशासन कषे  बीर होनषे वालषे ऑनलाइन लषेनदषेन।

• उपभोतिा से प्रशासन (C2A): व्यवक्त्यों औि लोक प्रशासन कषे  बीर होनषे वालषे ऑनलाइन लषेनदषेन।

ई-कॉमस्भ व्यापाि खुदिा ववक्रषे ताओ ंऔि गाहकों को कु् लार प्रदान किता ह।ै

खुदरा रिके्र्ताओ ं्ेक रिए िाभ:

• ऑनलाइन उपवसथवत सथावपत किता है

• ऊपिी लारत को हटाकि परिरालन लारत कम कि दषेता है

• अच ष्े  कीवड््भस कषे  उप्योर कषे  माध्यम सषे रिांड जाररूकता बढ जाती है

• रौरोवलक दूरि्यों तथा सम्य की कमी जसैी बािाओ ंको दूि किकषे  वबक्री में बढोत्तिी होती ह।ै

रिाह्कों ्ेक रिए िाभ:

• वकसी री वासतववक दुकान सषे कहीं अविक व्यापक िें ज प्रदान किता है

• दूिसथ सथानों सषे वसतुओ ंऔि सषेवाओ ंकी खिीद सक्म बनाता है

• उपरोक्ताओ ंको मूल्य की तुलना किनषे में सक्म बनाता है
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10.2.3.2 रिरजटि इंरिया अरभयान

प्रिानमंत्री निें रि मोदी नषे हि नाररिक को वडवजटल सषेवाओ,ं ज्ान औि जानकािी तक पठै/पहँुर प्रदान किनषे कषे  उद्षेश्य सषे 2015 में वडवजटल इंवड्या 

अवर्यान का शुरािंर वक्या। अवर्यान का उद्षेश्य दषेश कषे  ऑनलाइन बुवन्यादी ढांरषे में सुिाि किना औि इंटिनषेट कनषेवक्टववटी बढाना ह,ै इस प्रकाि 

ई-कॉमस्भ उद्ोर को बढावा वमलषेरा।

वत्भमान में, अविकति ऑनलाइन लषेनदषेन वट्यि 2 औि वट्यि 3 शहिों सषे होतषे हैं। एक बाि वडवजटल इंवड्या अवर्यान सथावपत होनषे कषे  बाद, सिकाि मोबाइल 

कनषेवक्टववटी कषे  माध्यम सषे सषेवाएं प्रदान किषे री, वजससषे दषेश कषे  सुदूि कोनों तक इंटिनषेट पहँुरानषे में मदद वमलषेरी। इससषे ई-कॉमस्भ बाजाि को राित कषे  

टी्यि 4 शहिों औि गामीण क्षेत्रों में प्रवषेश किनषे में मदद वमलषेरी।

ई-्कॉमसटि गर्तरिरध

एक उतपाद ्या सषेवा रुनें वजसषे आप ऑनलाइन बषेरना राहतषे हैं। आप मौजदूा ई-कॉमस्भ पलषेटफॉम्भ  का उप्योर कैसषे किें रषे इसकी व्याख्या कितषे हुए एक 

संवक्प्त नोट वलखें, ्या अपनषे उतपाद ्या सषेवाएं बषेरनषे कषे  वलए न्या ई-कॉमस्भ पलषेटफॉम्भ  बनाएँ।

10.2.3.3 सुझाि 

• अपना ई-कॉमस्भ पलषेटफॉम्भ  शुरू किनषे सषे पहलषे, सब कु् जांर लें।

• अपनषे सोवश्यल मीवड्या पि व्यवक्तरत रूप सषे किीब सषे ध्यान दें।
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यूरनट 10.3: पसैे ्का महति

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. पसैषे बरानषे कषे  महतव पि ररा्भ  कि सकें रषे

2. पसैषे बरानषे कषे  लारों पि ररा्भ  कि सकें रषे

3. बैंक खातों कषे  प्रमुख प्रकािों पि ररा्भ  कि सकें रषे

4. बैंक में खाता खोलनषे की प्रवक्र्या का वण्भन किनषे में

5. सथाई औि परिवतशी लारत कषे  बीर अंति सपष्ट कि सकें रषे

6. वनवषेश ववकलपों कषे  प्रमुख प्रकािों का वण्भन कि सकें रषे

7. बीमा उतपादों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

8. किों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

9. ऑनलाइन बैंवकंर कषे  उप्योरों पि ररा्भ  कि सकें रषे

10. इलषेक्ट्ॉवनक िन हसतांतिण कषे  प्रमुख प्रकािों पि ररा्भ  कि सकें रषे

यूरनट ्ेक उद्ेशय 

10.3.1 वयरतिग्त रिति – बच्त कयों ्करें

बच्त ्ेक महति

हम सरी जानतषे हैं वक रववष््य अप्रत्यावशत ह।ै आप नहीं जानतषे वक कल, अरलषे सप्ताह ्या अरलषे साल क््या होरा। ्यही कािण ह ैवक साल दि साल पसैषे की 

बरत महतवपणू्भ  होती ह।ै पसैा बरानषे सषे, आपको सम्य कषे  साथ अपनी ववत्ती्य वसथवत में सुिाि लानषे में मदद वमलषेरी। लषेवकन अविक महतवपणू्भ  बात ह,ै  

वक आपात वसथवत कषे  वलए पसैषे संराल कि िखनषे सषे आपको मन की शांवत वमलषेरी। पसैषे बरानषे सषे कई औि अविक ववकलपों औि संरावनाओ ंकषे  दिवाजषे 

खुलतषे हैं।

बच्त ्करने ्ेक िाभ

बरत की आदत डालनषे सषे कई लार हो सकतषे हैं। बरत किनषे सषे आप को वनमन में मदद वमलती ह:ै

• आर्थटि्क रूप से सि्तंत्र बनने में: जब आपकषे  सव्ंय को ववत्ती्य दृवष्ट सषे सुिवक्त महससू किानषे कषे  वलए प्या्भप्त पसैा हो, तो आप ्ुरट््यों पि जानषे सषे 

लषेकि, करि्यि बदलनषे तथा अपना कािोबाि शुरु किनषे तक कोई री मनराहा फैसला लषे सकतषे हैं।

• रशक्ा ्ेक माधयम से सियं पर रनिेश ्करें : बरत कषे  माध्यम सषे, आप पाठ््यक्रमों का रुरतान किनषे कषे  वलए प्या्भप्त कमा सकतषे हैं जो आपकषे  पषेशषेवि 

अनुरव में जुड जाएरा औि अंत में बषेहति वषेतन दषेनषे वाली नौकरि्यां वमल जाएंरी।

• ्कजटि मुति हो जाएं: एक बाि आिवक्त फंड कषे  रूप में प्या्भप्त बरानषे कषे  बाद, आप अपनी बरत का उप्योर ऋण ्या वबलों जसैषे कज्भ का रुरतान किनषे 

कषे  वलए कि सकतषे हैं, जो सम्य कषे  साथ संवरत हो जातषे हैं।

• अप्रतयारश्त खचषों ्ेक रिए ्तयैार रहें: बरत होनषे सषे आप आवथ्भक रूप सषे वबना तनाव महससू वकए अरानक आनषे वालषे काि ्या घि की मिममत जसैषे 

अप्रत्यावशत खरकों कषे  वलए रुरतान किनषे में सक्म होतषे हैं।

• आपा्त रस्थर्त ्ेक रिए भुग्तान ्करें : बरत आपको आवथ्भक रूप सषे बोवझल महससू वकए वबना अरानक आई सवास्थ्य समस्याओ ं्या ततकाल 

्यात्राओ ंजसैी आपातवसथवत्यों सषे वनपटनषे में मदद किती ह।ै

• बड़ी खरीद ्करने ्का साम््थटि य और प्रमुख िक्य प्राप्त ्करना: लरन सषे बरत किना घि ्या एक काि खिीदनषे जसैी बडी खिीद औि लक््यों कषे  वलए 

रुरतान किना संरव बनाता ह।ै
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• सेिामुति होना: जब आपकषे  पास अपनी नौकिी सषे प्राप्त होनषे वाली आ्य नहीं होरी, तब आपकषे  द्ािा सम्य कषे  साथ बराए रए पसैषे आपको  

आिाम देंरषे।

10.3.1.1 सुझाि 
• अपनी खर्भ किनषे की आदत को कम किें । प्रवत सप्ताह एक महंरी आइटम पि खर्भ नहीं किनषे की कोवशश किें  औि उस पसैषे को अपनी बरत में डालें 

वजसषे अन्यथा आपनषे खर्भ कि वद्या होता।

• त्य किें  वक आप वनवश्चत वदनों ्या हफतों पि कु् री नहीं खिीदेंरषे औि अपनषे वनश्च्य पि अवडर िहेंरषे।

10.3.2 बैं्क खा्तों ्ेक प्र्कार

राित में बैंक राि मुख्य प्रकाि कषे  बैंक खातों की पषेशकश कितषे हैं। ्यषे हैं:

1. राल ूखातषे

2. बरत खातषे

3. आवतशी जमा खातषे

4. साववि जमा खातषे

चािू खा्ते

राल ूखातषे सबसषे अविक रिव्य/तिल जमा की पषेशकश कितषे हैं औि इस प्रकाि, व्यापारि्यों औि कंपवन्यों कषे  वलए सबसषे अनुकूल हैं। क््योंवक ्यह खातषे 

वनवषेश औि बरत कषे  वलए नहीं बनषे हैं, इसवलए एक वदन में वकए जानषे वालषे लषेनदषेन की संख्या ्या िावश पि कोई सीमा नहीं लराई रई ह।ै राल ूखाता िािकों 

को अपनषे खातों में िखी िावश पि कोई ब्याज नहीं दषेता ह।ै उनसषे इस तिह कषे  खातों पि ऑफि की जानषे वाली कु् सषेवाओ ंकषे  वलए शुलक वल्या जाता ह।ै

बच्त खा्ते

बरत खातषे बरत को बढावा दषेनषे कषे  वलए होतषे हैं औि इसवलए वषेतनरोरी व्यवक्त्यों, पेंशनिों औि ्ात्रों कषे  वलए नंबि एक पसंद हैं। हालांवक जमा की िावश 

औि संख्या पि कोई प्रवतबंि नहीं ह,ै वफि री सामन्यता वनकासी की िावश औि संख्या पि प्रवतबंि होतषे हैं। बरत खाता िािकों को अपनी बरत पि ब्याज़ 

वद्या जाता ह।ै

आि्तकी जमा खा्ते

आवतशी जमा खातों को RD खातषे री कहा जाता ह,ै जो उन लोरों कषे  वलए होतषे हैं जो हि महीनषे एक िावश बराना राहतषे हैं, लषेवकन एक बाि में एक बडी िावश 

वनवषेश किनषे में असमथ्भ हैं। इस तिह कषे  खाता िािक पवू्भ  वनिा्भ रित अववि (कम सषे कम 6 महीनषे) कषे  वलए एक ्ोटी, वनवश्चत िावश हि महीनषे जमा कितषे 

हैं। मावसक रुरतान में दषेिी होनषे पि खाता िािक सषे एक दंड िावश ली जाती ह।ै कुल िावश वनिा्भ रित अववि कषे  अंत में ब्याज कषे  साथ लौटा दी जाती ह।ै

सािरध जमा खा्ते

साववि जमा खातों को FD खातषे री कहा जाता ह,ै ्यषे उन लोरों कषे  वलए आदश्भ हैं जो ब्याज की एक उचर दि कषे  बदलषे में लंबषे सम्य कषे  वलए अपनी  

बरत जमा किना राहतषे हैं। ब्याज दि की पषेशकश जमा िावश औि सम्य अववि पि वनर्भि किती ह ैऔि ्यह हि बैंक में अलर-अलर होती ह।ै FD कषे  मामलषे 

में, खाता िािक द्ािा एक वनवश्चत िावश वनवश्चत सम्य अववि कषे  वलए जमा की जाती ह।ै जब अववि समाप्त हो जाती ह ैतो पसैा वापस वल्या जा सकता ह।ै 

्यवद आवश्यक हो, तो जमाकता्भ  सम्य सषे पहलषे साववि जमा तोड सकतषे हैं। बहिहाल, इससषे सामान्यता एक दंड िावश लरती ह ैजो हि बैंक में अलर-अलर 

होती ह।ै
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10.3.2.2 सुझाि 

10.3.2.1 बैं्क में खा्ता खोिना
बैंक में खाता खोलना काफी सिल प्रवक्र्या ह।ै अपना खुद का एक खाता खोलनषे कषे  वलए वनमन रिणों पि एक नज़ि डालें:

चरण 1: खा्ता खोिने िािा िॉमटि भरें
इस फॉम्भ  में आप को वनमनवलवखत जानकािी प्रदान किनी होरी:

• व्यवक्तरत ववविण (नाम, पता, फोन नंबि, जनम वतवथ, वलंर, व्यवसा्य, पता)

• अपनषे खातषे का ववविण प्राप्त किनषे की वववि (हाड्भ  कॉपी/ईमषेल)

• अपनषे आिंवरक जमा का ववविण (नकद/रकै)

• खातषे कषे  संरालन का तिीका (ऑनलाइन/मोबाइल बैंवकंर/पािंपरिक रकै कषे  माध्यम सषे, वसलप बुक्स) सुवनवश्चत किें  वक आप नषे हि आवश्यक जरह 

पि हसताक्ि वकए हैं।

चरण 2: अपनी ्तसिीर िगाएँ
फॉम्भ  पि दी रई जरह में अपनी हाल ही की फोटोगाफ वरपकाएं।

चरण 3: अपना, अपने रिाह्क ्को जारनए (KYC) रििरण प्रदान ्करें
KYC एक प्रवक्र्या ह ैजो बैंकों को अपनषे गाहकों कषे  पतषे औि उनकी पहरान की पुवष्ट किनषे में मदद किती ह।ै एक खाता खोलनषे कषे  वलए, हि व्यवक्त को 

फोटो पहरान (ID) औि पतषे कषे  प्रमाण कषे  संबंि में कु् अनुमोवदत दसतावषेज प्रसतुत किनषे होतषे हैं।। कु् आविकारिक विै दसतावषेज़ (OVDs) हैं:

• पासपोट्भ

• ड्ाइववंर लाइसेंस

• मतदाता पहरान पत्र

• पनै काड्भ

• UIDAI (आिाि) काड्भ

चरण 4: अपने सभी दस्तािेज़ जमा ्करें
खाता खोलनषे का रिा हुआ फॉम्भ  औि KYC दसतावषेज़ जमा किें । वफि फॉम्भ  पि काि्भ वाई होनषे औि आपका खाता खुलनषे तक प्रतीक्ा किें !

• उप्ुयक्त खाता रुनें।

• नामांकन की पिूी जानकािी रिें ।

• शुलकों कषे  बािषे  में पू् ें ।

• वन्यमों को समझें।

• ऑनलाइन बैंवकंर कषे  बािषे  में पू् ें  - ्यह सुवविाजनक ह!ै

• अपनषे बैंक बलैेंस पि नज़ि िखें।
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10.3.3 िाग्तें: स्थाई बनाम पररि्तकी

10.3.4 रनिेश, बीमा ि ्कर

स्थाई ि पररि्तकी िाग्तें कया हैं

• सथाई व परिवतशी लारत वमलकि वकसी कंपनी की कुल लारत बनती ह।ै वसतुओ ंव सषेवाओ ंका उतपादन कितषे हुए कमपनी को ्यषे दो प्रकाि कषे  मूल्य 

वहन किनषे पडतषे हैं।

• सथाई लारत वकसी कंपनी द्ािा उतपावदत वसतुओ ंव सषेवाओ ंकी मात्रा कषे  साथ बदलती नहीं ह।ै ्यह हमषेशा समान िहती ह।ै

• दूसिी ओि, परिवतशी लारत, उतपावदत वसतुओ ंव सषेवाओ ंकी मात्रा कषे  अनुसाि घटती व बढती िहती ह।ै दूसिषे  शबदों में, ्यह उतपावदत मात्रा कषे  अनुसाि 

बदलती िहती ह।ै

स्थाई ि पररि्तकी िाग्तों ्ेक बीच अं्तर

आइए सथाई व परिवतशी लारतों कषे  बीर प्रमुख अतंिों पि नज़ि डालें:

्कसौटी स्थाई िाग्त पररि्तकी िाग्त

अथ्भ लारत समान िहती ह,ै राहषे उतपादन की मात्रा 

वकतनी री क््यों न हो।

ऐसी लारत जो वनमनानुसाि बदलती िहती है

प्रकृवत सम्य समबंवित मात्रा समबंवित

व्य्य / खर्भ व्य्य पि उतपावदत ्यवूनट्स की मात्रा सषे कोई 

फक्भ  नहीं पडता।

्यवूनट्स का उतपादन वक्यषे जानषे पि ही व्य्य होता ह।ै

्यवूनट लारत उतपावदत ्यवूनट्स की संख्या कषे  व्ुयतक्रमानुपाती 

होती है

प्रवत ्यवूनट, समान िहती ह।ै

उदाहिण मूल्य ह्ास, वकिा्या, वषेतन, बीमा, कि आवद उप्योर वक्या र्या मटैीरि्यल, वषेतन, वबक्री पि कमीशन, पवैकंर खर्भ आवद।

10.3.3.1 सुझाि 
• कोई लारत सथाई ह ै्या परिवतशी, ्यह वनिा्भ रित किनषे कषे  वलए वनमन प्रश्न पू् ें : ्यवद कंपनी अपनी उतपादन रवतवववि्याँ िोक दषेती ह,ै तो वकसी वववशष्ट 

लारत में कोई परिवत्भन होरा? ्यवद उत्ति ‘नहीं’ ह,ै तो ्यह सथाई लारत ह।ै ्यवद उत्ति ‘हां’ ह,ै तो संरवतः ्यह परिवतशी लारत ह।ै

रनिेश

वनवषेश का अथ्भ ह ैरववष््य में ववत्ती्य लार कमानषे कषे  उद्धषेश्य सषे आज व्य्य वक्या र्या िन। वनवषेश ववकलपों कषे  प्रमुख प्रकाि वनमनवलवखत हैं:

• बॉनि्स: बॉनड्स साव्भजवनक व वनजी कंपवन्यों द्ािा िन की एक बडी िावश जुटानषे का सािन ह ै- ्यह िावश इतनी बडी होती ह,ै वक इसषे बैंक सषे ऋण 

कषे  रूप में नहीं वल्या जा सकता। ्यषे बॉनड्स (प्रवतज्ापत्र) वफि साव्भजवनक बाज़ाि में जािी वक्यषे जातषे हैं औि ऋणदाताओ ंद्ािा ख़िीदषे जातषे हैं।

• सटॉ्क: सटॉक ्या इवक्वटी कंपवन्यों द्ािा जािी वक्यषे रए शषे्यि होतषे हैं जो आम जनता द्ािा ख़िीदषे जातषे हैं।

• िघु बच्त योजनाएं: लघु बरत ्योजनाएं कम-कम मात्रा में िन की बरत किनषे कषे  सािन हैं। कु् लोकवप्र्य ्योजनाओ ंमें कम्भरािी रववष््य वनवि, 

सुकन्या समवृद्ध ्योजना व िाष्ट्ी्य पेंशन ्योजना शावमल हैं।
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• मयूचुअि िंि: म्यरुूअल फंड पषेशषेवि तिीकषे  सषे प्रबंवित ववत्ती्य सािन हैं, वजनमें वनवषेशकों की ओि सषे वववरनन प्रवतरवूत्यों में िन का वनवषेश वक्या 

जाता ह।ै

• सािरध जमाएँ: वकसी ववत्ती्य संसथान कषे  पास वनिा्भ रित सम्य कषे  वलए वनवश्चत िनिावश जमा किाई जाती ह ैवजससषे िन पि ब्याज वमलता है

• ररयि एसटटे: संपवत्त खिीदनषे कषे  वलए बैंकों सषे ऋण वल्या जाता ह,ै जो इसकषे  बाद वकिा्यषे पि दी जाती ह ै्या बषेर दी जाती ह ैवजसका उद्षेश्य संपवत्त की 

बढी हुई कीमतों पि लार कमाना होता ह।ै

• हेज िंि्स: हषेज फंड्स ववत्ती्य ्यौवरकों औि / ्या साव्भजवनक रूप सषे खिीदी-बषेरी जानषे वाली प्रवतरवूत्यों, दोनों में ही वनवषेश वक्यषे जातषे हैं।

• प्राइिेट इरकिटी: प्राइवषेट इवक्वटी वकसी ऐसी ऑपिषे वटंर कंपनी कषे  शषे्यिों में वनवषेश किना ह,ै जो साव्भजवनक रूप सषे सरूीबद्ध/वलसटषेड नहीं होती औि 

वजसकषे  शषे्यि सटॉक मावक्भ ट में उपलबि नहीं होतषे।

• उद्यम पंूजी (िेंचर ्ैकरपटि): उद्म पूंजी (वेंरि कैवपटल) का अथ्भ ह,ै वकसी उरिती हुई कंपनी में, सटॉक्स कषे  बदलषे, रािी मात्रा में पसैा लराना।

बीमा

बीमा दो तिह का होता ह:ै

1. जीवन बीमा 

2. रिै-जीवन ्या सामान्य बीमा

जीिन बीमा उतपाद

मुख्य जीवन बीमा उतपाद हैं:

1. रनधाटिरर्त अिरध बीमा (टमटि इंशयोरें स): ्यह बीमा का सबसषे सिल व ससता प्रारूप ह।ै ्यह वनिा्भ रित अववि, जसैषे 15 सषे 20 वष्भ  कषे  वलए ववत्ती्य सुिक्ा 

उपलबि किाता ह।ै मतृ्ुय होनषे की वसथवत में, आपकषे  परिवाि को बीवमत िावश का रुरतान वक्या जाता ह।ै ्यवद बीमाकता्भ  वनिा्भ रित अववि तक जीववत 

िहता ह,ै तो उसषे वकसी तिह का रुरतान नहीं किना पडता।

2. एंिोमेंट पॉरिसी: ्यह बीमा व वनवषेश कषे  दोहिषे  फा्यदषे दषेती ह।ै प्रीवम्यम का कु् वहससा बीवमत िावश में आबंवटत वक्या जाता ह ैजबवक शषेष प्रीवम्यम 

का वनवषेश इवक्वटी व डषेबट में वक्या जाता ह।ै इसमें वनिा्भ रित अववि कषे  बाद ्या बीमा िािक की मतृ्ुय जो री पहलषे हो, होनषे पि एकमुशत िावश का 

रुरतान वक्या जाता ह।ै

3. यूरनट-रिंकि इंशयोरें स ्पिान (ULIP): इसमें प्रीवम्यम का कु् वहससा जीवन बीमा पि खर्भ वक्या जाता ह,ै जबवक शषेष वहससषे का वनवषेश इवक्वटी व 

डॅब् ट में कि वद्या जाता ह।ै इससषे वन्यवमत बरत की आदत ववकवसत होती ह।ै

4. मनी ब्ैक जीिन बीमा: पॉवलसी अववि कषे  दौिान, पॉवलसीिािक कषे  जीववत िहनषे पि आंवशक उत्तिजीववता लारों का आवविक रुरतान वक्या जाता 

ह।ै बीमािािक की मतृ्ुय होनषे पि, कंपनी उत्तिजीववता लारों कषे  साथ पिूी बीवमत िावश का रुरतान किती ह।ै

5. पूणटि जीिन बीमा: ्यह बीमा तथा वनवषेश कषे  दोहिषे  लार दषेता ह ै्यह व्यवक्त कषे  पिूषे  जीवन ्या 100 वष्भ  की उम्र, जो री पहलषे हो तक बीमा कवि उपलबि 

किता ह।ै

सामानय बीमा (जनरि इंशयोरें स)

सामान्य बीमा (जनिल इंश्योिें स) कषे  अनतर्भत सरी इंश्योिें स कवि वाली समपवत्त्यों, जसैषे पशु, खषेती की फसलों, वसतुओ,ं कािखानों, कािों आवद का बीमा 

वक्या जाता ह।ै

सामान्य बीमा उतपाद:

1. मोटर बीमा: इसषे रौपवह्या वाहन बीमा व दुपवह्या वाहन बीमा में बांटा जा सकता ह।ै

2. सिास्थय बीमा: सवास्थ्य बीमा कषे  प्रमुख प्रकािों में व्यवक्तरत सवास्थ्य बीमा, फैवमली फलोटि सवास्थ्य बीमा, समग सवास्थ्य बीमा व रंरीि बीमािी 

बीमा शावमल होतषे हैं।

3. यात्रा बीमा: इसषे व्यवक्तरत ट्षेवल पॉवलसी, फैवमली ट्षेवल पॉवलसी, सटूडेंट ट्षेवल इंश्योिें स व सीवन्यि वसवटज़न हषेलथ इंश्योिें स में वरशीकृत वक्या जा 

सकता ह।ै



307306

प्रतिभागी पुत्िका

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

4. गहृ बीमा: ्यह मकान व सामान को जोवखम सषे सुिक्ा प्रदान किता ह।ै

5. समुरिी बीमा (मेरीन इंशयोरैंस): ्यह बीमा िषे ल, सडक, समुरि ्या वा्ुय मार्भ  सषे आवारमन कषे  दौिान वसतुओ,ं माल, कारपो आवद कषे  रुम हो जानषे अथवा 

क्वतगसत हो जानषे की वसथवत में ववत्ती्य सुिक्ा प्रदान किता ह।ै

्कर (टकैस)

कि (टकै्स) दो प्रकाि कषे  होतषे हैं: 

1. प्रत्यक् कि 

2. अप्रत्यक् कि

प्रतयक् ्कर

प्रत्यक् कि वकसी ्यवूनट ्या व्यवक्त पि प्रत्यक् रूप सषे लरा्यषे जातषे हैं औि ्यषे अहसतांतिणी्य होतषे हैं। प्रत्यक् किों कषे  कु् उदाहिण हैं:

• आय ्कर: ्यह कि एक ववत्ती्य वष्भ  कषे  दौिान आपकी आ्य पि लरा्या जाता ह।ै ्यह व्यवक्त्यों व कंपवन्यों, दोनों पि लार ूहोता ह।ै

• पंूजी िाभ ्कर: जब री आपको एक बडी मात्रा में िन वमलता ह,ै तो ्यह कि लार ूहोता ह।ै  आमतौि पि ्यह दो प्रकाि का होता ह ै- 36 महीनों सषे कम 

कषे  वलए वक्यषे रए वनवषेश पि होनषे वाला अलपाववि पूंजी लार व 36 महीनों सषे अविक की अववि कषे  वलए वक्यषे रए वनवषेश पि होनषे वाला दीघ्भकावलक 

पूंजी लार।

• प्रर्तभूर्त िने-दने ्कर: ्यह कि शषे्यि कषे  मूल्य में जोड वद्या जाता ह।ै हि बाि शषे्यि बषेरतषे ्या खिीदतषे सम्य ्यह कि लरता ह।ै

• अनुिाभ ्कर: ्यह कि कंपनी द्ािा उपावज्भत रत्तों ्या कम्भरारि्यों द्ािा उप्योर वक्यषे रए रत्तों पि लरता ह।ै

• ्कॉपथोरेट ्कर: कंपवन्यों द्ािा अवज्भत िाजसव पि कॉपपोिषे ट कि वद्या जाता ह।ै

अप्रतयक् ्कर

अप्रत्यक् कि वसतुओ ं्या सषेवाओ ंपि लरा्यषे जातषे हैं। अप्रत्यक् किों कषे  कु् उदाहिण हैं:

• रबक्री ्कर: वबक्री कि वकसी उतपाद की वबक्री पि लरा्या जाता ह।ै

• सेिा ्कर: सषेवा कि राित में उपलबि किाई जानषे वाली सषेवाओ ंपि लरा्या जाता ह।ै

• मूलय-िरदटि्त ्कर: मूल्य- ववद्ध्भत कि का वनण्भ्य िाज्य सिकाि द्ािा वल्या जाता ह ै्यह कि िाज्य में बषेरीं जानषे वाली वसतुओ ंपि लरा्या जाता ह।ै कि 

की िावश का वनिा्भिण िाज्य द्ािा वक्या जाता ह।ै

• ्कसटम शुल्क ि चुंगी: कसटम शुलक ऐसा शुलक ह ैजो वकसी अन्य दषेश सषे आ्यात कि खिीदी रई वसतुओ ंपि लरा्या जाता ह।ै रंुरी उन वसतुओ ंपि 

लरती ह ैजो राित में ही एक िाज्य सषे दूसिषे  िाज्य में लषे जाई जाती हैं।

• उतपाद शुल्क: राित में वववनवम्भत ्या उतपावदत सरी वसतुओ ंपि उतपाद शुलक लरा्या जाता ह।ै

10.3.4.1 सुझाि 
• इस बात पि ववराि किें  वक आप अपना िन वकतनी जलदी वापस पाना राहतषे हैं औि इसी कषे  अनुसाि अपनी वनवषेश ्योजना रुनें।

• सुवनवश्चत किें  वक आप अपनषे वलए उप्ुयक्त बीमा पॉवलसी रुन िहषे हों।

• ्याद िखें, किों का रुरतान न किनषे पि जुमा्भनषे सषे लषेकि जषेल तक की सज़ा हो सकती ह।ै
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10.3.5 ऑनिाइन बैंर्ंकग, NEFT, RTGS आरद

ऑनिाइन बैंर्ंकग कया ह?ै

इंटिनषेट ्या ऑनलाइन बैंवकंर खातािािकों को लपैटॉप कषे  ज़रि्यषे कहीं सषे री अपना खाता एक्सषेस किनषे की सुवविा प्रदान किती ह।ै इस तिह सषे, वनददेश 

जािी वक्यषे जा सकतषे हैं। अपना खाता एक्सषेस किनषे कषे  वलए, खातािािकों को अपना ववशषेष गाहक आईडी नंबि औि पासवड्भ  प्र्योर किना होता ह।ै

इंटरनेट बैंर्ंकग ्का प्रयोग रनमन ्ेक रिए र्कया जा स्क्ता ह:ै

• खातषे में बका्या िावश का पता लरानषे कषे  वलए

• एक खातषे सषे दूसिषे  खातषे में पसैा हसतांतरित किनषे कषे  वलए

• रषेक जािी किनषे हषेतु

• रुरतान हषेतु वनददेश दषेनषे कषे  वलए

• रषेक बुक हषेतु वनवषेदन किनषे कषे  वलए

• खातषे कषे  ववविण हषेतु वनवषेदन कषे  वलए

• साववि जमा कषे  वलए

इिकेट्ॉरन्क िंि ट्ांसिर ्ेक रिए

इलषेक्ट्ॉवनक फंड ट्ांसफि इंटिनषेट व मोबाइल बैंवकंर जसैषे एकीकृत बैंवकंर सािनों का इसतषेमाल किकषे , आिाम सषे घि बठैषे  िन हसतांतरित किनषे का एक 

सुवविाजनक तिीका ह।ै

इलषेक्ट्ॉवनक माध्यमों सषे िन का हसतांतिण अत्यविक सुवविाजनक ह।ै ऑनलाइन बैंवकंर की मदद सषे आप इनका र्यन कि सकतषे हैं:

• समान बैंक में अपनषे ही एक खातषे सषे दूसिषे  खातषे में िन का हसतांतिण।

• समान बैंक कषे  अलर-अलर खातों में िन का हसतांतिण।

• NEFT का प्र्योर कितषे हुए वववरनन बैंकों कषे  खातों में िन हसतांतिण।

• RTGS का प्र्योर कितषे हुए अन्य बैंक खातों में िन हसतांतिण।

• IMPS का प्र्योर कितषे हुए वववरनन बैंक खातों में िन का हसतांतिण।

NEFT

NEFT का अथ्भ ह ैनषेशनल इलषेक्ट्ॉवनक फणड ट्ांसफि। ्यह िन हसतांतिण प्रणाली आपको अपनषे बैंक खातषे सषे उसी बैंक कषे  वकसी अन्य खातषे में ्या वकसी 

अन्य बैंक कषे  खातषे में इलषेक्ट्ॉवनक रूप सषे िन हसतांतरित किनषे की सुवविा प्रदान किती ह।ै NEFT का प्र्योर व्यवक्त्यों, फमकों व कॉपपोिषे ट संरठनों द्ािा 

एक खातषे सषे अन्य खातों में िन कषे  हसतांतिण कषे  वलए वक्या जाता ह।ै

NEFT कषे  माध्यम सषे िन हसतांतरित किनषे कषे  वलए, दो रीज़ों की आवश्यकता होती ह:ै

• हसतांतिण किनषे वाला बैंक

• लवक््यत बैंक

NEFT कषे  माध्यम सषे िन हसतांतरित किनषे सषे पहलषे आपको उस लाराथशी का पंजीकिण किना पडषेरा वजसषे िन रषेजा जाना ह।ै इस पंजीकिण को पिूा किनषे 

कषे  वलए, आपको वनमनवलवखत की आवश्यकता पडषेरी

• प्राप्तकता्भ  का नाम

• प्राप्तकता्भ  की खाता संख्या

• प्राप्तकता्भ  कषे  बैंक का नाम

• प्राप्तकता्भ  कषे  बैंक का IFSC कोड
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RTGS

RTGS का अथ्भ ह ैरि्यल टाइम गॉस सषेटलमेंट ्यह एक रि्यल टाइम िन हसतांतिण प्रणाली ह,ै जो आपको सकल आिाि पि ्या तुिंत एक बैंक सषे दूसिषे  बैंक 

में िन हसतांतरित किनषे में सक्म बनाती ह।ै हसतांतरित िन एक बैंक कषे  खातषे सषे तुिंत वनकाल वल्या जाता ह ैऔि उसी सम्य दूसिषे  बैंक कषे  खातषे में जमा 

हो जाता ह।ै RTGS रुरतान रषेटवषे का िख-िखाव रािती्य रिज़व्भ बैंक द्ािा वक्या जाता ह।ै बैंकों कषे  बीर लषेन-दषेन इलषेक्ट्ॉवनक रूप सषे वक्या जाता है

RTGS का प्र्योर व्यवक्त्यों, कंपवन्यों व फमकों द्ािा बडी मात्रा में िन हसतांतरित किनषे कषे  वलए वक्या जा सकता ह।ै RTGS कषे  द्ािा िन रषेजनषे सषे पहलषे, 

आपको अपनषे ऑनलाइन बैंवकंर खातषे कषे  ज़रि्यषे लाराथशी व उसकषे  बैंक खातषे का ववविण डालना होरा। ्यह पंजीकिण पिूा किनषे कषे  वलए, आपको 

वनमनवलवखत जानकािी की आवश्यकता होरी:

• लाराथशी का नाम 

• लाराथशी की खाता संख्या

• लाराथशी कषे  बैंक का पता 

• बैंक का IFSC कोड

IMPS

IMPS का अथ्भ ह ैइमीवड्यषेट पषेमेंट सवव्भस (तवरित रुरतान सषेवा)। ्यह एक रि्यल-टाइम, अंति-बैंकी्य, इलषेक्ट्ॉवनक िन हसतांतिण प्रणाली ह,ै वजसका 

प्र्योर राित रि कषे  बैंकों में िन कषे  हसतांतिण कषे  वलए वक्या जाता ह।ै IMPS उप्योक्ताओ ंको मोबाइल फोन का प्र्योर कितषे हुए, मोबाइल बैंवकंर व SMS 

कषे  माध्यम सषे तवरित इलषेक्ट्ॉवनक हसतांतिण रुरतान में सक्म बनता ह।ै इसका प्र्योर ATMs व ऑनलाइन बैंवकंर कषे  माध्यम सषे री वक्या जा सकता ह।ै 

IMPS हफतषे कषे  सातों वदन रौवबसों घंटषे उपलबि ह।ै ्यह प्रणाली एक सुिवक्त हसतांतिण रषेटवषे ह ैऔि तुिंत ऑड्भस्भ  कषे  पिूषे  होनषे की पुवष्ट किता ह।ै

IMPS कषे  माध्यम सषे िन हसतांतिण कषे  वलए आपको ्यह किनषे की आवश्यकता ह:ै

• अपनषे बैंक में IMPS कषे  वलए पंजीकिण

• बैंक सषे एक मोबाइल मनी आइडेंवटफा्यि (MMID) प्राप्त किें

• बैंक सषे MPIN प्राप्त किें

्यषे दोनों प्राप्त किनषे कषे  बाद आप लाराथशी को कोई री िावश हसतांतरित किनषे कषे  वलए लॉर-इन कि सकतषे हैं ्या SMS कषे  माध्यम सषे वनवषेदन रषेज सकतषे हैं।

लाराथशी को हसतांतरित िन प्राप्त किनषे कषे  वलए वनमन रीज़ें किनी होंरी:

• अपनषे मोबाइल नंबि को समबंवित खातषे सषे जोडना

• बैंक सषे MMID प्राप्त किना

IMPS कषे  माध्यम सषे िन का हसतांतिण किनषे कषे  वलए, आपको वनमनवलवखत जानकािी डालनी होरी:

• लाराथशी का मोबाइल नंबि 

• लाराथशी का MMID

• हसतांतरित िावश 

• आपका MPIN

जसैषे ही आपकषे  खातषे सषे िन वनकल जाता ह ैऔि लाराथशी कषे  खातषे में पहँुर जाता ह,ै तो रववष््य में सनदर्भ कषे  वलए आपको ट्ांज़षेक्शन रिफिषे नस नंबि कषे  साथ 

एक पुवष्ट (कनफमदेशन) SMS रषेजा जा्यषेरा।
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10.3.5.1 NEFT, RTGS ि IMPS ्ेक बीच अं्तर

10.3.5.2 सुझाि 

• अपनी ऑनलाइन बैंवकंर वषेबसाइट दषेखनषे कषे  वलए, करी री वकसी ई-मषेल सनदषेश में वदए रए वकसी वलंक पि वक्लक न किें ।

• ऑनलाइन बैंवकंर का प्र्योर किनषे कषे  दौिान आपसषे करी री आपकषे  क्रषे वडट ्या डषेवबट काड्भ  की जानकािी नहीं मांरी जाती।

• अपना ऑनलाइन बैंवकंर पासवड्भ  वन्यवमत रूप सषे बदलतषे िहषे।

तित्र 10.3.1: NEFT, RTGS ि IMPS के बीि अंिर
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यूरनट 10.4: रोज़गार ि सि-रोज़गार ्ेक रिए ्तयैारी

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. साक्ातकाि कषे  वलए त्ैयािी किनषे कषे  वववरनन रिणों पि ररा्भ  कि सकें रषे

2. प्ररावी रिज्यमूषे बनानषे कषे  वववरनन रिणों पि ररा्भ  कि सकें रषे

3. साक्ातकाि में अक्सि पू् षे  जानषे वालषे सवालों पि ररा्भ  कि सकें रषे

4. ररा्भ  कि सकें रषे वक साक्ातकाि में अक्सि पू् षे  जानषे वालषे सवालों का जवाब कैसषे वद्या जाए

5. बुवन्यादी का्य्भसथल शबदावली पि ररा्भ  कि सकें रषे

यूरनट ्ेक उद्ेशय 

10.4.1 साक्ात्कार (इंटरवयू) ्की ्तयैारी: इंटरवयू ्ेक रिए ्तयैारी ्ैकसे ्करें
आप जो नौकिी राहतषे हैं, उसषे पानषे कषे  वलए आपकी सफलता मुख्य रूप सषे इस बात पि वनर्भि किती ह,ै वक उस नौकिी कषे  वलए आपका इंटिव्य ूकैसा होता 

ह।ै इसवलए, अपना इंटिव्य ूदषेनषे सषे पहलषे ्यह महत्वपणू्भ  ह,ै वक आप थोडषे सी रिसर्भ व ्योजना कषे  साथ इसकी त्ैयािी कैसषे कितषे हैं। वकसी री इंटिव्य ूकषे  वलए 

पिूी तिह त्ैयािी किनषे सषे पहलषे इन रिणों का ध्यान िखें:

1. रजस संगठन ्ेक रिए इंटरवयू द ेरहे हैं उस्ेक बारे में जान्कारी प्राप्त ्करें ।

• पहलषे सषे ही कंपनी कषे  बािषे  में जानकािी प्राप्त कि लषेनषे सषे आपको इंटिव्य ूकषे  सम्य अविक त्ैयाि िहनषे में मदद वमलषेरी। संरठन कषे  बािषे  में आपकी 

जानकािी सषे आपको इंटिव्य ूमें प्रश्नों का उत्ति दषेनषे में आसानी होरी औि आप अविक ववश्वसत वदखाई देंरषे औि महससू किें रषे। इससषे आप वनवश्चत रूप 

सषे, उन उममीदवािों सषे अलर वदखाई देंरषे वजनहें इसकषे  बािषे  में इतनी जानकािी नहीं ह।ै

• कंपनी की पषृ्ठरवूम की जानकािी लें। कंपनी व इसकषे  उद्ोर ववविण की पिूी जानकािी प्राप्त किनषे का प्र्यास किें ।

• कंपनी कषे  वक्र्याकलापों की जानकािी प्राप्त किनषे कषे  वलए कंपनी की वषेबसाइट दषेखना री एक अच्ा तिीका ह।ै कंपनी की वषेबसाइट महत्वपणू्भ 

जानकािी का सािन होती ह।ै कंपनी की वमशन सटषेटमेंट (ध्यषे्य वक्तव्य) को पढें  व समझें। कंपनी कषे  उतपादों/सषेवाओ ंव गाहकों की सरूी पि ववशषेष 

ध्यान दें। कंपनी कषे  संराववत ववकास व वसथिता की जानकािी कषे  वलए इसकी प्रषेस ववज्वप्त्यां पडें।

• अपनी खोजबीन पिूी किनषे कषे  बाद ्यवद कोई प्रश्न मन में हों, तो उनहें वलखें।

2. इस बारे में रिचार ्करें  र्क कया आप्की ्ुकशि्ताएं ि योगय्ताएं नौ्करी ्की आिशय्क्ताओ ंसे मेि खा्ती हैं।

• साविानीपवू्भक नौकिी कषे  ववविण को पडें व उसका ववश्षे षण किें ।

• नौकिी की आवश्यकताओ ंको पिूा किनषे वाली जानकािी, कुशलताओ ंव ्योग्यताओ ंका संवक्प्त ववविण बनाएं।

• संरठन कषे  पदानुक्रम पि नज़ि डालें। ्यह दषेखें की वजस पद कषे  वलए आपनषे आवषेदन वक्या ह ैवह इस क्रम में कहाँ पि ह।ै

3. आम्तौर पर सबसे अरध्क पूछे जाने िाि ेइंटरवयू प्रश्न दखेें और अपने उतिर ्तयैार ्करें ।

• ्याद िखें, अविकांश इंटिव्य ू(साक्ातकािों) में आपकषे  रिज्यमूषे सषे जुडषे  व कषे स सटडी (वववशष्ट मामलों सषे जुडषे) प्रश्न पू् षे  जातषे हैं।

• इन क्षेत्रों सषे जुडषे  सामान्य प्रश्नों कषे  उत्ति कषे  बािषे  में ववराि किें ।

• इन उत्तिों का तब तक अभ्यास किें  जब तक आप ववश्वसत व सपष्ट तिीकषे  सषे इनका जवाब दषेनषे में सक्म न हो जाएं।

4. इंटरवयू ्ेक रिए अपनी िेशभूषा ्की योजना बनाएं।

• औपरारिक व्यावसाव्यक वषेशरषूा रुनना ही सबसषे सुिवक्त ववकलप होता ह,ै बशतदे वबज़नषेस कैजुअल परििान की मांर न की जा्यषे (इस मामलषे में 

अपना सवपोत्तम वनण्भ्य प्र्योर किना रावहए)।
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• सुवनवश्चत कि लें की आपकषे  व्रि साफ़-सुथिषे  व अच्ी तिह प्रषेस/ इ्रिी वक्यषे रए हों। सामान्य िंर कषे  कपडें पहनषे - न तो अत्यविक रमकदाि औि न 

ही बहुत हलकषे  िंर कषे ।

• आपकषे  द्ािा पहनषे रए जतूषे आपकषे  कपडों कषे  अनुरूप होनषे रावहए औि इंटिव्य ूमें पहननषे ्योग्य होनषे रावहए।

• ्याद िखें, आपका लक््य हि व्यवक्त पि ्यह प्रराव ्ोडना ह ैवक आप एक प्रोफषे शनल व अत्यविक सक्म व्यवक्त हैं।

5. सुरनरश्च्त ्कर िें ्की आपने िह सब ्ुकछ अपने पास रख रिया ह ैरजस्की इंटरवयू ्ेक दौरान ज़रूर्त पड़ स्क्ती ह।ै

• अपनषे रिज्यमूषे (जीवनवतृ) की कु् प्रवत्याँ अपनषे पास िखें। अपनषे रिज्यमूषे कषे  वलए एक अच्ी रुणवत्ता वालषे पषेपि का उप्योर किें ।

• हमषेशा अपनषे पास एक नोटपडै व पषेन िखें।

• आवषेदन पत्र रिनषे कषे  वलए, अपनषे साथ प्या्भप्त जानकािी लषे जाएं।

• ्यवद प्रासंवरक हो तो, अपनषे साथ अपनषे का्य्भ  कषे  कु् सैंपल (नमूनषे) लषे जाएं।

6. अमौरख्क संिाद ्ेक महत्ि ्को याद रखें।

• ववश्वास बढानें का अभ्यास किें । सव्ंय को मुसकुिानषे की ्याद वदलातषे िहें औि, सामनषे वालषे की आँखों की तिफ दषेखकि बात किें । मजबतूी सषे हाथ 

वमलाएं।

• वदमार में बठैनषे/खडषे होनषे की मुरिा का ध्यान िखें। सीिषे खडषे होनषे का अभ्यास किें । नव्भस होनषे कषे  लक्णों, जसैषे रंरल होनषे व पिै को लराताि वहलानषे 

सषे सव्ंय को िोकनषे का अभ्यास किें ।

• अपनी प्रवतवक्र्याओ ंको वन्ंयत्रण में िखें। ्याद िखें, आपकषे  रषेहिषे  कषे  राव आपकी वासतववक रावनाओ ंको अवरव्यक्त कितषे हैं। अपनी एक सकािातमक 

्वव बनानषे का प्र्यास किें ।

7. इंटरवयू समाप्त ्करने िाि ेप्रश्नों ्की सूची बनाएं।

• अविकांश साक्ातकािों में, साक्ातकता्भ  आपसषे पू् ें  वक क््या आपकषे  री कु् प्रश्न हैं? अब आपकषे  पास ्यह वदखानषे का मौका ह ैवक आपनषे क््या रिसर्भ 

की हुई ह ैऔि आप कंपनी कषे  बािषे  में औि अविक जाननषे कषे  इच्ुक हैं।

• ्यवद साक्ातकािकता्भ  आपसषे ्यह प्रश्न नहीं पू् ता ह ैतो आप उनहें ्यह बता सकतषे हैं वक आपकषे  पास कु् ऐसषे प्रश्न हैं वजन पि आप ररा्भ  किना राहतषे 

हैं। आपकषे  पास अब उन नोट्स का सनदर्भ दषेनषे का अवसि ह ैवजसकषे  बािषे  में आपनषे अध्य्यन वक्या ह।ै

• इस सम्य पू् षे  जानषे वालषे कु् अच ष्े  प्रश्न हैं:

» इस नौकिी में सफलता कषे  वलए आपकषे  अनुसाि सबसषे महतवपणू्भ  मापदंड ्यह ह?ै

» मषेिषे  का्य्भप्रदश्भन का मूल्यांकन कैसषे वक्या जा्यषेरा?

» उननवत कषे  वलए क््या अवसि हैं?

» नौकिी पि िखनषे की (हा्यरिंर) प्रवक्र्या कषे  अरलषे रिण क््या हैं?

• ्याद िखें, करी री वह जानकािी न पू् ें  जो कंपनी की वषेबसाइट पि आसानी सषे उपलबि ह।ै

10.4.1.1 सुझाि 
• व्यावहारिक व संराववत प्रश्न पू् ें ।

• बातरीत कितषे सम्य, राव-रंवरमाओ ंकषे  प्ररावी रूपों जसैषे मुसकुिाहट, नषेत्र संपक्भ  व सवक्र्यता सषे सुननषे व वसि वहलानषे का प्र्योर किें । झुकें  नहीं, 

आसपास की वसतुओ ंसषे वखलवाड न किें , बषेरनै न हों, च्यइंूरम न रबाएं, ्या बडबडाएं नहीं।
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10.4.2 प्रभािी ररजयूमे ्तयैार ्करना 
रिज्यमूषे एक ऐसा औपरारिक दसतावषेज़ होता ह,ै जो वकसी उममीदवाि कषे  का्या्भनुरव, वशक्ा व कुशलताओ ं को प्रदवश्भत किता ह।ै एक अच्ा रिज्यमू 

संराववत वन्योक्ता को प्या्भप्त जानकािी दषेकि ्यह ववश्वास वदलाता ह ैवक आवषेदक साक्ातकाि कषे  वलए ्योग्य ह।ै इसवलए रिज्यमूषे प्ररावी तिीकषे  सषे बनाना 

बहुत महतवपणू्भ  ह।ै प्ररावी रिज्यमूषे बनानषे कषे  वलए वनमनवलवखत रिणों पि नज़ि डालें:

चरण 1: अपने प्त ेिािा रहससा रिखें

पतषे का वहससा आपकषे  रिज्यमूषे में सबसषे ऊपि होना रावहए। इसमें आपका नाम, पता, फ़ोन नंबि व ई-मषेल एड्षेस शावमल होता ह।ै इस वहससषे को अपनषे शषेष 

रिज्यमूषे सषे अलर किनषे कषे  वलए इसकषे  बाद एक मोटी लाइन डालें।

उदाहरण:

चरण 2: प्रोिाइि समरी सेकशन, जोड़ें

आपकषे  रिज्यमूषे कषे  इस वहससषे में आपका अनुरव, उपलवबि्यां, पुिसकाि, प्रमाणीकिण व शवक्त्यों की जानकािी होनी रावहए। आप अपनषे सािांश को 2-3 

मुख्य वबनदुओ ंतक सीवमत, ्या 8-10 मुख्य वबनदुओ ंतक ववसततृ कि सकतषे हैं।

उदाहरण:

चरण 3: अपनी शरैक््क योगय्ताएं शारमि ्करें ।

अपना शवैक्क रिकॉड्भ  सरूीबद्ध कितषे सम्य, सबसषे पहलषे अपनी सबसषे बडी वडगी सरूीबद्ध किें । उसकषे  बाद उचरतम ्योग्यता कषे  नीरषे उससषे कम उचरतम 

्योग्यता जोडें औि इसी क्रम में आरषे जोडतषे जाएं। अपनी शवैक्क पषृ्ठरवूम की सपष्ट व सटीक तसवीि उपलबि किानषे कषे  वलए, ्यह महतवपणू्भ  ह ैवक प्रत्यषेक 

सरूीबद्ध वडगी ्या प्रमाणपत्र कषे  वलए, आपनषे अपनषे सथान, दजदे, प्रवतशत ्या CPI की जानकािी री दी हो।

्यवद आपनषे कु् प्रमाणीकिण ्या प्रवशक्ण वलए हैं, तो आप अपनषे शवैक्क ्योग्यता खंड में प्रवशक्ण व प्रमाणीकिण खंड शावमल कि सकतषे हैं।

उदाहरण:
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चरण 4: अपनी ्त्कनी्की ्ुकशि्ताओ ं्को सूचीबद ्करें ।

अपनी तकनीकी कुशलताओ ं की सरूी बनातषे सम्य, सबसषे पहलषे वषे कुशलताएं वलखें वजनकषे  बािषे  में आप सबसषे अविक ववश्वसत हैं। इसकषे  बाद ऐसी 

कुशलताएं वलखें वजनमें आप पिूी तिह पािंरत नहीं हैं। कषे वल एक ही कौशल शावमल किना री सव्भथा उप्ुयक्त ह,ै ्यवद आपको ऐसा लरता ह ैवक ्यह 

वववशष्ट कौशल आपकषे  रिज्यमूषे को उललषेखनी्य रूप सषे महतवपणू्भ  बना दषेता ह।ै ्यवद आपकषे  पास कोई तकनीकी कौशल नहीं ह ैतो आप ्यह रिण ्ोड 

सकतषे हैं।

उदाहरण:

चरण 5: अपना शरैक््क प्रोजेकट अनुभि शारमि ्करें ।

वषे सरी महतवपणू्भ  प्रोजषेक्ट सरूीबद्ध किें  वजन पि आपनषे काम वक्या ह।ै इस खंड में वनमनवलवखत जानकािी डालें:

उदाहरण:

चरण 6: अपनी शरतियां सूचीबद ्करें ।

्यह वह वहससा ह ैवजसमें आप अपनी प्रमुख शवक्त्यों की जानकािी दषे सकतषे हैं। ्यह खंड बुलषेट पवाइंट्स में होना रावहए।

उदाहरण:

चरण 7: अपनी पाठतिर गर्तरिरधयों ्की सूची बनाएं।

्यह प्रदवश्भत किना बहुत महतवपणू्भ  ह ै वक आपकी ववववि रुवर्याँ हैं औि आपका जीवन वशक्ा सषे पिषे  री ह।ै पाठ््यषेत्ति रवतवववि्यों को शावमल किनषे सषे 

आपको ऐसषे अन्य उममीदवािों की तुलना में अविक प्राथवमकता वमल सकती ह ैवजनकषे  आपकषे  समान शवैक्क अंक व प्रोजषेक्ट अनुरव होतषे हैं। ्यह खंड बुलषेट 

पवाइंट्स में होना रावहए।

उदाहरण:
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चरण 8: अपनी वयरतिग्त जान्कारी रिखें।

आपकषे  रिज्यमूषे कषे  अंवतम वहससषे में वनमनवलवखत व्यवक्तरत जानकािी होनी रावहए:

• जनम वतवथ 

• वलंर व ववैावहक वसथवत

• िाष्ट्ी्यता 

• ज्ात राषाएँ

उदाहरण:

10.4.1.2 सुझाि 
• अपनी रिज्यमूषे फाइल का नाम ्ोटा, सिल व सरूनातमक िखें।

• सुवनवश्चत कि लें वक रिज्यमूषे साफ़ सुथिा व टाइवपंर की रलवत्यों सषे मुक्त हो।

• हमषेशा अपना रिज्यमूषे सादषे सफ़षे द कारज़ पि त्ैयाि किें ।

10.4.3 साक्ात्कार में आम्तौर पर पूछे जाने िाि ेप्रश्न

आमतौि पि इंटिव्य ू(साक्ातकाि) में पू् षे  जानषे वालषे प्रश्नों पि नज़ि डालें औि उनका उत्ति दषेनषे कषे  सहा्यक कु् सुझावों पि ववराि किें ।

1. कया आप अपने बारे में मुझे ्ुकछ ब्ता स्क्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• अपनषे वप्लषे काम की पिूी जानकािी ्या व्यवक्तरत इवतहास न बताएं।

• अपनषे 2-3 वववशष्ट अनुरव बताएं जो आपको सवा्भ विक महतवपणू्भ  व प्रासंवरक लरतषे हों।

• इस बात सषे समापन किें  वक उन अनुरवों नषे आपको इस वववशष्ट रवूमका कषे  वलए वकस तिह बषेहति बना्या ह।ै
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2. आप्को इस पद ्ेक बारे में ्ैकसे प्ता िगा?

उतिर दनेे हे्तु सुझाि:

• साक्ातकािकता्भ  को बताएं वक आपको इस नौकिी कषे  बािषे  में कैसषे पता लरा - राहषे वह वकसी वमत्र (वमत्र का नाम), आ्योजन ्या लषेख (उनका नाम 

बताएं) ्या वकसी जॉब पोट्भल (बताएं वकस पोट्भल सषे) सषे लरा हो।

• ्यह बताएं वक इस रवूमका कषे  बािषे  में आप वकतनषे उतसावहत हैं औि इसकषे  बािषे  में आपको क््या आकष्भक लरा ह।ै

3. आप ्ंकपनी ्ेक बारे में कया जान्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• कंपनी कषे  About Us पषृ्ठ को न दोहिाएं।

• ्यह प्रदवश्भत किें  की आप कंपनी कषे  लक््यों को समझतें व उनका ध्यान िखतषे हैं।

• ्यह बताएं वक आप कंपनी कषे  वमशन व मूल्यों में क््यों ववश्वास िखतषे हैं।

4. आप यह नौ्करी कयों चाह्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• दशा्भ एं वक आप नौकिी कषे  बािषे  में उतसावहत हैं।

• ्यह बताएं वक ्यह रवूमका आपकषे  अनुरूप ह।ै

• बताएं वक आप कंपनी को क््यों पसंद कितषे हैं?

5. हमें आप्को नौ्करी कयों दनेी चारहए?

उतिर दनेे हे्तु सुझाि:

• अपनषे शबदों सषे वसद्ध किें  वक आप कषे वल काम ही नहीं कि सकतषे, बवलक वनवश्चत रूप सषे उतकृष्ट परिणाम री दषे सकतषे हैं।

• बताएं, वक टीम व का्य्भ  संसकृवत कषे  वलए कैसषे आप वबलकुल दुरुसत सावबत होंरषे।

• ्यह बताएं वक आपको अन्य उममीदवािों की तुलना में क््यों रुना जाना रावहए।

6. आप्की सबसे शानदार पेशेिर शरतियां कया हैं?

उतिर दनेे हे्तु सुझाि:

• ईमानदाि होना - अच ष्े  लरनषे वालषे उति दषेनषे की बजा्य अपनी कु् वासतववक शवक्त्यों कषे  बािषे  में बताएं।

• उन वववशष्ट शवक्त्यों कषे  उदाहिण दें जो आपषेवक्त पद सषे संबंवित हों।

• उदाहिण दषेकि बताएं वक आपनषे इन शवक्त्यों को वकस तिह प्रदवश्भत वक्या ह।ै

7. अपनी ्कमजोररयों ्ेक बारे में ब्ताएं?

उतिर दनेे हे्तु सुझाि:

• इस प्रश्न का उद्षेश्य आपकी सव-जाररूकता व ईमानदािी का आंकलन किना ह।ै

• अपनी वकसी ऐसी कमी का उदाहिण दें वजसकषे  साथ आप संघष्भ  कि िहषे हैं, लषेवकन ्यह री बताएं वक आप इस पि सुिाि कषे  वलए काम कि िहषे हैं।

8. आप्की िे्तन अपेक्ाएं कया हैं?

उतिर दनेे हे्तु सुझाि:

• वकसी पद कषे  वलए आवषेदन कितषे सम्य उस पद कषे  वलए सामान्यत: वद्यषे जानषे वालषे वषेतन कषे  बािषे  में खोजबीन कि लें।

• अपनषे अनुरव, वशक्ा व कुशलताओ ंकषे  आिाि पि पता लराएं वक आपकषे  वषेतन की सीमा क््या होनी रावहए।

• लरीलषे बनें। साक्ातकािकता्भ  को बताएं वक आप जानतषे हैं वक आपकी कुशलताएं वकतनी मूल्यवान हैं, लषेवकन आपको नौकिी की ज़रूित ह ैऔि आप 

इस पि बात किनषे कषे  इच्ुक हैं।
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10.4.3.1 सुझाि 
• उत्ति दषेतषे सम्य ईमानदाि औि ववश्वसत िहें।

• अपनषे उत्तिों को औि अविक प्ररावशाली बनानषे कषे  वलए अपनषे पुिानषे अनुरवों कषे  उदाहिणों का प्र्योर किें ।

10.4.5 ्काम ्ेक रिए ्तयैारी - श्ततें ि शबदािरियाँ
प्रत्यषेक कम्भरािी को वनमनवलवखत शबदों कषे  बािषे  में पिूी जानकािी होनी रावहए:

• िारषटि्क अि्काश: वन्योक्ताओ ंद्ािा कम्भरारि्यों को वद्या जानषे वाला सरुरतान अवकाश।

• पषृ्ठभूरम ्की जाँच: संराववत उममीदवािों द्ािा उपलबि किा्यी रई जानकािी की सटीकता को सत्यावपत किनषे कषे  वलए वन्योक्ताओ ंद्ािा प्र्योर की 

जानषे वाली वववि।

• िाभ: कम्भरािी कषे  प्रवतपवूत्भ  पकैषे ज का एक वहससा।

• अन्तराि (ब्ेकस): का्य्भघंटों कषे  दौिान कम्भरारि्यों द्ािा वल्या र्या अलप अववि का ववशाम।

• प्रर्तपूर्तटि प्ेैकज: वषेतन एवं लारों का सवममशण जो कोई वन्योक्ता अपनषे कम्भरारि्यों को दषेता ह।ै

• प्रर्तपूर्तटि समय (्कॉमप टाइम): वषेतन कषे  बदलषे ्ुट्ी।

9. ्काम ्ेक अिािा आप कया ्करना पसंद ्कर्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• इस प्रश्न का उद्षेश्य ्यह दषेखना ह ैवक आप कंपनी की संसकृवत में सामंजस्य वबठा सकें रषे वक नहीं।

• ईमानदाि बनें - उन रवतवववि्यों व रुवर्यों कषे  बािषे  में खुल कि बताएं जो आपको पसंद ह ैऔि वजनसषे आप उतसावहत होतषे हैं।

10. यरद आप जानिर हो्त े्तो कया बनना चाह्त?े

उतिर दनेे हे्तु सुझाि:

• ्यह प्रश्न पू् नषे का उद्षेश्य ्यह दषेखना ह ैवक आप अपनषे बल पि सोरनषे में सक्म हैं।

• आपका कोई री उत्ति रलत नहीं होरा - लषेवकन अच्ा प्रराव डालनषे कषे  वलए, अपनषे उत्ति कषे  माध्यम सषे अपनी शवक्त्यों ्या व्यवक्ततव की ्ाप ्ोडनषे 

का प्र्यास कीवज्यषे।

11. अपने रिचार से आप बेह्तर या अिग ्तरी्ेक से कया ्कर स्क्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• ्यह प्रश्न पू् नषे का उद्षेश्य ्यह पता लराना ह ैवक क््या आपनषे कंपनी कषे  बािषे  में कु् खोजबीन की ह ैऔि इससषे ्यह री पता रलता ह ैवक क््या आप 

समालोरना कषे  आिाि पि सोर सकतषे हैं औि नए ववराि दषे सकतषे हैं।

• नए ववराि सुझाइ्यषे। ्यह दशा्भ एं वक आपकी रुवर्यों व ववशषेषज्ता सषे इन ववरािों को कैसषे वक्र्यावनवत वक्या जा सकता ह।ै

12. कया आप हमसे ्ुकछ पूछना चाह्त ेहैं?

उतिर दनेे हे्तु सुझाि:

• ऐसषे प्रश्न न पू् ें  वजसका उत्ति आसानी सषे कंपनी की वषेबसाइट पि ्या ऑनलाइन सर्भ कषे  माध्यम सषे वमल सकता ह।ै

• ऐसषे बुवद्धमत्तापणू्भ  प्रश्न पू् ें  जो रंरीिता सषे सोरनषे की आपकी ्योग्यता दशा्भतषे हों।
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• ठे्का ्कमटिचारी: ऐसा कम्भरािी जो वकसी ऐसषे संरठन कषे  वलए काम किता ह,ै जो उक्त कम्भरािी की सषेवाएं, वकसी प्रोजषेक्ट ्या सम्य आिाि पि वकसी 

अन्य कंपनी को बषेरता ह।ै

• रनयुरति ्का ्कांट्केट: जब वकसी कम्भरािी को रुरतान ्या वषेतन कषे  बदलषे काम की पषेशकश की जाती ह,ै औि वह वन्योक्ता द्ािा की रई पषेशकश 

को सवीकाि कि लषेता ह,ै तो िोज़राि (वन्ुयवक्त) का कांट्षेक्ट हो जाता ह।ै

• ्कॉपथोरेट संस्ृकर्त: कंपनी कषे  सरी सदस्यों द्ािा आपस में आदान-प्रदान की रई तथा कम्भरारि्यों की एक पीडी सषे दूसिी पीडी को प्रदान की रई 

मान्यताएं व मूल्य।

• ्काउंटर पेश्कश/्काउंटर प्रस्ताि: कंपनी द्ािा प्रसताववत वषेतन की िावश बढानषे कषे  वलए संराववत कम्भरािी द्ािा प्र्योर की रई नरैोवशएशन 

तकनीक।

• ्किर िटेर: ऐसा पत्र वजसकषे  साथ उममीदवाि का रिज्यमूषे संलगन होता ह।ै इसमें उममीदवाि कषे  रिज्यमूषे कषे  महतवपणू्भ  वबंदु होतषे हैं औि ्यह वषे वासतववक 

उदाहिण उपलबि किाता ह ैजो अपषेवक्त का्य्भ  किनषे कषे  वलए उममीदवाि की ्योग्यता को प्रमावणत किता ह।ै

• ्करर्ुकिम िायट े(CV)/ररजयूमे: उममीदवाि की उपलवबि्यों, शवैक्क पषृ्ठरवूम, का्या्भनुरव, कुशलताओ ंव शवक्त्यों का सािांश।

• असिी्कार पत्र: वन्योक्ता द्ािा कम्भरािी को दी रई नौकिी की पषेशकश को असवीकाि कितषे हुए, कम्भरािी द्ािा वन्योक्ता को रषेजा र्या पत्र।

• ्कटौर्तयां: कम्भरािी कषे  वषेतन में सषे घटाई रई िन िावश, वजसका उललषेख कम्भरािी की वषेतन परशी (पषे वसलप) में हो।

• भेदभाि: वकसी व्यवक्त कषे  साथ, वकसी अन्य व्यवक्त की तुलना में ख़िाब ्या असमान व्यवहाि किना।

• ्कमटिचारी: ऐसा व्यवक्त जो रुरतान कषे  बदलषे वकसी अन्य व्यवक्त कषे  वलए काम किता ह।ै

• ्कमटिचारी प्ररशक्ण: वकसी कम्भरािी को उसकषे  वरिष्ठ अविकािी कषे  आदषेश कषे  अंतर्भत किाई जानषे वाली का्य्भशाला ्या इन-हाउस प्रवशक्ण, वजससषे 

वन्योक्ता को फा्यदा पहंुरषे।

• रोज़गार अन्तराि: नौकरि्यों कषे  बीर बषेिोज़रािी कषे  सम्य की अववि्याँ।

• रनधाटिरर्त-अिरध ्ेक ्कांट्केट: नौकिी का कांट्षेक्ट, जो एक सहमवत सषे त्य की रई वनिा्भ रित-वतवथ पि समाप्त हो जाता ह।ै

• िॉिो-अप: वकसी उममीदवाि द्ािा संराववत वन्योक्ता कषे  पास अपना रिज्यमूषे रषेजषे जानषे कषे  बाद, वन्योक्ता सषे संपक्भ  किनषे की रवतवववि।

• फ्ीिांसर/्ंकसिटेंट/सि्तंत्र ठे्ेकदार: ऐसा व्यवक्त जो सव्ंय कषे  वलए काम किता ह ैऔि वववरनन वन्योक्ताओ ंकषे  साथ असथाई नौकरि्यां व प्रोजषेक्ट 

पिूषे  किता ह।ै

• छुट्ी: काम सषे सरुरतान अवकाश।

• घंटिेार दर: 60 वमनट कषे  काम कषे  वलए वद्या जानषे वाला वषेतन ्या रुरतान।

• इंटनटिरशप: वकसी संराववत कम्भरािी वजसषे इंटन्भ  कहा जाता ह ैको वकसी वन्योक्ता द्ािा एक वनिा्भ रित, सीवमत सम्य अववि कषे  वलए वन्योक्ता की 

कंपनी में वद्या र्या नौकिी का अवसि।

• इंटरवयू (साक्ात्कार): संराववत कम्भरािी को नौकिी पि िखषे जानषे का वनिा्भिण किनषे कषे  वलए, संराववत कम्भरािी व वन्योक्ता कषे  प्रवतवनवि कषे  बीर 

होनषे वाला संवाद।

• नौ्करी ्ेक रिए आिेदन: एक फॉम्भ  वजसमें उममीदवाि कषे  बािषे  में जानकािी, जसैषे उममीदवाि का नाम, पता, संपक्भ  ववविण व का्य्भ  अनुरव शावमल 

होता ह।ै नौकिी का आवषेदन पत्र जमा किानषे का उद्षेश्य ्यह दशा्भना होता ह,ै वक उममीदवाि की वदलरसपी वकसी वववशष्ट कंपनी में काम किनषे में ह।ै

• नौ्करी ्की पेश्कश: वकसी वन्योक्ता द्ािा संराववत कम्भरािी को िोज़राि की पषेशकश किना।

• जॉब सचटि एजेंट: एक ऐसा प्रोगाम जो उममीदवािों को नौकरि्यों कषे  वलए प्रोगाम में सरूीबद्ध मापदंडों का र्यन किकषे  िोज़राि अवसिों की खोज में 

सक्म बनाता ह।ै

• ि ेऑि (्कामबंदी): लषे ऑफ तब होता ह ैजब कम्भरािी को असथाई रूप सषे अपना काम बंद किना पडता ह,ै क््योंवक वन्योक्ता कषे  पास उस कम्भरािी 

कषे  वलए कोई काम नहीं होता।

• अि्काश: वकसी वन्योक्ता द्ािा अपनषे कम्भरािी को काम सषे अनुपवसथत िहनषे व ्ुट्ी लषेनषे की औपरारिक अनुमवत।

• सिी्कायटि्ता पत्र: वन्योक्ता द्ािा कम्भरािी को नौकिी की पषेशकश किनषे व पषेशकश की शतकों का ववविण दषेनषे की पुवष्ट किनषे वाला पत्र।
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• सहमर्त पत्र: ऐसा पत्र जो िोज़राि (नौकिी) की शतकों की रूपिषे खा प्रदवश्भत किता ह।ै

• संस्तुर्त पत्र: वकसी व्यवक्त की का्य्भ  कुशलताओ ंकी पुवष्ट किनषे कषे  उद्षेश्य सषे वलखा र्या पत्र।

• मा्ततृि अि्काश: ऐसी मवहलाओ ंद्ािा वल्या र्या अवकाश जो रर्भवती हैं ्या वजनहोंनषे हाल ही में संतान को जनम वद्या ह।ै

• मागटिदशटि्क (मेंटर): ऐसा व्यवक्त जो आपसषे उचर पद पि काम कि िहा ह ैऔि आपको कैरि्यि कषे  वलए सलाह व मार्भदश्भन दषेता ह।ै

• नयून्तम मजदूरी: प्रवत घंटा आिाि पि रुरतान की जानषे वाली न्यनूतम िावश।

• नोरटस: वन्योक्ता ्या कम्भरािी द्ािा की रई वह घोषणा वजसमें ्यह कहा जाता ह ैवक कम्भरािी का कांट्षेक्ट वकसी वनवद्भष्ट वतवथ को समाप्त हो जा्यषेरा।

• रोज़गार (नौ्करी) ्की पेश्कश: वन्योक्ता द्ािा संराववत कम्भरािी को की रई पषेशकश वजसमें दी जानषे वाली नौकिी सषे जुडी महतवपणू्भ  जानकािी 

जसैषे शुरू किनषे की वववि, वषेतन, का्य्भवसतवथ्यां आवद का ववविण होता ह।ै

• मुति-रनणटिय (ओपन एनिीि) ्कांट्केट: िोज़राि ्या नौकिी का ऐसा कांट्षेक्ट जो तब तक रलता ह ैजब तक वन्योक्ता ्या कम्भरािी दोनों में सषे कोई 

इसषे समाप्त नहीं कि दषेता।

• अतयरध्क योगय (ओिर किारििाइि): ऐसा व्यवक्त जो वकसी वववशष्ट नौकिी/पद कषे  वलए इसवलए उप्ुयक्त नहीं होता क््योंवक उसकषे  पास बहुत 

अविक का्य्भ  अनुरव ्या वशक्ा का ऐसा सति होता ह,ै जो उस का्य्भ  ्या नौकिी कषे  वलए वांव्त ्योग्यता सषे बहुत अविक ह ै्या वह वत्भमान में अथवा पवू्भ 

में बहुत अविक वषेतन पा िहा हो।

• अंश-्कारि्क ्कामगार: ऐसा कम्भरािी जो का्य्भ  कषे  सामान्यत: वनिा्भ रित मानक घंटों सषे कम घंटों कषे  वलए काम किता ह।ै

• रप्ततृि अि्काश: हाल ही में वपता बनषे व्यवक्त को वद्या जानषे वाला अवकाश।

• ररकु्रटर/हेिहनटसटि/एगजीकयूरटि सचटि िमसटि: वन्योक्ता द्ािा रुरतान आिाि पि िखषे रए पषेशषेवि जो वववशष्ट पदों कषे  वलए लोरों की खोज कितषे हैं।

• इस्तीिा दनेा/तयागपत्र: जब कोई कम्भरािी औपरारिक रूप सषे अपनषे वन्योक्ता को सवूरत किता ह ैवक वह अपनी नौकिी ्ोड िहा ह।ै

• सि-रोजगारी: ऐसा व्यवक्त वजसका अपना व्यवसा्य ह ैऔि वह कम्भरािी कषे  रूप में काम नहीं किता।

• टाइम शीट: ऐसा फॉम्भ  जो वकसी कम्भरािी द्ािा वन्योक्ता को वद्या जाता ह ैवजसमें कम्भरािी द्ािा प्रवतवदन वक्यषे जानषे वालषे का्य्भ  घंटों का ववविण 

होता ह।ै
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यूरनट 10.5: उद्यमशीि्ता ्को समझना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. उद्मशीलता की अविािणा पि ररा्भ  कि सकें रषे

2. उद्मशीलता कषे  महतव पि ररा्भ  कि सकें रषे

3. उद्मशीलता की ववशषेषताओ ंकी ररा्भ  कि सकें रषे

4. उद्मों कषे  वववरनन प्रकािों का वण्भन कि सकें रषे

5. एक प्ररावी नषेता कषे  रुणों की सरूी बना सकें रषे

6. प्ररावी नषेततृव कषे  लारों पि ररा्भ  कि सकें रषे

7. एक प्ररावी टीम कषे  रुणों की सरूी बना सकें रषे

8. प्ररावशाली ढंर सषे सुननषे कषे  महतव पि ररा्भ  कि सकें रषे

9. प्ररावी तिीकषे  सषे सुननषे की प्रवक्र्या पि ररा्भ  कि सकें रषे

10. प्ररावशाली ढंर सषे बात किनषे कषे  महतव पि ररा्भ  कि सकें रषे

11. ररा्भ  कि सकें रषे वक प्ररावशाली ढंर सषे कैसषे बात की जाए

12. ररा्भ  कि सकें रषे वक समस्याओ ंको वकस प्रकाि हल वक्या जाए

13. समस्या सुलझानषे कषे  महतवपणू्भ  रुणों की सरूी बना सकें रषे

14. समस्या सुलझानषे कषे  कौशल आंकलन कषे  तिीकों पि ररा्भ  कि सकें रषे

15. नरैोवशएशन कषे  महतव पि ररा्भ  कि सकें रषे

16. ररा्भ  कि सकें रषे वक नरैोवशएट कैसषे वक्या जाए

17. ररा्भ  कि सकें रषे वक नए व्यापाि अवसिों की पहरान कैसषे की जाए

18. ररा्भ  कि सकें रषे वक नए व्यापाि अवसिों की पहरान अपनषे व्यवसा्य कषे  रीति कैसषे की जाए

19. उद्मी कषे  अथ्भ को समझ सकें रषे

20. वववरनन प्रकाि कषे  उद्वम्यों का वण्भन कि सकें रषे

21. उद्वम्यों की ववशषेषताओ ंकी सरूी बना सकें रषे

22. उद्वम्यों की सफलता की कहावन्यां ्याद कि पाएंरषे

23. उद्मशीलता की प्रवक्र्या पि ररा्भ  कि सकें रषे

24. उद्मशीलता ईकोवससटम का वण्भन कि सकें रषे

25. उद्मशीलता ईकोवससटम में सिकाि की रवूमका पि ररा्भ  कि सकें रषे

26. राित में वत्भमान उद्मशीलता ईकोवससटम पि ररा्भ  कि सकें रषे

27. मषेक इन इंवड्या अवर्यान कषे  उद्षेश्य को समझ सकें रषे

28. उद्वमता औि जोवखम लषेनषे की क्मता कषे  बीर संबंि पि ररा्भ  कि सकें रषे

29. उद्मशीलता औि लरीलषेपन कषे  बीर संबंि पि ररा्भ  कि सकें रषे

30. एक लरीलषे उद्मी की ववशषेषताओ ंका वण्भन कि सकें रषे

31. ररा्भ  कि सकें रषे वक असफलता सषे कैसषे वनपटा जाए

यूरनट ्ेक उद्ेशय 
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10.5.1 अिधारणा पररचय 
ऐसा व्यवक्त, जो वकसी री तिह का जोवखम उठाकि, कािोबाि शुरु किनषे कषे  वलए दृढ-संकलप हो, उद्मी कहलाता ह।ै उद्मी अपनषे सव्ंय कषे  सटाट्भ  अप 

रलातषे हैं, ववत्ती्य जोवखमों कषे  वलए वजममषेदािी उठातषे हैं औि सफलता हावसल किनषे कषे  वलए िरनातमकता, अवरनवता औि सव-प्रषेिणा कषे  ववशाल क्षेत्र सषे 

जुडतषे हैं। वषे बडषे सपनषे दषेखतषे हैं औि अपनी सोर को व्यवहारिक पषेशकश तक लषे जानषे कषे  वलए वनवश्चत होतषे हैं। उद्मी का लक््य एक उद्म का वनमा्भण किना 

होता ह।ै इस उद्म का वनमा्भण किनषे की प्रवक्र्या को उद्मशीलता कहा जाता ह।ै

10.5.1.1 उद्यमशीि्ता ्का महति

वनमनवलवखत कािणों सषे उद्मशीलता बहुत महतवपणू्भ  ह:ै

1. इससषे नए संरठनों का वनमा्भण होता है

2. ्यह बाज़ाि में िरनातमकता लाती है

3. ्यह जीवन कषे  मानकों में सुिाि लाती है

4. ्यह दषेश की अथ्भव्यवसथा ववकवसत किनषे में मदद किती है

10.5.1.2 उद्यमशीि्ता ्की रिशेष्ताएं
सरी सफल उद्वम्यों में कु् सांझी ववशषेषताएं होती हैं।

जो ्यषे हैं:

• अपनषे काम कषे  बािषे  में अत्यविक जुननूी होना

• अपनषे आप में ववश्वास िखना

• अनुशावसत औि समवप्भत होना

• प्रषेरित औि जोशीला होना

• अत्यविक िरनातमक

• दूिदृष्टा होना

• खुलषे वदमार का होना

• वनणा्भ्यक होना

उद्वम्यों में ऐसी सोर री होती ह:ै

• उचर जोवखम की सहनशीलता

• हि काम की संपणू्भ  ्योजना

• अपनषे िन का बुवद्धमत्तापणू्भ  उप्योर

• गाहकों को अपनी प्राथवमकता मानना

• अपनी पषेशकशों औि अपनषे बाज़ाि को ववसताि सषे समझतषे हैं

• आवश्यकता पडनषे पि ववशषेषज्ों की सलाह लें

• जानतषे हैं, वक कब हावन्यों को कम किना है
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10.5.1.3 प्ररसद उद्यरमयों ्ेक उदाहरण

कु् मशहूि उद्मी हैं:

• वबल रषेट्स (Microsoft कषे  संसथापक)

• सटीव जॉब् स (Apple कषे  सह-संसथापक)

• माक्भ  ज़किबर्भ (Facebook कषे  संसथापक)

• वपएिषे  ओवमडा्यि (eBay कषे  संसथापक)

10.5.1.4 उद्यरमयों ्ेक प्र्कार
राित में एक उद्मी कषे  रूप में, आप वनमनवलवखत में सषे वकसी री प्रकाि कषे  उद्म कषे  मावलक बन सकतषे हैं औि उसषे रला सकतषे हैं: 

सोि प्रोप्राइटररशप (ए्कि सिारमति)

एक सोल प्रोप्राइटिवशप (एकल सवावमतव) में, एक व्यवक्त उद्म का सवामी होता ह,ै इसका प्रबंिन किता ह ै औि इस पि वन्ंयत्रण िखता ह।ै काननूी 

औपरारिकताओ ंकषे  संदर्भ  में इस तिह का वबज़नषेस बनाना सबसषे आसान होता ह।ै व्यवसा्य औि मावलक का काननूी अवसततव वरनन नहीं होता ह।ै सािा 

लार सवामी का होता ह,ै इसी तिह सािा घाटा री उसी का होता ह।ै

पाटटिनररशप (रहससेदारी)

पाट्भनिवशप फम्भ  की सथापना दो ्या अविक लोरों द्ािा की जाती ह।ै उद्म कषे  मावलकों को पाट्भनि (वहससषेदाि) कहा जाता ह।ै सरी पाट्भनस्भ (वहससषेदािों) 

द्ािा पाट्भनिवशप समझौतों पि हसताक्ि वक्यषे जानषे रावहएं। फम्भ  औि पाट्भनस्भ (वहससषेदािों) का अलर कोई काननूी अवसततव नहीं होता ह।ै लार का बंटवािा 

पाट्भनस्भ (वहससषेदािों) में होता ह।ै हावन्यों कषे  संदर्भ  में, पाट्भनस्भ (वहससषेदािों) का उत्तदाव्यतव असीवमत होता ह।ै फम्भ  की उम्र अववि सीवमत होती ह ैऔि वकसी 

एक वहससषेदाि की मतृ्ुय हो जानषे, सषेवावनवतृ हो जानषे, दीवावल्या घोवषत हो जानषे ्या वववक्प्त (पारल) हो जानषे पि ्यह समाप्त हो जाती ह।ै

सीरम्त उतिरदारयति पाटटिनररशप (LLP)

सीवमत उत्तिदाव्यतव पाट्भनिवशप ्या LLP में, फम्भ  कषे  वहससषेदाि दीघ्भकावलक अवसततव कषे  साथ-साथ सीवमत उत्तिदाव्यतव का लार उठातें हैं। प्रत्यषेक पाट्भनि 

का उत्तिदाव्यतव LLP को उसकषे  सवीकृत ्योरदान तक सीवमत होता ह।ै पाट्भनिवशप व इसकषे  वहससषेदािों का अलर काननूी अवसततव होता ह।ै

10.5.1.5 सुझाि 
• अन्य लोरों की असफलताओ ंसषे सीखें।

• सुवनवश्चत किें  वक आप ्यही राहतषे हैं।

• अपनषे ववराि सषे वकसी समस्या को जोड कि दषेखनषे की बजाए हल किनषे कषे  वलए समस्या खोजतषे हैं।

10.5.2 िीिररशप ि टीमि्कटि : िीिररशप ि िीिसटि
लीडिवशप का अथ्भ अन्य लोरों कषे  अनुसिण कषे  वलए एक उदाहिण सथावपत किना। एक अच्ा उदाहिण सथावपत किनषे का अथ्भ ह ैवकसी को ऐसा का्य्भ 

किनषे कषे  वलए कहना जो आप सवषेच्ा सषे सव्ंय नहीं किना राहेंरषे। लीडिवशप सषे ्यह पता रलता ह ैवक एक टीम व एक कंपनी कषे  रूप में जीत हावसल किनषे 

कषे  वलए क््या किना ह।ै

लीडि सही काम किनषे में ववश्वास िखतषे हैं। वषे दूसिो को सही का्य्भ  किनषे हषेतु सहा्यता दषेनषे में री ववश्वास िखतें हैं। प्ररावी लीडि वह होता ह ैजो:

• रववष््य कषे  वलए एक प्रषेिक सोर (ववज़न) का वनमा्भण किता ह।ै

• अपनी टीम को उस ववज़न (दूिदृवष्ट) को आरषे बढानषे कषे  वलए उतसावहत व प्रषेरित किता ह।ै
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10.5.2.1 ने्ततृि गुण जो सभी उद्यरमयों ्ेक रिए आिशय्क हैं

सफल उद्मी बनना कषे वल तरी संरव ह,ै जब उद्मी में उतकृष्ट नषेततृव रुण हैं। कु् महतवपणू्भ  नषेततृव ्योग्यताएं जो प्रत्यषेक उद्मी में होनी रावहए:

1. वयिहारर्क्ता: इसका अथ्भ ह ैसरी अविोिों व रुनौवत्यों को सामनषे लानषे की ्योग्यता होना, तावक समस्याओ ंका समािान वक्या जा सकषे  औि 

जोवखमों को कम वक्या जा सकषे ।

2. रिनम्र्ता: इसका अथ्भ ह ैरलवत्यों को आमतौि पि व शीघ्र सवीकाि किना औि अपनी रवतवववि्यों की वजममषेदािी लषेना। रलवत्यों को ऐसी रुनौवत्यों 

कषे  रूप में दषेखा जाना रावहए वजनका सामना वक्या जा सकषे , न वक इनहें वकसी पि दोष लरानषे का अवसि बनाना रावहए।

3. िचीिापन: अच ष्े  लीडि कषे  वलए बहुत लरीला होना औि बदलाव को जलदी सषे सवीकाि किना महतवपणू्भ  होता ह।ै ्यह जानना री उतना ही महतवपणू्भ 

ह ैवक कब वसथवत कषे  अनुसाि सव्ंय को ढाला जा्यषे औि कब नहीं।

4. प्रमारण्क्ता: इसका अथ्भ ह ैअपनी शवक्त्यों व कमज़ोरि्यों, दोनों का प्रदश्भन किना। इसका अथ्भ ह ैइंसान बनना औि अन्य लोरों को वदखाना वक 

आप री इंसान हैं।

5. पुनरारिष्कार: इसका अथ्भ ह ै आवश्यकता पडनषे पि अपनी नषेततृव शलैी को तिोताज़ा किना ्या उसमें बदलाव किना। ऐसा किनषे कषे  वलए ्यह 

सीखना महतवपणू्भ  ह ैवक आपकषे  नषेततृव में कहां कवम्यां ह ैऔि उनहें समाप्त किनषे कषे  वलए कौन-कौन सषे संसािन हैं।

6. जागरू्क्ता: इसका अथ्भ ह ै्यह पता लराना वक अन्य लोर आपको कैसषे दषेखतषे हैं। इसका अथ्भ ह ै्यह समझना वक आपकी उपवसथवत आपकषे  आस-पास 

कषे  लोरों को कैसषे प्रराववत किती ह।ै

10.5.2.2 प्रभािी ने्ततृि ्ेक िायदे
प्ररावी नषेततृव कषे  अनषेक फा्यदषे हैं। महान नषेततृव लीडि को सफलतापवू्भक आरषे बढता ह:ै

• टीम सदस्यों की वफादािी औि प्रवतबद्धता प्राप्त होती ह।ै

• टीम को कंपनी कषे  लक््य औि उद्षेश्य प्राप्त किनषे कषे  वलए उतसावहत होती ह।ै

• टीम सदस्यों में मनोबल का वनमा्भण होता ह ैऔि ववश्वास उत्पनन होता ह।ै

• टीम सदस्यों में आपसी समझ औि टीम रावना बढती ह।ै

• टीम सदस्यों को वकसी री परिवसथवत कषे  अनुसाि बदलाव लानषे की आवश्यकता कषे  वलए सहमत वक्या जा सकता है

10.5.2.3 टीमि्कटि  (सामूरह्क ्कायटि) और टीम

टीमवक्भ  तब होता ह ैजब का्य्भसथल पि लोर अपनी व्यवक्तरत कुशलताओ ंको एक साथ वमलाकि साझषे लक््य को प्राप्त कितषे हैं। प्ररावशाली टीम में वषे लोर 

शावमल होतषे हैं जो इस साझषे लक््य को प्राप्त किनषे कषे  वलए वमलकि काम कितषे हैं। अच्ी टीम वह होती ह ैजो अंवतम परिणाम कषे  वलए सव्ंय को वजममषेदाि 

मानती ह।ै

10.5.2.4 उद्यमशीि्ता ्की सिि्ता में टीम ि्कटि  ्का महति
उद्मशील लीडि कषे  वलए वकसी उपक्रम की सफलता हषेतु प्ररावी टीम महतवपणू्भ  होती ह।ै एक उद्मी को ्यह सुवनवश्चत किना रावहए वक वह जो टीम बनाता 

ह ैउसमें महतवपणू्भ  ववशषेषताएं, लक्ण औि रुण होनषे रावहएं। एक प्ररावशाली टीम वह होती ह ैवजसमें वनमनवलवखत ववशषेषताएं होती हैं:

1. उद्ेशय ्की ए्क्ता: सरी टीम सदस्यों को टीम कषे  उद्षेश्य, ववज़न औि लक््यों को सपष्ट रूप सषे समझना रावहए औि इसकषे  वलए समान रूप सषे प्रवतबद्ध 

होना रावहए।

2. उत्ृकष्ट संिाद ्कौशि: टीम सदस्यों कषे  पास अपनी आशंकाओ ंको व्यक्त किनषे, प्रश्न पू् नषे तथा जवटल जानकािी का वण्भन किनषे कषे  वलए िषे खावरत्र 

व राट््भस का प्र्योर किनषे की ्योग्यता होनी रावहए।
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10.5.2.4.1 सुझाि 
• अपनषे मूल आइवड्या कषे  साथ बहुत ज्यादा न जुडषे िहें। इसमें परिवत्भन औि बदलाव की अनुमवत दें।

• अपनी कमज़ोरि्यों कषे  प्रवत जाररूक िहें औि एक ऐसी टीम बनाएं जो आपकी कवम्यों को पिूा कि सकषे ।

• कषे वल सही लोरों का र्यन किना ही काफी नहीं ह।ै अपनषे सवा्भ विक प्रवतरावान लोरों को प्रोतसावहत ्या पुिसकृत किनषे की री आवश्यकता होती 

ह ैतावक उनहें प्रषेिणा वमलती िहषे।

• अपनी टीम सषे सममान हावसल किें ।

3. रमि्कर ्काम ्करने ्की योगय्ता: प्रत्यषेक सदस्य को समझना रावह्यषे वक उसषे नए ववरािों पि वन्यवमत फीडबकै उपलबि किानषे का हक ह।ै

4. पहि: टीम में अर्तसरक्रय वयरति शारमि होने चारहएं। सदस्यों में नए ववरािों कषे  साथ आरषे आनषे, मौजदूा ववरािों में सुिाि किनषे औि अपना सव्ंय 

का अनुसंिान किनषे का जोश होना रावहए।

5. दूरदृष्टा सदसय: टीम में समस्याओ ंका पवूा्भनुमान किनषे औि उनकषे  वासतववक समस्या में बदलनषे सषे पहलषे इनका समािान वनकाल लषेनषे की ्योग्यता 

होनी रावहए।

6. उत्ृकष्ट अनु्ूकिन योगय्ता: टीम को ्यह ववश्वास होना रावहए वक परिवत्भन एक सकािातमक शवक्त ह।ै परिवत्भन को सुिाि किनषे औि न्यी बातों 

का प्र्यास किनषे कषे  अवसि कषे  रूप में दषेखा जाना रावहए।

7. उत्ृकष्ट संगठनातम्क योगय्ता: टीम कषे  पास मानक का्य्भ  प्रवक्र्याओ,ं उत्तिदाव्यतवों को संतुवलत किनषे, परि्योजनाओ ंकी उवरत ्योजना बनानषे 

औि प्ररवत तथा वनवषेशों पि वमलनषे वालषे लारों का आंकलन किनषे की वववि त्ैयाि किनषे की ्योग्यता होनी रावह्यषे।

10.5.3 संिाद ्कौशि 
संवाद की प्रवक्र्या कषे  दौिान संदषेश को सही तिीकषे  सषे प्राप्त किनषे औि समझनषे की ्योग्यता को शवण (सुननषे की ्योग्यता) कहा जाता ह।ै प्ररावी संवाद कषे  

वलए सुननषे की ्योग्यता महतवपणू्भ  ह।ै प्ररावी शवण (सुननषे की ्योग्यता) कौशल कषे  वबना, संदषेशों को रलत समझा जा सकता ह।ै इससषे संवाद में रूकावट 

आ जाती ह ैऔि संदषेश रषेजनषे व प्राप्त किनषे वाला वनिाश औि पिषे शान हो सकता ह।ै

इस बात पि ध्यान दषेना बहुत महतवपणू्भ  ह ैवक सुननषे का अथ्भ वही नहीं ह,ै जो सुनाई दषेनषे का ह।ै सुननषे का अथ्भ कषे वल उन आवाज़ों सषे ह ैजो आपको सुनाई 

दषेती हैं। शवण (सुननषे की ्योग्यता) का अथ्भ उससषे कहीं अविक व्यापक ह।ै शवण (सुननषे की ्योग्यता) कषे  वलए, ध्यान कें वरित किनषे की आवश्यकता होती 

ह।ै इसका अथ्भ कषे वल कहानी सुनना नहीं ह,ै बवलक इस बात पि ध्यान दषेना री ह ैवक कहानी वकस तिह सुनाई जाती ह,ै वकस तिह की राषा औि आवाज़ 

का प्र्योर वक्या जाता ह ैऔि वक्ता अपनी राव-रंवरमाओ ंका प्र्योर वकस तिह किता ह।ै सुननषे की ्योग्यता इस बात पि वनर्भि किती ह ैकोई व्यवक्त 

मौवखक औि अमौवखक, दोनों तिह कषे  संकषे तों का सही अथ्भ वनकालकि ्या महससू किकषे , वकतना समझ सकता ह।ै

10.5.3.1 प्रभािी रूप से ्ैकसे सुनें 
प्ररावी रूप सषे सुननषे कषे  वलए आपको:

• बातें किना ्ोडना होरा

• टोकना ्ोडना होरा

• जो कहा जाए उस पि पिूी तिह सषे ध्यान लराना होरा

• हामी रिनी होरी औि प्रोतसाहक शबदों व हाव-रावों का इसतषेमाल किना होरा

• खुलषे-ववरािों वाला िहना होरा

• वक्ता कषे  नज़रिए सषे सोरना होरा
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10.5.3.2 प्रभािी रूप से ्ैकसे सुनें 
कोई संदषेश वकतनी सफलता सषे समप्रषेवषत हुआ ह,ै ्यह पिूी तिह सषे इस बात पि वनर्भि किता ह ैवक आपनषे इसषे वकतनषे प्ररावपणू्भ  ढंर सषे गहण वक्या। एक 

प्ररावी वक्ता वह ह,ै जो सपष्ट तिीकषे  सषे बोलषे, शबदों का सही उचरािण किषे , सही शबदों का र्यन किषे  औि उस रवत सषे बोलषे जो आसानी सषे समझ आती हो। 

इसकषे  अलावा, जोि सषे बोलषे जानषे वालषे शबदों का हाव-राव, लहजषे व राव-रंवरमा सषे पिूी तिह सषे वमलान होना रावहए।

आप क््या कहतषे हैं, औि वकस लहजषे में कहतषे हैं, इसकषे  परिणामसवरूप कई िािणाएं बनती हैं। जो व्यवक्त वझझक कि बोलता ह,ै उसकषे  बािषे  में ्यह िािणा 

का्यम की जा सकती ह,ै वक उसमें आतम-ववश्वास की कमी ह ै्या उसषे उस ववष्य में ज्यादा ज्ान नहीं ह,ै वजस पि ररा्भ  की जा िही ह।ै िीमी आवाज़ वालों 

को आसानी सषे शमशीलषे होनषे का दजा्भ  वद्या जा सकता ह।ै औि जो बषेहद सपष्टता कषे  साथ प्ररावशाली लहजषे में बोलतषे हैं, उनहें आमतौि पि बषेहद आतमववश्वासी 

माना जाता ह।ै ्यह बात संराषण को संवाद का एक वनणा्भ्यक कौशल बना दषेती ह।ै

10.5.3.3 प्रभािी रूप से ्ैकसे बोिें 
प्ररावी रूप सषे बोलनषे कषे  वलए आपको:

• अपनषे राषण में आंखें वमलाना, मुसकुिाना, हामी रिना, हाव-राव व्यक्त किना आवद जसैी राव-रंवरमाओ ंको शावमल किना होरा।

• असल में राषण दषेनषे सषे पहलषे अपनषे राषण का मसौदा बनाना होरा।

• सुवनवश्चत किना होरा, वक आपकी सरी रावनाएं व अनुरवूत्यां वन्ंयत्रण में हों।

• अपनषे शबदों को सपष्ट औि उवरत सवि व प्रबलता कषे  साथ बोलना होरा। आपका पिूा राषण वबलकुल सपष्ट होना रावह्यषे।

• राषण कषे  वक्त लहज़ा खुशनुमा व सवाराववक िखषे। आपकषे  शोताओ ंको ऐसा नहीं लरना रावहए वक आप कोई असवाराववक लहज़ा अपना िहषे हैं ्या 

असहज तिीकषे  सषे बोल िहषे हैं।

• अपना संदषेश पहंुरानषे कषे  वलए सटीक व वववशष्ट शबदों का प्र्योर किें । हि हाल में दोहिषे  मतलब वालषे शबदों सषे बरना रावहए।

• सुवनवश्चत किें  वक आपकषे  राषण में एक तावक्भ क प्रवाह हो।

• संवक्प्त िहें। कोई सरूना न जोडें।

• व्यगता औि फडकनषे आवद जसैी वखझानषे वाली आदतों सषे बरनषे का सजर प्र्यास किें ।

• अपनषे शबद ध्यानपवू्भक रुनें औि सिल शबदों का इसतषेमाल किें , वजससषे ज्यादाति शोताओ ंको उनहें समझनषे में कोई पिषे शानी न हो।

• सलाइड्स ्या वहाइटबोड्भ  जसैषे ववजु़अल सािनों का उप्योर किें ।

• सहजता सषे बोलें तावक आपकषे  शोता आसानी सषे समझ सकें  वक आप क््या कह िहषे हैं। हालांवक, ध्यान िहषे, वक इतना िीिषे  री न बोलें, वक इससषे रूखाप़न 

झलकषे  ्या ऐसा लरषे वक आप त्ैयािी कषे  साथ नहीं आ्यषे हैं ्या वफि आप दूसिों को नीरा वदखानषे की कोवशश कि िहषे हैं।

• सही जरहों पि थोडा रुकें ।

• बहुत ज्यादा िीिज िखना होरा

• इसतषेमाल वकए जानषे वालषे लहजषे पि ध्यान दषेना होरा

• वक्ता कषे  हाव-राव, राव-रंवरमाओ ंव आंखों की रवत/हिकत पि ध्यान दषेना होरा

• हडबडाहट व जलदबाजी न मराएं

• वक्ता की बनावट ्या आदत सषे न वरडषे ्या अपना ध्यान बटनषे न दें



325324

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

10.5.3.4 सुझाि 

• अरि आपको इस बात पि ध्यान दषेना मुवशकल लरषे वक कोई क््या कह िहा ह,ै तो उनकषे  शबद अपनषे वदमार में दोहिानषे की कोवशश किें ।

• वजस व्यवक्त सषे आप बात कि िहषे हैं, उसको बोलतषे व सुनतषे वक्त हमषेशा उसकी आंखों सषे संपक्भ  बनाएं िखें। इससषे बातरीत में आपकी वदलरसपी नज़ि 

आती ह ैऔि रूवर बढती ह।ै

10.5.4 समसया समाधान ि मोिभाि/नगैोरशएशन ्कौशि 
Concise Oxford Dictionary (1995) कषे  मुतावबक, समस्या का मतलब ह,ै “एक संदषेहातमक ्या मुवशकल मसला वजसषे समािान की ज़रूित हो”

सरी समस्याओ ंमें दो ततव होतषे हैं:

1. लक््य 

2. बािाएं

समस्या समािान का उद्षेश्य बािाओ ंको पहरानना औि लक््य प्रावप्त हषेतु उनहें दूि किना होता ह।ै

10.5.4.1 समसयाएं ्ैकसे सुिझाएं

10.5.4.2 समसया सुिझाने ्ेक महतिपूणटि गुण

वकसी समस्या को सुलझानषे कषे  वलए तावक्भ क सोर की ज़रूित पडती ह।ै जब कोई मसला सुलझाना हो तो इन तावक्भ क रिण अपनाएं:

• चरण 1: समस्या पहरानें 

• चरण 2: समस्या का ववसताि सषे अध्य्यन किें

• चरण 3: सरी संराववत समािानों की सरूी बनाएं 

• चरण 4: बषेहतिीन समािान रुनें

• चरण 5: रुनषे हुए समािान को लार ूकिें   

• चरण 6: जांरें वक समस्या वाकई सुलझ रई है

समस्या सुलझानषे की अत्ंयत ववकवसत ्योग्यता, व्यवसाव्य्यों तथा उनकषे  कम्भरारि्यों, दोनों कषे  वलए बषेहद ज़रूिी हैं। समस्याओ ंको प्ररावशाली ढंर सषे 

सुलझानषे में वनमन व्यवक्तरत रुण एक महतवपणू्भ  रवूमका वनरातषे हैं:

• खुलषे ववरािों वाला बनें 

• सही सवाल पू् ें

• सवक्र्य िहें 

• घबिाएं नहीं

• सकािातमक दृवष्टकोण िखें 

• सही समस्या पि ध्यान दें
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10.5.4.2 समसया सुिझाने ्ेक महतिपूणटि गुण

10.5.4.3 नगैोरशएशन कया ह?ै

एक उद्मी कषे  तौि पि, ्यह अच्ी बात ह ैवक संराववत उममीदवािों को वन्ुयक्त किनषे सषे पहलषे उनकषे  समस्या सुलझानषे कषे  हुनि को पिखा जाए। इस हुनि 

को पिखनषे कषे  कु् तिीकषे  इस तिह हैं:

• आिेदन पत्र: आवषेदन पत्र में उममीदवाि कषे  समस्या सुलझानषे कषे  कौशल का कोई प्रमाण माँरषे।

• मनोरमर्तय/साइ्कोमरैट््क परीक्ण: संराववत उममीदवािों सषे तावक्भ क सवाल पू् ें  औि उनहें रंरीि वरंतन वालषे प्रश् न दें औि दषेखें वक वषे वकतनषे 

कािरि हैं।

• साक्ात्कार: बनावटी समस्यागसत हालात पदैा किें  ्या नवैतक सवाल उठाएं औि दषेखें वक उममीदवाि कैसषे जवाब दषेतषे हैं।

• ्त्कनी्की सिाि: उममीदवािों को असल वजं़दरी की समस्याओ ंकषे  उदाहिण दें औि उनकी वरंतन प्रवक्र्या का मूल्यांकन किें ।

नरैोवशएशन मतरषेदों को दूि किनषे का एक तिीका ह।ै नरैोवशएशन का उद्धषेश्य, वववादों को टालतषे हुए, समझौतषे ्या िाजीनामषे कषे  जरिए मतरषेदों को हल 

किना ह।ै नरैोवशएशन कषे  वबना, मतरषेद लोरों कषे  बीर अंसतोष को जनम दषेतषे हैं। नरैोवशएशन का अच्ा हुनि दोनों पक्ों को संतुष्ट किनषे में मदद किता 

ह ैऔि मजबतू रिशतषे बनानषे की ओि लषे जाता ह।ै

नगैोरशएशन कयों

व्यवसा्य शुरू किनषे में कई नरैोवशएशन किनषे पडतषे हैं। कु् नरैोवशएशन ्ोटषे होतषे हैं जबवक अन्य इतनषे रंरीि होतषे हैं वक सटाट्भअप बना ्या वबराड 

सकतषे हैं। नरैोवशएशन का्य्भसथल पि री अहम रवूमका वनरातषे हैं। एक उद्मी कषे  तौि पि, आपको न महज ्यह जाननषे की ज़रूित होती ह ै वक खुद 

नरैोवशएट कैसषे किें , बवलक ्यह री वक नरैोवशएशन की कला में कम्भरारि्यों को री कैसषे प्रवशवक्त किें ।

नगैोरशएशन ्ैकसे ्करें

नरैोवशएशन समझनषे कषे  वलए कु् रिणों पि ध्यान दें:

चरण 1: नरैोवशएशन सषे पहलषे की त्ैयािी: समस्या पि बातरीत किनषे कषे  वलए वमलनषे कषे  सथान पि सहमवत, ्यह त्य किना वक कौन-कौन मौजदू होंरषे 

औि बातरीत कषे  वलए सम्यसीमा त्य किना।

चरण 2: समस्या पि ररा्भ  किना: इसमें सवाल पू् ना, दूसिा पक् सुनना, अपनषे ववराि सामनषे िखना औि संदषेहों को दूि किना शावमल ह।ै

चरण 3: उद्धषेश्य सपष्ट किें : सुवनवश्चत किें  वक दोनों ही पक् समान समस्या हल किना राहतषे हैं औि समान लक््य तक पहँुरना राहतषे हैं।

चरण 4: दानों पक्ों कषे  लार का लक््य िखें: नरैोवशएशन कषे  वक्त खुलषे ववरािों वाला िहनषे की पिूी कोवशश किें । दोनों पक्ों कषे  लार की वसथवत पानषे कषे  

वलए समझौता किें  औि वकैवलपक समािान पषेश किें ।

चरण 5: समझौतषे को सपष्ट तौि पि परिरावषत किें : जब कोई समझौता त्य हो जाए, तो समझौतषे का ववविण दोनों पक्ों को एकदम सपष्ट होना रावहए, 

रलतफहमी की कोई रंुजाइश नहीं होनी रावहए।

चरण 6: सव्भसममत समािान को लार ूकिें : समािान को अमल में लानषे कषे  वलए का्य्भवाही किनषे पि सहमत हों।

10.5.4.4 सुझाि 
• इस पि अमल किनषे सषे पहलषे ्यह जान लें वक आप राहतषे क््या हैं

• बोलनषे की बजाए सुननषे व सोरनषे को ज्यादा अहवम्यत दें

• जीतनषे की बजाए रिशता का्यम किनषे पि ध्यान दें
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10.5.5 वयिसारय्क अिसरों ्की पहचान

• ्याद िखें वक आपका व्यवहाि कौशल नतीजषे पि असि डालषेरा

• जानें वक कब पी ष्े  हटना ह ै– क््योंवक करी-कराि समझौतषे पि पहंुरना मुमवकन नहीं होता

“उद्यमी हमशेा बिलाि की खोज में रहता ह,ै इस पर ्रवतवक््ा िेता ह ैऔर एक अिसर के तौर पर इसका इस्तमेाल करता ह।ै” 

पीटि ड्कि

व्यवसाव्यक अवसिों को पहराननषे की ्योग्यता एक उद्मी का एक अहम रुण ह।ै

अिसर कया ह?ै

अवसि शबद का अथ्भ हालातों की वजह सषे वमलनषे वाला एक अच्ा मौका ्या कु् किनषे कषे  वलए एक अनुकूल माहौल होता ह।ै

एक व्यवसाव्यक अवसि का मतलब ह ैवक मौजदूा माहौल में, मौजदूा सम्य में, वकसी खास व्यवसा्य को रलानषे कषे  वलए उपलबि एक अच्ा ्या अनुकूल 

बदलाव।

उद्यरमयों ्ेक सामने आने िाि ेआम सिाि

एक रंरीि सवाल वजसका सरी उद्मी सामना कितषे हैं, वक उस व्यवसाव्यक अवसि को कैसषे खोजें जो उनकषे  वलए सही हो।

कु् आम सवाल वजनकषे  बािषे  में उद्मी लराताि सोरतषे िहतषे हैं:

• क््या नए उपक्रम को वकसी अपणू्भ  आवश्यकता कषे  आिाि पि कोई न्या उतपाद ्या सषेवा लानी रावहए?

• क््या नए उपक्रम को एक बाजाि सषे कोई मौजदूा उतपाद ्या सषेवा रुनकि इसषे दूसिषे  बाज़ाि में पषेश किना रावहए, जहां ्यह उपलबि न हो?

• क््या उपक्रम को एक आजमाए व पिीवक्त फॉमू्भलषे पि आिारित िहना रावहए, जो हि जरह काम किषे ?

इसवलए ्यह बषेहद ज़रूिी ह ैवक उद्मी जानें वक नए व मौजदूा व्यवसाव्यक अवसिों को कैसषे पहरानें औि उनकी सफलता की संरावनाओ ंको पिखें।

्कोई सोच ए्क अिसर ्कब हो्ती ह?ै

एक सोर एक अवसि तब होती ह ैजब:

• ्यह गाहक कषे  वलए मूल्यवद्ध्भन किषे

• ्यह वकसी अहम समस्या को हल किषे , दुखती नबज ठीक किषे  ्या कोई मांर पिूी किषे

• एक तरडा बाजाि औि मुनाफषे  की रंुजाइश हो

• सही सम्य व सथान पि संसथापक व मनैषेजमेंट टीम कषे  साथ अच्ा तालमषेल हो

अवसिों को दषेखतषे वक्त ध्यान दषेनषे वालषे कािक

• व्यवसाव्यक अवसिों को दषेखतषे वक्त वनमन पि ध्यान दें:

• फंवडंर में बदलतषे आवथ्भक रूझान

• वेंडस्भ, पाट्भनस्भ व सपला्यस्भ कषे  बीर बदलतषे रिशतषे

• बाजाि कषे  रूझान

• िाजनीवतक समथ्भन में बदलाव

• लवक्त लोरों में बदलाव
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नए वयिसारय्क अिसरों ्को पहचानने ्ेक ्तरी्ेक

• बाजार ्की अक्म्ताएं पहचानें: जब कोई बाजाि दषेखें, तो इस बात पि ध्यान दें वक कौन सी अक्मताएं बाजाि में मौजदू हैं। इन अक्मताओ ंको ठीक 

किनषे कषे  तिीकों कषे  बािषे  में सोरें।

• मुखय बाधाओ ं्को दूर ्करें : न्या उतपाद ्या सषेवा बनानषे कषे  बजाए, आप नए ढंर सषे कोई उतपाद, सषेवा ्या प्रवक्र्या सुिाि सकतषे हैं।

• ्ुकछ नया रचें: मौजदूा व्यवसाव्यक मॉडलों कषे  आिाि पि सोरें वक आप गाहकों कषे  वलए न्या अनुरव कैसषे िर सकतषे हैं।

• ्कोई उभर्ता क्ेत्र/उद्योग चुनें: शोि किें  औि पता लराएं वक कौन सा क्षेत्र ्या उद्ोर उरि िहा ह ैऔि सोरें वक कौन सषे अवसि आप इसमें जोड  

सकतषे हैं।

• उतपाद रभनन्ता ्ेक बारे में सोचें: अरि आपकषे  वदमार में पहलषे सषे ही कोई उतपाद ह,ै तो इसषे मौजदूा उतपादों सषे अलर सथावपत किनषे कषे  तिीकों कषे  

बािषे  में सोरें।

अपने वयिसाय ्ेक भी्तर वयिसारय्क अिसर पहचानने ्ेक ्तरी्ेक

SWOT पड़्ताि: अपनषे व्यवसा्य कषे  रीति अवसि पहराननषे का एक बषेहतिीन तिीका SWOT ववश्षे षण का वनमा्भण किना ह।ै SWOT का मतलब 

सट्ेंथ(मजबतूी), वीकनषेस(कमजोिी), अपिच्ुयवनटी(अवसि), व थ्षेट(डि) ह।ै SWOT ववश्षे षण फ्षे मवक्भ :

व्यवसाव्यक अवसिों को दषेखतषे वक्त वनमन पि ध्यान दें:

SWOT फ्षे मवक्भ  कषे  इसतषेमाल सषे खुद को व अपनषे प्रवत्योवर्यों को दषेखतषे हुए, आप उन अवसिों को ढंूढ सकतषे हैं वजनहें आप संरालनषे कषे  साथ-साथ 

इसतषेमाल कि सकें  औि उन डिों को दूि कि सकें  जो आपकी सफलता को पटिी सषे उताि सकतषे हैं।

अपनी USP स्थारप्त ्करें

अपनी USP सथावपत किें  औि खुद को अपनषे प्रवत्योवर्यों सषे हटकि दशा्भ एं। पता लराएं, वक गाहक आपसषे क््यों खिीदेंरषे औि उस वजह को बढावा दें।

तित्र 10.5.1: SWOT तिशे्रण
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अिसर ्का रिशे्षण

जब आप एक बाि अवसि की पहरान कि लें, तो आपको इसकषे  ववश्षे षण किनषे की ज़रूित होरी। वकसी अवसि का ववश्षे षण किनषे कषे  वलए, आपको:

• सोर पि ध्यान कें वरित किना है

• सोर कषे  बाजाि पि ध्यान कें वरित किना है

• सोर में समान वसथवत वालषे इंडसट्ी लीडस्भ सषे बात किनी है

• सोर में समान वसथवत वालषे बडषे व्यवसाव्य्यों सषे बात किनी है

10.5.5.1 सुझाि 
• ्याद िखें, वक अवसि हालात कषे  मुतावबक होतषे हैं।

• सफल सावबत हो रुका ट्कै रिकॉड्भ  अपनाएं।

• लषेटषेसट क्रषे ज़ सषे बरें।

• अपनी सोर सषे प्याि किें ।

10.5.6 उद्यरम्ता इ्को-रससटम ्को सपोटटि ्कर्ती है

एक उद्मी वो व्यवक्त ह ैजो:

• वकसी कम्भरािी कषे  वलए काम नहीं किता

• एक ्ोटा उपक्रम रलाता है

• उपक्रम कषे  सरी जोवखमों व फा्यदों, सोर, माल ्या सषेवा को मानकि रलता है

उद्यरमयों ्ेक प्र्कार

उद्मी मुख्य तौि पि राि प्रकाि कषे  हैं:

1. परंपराग्त उद्यमी: इस तिह कषे  उद्मी में आमतौि पि वकसी तिह का हुनि होता ह ै– वषे बढई, वम्रिी, बावरशी आवद हो सकतषे हैं। उनकषे  ऐसषे व्यवसा्य 

होतषे हैं जो कई सालों सषे रलषे आ िहषे हैं जसैषे िषे सटोिें ट, दुकान व बढई। खासतौि सषे, समान क्षेत्र में अपना खुद का व्यवसा्य शुरू किनषे सषे पहलषे वषे वकसी 

खास इंडसट्ी में रिपिू अनुरव हावसल कितषे हैं।

2. रि्कास क्म्ता िाि ेउद्यमी: इस तिह कषे  उद्मी की इच्ा एक ऐसा उपक्रम शुरू किनषे की होती ह ैजो ववकास किषे , बहुत सषे गाहक बना्यषे औि ढषेि 

सािा पसैा कमाए। उनका अंवतम लक््य आवखिकाि अपनषे उपक्रम को अच ष्े  मुनाफषे  पि बषेरना होता ह।ै ऐसषे उद्वम्यों की आमतौि पि ववज्ान ्या 

तकनीकी पषृ्ठरवूम होती ह।ै

3. प्रोजेकट-िरक्य्त उद्यमी: इस तिह कषे  उद्मी आमतौि पि कला ्या मनोववज्ान की पषृ्ठरवूम वालषे होतषे हैं। उनकषे  उपक्रम ऐसी रीज़ों पि ध्यान कें वरित 

किनषे की कोवशश कितषे हैं वजनको लषेकि वषे बषेहद जुननूी होतषे हैं।

4. जीिनशिैीग्त उद्यमी: इस तिह कषे  उद्मी आमतौि पि एक टीरि ्या एक सवरव कषे  तौि पि काम कितषे हैं। वषे बहुत ज्यादा पसैा कमानषे की बजाए, 

ऐसी रीज़ बषेरनषे में रूवर िखतषे हैं वजसषे लोर पसंद किें ।

ए्क उद्यमी ्ेक गुण

सफल उद्वम्यों में वनमनवलवखत रुण होतषे हैं:

• वषे बषेहद अवरप्रषेरित होतषे हैं
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• वषे िरनातमक व सीखनषे की ललक िखनषे वालषे होतषे हैं

• वषे हिषे क काम को संरालनषे कषे  वलए मानवसक तौि पि त्ैयाि होतषे हैं

• उनमें व्यवसा्य का बषेहतिीन हुनि होता ह ै– वषे जानतषे हैं वक अपना नकदी प्रवाह, वबक्री व मुनाफा कैसषे जांरें

• वषे बडषे जोवखम उठानषे कषे  वलए त्ैयाि होतषे हैं

• बषे बषेहद सवक्र्य होतषे हैं – इसका मतलब ह ैवक वषे वकसी दूसिषे  का इंतजाि किनषे की बजा्य, अपना काम सव्ंय किना राहतषे हैं

• उनकषे  पास एक नजरि्या होता ह ै– वषे पणू्भ  परिप्रषेक््य दषेखनषे की ्योग्यता िखतषे हैं

• वषे लरीलषे औि खुलषे ववरािों वालषे होतषे हैं

• वषे फैसला लषेनषे में अच ष्े  होतषे हैं

10.5.6.1 उद्यमी ्की सिि ्कहारनयां

10.5.6.2 उद्यरम्ता ्की प्ररक्रया

धीरू भयाई अंबयानी

िीरू भाई अबंानी न ेअपना उद्यमी करर्र सप्ाहातं पर माउंट वगरनार म ें तीथ््स ावरि्ों को “पकौड़े” बचेन ेस ेश युरू वक्ा था। 16 की उम्र म ें, ि े्मन गए जहा ं

उनहोंन ेएक गसै-स्टेशन अटेंडेंट, और एक तले कंपनी म ें कलक्स  के तौर पर काम वक्ा। ि े50,000 रुप्ों के साथ भारत लौटे और एक टेकसटाइल ट्वेडंग 

कंपनी श युरू की। ररला्सं गलोबल माकमे ट म ें पसैा उगाहन ेिाली पहली भारती् कंपनी बनी और फॉबस्स 500 की सचूी म ें जगह पान ेिाली पहली भारती् 

कंपनी बनी।

डॉ. करसनभयाई पटले

करसनभाई पटेल न ेअपन ेघर के पी् ेअहात ेम ें वडटजजेंट पाउडर बना्ा। ि ेअपना उतपाि घर-घर जाकर बचेत ेथ ेऔर बचे ेगए हरेक पकै पर पसैा िापसी 

की गारंटी भी िेत ेथ।े ि े3 रुप् े्रवत . वकलोग्ाम लते ेथ ेजबवक उस िक्त सबस ेसस्ता वडटजजेंट 13 रुप् े्रवत वकलोग्ाम था। डॉ. पटेल न ेआवखरकार वनरमा 

श युरू वक्ा जो भारती् घरेल ूवडटजजेंट बाजार का परूी तरह स ेएक न्ा वहस्सा बन ग्ा।

रवलए उद्वमता प्रवक्र्या कषे  रिणों पि एक नजि डालतषे हैं।

• चरण 1: सोर वनिा्भिण। उद्वमता प्रवक्र्या एक ऐसषे ववराि सषे शुरू होती ह ैजो उद्मी कषे  मन में आ्या हो। ्यह ववराि एक समस्या होती ह,ै जो हल की 
जा सकती ह।ै

• चरण 2: पनपना ्या मान्यता प्राप्त किना। इस रिण में सोरी रई समस्या का संराववत समािान वनकाला जाता ह।ै

• चरण 3: त्ैयािी किना ्या व्याख्या किना। समस्या का आरषे अध्य्यन वक्या जाता ह ैऔि ्यह पता लरानषे कषे  वलए शोि वक्या जाता ह ैदूसिों नषे समान 
समस्या का हल वनकालनषे कषे  वलए कैसषे कोवशश की।

• चरण 4: सपनषे बुनना ्या कलपना किना इस रिण में िरनातमक ववराि मंथन शावमल ह,ै तावक औि अविक ववराि (आइवड्याज़) मन में आएं। समस्या 
वालषे क्षेत्रों पि ज्यादा सोर-ववराि नहीं वक्या जाता।

• चरण 5: संराव्यता अध्य्यन: अरला कदम ह,ै एक संराव्यता अध्य्यन किना, वजससषे ्यह पता लरा्या जा सकषे , वक ्यह आइवड्या लारदषे्य होरा ्या 
नहीं औि इसषे आज़मा्या जा्यषे ्या नहीं।

• चरण 6: प्रकावशत किना ्या हकीकत में बदलना ्यह तब होता ह ैजब सरी अवनवश्चत क्षेत्र अरानक सपष्ट हो जातषे हैं। उद्मी को पिूा ववश्वास हो जाता 
ह,ै वक उसकी सोर में दम ह।ै

• चरण 7: पुष्टीकिण ्या प्रमाणीकिण। इस आवखिी रिण में, इस बात की पुवष्ट की जाती ह,ै वक ्यह आइवड्या काम किषे रा वक नहीं औि ्यह उप्योरी 
ह,ै ्या नहीं।

इस प्रवक्र्या की बषेहति समझ पानषे कषे  वलए नीरषे वदए वरत्र पि नजि डालें।
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10.5.6.3 उद्यमी कया हो्ता ह?ै
उद्वमता ईकोवससटम को समवथ्भत किती ह,ै ्यह उद्वमता कषे  संगवहत तथा समग सवरूप का द्ोतक ह।ै नई कंपवन्यां कषे वल उनहें लॉरं किनषे वालषे साहसी, दूि 

दृष्टा उद्वम्यों की बदौलत नहीं उरिती तथा फलती-फूलती, बवलक इसवलए काम्याब होती हैं, क््योंवक ्यषे वनजी तथा साव्भजवनक प्रवतरावर्यों सषे रिषे  परिवषेश 

्या ‘‘ईकोवससटम’’ में लराई जाता हैं। ्यषे प्रवतरारी इन न्यषे उपक्रमों को पोवषत किकषे  तथा बना्यषे िखकि इन उद्वम्यों कषे  प्र्यासों को सफल बनातषे हैं।

उद्वमता ईकोवससटम वनमनवलवखत ्ह क्षेत्रों सषे बना ह:ै

1. अनु्ूकि संस्ृकर्त: इसमें उद्मी की जोवखम व रलवत्यों को सहनषे की शवक्त, बवढ्या नषेटववकयं र औि सकािातमक सामावजक रुतबा जसैषे ततव 

शावमल हैं।

2. सुरिधाजन्क नीर्तयां ि ने्ततृि: इसमें वन्यामक फ्षे मवक्भ  कषे  लार औि साव्भजवनक अनुसंिान संसथानों का अवसततव शावमल ह।ै

3. रितिीय रि्कलप: एंजषेल फाइनेंवसंर, उपक्रम पूंजीपवत औि माइक्रो लोनस इसकषे  अच ष्े  उदाहिण होंरषे।

4. मानि पंूजी: इसका संदर्भ प्रवशवक्त व अप्रवशवक्त शम, उद्मी औि उद्वमता प्रवशक्ण प्रोगाम आवद सषे हैं।

5. उतपाद ि सेिाओ ं्ेक रिए रह्त्कर बाजार: इसका तातप्य्भ  उतपाद/सषेवा कषे  वलए बाजाि की मौजदूरी ्या मौजदूरी की संरावना सषे ह।ै

6. संस्थाग्त ि आधारभू्त संरचनातम्क सपोटटि: इसमें काननूी व ववत्ती्य सलाहकाि, दूिसंराि, वडवज़टल व ट्ांसपोटदेशन इंफ्ासट्क्रि औि उद्वमता 

नषेटववकयं र का्य्भक्रम शावमल हैं।

्यषे रार दशा्भतषे हैं वक क््या उद्वमता को सपोट्भ  किनषे वाला एक मजबतू ईकोवससटम ह ैऔि इसषे औि अविक प्रोतसावहत किनषे हषेतु सिकाि को क््या कदम 

उठानषे रावहएं। ्ह रार औि उनकषे  वववरनन ततव गाफ कषे  रूप में दशा्भए रए हैं।

तित्र 10.5.2: उद्तमिा प्रकक्या के िरण
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तित्र 10.5.4: उद्तमिा को समथटिन देने िािा ईकोतस्टम
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हि उद्वमता को समवथ्भत किनषे वाला ईकोवससटम अनठूा ह ैऔि इस तंत्र कषे  सरी ततव पिसपि वनर्भि हैं। ्यद्वप, हि उद्वमता ईकोवससटम का उपिोक्त ्: 

ववशषेषताओ ंद्ािा व्यापक रूप सषे वण्भन वक्या जा सकता ह,ै हि ईकोवससटम सकैडों ततवों की एक-दूसिषे  सषे होनषे वाली जवटल तथा वववशष्ट अनत: वक्र्याओ ं

का नतीजा ह।ै

उद्वमता ईकोवससटम आवखिकाि (व्यापक तौि पि) खुद सषे रलनषे वाला बन जाता ह।ै जब ्यषे ्ह रार प्या्भप्त लरीलषे होतषे हैं, तो ्यषे पिसपि लारदा्यक होतषे 

हैं। इस वबंदु पि, सिकाि की रारीदािी बडषे सति पि कम हो सकती ह ैऔि होनी रावहए। ईकोवससटम को सुरारू रूप सषे रलानषे कषे  वलए साव्भजवनक नषेताओ ं

को ज्यादा वनवषेश किनषे की ज़रूित नहीं पडती। ्यह लावजमी ह ैवक उद्वमता ईकोवससटम प्रोतसाहन सव-रुरतान कषे  वहसाब सषे बनषे होतषे हैं, इसवलए परिवषेश 

की वहनी्यता पि कें वरित होतषे हैं।

10.5.6.4 उद्यरम्ता ई्कोरससटम में सर्कार ्की भूरम्का

10.5.6.5 भार्त में उद्यरम्ता ई्कोरससटम ्की ्तसिीर

नए उपक्रमों को प्रोतसाहन दषेनषे पि नीवतवनमा्भताओ ं का ववशषेष ज़ोि िहता ह।ै दुवन्या रि में सिकािें  इस बात को मान िहीं हैं, वक वववशष्ट प्रकाि कषे  

समथ्भनकािी माहौल में व्यापाि फलतषे-फूलतषे हैं। नीवतवनमा्भताओ ंको हालात का अध्य्यन किना रावहए औि नीवत्यां व वन्यामक बनातषे वक्त वनमनवलवखत 

वबंदुओ ंको ध्यान में िखना रावहए वजससषे उद्वमता को समथ्भन दषेनषे वाला एक सफल ईकोवससटम बन सकषे ।

• नीवतवनमा्भताओ ंको उन वन्यामकों सषे बरना रावहए जो नए प्रवत्योवर्यों को हतोतसावहत कितषे हैं औि व्यवसा्य सटाट्भअपस कषे  वलए सक्म तिीकषे  

बनानषे की ओि काम किना रावहए। नीवत्यां व वन्यामक जो उद्वमता उपक्रमों कषे  मुकाबलषे मौजदूा प्रबल कमपवन्यों की पक्िि हैं, सपिा्भ  को सीवमत 

किती हैं औि नई कमपवन्यों कषे  प्रवषेश में िोडा बनती हैं।

• बाज़ाि की नाकावम्यों में संशोिन किनषे हषेतु नीवत्याँ ववकवसत किनषे कषे  बजा्य, नीवतवनमा्भताओ ंको उद्वम्यों सषे बातरीत किनी रावह्यषे औि उन 

रुनौवत्यों को समझना रावह्यषे वजनका वषे सामना कि िहषे हैं। न्यषे आइवड्या की खोज, उतपाद ववकास तथा सौदषे का प्रवाह बढानषे हषेतु प्रषेरित किनषे 

वाली नीवत्यों कषे  ववकास कषे  वलए फीडबकै का प्र्योर वक्या जाना रावह्यषे।

• उद्वमता समथ्भकों को एक डाटाबषेस बनाना रावहए जो ्यह पहरान किनषे में सक्म हो वक ईकोवससटम में रारीदािी किनषे वालषे कौन हैं औि वषे कैसषे 

जुडें  हैं। ्यषे ईकोवससटम मपै अनुबंि िणनीवत्यां बनानषे में कािग़ि औजाि हैं।

• आवथ्भक व सामवजक जीवन में दुघ्भटनाएं अपरिहा्य्भ  हैं। हालांवक, ्यहॉ ं्यह उललषेखनी्य ह,ै वक आवथ्भक दुघ्भटनाएं उद्वमता कषे  अवसि पदैा किती हैं। 

उद्वमता ईकोवससटम कषे  वनमा्भताओ ं (उद्मी, मेंटि, नीवतवनमा्भता व उपरोक्ता,) को इन वरिावटों को रांपना रावहए, तावक उनकषे  रलतषे पदैा हुए 

अवसिों सषे लार कमा्या जा सकषे ।

सथानी्य उद्वमता ईकोवससटम को समथ्भन दषे, इसकषे  वलए प्ररावी िणनीवत्यों की आवश्यकता व्यवहारिक ह।ै असल ईकोवससटम की बषेहति समझ एक 

फ्षे मवक्भ  प्रदान किती ह,ै वजसकषे  तहत नीवतवनमा्भता प्रासंवरक सवाल पू्  सकतषे हैं, अविक का्य्भकुशल दृवष्टकोण अपना सकतषे हैं औि आनषे वालषे नतीजों 

का मूल्याँकन कि सकतषे हैं।

उद्वमता को राित में न्या सममान वमला ह।ै बहुत सषे रािती्य, जो कािोबाि की दुवन्या सषे वावकफ हैं, वजनहोंनषे पिंपिारत रूप सषे नौकिी किनषे का ववकलप 

रुना था, अब अपनषे उपक्रम सथावपत कि िहषे हैं। उद्वमता ईकोवससटम कषे  बहुत सषे ततव अब इकट्षे होनषे शुरु हो र्यषे हैं। उदाहिण कषे  वलए, उपक्रम पूंजीपवत्यों, 

सिकािी ्योजनाओ ंव इंक््ुयबषेटस्भ, वशक्ा उद्ोर संपक्भ  तथा उरितषे समूहों में इज़ाफा औि गामीण अथ्भव्यवसथा को समथ्भन। ्यषे सरी पहलें प्ररावी हैं, लषेवकन 

ईकोवससटम को वनमनवलवखत तिीकों द्ािा वफि सषे बढानषे व समदृ्ध किनषे की ज़रूित ह:ै

1. हमें असफलताओ ंकषे  प्रवत अपनषे व्यवहाि की समीक्ा किनषे की ज़रूित ह ैऔि उनहें अनुरव कषे  तौि पि सवीकाि किनषे की ज़रूित ह।ै

2. हमें वशवक्तों को उद्मी बननषे कषे  वलए प्रोतसावहत किनषे की ज़रूित ह ैऔि सकूल व कॉलषेजों में उद्मी हुनि मुह्ैया किवानषे की ज़रूित ह।ै

3. वववश्वववद्ाल्य, अनुसंिान प्र्योरशालाओ ंतथा सिकाि को उद्वमता को समथ्भन दषेनषे वाला ईकोवससटम त्ैयाि किनषे में अपनी रवूमका वनरानषे की 

आवश्यकता ह।ै
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4. नीवतवनमा्भताओ ंको भ्रष्टाराि, िषे ड टषेप व अफसिशाही जसैी बािाओ ंको कम किनषे पि ध्यान दषेनषे की ज़रूित ह।ै

5. हमें अपनषे काननूों में संशोिन किना रावह्यषे, अंतिा्भष्ट्ी्य उपक्रम पूंजी फमकों को आकवष्भत किना रावह्यषे औि उनहें राित लषे आना रावह्यषे।

6. हमें राित कषे  उन वद्ती्यक व ततृी्यक शहिों तक पहंुरनषे कषे  वलए नीवत्यां व वववि्यां बनानी रावहए, जहां लोरों की पठै उन संसािनों तक नहीं ह,ै 

जो शहिों में उपलबि हैं।

आज, इस दषेश में नवीन समािान शावमल किनषे का एक बडा अवसि ह ैजो आरषे बढनषे में सक्म हो औि ईकोवससटम में सह्योर किषे  औि साथ ही इसषे  

समदृ्ध किषे ।

10.5.6.6 मे्क इन इंरिया अरभयान

हिषे क उद्मी की कु् ज़रूितें होती हैं। उनकी कु् महतवपणू्भ  ज़रूितें इस प्रकाि हैं:

• आसानी सषे कज्भ पाना

• आसानी सषे वनवषेशक पाना

• किों सषे ्ूट पाना

• संसािनों व बषेहति आिािरतू संिरना की आसान पठै

• ऐसी प्रवक्र्या का लार उठाना, वजसमें कोई पिषे शानी न हो औि तवरित हो

• अन्य फमकों सषे आसानी सषे रारीदािी कि सकें

प्रिानमंत्री मोदी द्ािा लॉनर मषेक इन इंवड्या अवर्यान, का मकसद ्ुयवाओ,ं महतवाकांक्ी उद्वम्यों की इन सरी ज़रूितों को पिूा किना ह।ै इसका मकसद 

्यषे ह:ै

• वनवषेश को आसान बनाना

• नई सोर को समथ्भन दषेना

• कौशल ववकास बढाना

• उद्वम्यों कषे  आइवड्या की सुिक्ा

• उतपादों कषे  वनमा्भण कषे  वलए अत्यािुवनक सुवविाएं बनाना

10.5.6.6 सुझाि 
• अन्य उद्वम्यों, उपक्रम पूंजीपवत्यों, एंजषेल वनवषेशकों कषे  साथ मौजदूा बाजाि, नषेटवक्भ  का शोि किना औि आपकी उद्वमता को सक्म किनषे कषे  वलए 

लार ूनीवत्यों की ववसताि सषे समीक्ा किना।

• असफलता आरषे बढनषे कषे  वलए एक सीढी ह,ै न वक िासतषे का अंत। अपनी व अपनषे सावथ्यों की रलवत्यों की समीक्ा किें  औि अपनषे रावी उपक्रम में 

इनहें सुिाि लें।

• अपनषे ईकोवससटम में सवक्र्य िहें। अपनषे ईकोवससटम की अहम ववशषेषताएं पहरानें औि अपनषे उद्म को समथ्भन दषेनषे वालषे ईकषे वससटम कषे  वलए सव-

वहनी्यता सुवनवश्चत किनषे हषेतु उसषे समदृ्ध कितषे िहें।
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10.5.7 जोरखमों उठाने ्की इचछा ि िचीिापन

उद्यरम्ता और जोरखम

उद्मी सवाराववक रूप सषे जोवखम उठानषे वालषे होतषे हैं। वषे पथ का वनमा्भण किनषे वालषे होतषे हैं, न वक पहलषे सषे त्य पथ पि रलनषे वालषे। एक आम, एहवत्याती 

व्यवक्त कषे  उलट, एक उद्मी अपनी नौकिी (उसकी एकमात्र आमदनी) ्ोडनषे औि अपनषे आइवड्या कषे  वलए सव्ंय को जोवखम में डालनषे कषे  बािषे  में दो बाि 

नहीं सोरषेरा।

एक उद्मी जानता ह ैवक अपनषे सपनों को पिूा कितषे वक्त उसकषे  अनुमान रलत सावबत हो सकतषे हैं औि अप्रत्यावशत घटनाएं घट सकती हैं। वह जानता ह ै

वक कई समस्याओ ंसषे वनपटनषे कषे  बाद री, सफलता की कोई रािंटी नहीं ह।ै उद्वमता जोवखम उठानषे की ्योग्यता का प्या्भ्यवारी ह।ै ्यह ्योग्यता, जो वक 

जोवखम लषेनषे की क्मता कहलाती ह,ै एक उद्मी का रुण ह ैजो वक कु् हद तक आनुवंवशक होता ह ैऔि कु् हद तक हावसल वक्या र्या।

जोरखम िनेे ्की क्म्ता कया ह?ै

जोवखम लषेनषे की क्मता की परिराषा ्यह ह,ै वक कमपनी अपनषे उद्धषेश्यों की प्रावप्त कषे  वलए वकस हद तक जोवखम उठानषे कषे  वलए त्ैयाि ह।ै इसका तातप्य्भ 

संराववत मुनाफषे  व माहौल में आए बदवाल (आवथ्भक ईकोवससटम, नीवत्यां आवद) सषे होनषे वालषे नुकसान कषे  बीर कंपनी द्ािा वबठा्यषे र्यषे सनतुलन सषे होता 

ह।ै ज्यादा जोवखम उठाना सषे ज्यादा मुनाफा हो सकता ह,ै लषेवकन इससषे उतनषे ही अविक नुकसान की री संरावना बन जाती ह।ै हालांवक, बहुत ज्यादा 

सतक्भ  िहना कंपनी कषे  वखलाफ जा सकता ह,ै क््योंवक इससषे वह ववकास औि अपनषे उद्धषेश्यों को पिूा किनषे कषे  कई अच ष्े  अवसि खो दषेती ह।ै

जोवखम लषेनषे की क्मता कषे  सति को “वनमन”, “मध्यम” व “उचर” में वरशीकृत वक्या जा सकता ह।ै कंपनी कषे  उद्वम्यों को सरी संराववत ववकलपों का 

मूल्यांकन किना होता ह ैऔि उस ववकलप को रुनना होता ह,ै वजसकषे  सफल होनषे की संरावना सबसषे अविक ह।ै कंपवन्यों कषे  वववरनन मकसदों कषे  वलए 

जोवखम लषेनषे की क्मता कषे  सति री अलर-अलर होतषे हैं। सति इन बातों पि वनर्भि कितषे हैं:

• उद्ोर का प्रकाि

• बाजाि दबाव

• कंपनी कषे  उद्धषेश्य

उदाहिण कषे  वलए, क्रांवतकािी िािणा वालषे एक सटाट्भअप की जोवखम लषेनषे की क्मता का सति बहुत ऊँरा होरा। सटाट्भअप अपनी दीघ्भकावलक सफलता 

हावसल किनषे सषे पहलषे लघुकावलक असफलताएं झषेल सकता ह।ै इस तिह की रखू एक-सी नहीं िहषेरी औि कंपनी कषे  मौजदूा हालातों कषे  मुतावबक त्य 

होती िहषेरी।

जोरखम िनेे ्की क्म्ता ्का ितिवय

कंपवन्यों को अपनी जोवखम लषेनषे की क्मता को अपनषे उद्धषेश्यों तथा अवसिों कषे  बािषे  में वलए जानषे वालषे वनण्भ्यों कषे  साथ जोडना तथा परिरावषत किना होता 

ह।ै जोवखम लषेनषे की क्मता का वक्तव्य होनषे का अथ्भ ह,ै एक ऐसी संिरना मौज़दू होना, जो सपष्ट रूप सषे व्यापाि में जोवखम की सवीका्य्भता तथा प्रबंिन 

को व्यक्त किती ह।ै ्यह जोवखम उठानषे की सीमा को कंपनी की हद में िखता ह।ै जोवखम लषेनषे की क्मता कषे  वक्तव्य सषे वनमन जावहि होनषे रावहए:

• व्यवसा्य द्ािा झषेलषे जानषे वालषे जोवखमों की प्रकृवत।

• कौन सषे जोवखम कंपनी आसानी सषे लषे सकती ह ैऔि कौन सषे जोवखम असवीका्य्भ  हैं।

• सरी जोवखम शषेवण्यों में वकतना जोवखम सवीका्य्भ  ह।ै

• जोवखम व फा्यदषे कषे  बीर इवच्त अदला-बदली।

• जोवखम तथा इसकषे  पिीक्ण कषे  उपा्य औि पडताल कषे  तिीकषे  औि जोवखम कषे  सति का वन्यमन।

उद्यरम्ता और िचीिापन

उद्मी कषे  ररित्र में लरीलापन नामक ववशषेषताएं वनवहत होती हैं। ्यषे ्योग्यताएं एक उपक्रम को ववकवसत किनषे कषे  शुरुआती रिणों में खासतौि सषे बहुत 

बडी रवूमका अदा किती हैं। जोवखम लरीलापन एक बषेहद मूल्यवान रुण ह,ै क््योंवक ऐसा ववश्वास ह ैवक ्यह व्यवसा्य कषे  माहौल में बदलाव औि रुनौवत्यों 

कषे  डि कषे  वखलाफ उद्वम्यों की िक्ा किता ह।ै

उद्यरम्ता िचीिापन कया ह?ै

लरीलापन शबद उन व्यवक्त्यों की व्याख्या किनषे हषेतु प्र्योर वक्या जाता ह,ै जो अपनी वजं़दरी व करि्यि महतवाकांक्ाओ ंसषे संबंवित असफलताओ ंसषे 

उरिनषे की क्मता िखतषे हैं। एक लरीला व्यवक्त वह होता ह ैजो असफलताओ ंसषे आसानी सषे व जलदी सषे उरिनषे में सक्म हो। उद्वम्यों कषे  वलए, लरीलापन 
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एक वनणा्भ्यक रुण ह।ै उद्वमता लोर को वनमनवलवखत तिीकों सषे वनखािा जा सकता ह:ै

• कोर व मेंटि कषे  पषेशषेवि नषेटवक्भ  को ववकवसत किकषे

• ्यह सवीकाि किकषे  वक बदलाव वजं़दरी का वहससा है

• बािाओ ंको ऐसा मान कि, वक इनहें पाि वक्या जा सकता है

िचीि ेउद्यमी ्ेक गुण

उद्मी को इतना लरीला बनानषे, वक वह अपनषे व्यवसाव्यक उपक्रम में पिूी तिह आरषे बढें , हषेतु वनमन ववशषेषताओ ंकी आवश्यकता होती ह:ै

• वन्ंयत्रण की मजबतू रीतिी रावना

• मजबतू सामावजक समपक्भ

• असफलताओ ंसषे सीखनषे का हुनि

• समग परिप्रषेक््य दषेखनषे की क्मता

• वववविता अपनानषे व ववसतारित होनषे की क्मता

• बनषे िहनषे की प्रववृत्त

• नकदी-प्रवाह कषे  प्रवत सरषेत िहनषे की आदत

• बािीकी सषे ध्यान दषेना

10.5.7.1 सुझाि 
• गाहकों, सपला्यिों, सावथ्यों, दोसतों व परिवाि का एक बडा नषेटवक्भ  बनाएं। ्यह न वसफ्भ  आपकषे  व्यवसा्य को बढानषे में मदद किषे रा, बवलक आपको 

नए अवसि सीखनषे, पहराननषे में री मदद किषे रा औि बाजाि कषे  बदलावों सषे अवरत िखषेरा।

• असफलताओ ंसषे मा्यसू न हों। इस बात पि ध्यान दें वक वफि सषे आरषे बढनषे कषे  वलए क््या वक्या जाए।

• हालांवक आपको अपनषे खरकों पि वन्ंयत्रण िखनषे का प्र्यास किना रावह्यषे, ऐसा आपकी कमपनी कषे  ववकास की कीमत पि हिवरज़ नहीं होना रावह्यषे।

10.5.8 सिि्ता और असिि्ता
उद्वमता में सफलताओ ंऔि असफलताओ ंको समझें

श्याम एक मशहूि उद्मी ह,ै वह अपनी सफलता की कहानी कषे  वलए जाना जाता ह।ै मरि एक बात ज्यादाति लोर नहीं जानतषे, वक श्याम अपना उपक्रम 

सफल किनषे सषे पहलषे कई बाि असफल हुआ था। ्यह जाननषे कषे  वलए वक उद्वमता असल में क््या ह,ै उनका साक्ातकाि पढें , उस उद्मी की सीिी बात वजसषे 

दोनों वमलषे, असफलता औि सफलता।

साक्ात्कार्क्ताटि: श्याम, मैंनषे सुना ह ैवक उद्मी ज़बिदसत जोवखम उठानषे की क्मता िखतषे हैं, जो असफल होनषे सषे करी नहीं डितषे। क््या ्यह सर ह?ै

शयाम: हां हां (हँसकि), नहीं बषेशक ्यह सही नहीं ह!ै ज्यादाति लोर मानतषे हैं वक उद्वम्यों को वबना वकसी डि कषे  जुननूी होना रावह्यषे। मरि सचराई ्यह 

ह,ै वक डि एक बहुत आम व जा्यज़ मानवी्य प्रवतवक्र्या ह,ै खासतौि सषे जब आप अपना व्यवसा्य शुरू किनषे की ्योजना बना िहषे होतषे हैं! असल में, मषेिा 

सबसषे बडा डि असफल होनषे का डि था। सचराई ्यह ह,ै वक उद्मी वजतनषे असफल होतषे हैं, उतनषे ही वषे सफल होतषे हैं। नुसखा ्यह ह ैवक असफलता कषे  डि को 

खुद पि इतना हावी न होनषे दें वक आप आरषे बढनषे की अपनी ्योजनाओ ंको िोक दें। ्याद िखें, असफलताएं रववष््य की सफलता का पाठ हैं!

साक्ात्कार्क्ताटि: आपकषे  मुतावबक उद्मी कषे  असफल होनषे की वजह क््या होती ह?ै
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10.5.8.1 सुझाि 

शयाम: खिै, उद्मी कषे  असफल होनषे की कोई एक अकषे ली वजह नहीं होती। उद्मी कई वजहों की वजह सषे असफल हो सकता ह।ै आप इसवलए असफल हो 

सकतषे हैं वक आपनषे अपनषे असफलता कषे  डि कषे  आरषे हाि मान ली। आप इसवलए असफल हो सकतषे हैं वक आप काम बांटनषे कषे  प्रवत अवनच्ुक थषे। जसैा वक 

कहा जाता ह,ै “आप कु् री कि सकतषे हैं, मरि सब कु् नहीं!” आप इसवलए असफल हो सकतषे हैं वक आपनषे आसानी सषे हाि मान ली - हो सकता ह ैवक 

आप प्या्भप्त रूप सषे डटषे न हो। आप इसवलए असफल हो सकतषे हैं वक आपनषे अपनी ऊजा्भ  ्ोटषे, ग़िै-ज़रूिी कामों पि लरा दी औि वो काम नजिअंदाज कि 

वदए जो बषेहद महतवपणू्भ  थषे। असफलता की एक औि वजह रलत लोरों कषे  साथ रारीदािी री हो सकती ह,ै अपनषे उतपाद सही जरह पि, सही सम्य पि सही 

गाहक को न बषेर पाना......औि री बहुत सषे कािण!

साक्ात्कार्क्ताटि: एक उद्मी कषे  तौि पि, आपको क््या लरता ह ैवक असफलता को कैसषे लषेना रावहए?

शयाम: मषेिा मानना ह ैवक हम सबको असफलता को एक पूंजी मानना रावहए, बजाए इसकषे  वक ्यह कु् नकािातमक रीज़ ह।ै मैं इसषे इस तिीकषे  सषे दषेखता 

हंू वक, अरि आपकषे  पास कोई आइवड्या ह,ै तो आपको इसषे अमल में लानषे की कोवशश किनी रावहए, राहषे आपकषे  असफल होनषे की संरावना ही क््यों न हो। 

ऐसा इसवलए, क््योंवक प्र्यास ही न किना तो असफलता ह ैही! औि असफलता आपकषे  साथ घट सकनषे वाली सबसषे बुिी घटना नहीं ह।ै मषेिा मानना ह ैवक 

प्र्यास न किना औि वफि प्ताना, वक काश! प्र्यास वक्या होता.....असल में प्र्यास किनषे औि असफल िहनषे सषे कहीं अविक बदति ह।ै

साक्ात्कार्क्ताटि: जब आप पहली बाि असफल हुए तो आपको कैसा लरा?

शयाम: मषेिा वदल पिूी तिह टूट र्या था! ्यह बहुत दद्भनाक अनुरव था। मरि अच्ी बात ्यह ह,ै वक आप असफलता सषे उबि जातषे हैं। औि हि आनषे वाली 

असफलता कषे  साथ, उबिनषे की प्रवक्र्या औि आसान हो जाती ह।ै ऐसा इसवलए होता ह ैक््योंवक आप असफलता को एक पाठ मानना शुरू कि दषेतषे हैं, जो 

आवखिकाि सफल होनषे में आपकी मदद किती ह,ै बजाए इसषे एक ऐसी बािा मानना कषे , वजसषे आप पाि न कि सकें । आप ्यह महससू किना शुरू कि देंरषे 

वक असफलता कषे  कई फा्यदषे ह।ै

साक्ात्कार्क्ताटि: क््या आप हमें असफलता कषे  कु् फा्यदषे बता सकतषे हैं?

शयाम: एक फा्यदा ्यह ह ैजो मैंनषे असफलता सषे वनजी तौि पि सीखा ह ैवक असफलता नषे मुझषे रीज़ों को एक नई िोशनी में दषेखना वसखा्या। इसनषे मुझषे वो 

जवाब वदए जो मषेिषे  पास पहलषे नहीं थषे। असफलता आपको बषेहद मजबतू बनाती ह।ै ्यह आपकषे  अवरमान को वन्ंयत्रण में िखनषे में री मदद किती ह।ै

साक्ात्कार्क्ताटि: आप उन उद्वम्यों को क््या सलाह देंरषे जो अपना खुद का उपक्रम शुरू किना राहतषे हैं?

शयाम: मैं उनको कहना राहंूरा वक अपनी रिसर्भ किें  औि ्यह सुवनवश्चत किें  वक उनकषे  उतपाद की गाहकों को वाकई ज़रूित ह।ै मैं उनको अपनषे रारीदाि 

व कम्भरािी बषेहद समझदािी औि साविानी सषे रुननषे की िा्य दँूरा। मैं उनको कहंूरा वक आक्रामक होना बहुत महतवपणू्भ  ह ै– अपनषे उतपाद को वजतना हो 

सकषे , आक्रामक ढंर सषे बढावा दें औि उसकी माकदे वटंर किें । मैं उनहें रषेताना राहँूरा, वक वकसी उपक्रम को शुरू किना बषेहद खरशीला होता ह ैऔि उनहें उस 

हालात कषे  वलए त्ैयाि िहना रावहए जहां उनकषे  पसैषे खतम हो जाएंरषे।

मैं उनहें दीघ्भकावलक उद्षेश्य बनानषे कषे  वलए कहंूरा औि उन उद्षेश्यों को पानषे कषे  वलए कोई ्योजना अमल में लानषे कषे  वलए कहंूरा। मैं उनहें एक ऐसा उतपाद 

बनानषे की िा्य दँूरा, जो वाकई अनठूा हो। इस बात का बषेहद ध्यान िखें व सुवनवश्चत किें  वक आप वकसी दूसिषे  सटाट्भअप की नकल न किें । आवखि में, मैं 

उनको कहना राहंूरा वक ्यह बहुत महतवपणू्भ  ह ैवक वषे सही वनवषेशक तलाशें।

साक्ात्कार्क्ताटि: श्याम, ्यह वाकई काफी मददराि सलाह ह!ै मुझषे पिूा ववश्वास ह,ै वक ्यषे सुझाव उद्वम्यों को अपना सफि शुरू किनषे कषे  वलए औि अविक 

त्ैयाि कि देंरषे। अपनषे बषेशकीमती अनुरव साझा किनषे कषे  वलए िन्यवाद!

• ्याद िखें वक कु् री नामुमवकन नहीं ह।ै

• शुरू किनषे सषे पहलषे अपना वमशन व अपना उद्षेश्य पहरान लें।

• अपनषे अरलषे कदम की ्योजना बनाएं – जलदबाजी में फैसलषे न लें।
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यूरनट 10.6: ए्क उद्यमी बनने ्की ्तयैारी ्करना

इस ्यवूनट कषे  अंत में, आप वनमन किनषे में सक्म होंरषे:

1. ररा्भ  कि सकें रषे वक ववपणन (माकदे ट) शोि कैसषे वक्या जाए

2. माकदे वटंर कषे  4 P का वण्भन कि सकें रषे

3. ववराि उतपवत्त कषे  महतव पि ररा्भ  कि सकें रषे

4. बुवन्यादी व्यापाि शबदावली को ्याद कि सकें रषे

5. CRM की आवश्यकता पि ररा्भ  कि सकें रषे

6. CRM कषे  लारों पि ररा्भ  कि सकें रषे

7. नषेटववकयं र की आवश्यकता पि ररा्भ  कि सकें रषे

8. नषेटववकयं र कषे  लारों पि ररा्भ  कि सकें रषे

9. लक््यवनिा्भिण कषे  महतव को समझ सकें रषे

10. अलपकावलक, मध्यम अववि औि लंबी अववि कषे  लक््यों कषे  बीर अंति कि सकें रषे

11. ररा्भ  कि सकें रषे वक एक व्यवसा्य ्योजना कैसषे वलखी जाए

12. ववत्ती्य ्योजना प्रवक्र्या की व्याख्या कि सकें रषे

13. अपनषे जोवखम को प्रबंवित किनषे कषे  तिीकों पि ररा्भ  कि सकें रषे

14. बैंक सषे ववत्त कषे  वलए आवषेदन किनषे की प्रवक्र्या औि औपरारिकताओ ंका वण्भन कि सकें रषे

15. ररा्भ  कि सकें रषे वक अपनषे उपक्रम का प्रबंिन कैसषे वक्या जाए

16. ऐसषे महतवपणू्भ  प्रश्नों की सरूी बना सकें रषे जो प्रत्यषेक उद्मी को उप्रकम शुरू किनषे सषे पहलषे पू् नषे रावहए

यूरनट ्ेक उद्ेशय 

10.6.1 बाजार अधययन / मा्कमे रटंग ्ेक 4 पी / ए्क आइरिया ्का महति
मा्कमे ट ररसचटि समझना

माकदे ट रिसर्भ वकसी उतपाद ्या सषेवा जो बाजाि में बषेरी जा िही हो पि बाजाि सरूना जुटानषे, इसका ववश्षे षण किनषे व इसकी व्याख्या किनषे की प्रवक्र्या ह।ै 

इसमें वनमन की सरूना री शावमल ह:ै

• वप्लषे, मौजदूा व रावी गाहक

• गाहक ववशषेषताएं व खर्भ किनषे की आदतें

• लवक््यत बाजाि की वसथवत व आवश्यकताएं

• संपणू्भ  उद्ोर

• संबंवित प्रवतसपिशी

मा्कमे ट ररसचटि में दो ्तरह ्का िाटा शारमि ह:ै

• प्राथवमक सरूना। ्यह रिसर्भ आपकषे  द्ािा सव्ंय आपकषे  द्ािा वन्ुयक्त वकए रए वकसी व्यवक्त की द्ािा की जाती ह।ै

• वद्ती्यक सरूना। ्यह रिसर्भ पहलषे सषे ही मौजदू होती ह ैऔि आपको इसषे तलाशना व इसतषेमाल किना होता ह।ै
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प्रा्थरम्क ररसचटि

प्राथवमक रिसर्भ दो प्रकाि की हो सकती ह:ै

• खोजपर्क: ्यह एकदम खुली होती ह ैऔि इसमें आमतौि पि ववसतारित, रिैसंिरनातमक साक्ातकाि शावमल होतषे हैं।

• रिरशष्ट: ्यह सटीक होती ह ैऔि इसमें संिरनातमक, औपरारिक साक्ातकाि शावमल होतषे हैं। खोजपिक रिसर्भ रलानषे की अपषेक्ा वववशष्ट रिसर्भ 

रलाना ज्यादा खरशीला ह।ै

रद््तीय्क ररसचटि

वद्ती्यक रिसर्भ बाहिी जानकािी का इसतषेमाल किती ह।ै कु् आम वद्ती्यक स्ोत इस तिह हैं:

• सािटिजरन्क स्ो्त: ्यषे आमतौि पि मुफत होतषे हैं औि इनमें काफी अच्ी जानकािी होती ह।ै उदाहिण हैं सिकािी ववरार, पवबलक लाइरिषेरि्यों कषे  

व्यवसाव्यक ववरार आवद।

• िारणरजय्क स्ो्त: ्यषे मूल्यवान जानकािी दषेतषे हैं मरि आमतौि पि इसका शुलक लषेतषे हैं। उदाहिण हैं रिसर्भ व ट्षेड संघ, बैंक व अन्य ववत्ती्य  

संसथान आवद।

• रशक्ण संस्थान: ्यषे जानकािी सरूना की एक संपदा पषेश कितषे हैं। उदाहिण हैं कॉलषेज, ्यवूनववस्भटी, तकनीकी संसथान आवद।

10.6.1.1 रिपणन ्ेक 4 Ps

ववपणन कषे  4 Ps वनमनवलवखत हैं:

1. उतपाद (Product), 

2. कीमत (Price), 

3. संवि्भन (Promotion), औि 

4. सथान (Place)। 

आइ्यषे इन 4 Ps में सषे प्रत्यषेक पि ववसताि सषे ववराि कितषे हैं।

उतपाद

कोई उतपाद:

• एक मूत्भ  माल

• ्या अमूत्भ  सषेवा हो सकती है

आपका उतपाद कु् री क््यों न हो, इससषे पहलषे वक आप ववपणन प्रवक्र्या शुरू किें , आपकषे  वलए सपष्ट रूप सषे ्यह समझ लषेना महतवपणू्भ  ह,ै वक आप क््या 

ऑफि कि िहषे हैं, उसकी अनठूी ववशषेषताएं क््या हैं।

अपनषे आप सषे पू् षे  जानषे वालषे कु् प्रश्न:

• गाहक की उतपाद/सषेवा सषे क््या अपषेक्ा ह?ै

• इससषे कौन सी ज़रूितों की पवूत्भ  होती ह?ै

• क््या कोई अन्य ववशषेषताएं री हैं, वजनहें जोडा जा सकता ह?ै

• क््या इसमें कोई खरशीली औि अनावश्यक ववशषेषताएं हैं?

• गाहक इसका इसतषेमाल वकस तिह सषे किें रषे?

• इसषे क््या नाम वद्या जाना रावहए?

• ्यह समान उतपादों सषे वकस प्रकाि वरनन ह?ै
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• इसकषे  उतपादन की लारत वकतनी होरी?

• क््या इसषे मुनाफषे  में बषेरा जा सकता ह?ै

्कीम्त

जब उतपाद कषे  सरी ततवों को वनिा्भ रित कि वल्या र्या हो, तो कीमत संबंिी घटक पि ववराि वक्या जाना रावहए। वकसी उतपाद की कीमत अनषेक कािकों 

पि वनर्भि किषे री, जसैषे लार की मात्रा, आपवूत्भ , मांर औि ववपणन का्य्भनीवत।

अपनषे आप सषे पू् षे  जानषे वालषे कु् प्रश्न:

• गाहकों कषे  वलए इस उतपाद/सषेवा का मूल्य क््या ह?ै

• क््या सथानी्य उतपादों/सषेवाओ ंद्ािा मूल्य वबनदुओ ंको त्य वक्या र्या ह?ै

• क््या गाहक कीमत कषे  प्रवत संवषेदनशील ह?ै

• क््या ्ूट दी जानी रावहए?

• आपकषे  प्रवतसपवि्भ्यों की तुलना में आपकषे  द्ािा त्य की रई कीमत कैसी ह?ै

संिधटिन

जब आप अपनषे उतपाद औि उसकी कीमत कषे  प्रवत सुवनवश्चत हो जातषे हैं, तो अरला रिण होरा इसकषे  संवि्भन पि ववराि किना। संवि्भन कषे  कु् महतवपणू्भ 

ततवों में ववज्ापन, जन-संपक्भ , सोवश्यल मीवड्या, माकदे वटंर, ईमषेल माकदे वटंर, सर्भ इंजन माकदे वटंर, वीवड्यो माकदे वटंर आवद शावमल हैं।

अपनषे आप सषे पू् षे  जानषे वालषे कु् प्रश्न:

• आपको अपनषे उतपाद ्या सषेवा का संवि्भन कहां किना रावहए?

• अपनषे लक््य दश्भकरणों तक पहंुरनषे कषे  वलए प्र्योर वकए जानषे वाला सव्भशषेष्ठ माध्यम कौन सा ह?ै

• अपनषे उतपाद कषे  संवि्भन का सबसषे अच्ा सम्य क््या होरा?

• आपकषे  प्रवतसपिशी अपनषे उतपादों का संवि्भन वकस तिह सषे कि िहषे हैं।

स्थान

अविकांश ववपणनकता्भओ ंकषे  अनुसाि, ववपणन का आिाि सही सम्यपि, सही जरह पि, सही कीमत पि सही उतपाद ऑफि किना ह।ै इस कािण सषे, 

संराववत क्लाइनट्स को वासतववक क्लाइनट्स में बदलनषे कषे  वलए सवपोत्तम संरव सथान रुनना अत्ंयत महतवपणू्भ  होता ह।ै

अपनषे आप सषे पू् षे  जानषे वालषे कु् प्रश्न:

• आपकषे  उतपाद ्या सषेवा की खोज वासतववक सटोि में की जा्यषेरी, ऑनलाइन सटोि में ्या वफि दोनों में?

• आपको सवा्भ विक उप्ुयक्त ववतिण रनैलों को एक्सषेस किनषे कषे  वलए क््या किना रावहए?

• क््या आपको ववक्र्य दल (सषेलस फोस्भ) की आवश्यकता होरी?

• आपकषे  प्रवतसपिशी अपनषे उतपाद ्या सषेवाएं कहॉ ंसषे ऑफि कि िहषे हैं?

• क््या आपको अपनषे प्रवतसपवि्भ्यों कषे  पद वरनहों पि रलना रावहए?

• क््या आपको अपनषे प्रवतसपवि्भ्यों सषे कु् हट कि किना रावहए?

IDEA (आइरिया या रिचार) ्का महति

ववराि प्ररवत का आिाि होतषे हैं। कोई ववराि ्ोटा ्या अवद्ती्य हो सकता ह,ै आसानी सषे पिूा वक्या जानषे वाला हो सकता ह ै्या उसषे लार ूकिना बहुत ही 

कवठन हो सकता ह।ै कैसी री वसथवत क््यों न हो, सचराई ्यह ह ैवक वकसी ववराि सषे उसकषे  महतव का पता लरता ह।ै वबना ववरािों कषे  कु् री संरव नहीं 

ह।ै अविकांश लोर अपनषे ववरािों को प्रसतुत किनषे सषे डितषे हैं, उनहें डि होता ह ैवक उनकी हंसी उडाई जाएरी। लषेवकन, ्यवद आप एक उद्मी हैं औि प्रवतसपिशी 

तथा नवोनमषेषी/उननवतशील बनषे िहना राहतषे हैं, तो आपको अपनषे ववरािों को सामनषे लाना होरा।
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ऐसा किनषे कषे  कु् तिीकषे  हैं:

• ववराि मंथन की संसकृवत की सथापना किना जहां पि आप रूवर िखनषे वाली सरी पक्ों को ्योरदान कषे  वलए आमंवत्रत कितषे हैं

• ववरािों पि खुलषे रूप सषे ररा्भ  किना तावक लोर उन ववरािों कषे  संबंि में अपनषे ववराि, दृवष्टकोण, ्या िा्य दषे सकें ।

• खुलषे मन-मवसतष्क वाला बनना औि अपनषे ववरािों को सीवमत न किना, राहषे कोई ववराि बहुत हास्यासपद ही क््यों न वदखाई दषे।

• वकसी री ऐसषे ववराि को न त्यारना वजस पि आप ततकाल काम नहीं कितषे हैं, अवपतु उनका नोट बना कि िखना औि उनहें संजो कि िखना तावक 

उन पि बाद में करी ववराि वक्या जा सकषे ।

10.6.1.2 सुझाि 

• ध्यान िखें वक अच ष्े  ववराि हमषेशा ही अनठूषे  नहीं होतषे।

• ्याद िखें वक आपकषे  ववराि की सफलता में सम्य बहुत बडी रवूमका वनराता ह।ै

• वसथवत्यां औि परिवसथवत्यां हमषेशा बदलेंरी, इसवलए लोरपणू्भ  िहें औि तदनुसाि अपनषे ववराि को अनुकूवलत किें ।

10.6.2. वयिसाय इ्काई अिधारणाएं: मूिभू्त वयिसाय शबदाििी
्यवद आपका उद्षेश्य कोई व्यवसा्य शुरू किना औि उसषे रलाना ह,ै तो ्यह महतवपणू्भ  ह ैवक आपको मूलरतू व्यवसा्य शबदों की अच्ी समझ होनी हो। हि 

उद्मी को वनमनवलवखत शबदों की रली रांवत जानकािी होनी रावहए:

• िखेां्कन: ववत्ती्य लषेनदषेनों को रिकाड्भ  औि रिपोट्भ  किनषे की व्यववसथत वववि

• िखेा दये: कंपनी द्ािा अपनषे लषेनदािों को दषे्य िावश।

• िखेा प्रा्पय: क्लाइनट्स द्ािा कंपनी को दषे्य िावश

• समपरतियां: कंपनी द्ािा िारित औि अपनषे व्यवसा्य को प्ररावलत किनषे कषे  वलए प्र्योर की जानषे वाली सरी रीज़ों का मूल्य

• ्तुिन पत्र: कंपनी की संपवत्त्यों, दषे्यताओ,ं औि वकसी वववशष्ट सम्य पि सवामी की ईवक्वटी का सािांश।

• बॉटम िाइन: वकसी महीनषे कषे  अंत में व्यवसा्य द्ािा अवज्भत ्या रंवाई रई कुल िावश

• वयिसाय: कोई संरठन, जो लार अवज्भत किनषे कषे  उद्षेश्य सषे काम किता ह।ै

• वयापार से वयापार (B2B): कोई व्यवसा्य वजसकषे  द्ािा वकसी दूसिषे  व्यवसा्य को माल ्या सषेवाओ ंकी वबक्री की जाती ह।ै

• उपभोतिा से वयापार (B2C): कोई व्यवसा्य वजसकषे  द्ािा अंवतम उप्योरकता्भओ ंको माल ्या सषेवाओ ंकी वबक्री का जाती ह।ै

• पंूजी: वकसी व्यवसा्य का उसकषे  खातों, समपवत्त्यों तथा वनवषेशों में लरा िन। दो मुख्य प्रकाि की पूंजी में ऋण औि ईवक्वटी शावमल होतषे हैं।

• न्कदी प्रिाह: व्यवसा्य में एक महीनषे कषे  दौिान वनवि्यों की समग आवाजाही, वजसमें आ्य औि व्य्य शावमल हैं।

• न्कदी प्रिाह रििरण: सम्य की वकसी वववशष्ट अववि कषे  दौिान व्यवसा्य में आनषे औि जानषे वाली पूंजी को दशा्भनषे वाला ववविण।

• ठे्का (संरिदा): वषेतन कषे  वलए काम किनषे हषेतु एक औपरारिक समझौता।

• मूलय ह्ास: सम्य कषे  साथ वकसी समपवत्त की कीमत में कमी।

• खचटि: वकसी व्यवसा्य द्ािा अपनषे प्ररालनों कषे  दौिान वहन की जानषे वाली लारतें।

• रिति: िन औि अन्य संपवत्त्यों का प्रबंिन औि आवंटन
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10.6.3. CRM और नेटिर्किं ग

• रितिीय ररपोटटि: व्यवसाव्यक लषेन दषेनों औि व्य्यों का व्यापक लषेखा-जोखा

• रनय्त िाग्त: एक बाि वक्या जानषे वाला खर्भ।

• आय रििरण (िाभ और हारन रििरण): वकसी सम्याववि में व्यव्यास की लारप्रदता को दशा्भता ह।ै

• दये्ताएं: वह मूल्य जो व्यवसा्य द्ािा वकसी दूसिषे  को दषे्य होता ह।ै

• रिपणन: उतपाद ्या सषेवा कषे  संवि्भन, ववक्र्य औि ववतिण की प्रवक्र्या।

• रनिि आय/िाभ: िाजसव घटा व्य्य।

• रनिि संपरति: व्यवसा्य की कुल कीमत

• पेब्ैक (चु्कौ्ती) अिरध: व्यवसा्य में वकए रए वनवषेश की वसलूी में लरनषे वाला सम्य।

• िाभ मारजटिन: लार का अनुपात, वजसषे िाजसव द्ािा ववरावजत वक्या जाता ह ैऔि प्रवतशत कषे  रूप में दशा्भ्या जाता ह।ै

• रनिेश प्रर्तिि (ROI): व्यवसा्य द्ािा वनवषेश पि प्रवतफल कषे  रूप में प्राप्त की जानषे वाली िावश।

• राजसि: व्य्यों को घटानषे सषे पवू्भ  आ्य की कुल िावश।

• रिक्रय संभािना: एक संराववत गाहक।

• आपूर्तटि्क्ताटि: व्यवसा्य को आपवूत्भ्यों का प्रदाता।

• िरक््त बाज़ार: गाहकों का एक वववशष्ट समूह वजनकषे  वलए कंपनी कषे  उतपाद औि सषेवाएं लवक्त होती हैं।

• मूलयन: व्यवसा्य की कुल संपवत्त का समग अनुमान।

• रिचिनशीि िाग्त: व्यवसा्य की रवतवववि कषे  अनुपात में परिववत्भत होनषे वालषे व्य्य।

• ्कायटिशीि पंूजी: मौजदूा समपवत्त्यां घटा राल ूदषे्यताओ ंकषे  आिाि पि परिकवलत।

CRM कया ह?ै

CRM का अथ्भ ह ैगाहक संबंि प्रबंिन मूल रूप सषे गाहक संबंि पं्रबंिन का आश्य गाहकों कषे  साथ अपनषे संबंिों का प्रबंिन किना था। लषेवकन, वत्भमान में, 

इसका आश्य IT प्रणावल्यां औि सॉफटवषे्यि सषे ह ैवजनका वडज़ाइन कंपवन्यों द्ािा अपनषे संबंिों कषे  प्रबंिन कषे  वलए वक्या जाता ह।ै

CRM ्की आिशय्क्ता

कंपनी द्ािा अपनषे गाहकों कषे  साथ वजतनषे अच ष्े  तिीकषे  सषे अपनषे संबंिों का प्रबंिन वक्या जाएरा, कंपनी की सफलता की संरावनाएं उतनी ही अविक 

होंरी। वकसी उद्मी कषे  वलए, मौजदूा गाहकों को सफलतापवू्भक अपनषे साथ बनाए िखना औि उद्म का ववसताि बहुत अविक महतवपणू्भ  होता ह।ै इसी कािण 

सषे ऐसी IT प्रणावल्यों, वजनमें गाहकों कषे  साथ व्यवहाि किनषे सषे जुडी समस्याओ ंका समािान दवैनक आिाि पि वक्या जाता ह,ै की मांर बढती जा िही ह।ै

गाहक सम्य कषे  साथ साथ परिवत्भन अपषेवक्त होता ह,ै औि प्रौद्ोवरकी सषे वासतव में ्यह समझना आसान बना्या जा सकता ह ैवक गाहक वासतव में राहतषे 

क््या हैं। इस अंतज्ा्भन सषे कंपवन्यों को अपनषे गाहकों की ज़रूितों कषे  प्रवत अविक प्रवतवक्र्याशील होनषे में सहा्यता वमलती ह।ै इससषे वषे ज़रूित होनषे पि अपनषे 

व्यवसा्य को बदल पानषे में समथ्भ होतषे हैं, तावक उनकषे  गाहकों को संरवत: सव्भशषेष्ठ रूप सषे सषेवाएं प्रदान की जा सकें । सिल शबदों में कहा जाए तो CRM 

सषे कंपवन्यों को अपनषे गाहकों कषे  मूल्य को सवीकाि किनषे में सहा्यता वमलती ह ैऔि वषे उननत गाहक संबंिों का दोहन कि सकनषे में सक्म हो पाती हैं।

CRM ्ेक िाभ

CRM कषे  अनषेक महतवपणू्भ  लार होतषे हैं:

• इससषे मौजदूा गाहकों कषे  साथ संबंिों में सुिाि किनषे में सहा्यता वमलती ह ैवजसकषे  परिणाम सवरूप:

» वबक्री में बढोतिी होती है



343342

प्रतिभागी पुत्िका रोटो आरटटि्ट

विक्रय हेतु नहीं - केिल आंतरिक प्रसाि के वलए

» गाहक की आवश्यकताओ ंकी पहरान हो पाती है

» उतपादों का क्रॉस ववक्र्य संरव हो पाता है

• इससषे आप अपनषे उतपादों ्या सषेवाओ ंका बषेहति ववपणन कि सकतषे हैं।

• इससषे गाहक की संतुवष्ट औि उसषे अपनषे साथ बनाए िखनषे में सुिाि होता ह।ै

• इससषे सवा्भ विक लारदा्यक गाहकों की पहरान किकषे  औि उन पि ध्यान कषे वनरित किकषे  लारप्रदता में सुिाि होता ह।ै

6.3.3.1 नेटिर्किं ग कया ह?ै
व्यवसा्य में, नषेटववकयं र का अथ्भ ह ैअपनषे व्यवसा्य औि व्यवक्तरत कनषेक्शनों का दोहन किना तावक नए कािोबाि की वन्यवमत आपवूत्भ  प्राप्त की जा सकषे । 

माकदे वटंर की ्यह वववि प्ररावी औि साथ ही वनमन लारत वाली होती ह।ै ्यह ववक्र्य कषे  अवसिों औि संपककों का ववकास किनषे का शानदाि तिीका ह।ै 

नषेटववकयं र, िषे फिलस औि परिर्यों पि वनर्भि हो सकती ह ै्या ऐसा फोन, ईमषेल, सामावजक औि व्यवसाव्यक नषेटववकयं र वषेबसाइट्स कषे  माध्यम सषे वक्या जा 

सकता ह।ै

नेटिर्किं ग ्की आिशय्क्ता

कािोबाि सषे जुडषे  लोरों कषे  वलए नषेटववकयं र एक अवनवा्य्भ  व्यवक्तरत कौशल ह,ै लषेवकन ्यह उद्वम्यों कषे  वलए उससषे री कहीं अविक महतवपणू्भ  ह।ै नषेटववकयं र 

की प्रवक्र्या की जडें, रिशतों कषे  सजृन सषे जुडी हैं। नषेटववकयं र कषे  परिणामसवरूप ववसतारित संराि संरव होता ह ैऔि उद्वमता ईकोवससटम में एक सशक्त 

उपवसथवत को दज्भ वक्या जाता ह।ै इससषे दूसिषे  उद्वम्यों कषे  साथ मजबूत रिशतषे बनानषे में मदद वमलती ह।ै

पिूी दुवन्या में होनषे वालषे वबजनषेस नषेटववकयं र आ्योजन, समान सोर िखनषे वालषे उद्वम्यों, जो संराि, ववराि वववनम्य औि सोर को वासतववकता में बदलनषे 

कषे  वलए समान मूलरतू मान्यताओ ंको साझा कितषे हैं, को आपस में एक-दूसिषे  सषे जोडनषे में बहुत बडी रवूमका वनरातषे हैं। इस प्रकाि कषे  नषेटववकयं र का्य्भक्रमों 

द्ािा संराववत वनवषेशकों कषे  साथ उद्वम्यों को जोडनषे में री अवत महतवपणू्भ  रवूमका वनराई जाती ह।ै उद्मी व्यापक रूप सषे वरनन अनुरव औि पषृ्ठरवूम्यों 

वालषे हो सकतषे हैं, लषेवकन उन सरी कषे  मन में एक समान लक््य होता ह ै- वषे सरी समपक्भ , प्रषेिणा, सलाह, अवसि औि ववश्वसनी्य सलाहकाि राहतषे हैं। 

नषेटववकयं र सषे उनहें ऐसा किनषे का एक मंर प्राप्त हो जाता ह।ै नषेटववकयं र कषे  लार

उद्वम्यों को नषेटववकयं र सषे असंख्य लार प्राप्त होतषे हैं कु् बडषे लार वनमनवलवखत हैं:

• उचर-सतिी्य लीड्स प्राप्त होती हैं

• कािोबाि कषे  अविक अवसि वमलतषे हैं

• उप्ुयक्त कनषेक्शनों कषे  वलए बषेहति स्ोत

• एक समान सोर वालषे उद्वम्यों सषे सलाह की प्रावप्त

• रावी परिदृश्य का अनुमान औि आपकषे  प्रोफाइल का संवि्भन

• सकािातमक औि उतसाही लोरों सषे मुलाकात

• आतमववश्वास में बढोतिी

• दूसिषे  की सहा्यता सषे वमलनषे वाली संतुवष्ट

• सशक्त औि सथाई वमत्रता की सथापना

10.6.3.2 सुझाि 
• आवश्यकताओ ंकी पहरान किनषे औि फीडबकै प्राप्त किनषे कषे  वलए सोवश्यल मीवड्या इंटिैक्शनस का प्र्योर किें

• नषेटववकयं र कितषे सम्य, हां/नहीं जसैषे प्रश्नों की बजाए, खुलषे प्रश्न पू् ें
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10.6.4 वयिसाय योजना: िक्य कयों रनधाटिरर्त र्कए जाएं

10.6.4.1 वयिसाय योजना ्ेक ्तति

लक््यों को त्य किना महतवपणू्भ  होता ह ैक््योंवक इससषे आपको दीघ्भकावलक ववज़न औि अलपकावलक प्रषेिणा प्राप्त होती ह।ै लक््य अलपकावलक, मध्याववि 

औि दीघ्भकावलक हो सकतषे हैं।

अलप्कारि्क िक्य

• ्यह तातकावलक रववष््य कषे  वलए वववशष्ट लक््य होतषे हैं। उदाहिण: खिाब हो रुकी मशीन की मिममत किाना। मध्यम अववि लक््य

• ्यषे लक््य आपकषे  अलपकावलक लक््यों पि वनवम्भत होतषे हैं।

• इनका आपकषे  अलपकावलक लक््यों की तिह इतना अविक वववशष्ट होना ज़रूिी नहीं ह।ै

उदाहरण: सषेवा समझौतषे की व्यवसथा किना तावक ्यह सुवनवश्चत वक्या जा सकषे  वक आपकी मशीन वफि सषे खिाब नहीं होती ह।ै

दीघटि्कारि्क िक्य

इन लक््यों कषे  वलए सम्य औि वन्योजन की आवश्यकता होती ह।ै आमतौि पि इनहें प्राप्त किनषे में एक वष्भ  ्या अविक सम्य लरता ह।ै

उदाहरण: अपनषे खरकों की ्योजना बनाना तावक आप नई मशीनों को खिीद सकें ।

वयिसाय योजना कयों ्तयैार ्की जाए

व्यवसा्य ्योजना, ्यह समझनषे का एक सािन ह ैवक अपनषे कािोबाि को संजो कि कैसषे िखा जाए। इसका प्र्योर प्ररवत पि नज़ि िखनषे, की वनरिानी 

किनषे, जवाबदषेही को बढावा दषेनषे औि कािोबाि कषे  रववष््य को वन्ंयवत्रत किनषे कषे  वलए वक्या जा सकता ह।ै आमतौि पि इसकषे  द्ािा 3-5 वष्भ  का पवूा्भनुमान 

प्राप्त होता ह ैऔि इसमें उस ्योजना को िषे खांवकत वक्या जाता ह,ै वजसषे कंपनी अपना िाजसव बढानषे कषे  वलए अमल में लाना राहती ह।ै महतवपणू्भ  कम्भरारि्यों 

्या रावी वनवषेशकों की अवररूवर को प्राप्त किनषे कषे  वलए री व्यवसा्य ्योजना एक महतवपणू्भ  सािन ह।ै

वववशष्ट रूप सषे व्यवसा्य ्योजना में आठ ततव शावमल होतषे हैं।

्कायटि्कारी सारांश

का्य्भकािी सािांश टाइटल पषृ्ठ कषे  अनुसाि ह।ै सािांश में, कािोबाि सवामी कषे  रूप में औि कािोबाि जसैषे सवरूप में आपकी इच्ाओ ंका संवक्प्त में सपष्ट 

वण्भन वक्या जाना रावहए। ्यह आपकषे  व्यवसा्य औि आपकी ्योजनाओ ंकी समीक्ा ह।ै आदश्भ रूप सषे ्यह 1-2 पषृ्ठों सषे ज्यादा नहीं होना रावहए।

आपकषे  का्य्भकािी सािांश में वनमनवलवखत शावमल होना रावहए:

• रमशन ितिवय: समग रूप सषे अपनषे व्यव्यास कषे  सवरूप को समझाना।

उदाहरण: Nike का वमशन वक्तव्य

Nike का वमशन वक्तव्य, “दुवन्या कषे  प्रत्यषेक वखलाडी में प्रषेिणा औि इनोवषेशन का ववकास किना।”

• ्ंकपनी जान्कारी: इसमें ्यह जानकािी वनवहत होती ह ै वक आपकषे  व्यवसा्य की सथापना कब की रई थी, संसथापकों कषे  नाम औि रवूमकाएं, 

कम्भरारि्यों की संख्या, आपकषे  कािोबाि का सथान आवद।

• रि्कास संबंधी रिरशष्ट ्त्थय: कंपनी कषे  ववकास कषे  उदाहिणों का उललषेख किें । जहां री संरव हो वहां गाफस औि राट््भस का इसतषेमाल किें ।

• आप्ेक उतपाद/सेिाएं: प्रदान वकए जानषे वालषे उतपादों तथा सषेवाओ ंका वण्भन किें ।

• रितिीय जान्कारी: मौजदूा बैंक औि वनवषेशकों की जानकािी प्रदान किना।

• भािी योजनाओ ं्को सारांश रूप से प्रस्तु्त ्करें : वण्भन किें  वक आप रववष््य में अपनषे कािोबाि कषे  बािषे  में क््या अवरकलपना कितषे हैं।

वयिसाय रििरण

आपकी व्यव्यास ्योजना कषे  दूसिषे  खणड में आपकषे  कािोबाि कषे  वववरनन ततवों की ववसततृ समीक्ा उपलबि किाई जानी रावहए। इससषे संराववत गाहकों 

को आपकी व्यावसाव्यक ्योजना औि आपकी पषेशकशों की वववशष्टता को सही-सही समझनषे में मदद वमलषेरी।
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आपकषे  व्यावसाव्यक ववविण में वनमनवलवखत त्थ्य शावमल होनषे रावहए:

• आपकषे  व्यवसा्य की प्रकृवत का वण्भन

• वषे बाज़ाि आवश्यकताएं वजनहें आप संतुष्ट किनषे का लक््य िखतषे हैं

• आपकषे  उतपादों औि सषेवाओ ंद्ािा इन आवश्यकताओ ंको वकस तिह सषे पिूा वक्या जाता ह।ै

• वषे वववशष्ट उपरोक्ता औि संरठन वजनहें आप सषेवाएं प्रदान किानषे का इिादा िखतषे हैं।

• आपकषे  वववशष्ट प्रवतसपिा्भतमक लार

बाज़ार रिशे्षण

बाज़ाि ववश्षे षण खणड आमतौि पि व्यावसाव्यक ववविण कषे  बाद आता ह ैइस खणड का उद्षेश्य आपकषे  उद्ोर औि बाज़ाि जानकािी ्या ज्ान को वदखाना 

होता ह।ै ्यह वह खणड ह ैजहां पि आपको अपनषे शोि परिणामों औि वनष्कषकों को दशा्भना रावहए।

आपकषे  बाज़ाि ववश्षे षण में वनमनवलवखत शावमल होनषे रावहए:

• आपका उद्ोर ववविण औि परिप्रषेक््य (आउटलुक)

• आपकषे  लवक्त बाज़ाि सषे संबंवित जानकािी

• आपकषे  लक््य दश्भकरण की आवश्यकताएं औि जनसांवख्यकी

• आपकषे  लवक्त बाज़ाि का आकाि

• आप वकतनषे माकदे ट शषे्यि पि कबजा किना राहतषे हैं।

• आपकी कीमत संबंिी संिरना

• आपका प्रवतसपिा्भतमक ववश्षे षण

• कोई वववन्यामक अपषेक्ाएं

संगठन और प्रबंधन

्यह खणड बाज़ाि ववश्षे षण कषे  ततकाल बाद आना रावहए। आपकषे  संरठन औि प्रबंिन खणड में वनमनवलवखत शावमल होना रावहए:

• आपकी कंपनी का संरठनातमक ढांरा

• आपकी कंपनी कषे  सवावमतव का ब्यौिा

• आपकषे  प्रबंिन दल का ब्यौिा

• आपकषे  वनदषेशकों की ्योग्यता

• प्रत्यषेक वडववज़न /ववरार का ववसततृ ववविण औि इसकषे  का्य्भ

• आपकषे  द्ािा अपनषे कम्भरारि्यों को वद्या जानषे वाला वषेतन औि लार

• आपकषे  द्ािा प्रदान वकए जानषे वालषे प्रोतसाहन (इंसषेवनटवस)

सेिा या उतपाद िाइन

अरला खणड सषेवा ्या उतपाद लाइन खणड ह।ै ्यहां पि आप अपनी सषेवा ्या उतपाद का वण्भन कितषे हैं, संराववत औि मौजदूा गाहकों को वमलनषे वालषे लारों 

पि बल दषेतषे हैं। ववसताि सषे समझाएं वक आपकषे  उतपाद की पसंद सषे क््या आपकषे  लवक्त गाहकों की आवश्यकताओ ंकी पवूत्भ  होरी।

आपकषे  सषेवा औि उतपाद लाइन खणड में वनमनवलवखत शावमल होना रावहए:

• आपकषे  उतपाद/सषेवा का वण्भन

• आपकषे  उतपाद ्या सषेवा कषे  जीवन रक्र का वण्भन

• वकसी कॉपीिाइट ्या पषेटषेनट आवषेदन की सरूी
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• वकसी R &D रवतवववि का ववविण वजसमें आप शावमल हैं अथवा शावमल होनषे की ्योजना िखतषे हैं।

रिपणन और रिक्रय

एक बाि जब आपकी ्योजना का सषेवा ्या उतपाद लाइन खणड पिूा हो जाता ह,ै तो आपको अपनषे व्यवसा्य कषे  वलए ववपणन औि ववक्र्य प्रबंिन का्य्भनीवत 

कषे  वण्भन पि का्य्भ  आिमर किना रावहए।

आपकषे  ववपणन खणड में वनमनवलवखत का्य्भनीवत्यां शावमल होनी रावहएं:

• बाज़ार पठै ्कायटिनीर्त: इस का्य्भनीवत में मौजदूा बाजािों में आपकषे  मौजदूा उतपादों ्या सषेवाओ ंको बषेरनषे पि ध्यान कषे वनरित वक्या जाता ह,ै तावक 

आपकषे  माकदे ट शषे्यि वहससषे को बढा्या जा सकषे ।

• रि्कास ्कायटिनीर्त: इस का्य्भनीवत में माकदे ट शषे्यि को बढानषे पि ध्यान कषे वनरित वक्या जाता ह,ै राहषे इससषे अलपाववि में आ्य में कमी ही क््यों न हो।

• रि्तरण ्ेक चनैि ्कायटिनीर्त: ्यषे थोक ववक्रषे ता, खुदिा ववक्रषे ता, ववतिक औि इंटिनषेट री हो सकतषे हैं।

• संचार ्कायटिनीर्त: ्यषे वलवखत का्य्भनीवत्यां (ई-मषेल, पाठ, रटै), मौवखक का्य्भनीवत्यां (फोन कालस, वीवड्यो कालस, आमनषे सामनषे बठै कि  

बातरीत किना), रिै मौवखक का्य्भनीवत्यां (राव रंवरमाएं, रषेहिषे  कषे  राव, सवि का लहज़ा) औि दृवश्यक का्य्भनीवत्यां (संकषे त, वषेबपषृ्ठ, उदाहिण) हो 

सकती हैं।

आपकषे  ववक्र्य खणड में वनमनवलवखत जानकािी होनी रावहए:

• ्कायटिबि ्कायटिनीर्त: इस का्य्भनीवत में उद्म कषे  िाजसव को बढावा दषेनषे पि ध्यान कषे वनरित वक्या जाता ह।ै

• आपकी ववक्र्य संबंवित रवतवववि्यों का ववविण (रिषेकडाउन): इस्का अ्थटि रिस्तार से यह ्तय ्करना ह,ै र्क आप अपने उतपादों और सेिाओ ं्को 

र्कस प्र्कार से बेचने ्का इरादा रख्त ेहैं - क््या आप इसषे ऑफलाइन ्या ऑनलाइन बषेरेंरषे, आप वकतनषे ्यवूनट्स को बषेरनषे का इिादा िखतषे हैं, आपकी 

प्रत्यषेक ्यवूनट को वकस कीमत पि बषेरनषे की ्योजना हैं, आवद.

रितिपोषण अनुरोध

्यह खणड वववशष्ट रूप सषे उन लोरों कषे  वलए ह ैवजनहें अपनषे उद्म कषे  वलए ववत्त पोषण की आवश्यकता होती ह।ै ववत्त पोषण खणड में वनमनवलवखत जानकािी 

शावमल होनी रावहए:

• वत्भमान में आपको वकतना ववत्त पोषण रावहए।

• अरलषे पांर वषकों कषे  दौिान आपको वकतना ववत्त पोषण रावह्यषे होरा। ्यह आपकषे  दीघ्भकावलक लक््यों पि वनर्भि किषे रा।

• आप वकस प्रकाि का ववत्त पोषण राहतषे हैं औि आप इसका कैसषे प्र्योर किनषे की ्योजना िखतषे हैं। क््या आपको ऐसा ववत्त पोषण रावहए वजसका प्र्योर 

कषे वल वववशष्ट उद्षेश्य कषे  वलए वक्या जा सकषे , ्या वह ववत्त-पोषण वजसका प्र्योर वकसी री आवश्यकता कषे  वलए वक्या जा सकषे ?

• रववष््य कषे  वलए का्य्भनीवतक ्योजनाएं इसमें आपकी दीघ्भकावलक ्योजनाओ ं का ववसततृ ववविण शावमल होरा - ्यषे ्योजनाएं क््या हैं, औि इन 

्योजनाओ ंको लार ूकिनषे कषे  वलए आपको वकतनषे पसैषे की ज़रूित होरी।

• ऐवतहावसक औि रावी ववत्ती्य जानकािी ऐसा आपकषे  समसत ववत्ती्य रिकाड््भस को त्ैयाि किकषे  औि उनहें बनाए िख कि वक्या जा सकता ह,ै वजसकी 

शुरूआत आपकषे  द्ािा उद्म को शुरू किनषे सषे लषेकि आज तक कषे  ववत्ती्य रिकाड््भस को त्ैयाि किनषे सषे होती ह।ै इसकषे  वलए अपषेवक्त दसतावषेज़ों में 

आपका तुलन पत्र वजसमें आपकी कंपनी की समपवत्त्यों औि दषे्यताओ ंका ब्यौिा शावमल होता ह,ै आपका आ्य ववविण वजसमें आपकी कंपनी कषे  

िाजसव, व्य्य औि वष्भ  कषे  वलए वनवल आ्य को सरूीबद्ध वक्या जाता ह,ै आपकी कि ववविवण्यां (आम तौि पि वप्लषे तीन वष्भ  की) औि आपका नकदी 

प्रवाह बजट शावमल होता ह ैवजसमें आनषे वाली नकदी, औि बाहि जानषे वाली नकदी का वण्भन वक्या जाता ह ैऔि ्यह उललषेख वक्या जाता ह ैवक क््या 

आपकषे  पास महीनषे कषे  अंत में नकदी की कमी ह ै(नकािातमक शषेष) ह ैअथवा अविशषेष (सकािातमक शषेष) ह।ै

रितिीय रनयोजन

इससषे पहलषे की आप अपनषे उद्म का वनमा्भण किनषे की शुरूआत किें , आपको अपनषे ववत्त आवद की ्योजना बनानी होती ह।ै ववत्ती्य वन्योजन कषे  रिणों पि 

ध्यान दें:

• चरण 1: ववत्ती्य ्योजना त्ैयाि किें  इसमें आपकषे  लक््य, का्य्भनीवत्यां औि इन लक््यों को पिूा किनषे कषे  वलए सम्याववि्यां शावमल होनी रावहए।

• चरण 2: अपनषे सरी महतवपणू्भ  ववत्ती्य दसतावषेजों की व्यवसथा किें  अपनषे वनवषेश ब्यौिषे , बैंक ववविण, कि संबंिी कारज़ात, क्रषे वडट काड्भ  वबलस, बीमा 

संबंिी कारज़ात औि वकसी री अन्य ववत्ती्य रिकाड्भ  को फाइल में संजो कि िखें।
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• चरण 3: अपनी वनवल संपवत्त्यों का परिकलन किें  इसमें अपनी सव्ंय की समपवत्त्यों (समपवत्त्यां जसैषे घि, बैंक खातषे, वनवषेश आवद) का परिकलन 

किना औि उसमें सषे आपकषे  द्ािा दषे्य िावश्यां (दषे्यताएं जसैषे ऋण, लंवबत क्रषे वडट काड्भ  ववविण आवद) को घटा्या जाना होता ह,ै औि इसषे बाद जो शषेष िह 

जाता ह ैवह आपकी वनवल समपवत्त्यां होती हैं।

• चरण 4: व्य्य किनषे की ्योजना त्ैयाि किें  इसका अथ्भ ह ैवक ववसताि सषे ्यह वलखषे वक आपका पसैा कहां सषे आएरा औि कहां जाएरा।

• चरण 5: आपातकालीन वनवि बनाएं एक अच्ी आपातकालीन वनवि में इतना िन शावमल होता ह ैवजससषे कम सषे कम 6 महीनों कषे  खरकों को कवि 

वक्या जा सकषे ।

• चरण 6: अपना बीमा वनिा्भ रित किें । बीमा सषे दीघ्भकावलक ववत्ती्य सुिक्ा वमलती ह ैऔि आपको जोवखमों कषे  ववरूद्ध सुिक्ा प्राप्त होती ह।ै

जोरखम प्रबंधन

उद्मी कषे  रूप में, आपकषे  वलए ्यह महतवपणू्भ  ह ैवक आप वजस प्रकाि कषे  उद्म की शुरूआत किना राहतषे हैं, उससषे जुडषे  जोवखमों का मूल्यांकन किें , इससषे 

पहलषे की आप कंपनी की सथापना किें । आपकषे  द्ािा जब संराववत जोवखमों की पहरान कि ली जाती ह,ै आप उनहें कम किनषे कषे  वलए कदम उठा सकतषे 

हैं। जोवखमों का पं्रबिन किनषे कषे  कु् तिीकषे  वनमनवलवखत हैं:

• समान कािोबािों पि शोि किें  औि उनकषे  जोवखमों का पता लराएं औि ्यह जानकािी प्राप्त किें  वक उनहें कैसषे न्यनूतम वक्या र्या ह।ै

• मौजदूा बाज़ाि रूझानों का मूल्यांकन किें  औि ्यह पता लराएं वक क््या इसी प्रकाि कषे  उतपाद औि सषेवाएं, वजनहें कु् सम्य पहलषे पषेश वक्या र्या था, 

उनहें आज री लोरों द्ािा पणू्भ  रूप सषे सवीकाि वक्या जा िहा ह ै्या नहीं।

• इस बात पि ववराि किें  वक क््या आप अपनषे उतपाद ्या सषेवा को पषेश किनषे कषे  वलए वासतव में अपषेवक्त ववशषेषज्ता िखतषे हैं।

• अपनषे ववत्त की जांर किें  औि दषेखें वक क््या आपकषे  पास उद्म को शुरू किनषे कषे  वलए प्या्भप्त आमदनी ह।ै

• अथ्भव्यवसथा की मौजदूा वसथवत कषे  प्रवत जाररूक िहें, ववराि किें  वक सम्य कषे  साथ अथ्भव्यवसथा में कैसषे परिवत्भन हो सकता ह,ै औि इस बात पि 

ववराि किें  वक इनमें सषे वकसी री परिवत्भन सषे आपका उद्म वकस प्रकाि सषे प्रराववत हो सकता ह।ै

• ववसततृ व्यव्यास ्योजना त्ैयाि किें

10.6.4.2 सुझाि 
• सुवनवश्चत किें  वक आपकी ्योजना में समसत महतवपणू्भ  ततवों को कवि वक्या जा्यषे।

• ऑकंडों की डषेटा की रहन जॉरं कि लें।

• संवक्प्तता बितें औि ्यथा्भथ्भवादी िहें।

• अपनी का्य्भप्रणाली औि पवूा्भनुमान कषे  संबंि में सतक्भ ता बितषे (अनुदािवादी िहें)

• जहां कहीं संरव हो ववजु़अलस जसैषे राट््भस, गाफस औि ्वव्यों का प्र्योर किें

10.6.5 बैं्क रिति पोषण ्ेक रिए प्ररक्रया और औपचारर्क्ताएं
बैं्क रिति पोषण ्की आिशय्क्ता

उद्वम्यों कषे  सामनषे सबसषे कवठन रुनौती सटाट्भअपस कषे  वलए फंड जुटानषे की होती ह।ै उपलबि वववरनन ववत्त पोषण ववकलपों कषे  साथ, उद्वम्यों को इस बात 

पि रहन ववराि किना होता ह ैवक उनकषे  वलए कौन सी ववत्त पोषण वववि सव्भशषेष्ठ िहषेरी। राित में, बैंक सटाट्भअपस कषे  वलए सबसषे बडषे ववत्त पोषक हैं, औि 

वषे ही प्रवतवष्भ हजािों सटाट्भअपस का ववत्त पोषण कितषे हैं।
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10.6.5.2 बैं्क द्ारा ऋण प्रदान ्करने ्ेक मानदणि

10.6.5.1 उद्यरमयों ्को रिति पोषण ्ेक रिए बैं्क ्को ्कौन सी जान्कारी दनेी चारहए
बैंक सषे संपक्भ  कितषे सम्य, उद्वम्यों को उन वववरनन मानदणडों की सपष्ट जानकािी होनी रावहए वजनका प्र्योर बैंक द्ािा ऋण आवषेदनों की सक्रीवनंर, 

िषे वटंर औि प्रसंसकिण किनषे कषे  वलए वक्या जाना ह।ै उद्वम्यों को बैंक को सटीक औि सही जानकािी प्रदान किनषे कषे  महतव कषे  प्रवत री जाररूक होना 

रावहए। ववत्ती्य संसथानों कषे  वलए पहलषे की अपषेक्ा अब ऋण आवषेदकों कषे  रकू संबंिी व्यवहाि का पता लराना बहुत ही आसान हो रुका ह।ै बैंक सषे ववत्त 

पोषण की अपषेक्ा किनषे वालषे उद्वम्यों को अपनी सामान्य जानकािी, ववत्ती्य वसथवत औि रांिटी ्या समपावश्व्भक (कोलॅट्लस) आवद, वजसषे वषे उपलबि किा 

सकतषे हैं, कषे  बािषे  में जानकािी प्रदान किनी रावहए।

सामान्य जानकािी

्यहां पि आप, एक उद्मी कषे  रूप में, बैंक को अपनषे बकैगाउंड की जानकािी दषे सकतषे। इस प्रकाि की जानकािी में वनमनवलवखत शावमल होता ह:ै

• पररचय पत्र: इस पत्र को एक सममानी्य कािोबािी व्यवक्त द्ािा वलखा जाना रावहए जो आपको रली रांवत जानता ह ैतावक वह आपका परिर्य दषे 

सकषे । इस पत्र का लक््य आपकी उपलवबि्यों को वरनाना ह ैऔि आपकषे  ररित्र औि सत्यवनष्ठा का सत्यापन किना ह।ै

• आप्का प्रोिाइि: मूल रूप सषे ्यह आपका जीवन-वतृ ह।ै आपको बैंक को अपनी शकै्वणक उपलवबि्यों, पषेशषेवि प्रवशक्ण, ्योग्यताओ,ं िोज़राि 

रिकाड््भस औि उपलवबि्यों का उप्ुयक्त ब्यौिा प्रदान किना होता ह।ै

• रबजनेस ब्ोशर (रििररण्का): वववशष्ट रूप सषे वकसी व्यवसा्य ववविवणका में कंपनी कषे  उतपादों, क्लाइनट्स, कािोबाि वकतनषे सम्य सषे वक्या जा 

िहा ह,ै आवद की जानकािी प्रदान की जाती ह।ै

• बैं्क और अनय संदभटि: ्यवद आपका वकसी अन्य बैंक में खाता ह,ै तो इन बैंक ववविणों को प्रदान किना एक अच्ी बात होरी।

• ्ंकपनी ्ेक सिारमति या पंजी्करण ्की जान्कारी: कु् मामलों में, आपको कंपनी कषे  सवावमतव औि पंजीकिण का साक््य दषेना पड सकता ह।ै 

समपवत्यों औि दषे्यताओ ंकी सरूी की री ज़रूित हो सकती ह।ै

ववत्ती्य वसथवत

बैंक आपकषे  उद्म की मौजदूा ववत्ती्य वसथवत की जानकािी की अपषेक्ा कि सकतषे हैं। आपकषे  द्ािा त्ैयाि की जानषे वाली मानक ववत्ती्य रिपोट््भस में 

वनमनवलवखत जानकािी शावमल होनी रावहए:

• तुलन पत्र 

• लार औि हावन खाता

• नकदी प्रवाह ववविण 

• अनुमावनत वबक्री औि िाजसव

• व्यापाि ्योजना 

• संराव्यता अध्य्यन

गारंटी या समपारश्टि्क

आमतौि पि बैंक आपको वबना वसक््योरिटी कषे  ऋण दषेनषे सषे इंकाि कि देंरषे। आप वसक््योरिटी कषे  तौि पि समपवत्त्यां दषे सकतषे हैं औि ्यवद आप ऋण की रुकौती 

किनषे मषे ववफल िहतषे हैं तो बैंक उनहें जबत कि सकतषे हैं औि बषेर सकतषे हैं। वन्यत समपवत्त्यां जसैषे मशीनिी, उपकिण, वाहन आवद पि ऋण की वसक््योरिटी 

कषे  वलए ववराि वक्या जा सकता ह।ै

्यवद आप वनमनवलवखत उिाि दषेनषे कषे  मानदणडों को पिूा कि सकतषे हैं, तो ववत्त पोषण कषे  आपकषे  अनुिोि को मंजिू वकए जानषे की उचरति संरावनाएं होती हैं:

• बषेहति नकदी प्रवाह

• प्या्भप्त शषे्यििािक वनवि्यां

• प्या्भप्त वसक््योरिटी
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• कािोबाि में अनुरव

• अच्ी प्रवतष्ठा

प्ररक्रया

ववत्त पोषण हषेतु आवषेदन किनषे कषे  वलए वनमनवलवखत प्रवक्र्या का पालन वक्या जाना रावहए।

• अपनषे आवषेदन प्रपत्र औि अन्य सरी अपषेवक्त दसतावषेजों को बैंक में प्रसतुत किें ।

• बैंक द्ािा आपकी उिाि पात्रता का साविानीपवू्भक आकलन वक्या जाएरा औि प्रबंिन, ववत्त, प्ररालन, औि औद्ोवरक जानकािी औि ववरत ऋण 

वनष्पादन जसैषे पिैामीटस्भ का ववश्षे षण किकषे  आपको िषे वटंर प्रदान की जाएरी।

• बैंक द्ािा वनण्भ्य वक्या जाएरा वक क््या आपको ववत्त पोषण वद्या जाए अथवा नहीं।

10.6.5.3 सुझाि 
• अनुरवी बैंकस्भ सषे ववत्त पोषण ववकलपों कषे  बािषे  में सलाह प्राप्त किें ।

• सजर िहें औि वजतनी आपको आवश्यकता ह,ै उससषे अविक उिाि न लें, न ही अपनी आवश्यकता सषे अविक लंबी अववि कषे  वलए उिाि लें औि इसकषे  

वलए अपनी सुवविा सषे पिषे  उचर ब्याज दि री उिाि लषेनषे सषे बरें।

10.6.6 उद्यम प्रबंधन- ए्क समीक्ा

अपनषे उद्म का प्ररावशाली रूप सषे प्रबंिन किनषे कषे  वलए, आपको वववरनन पहलुओ ंपि ववराि किना होरा वजसमें वदन प्रवतवदन की रवतवववि्यां कषे  प्रबंिन 

सषे लषेकि, वकसी बडी घटना का प्रबंिन शावमल ह।ै अपनी कंपनी कषे  प्ररावी प्रबंिन कषे  वलए आइ्यषे कु् सिल रिणों पि ववराि कितषे हैं।

चरण 1: अपने िीिररशप (ने्ततृि) ्कौशि ्का प्रयोग ्करें  और जब भी अपेरक््त हो, सिाह प्राप्त ्करें ।

आइ्यषे िामू कषे  उदाहिण पि ववराि कितषे हैं, एक उद्मी वजसनषे अरी हाल ही में अपना व्यवसा्य शुरू वक्या ह।ै िामू कषे  पास अच्ा लीडिवशप कौशल ह ै- वह 

ईमानदाि ह,ै अच ष्े  सषे बातरीत किता ह,ै ्यह री जानता ह ैवक काम को वकस प्रकाि सषे ववरावजत वक्या जाए आवद। इन लीडिवशप कौशल सषे सुवनवश्चत रूप 

सषे िामू को अपनषे उद्म कषे  प्रबंिन में सहा्यता वमलषेरी। लषेवकन, करी करी िामू को ऐसी वसथवत्यों का सामना किना पडता ह ैवजनकी हैंडवलंर कषे  बािषे  में 

वह वनवश्चत रूप सषे नहीं जानता। िामू को ऐसी वसथवत में क््या किना रावहए? उसकषे  वलए एक समािान ्यह ह ैवक उसषे अपनषे सषे अविक अनुरवी मनैषेजि का 

पता लराना रावहए जो उसका मार्भदश्भन कि सकषे । िामू कषे  वलए दूसिा समािान ्यह ह ैवक वह अपनषे ही नषेटववकयं र कौशल का इसतषेमाल किषे  तावक वह 

दूसिषे  संरठनों कषे  मनैषेजस्भ सषे संपक्भ  कि सकषे , जो उसषे इस प्रकाि की वसथवत्यों कषे  बािषे  में काि्भ वाई किनषे कषे  बािषे  में सलाह दषे सकतषे हैं।

चरण 2: अपने ्कायषों ्को दूसरों में बांट दें- इस ्त्थय ्को समझ िें र्क आप हर ्काम सियं नहीं ्कर स्क्त ेहैं।

्यहां तक वक इस दुवन्या में सवा्भ विक कुशल मनैषेजि वह हि काम सव्ंय नहीं कि पाएरा वजसकी उससषे उद्म द्ािा मांर ्या आशा की जाती ह।ै वकसी 

समझदाि मनैषेजि को ्यह समझना होता ह ैवक उसकषे  उद्म कषे  प्रबंिन कषे  पी ष्े  सवा्भ विक महतवपणू्भ  बात ्यह ह ैवक उसषे अपनषे आसपास कषे  लोरों कषे  बीर 

में अपनषे का्य्भ  का ववराजन किना रावहए। इसषे डषेवलरषेशन कहा जाता ह:ै लषेवकन डषेवलरषेशन प्या्भप्त नहीं ह।ै ्यवद कोई मनैषेजि बषेहति परिणाम राहता ह,ै तो 

उसषे प्ररावी रूप सषे का्य्भ  ववराजन किना रावहए. ्यह महतवपणू्भ  ह ैक््योंवक जब ववराजन रलत तिीकषे  सषे वक्या जाता ह,ै तो परिणाम सवरूप आपकषे  वलए 

औि अविक काम री पदैा हो सकता ह।ै प्ररावी रूप सषे का्य्भ  ववराजन कषे  वलए, आपको दो सवूर्यां त्ैयाि कितषे हुए काम शुरू किना रावहए। एक सरूी में 

वह काम होनषे रावहए वजनकषे  बािषे  में आप जानतषे हैं वक आप सव्ंय उनकी दषेखराल कि सकतषे हैं। दूसिी सरूी में वषे बातें शावमल होनी रावहए वजनकषे  बािषे  में 

आपको ववश्वास ह ैवक उनका प्रबंिन औि िख िखाव किनषे कषे  वलए उनहें दूसिों को वद्या जा सकता ह।ै रलत का्य्भ  ववराजन कषे  अलावा, एक अन्य मुद्ा 

पदैा हो सकता ह ैवजसषे आवश्यकता सषे अविक डषेलीरषेशन कहा जाता ह।ै इसका अथ्भ ह ैवक अपनषे बहुत सषे का्यकों को दूसिों को दषे दषेना। इसकषे  साथ समस्या 

्यह ह ैवक वजतनषे अविक का्य्भ  आप डषेलीरषेट कितषे हैं, उतना ही अविक सम्य आपको, उन लोरों कषे  का्य्भ  की प्ररवत को ट्कै किनषे औि उसकी वनरिानी 

किनषे में लर जाता ह,ै वजनको आपनषे ्यह का्य्भ  सौंपषे थषे। इससषे आपकषे  पास अपनषे काम को पिूा किनषे कषे  वलए बहुत ही कम सम्य बरषेरा।
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10.6.6.1 सुझाि 

10.6.7.20 उद्यमशीि्ता पर रिचार ्करना

चरण 3: ्काम पर सही वयरतियों ्की रनयुरति ्करें ।

सही व्यवक्त्यों की वन्ुयवक्त किना आपकषे  उद्म कषे  प्ररावी प्रबंिन में बहुत ही वनणा्भ्यक सावबत होता ह।ै का्य्भ  कषे  वलए सवा्भ विक उप्ुयक्त व्यवक्त्यों की 

वन्ुयवक्त किनषे कषे  वलए, आपको साक्ातकाि की प्रवक्र्या कषे  बािषे  में बहुत ही सजर िहना होरा। आपको संराववत उममीदवािों सषे सही प्रश्न पू् नषे होंरषे औि 

साविानी सषे उनकषे  उत्तिों का मूल्यांकन किना होरा। पषृ्ठरवूम जांर किना हमषेशा ही अच्ा सावबत होता ह।ै क्रषे वडट जांर किना री उप्ुयक्त िहता ह,ै ववशषेष 

रूप सषे वजन व्यवक्त्यों की आप वन्ुयवक्त किनषे जा िहषे हैं, वषे आपकषे  पसैषे का िख िखाव किें रषे। प्रत्यषेक रवूमका, वजसकषे  वलए आप वन्ुयवक्त किनषे जा िहषे हैं, 

कषे  वलए एक ववसततृ जॉब ववविण त्ैयाि किें  औि सुवनवश्चत किें  वक समसत उममीदवािों को जॉब ववविण की सपष्ट औि सही जानकािी ह।ै आपकषे  पास 

कम्भरािी वन्यम पुवसतका होनी रावहए, वजसमें आपको उन सरी उममीदों को शावमल किना रावहए जो आप अपनषे कम्भरारि्यों सषे िखतषे हैं। इन सरी का्यकों 

सषे ्यह सुवनवश्चत किनषे में सहा्यता वमलषेरी वक आपकषे  उद्म को रलानषे कषे  वलए आपनषे सही लोरों सषे ही संपक्भ  वक्या ह।ै

चरण 4: अपने ्कमटिचाररयों ्को अरभप्रेरर्त ्करें  और उनहें भिी भांर्त प्ररशक्ण दें।

आपकषे  उद्म का कषे वल तरी प्ररावी रूप सषे प्रबंिन वक्या जा सकता ह ैजब कम्भरािी आपकषे  उद्म कषे  वलए कडी मषेहनत किनषे कषे  वलए अवरप्रषेरित हों। 

अवरप्रषेरित होनषे कषे  एक रार कषे  तौि पि, आपकषे  कम्भरारि्यों को आपकषे  उद्म कषे  ववज़न औि वमशन में ववश्वास होना रावहए औि वषे वासतव में उनको प्राप्त 

किनषे की वदशा में प्र्यास किनषे कषे  इच्ुक होनषे रावहएं। आप अपनषे कम्भरारि्यों को सममान, बोनस आवद औि उपलवबि्यों कषे  वलए पुरूसकाि आवद प्रदान 

किकषे  अवरप्रषेरित कि सकतषे हैं। आप उनहें ्यह बता कि री अवरप्रषेरित कि सकतषे हैं वक उनकषे  ही प्र्यासों की वजह सषे कंपनी नषे वकस प्रकाि सषे सफलता 

हावसल की ह।ै इससषे वषे रव्भ  महससू किें रषे औि उनकषे  मन में उत्तिदाव्यतव की रावना ववकवसत होरी वजससषे वषे औि अविक अवरप्रषेरित होंरषे।

अपनषे कम्भरारि्यों को अवरप्रषेरित किनषे कषे  अलावा, इनहें वनिनति नए अभ्यासों औि तकनीकों का प्रवशक्ण वद्या जाना रावहए। ्याद िखें, वक प्रवशक्ण एक 

बाि वक्या जानषे वाला प्र्यास नहीं ह।ै ्यह सतत प्र्यास ह ैवजसषे वनिनति वक्या जाना रावहए।

चरण 5: अपने रिाह्कों ्को भिी भांर्त हैंिि ्करने ्ेक रिए अपने ्कमटिचाररयों ्को प्ररशक्ण दें।

आपकषे  कम्भरारि्यों को गाहक पं्रबिन की कला में पािंरत होना रावहए। इसका अथ्भ ह ैवक वषे ्यह समझनषे में समथ्भ होनषे रावहए वक उनकषे  गाहक क््या राहतषे 

हैं औि साथ ही उनहें ्यह री मालमू होना रावहए वक उनकी ज़रूितों को वकस तिह सषे पिूा वक्या जाए। वषे इन बातों को वासतववक रूप सषे समझ सकें , उनहें 

्यह दषेखना होरा वक आप गाहकों कषे  साथ वकस प्रकाि सषे प्ररावी रूप सषे काि्भ वाई कितषे हैं। इसषे उदाहिण द्ािा अरुवाई किना कहतषे हैं। उनहें ्यह वदखाएं 

वक आप अपनषे क्लाइनट्स की बातों को वकस प्रकाि रंरीिता सषे सुनतषे हैं, औि उनकी ज़रूितों को समझनषे में आप वकतनषे प्र्यास कितषे हैं। आप अपनषे 

क्लाइनट्स सषे जो प्रश्न पू् तषे हैं, उनहें इन प्रश्नों को समझनषे दें तावक वषे समझ सकें  वक कौन सषे प्रश्न उप्ुयक्त होतषे हैं।

चरण 6: अपने उद्यम ्का प्रभािी रिपणन (प्रस्तु्ती्करण) ्करें ।

अपनषे उद्म कषे  प्ररावी ववपणन (प्रसतुतीकिण) कषे  वलए अपनषे समसत कौशल औि अपनषे कम्भरारि्यों कषे  कौशल का उप्योर किें । ्यवद आपको लरता ह ैवक 

इस ववष्य में आपको सहा्यता की ज़रूित ह,ै तो आप एक माकदे वटंर एजषेनसी की वन्ुयवक्त कि सकतषे हैं।

अब आपको ्यह समझ में आ रुका ह ैवक आपकषे  उद्म को प्ररावी रूप सषे रलानषे कषे  वलए क््या अपषेवक्त ह,ै इन बातों को लार ूकिें  औि दषेखें वक आपकषे  उद्म 

का प्रबंिन वकतना आसान हो जाता ह!ै

• अनुरवी बैंकस्भ सषे ववत्त पोषण ववकलपों कषे  बािषे  में सलाह प्राप्त किें ।

• सजर िहें औि वजतनी आपको आवश्यकता ह,ै उससषे अविक उिाि न लें, न ही अपनी आवश्यकता सषे अविक लंबी अववि कषे  वलए उिाि लें औि इसकषे  

वलए अपनी सुवविा सषे पिषे  उचर ब्याज दि री उिाि लषेनषे सषे बरें।

उद्मशीलता पि ववराि किनषे सषे पहलषे सव्ंय सषे पू् षे  जानषे वालषे प्रश्न

• मैं कािोबाि क््यों शुरू कि िहा हंू?

• मैं कौन सी समस्या का समािान किनषे जा िहा हंू?
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• क््या दूसिों नषे इस समस्या का समािान किनषे का इससषे पहलषे प्र्यास वक्या था? क््या वषे सफल िहषे थषे अथवा ववफल?

• क््या मषेिा कोई मार्भदश्भक1 ह,ै ्या कोई उद्ोर ववशषेषज् ह ैवजससषे मैं सहा्यता प्राप्त कि सकता हंू?

• मषेिषे  आदश्भ गाहक2 कौन कौन हैं?

• मषेिषे  प्रवतसपिशी3 कौन कौन हैं?

• मषेिा कािोबाि दूसिषे  कषे  कािोबाि सषे वकस प्रकाि सषे वरनन ह?ै

• मषेिषे  उतपाद ्या सषेवा की महतवपणू्भ  ववशषेषताएं क््या हैं?

• क््या मैंनषे SWOT4 ववश्षे षण वक्या ह?ै

• उस बाज़ाि का आकाि क््या ह ैवजसमें मषेिषे  उतपाद ्या सषेवा को खिीदा जाएरा?

• बाज़ाि की जांर किनषे कषे  वलए न्यनूतम व्यवहा्य्भ  उतपाद5 को त्ैयाि किनषे कषे  वलए क््या प्र्यास किनषे होंरषे?

• मुझषे कािोबाि की शुरूआत किनषे कषे  वलए वकतनषे पसैो की ज़रूित ह?ै

• क््या मुझषे ऋण की आवश्यकता होरी?

• मषेिषे  उतपाद औि सषेवाएं वकतनी जलदी उपलबि हो सकें री?

• मैं न लार - न हावन6 की वसथवत ्या लार की वसथवत में कब पहंुर जाऊंरा?

• मषेिषे  उद्म में वनवषेश किनषे वालषे वकस प्रकाि सषे लारावनवत होंरषे?

• मुझषे अपनषे व्यवसा्य कषे  वलए वकस प्रकाि कषे  काननूी अवंसिरना7 त्ैयाि किनी होरी?

• मुझषे कौन-कौन सषे कि8 दषेनषे होतषे हैं?

• मुझषे वकस प्रकाि कषे  बीमा9 की आवश्यकता ह?ै

• क््या फीडबकै कषे  वलए मैंनषे अपनषे संराववत गाहकों सषे संपक्भ  वक्या ह?ै

10.6.6.1 सुझाि 
• इससषे पहलषे वक आप अपना महतवपणू्भ  सम्य, पसैा औि संसािन अपनषे कािोबाि में लराएं, ्यह बहुत महतवपणू्भ  ह ैवक आप अपनी कािोबाि संबंिी सोर 

का सत्यापन ्या पुवष्ट कि लें।

• वजतनषे अविक प्रश्न आप अपनषे आप सषे पू् ेंरषे, आप उतनषे ही अपनषे उद्म की सफलताओ ंऔि ववफलताओ ंकी हैंडवलंर किनषे कषे  वलए त्ैयाि हो पाएंरषे।

िुटनोट:

1. एक मार्भदश्भक एक ववश्वसनी्य औि अनुरवी व्यवक्त होता ह ैजो आपको प्रवशवक्त किनषे औि आपका मार्भदश्भन किनषे कषे  वलए त्ैयाि होता ह।ै

2. गाहक कोई ऐसा व्यवक्त होता ह ैजो माल औि/्या सषेवाओ ंको खिीदता ह।ै

3. प्रवतसपिशी ऐसषे व्यवक्त ्या कंपनी होती हैं जो ऐसषे उतपाद औि/्या सषेवाओ ंकी वबक्री कितषे हैं जो आपकषे  उतपादों औि/्या सषेवाओ ंकषे  समान ह।ै

4. SWOT का अथ्भ ह ैशवक्त्यां, कवम्यां, अवसि औि जोवखम। अपनी कंपनी कषे  SWOT ववश्षे षण कषे  वलए, आपको अपनी कंपनी की सरी शवक्त्यों औि 

कवम्यों की सरूी त्ैयाि किनी होरी, अपनी कंपनी कषे  वलए उपलबि अवसि, औि अपनी कंपनी कषे  समक् आनषे वालषे जोवखमों की सरूी बनानी होरी।

5. एक न्यनूतम व्यवहा्य्भ  उतपाद वह उतपाद ह ैवजसमें न्यनूतम संरव ववशषेषताएं होती हैं, वजसषे गाहकों को बषेरा जा सकता ह,ै तावक उस उतपाद कषे  संबंि 

में गाहकों सषे फीडबकै प्राप्त वक्या जा सकषे ।

6. कोई कंपनी उस सम्य न लार न हावन (रिषेक इवन) की वसथवत में होती ह,ै जब कंपनी कषे  लार उसकी लारत कषे  बिाबि होतषे हैं।

7. काननूी अवसंिरना में, एकल सवावमतव, साझषेदािी ्या सीवमत दषे्यता साझषेदािी हो सकती ह।ै
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8. दो प्रकाि कषे  कि होतषे हैं- प्रत्यक् कि वजनका रुरतान व्यवक्त ्या कंपनी द्ािा वक्या जाता ह,ै ्या अप्रत्यक् कि, वजनहें माल औि/्या सषेवाओ ंपि लरा्या 

जाता ह।ै

9. दो प्रकाि कषे  बीमा होतषे हैं - जीवन बीमा औि सामान्य बीमा जीवन बीमा में मानव जीवन को कवि वक्या जाता ह ैजबवक सामान्य में पशु, माल, काि 

आवद जसैी समपवत्त्यों को कवि वक्या जाता ह।ै
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